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CHAPTER 1

Idris 教程

本文档为 奉奤奲奩女 的教程，它简单介绍了如何用 奉奤奲奩女 语言编程。 文档中覆盖了该语言的核心特性，并假
定你至少熟悉一门函数式编程语言，如 奈奡女奫奥奬奬 或 奏奃奡奭奬。

注注注解解解: 奉奤奲奩女 文档已按照 创创创作作作共共共用用用 CC0 许许许可可可协协协议议议 发布。因此根据法律规定， Idris 社社社区区区 已放弃对
奉奤奲奩女 文档的所有版权以及相关或邻接的权利。

关于 奃奃夰 的更多信息参见：奨奴奴奰女夺夯夯奣奲奥奡奴奩奶奥奣奯奭奭奯奮女央奯奲奧夯奰奵奢奬奩奣奤奯奭奡奩奮夯奺奥奲奯夯失央夰夯奤奥奥奤央奺奨

1.1 引引引言言言

在传统编程语言中，类类类型型型 与 值值值 之间有明确的区分。例如在 奈奡女奫奥奬奬 中夬 下面这些类型分别表示整数、
字符、字符列表 以及任意值的列表：

• Int夬 Char夬 [Char]夬 [a]

与此对应，下面这些值分别为上述类型的成员：

• 42夬 ’a’夬 "Hello world!"夬 [2,3,4,5,6]

然而，在带有 依依依赖赖赖类类类型型型（（（Dependent Type））） 的语言中，它们的区别并不明显。 依赖类型允许类型
「依赖」于值，换句话说，类型是 一一一等等等（（（First-Class））） 的语言构造， 即它可以像值一样进行操作。
标准范例就是带长度的列表类型1 Vect n a， 其中 a 为元素的类型，而 n 为该列表的长度且可以任意
长。

当类型包含了描述其性质的值（如列表的长度）时，它就能描述函数自身的性质了。 比如连接两个列
表的操作，它拥有性质：结果列表的长度为两个输入列表的长度之和。 因此我们可以为 app 函数赋予
如下类型，它用于连接向量（奖奥奣奴奯奲）：

app : Vect n a -> Vect m a -> Vect (n + m) a

1 也许会令人困惑，它在依赖类型编程的文献中通常被称作「向量 (Vector) 」。

夲
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本教程介绍了 奉奤奲奩女，一个通用的依赖类型函数式编程语言。奉奤奲奩女 项目旨在为可验证的通用编程打造一
个依赖类型的语言。 为此，奉奤奲奩女 被设计成了编译型语言，目的在于生成高效的可执行代码。 它还拥有
轻量的外部函数接口，可与外部 C 库轻松交互。

1.1.1 目目目标标标受受受众众众

本教程面向已经熟悉函数式语言（如 奈奡女奫奥奬奬 或 奏奃奡奭奬 ）的读者，旨在简要地介绍该语言。 尽管大多
数概念都会有简单的解释，读者仍须熟悉 奈奡女奫奥奬奬 的语法。 我们亦假设读者有兴趣使用依赖类型来编写
和验证系统软件。

对 奉奤奲奩女 更加深入的介绍，见 奅奤奷奩奮 奂奲奡奤她 所著的《 奉奤奲奩女 类型驱动开发 》， 其进度要慢得多，涵盖了
交互式程序开发以及更多的例子。本书可从 奍奡奮奮奩奮奧 获取。

1.1.2 示示示例例例代代代码码码

本教程中的示例代码通过了 奉奤奲奩女 的测试。这些文件可在 奉奤奲奩女 发行版的 samples 目录中找到，因此您
可以轻松使用它们。然而，我们强烈建议您不要只是载入后阅读， 而是亲自输入它们。

1.2 入入入门门门

1.2.1 前前前提提提需需需求求求

在安装 奉奤奲奩女 之前，你需要确认是否拥有所有必须的库和工具。你需要：

• 近期版本的 奇奈奃 。目前测试过的最早版本为 夷央失夰央夳央

• GNU 多多多精精精度度度运运运算算算库库库 夨奇奍奐天 可从 奍奡奣奐奯奲奴女夯奈奯奭奥奢奲奥奷 和所有主流 奌奩奮奵奸 发行版中获取。

1.2.2 下下下载载载并并并安安安装装装

如果你满足所有的前提需求，那么安装 奉奤奲奩女 的最简方式就是在命令行输入：

cabal update; cabal install idris

这会安装 奈奡奣奫奡奧奥 中的最新版本及其所有依赖。如果你想要最新开发版的话， 可以在 奇奩奴奈奵奢 上找到
它， 然后根据构建指令来安装。

如果你之前从未安装过使用 奃奡奢奡奬 的东西，奉奤奲奩女 可能不在你的 奐奁奔奈 中。 如果 奉奤奲奩女 可执行文件
无法找到，请将 ~/.cabal/bin 添加到 $PATH 环境变量中。奍奡奣 奏奓 奘 用户则需要添加 ~/Library/
Haskell/bin，套奩奮奤奯奷女 用户通常会发现 奃奡奢奡奬 将程序安装在 %HOME%\AppData\Roaming\cabal\bin
中。

为了检查安装是否成功，你需要编写第一个程序。请创建一个名为 hello.idr 的文件， 其中包含以下
文本：

module Main

main : IO ()
main = putStrLn "Hello world"

1.2. 入入入门门门 3
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如果你熟悉 奈奡女奫奥奬奬，那会很清楚这段程序在做什么，是如何做的； 如果你对它感到陌生，我们稍后会
详细地解释。你可以在命令行中输入 idris hello.idr -o hello 来将程序编译成可执行文件。 这会
创建一个名为 hello 的可执行文件，你可以运行它：

$ idris hello.idr -o hello
$ ./hello
Hello world

请注意，美元符号 $ 表示命令行。下面是一些常用的 奉奤奲奩女 命令行选项：

• -o prog 编译成名为 prog 的可执行文件。

• --check 无需启动交互式环境就对文件及其依赖进行类型检查。

• --package pkg 将包添加为依赖，例如通过 --package contrib 来使用 奣奯奮奴奲奩奢 包。

• --help 显示用法摘要和命令行选项。

1.2.3 交交交互互互式式式环环环境境境

在命令行中输入 idris 来启动交互式环境。你会看到如下内容：

$ idris
____ __ _
/ _/___/ /____(_)____
/ // __ / ___/ / ___/ Version 1.3.1

_/ // /_/ / / / (__ ) http://www.idris-lang.org/
/___/\__,_/_/ /_/____/ Type :? for help

Idris>

它会提供一个 ghci 风格的界面，可以像类型检查那样求值表达式、进行定理证明、 编译、编辑、以及
执行多种其它操作。命令 :? 会列出所支持的命令。在以下示例中， hello.idr 已被加载，main 的类
型已通过检查，之后该程序被编译成了可执行的 hello。 在对某文件类型检查时，如果通过，就会创建
它的的字节码版本（本例中为 hello.ibc） 以提升未来的加载速度。在源文件被修改之后，字节码会
重新生成。

$ idris hello.idr
____ __ _

/ _/___/ /____(_)____
/ // __ / ___/ / ___/ Version 1.3.1

_/ // /_/ / / / (__ ) http://www.idris-lang.org/
/___/\__,_/_/ /_/____/ Type :? for help

Type checking ./hello.idr
*hello> :t main
Main.main : IO ()
*hello> :c hello
*hello> :q
Bye bye
$ ./hello
Hello world

1.3 类类类型型型与与与函函函数数数
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1.3.1 原原原语语语类类类型型型

奉奤奲奩女 定义了一些原语（奐奲奩奭奩奴奩奶奥）类型：Int、Integer 和 Double 用于数值类型， Char 和 String 用
于文本操作，Ptr 则表示外部指针。库中还声明了一些数据类型， 包括 Bool 及其值 True 和 False。
我们可以用这些类型来声明常量。 将以下内容保存到文件 Prims.idr 中，在命令行中输入 idris
Prims.idr 以将其加载到 奉奤奲奩女 的交互式环境中：

module Prims

x : Int
x = 42

foo : String
foo = "Sausage machine"

bar : Char
bar = 'Z'

quux : Bool
quux = False

提提提示示示: 原语（奐奲奩奭奩奴奩奶奥）本意为不可分割的基本构件，原语类型即最基本的类型。

奉奤奲奩女文件由一个可选的模块声明（此处为 module Prims），一个可选的导入列表，一组声明及其定义
构成。在本例中并未指定导入。奉奤奲奩女 可由多个模块构成， 每个模块中的每个定义都有它自己的命名空
间。这点会在 模块与命名空间 夨姩妡妵 夲夹天 一节中进一步讨论。在编写 奉奤奲奩女 程序时，声明的顺序和缩进都
很重要。 函数和数据类型必须先定义再使用，每个定义都必须有类型声明，例如之前列出的 x : Int
和 foo : String。新声明的缩进级别必须与之前的声明相同。 此外，分号 ; 也可用于结束声明。

库模块 Prelude 会在每个 奉奤奲奩女 程序中自动导入，包括 奉奏 功能，算术运算， 数据结构以及多种通用函
数。奐奲奥奬奵奤奥 中定义了一些算术和比较运算符， 我们可以在提示符中使用它们。在提示符中进行求值会
给出一个答案及其类型。例如：

*prims> 6*6+6
42 : Integer
*prims> x == 6*6+6
True : Bool

奉奤奲奩女 为原语类型定义了所有的普通算术和比较运算。它们通过接口进行了重载， 并可被扩展以适用于
用户定义的类型，这点我们会在 接口 夨姩妡妵 夲失天 一节中讨论。布尔表达式可通过 if...then...else 构
造来测试，例如：

*prims> if x == 6 * 6 + 6 then "The answer!" else "Not the answer"
"The answer!" : String

1.3.2 数数数据据据类类类型型型

数据类型的声明方式和语法与 奈奡女奫奥奬奬 非常相似。例如，自然数和列表的声明如下：

data Nat = Z | S Nat -- 自然数（零与后继）
data List a = Nil | (::) a (List a) -- 多态列表

以上声明来自于标准库。一进制自然数要么为零（Z）， 要么就是另一个自然数的后继（S k）；列表
要么为空（Nil）， 要么就是一个值被添加在另一个列表之前（x :: xs）。 在 List 的声明中，我们
使用了中缀操作符 ::。 像这样的新操作符可通过缀序声明（奆奩奸奩奴她 奄奥奣奬奡奲奡奴奩奯奮）来添加，如下所示：

1.3. 类类类型型型与与与函函函数数数 5
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infixr 10 ::

函数、数据构造器与类型构造器均可用名字作为中缀操作符。它们被括在括号中时， 也可作为前缀形
式使用，例如 (::)。中缀操作符可使用下面的任何符号：

:+-*\/=.?|&><!@$%^~#

有些以这些符号构成的操作符无法被用户定义。它们是 :、=>、->、<-、=、?=、|、**、
==>、\、%、~、? 以及 !。

1.3.3 函函函数数数

函数通过模式匹配（奐奡奴奴奥奲奮 奍奡奴奣奨奩奮奧）实现，语法同样和 奈奡女奫奥奬奬 类似。 其主要的不同在于 奉奤奲奩女 的
所有函数都需要类型声明，声明中使用单冒号 : （而非 奈奡女奫奥奬奬 的双冒号 :: ）。自然数的某些运算函
数定义如下，同样来自标准库：

-- 一进制加法
plus : Nat -> Nat -> Nat
plus Z y = y
plus (S k) y = S (plus k y)

-- 一进制乘法
mult : Nat -> Nat -> Nat
mult Z y = Z
mult (S k) y = plus y (mult k y)

标准算术运算符 + 和 * 同样根据 Nat 的需要进行了重载， 它们使用上面的函数来定义。和 奈奡女奫奥奬奬
不同的是，类型和函数名的首字母并无大小写限制。 函数名（前面的 plus 和 mult ），数据构造器
（Z、S、Nil 和 ::） 以及类型构造器（Nat 和 List）均属同一命名空间。不过按照约定， 数据类型和
构造器的名字通常以大写字母开头。我们可以在 奉奤奲奩女 提示符中测试这些函数：

Idris> plus (S (S Z)) (S (S Z))
4 : Nat
Idris> mult (S (S (S Z))) (plus (S (S Z)) (S (S Z)))
12 : Nat

注注注解解解: 在显示一个 Nat 元素，如 (S (S (S (S Z)))) 时，奉奤奲奩女 会将其显示为 4。 plus (S (S Z))
(S (S Z)) 的结果实际上为 (S (S (S (S Z))))， 即自然数 4。这点可在 奉奤奲奩女 提示符中验证：

Idris> (S (S (S (S Z))))
4 : Nat

和算术运算符一样，整数字面也可通过接口重载，因此我们也能像下面这样测试函数：

Idris> plus 2 2
4 : Nat
Idris> mult 3 (plus 2 2)
12 : Nat

你可能会很好奇，既然计算机已经完美内建了整数运算，我们为何还需要一进制的自然数？ 主要的原
因在于一进制数的结构非常便于推理，而且易与其它数据结构建立联系， 我们之后就会看到。尽管如
此，我们并不希望以牺牲效率为代价获得这种便捷。幸运的是， 奉奤奲奩女 知道 Nat （以及类似的结构化类
型）和数之间的联系， 这意味着 奉奤奲奩女 可以优化它们的表示以及像 plus 和 mult 这样的函数。

1.3. 类类类型型型与与与函函函数数数 6
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where 从从从句句句

函数也可通过 where 从句来 局局局部部部 地定义。例如，要定义用来反转列表的函数， 我们可以使用辅助函数
来累加新的，反转后的列表，并且它无需全局可见：

reverse : List a -> List a
reverse xs = revAcc [] xs where
revAcc : List a -> List a -> List a
revAcc acc [] = acc
revAcc acc (x :: xs) = revAcc (x :: acc) xs

缩进是十分重要的，where 块中函数的缩进层次必须比外层函数更深。

注注注解解解: 作用域

任何外层作用域中可见，且没有被重新被定义过的名字，在 where 从句中也可见 （这里的 xs 被重新定
义了）。若某个名字是某个类型的 形形形参参参（（（Parameter））），那么仅当它在类型中出现时才会在 where 从
句的作用域中，即，它在整体结构中是固定不变的。

除函数外，where 块中也可包含局部数据声明，以下代码中的的 MyLT 就无法在 foo 的定义之外访问。

foo : Int -> Int
foo x = case isLT of

Yes => x*2
No => x*4

where
data MyLT = Yes | No

isLT : MyLT
isLT = if x < 20 then Yes else No

通常，where 从句中定义的函数和其它顶层函数一样，都需要类型声明。 然而，函数 f 的类型声明可
在以下情况中省略：

• f 出现在顶层定义的右边

• f 的类型完全可以通过其首次应用来确定

因此，举例来说，以下定义是合法的：

even : Nat -> Bool
even Z = True
even (S k) = odd k where

odd Z = False
odd (S k) = even k

test : List Nat
test = [c (S 1), c Z, d (S Z)]

where c x = 42 + x
d y = c (y + 1 + z y)

where z w = y + w

坑坑坑

奉奤奲奩女 程序中可以挖 坑坑坑（（（Hole））） 来表示未完成的部分。例如，我们可以在「奈奥奬奬奯 奷奯奲奬奤」 程序中为问
候语 greeting 挖一个坑：

1.3. 类类类型型型与与与函函函数数数 7
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main : IO ()
main = putStrLn ?greeting

语法 ?greeting 挖了个坑，它表示程序中尚未写完的部分。这是个有效的 奉奤奲奩女 程序，你可以检查
greeting 的类型：

*Hello> :t greeting
--------------------------------------
greeting : String

检查坑的类型也会显示作用域中所有变量的类型。例如，给定一个未完成的 even 定义：

even : Nat -> Bool
even Z = True
even (S k) = ?even_rhs

我们可以检查 even_rhs 的类型，查看期望的返回类型，以及变量 k 的类型：

*Even> :t even_rhs
k : Nat

--------------------------------------
even_rhs : Bool

坑非常有用，因为它能帮助我们 逐逐逐步步步地地地 编写函数。我们无需一次写完整个函数， 而是留下一些尚未编
写的部分，让 奉奤奲奩女 告诉我们如何完成其定义。

提提提示示示: 奬奨女（奬奥奦奴 奨奡奮奤 女奩奤奥） 与 奲奨女（奲奩奧奨奴 奨奡奮奤 女奩奤奥）分别表示等式中等号的左边和右边， 即左式和右
式。

1.3.4 依依依赖赖赖类类类型型型

一一一等等等类类类型型型

在 奉奤奲奩女 中，类型是一等（奆奩奲女奴夭奃奬奡女女）的，即它们可以像其它的语言构造那样被计算和操作 （以及传
给函数）。例如，我们可以编写一个用来计算类型的函数：

isSingleton : Bool -> Type
isSingleton True = Nat
isSingleton False = List Nat

该函数可从一个 Bool 值计算出适当的类型，布尔值表示其类型是否为一个单例（奓奩奮奧奬奥奴奯奮）。 我们可
以在任何能够使用类型的地方用该函数计算出一个类型。例如，它可用于计算返回类型：

mkSingle : (x : Bool) -> isSingleton x
mkSingle True = 0
mkSingle False = []

它也可拥有不同的输入类型。以下函数能够计算 Nat 列表之和，或者返回给定的 Nat，这取决于单例标
记 single 是否为 True：

sum : (single : Bool) -> isSingleton single -> Nat
sum True x = x
sum False [] = 0
sum False (x :: xs) = x + sum False xs

1.3. 类类类型型型与与与函函函数数数 8
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向向向量量量

依赖类型的一个范例就是「带长度的列表」类型，在依赖类型的文献中， 它通常被称作向量
（奖奥奣奴奯奲）。向量作为 奉奤奲奩女 库的一部分，可通过导入 Data.Vect 来使用，当然我们也自己声明
它：

data Vect : Nat -> Type -> Type where
Nil : Vect Z a
(::) : a -> Vect k a -> Vect (S k) a

注意我们使用了与 List 相同的构造器名。只要名字声明在不同的命名空间内 （在实践中，通常在不同
的模块内），奉奤奲奩女 就能接受像这样的特设（奡奤夭奨奯奣）名重载。 有歧义的构造器名称通常可根据上下文
来解决。

这里声明了一个类型族（奔她奰奥 奆奡奭奩奬她），该声明的形式与之前的简单类型声明不太一样。 我们显式地
描述了类型构造器 Vect 的类型，它接受一个 Nat 和一个类型作为参数，其中 Type 表示类型的类型。
我们说 Vect 通过 Nat 来 索索索引引引，并被 Type 参参参数数数化化化 。 每个构造器会产生该类型家族的不同部分。 Nil
只能用于构造零长度的向量， 而 :: 用于构造非零长度的向量。在 :: 的类型中，我们显式地指定了一
个类型为 a 的元素和一个类型为 Vect k a 的尾部（奔奡奩奬）（即长度为 k 的向量）， 二者构成了一个长
度为 S k 的向量。

同 List 以及 Nat 这类简单类型一样，我们可以通过模式匹配以同样的方式为 Vect 这样的依赖类型定
义函数。 作用于 Vect 的函数的类型能够描述所涉及向量的长度会如何变化。例如，下面定义的 ++ 用
于连接两个 Vect：

(++) : Vect n a -> Vect m a -> Vect (n + m) a
(++) Nil ys = ys
(++) (x :: xs) ys = x :: xs ++ ys

(++) 的类型描述了结果向量的长度必须为输入向量的长度之和。 如果我们以某种方式给出了错误的定
义使其不成立，那么 奉奤奲奩女 就不会接受该定义。 例如：

(++) : Vect n a -> Vect m a -> Vect (n + m) a
(++) Nil ys = ys
(++) (x :: xs) ys = x :: xs ++ xs -- 有误

在经由 奉奤奲奩女 类型检查器检查时，它会给出以下结果：

$ idris VBroken.idr --check
VBroken.idr:9:23-25:
When checking right hand side of Vect.++ with expected type

Vect (S k + m) a

When checking an application of constructor Vect.:::
Type mismatch between

Vect (k + k) a (Type of xs ++ xs)
and

Vect (plus k m) a (Expected type)

Specifically:
Type mismatch between

plus k k
and

plus k m

该错误信息指出两个向量的长度不匹配：我们需要一个长度为 k + m 的向量， 而你提供了一个长度为
k + k 的向量。

1.3. 类类类型型型与与与函函函数数数 9
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有有有限限限集集集

有限集，顾名思义，即元素有限的集合。它作为 奉奤奲奩女 库的一部分，可通过导入 Data.Fin 来使用，当
然也可以像下面这样声明它：

data Fin : Nat -> Type where
FZ : Fin (S k)
FS : Fin k -> Fin (S k)

从它的签名中，我们可以看出该类型构造器接受一个 Nat，然后产生一个 类类类型型型 。 因此，它不是一个
「对象的容器」意义上的集合，而是个拥有无名元素的一般集合。举例来说， 就是「存在一个包含五
个元素的集合」的那种集合。实际上，它是一个捕获了所有落入零至 (n - 1) 范围内的整数的类型，其
中 n 是用于实例化 Fin 类型的参数。例如， Fin 5 可被视作从 夰 到 头 之间的整数的类型。

我们来仔细地观察一下它的构造器。

对于拥有 S k 个元素的有限集来说，FZ 是它的第零个元素， FS n 则是它的第 n+1 个元素。 Fin 通过
Nat 来索引， 它表示该集合中元素的个数。由于我们无法构造出属于空集的元素，因此也就无法构造出
Fin Z。

如之前提到的， Fin 家族的用途之一在于表示有界的自然数集。由于前 n 个自然数构成了一个含有 n
个元素的有限集，我们可以将 Fin n 视作大于等于零且小于 n 的整数集。

例如，下面的函数根据给定的有界索引 Fin n 找出 Vect 中的元素， 它在 奐奲奥奬奵奤奥 中定义为：

index : Fin n -> Vect n a -> a
index FZ (x :: xs) = x
index (FS k) (x :: xs) = index k xs

该函数从一个向量中找出给定位置的值。位置的边界由该向量的长度所界定 （每种情况下都是 n ），
因此无需在运行时进行边界检查。类型检查器保证了位置不会大于该向量的长度，当然也不会小于零。

注意这里也没有 Nil 的情况，因为这种情况不可能存在。 由于没有类型为 Fin Z 且位置为 Fin n 的元
素，因此 n 不可能是 Z。 因此，如果你试图在一个空向量中查找元素，就会得到一个编译时的类型错
误， 因为这样做会强行令 n 为 Z。

隐隐隐式式式参参参数数数

我们再仔细观察一下 index 的类型：

index : Fin n -> Vect n a -> a

它接受两个参数：一个类型为 n元素有限集的元素，以及一个类型为 a的 n元素向量。不过这里还有两
个名字：n 和 a，它们未被显式地声明。index 包含了 隐隐隐式式式 参数。我们也可以将 index 的类型写作：

index : {a:Type} -> {n:Nat} -> Fin n -> Vect n a -> a

隐式参数在类型声明的大括号 {} 中给定，它们并没有在应用 index 时给出， 因为它们的值可以从 Fin
n 和 Vect n a 的参数类型中推导出来。 任何以小写字母开头，在类型声明中作为形参和索引出现的名
字都不会应用到任何实参上， 它们 总总总是是是 会作为隐式参数被自动绑定。隐式参数仍然可以在应用时通过
{a=value} 和 {n=value} 来显式地给定，例如：

index {a=Int} {n=2} FZ (2 :: 3 :: Nil)

实际上，无论是隐式还是显式，任何参数都可以给定一个名称。我们可以将 index 声明成这样：

1.3. 类类类型型型与与与函函函数数数 10
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index : (i:Fin n) -> (xs:Vect n a) -> a

写不写它纯属偏好问题，不过有时它能让参数更加明确，有助于函数文档的记录。

此外， {} 在等号左边时可用作模式匹配，即 {var = pat} 获取一个隐式变量， 并试图对「奰奡奴」进行
模式匹配。例如：

isEmpty : Vect n a -> Bool
isEmpty {n = Z} _ = True
isEmpty {n = S k} _ = False

「「「using」」」记记记法法法

有时为隐式参数提供类型会十分有用，特别是存在依赖顺序，或隐式参数本身含有依赖的情况下。 例
如，我们可能希望在以下定义中指明隐式参数的类型，它为向量定义了前提（它也在 Data.Vect 的
Elem 下定义）：

data IsElem : a -> Vect n a -> Type where
Here : {x:a} -> {xs:Vect n a} -> IsElem x (x :: xs)
There : {x,y:a} -> {xs:Vect n a} -> IsElem x xs -> IsElem x (y :: xs)

IsElem x xs 的实例描述了 x 是 xs 中的一个元素。我们可以构造这样的谓词： 若所需的元素在向量的
头部时为 Here，在向量的尾部中时则为 There。例如：

testVec : Vect 4 Int
testVec = 3 :: 4 :: 5 :: 6 :: Nil

inVect : IsElem 5 Main.testVec
inVect = There (There Here)

重重重要要要: 隐式参数与作用域

在类型签名中，类型检查器会将所有以小写字母开头 并并并且且且 没有应用到别的东西上的变量 视作隐式变
量。要让上面的代码示例能够编译，你需要为 testVec 提供一个限定名。 在前面的例子中，我们假设
该代码处于 Main 模块内。

如果大量使用相同的隐式参数，就会导致定义难以阅读。为避免此问题，可使用 using 块来为任何在块
中出现的隐式参数指定类型和顺序：

using (x:a, y:a, xs:Vect n a)
data IsElem : a -> Vect n a -> Type where

Here : IsElem x (x :: xs)
There : IsElem x xs -> IsElem x (y :: xs)

注：声明顺序与 mutual 互用块

通常，函数与数据类型必须在使用前定义，因为依赖类型允许函数作为类型的一部分出现， 而类型检
查会依赖于特定的函数如何定义（尽管这只对全函数成立，见 完全性检查 夨姩妡妵 头头天）。 然而，此限制
可通过使用 mutual 互用块来放宽，它允许数据类型和函数同时定义：

mutual
even : Nat -> Bool

(äÿŃéąțçżğçżŋ)
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(çżŋäÿŁéąț)

even Z = True
even (S k) = odd k

odd : Nat -> Bool
odd Z = False
odd (S k) = even k

在 mutual 块中，首先所有的类型声明会被添加，然后是函数体。 因此，没有一个函数类型可以依赖于
块中任何函数的归约行为。

1.3.5 I/O

如果计算机程序不能通过某种方式与用户或系统进行交互，那么它基本上没什么用。在 奉奤奲奩女 这样纯粹
（奐奵奲奥）的语言中，表达式没有副作用（奓奩奤奥夭奅夛奥奣奴）。而 奉夯奏 的难点在于它本质上是带有副作用的。
因此在 奉奤奲奩女 中，这样的交互被封装在 IO 类型中：

data IO a -- IO 操作返回一个类型为 a 的值

我们先给出 IO 抽象的定义，它本质上描述了被执行的 奉夯奏 操作是什么， 而非如何去执行它们。最终操
作则由运行时系统在外部执行。我们已经见过一个带 奉奏 的程序了：

main : IO ()
main = putStrLn "Hello world"

putStrLn 的类型描述了它接受一个字符串，然后通过 奉夯奏 活动返回一个单元类型 () 的元素。它还有
一个变体 putStr 用来输出字符串但不换行。

putStrLn : String -> IO ()
putStr : String -> IO ()

我们可以从用户的输入中读取字符串：

getLine : IO String

奐奲奥奬奵奤奥 中定义了很多 奉夯奏 操作，例如为了读写文件，需要包含：

data File -- abstract
data Mode = Read | Write | ReadWrite

openFile : (f : String) -> (m : Mode) -> IO (Either FileError File)
closeFile : File -> IO ()

fGetLine : (h : File) -> IO (Either FileError String)
fPutStr : (h : File) -> (str : String) -> IO (Either FileError ())
fEOF : File -> IO Bool

注意其中几个函数会返回 Either ，因为它们可能会失败。

1.3.6 「「「do」」」记记记法法法

奉夯奏 程序通常需要串连起多个活动，将一个计算的输出送入下一个计算的输入中。 然而，IO 是一个抽
象类型，因此我们无法直接访问一个计算的结果。 因此，我们用 do夭记法来串连起操作：

1.3. 类类类型型型与与与函函函数数数 12
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greet : IO ()
greet = do putStr "What is your name? "

name <- getLine
putStrLn ("Hello " ++ name)

语法 x <- iovalue 执行 IO a 类型的 奉夯奏 操作 iovalue，然后将类型为 a 的结果送入变量 x 中。在这
种情况下，getLine 会返回一个 IO String，因此 name 的类型为 String。缩进十分重要： 奤奯 语句块
中的每个语句都必须从同一列开始。pure 操作允许我们将值直接注入到 奉奏 操作中：

pure : a -> IO a

后面我们会看到，do夭记法比这里的展示更加通用，并且可以被重载。

1.3.7 惰惰惰性性性

通常，函数的参数会在函数被调用前求值（也就是说，奉奤奲奩女 采用了 及及及早早早（（（Eager））） 求值策略）。然
而，这并不总是最佳的方式。考虑以下函数：

ifThenElse : Bool -> a -> a -> a
ifThenElse True t e = t
ifThenElse False t e = e

该函数会使用参数 t 或 e 二者之一，而非二者都用（我们之后会看到其实它被用于实现 if...then...
else 构造）。我们更希望 只只只有有有 用到的参数才被求值。为此， 奉奤奲奩女 提供了 Lazy 数据类型，它允许暂
缓求值：

data Lazy : Type -> Type where
Delay : (val : a) -> Lazy a

Force : Lazy a -> a

类型为 Lazy a 的值只有通过 Force 强制求值时才会被求值。奉奤奲奩女 类型检查器知道 Lazy 类型，并会在
必要时在 Lazy a 和 a 之间插入转换， 反之亦同。因此我们可以将 ifThenElse 写成下面这样，无需任
何 Force 或 Delay 的显式使用：

ifThenElse : Bool -> Lazy a -> Lazy a -> a
ifThenElse True t e = t
ifThenElse False t e = e

1.3.8 余余余数数数据据据类类类型型型

我们可以通过余数据类型，将递归参数标记为潜在无穷来定义无穷数据结构。对于一个余数据类型 T，
其每个构造器中类型为 T 的参数都会被转换成类型为 Inf T 的参数。 这会让每个 T 类型的参数惰性
化，使得类型为 T 的无穷数据结构得以构建。 余数据类型的一个例子为 Stream，其定义如下：

codata Stream : Type -> Type where
(::) : (e : a) -> Stream a -> Stream a

它会被编译器翻译成下面这样：

data Stream : Type -> Type where
(::) : (e : a) -> Inf (Stream a) -> Stream a

以下是如何用余数据类型 Stream 来构建无穷数据结构的例子。 在这里我们创建了一个 失 的无穷流：

1.3. 类类类型型型与与与函函函数数数 13
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ones : Stream Nat
ones = 1 :: ones

要重点注意：余数据类型不允许创建互用的无穷递归数据结构。 例如，以下代码会创建一个无穷循环
并导致栈溢出：

mutual
codata Blue a = B a (Red a)
codata Red a = R a (Blue a)

mutual
blue : Blue Nat
blue = B 1 red

red : Red Nat
red = R 1 blue

mutual
findB : (a -> Bool) -> Blue a -> a
findB f (B x r) = if f x then x else findR f r

findR : (a -> Bool) -> Red a -> a
findR f (R x b) = if f x then x else findB f b

main : IO ()
main = do printLn $ findB (== 1) blue

为了修复它，我们必须为构造器参数的类型显式地加上 Inf 声明，因为余数据类型 不会将它添加到和
正在定义的构造器类型 不不不同同同 的构造器参数上。例如，以下程序输出「失」。

mutual
data Blue : Type -> Type where
B : a -> Inf (Red a) -> Blue a

data Red : Type -> Type where
R : a -> Inf (Blue a) -> Red a

mutual
blue : Blue Nat
blue = B 1 red

red : Red Nat
red = R 1 blue

mutual
findB : (a -> Bool) -> Blue a -> a
findB f (B x r) = if f x then x else findR f r

findR : (a -> Bool) -> Red a -> a
findR f (R x b) = if f x then x else findB f b

main : IO ()
main = do printLn $ findB (== 1) blue

提提提示示示: 「归纳数据类型」和「余归纳数据类型」

余数据类型（奃奯奤奡奴奡 奔她奰奥）的全称为余归纳数据类型（奃奯奩奮奤奵奣奴奩奶奥 奄奡奴奡 奔她奰奥）， 归纳数据类型和
余归纳数据类型是对偶的关系。从语义上看， 奉奮奤奵奣奴奩奶奥 奔她奰奥 描述了如何从更小的 奴奥奲奭 构造出更大的
奴奥奲奭；而 奃奯奩奮奤奵奣奴奩奶奥 奔她奰奥 则描述了如何从更大的 奴奥奲奭 分解成更小的 奴奥奲奭。 二者即为塔斯基不动点

1.3. 类类类型型型与与与函函函数数数 14
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定理中的最大不动点（对应余归纳）和最小不动点（对应归纳）。 参考自 奂奥奬奬奥奶奥 的回答。

1.3.9 常常常用用用数数数据据据类类类型型型

奉奤奲奩女 包含了很多常用的数据类型和库函数（见发行版中的 libs/ 目录及 文档 ）。本节描述了其中的一
部分。 作为 Prelude.idr 的一部分，下面描述的函数都会被每个 奉奤奲奩女 程序自动导入，

List 与与与 Vect

我们已经见过 List 和 Vect 数据类型了：

data List a = Nil | (::) a (List a)

data Vect : Nat -> Type -> Type where
Nil : Vect Z a
(::) : a -> Vect k a -> Vect (S k) a

注意它们的构造器名称是相同的：只要构造器名称在不同的命名空间中声明， 它们就可以被重载（其
实一般的名字都可以），并且通常会根据其类型来确定。 作为一种语法糖，任何带有 Nil 和 :: 构造其
名的类型都可被写成列表的形式。 例如：

• [] 表示 Nil

• [1,2,3] 表示 1 :: 2 :: 3 :: Nil

库中还定义了一些用于操作这些类型的函数。 map 对 List 和 Vect 都进行了重载，它将一个函数应用
到列表或向量中的每个元素上。

map : (a -> b) -> List a -> List b
map f [] = []
map f (x :: xs) = f x :: map f xs

map : (a -> b) -> Vect n a -> Vect n b
map f [] = []
map f (x :: xs) = f x :: map f xs

例如，给定以下整数向量，以及一个将整数乘以 夲 的函数：

intVec : Vect 5 Int
intVec = [1, 2, 3, 4, 5]

double : Int -> Int
double x = x * 2

函数 map 可像下面这样将该向量中的每个元素乘以二：

*UsefulTypes> show (map double intVec)
"[2, 4, 6, 8, 10]" : String

更多可用于 List 和 Vect 的函数的详情请参阅以下库文件：

• libs/prelude/Prelude/List.idr

• libs/base/Data/List.idr

• libs/base/Data/Vect.idr
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• libs/base/Data/VectType.idr

其中包括过滤、追加、反转等函数。

题外话：匿名函数与操作符段

上面的表达式其实还有更加利落的写法。其中一种就是使用匿名函数（奁奮奯奮她奭奯奵女 奆奵奮奣奴奩奯奮）：

*UsefulTypes> show (map (\x => x * 2) intVec)
"[2, 4, 6, 8, 10]" : String

记法 \x => val 构造了一个匿名函数，它接受一个参数 x 并返回表达式 val。 匿名函数可以接受多个
参数，它们以逗号分隔，如 \x, y, z => val。 参数也可以显式地给定类型，如 \x : Int => x *
2，也可使用模式匹配，如 \(x, y) => x + y。

*UsefulTypes> show (map (* 2) intVec)
"[2, 4, 6, 8, 10]" : String

(*2) 是将数字乘以 夲 的函数的简写，它会被展开为 \x => x * 2。 同样，(2*) 会被展开为 \x => 2
* x。

提提提示示示: 匿名函数在函数式编程中又称为 𝜆夭表达式（奌奡奭奢奤奡 奅奸奰奲奥女女奩奯奮）。

Maybe

Maybe 描述了可选值，表示给定类型的值是否存在：

data Maybe a = Just a | Nothing

Maybe 是一种为可能失败的操作赋予类型的方式。例如，在 List （而非向量）中查找时可能会产生越
界错误：

list_lookup : Nat -> List a -> Maybe a
list_lookup _ Nil = Nothing
list_lookup Z (x :: xs) = Just x
list_lookup (S k) (x :: xs) = list_lookup k xs

maybe 函数用于处理 Maybe 类型的值，如果值存在就对其应用一个函数， 否则提供一个默认值：

maybe : Lazy b -> Lazy (a -> b) -> Maybe a -> b

注意前两个参数的类型被封装在 Lazy 内。由于二者只有其一会被使用， 而计算完大型表达式之后就丢
弃会造成浪费，因此我们将它们标记为 Lazy。

元元元组组组

值可以通过以下内建的数据类型构成序对（奐奡奩奲）：

data Pair a b = MkPair a b

序对的语法糖可以写成 (a, b)，根据上下文，其意思为 Pair a b 或 MkPair a b。元组（奔奵奰奬奥）可
包含任意个数的值，它通过嵌套的序对来表示：
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fred : (String, Int)
fred = ("Fred", 42)

jim : (String, Int, String)
jim = ("Jim", 25, "Cambridge")

*UsefulTypes> fst jim
"Jim" : String
*UsefulTypes> snd jim
(25, "Cambridge") : (Int, String)
*UsefulTypes> jim == ("Jim", (25, "Cambridge"))
True : Bool

依依依赖赖赖序序序对对对

依赖序对允许序对第二个元素的类型依赖于第一个元素的值。

data DPair : (a : Type) -> (P : a -> Type) -> Type where
MkDPair : {P : a -> Type} -> (x : a) -> P x -> DPair a P

同样，它也有语法糖。(a : A ** P)表示由 奁和 奐构成的序对的类型，其中名字 a可出现在 P中。(
a ** p ) 会构造一个该类型的值。例如， 我们可以将一个数和一个特定长度的 Vect 构造成一个序
对：

vec : (n : Nat ** Vect n Int)
vec = (2 ** [3, 4])

如果你喜欢，也可以把它写成较长的形式，二者完全等价：

vec : DPair Nat (\n => Vect n Int)
vec = MkDPair 2 [3, 4]

当然，类型检查器可以根据向量的的长度推断出第一个元素的值。 我们可以在希望类型检查器填写值
的地方写一个下划线 _，这样上面的定义也可以写作：

vec : (n : Nat ** Vect n Int)
vec = (_ ** [3, 4])

有时我们也更倾向于省略该序对第一个元素的类型，同样，它也可以被推断出来：

vec : (n ** Vect n Int)
vec = (_ ** [3, 4])

依赖序对的一个用处就是返回依赖类型的值，其中的索引未必事先知道。例如， 若按照某谓词过滤出
Vect 中的元素，我们不会事先知道结果向量的长度：

filter : (a -> Bool) -> Vect n a -> (p ** Vect p a)

如果 Vect 为空，结果很简单：

filter p Nil = (_ ** [])

在 :: 的情况下，我们需要检查 filter 递归调用的结果来提取结果的长度和向量。 为此，我们使用
with 记法，它允许我们对中间值进行模式匹配：
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filter p (x :: xs) with (filter p xs)
| ( _ ** xs' ) = if (p x) then ( _ ** x :: xs' ) else ( _ ** xs' )

我们之后会看到 with 的更多详情。

依赖序对有时被称作「奓奩奧奭奡 类型」。

记记记录录录

记记记录录录（（（Record））） 数据类型将多个值（记录的 字字字段段段（（（Field））））收集在一起。 奉奤奲奩女 提供了定义记录的
语法，它也会自动生成用于访问和更新字段的函数。 和数据结构的语法不同，奉奤奲奩女 中的记录遵循与
奈奡女奫奥奬奬 中看起来不同的语法。 例如，我们可以将一个人的名字和年龄用记录表示：

record Person where
constructor MkPerson
firstName, middleName, lastName : String
age : Int

fred : Person
fred = MkPerson "Fred" "Joe" "Bloggs" 30

构造器名称由 constructor 关键字确定，字字字段段段 在 where 关键字之后的缩进块中给定（此处为
firstName、middleName、lastName 以及 age）。

*Record> firstName fred
"Fred" : String
*Record> age fred
30 : Int
*Record> :t firstName
firstName : Person -> String

我们也可以用字段名来更新一个记录（确切来说，会产生一个更新了给定字段的记录的副本）：

*Record> record { firstName = "Jim" } fred
MkPerson "Jim" "Joe" "Bloggs" 30 : Person
*Record> record { firstName = "Jim", age $= (+ 1) } fred
MkPerson "Jim" "Joe" "Bloggs" 31 : Person

语法 record { field = val, ... } 会生成一个更新了记录中给定字段的函数。= 为字段赋予新值，
而 $= 通过应用一个函数来更新其值。

每个记录在它自己的命名空间中定义，这意味着字段名可在多个记录中重用。

记录以及记录中的字段可拥有依赖类型。更新允许更改字段的类型，前提是结果是良类型的。

record Class where
constructor ClassInfo
students : Vect n Person
className : String

将 students 的字段更新为不同长度的向量是安全的，因为它不会影响该记录的类型：

addStudent : Person -> Class -> Class
addStudent p c = record { students = p :: students c } c

*Record> addStudent fred (ClassInfo [] "CS")
ClassInfo [MkPerson "Fred" "Joe" "Bloggs" 30] "CS" : Class

1.3. 类类类型型型与与与函函函数数数 18



Idris 语语语言言言文文文档档档, 版版版本本本 1.3.1

我们也可以用 $= 来更简洁地定义 addStudent：

addStudent' : Person -> Class -> Class
addStudent' p c = record { students $= (p ::) } c

嵌套记录的更新

奉奤奲奩女 也提供了便于访问和更新嵌套记录的语法。例如，若一个字段可以通过表达式 c (b (a x)) 访
问，那么它就可通过以下语法更新：

record { a->b->c = val } x

这会返回一个新的记录，通过路径 a->b->c 访问的字段会被设置为 val。 该语法是一等的，即 record
{ a->b->c = val } 本身拥有一个函数类型。 与此对应，你也可以使用以下语法访问该字段：

record { a->b->c } x

$= 记法对嵌套记录的更新亦有效。

依依依赖赖赖记记记录录录

记录也可依赖于值。记录拥有 形形形参参参，它无法像其它字段那样更新。 形参作为结果类型的参数出现，写
在记录类型名之后。例如，一个序对类型可定义如下：

record Prod a b where
constructor Times
fst : a
snd : b

使用前面的 class 记录，班级的大小可用 Vect 及通过 女奩奺奥 参数化该记录的大小来限制其类型。例如：

record SizedClass (size : Nat) where
constructor SizedClassInfo
students : Vect size Person
className : String

注注注意意意 它无法再使用之前的 addStudent 函数了，因为这会改变班级的大小。 现在用于添加学生的函数
必须在类型中指定班级的大小加一。由于其大小用自然数指定， 新的值可使用 S 构造器递增：

addStudent : Person -> SizedClass n -> SizedClass (S n)
addStudent p c = SizedClassInfo (p :: students c) (className c)

1.3.10 更更更多多多表表表达达达式式式

let 绑绑绑定定定

中间值可使用 let 绑定来计算：

mirror : List a -> List a
mirror xs = let xs' = reverse xs in

xs ++ xs'

我们也可以在 let 绑定中进行简单的模式匹配。例如，我们可以按如下方式从记录中提取字段， 也可
以通过顶层的模式匹配来提取字段：
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data Person = MkPerson String Int

showPerson : Person -> String
showPerson p = let MkPerson name age = p in

name ++ " is " ++ show age ++ " years old"

列列列表表表推推推导导导

奉奤奲奩女 提供了 推推推导导导 记法作为构建列表的简便写法。一般形式为：

[ expression | qualifiers ]

它会根据逗号分隔的限定式 qualifiers 给定的条件，通过求值表达式 expression 产生的值来生成列
表。例如，我们可以按如下方式构建构建勾股三角的列表：

pythag : Int -> List (Int, Int, Int)
pythag n = [ (x, y, z) | z <- [1..n], y <- [1..z], x <- [1..y],

x*x + y*y == z*z ]

[a..b] 是另一种构建从 a 到 b 的数列的简便记法。此外， [a,b..c] 以 a，b 之差为增量，构建
从 a 到 c 的数列。 它可作用于 Nat、Int 以及 Integer，它们使用了 奐奲奥奬奵奤奥 中的 enumFromTo 与
enumFromThenTo 函数。

提提提示示示: 推导式

推导式（奃奯奭奰奲奥奨奥奮女奩奯奮）来源于集合的构建方法，即 {x|x∈XΦ(x)}，其中的 Φ(x) 即为限定式
（契奵奡奬奩夜奥奲）。详情参见 维基百科 。

case 表表表达达达式式式

另一种检查 简简简单单单 类型的中间值的方法是使用 case 表达式。例如， 以下函数在给定的字符处将字符串
分为两部分：

splitAt : Char -> String -> (String, String)
splitAt c x = case break (== c) x of

(x, y) => (x, strTail y)

break 是个库函数，它从给定的函数返回 奴奲奵奥 的位置将字符串分为一个字符串的序对。 我们接着解构
它返回的序对，并移除第二个字符串的第一个字符。

一个 case 表达式可匹配多种情况，例如去检查一个类型为 Maybe a 的中间值。 回想 list_lookup，
它按索引查找列表中的元素，若索引越界则返回 Nothing。 我们可以用它来编写 lookup_default，该
函数按索引查找元素，若索引越界则返回默认值：

lookup_default : Nat -> List a -> a -> a
lookup_default i xs def = case list_lookup i xs of

Nothing => def
Just x => x

若索引在界内，我们就会获得该索引对应的值，否则就会获得默认值：

*UsefulTypes> lookup_default 2 [3,4,5,6] (-1)
5 : Integer

(äÿŃéąțçżğçżŋ)
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(çżŋäÿŁéąț)

*UsefulTypes> lookup_default 4 [3,4,5,6] (-1)
-1 : Integer

限限限制制制：：： case 构造用于对中间表达式进行简单的分析，以此避免编写辅助函数， 它也在内部用于实现
let 和 𝜆夭绑定的模式匹配。它 仅仅仅 在以下情况中可用：

• 每个分支 匹匹匹配配配 一个相同类型的值，并 返返返回回回 一个相同类型的值。

• 结果的类型是「已知」的，即表达式的类型无需对该 case 表达式进行类型检查就能确定。

1.3.11 完完完全全全性性性

奉奤奲奩女 区分 完完完全全全（（（全全全，，，Total））） 函数与 部部部分分分（（（偏偏偏，，，Partial））） 函数。 全函数满足以下情况之一：

• 对于所有可能的输入都会终止，或

• 产生一个非空的，有限的，可能为无限结果的前缀

若一个函数是完全的，我们可以认为其类型精确描述了该函数会做什么。例如， 若我们有一个返回类
型为 String 的函数，根据它是否完全，我们能知道的东西会有所不同：

• 若它是全函数，就会在有限的时间内返回一个类型为 String 的值；

• 若它是偏函数，那么只要它不崩溃或进入无限循环，就会返回一个 String。

奉奤奲奩女 对此作了区分，因此它知道在进行类型检查（正如我们在 一等类型 夨姩妡妵 夸天 一节所见）的时候，哪
些函数可以安全地求值。毕竟，若它在类型检查时试图对一个不终止的函数求值， 那么类型检查将无
法终止！因此，在类型检查时只有全函数才会被求值。偏函数仍然可在类型中使用， 但它们不会被进
一步求值。

1.4 接接接口口口

我们经常想要定义能够跨多种不同数据类型工作的函数。例如，我们想要算术运算符至少可以作用于
Int、Integer 和 Double。我们想要 == 作用于大部分的数据类型。 我们想要以一种统一的方式来显示
不同的类型。

为此，我们使用了 接接接口口口（（（Interface））），它类似于 奈奡女奫奥奬奬 中的类型类（奔她奰奥奣奬奡女女）或 奒奵女奴 中的特
性（奔奲奡奩奴）。为了定义接口，我们提供了一组可重载的的函数。Show 接口就是个简单的例子， 它在
奐奲奥奬奵奤奥 中定义，并提供了将值转换为 String 的接口：

interface Show a where
show : a -> String

它会生成一个类型如下的函数，我们称之为 Show 接口的 方方方法法法（（（Method）））：

show : Show a => a -> String

我们可以把它读作：「在 a 实现了 Show 的约束下，该函数接受一个输入 a 并返回一个 String。」我
们可以通过为它定义接口的方法来实现该接口。例如，Nat 的 Show 实现可定义为：

Show Nat where
show Z = "Z"
show (S k) = "s" ++ show k
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Idris> show (S (S (S Z)))
"sssZ" : String

一个类型只能实现一次某个接口，也就是说，实现无法被覆盖。实现的声明自身可以包含约束。为此，
实现的参数必须为构造器（即数据或类型构造器）或变量（也就是说，你无法为函数赋予实现）。 例
如，要为向量定义一个 Show 的实现，我们需要确认其元素实现了 Show， 因为要用它来将每个元素都
转换为 String：

Show a => Show (Vect n a) where
show xs = "[" ++ show' xs ++ "]" where

show' : Vect n a -> String
show' Nil = ""
show' (x :: Nil) = show x
show' (x :: xs) = show x ++ ", " ++ show' xs

提提提示示示: 译者更愿意将它读作：对于一个实现了 Show 的 a， Vect n a 对 Show 的实现为……

1.4.1 默默默认认认定定定义义义

库中定义了 Eq 接口，它提供了比较值是否相等的方法，所有内建类型都实现了它：

interface Eq a where
(==) : a -> a -> Bool
(/=) : a -> a -> Bool

要为类型实现一个接口，我们必须给出所有方法的定义。例如，为 Nat 实现 Eq：

Eq Nat where
Z == Z = True
(S x) == (S y) = x == y
Z == (S y) = False
(S x) == Z = False

x /= y = not (x == y)

很难想象在哪些情况下 /= 方法不是应用了 == 方法的结果的否定。 因此，利用接口声明中的某个方法
为其它方法提供默认的定义会很方便：

interface Eq a where
(==) : a -> a -> Bool
(/=) : a -> a -> Bool

x /= y = not (x == y)
x == y = not (x /= y)

Eq 的最小完整实现只需要定义 == 或 /= 二者之一，而不需要二者都定义。 若缺少某个方法定义，且存
在它的默认定义，那么就会使用该默认定义。

1.4.2 扩扩扩展展展接接接口口口

接口也可以扩展。逻辑上，相等关系 Eq 的下一步是定义排序关系 Ord。 我们可以定义一个 Ord 接口，
它除了继承 Eq 的方法外还定义了自己的方法：
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data Ordering = LT | EQ | GT

interface Eq a => Ord a where
compare : a -> a -> Ordering

(<) : a -> a -> Bool
(>) : a -> a -> Bool
(<=) : a -> a -> Bool
(>=) : a -> a -> Bool
max : a -> a -> a
min : a -> a -> a

sort : Ord a => List a -> List a

函数、接口和实现可拥有多个约束。多个约束的列表写在括号内，以逗号分隔，例如：

sortAndShow : (Ord a, Show a) => List a -> String
sortAndShow xs = show (sort xs)

注注注意意意：：：接接接口口口与与与 mutual 块块块

除 mutual 块外，奉奤奲奩女 严格遵循「先定义后使用」的规则。在 mutual 块中， 奉奤奲奩女 会分两趟进行繁释
（奥奬奡奢奯奲奡奴奥）：第一趟为类型，第二趟为定义。当互用块中包含接口声明时， 第一趟会繁释接口的头
部而不繁释方法类型；第二趟则繁释方法类型以及所有的默认定义。

1.4.3 函函函子子子与与与应应应用用用子子子

目前，我们已经见过形参类型为 Type 的单形参接口了。通常，形参的个数可为任意个 （甚至零个），
而形参也可为 任任任意意意 类型。若形参的类型不为 Type， 我们则需要提供显式的类型声明。例如，奐奲奥奬奵奤奥
中定义的函子接口 Functor 为：

interface Functor (f : Type -> Type) where
map : (m : a -> b) -> f a -> f b

函子允许函数应用到结构上，例如将一个函数应用到 List 的每一个元素上：

Functor List where
map f [] = []
map f (x::xs) = f x :: map f xs

Idris> map (*2) [1..10]
[2, 4, 6, 8, 10, 12, 14, 16, 18, 20] : List Integer

定义了 Functor 之后，我们就能定义应用子 Applicative 了， 它对函数应用的概念进行了抽象：

infixl 2 <*>

interface Functor f => Applicative (f : Type -> Type) where
pure : a -> f a
(<*>) : f (a -> b) -> f a -> f b
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1.4.4 单单单子子子与与与 do-记记记法法法

单子接口 Monad 允许我们对绑定和计算进行封装，它也是 「do」记法 夨姩妡妵 失夲天 一节中 do夭记法的基础。
单子扩展了前面定义的 Applicative，其定义如下：

interface Applicative m => Monad (m : Type -> Type) where
(>>=) : m a -> (a -> m b) -> m b

在 do 块中会应用以下语法变换：

• x <- v; e 变为 v >>= (\x => e)

• v; e 变为 v >>= (\_ => e)

• let x = v; e 变为 let x = v in e

IO 实现了 Monad，它使用原语函数定义。我们也可以为 Maybe 定义实现， 其实现如下：

Monad Maybe where
Nothing >>= k = Nothing
(Just x) >>= k = k x

通过它，我们可以定义一个将两个 Maybe Int 相加的函数，并用单子来封装错误处理：

m_add : Maybe Int -> Maybe Int -> Maybe Int
m_add x y = do x' <- x -- 从 x 中提取值

y' <- y -- 从 y 中提取值
pure (x' + y') -- 二者相加

若 x 和 y 均可用，该函数会从二者中提取出值；若其中一个或二者均不可用， 则返回 Nothing
（「奦奡奩奬夭奦奡女奴 速错原则」）。Nothing 的情况通过 >>= 操作符来管理，由 do夭记法来隐藏。

*Interfaces> m_add (Just 20) (Just 22)
Just 42 : Maybe Int
*Interfaces> m_add (Just 20) Nothing
Nothing : Maybe Int

模模模式式式匹匹匹配配配绑绑绑定定定

有时我们需要立即对 do夭记法中某个函数的结果进行模式匹配。例如，假设我们有一个函数
readNumber，它从控制台读取一个数，若该数有效则返回 Just x 形式的值，否则返回 Nothing ：

readNumber : IO (Maybe Nat)
readNumber = do
input <- getLine
if all isDigit (unpack input)

then pure (Just (cast input))
else pure Nothing

如果接着用它来编写读取两个数，若二者均无效则返回 Nothing 的函数， 那么我们可能想要对
readNumber 进行模式匹配：

readNumbers : IO (Maybe (Nat, Nat))
readNumbers =

do x <- readNumber
case x of

Nothing => pure Nothing
(äÿŃéąțçżğçżŋ)
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Just x_ok => do y <- readNumber
case y of

Nothing => pure Nothing
Just y_ok => pure (Just (x_ok, y_ok))

如果有很多错误需要处理，它的嵌套层次很快就会变得非常深！我们不妨将绑定和模式匹配组合成一
行。 例如，我们可以对 Just x_ok 的形式进行模式匹配：

readNumbers : IO (Maybe (Nat, Nat))
readNumbers =

do Just x_ok <- readNumber
Just y_ok <- readNumber
pure (Just (x_ok, y_ok))

然而问题仍然存在，我们现在忽略了 Nothing 的情况，所以该函数不再是完全的了！ 我们可以把
Nothing 的情况添加回去：

readNumbers : IO (Maybe (Nat, Nat))
readNumbers =

do Just x_ok <- readNumber | Nothing => pure Nothing
Just y_ok <- readNumber | Nothing => pure Nothing
pure (Just (x_ok, y_ok))

此版本的 readNumbers 效果与初版完全一样（实际上，它是初版的语法糖， 并且会直接被翻译回初版
的形式）。每条语句的第一部分（Just x_ok <- 和 Just y_ok <-）给出了首选的绑定：若能匹配，do
块的剩余部分就会继续执行。 第二部分给出了候选的绑定，其中的绑定可以有不止一个。

!-记记记法法法

在很多情况下，do夭记法会让程序不必要地嗦，在将值绑定一次就立即使用的情况下尤甚， 例如前面的
m_add。此时我们可以使用更加简短的方式：

m_add : Maybe Int -> Maybe Int -> Maybe Int
m_add x y = pure (!x + !y)

!expr 记法表示 expr 应当在求值后立即被隐式绑定。从概念上讲，我们可以把 ! 看做拥有以下类型的
前缀函数：

(!) : m a -> a

然而请注意，它并不是一个真的函数，而是一个语法！在实践中，子表达式 !expr 会在 expr 的当前作
用域内尽可能地提升，将它绑定到一个全新的名字 x， 然后用它来代替 !expr。首先表达式会按从左到
右的顺序深度优先地上升。在实践中，! 记法允许我们以更直接的方式来编程，同时该记法也标出了哪
些表达式为单子。

例如，表达式：

let y = 42 in f !(g !(print y) !x)

会被提升为：

let y = 42 in do y' <- print y
x' <- x
g' <- g y' x'
f g'
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单单单子子子推推推导导导式式式

我们之间在 更多表达式 夨姩妡妵 失夹天 一节中看到的列表推导记法其实更通用， 它可应用于任何实现了
Monad 和 Alternative 的东西：

interface Applicative f => Alternative (f : Type -> Type) where
empty : f a
(<|>) : f a -> f a -> f a

通常，推导式形式为 [ exp | qual1, qual2, …, qualn ] 其中 quali 可以为：

• 一个生成式 x <- e

• 一个 守守守卫卫卫式式式（（（Guard））），它是一个类型为 Bool 的表达式

• 一个 奬奥奴 绑定 let x = e

要翻译一个推导式 [exp | qual1, qual2, …, qualn]，首先任何作为 守守守卫卫卫式式式 的限定式 qual 会使用
以下函数翻译为 guard qual：

guard : Alternative f => Bool -> f ()

接着该推导式会被转换为 do夭记法：

do { qual1; qual2; ...; qualn; pure exp; }

使用单子推导式，m_add 的选取（奡奬奴奥奲奮奡奴奩奶奥）定义为：

m_add : Maybe Int -> Maybe Int -> Maybe Int
m_add x y = [ x' + y' | x' <- x, y' <- y ]

1.4.5 习习习语语语括括括号号号

do夭记法为串连提供了另一种写法，而习语则为 应应应用用用 提供了另一种写法。 本节中的记法以及大量的例
子受到了 奃奯奮奯奲 奍奣奂奲奩奤奥 和 奒奯女女 奐奡奴奥奲女奯奮 的论文 「带作用的应用子编程」1 的启发。

首先，让我们回顾一下前面的 m_add。它所做的只是将一个操作符应用到两个从 Maybe Int 中提取的
值。我们可以抽象出该应用：

m_app : Maybe (a -> b) -> Maybe a -> Maybe b
m_app (Just f) (Just a) = Just (f a)
m_app _ _ = Nothing

我们可以用它来编写另一种 m_add，它使用了函数应用的选取概念，带有显式的 m_app 调用：

m_add' : Maybe Int -> Maybe Int -> Maybe Int
m_add' x y = m_app (m_app (Just (+)) x) y

与其到处插入 m_app，我们不如使用习语括号（奉奤奩奯奭 奂奲奡奣奫奥奴女）来做这件事。 为此，我们可以像下面
这样为 Maybe提供一个 Applicative的实现，其中 <*>的定义方式与前面的 m_app相同（它已在 奉奤奲奩女
库中定义）：

Applicative Maybe where
pure = Just

(äÿŃéąțçżğçżŋ)

1 Conor McBride and Ross Paterson. 2008. Applicative programming with effects. J. Funct. Program. 18, 1 (January
2008), 1-13. DOI=10.1017/S0956796807006326 http://dx.doi.org/10.1017/S0956796807006326
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(Just f) <*> (Just a) = Just (f a)
_ <*> _ = Nothing

按照 <*> 的实现，我们可以像下面这样使用它，其中函数应用 [| f a1 … an |] 会被翻译成 pure f
<*> a1 <*> … <*> an：

m_add' : Maybe Int -> Maybe Int -> Maybe Int
m_add' x y = [| x + y |]

错错错误误误处处处理理理解解解释释释器器器

习语记法在定义求值器时通常很有用。奍奣奂奲奩奤奥 和 奐奡奴奥奲女奯奮 就为下面这样的语言描述了求值器1 ：

data Expr = Var String -- 变量
| Val Int -- 值
| Add Expr Expr -- 加法

求值会被根据上下文将变量（表示为 String）映射为 Int 值，且可能会失败。 我们定义了数据类型
Eval 来包装求值器：

data Eval : Type -> Type where
MkEval : (List (String, Int) -> Maybe a) -> Eval a

将求值器包装在数据类型中意味着我们之后可以为它提供接口的实现。我们首先定义一个函数， 它在
求值过程中从上下文取出值。

fetch : String -> Eval Int
fetch x = MkEval (\e => fetchVal e) where

fetchVal : List (String, Int) -> Maybe Int
fetchVal [] = Nothing
fetchVal ((v, val) :: xs) = if (x == v)

then (Just val)
else (fetchVal xs)

在定义该语言的求值器时，我们会应用 Eval上下文中的函数，这样它自然会为 Eval提供 Applicative
的实现。在 Eval 能够实现 Applicative 之前，我们必须为 Eval 实现 Functor：

Functor Eval where
map f (MkEval g) = MkEval (\e => map f (g e))

Applicative Eval where
pure x = MkEval (\e => Just x)

(<*>) (MkEval f) (MkEval g) = MkEval (\x => app (f x) (g x)) where
app : Maybe (a -> b) -> Maybe a -> Maybe b
app (Just fx) (Just gx) = Just (fx gx)
app _ _ = Nothing

现在就可以在求值表达式时，通过应用的习语来处理错误了：

eval : Expr -> Eval Int
eval (Var x) = fetch x
eval (Val x) = [| x |]
eval (Add x y) = [| eval x + eval y |]

(äÿŃéąțçżğçżŋ)
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runEval : List (String, Int) -> Expr -> Maybe Int
runEval env e = case eval e of

MkEval envFn => envFn env

1.4.6 命命命名名名实实实现现现

有时我们希望一个类型可以拥有一个接口的多个实现，例如为排序或打印提供另一种方法。 为此，实
现可以像下面这样 命命命名名名：

[myord] Ord Nat where
compare Z (S n) = GT
compare (S n) Z = LT
compare Z Z = EQ
compare (S x) (S y) = compare @{myord} x y

它像往常一样声明了一个实现，不过带有显式的名字 myord。语法 compare @{myord} 会为 compare
提供显式的实现，否则它会使用 Nat 的默认实现。我们可以用它来反向排序一个 Nat 列表。给定以下
列表：

testList : List Nat
testList = [3,4,1]

我们可以在 奉奤奲奩女 提示符中用默认的 Ord 实现来排序，之后使用命名的实现 myord：

*named_impl> show (sort testList)
"[sO, sssO, ssssO]" : String
*named_impl> show (sort @{myord} testList)
"[ssssO, sssO, sO]" : String

有时，我们也需要访问命名的父级实现。例如 奐奲奥奬奵奤奥 中定义的半群 Semigroup 接口：

interface Semigroup ty where
(<+>) : ty -> ty -> ty

接着又定义了幺半群 Monoid，它用「幺元」 neutral 扩展了 Semigroup：

interface Semigroup ty => Monoid ty where
neutral : ty

我们可以为 Nat 定义 Semigroup 与 Monoid 的两种不同的实现， 一个基于加法，一个基于乘法：

[PlusNatSemi] Semigroup Nat where
(<+>) x y = x + y

[MultNatSemi] Semigroup Nat where
(<+>) x y = x * y

加法的幺元为 0，而乘法的幺元为 1。因此，我们在定义 Monoid 的实现时， 保证扩展了正确的
Semigroup 十分重要。我们可以通过 using 从句来做到这一点：

[PlusNatMonoid] Monoid Nat using PlusNatSemi where
neutral = 0

[MultNatMonoid] Monoid Nat using MultNatSemi where
neutral = 1

1.4. 接接接口口口 28



Idris 语语语言言言文文文档档档, 版版版本本本 1.3.1

using PlusNatSemi 从句指明 PlusNatMonoid 应当扩展 PlusNatSemi。

1.4.7 确确确定定定形形形参参参

当接口的形参多于一个时，通过限定形参可帮助查找实现。例如：

interface Monad m => MonadState s (m : Type -> Type) | m where
get : m s
put : s -> m ()

在此接口中，查找该接口的实现只需要知道 m 即可，而 s 可根据实现来确定。 它通过在接口声明之后
添加 | m 来声明。我们将 m 称为 MonadState 接口的 确确确定定定形形形参参参（（（Determining Parameter））） ，因为
它是用于查找实现的形参。

1.5 模模模块块块与与与命命命名名名空空空间间间

奉奤奲奩女 程序由一组模块构成。每个模块包含一个可选的 module 声明来命名模块， 一系列 import 语句用
于导入其它模块，还有一组类型、接口和函数的声明与定义。 例如，以下模块定义了二叉树类型 BTree
（在 Btree.idr 文件中）：

module Btree

public export
data BTree a = Leaf

| Node (BTree a) a (BTree a)

export
insert : Ord a => a -> BTree a -> BTree a
insert x Leaf = Node Leaf x Leaf
insert x (Node l v r) = if (x < v) then (Node (insert x l) v r)

else (Node l v (insert x r))

export
toList : BTree a -> List a
toList Leaf = []
toList (Node l v r) = Btree.toList l ++ (v :: Btree.toList r)

export
toTree : Ord a => List a -> BTree a
toTree [] = Leaf
toTree (x :: xs) = insert x (toTree xs)

修饰符 export 和 public export 说明了哪些名称在其它模块中可见。 之后会详细解释。

这里给出了一个 奭奡奩奮 程序（在 bmain.idr 文件中），它利用 Btree 模块对列表排序：

module Main

import Btree

main : IO ()
main = do let t = toTree [1,8,2,7,9,3]

print (Btree.toList t)

同一名称可以在多个模块中定义：名称可以通过模块名来字 限限限定定定（（（Qualified）））。 Btree 模块中定义的
全部名称如下：
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• Btree.BTree

• Btree.Leaf

• Btree.Node

• Btree.insert

• Btree.toList

• Btree.toTree

如果名称可以区分，就没必要给出完整的限定名。通过明确的限定，或者根据它们的类型， 可以消除
名称的歧义。

模块名和文件名之间没有正式的联系，尽管通常会建议使用同一名字。import 语句用于引用文件
名，它通过 . 来分隔路径。例如，import foo.bar 会导入文件 foo/bar.idr，其中通常会有模块声明
module foo.bar。对模块名字的唯一要求是， 包含 main 函数的主模块必须命名为 Main，而文件名无
需为 Main.idr。

1.5.1 导导导出出出修修修饰饰饰符符符

奉奤奲奩女 允许对模块内容的可见性进行细粒度的控制。默认情况下， 模块中定义的所有名称都是私有
的。这有助于最小化接口并隐藏内部细节。奉奤奲奩女 允许将函数、类型和接口标记为 private、export 或
public export。 它们的一般含义如下夺

• private 表示完全不被导出。此为默认情况。

• export 表示顶级类型是导出的。

• public export 表示整个定义都是导出的。

更改可见性的另一限制是，定义无法引用可见性更低的名称。例如， public export 的定义无法使用
私有名称夬 而 export 的类型也无法使用私有名称。 这是为了避免私有名称泄露到模块的接口中。

对对对于于于函函函数数数的的的意意意义义义

• export 表示导出类型

• public export 表示导出类型和定义夬 导出之后的定义可被使用。 换言之夬 定义本身被认为是模块
接口的一部分。名字 public export 比较长是为了让你三思而后行。

注注注解解解: 奉奤奲奩女 中的同义类型可通过编写函数来创建。在为模块设置可见性时， 如果同义类型要在模块外
部使用，那么将它们声明为 public export 可能会更好。 否则，奉奤奲奩女 会无法获知该类型与谁同义。

既然 public export 意味着函数的定义是导出的，那么该函数的定义实际上也就成为了模块 奁奐奉 的一
部分。因此，除非你确实想要导出函数的完整定义，否则最好避免将其声明为 public export 。

对对对于于于数数数据据据类类类型型型的的的涵涵涵义义义

对于数据类型，其涵义如下：

• export 的类型构造器是导出的
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• public export 的类型构造器和数据构造器是导出的

对对对于于于接接接口口口的的的涵涵涵义义义

对于接口，其涵义如下：

• export 的接口名字是导出的

• public export 的接口名、方法名和默认定义都是导出的

%access 指指指令令令

默认的导出模式可以通过 %access 指令更改，例如：

module Btree

%access export

public export
data BTree a = Leaf

| Node (BTree a) a (BTree a)

insert : Ord a => a -> BTree a -> BTree a
insert x Leaf = Node Leaf x Leaf
insert x (Node l v r) = if (x < v) then (Node (insert x l) v r)

else (Node l v (insert x r))

toList : BTree a -> List a
toList Leaf = []
toList (Node l v r) = Btree.toList l ++ (v :: Btree.toList r)

toTree : Ord a => List a -> BTree a
toTree [] = Leaf
toTree (x :: xs) = insert x (toTree xs)

在这种情况下，没有访问修饰符的任何函数均可以导出为 export，而不是 private。

内内内部部部模模模块块块 API 的的的传传传递递递

另外，通过对 import 使用 public 修饰符，可将模块内导入的模块再次导出。 例如：

module A

import B
import public C

模块 A 会导出名字 a夬 以及模块 C 中所有公共或抽象的名称， 但无法再从模块 B 中导出任何东西。

1.5.2 显显显式式式命命命名名名空空空间间间

在定义模块的同时，也会隐式定义一个命名空间。然而，该命名空间也可以 显显显式式式 给出。当你想在同一
模块内重载名称时，它会非常有用：
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module Foo

namespace x
test : Int -> Int
test x = x * 2

namespace y
test : String -> String
test x = x ++ x

这个（明显人为设计的）模块使用完整的限定名 Foo.x.test 和 Foo.y.test 定义了两个函数，二者可
以根据函数类型来消歧义：

*Foo> test 3
6 : Int
*Foo> test "foo"
"foofoo" : String

1.5.3 形形形参参参化化化的的的块块块

一组函数的多个参数可通过 parameters 声明进行形参化（奐奡奲奡奭奥奴奥奲奩女奥），例如：

parameters (x : Nat, y : Nat)
addAll : Nat -> Nat
addAll z = x + y + z

parameters 形参块的作用是为块中的每个函数、类型和数据构造器添加形参声明。 具体来说，就是
将形参添加到参数列表的前面。在此块外，形参必须显式地给定。 因此在 奒奅奐奌 中调用 addAll 函数
时，它会拥有以下函数声明：

*params> :t addAll
addAll : Nat -> Nat -> Nat -> Nat

以及以下定义：

addAll : (x : Nat) -> (y : Nat) -> (z : Nat) -> Nat
addAll x y z = x + y + z

形参块可以嵌套。在为所有类型和数据构造器显式地添加形参时， 块中也可包含数据声明。它们也可
以是带有隐式参数的依赖类型：

parameters (y : Nat, xs : Vect x a)
data Vects : Type -> Type where
MkVects : Vect y a -> Vects a

append : Vects a -> Vect (x + y) a
append (MkVects ys) = xs ++ ys

为了在形参块外使用 Vects 或者 append，我们必须给出参数 xs 和 y。 在这里，我们可以用占位符来
代表类型检查器能推断出的值：

*params> show (append _ _ (MkVects _ [1,2,3] [4,5,6]))
"[1, 2, 3, 4, 5, 6]" : String

提提提示示示: 形形形参参参（（（Parameter）））与与与实实实参参参（（（Argument）））
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在数学中，对于函数 f(x)，f 为函数名，x 则称作函数 f 的形式参数（奐奡奲奡奭奥奴奥奲），简称形参；在
函数应用时，传输函数的参数则称作实际参数 （奁奲奧奵奭奥奮奴），简称实参。例如 f(2) 中的 2 即为传入
f(x) 的实参。

在英文原文中，有时并不明确区分形参与实参，一般统译作「参数」。只有当需要明确区分时， 才分
别译作「形参」与「实参」。

1.6 包包包

奉奤奲奩女 包括一套简单的构建系统，它会根据已命名的包描述文件来构建包以及可执行文件。 描述文件可
以配合 奉奤奲奩女 编译器来管理开发过程。

1.6.1 包包包的的的描描描述述述

包的描述包含以下内容：

• 包头，由关键字 package 后跟一个包名构成。包名可以是任何有效的 奉奤奲奩女 标识符。 奩奐奋奇 格式
也可包含一个带引号的 version，它接受任何有效的文件名。

• 描述包内容的字段，<field> = <value>

其中至少有一个 奭奯奤奵奬奥女 字段，对应的值为逗号分隔的模块列表。例如， 给定一个 奉奤奲奩女 包 maths，包
含 Maths.idr 、Maths.NumOps.idr Maths.BinOps.idr 和 Maths.HexOps.idr 几个模块，其相应的包
文件应为：

package maths

modules = Maths
, Maths.NumOps
, Maths.BinOps
, Maths.HexOps

其它包文件的例子可以在主 奉奤奲奩女 仓库的 libs 目录中以及 第三方库 中找到。

1.6.2 使使使用用用包包包文文文件件件

奉奤奲奩女 本身是知晓包的，还有一些专门的命令来帮助构建、安装以及清除包。 例如，对于前面给出的
maths 包，我们可以像下面这样使用 奉奤奲奩女：

• idris --build maths.ipkg 会构建包中的所有模块。

• idris --install maths.ipkg 会安装包，使其可以被其它 奉奤奲奩女 库和程序访问。

• idris --clean maths.ipkg 会删除构建时候产生的所有代码及可执行文件。

一旦 奭奡奴奨女 包安装完成，命令行选项 --package maths （简写为 -p maths）就可以使用了。例如：

idris -p maths Main.idr
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1.6.3 测测测试试试 Idris 包包包

集成的构建系统包含简单的测试框架。该框架会收集 tests 下的 ipkg 文件中列出的函数。所有的测试
函数必须返回 IO () 。

当输入 idris --testpkg yourmodule.ipkg 后，构建系统会列出单个 main 函数下的 tests 函数，并
在你机器上的全新环境中创建一个临时文件。 它会将该临时文件编译成可执行文件并执行它。

测试本身负责报告它们的成功或失败。测试函数通常用 putStrLn 报告测试结果。 测试框架不强加任何
报告标准，因此也不会合计测试结果。

我们以下面的函数列表为例，它们在样本包 maths 中名为 NumOps 的模块内定义：

module Maths.NumOps

%access export -- to make functions under test visible

double : Num a => a -> a
double a = a + a

triple : Num a => a -> a
triple a = a + double a

一个限定名为 Test.NumOps 的简单测试模块可声明为：

module Test.NumOps

import Maths.NumOps

%access export -- to make the test functions visible

assertEq : Eq a => (given : a) -> (expected : a) -> IO ()
assertEq g e = if g == e

then putStrLn "Test Passed"
else putStrLn "Test Failed"

assertNotEq : Eq a => (given : a) -> (expected : a) -> IO ()
assertNotEq g e = if not (g == e)

then putStrLn "Test Passed"
else putStrLn "Test Failed"

testDouble : IO ()
testDouble = assertEq (double 2) 4

testTriple : IO ()
testTriple = assertNotEq (triple 2) 5

函数 assertEq 和 assertNotEq 分别用于运行预期为通过和失败的相等性测试。 实际上的测试为
testDouble 和 testTriple，它们在 maths.ipkg 文件中的声明如下

package maths

modules = Maths.NumOps
, Test.NumOps

tests = Test.NumOps.testDouble
, Test.NumOps.testTriple

测试框架可通过 idris --testpkg maths.ipkg 命令调用：
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> idris --testpkg maths.ipkg
Type checking ./Maths/NumOps.idr
Type checking ./Test/NumOps.idr
Type checking /var/folders/63/np5g0d5j54x1s0z12rf41wxm0000gp/T/idristests144128232716531729.idr
Test Passed
Test Passed

注意当我们使用 assertEq 和 assertNoEq 函数测试时，它们是如何通过打印 Test Passed 来报告测试
成功的。

1.6.4 在在在 Atom 中中中使使使用用用包包包依依依赖赖赖

如果你在使用 奁奴奯奭 编辑器，并且依赖了另一个包，例如 import Lightyear 或者 import Pruviloj，
那么你需要让 奁奴奯奭 知道它应该加载什么。最简单的方式是通过 央奩奰奫奧 文件来完成。本教程在下一节中
会描述一个 奩奰奫奧 文件通常会包含哪些内容， 不过这里先给出此平凡例子的简单步骤：

• 创建一个 奭她奐奲奯奪奥奣奴 文件夹。

• 添加一个 奭她奐奲奯奪奥奣奴央奩奰奫奧 文件，包含如下代码：

package myProject

pkgs = pruviloj, lightyear

• 在 奁奴奯奭 中，使用文件菜单打开 奭她奐奲奯奪奥奣奴 文件夹。

更多信息

更多详情，包括可用字段的完整列表，可在参考手册的 Packages 夨姩妡妵 失夵失天 中找到。

1.7 示示示例例例：：：良良良类类类型型型的的的解解解释释释器器器

在本节中，我们使用已经见过的特性来编写一个更大的例子：一个简单的函数式语言解释器， 带有变
量、函数应用、二元运算符和 if...then...else 构造。 我们用依赖类型系统来保证所有能够表示的
程序都是良类型的。

1.7.1 语语语言言言的的的表表表示示示

首先，我们来定义语言中的类型。我们有整数、布尔和函数，用 Ty 来表示：

data Ty = TyInt | TyBool | TyFun Ty Ty

我们可以写一个函数将上面的表示转换为具体的 奉奤奲奩女 类型——要注意类型是一等的， 所以可以像其它
值一样参与计算：

interpTy : Ty -> Type
interpTy TyInt = Integer
interpTy TyBool = Bool
interpTy (TyFun a t) = interpTy a -> interpTy t

我们将定义一种表示方法，它只能表示良类型的程序。我们通过表达式的类型 与与与 其局部变量的类型
（上下文）来索引它。上下文可以用 Vect 数据类型来表达。 由于上下文需要被经常使用，因此它会被
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表示为隐式参数。为此，我们在 using 块中定义了所有需要的东西。（注意后文中的代码需要缩进才能
在 using 块中使用）：

using (G:Vect n Ty)

表达式通过局部变量的类型和表达式自身的类型来索引：

data Expr : Vect n Ty -> Ty -> Type

表达式的完整表示为：

data HasType : (i : Fin n) -> Vect n Ty -> Ty -> Type where
Stop : HasType FZ (t :: G) t
Pop : HasType k G t -> HasType (FS k) (u :: G) t

data Expr : Vect n Ty -> Ty -> Type where
Var : HasType i G t -> Expr G t
Val : (x : Integer) -> Expr G TyInt
Lam : Expr (a :: G) t -> Expr G (TyFun a t)
App : Expr G (TyFun a t) -> Expr G a -> Expr G t
Op : (interpTy a -> interpTy b -> interpTy c) ->

Expr G a -> Expr G b -> Expr G c
If : Expr G TyBool ->

Lazy (Expr G a) ->
Lazy (Expr G a) -> Expr G a

上述代码使用了 奉奤奲奩女 标准库中的 Vect 和 Fin 类型。它们不在 奐奲奥奬奵奤奥 中， 因此我们需要导入它们：

import Data.Vect
import Data.Fin

由于表达式通过其类型来索引，我们可以直接从构造器的定义中得出该语言的类型规则。 下面我们来
逐一观察每个构造器。

我们为变量使用了不带名字的表示法 夭 它们以 de Bruijn 法来索引。 变量以它们在上下文中从属关系
的证明来表示： HasType i G T 是变量 i 在上下文 G 中拥有类型 T 的证明。它的定义如下：

data HasType : (i : Fin n) -> Vect n Ty -> Ty -> Type where
Stop : HasType FZ (t :: G) t
Pop : HasType k G t -> HasType (FS k) (u :: G) t

我们把 Stop 当做最近定义的变量有良类型的证明，而 Pop n 则证明了 如果第 n 个最近定义的变量是
良类型的，那么第 n+1 个也是。在实践中， 这意味着我们通过 Var 构造器，使用 Stop 来引用最近定
义的变量， Pop Stop 来引用下一个，以此类推。

Var : HasType i G t -> Expr G t

所以，在表达式 \x. \y. x y 中，变量 x 的 奤奥 奂奲奵奩奪奮 索引为 失， 可表示为 Pop Stop ；变量 y 的 奤奥
奂奲奵奩奪奮 索引为 夰，可表示为 Stop 。 我们通过计算定义和使用之间 𝜆 的数量来查找它们。

值携带了整数的具体表示：

Val : (x : Integer) -> Expr G TyInt

𝜆 用于创建函数。在类型为 a -> t 的函数的作用域内，有一个新的类型为 a 的局部变量，它用上下文
索引来表示：

Lam : Expr (a :: G) t -> Expr G (TyFun a t)

函数应用接受一个从 a 到 t 的函数和一个类型为 a 的值，产生一个类型为 t 的值。

1.7. 示示示例例例：：：良良良类类类型型型的的的解解解释释释器器器 36



Idris 语语语言言言文文文档档档, 版版版本本本 1.3.1

App : Expr G (TyFun a t) -> Expr G a -> Expr G t

我们允许任意的二元运算符，运算符的类型会告诉我们参数的类型：

Op : (interpTy a -> interpTy b -> interpTy c) ->
Expr G a -> Expr G b -> Expr G c

最后，If 表达式根据给定的布尔值来做出选择，每个分支必须有相同的类型。 我们将对分支使用惰性
求值，只有被选择的分支才会被求值：

If : Expr G TyBool ->
Lazy (Expr G a) ->
Lazy (Expr G a) ->
Expr G a

1.7.2 编编编写写写解解解释释释器器器

当我们对一个 Expr 求值时，我们需要其作用域内的值及其类型。 Env 是一个根据其作用域中的类型来
索引的环境。尽管环境和局部变量类型的向量有着很强联系， 它也只是列表的另一种形式。我们使用
了一般的 :: 和 Nil 构造器， 这样就能使用一般的列表语法了。给定一个变量在上下文中定义的证明，
我们可以从环境中得到一个值：

data Env : Vect n Ty -> Type where
Nil : Env Nil
(::) : interpTy a -> Env G -> Env (a :: G)

lookup : HasType i G t -> Env G -> interpTy t
lookup Stop (x :: xs) = x
lookup (Pop k) (x :: xs) = lookup k xs

有了上述内容，解释器就是一个根据特定环境将 Expr 转换成一个具体的 奉奤奲奩女 值的函数了：

interp : Env G -> Expr G t -> interpTy t

作为参考，解释器的完整定义如下。对于每一个构造器，我们把它转换成对应的 奉奤奲奩女 值：

interp env (Var i) = lookup i env
interp env (Val x) = x
interp env (Lam sc) = \x => interp (x :: env) sc
interp env (App f s) = interp env f (interp env s)
interp env (Op op x y) = op (interp env x) (interp env y)
interp env (If x t e) = if interp env x then interp env t

else interp env e

我们来逐一观察每一种情况。对于一个变量，我们只要从环境中找出它：

interp env (Var i) = lookup i env

对于一个值，我们只需要返回其实际的表达方式：

interp env (Val x) = x

𝜆 则比较有意思。我们构造了一个解释 𝜆 内部作用域的函数，但其环境中带有一个新的值。 因此，目
标语言的函数可以用如下的方法来转换成 奉奤奲奩女 函数：
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interp env (Lam sc) = \x => interp (x :: env) sc

对于函数应用，我们解释函数及其参数，并直接将函数应用于参数。我们知道，根据其类型， 解释 f
必定会得到一个函数：

interp env (App f s) = interp env f (interp env s)

运算符和条件分支同样会转换成等价的 奉奤奲奩女 构造。对于运算符，我们将函数直接应用到 操作数上；对
于 If，我们直接使用 奉奤奲奩女 的 if...then...else 构造。

interp env (Op op x y) = op (interp env x) (interp env y)
interp env (If x t e) = if interp env x then interp env t

else interp env e

1.7.3 测测测试试试

我们可以编写一个简单的测试函数。首先，将两个输入值加起来，\x. \y. y + x 可写成如下形式：

add : Expr G (TyFun TyInt (TyFun TyInt TyInt))
add = Lam (Lam (Op (+) (Var Stop) (Var (Pop Stop))))

更有趣的是阶乘函数 fact，如 \x. if (x == 0) then 1 else (fact (x-1) * x)， 可写成如下形
式：

fact : Expr G (TyFun TyInt TyInt)
fact = Lam (If (Op (==) (Var Stop) (Val 0))

(Val 1)
(Op (*) (App fact (Op (-) (Var Stop) (Val 1)))

(Var Stop)))

1.7.4 运运运行行行

作为结束，我们编写一个 main 程序，它根据用户的输入来解释阶乘函数：

main : IO ()
main = do putStr "Enter a number: "

x <- getLine
printLn (interp [] fact (cast x))

此处的 cast 是一个被重载的函数，在可能的情况下，它将值转为另一种类型。在这里， 它将字符串转
换成了整数，在输入不合法时返回 夰 。在 奉奤奲奩女 的交互式环境运行中这个程序 会产生如下结果：

$ idris interp.idr
____ __ _

/ _/___/ /____(_)____
/ // __ / ___/ / ___/ Version 1.3.1

_/ // /_/ / / / (__ ) http://www.idris-lang.org/
/___/\__,_/_/ /_/____/ Type :? for help

Type checking ./interp.idr
*interp> :exec
Enter a number: 6
720
*interp>
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题题题外外外话话话：：：cast

奐奲奥奬奵奤奥 中定义了一个 Cast 接口来实现类型之间的转换：

interface Cast from to where
cast : from -> to

这是一个 多多多参参参数数数 接口，定义了转换的源类型和目标类型。在转换被应用的地方， 类型检查器必须能够
推导出 两两两个个个 参数。原语类型间有意义的转换均已定义。

1.8 视视视角角角与与与「「「with」」」规规规则则则

1.8.1 依依依赖赖赖模模模式式式匹匹匹配配配

由于类型可以依赖于值，因此某些参数的形式可根据其它参数的值来确定。例如， 如果我们写出 (++)
的长度隐式参数，就会看出它的形式由向量是否为空来决定：

(++) : Vect n a -> Vect m a -> Vect (n + m) a
(++) {n=Z} [] ys = ys
(++) {n=S k} (x :: xs) ys = x :: xs ++ ys

假如 n 在 [] 的情况下是一个后继，或者在 :: 的情况下为零， 那么它的定义就不是良类型的。

1.8.2 with 规规规则则则：：：匹匹匹配配配中中中间间间值值值

我们经常需要匹配中间计算（奉奮奴奥奲奭奥奤奩奡奴奥 奃奯奭奰奵奴奡奴奩奯奮）的结果。奉奤奲奩女 受到 Epigram1 中视角
（奖奩奥奷）的启发，为此提供了一种构造，即 with 规则， 它考虑到在依赖型的语言中匹配值会影响
我们对其它值的形式的了解。在最简单的形式中， with 规则会为正在定义的函数附加一个额外的参
数。

我们已经见过向量过滤函数了。这次我们用 with 来定义它：

filter : (a -> Bool) -> Vect n a -> (p ** Vect p a)
filter p [] = ( _ ** [] )
filter p (x :: xs) with (filter p xs)
filter p (x :: xs) | ( _ ** xs' ) = if (p x) then ( _ ** x :: xs' ) else ( _ ** xs' )

在这里，with 从句能让我们解构（奤奥奣奯奮女奴奲奵奣奴）奠奠夜奬奴奥奲 奰 奸女奠奠 的结果。 该视角精化的参数模式 filter
p (x :: xs) 位于 with 从句的下方， 之后是一条竖线 | 后面跟着解构的中间结果 ( _ ** xs' )。
如果该视角精化的参数模式与原函数的参数模式相同，那么 | 左侧的就是多余的，可以省略：

filter p (x :: xs) with (filter p xs)
| ( _ ** xs' ) = if (p x) then ( _ ** x :: xs' ) else ( _ ** xs' )

提提提示示示: 这个例子并不好，它省去了大量的细节，包括什么是视角，如何用视角来解构数据， 以及 奷奩奴奨
从句帮你做了什么。参数 p 与结果 (p ** Vect p a) 中的 p 也毫无关系，这点可能会对初学者造成困
扰。有条件的读者可参考 奔她奰奥夭奄奲奩奶奥奮 奄奥奶奥奬奯奰奭奥奮奴 奷奩奴奨 奉奤奲奩女 第二部分中的 奖奩奥奷女夺 奥奸奴奥奮奤奩奮奧 奰奡奴奴奥奲奮
奭奡奴奣奨奩奮奧 一章，或者重新思考接下来这个例子。

with 从句还可以嵌套：
1 Conor McBride and James McKinna. 2004. The view from the left. J. Funct. Program. 14, 1 (January 2004), 69-111.

https://doi.org/10.1017/S0956796803004829
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foo : Int -> Int -> Bool
foo n m with (succ n)

foo _ m | 2 with (succ m)
foo _ _ | 2 | 3 = True
foo _ _ | 2 | _ = False

foo _ _ | _ = False

如果中间计算本身具有依赖类型，那么其结果会影响其它参数的形式 — 我们可以通过测试 附加参数来
了解一个值的形式。在这类情况下，视角精化的参数模式必须是显式的。 例如，一个 Nat 不是偶数就
是奇数。如果它是偶数，那么它就等于两个 Nat 之和。 否则，它就是两个 Nat 之和再加一：

data Parity : Nat -> Type where
Even : Parity (n + n)
Odd : Parity (S (n + n))

我们将 Parity 称为 Nat 的一个 视视视角角角（（（View）））。它拥有一个 覆覆覆盖盖盖函函函数数数（（（Covering Function））） 来测
试 Nat 的奇偶性并构造相应的谓词：

parity : (n:Nat) -> Parity n

我们之后再看 parity 的定义。我们可以用它配合 with 规则来编写一个函数， 它将一个自然数转换成
一系列二进制数字（奆奡奬女奥 为 夰，奔奲奵奥 为 失，低位在前）：

natToBin : Nat -> List Bool
natToBin Z = Nil
natToBin k with (parity k)

natToBin (j + j) | Even = False :: natToBin j
natToBin (S (j + j)) | Odd = True :: natToBin j

parity k 的值影响了 k 的形式，因为 parity k 的结果取决于 k。 因此，除了 | 右侧的中间计算结果
（Even 和 Odd）的模式外， 我们还可以写出该结果如何影响 | 左侧的其它模式。即：

• 当 parity k 求值为 Even 时，我们可以根据 Even 构造器的定义 Parity (n + n)，将原始参数
k 精化为模式 (j + j)。这样 (j + j) 就代替了 | 左侧的 k，而 Even 构造器则出现在右侧。精化
模式中的自然数 j 会被用在 = 符号的两侧。

• 否则，当 parity k 求值为 Odd 时，根据 Odd 构造器的定义 Parity (S (n + n))，原始参数 k
会被精化为模式 S (j + j)， 它和 Odd 会出现在 | 的两侧，同样自然数 j 会被用在 = 符号的两
侧。

注意，在精化模式的两个 j 之间有一个函数 夨+天，它被允许是因为附加参数 已经确定了此模式的形式。

我们会在下一节 实践中的证明 夨姩妡妵 头夲天 中回到 parity 上来完成它的定义。

1.8.3 with 与与与证证证明明明

要使用依赖模式匹配进行定理证明，有时必须根据匹配模式显式地构造出证明结果。为此，你可以为
奷奩奴奨 从句加上 proof p 后缀，由模式匹配生成的证明会被命名为 p 并加入到作用域中。 例如：

data Foo = FInt Int | FBool Bool

optional : Foo -> Maybe Int
optional (FInt x) = Just x
optional (FBool b) = Nothing

isFInt : (foo:Foo) -> Maybe (x : Int ** (optional foo = Just x))
isFInt foo with (optional foo) proof p

(äÿŃéąțçżğçżŋ)
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isFInt foo | Nothing = Nothing -- here, p : Nothing = optional foo
isFInt foo | (Just x) = Just (x ** Refl) -- here, p : Just x = optional foo

1.9 定定定理理理证证证明明明

1.9.1 相相相等等等性性性

奉奤奲奩女 可以声明命题的相等性，陈述并证明有关程序的定理。 相等性是内建的，不过这里给出其概念上
的定义：

data (=) : a -> b -> Type where
Refl : x = x

任何类型的任何值之间都可以判断相等性，然而构造相等性证明的唯一方式就是值确实相等。例如：

fiveIsFive : 5 = 5
fiveIsFive = Refl

twoPlusTwo : 2 + 2 = 4
twoPlusTwo = Refl

1.9.2 空空空类类类型型型

存在一个空类型 ⊥，它没有构造器。因此，在不使用部分定义或一般递归函数的情况下， 无法构造出
空类型的元素（详见 完全性检查 夨姩妡妵 头头天 一节）。 由此，我们可以用空类型来证明某些命题是不可能
的，例如零不可能是任何自然数的后继：

disjoint : (n : Nat) -> Z = S n -> Void
disjoint n p = replace {P = disjointTy} p ()

where
disjointTy : Nat -> Type
disjointTy Z = ()
disjointTy (S k) = Void

我们不必太关心该函数如何工作 — 本质上，它应用库函数 replace， 根据相等证明来变换谓词。在本
例中，我们利用某些东西无法存在的证明， 将一个可以存在的类型（即空元组）的值，变换成了一个
无法存在的类型的值。

一旦拥有了空类型的元素，我们就能证明任何东西。void 在库中定义，用于辅助反证法。

void : Void -> a

1.9.3 简简简单单单定定定理理理

当对依赖类型进行类型检查时，该类型就会被 规规规范范范化化化（（（Normalized）））。 比如我们想要证明以下关于
plus 的归约行为（奒奥奤奵奣奴奩奯奮 奂奥奨奡奶奩奯奵奲）的定理：

plusReduces : (n:Nat) -> plus Z n = n

我们将该定理的陈述写成了类型，就像写出程序的类型一样。实际上证明和程序之间并没有本质的区
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别。 就我们所关注的而言，证明不过是个程序，只是它的类型精确到足以保证满足我们关心的特殊性
质。

我我我们不会在这里深入细节，奃奵奲奲她夭奈奯奷奡奲奤 同构1 解释了这种关系。该证明很平凡， 因为 plus 的定义
将 plus Z n 规范化成了 n：

plusReduces n = Refl

如果我们换种方式证明该论点，那就有点难了，因为加法是对第一个参数递归定义的。 该证明同样也
可以在 plus 的第一个参数 n 上递归：

plusReducesZ : (n:Nat) -> n = plus n Z
plusReducesZ Z = Refl
plusReducesZ (S k) = cong (plusReducesZ k)

cong 是库中定义的一个函数，它指明相等性也适用于函数应用：

cong : {f : t -> u} -> a = b -> f a = f b

我们可以对加法在后继上的递归行为做同样的事情：

plusReducesS : (n:Nat) -> (m:Nat) -> S (plus n m) = plus n (S m)
plusReducesS Z m = Refl
plusReducesS (S k) m = cong (plusReducesS k m)

即便对于如此平凡的定理，一口气构造出证明也有点棘手。当事情变得更复杂时， 需要考虑的就太多
了，此时根本无法在这种「批量模式」下构造证明。

奉奤奲奩女 提供了交互式编辑的能力，它可以帮助构造证明。关于在编辑器中交互式构造证明的更多详情，
参见 Theorem Proving 夨姩妡妵 失夳夶天。

1.9.4 实实实践践践中中中的的的证证证明明明

证明定理的需求可在实践中自然产生。例如，在之前的 视角与「with」规则 夨姩妡妵 夳夹天 一节中， 我们用
函数 parity 实现了 natToBin：

parity : (n:Nat) -> Parity n

然而，我们并未提供 parity 的定义。我们可能觉得它看起来会像下面这样：

parity : (n:Nat) -> Parity n
parity Z = Even {n=Z}
parity (S Z) = Odd {n=Z}
parity (S (S k)) with (parity k)

parity (S (S (j + j))) | Even = Even {n=S j}
parity (S (S (S (j + j)))) | Odd = Odd {n=S j}

然而，它会因类型错误而无法编译：

在按照期望的类型
Parity (S (S (j + j)))

检查 views.parity 中 with 块的右侧时

发现

(äÿŃéąțçżğçżŋ)

1 Timothy G. Griffin. 1989. A formulae-as-type notion of control. In Proceedings of the 17th ACM SIGPLAN-
SIGACT symposium on Principles of programming languages (POPL ‘90). ACM, New York, NY, USA, 47-58.
DOI=10.1145/96709.96714 http://doi.acm.org/10.1145/96709.96714
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Parity (S j + S j) （Even 的类型）
与

Parity (S (S (plus j j))) （期望的类型）
的类型不匹配

问题在于，在 Even 的类型中规范化 S j + S j 并不能得到我们需要的 Parity 右侧的类型。我们知道
S (S (plus j j)) 等于 S j + S j， 但需要向 奉奤奲奩女 证明它。我们可以先为该定义挖一些 坑坑坑 （见 坑
夨姩妡妵 夷天）：

parity : (n:Nat) -> Parity n
parity Z = Even {n=Z}
parity (S Z) = Odd {n=Z}
parity (S (S k)) with (parity k)

parity (S (S (j + j))) | Even = let result = Even {n=S j} in
?helpEven

parity (S (S (S (j + j)))) | Odd = let result = Odd {n=S j} in
?helpOdd

检查 helpEven 的类型会告诉我们需要为 Even 的情况证明什么：

j : Nat
result : Parity (S (plus j (S j)))

--------------------------------------
helpEven : Parity (S (S (plus j j)))

由此我们可以编写一个辅助函数，将它的类型 重重重写写写 为需要的形式：

helpEven : (j : Nat) -> Parity (S j + S j) -> Parity (S (S (plus j j)))
helpEven j p = rewrite plusSuccRightSucc j j in p

rewrite ... in 语法允许你根据相等性证明来改写它，以此改变表达式需要的类型。 在这里，我们使
用了 plusSuccRightSucc，其类型如下：

plusSuccRightSucc : (left : Nat) -> (right : Nat) -> S (left + right) = left + S right

我们可以在 helpEven 的右侧挖个坑来看到 rewrite 的效果，然后一步一步地做。 我们从下面开始：

helpEven : (j : Nat) -> Parity (S j + S j) -> Parity (S (S (plus j j)))
helpEven j p = ?helpEven_rhs

先查看一下 helpEven_rhs 的类型：

j : Nat
p : Parity (S (plus j (S j)))

--------------------------------------
helpEven_rhs : Parity (S (S (plus j j)))

然后通过应用 plusSuccRightSucc j j来进行 rewrite重写，它会给出等式 S (j + j) = j + S j，
从而在类型中用 j + S j 取代 S (j + j) （在这里是 S (plus j j)，它由 S (j + j) 规约而来 ）：

helpEven : (j : Nat) -> Parity (S j + S j) -> Parity (S (S (plus j j)))
helpEven j p = rewrite plusSuccRightSucc j j in ?helpEven_rhs

现在检查 helpEven_rhs 的类型会告诉我们发生了什么，包括刚才所用的等式的类型 （即
_rewrite_rule 的类型）：

j : Nat
(äÿŃéąțçżğçżŋ)
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p : Parity (S (plus j (S j)))
_rewrite_rule : S (plus j j) = plus j (S j)

--------------------------------------
helpEven_rhs : Parity (S (plus j (S j)))

对 Odd 的情况使用 rewrite 和另一个辅助函数，我们可以完成 parity：

helpEven : (j : Nat) -> Parity (S j + S j) -> Parity (S (S (plus j j)))
helpEven j p = rewrite plusSuccRightSucc j j in p

helpOdd : (j : Nat) -> Parity (S (S (j + S j))) -> Parity (S (S (S (j + j))))
helpOdd j p = rewrite plusSuccRightSucc j j in p

parity : (n:Nat) -> Parity n
parity Z = Even {n=Z}
parity (S Z) = Odd {n=Z}
parity (S (S k)) with (parity k)

parity (S (S (j + j))) | Even = helpEven j (Even {n = S j})
parity (S (S (S (j + j)))) | Odd = helpOdd j (Odd {n = S j})

rewrite 的完整细节超出了本入门教程的范围，不过定理证明教程 （见 Theorem Proving 夨姩妡妵 失夳夶天）
中覆盖了它。

1.9.5 完完完全全全性性性检检检查查查

如果我们真的想要信任我们的证明，它们定义为 全全全 函数是十分重要的 — 也就是说， 一个函数为所有
可能的输入情况定义，并且保证会终止。不然我们就能构造出一个空类型的元素， 以它开始我们可以
证明任何东西：

-- 利用部分定义的「hd」
empty1 : Void
empty1 = hd [] where

hd : List a -> a
hd (x :: xs) = x

-- 不会终止
empty2 : Void
empty2 = empty2

奉奤奲奩女 会在内部检查所有函数的完全性，我们可在提示符中用 :total 命令来检查。 我们会看到上面的
两个定义都是不完全的：

*Theorems> :total empty1
可能不完全，由于： empty1#hd

不完全，因为有遗漏的情况
*Theorems> :total empty2
可能不完全，由于递归路径 empty2

注意这里用了「可能」一词 — 由于停机问题的不可判定性，完全性检查当然永远无法确定。 因此，该
检查是保守的。我们也可以将函数标记为完全的，使其在完全性检查失败时产生编译期错误：

total empty2 : Void
empty2 = empty2

对 ./theorems.idr 进行类型检查
theorems.idr:25:empty2 可能不完全，由于递归路径 empty2
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令人欣慰的是，我们在 空类型 夨姩妡妵 头失天 一节中对零与后继构造器分立的证明是完全的：

*theorems> :total disjoint
Total

完全性检查必然是保守的。要被记录为完全的，函数 f 必须：

• 覆盖所有可能的输入

• 是 良良良基基基 的 — 即，当一系列（可能互相）递归的调用再次到达 f 时，它必须能够表明其参数之一
已经递减。

• 使用的数据类型必须 严严严格格格为为为正正正（（（strictly positive）））

• 没有调用任何不完全的函数

完完完全全全性性性的的的指指指令令令与与与编编编译译译器器器参参参数数数

默认情况下，奉奤奲奩女 允许所有良类型的定义，无论是否完全。然而在理想情况下， 函数总是要尽可能地
完全，因为这能保证它们可以在有限时间内， 对于所有可能的输入提供一个结果。我们可以要求函数
是完全的，通过以下两种方式之一：

• 使用 --total 编译器参数。

• 为源文件添加 %default total 指令。在这之后的所有定义都会要求为完全的， 除非显式地标记
为 partial。

在 %default total 声明 之之之后后后 的所有函数都会被要求是完全的。与此相应， %default partial 声明
之后的要求则被放宽。

最后，编译器参数 --warnpartial 会为任何未声明完全性的偏函数打印一个警告。

完完完全全全性性性检检检查查查的的的问问问题题题

请注意，完全性检查器并不完美！首先，由于停机问题的不可判定性，它必然是保守的， 因此一些 确确确
实实实完完完全全全 的程序不会被检测为完全的。其次，当前实现投入的精力有限， 因此它仍然有可能将不完全的
函数当作完全的。你的证明请先不要依赖它！

完完完全全全性性性的的的提提提示示示

有时你确信一个程序是完全的，但 奉奤奲奩女 不这么认为，此时可以对检查器给出提示， 以此来给出终止参
数的详情。检查器会确保所有的递归调用链最终都能导致其中一个参数递减到基本情况， 然而有些情
况很难辨别。例如，以下定义无法被检查为 total，因为检查器无法确定 filter (< x) xs 一定小于
(x :: xs)：

qsort : Ord a => List a -> List a
qsort [] = []
qsort (x :: xs)

= qsort (filter (< x) xs) ++
(x :: qsort (filter (>= x) xs))

奰奲奥奬奵奤奥 中定义的 assert_smaller 旨在解决这个问题：

assert_smaller : a -> a -> a
assert_smaller x y = y
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它简单地求值成第二个参数，但也会向完全性检查器断言 y 在结构上小于 x。 当检查器自己无法解决
时，它可用于解释完全性的推理。现在上面的例子可重写为：

total
qsort : Ord a => List a -> List a
qsort [] = []
qsort (x :: xs)

= qsort (assert_smaller (x :: xs) (filter (< x) xs)) ++
(x :: qsort (assert_smaller (x :: xs) (filter (>= x) xs)))

表达式 assert_smaller (x :: xs) (filter (<= x) xs) 断言 filter 的结果总是小于模式 (x ::
xs) 。

在更极端的情况下，函数 assert_total 能将一个表达式标为总是完全的：

assert_total : a -> a
assert_total x = x

通常，你应当避免使用该函数，不过在对原语进行推理，或者在对外部定义的， 完全性可被外部参数
展示的函数（例如 奃 库中的）进行推理时，它会非常有用。

1.10 临临临时时时定定定义义义

在依赖类型编程中，有时类型检查器需要的类型会和我们编写的程序的类型不同 （在这里是它们的形
式不同），然而尽管如此，它们在证明上依然是等价的。 例如，回想一下 parity 函数：

data Parity : Nat -> Type where
Even : Parity (n + n)
Odd : Parity (S (n + n))

我们要把它实现为：

parity : (n:Nat) -> Parity n
parity Z = Even {n=Z}
parity (S Z) = Odd {n=Z}
parity (S (S k)) with (parity k)

parity (S (S (j + j))) | Even = Even {n=S j}
parity (S (S (S (j + j)))) | Odd = Odd {n=S j}

它简单地指定了零为偶数，一为奇数，然后递归地说明了 k+2 的奇偶性与 k 相同。 显式地标出 n 是奇
数还是偶数对于类型推断来说是必须的。然而，类型检查器却拒绝了它：

viewsbroken.idr:12:10: 在解析 ViewsBroken.parity 的右侧时：
Parity (plus (S j) (S j))

与
Parity (S (S (plus j j)))

的类型不匹配

具体为：
plus (S j) (S j)

与
S (S (plus j j))

的类型不匹配

类型检查器告诉我们 (j+1)+(j+1) 和 2+j+j 无法规范化为相同的值。这是因为 plus 是在第一个参数
上递归定义的，而在第二个值中，有一个后继符号作用在第二个参数上， 因此它无法帮助归约。这些
值明显相等 — 不过我们要如何重写程序来修复此问题？
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1.10.1 临临临时时时定定定义义义

临临临时时时定定定义义义（（（Provisional Definition））） 允许我们推迟证明的细节以帮助解决此问题。 它主要有两个作
用：

• 在 成成成型型型（（（Prototyping））） 时，它可在所有的证明细节结束前测试程序。

• 在 阅阅阅读读读 程序时，推迟证明的细节通常会让过程更清晰，避免读者从底层算法中分心。

临时定义的写法和普通定义相同，只是它以 ?= 而非 = 引入右式。我们将 parity 定义为：

parity : (n:Nat) -> Parity n
parity Z = Even {n=Z}
parity (S Z) = Odd {n=Z}
parity (S (S k)) with (parity k)

parity (S (S (j + j))) | Even ?= Even {n=S j}
parity (S (S (S (j + j)))) | Odd ?= Odd {n=S j}

当写成这种形式时，奉奤奲奩女 不会报告类型错误，而是在定理中挖一个坑，以此来修正类型错误。 奉奤奲奩女 会
告诉我们有两个证明义务，其名字根据模块和函数名生成：

*views> :m
Global holes:

[views.parity_lemma_2,views.parity_lemma_1]

其中第一个坑的类型如下：

*views> :p views.parity_lemma_1

---------------------------------- (views.parity_lemma_1) --------
{hole0} : (j : Nat) -> (Parity (plus (S j) (S j))) -> Parity (S (S (plus j j)))

-views.parity_lemma_1>

它的两个参数为 j，一个是模式匹配作用域中的变量，另一个是 value， 它是我们在临时定义右侧给出
的值。我们的目标是重写类型以便让我们能使用该值。 我们可以用 奐奲奥奬奵奤奥 中的以下定理来达到此目
的：

plusSuccRightSucc : (left : Nat) -> (right : Nat) ->
S (left + right) = left + (S right)

还要再用 compute 来展开 plus 的定义：

-views.parity_lemma_1> compute

---------------------------------- (views.parity_lemma_1) --------
{hole0} : (j : Nat) -> (Parity (S (plus j (S j)))) -> Parity (S (S (plus j j)))

在应用 intros 之后，我们有：

-views.parity_lemma_1> intros

j : Nat
value : Parity (S (plus j (S j)))

---------------------------------- (views.parity_lemma_1) --------
{hole2} : Parity (S (S (plus j j)))

接着，我们对称地对 j 和 j 应用 plusSuccRightSucc 重写规则，它会给出：

1.10. 临临临时时时定定定义义义 47



Idris 语语语言言言文文文档档档, 版版版本本本 1.3.1

-views.parity_lemma_1> rewrite sym (plusSuccRightSucc j j)

j : Nat
value : Parity (S (plus j (S j)))

---------------------------------- (views.parity_lemma_1) --------
{hole3} : Parity (S (plus j (S j)))

sym 是一个在库中定义的函数，它可以反转重写的顺序：

sym : l = r -> r = l
sym Refl = Refl

我们可以用 trivial 策略来完成此证明，它会在前提中找到 value。 第二个引理的证明方式完全相
同。

现在我们可以在提示符中测试 with 规则：匹配中间值 夨姩妡妵 夳夹天 一节中的 natToBin 了。数字 头夲 的二进
制为 失夰失夰失夰。其二进制数字以逆序表示：

*views> show (natToBin 42)
"[False, True, False, True, False, True]" : String

1.10.2 暂暂暂且且且相相相信信信

奉奤奲奩女 在编译程序前需要完成证明（尽管在提示符中求值可以无需详细证明）。然而有时候， 特别在成
型时，不去完成证明反而更容易。在尝试证明它们之前就测试程序甚至可能会更好， 如果测试找到了
一个错误，你就会知道最好不要花时间去证明某些东西了！

因此，奉奤奲奩女 提供了一个内建的强迫（奣奯奥奲奣奩奯奮）函数，它允许我们使用类型错误的值：

believe_me : a -> b

显然，它的使用必须要非常小心。在成型时它非常有用，在断言外部代码（可能在外部的 奃 库中）的
性质时也是可以用的。使用了它的 views.parity_lemma_1 的「证明」为：

views.parity_lemma_2 = proof {
intro;
intro;
exact believe_me value;

}

exact 策略允许我们为该证明提供一个确切的值。在本例中，我们断言给出的值是正确的。

1.10.3 示示示例例例：：：二二二进进进制制制数数数

我们在前面通过 Parity 视角实现了 奎奡奴 到二进制数的转换。在这里， 我们会展示如何用同样的视角
来实现已验证的二进制转换。我们首先在与其等价的 Nat 上索引二进制数。这是一种通用的模式，即将
它的表示（这里为 Binary）与其含义 （这里为 Nat）关联起来：

data Binary : Nat -> Type where
BEnd : Binary Z
BO : Binary n -> Binary (n + n)
BI : Binary n -> Binary (S (n + n))

BO 和 BI 接受一个二进制数作为其参数并立即将它左移一位， 然后再加零或一作为新的最低位。索引 n
+ n 或 S (n + n) 描述了左移后再相加的结果与该数值的意义相同。它会产生低位在前的表示。
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现在，将 奎奡奴 转换为二进制的函数在其类型中描述了结果二进制数为原始 奎奡奴 的正确表示：

natToBin : (n:Nat) -> Binary n

Parity 视角让定义变得相当简单：把数折半其实就是进行一次右移，尽管我们需要在 奏奤奤 的情况下使
用临时定义：

natToBin : (n:Nat) -> Binary n
natToBin Z = BEnd
natToBin (S k) with (parity k)

natToBin (S (j + j)) | Even = BI (natToBin j)
natToBin (S (S (j + j))) | Odd ?= BO (natToBin (S j))

奏奤奤 情况的问题与 parity 定义中的相同，其证明过程也一样：

natToBin_lemma_1 = proof {
intro;
intro;
rewrite sym (plusSuccRightSucc j j);
trivial;

}

最后，我们来实现一个 奭奡奩奮 程序，它读取用户输入的整数并输出为二进制：

main : IO ()
main = do putStr "Enter a number: "

x <- getLine
print (natToBin (fromInteger (cast x)))

当然，为了能让它工作，我们需要为 Binary n 实现 Show：

Show (Binary n) where
show (BO x) = show x ++ "0"
show (BI x) = show x ++ "1"
show BEnd = ""

1.11 交交交互互互式式式编编编辑辑辑

目前，我们已经见过几个 奉奤奲奩女 的例子了，它的依赖类型系统可以在函数的 类类类型型型 中为期望的行为添加更
加精确的描述，为函数的正确性增加额外的信心。 我们也见识过类型系统如何帮助开发 奅奄奓奌 了，它
允许程序员描述目标语言的类型系统。 然而，精确的类型不止赋予了我们程序验证的能力，我们还可
以利用类型来帮助 构构构造造造 出 正正正确确确 的程序。

奉奤奲奩女 的 奒奅奐奌 提供了一些命令，可基于程序的类型来检查和修改程序的片段， 例如在模式变量中拆分
情况，检查坑的类型，甚至还有基本的证明搜索机制。在本节中， 我们解释了如何在文本编辑器中，
特别是如何在 奖奩奭 中利用这些特性。 奅奭奡奣女 的交互式模式也可以。

1.11.1 在在在 REPL 中中中编编编辑辑辑

奒奅奐奌 提供了许多命令，我们稍后会介绍它们。它们基于当前加载的模块来生成新的程序片段。 其一
般形式为：

:命令 [行号] [名称]
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也就是说，每条命令都会作用在源码中特定行的特定名称上，然后输出一个新的程序片段。 每个命令
都有一种原地 更更更新新新 源文件的形式：

:命令! [行号] [名称]

当 奒奅奐奌 被加载时，它还会用 idris --client 在后台启动一个进程，该进程接受并响应 奒奅奐奌 命
令。例如，如果我们在某处运行着 奒奅奐奌，就可以执行这样的命令：

$ idris --client ':t plus'
Prelude.Nat.plus : Nat -> Nat -> Nat
$ idris --client '2+2'
4 : Integer

文本编辑器可以利用此特性与编辑命令来提供交互式编辑。

1.11.2 编编编辑辑辑命命命令令令

:addclause

:addclause n f 命令，缩写为 :ac n f，它为第 n 行声明的函数 f 创建一个模版定义。例如，若从第
夹头 行开始的代码为：

vzipWith : (a -> b -> c) ->
Vect n a -> Vect n b -> Vect n c

那么 :ac 94 vzipWith 会给出：

vzipWith f xs ys = ?vzipWith_rhs

名称可根据程序员给定的提示来选择，必要时机器还会添加数字使其唯一。 我们可以像下面这样给出
提示：

%name Vect xs, ys, zs, ws

它声明了 Vect 类型族的名字应按照 xs、ys、zs、ws 的顺序来选取。

:casesplit

:casesplit n x 命令，缩写为 :cs n x，它将第 n 行的模式变量 x 拆分为能构成它的多种模式，并移
除任何由于一致性错误而不可能出现的情况。 例如，若从第 夹头 行开始的代码为：

vzipWith : (a -> b -> c) ->
Vect n a -> Vect n b -> Vect n c

vzipWith f xs ys = ?vzipWith_rhs

那么 :cs 96 xs 会给出：

vzipWith f [] ys = ?vzipWith_rhs_1
vzipWith f (x :: xs) ys = ?vzipWith_rhs_2

即，模式变量 xs 被拆分成了 [] 和 x :: xs 两种情况。与之前一样， 名称的选取启发自相同的规
则。若我们（用 :cs!）更新文件后再拆分同一行的 ys，就会得到：

vzipWith f [] [] = ?vzipWith_rhs_3
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即，模式变量 ys 被拆分成了 [] 这一个情况，因为 奉奤奲奩女 发现另一种可能的情况 y :: ys 会导致一致
性错误。

:addmissing

:addmissing n f 命令，缩写为 :am n f，它为第 n 行的函数 f 添加能覆盖所有输入情况的从句。例
如，若从第 夹头 行开始的代码为：

vzipWith : (a -> b -> c) ->
Vect n a -> Vect n b -> Vect n c

vzipWith f [] [] = ?vzipWith_rhs_1

那么 :am 96 vzipWith 会给出：

vzipWith f (x :: xs) (y :: ys) = ?vzipWith_rhs_2

即，它注意到不存在空向量的情况，然后生成了需要的从句，并消除了会导致不一致性错误的从句。

:proofsearch

:proofsearch n f 命令，缩写为 :ps n f，它试图通过证明搜索、 尝试局部变量的值、递归调用以及
所需类型族的构造器来为第 n 行的坑 f 查找一个值。该命令也可以接受一个可选的 提提提示示示（（（Hint））） 列
表， 也就是可用于尝试解决此坑的函数列表。例如，若从第 夹头 行开始的代码为：

vzipWith : (a -> b -> c) ->
Vect n a -> Vect n b -> Vect n c

vzipWith f [] [] = ?vzipWith_rhs_1
vzipWith f (x :: xs) (y :: ys) = ?vzipWith_rhs_2

那么 :ps 96 vzipWith_rhs_1 会给出：

[]

它能工作是因为它在对长度为 夰 的 Vect 进行搜索，而空向量是唯一的可能。 同样，在试图解决 :ps
97 vzipWith_rhs_2 时也出乎意料地只有一种可能：

f x y :: (vzipWith f xs ys)

它能工作是因为 vzipWith 拥有足够精确的类型：其结果向量一定非空（即至少有一个 ::）；第一个
元素的类型必须为 c，而得到它的唯一方法就是将 f 应用于 x 和 y；最后，该向量的尾部只能递归地构
造。

:makewith

:makewith n f 命令，缩写为 :mw n f，它为模式添加一个 with 从句。 以之前的 parity 为例。若第
失夰 行为：

parity (S k) = ?parity_rhs

那么 :mw 10 parity 会给出：

parity (S k) with (_)
parity (S k) | with_pat = ?parity_rhs
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若我们在占位符 _ 处填上 parity k，并用 :cs 11 with_pat 拆分 with_pat 的情况，就会得到以下模
式：

parity (S (plus n n)) | even = ?parity_rhs_1
parity (S (S (plus n n))) | odd = ?parity_rhs_2

注意情况拆分规范化了该模式（即给的是 plus 而非 +）。我们会看到在任何情况下， 使用交互式编辑
向程序员展示有效的模式都能显著简化依赖模式匹配的实现。

1.11.3 Vim 交交交互互互式式式编编编辑辑辑

奖奩奭 的编辑器模式提供语法高亮和缩进，通过前文所述的命令提供交互式编辑的支持。 交互式编辑使
用以下编辑器命令来进行，每一条都会直接更新缓冲区：

• \d 使用 :addclause 为当前行声明的名字添加模版定义。

• \c 使用 :casesplit 为光标处的变量执行情况拆分。

• \m 使用 :addmissing 为光标处的名字添加缺少的情况。

• \w 使用 :makewith 添加 with 从句。

• \o 使用 :proofsearch 调用证明搜索来解决光标处的坑。

• \p 使用 :proofsearch 根据附加的提示调用证明搜索以解决光标处的坑。

还有一些用来调用类型检查器与求值器的命令：

• \t 显示光标下（全局可见的）名称的类型。对坑而言，它会显示其上下文和预期的类型。

• \e 提醒要求值的表达式。

• \r 重新加载缓冲区并执行类型检查。

对应的命令在 奅奭奡奣女 模式中也可用。其它编辑器的支持可通过使用 idris –client 以相对直接的方式
来添加。

1.12 语语语法法法扩扩扩展展展

奉奤奲奩女 支持以多种方式实现 嵌嵌嵌入入入式式式领领领域域域特特特定定定语语语言言言（（（Embedded Domain Specific Language,
EDSL）））1 。 我们见过的一种方式是扩展 do 记法。另一种重要的方式就是对核心语法进行扩展。
在本节中，我们描述了两种扩展语法的方式：syntax 规则与 dsl 记法。

1.12.1 syntax 规规规则则则

我们已经见过 if...then...else 表达式了，然而它并不是内建的。同样， 我们可以定义一个 奐奲奥奬奵奤奥
中的函数（它在 惰性 夨姩妡妵 失夳天 一节中出现过了）：

1 Edwin Brady and Kevin Hammond. 2012. Resource-Safe systems programming with embedded domain specific
languages. In Proceedings of the 14th international conference on Practical Aspects of Declarative Languages (PADL‘12),
Claudio Russo and Neng-Fa Zhou (Eds.). Springer-Verlag, Berlin, Heidelberg, 242-257. DOI=10.1007/978-3-642-27694-
1_18 http://dx.doi.org/10.1007/978-3-642-27694-1_18
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ifThenElse : (x:Bool) -> Lazy a -> Lazy a -> a;
ifThenElse True t e = t;
ifThenElse False t e = e;

接着用 syntax 声明来扩展核心语法：

syntax if [test] then [t] else [e] = ifThenElse test t e;

syntax 声明的左式描述了语法规则，而右式描述了其展开式。语法规则的构成为：

• 关关关键键键字字字 — 在这里为 if、then 和 else，它必须是有效的标识符。

• 非非非终终终止止止符符符（（（Non-terminal）））—位于方括号内，此处为 [test]、[t]和 [e]，它们表示任意表达
式。为避免解析歧义，这些表达式不能在顶层使用语法扩展 （也就是说你可以在括号中使用）。

• 名名名称称称 — 位于大括号内，它表示可在右侧被绑定的名字。

• 符符符号号号 — 位于引号内，例如 ":="。它也可在语法规则中包含保留字，例如 "let" 或 "in"。

语法规则形式的限制在于它必须包含至少一个符号或关键字，且表示非终止符的变量不能重复。 任何
表达式都可以使用，不过如果在一个规则的同一行内有两个非终止符，那么只有简单的表达式会被使用
（即，变量、常量或方括号括起的表达式）。规则可在其定义之前使用，但无法递归地使用。 因此以
下语法扩展是有效的：

syntax [var] ":=" [val] = Assign var val;
syntax [test] "?" [t] ":" [e] = if test then t else e;
syntax select [x] from [t] "where" [w] = SelectWhere x t w;
syntax select [x] from [t] = Select x t;

语法宏可被进一步限制为只能在模式（即，只能在模式匹配从句的左侧）中或只能在被标为 pattern
或 term 语法规则的项（即除了模式匹配从句左侧的任何地方）中应用。 例如，假设我们定义了一个区
间 Interval，用 So 静态检查以保证下界小于上界：

data Interval : Type where
MkInterval : (lower : Double) -> (upper : Double) ->

So (lower < upper) -> Interval

我们可以用 pattern 定义一个语法，它总是匹配 Oh 作为证明论据，用 term 请求提供一个证明项：

pattern syntax "[" [x] "..." [y] "]" = MkInterval x y Oh
term syntax "[" [x] "..." [y] "]" = MkInterval x y ?bounds_lemma

在 term 中，语法 [x...y] 会生成一个证明义务 bounds_lemma （可能被重命名）。

最后，语法规则可引入另一种绑定形式。例如，for 循环在每次迭代中绑定一个参数：

syntax for {x} "in" [xs] ":" [body] = forLoop xs (\x => body)

main : IO ()
main = do for x in [1..10]:

putStrLn ("Number " ++ show x)
putStrLn "Done!"

注意，我们用形式 {x} 指明 x 表示一个已绑定的变量，它在右侧会被替换。 我们还把 in 放在了引号
中，因为它是保留字。
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1.12.2 dsl 记记记法法法

示例：良类型的解释器 夨姩妡妵 夳夵天 一节中的良类型解释器是个依赖类型编程模式的简单例子。也就是说：
先用依赖类型描述一个 目目目标标标语语语言言言 及其类型系统，保证只有良类型的程序可被表示， 然后再通过这种方
式表示程序。通过这种方式，我们可以编写序列化二进制数据2 或安全运行并发过程3 的程序。

然而，目标语言的形式使其难以在实践中编程。回想一下用 Expr 编写的阶乘程序：

fact : Expr G (TyFun TyInt TyInt)
fact = Lam (If (Op (==) (Var Stop) (Val 0))

(Val 1) (Op (*) (App fact (Op (-) (Var Stop) (Val 1)))
(Var Stop)))

由于这是一种特别有用的模式，因此 奉奤奲奩女 提供了语法重载1 使其在这种目标语言中更易于编程：

mkLam : TTName -> Expr (t::g) t' -> Expr g (TyFun t t')
mkLam _ body = Lam body

dsl expr
variable = Var
index_first = Stop
index_next = Pop
lambda = mkLam

dsl 块描述了每个语法构造是如何在目标语言中表示的。在这里的 expr 语言中， 任何变量都会被翻译
为 Var 构造器，使用 Pop 和 Stop 来构造 奤奥 奂奲奵奩奪奮 索引（即，由于变量本身被绑定，所以要统计有多
少个绑定）；而任何 𝜆夭表达式都会被翻译为 Lam 构造器。mkLam 函数会简单地忽略其第一个参数，它
是用户为变量选择的名字。 我们也可以通过这种方式来重载 let 与依赖函数的语法。现在可以将 fact
写成下面这样了：

fact : Expr G (TyFun TyInt TyInt)
fact = expr (\x => If (Op (==) x (Val 0))

(Val 1) (Op (*) (app fact (Op (-) x (Val 1))) x))

在这个新的版本中，expr 声明了下一个要被重载的表达式。我们可以利用习语括号， 通过以下声明再
进一步：

(<*>) : (f : Lazy (Expr G (TyFun a t))) -> Expr G a -> Expr G t
(<*>) f a = App f a

pure : Expr G a -> Expr G a
pure = id

注意，它无需成为 Applicative实现的一部分，因为习语括号记法会直接被翻译为名字 <*>和 pure，
针对特设（奡奤夭奨奯奣）类型的重载也被允许。现在我们可以写成：

fact : Expr G (TyFun TyInt TyInt)
fact = expr (\x => If (Op (==) x (Val 0))

(Val 1) (Op (*) [| fact (Op (-) x (Val 1)) |] x))

使用更加特设的重载、接口，以及新的语法规则，我们甚至可以再进一步：

2 Edwin C. Brady. 2011. IDRIS —: systems programming meets full dependent types. In Proceedings of the 5th
ACM workshop on Programming languages meets program verification (PLPV ‘11). ACM, New York, NY, USA, 43-54.
DOI=10.1145/1929529.1929536 http://doi.acm.org/10.1145/1929529.1929536

3 Edwin Brady and Kevin Hammond. 2010. Correct-by-Construction Concurrency: Using Dependent Types to Verify
Implementations of Effectful Resource Usage Protocols. Fundam. Inf. 102, 2 (April 2010), 145-176. http://dl.acm.org/
citation.cfm?id=1883636
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syntax "IF" [x] "THEN" [t] "ELSE" [e] = If x t e

fact : Expr G (TyFun TyInt TyInt)
fact = expr (\x => IF x == 0 THEN 1 ELSE [| fact (x - 1) |] * x)

1.13 杂杂杂项项项

在本节中，我们讨论了多种附加特性：

• 自动、隐式与默认参数

• 文学编程（奌奩奴奥奲奡奴奥 奐奲奯奧奲奡奭奭奩奮奧）

• 通过外部函数与外部库交互

• 接口

• 类型提供器（奔她奰奥 奐奲奯奶奩奤奥奲）

• 代码生成，以及

• 全域层级（奕奮奩奶奥奲女奥 奈奩奥奲奡奲奣奨她）

1.13.1 隐隐隐式式式参参参数数数

我们已经见过隐式参数了，它允许忽略能够被类型检查器推断出来的参数，例如：

index : {a:Type} -> {n:Nat} -> Fin n -> Vect n a -> a

自自自动动动隐隐隐式式式参参参数数数

在其它情况下，可以不通过类型检查来推断参数，而是通过在上下文中搜索恰当的值， 或通过构造证
明来推断参数。例如，以下 head 的定义需要证明列表非空：

isCons : List a -> Bool
isCons [] = False
isCons (x :: xs) = True

head : (xs : List a) -> (isCons xs = True) -> a
head (x :: xs) _ = x

如果可以静态地获知列表非空，那是由于它的值是已知的，或上下文中存在对它的证明。 证明可以自
动地构造，自动隐式参数允许它静默地发生。我们将 head 定义为：

head : (xs : List a) -> {auto p : isCons xs = True} -> a
head (x :: xs) = x

将隐式参数注解为 auto，表示 奉奤奲奩女 会试图搜索与其类型对应的值来填充它。 它会按照以下顺序尝
试：

• 局部变量，即类型正确的，在模式匹配中绑定的名字或 let 绑定。

• 所需类型的构造器。若它们有参数，就会递归地搜索到最深 失夰夰 层的深度。
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• 带函数类型的局部变量，对参数进行递归地搜索。

• 任何标出 %hint 注解的，带有相应返回类型的函数。

在找不到证明的情况下，它会像往常一样被显式地给出：

head xs {p = ?headProof}

定定定义义义隐隐隐式式式参参参数数数

除了让 奉奤奲奩女 自动查找给定类型的值外，有时我们还想要带有具体默认值的隐式参数。在 奉奤奲奩女 中，我们
可以用 default 注解来做这件事。尽管它主要是为了在 奡奵奴奯 自动构造证明失败，或找到的值没有帮助
时起辅助作用。然而，首先考虑一个更简单的， 不涉及证明的情况可能会更容易。

如果我们想要计算第 奮 个斐波那契数（第 夰 个斐波那契数定义为 夰），我们可以写：

fibonacci : {default 0 lag : Nat} -> {default 1 lead : Nat} -> (n : Nat) -> Nat
fibonacci {lag} Z = lag
fibonacci {lag} {lead} (S n) = fibonacci {lag=lead} {lead=lag+lead} n

定义完之后，fibonacci 5 等价于 fibonacci {lag=0} {lead=1} 5，它会返回第 夵 个斐波那契数。注
意虽然它可以工作，但这并不是 default 注解的用途，在这里它只用作展示。 通常，default 用于提
供定制证明搜索脚本的东西。

1.13.2 隐隐隐式式式转转转换换换

奉奤奲奩女 支持创建 隐隐隐式式式转转转换换换 ，在需要某项的类型能够匹配时， 它允许将一个类型的值自动转换成另一个
类型。这是为了增强便利性并减少冗余。 下面是个故意构造的简单例子：

implicit intString : Int -> String
intString = show

test : Int -> String
test x = "Number " ++ x

通常，我们无法将一个 Int 附加到一个 String 之后，不过隐式转换函数 intString 可以将 x 转换为
String，因此 test 定义的类型是正确的。 隐式转换的实现和其它函数一样，只不过加上了 implicit
修饰符， 且被限制为只能接受一个显式参数。

一次只有一个隐式转换会被应用。也就是说，隐式转换无法被链式调用。如前文所见， 简单类型的隐
式转换是不被鼓励的！更常见的做法是，使用隐式转换来减少 奅奄奓奌 的冗长度，或者隐藏证明的细节。
这些示例超出了本教程的范围。

1.13.3 文文文学学学编编编程程程

和 奈奡女奫奥奬奬 一样，奉奤奲奩女 支持 文文文学学学编编编程程程。如果某个文件的扩展名外 .lidr， 那么它会被当做文学编程文
件。在文学编程中，除了以大于号 > 开头的行外， 所有的内容都会被视为注释。例如：

> module literate

这是一行注释，主程序在下面

> main : IO ()
> main = putStrLn "Hello literate world!\n"
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附加的限制为，程序行（以 > 开头）与注释行（以任何其它字符开头）之间必须有一空行。

1.13.4 外外外部部部函函函数数数调调调用用用

在编程实践中，我们经常需要使用外部库，特别在与操作系统、文件系统、网络 等等等等等等 进行交互时。作
为 奐奲奥奬奵奤奥 的一部分，奉奤奲奩女 提供了轻量的外部函数接口。 我们假定读者有一定的 奃 和 gcc 编译器的知
识。首先，我们来定一个数据类型， 它描述了我们能够处理的外部类型：

data FTy = FInt | FFloat | FChar | FString | FPtr | FUnit

它们每一个都与 奃 的类型直接对应。分别为：int、double、char、 char*、void* 和 void。以下函
数还描述了它们到对应的 奉奤奲奩女 类型的翻译：

interpFTy : FTy -> Type
interpFTy FInt = Int
interpFTy FFloat = Double
interpFTy FChar = Char
interpFTy FString = String
interpFTy FPtr = Ptr
interpFTy FUnit = ()

外部函数由一组输入类型和返回类型描述，它们可以被转换为 奉奤奲奩女 类型：

ForeignTy : (xs:List FTy) -> (t:FTy) -> Type

外部函数被视作不纯粹的，因此 ForeignTy 构建了一个 IO 类型，例如：

Idris> ForeignTy [FInt, FString] FString
Int -> String -> IO String : Type

Idris> ForeignTy [FInt, FString] FUnit
Int -> String -> IO () : Type

我们通过为函数赋予名字、一系列参数的类型和返回值构建了一个外部函数调用。 内建的构造
mkForeign 将该函数的描述转换为一个可由 奉奤奲奩女 调用的函数：

data Foreign : Type -> Type where
FFun : String -> (xs:List FTy) -> (t:FTy) ->

Foreign (ForeignTy xs t)

mkForeign : Foreign x -> x

注意编译器期望 mkForeign 能够被完全地应用以构建完整的外部函数调用。例如， putStr 作为一个在
运行时系统中定义的外部函数 putStr 的调用，其实现如下：

putStr : String -> IO ()
putStr x = mkForeign (FFun "putStr" [FString] FUnit) x

include 与与与链链链接接接器器器指指指令令令

外部函数调用会按照 奉奤奲奩女 和 奃 的值的表示之间对应的转换，被直接翻译为 奃 函数的调用。 通常这会
需要将额外的库、头文件或目标文件链接进来。我们可以通过以下指令来完成：

• %lib target x — 将 libx 库 包 含 进 来 。 如 果 目 标 为 奃， 它 等 价 于 向 gcc 传
递 -lx 选 项 。 如 果 目 标 为 奊奡奶奡， 该 库 会 被 解 释 为 奭奡奶奥奮 的 依 赖 关 系 定 位 符
groupId:artifactId:packaging:version。
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• %include target x — 使用头文件或为给定的后端目标导入 x。

• %link target x.o — 在使用给定的后端目标时链接目标文件 x.o。

• %dynamic x.so — 动态链接共享的解释器目标文件 x.so。

测测测试试试外外外部部部函函函数数数调调调用用用

一般来说，奉奤奲奩女 解释器（用于类型检查和 奒奅奐奌）不会处理 奉奏 活动。除此之外，它既不会生成 奃 代
码，也不会将它编译成机器码，因此 %lib、%include 与 %link 是没有效果的。 奉奏 活动与 奆奆奉 调用可
使用特殊的 奒奅奐奌 命令 :x EXPR 来测试，而 奃 库可通过 :dynamic 命令或 %dynamic 指令来动态地加
载到解释器中。例如：

Idris> :dynamic libm.so
Idris> :x unsafePerformIO ((mkForeign (FFun "sin" [FFloat] FFloat)) 1.6)
0.9995736030415051 : Double

1.13.5 类类类型型型提提提供供供器器器

奉奤奲奩女 类型提供器，灵感来自 奆夣 的类型提供器，它能让我们的类型与 奉奤奲奩女 之外的世界建立「联系」。
例如，给定一个表示数据库模式（奓奣奨奥奭奡）的类型， 和一个针对它检查过的查询，类型提供器可以在
进行类型检查时读取真实数据库的模式。

奉奤奲奩女 类型提供器使用普通的 奉奤奲奩女 可执行语义来运行 奉奏 活动并提取出结果。 该结果会作为编译代码时
的常量被保存。它可以是个类型，此时它能像其它类型一样使用； 它也可以是个值，此时它也可以像
其它值一样使用，并作为一个索引被包含在类型中。

类型提供器尚且是个实验性的扩展。要启用它，请使用 %language 指令：

%language TypeProviders

某个类型 t 的提供器 p 不过就是个类型为 IO (Provider t) 的表达式。 %provide 指令会导致类型检
查器去执行该活动，并将其结果绑定到一个名字上。 我们最好用一个简单的例子来展示它。类型提供
器 fromFile 用于读取文本文件。 如果该文件由字符串 Int 构成，那么它就会提供 Int 类型。否则，
它就会提供 Nat 类型。

strToType : String -> Type
strToType "Int" = Int
strToType _ = Nat

fromFile : String -> IO (Provider Type)
fromFile fname = do Right str <- readFile fname

| Left err => pure (Provide Void)
pure (Provide (strToType (trim str)))

接着我们使用 %provide 指令：

%provide (T1 : Type) with fromFile "theType"

foo : T1
foo = 2

如果名为 theType 的文件由单词 Int 构成，那么 foo 的类型会是 Int。 否则，它会是 Nat。当 奉奤奲奩女
遇到该指令时，它首先会检查确认提供器表达式 fromFile theType 的类型为 IO (Provider Type)。
接着它会执行该提供器。 如果其结果为 Provide t，那么 T1 就会被定义为 t。否则，就会产生一个错
误。
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我们的数据类型 Provider t 定义如下：

data Provider a = Error String
| Provide a

我们已经见过 Provide 构造器了。Error 构造器允许类型提供器返回有用的错误信息， 本节中的示例
为了简单并未提供。更加复杂的类型提供器实现，包括一个静态检查的 奓契奌奩奴奥 绑定， 可从外部链接1

获取。

1.13.6 以以以 C 为为为编编编译译译目目目标标标

奉奤奲奩女 的默认编译目标为 奃。它通过以下命令编译：

$ idris hello.idr -o hello

此命令等价于：

$ idris --codegen C hello.idr -o hello

当使用以上命令编译时，它会生成一个临时的 奃 源码，接着再编译成名为 hello 的可执行文件。

要查看生成的 奃 代码，请通过以下命令编译：

$ idris hello.idr -S -o hello.c

要开启优化，请在代码中使用 %flag C 编译指令：

module Main
%flag C "-O3"

factorial : Int -> Int
factorial 0 = 1
factorial n = n * (factorial (n-1))

main : IO ()
main = do

putStrLn $ show $ factorial 3

要在编译生成的 奃 代码时加上调试信息，例如使用 gdb 在 奉奤奲奩女 程序中调试段错误时， 请使用 %flag
C 编译指令来包括调试符号，如下所示：

%flag C "-g"

1.13.7 以以以 JavaScript 为为为编编编译译译目目目标标标

奉奤奲奩女 可生成能够运行在浏览器以及 NodeJS 等类似环境中的 JavaScript 代码。 它可以通过 奆奆奉 与
JavaScript 生态进行交互。

代代代码码码生生生成成成

代码生成分为两种独立的目标。要生成适合在浏览器中运行的代码，请使用以下命令：

1 https://github.com/david-christiansen/idris-type-providers
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$ idris --codegen javascript hello.idr -o hello.js

产生的文件可以像其它 JavaScript 代码那样嵌入到 奈奔奍奌 中。

生成 NodeJS 代码的方式有点不同。奉奤奲奩女 会输出一个可直接调用 node 运行的 JavaScript 文件。

$ idris --codegen node hello.idr -o hello
$ ./hello
Hello world

考虑到 JavaScript 代码生成器使用 console.log 将文本写入到 stdout， 因此它会自动在每个字符串
之后加上换行。而此行为不会在 NodeJS 代码生成器中出现。

使使使用用用 FFI

要编写一个有用的应用，我们需要与外部世界进行交流。可能我们想要操作 奄奏奍 或发送 奁奪奡奸 请求。
为此可以使用 奆奆奉。由于大部分 JavaScript 奁奐奉 需要回调，因此我们需要扩展 奆奆奉 以将函数作为参数
来传入。

JavaScript 奆奆奉 的工作方式与一般的 奆奆奉 有点不同。它使用位置参数将我们的参数直接插入一段
JavaScript 代码中。

我们可以使用 JavaScript 的原语加法：

module Main

primPlus : Int -> Int -> IO Int
primPlus a b = mkForeign (FFun "%0 + %1" [FInt, FInt] FInt) a b

main : IO ()
main = do

a <- primPlus 1 1
b <- primPlus 1 2
print (a, b)

注意 %n 记法确定了从 夰 开始的第 n 个给定的外部函数的参数。 当你需要一个百分号而非位置时，请使
用 %% 来代替。

将函数传入外部函数中是非常相似的。假设我们想要从 JavaScript 世界中调用以下函数：

function twice(f, x) {
return f(f(x));

}

显然我们需要在这里传入一个函数 f （我们可以从 twice 中使用 f 的方式推断出来，如果 JavaScript
有类型的话会更加明显）。

当你给 JavaScript 奆奆奉 一个类型为 FFunction 的东西时，它能够理解要将函数作为参数。 以下示例代
码在 JavaScript 中调用了 twice 并将结果返回到了 奉奤奲奩女 程序中：

module Main

twice : (Int -> Int) -> Int -> IO Int
twice f x = mkForeign (

FFun "twice(%0,%1)" [FFunction FInt FInt, FInt] FInt
) f x

main : IO ()
(äÿŃéąțçżğçżŋ)
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(çżŋäÿŁéąț)

main = do
a <- twice (+1) 1
print a

该程序输出 3，正如我们所料。

包包包含含含外外外部部部的的的 JavaScript 文文文件件件

只要某人使用 JavaScript，他就有可能想要包含外部库，或者通过 奆奆奉 调用存储在外部文件中的函
数。JavaScript 和 NodeJS 代码生成器能够理解 %include 指令。请注意 JavaScript 和 NodeJS 是由不
同的代码生成器处理的， 因此你需要指明所需的目标。这也就表示你可以在同一个 奉奤奲奩女 源文件中分别
为 JavaScript 和 NodeJS 包含不同的文件。

因此如果你想要添加外部的 JavaScript 文件，可以这样做：

对于 NodeJS：

%include Node "path/to/external.js"

要在浏览器中使用：

%include JavaScript "path/to/external.js"

给定的文件会被添加的生成代码的顶部。对于库包，你也可以使用 奩奰奫奧 文件中的 奯奢奪女 选项来将 奪女 文件
包含在安装中，并使用：

%include Node "package/external.js"

奉奤奲奩女 的 JavaScript 和 NodeJS 后端也会在此位置查找文件。

包包包含含含 NodeJS 模模模块块块

NodeJS 代码生成器也可以通过 %lib 指令来包含模块。

%lib Node "fs"

该指令会编译成以下 JavaScript：

var fs = require("fs");

缩缩缩减减减生生生成成成的的的 JavaScript

奉奤奲奩女 会产生非常大的 JavaScript 代码块。然而，生成的代码可通过 奇奯奯奧奬奥 的 closure-compiler 缩
小。其它的缩减器也可用，不过 closure-compiler 提供了更高级的编译，它会做一些侵入性的内敛和
代码消除。奉奤奲奩女 可以充分利用这种编译模式， 强烈建议在传输用 奉奤奲奩女 编写的 JavaScript 应用时使用
它。

1.13.8 累累累积积积性性性

由于值可以出现在类型中， 反反反之之之亦亦亦然然然，因此类型自然也有类型。例如：
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*universe> :t Nat
Nat : Type
*universe> :t Vect
Vect : Nat -> Type -> Type

但是 Type 的类型呢？如果我们询问 奉奤奲奩女，它会报告：

*universe> :t Type
Type : Type 1

如果 Type 是它自己的类型，那么它会因为 奇奩奲奡奲奤 悖论 而导致不一致性，因此在内部存在类型的 层层层级级级
（（（Hierarchy））） （或 全全全域域域，奕奮奩奶奥奲女奥）：

Type : Type 1 : Type 2 : Type 3 : ...

全域类型是 积积积累累累（（（Cumulative））） 的，也就是说，如果有 x : Type n， 我们也可以有 x : Type m
使得 n < m。如果类型检查器发现了任何不一致性， 它就会生成这种全域约束并报告一个错误。一般来
说，程序员无须担心它， 但它确实可以防止（构造出）如下的程序：

myid : (a : Type) -> a -> a
myid _ x = x

idid : (a : Type) -> a -> a
idid = myid _ myid

将 myid 应用到其自身会导致在全域层级中出现一个循环，即 myid 第一个参数的类型为 Type，如果要
将其应用到自身，那么其级别不能低于所要求的级别。

1.14 扩扩扩展展展阅阅阅读读读

有关 奉奤奲奩女 编程的更多信息，以及依赖类型编程的一般问题解答，可从多种来源获取：

• 奉奤奲奩女 网站（奨奴奴奰夺夯夯奷奷奷央奩奤奲奩女夭奬奡奮奧央奯奲奧夯）以及在邮件列表中提问。

• 奷奥奢奣奨奡奴央奦奲奥奥奮奯奤奥央奮奥奴 上的 #idris 奉奒奃 频道。

• 维基（奨奴奴奰女夺夯夯奧奩奴奨奵奢央奣奯奭夯奩奤奲奩女夭奬奡奮奧夯奉奤奲奩女夭奤奥奶夯奷奩奫奩夯）上有更多用户提供的信息， 特别是：

– 奨奴奴奰女夺夯夯奧奩奴奨奵奢央奣奯奭夯奩奤奲奩女夭奬奡奮奧夯奉奤奲奩女夭奤奥奶夯奷奩奫奩夯奍奡奮奵奡奬

– 奨奴奴奰女夺夯夯奧奩奴奨奵奢央奣奯奭夯奩奤奲奩女夭奬奡奮奧夯奉奤奲奩女夭奤奥奶夯奷奩奫奩夯奌奡奮奧奵奡奧奥夭奆奥奡奴奵奲奥女

• 查查查看看看发发发行行行版版版中中中的的的 Prelude 并并并浏浏浏览览览 samples 目目目录录录。。。Idris 的的的源源源码码码可可可在在在线线线获获获取取取：：： 奨奴奴奰女夺夯夯奧奩奴奨奵奢央
奣奯奭夯奩奤奲奩女夭奬奡奮奧夯奉奤奲奩女夭奤奥奶 。

• Idris Hackers 网站上的既有项目： 奨奴奴奰夺夯夯奩奤奲奩女夭奨奡奣奫奥奲女央奧奩奴奨奵奢央奩奯 。

• 多篇论文（例如1、2 和3）。虽然它们大多描述的是旧版的 奉奤奲奩女。

1 Edwin Brady and Kevin Hammond. 2012. Resource-Safe systems programming with embedded domain specific
languages. In Proceedings of the 14th international conference on Practical Aspects of Declarative Languages (PADL‘12),
Claudio Russo and Neng-Fa Zhou (Eds.). Springer-Verlag, Berlin, Heidelberg, 242-257. DOI=10.1007/978-3-642-27694-
1_18 http://dx.doi.org/10.1007/978-3-642-27694-1_18

2 Edwin C. Brady. 2011. IDRIS —: systems programming meets full dependent types. In Proceedings of the 5th
ACM workshop on Programming languages meets program verification (PLPV ‘11). ACM, New York, NY, USA, 43-54.
DOI=10.1145/1929529.1929536 http://doi.acm.org/10.1145/1929529.1929536

3 Edwin C. Brady and Kevin Hammond. 2010. Scrapping your inefficient engine: using partial evaluation to
improve domain-specific language implementation. In Proceedings of the 15th ACM SIGPLAN international confer-
ence on Functional programming (ICFP ‘10). ACM, New York, NY, USA, 297-308. DOI=10.1145/1863543.1863587
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CHAPTER 2

常见问题解答（FAQ）

2.1 Agda 跟跟跟 Idris 有有有啥啥啥不不不一一一样样样啊啊啊？？？

和 奉奤奲奩女 一样，奁奧奤奡 也是个带有依赖类型的函数式语言，并且支持依赖模式匹配。 它们都能编写程序
和证明。不过，奉奤奲奩女 一开始就侧重于为通用编程而设计，而非 奁奧奤奡 侧重的定理证明。因此，它支持与
系统库和 奃 程序的互操作性，以及用于实现 奅奄奓奌 （领域特定语言）的语言构造。它还包括更高级的
编程构造，例如接口（类似于类型类）和 do 记法。

奉奤奲奩女 支持多种后端（默认为 奃 和 奊奡奶奡奓奣奲奩奰奴，可以通过插件添加更多），拥有一个 奃 编写的，带有垃
圾收集器和内建并发消息传递的参考运行时系统。

2.2 有有有标标标准准准库库库文文文档档档没没没？？？有有有函函函数数数列列列表表表没没没？？？

预置包的 奁奐奉 文档已在文档页中列出。

不幸的是，Idris 的默认前导和预置包在文档方面未必完整。其它查找函数的方式包括：

• 奒奅奐奌 命令：

– 使用 :apropos 来搜索文档和函数名中的文本。

– 使用 :search 来根据类型搜索函数。

– 使用 :browse 来列出给定名字空间中的内容。

• 使用 奒奅奐奌 的自动补全功能。

• 使用 grep 在 libs/ 中搜索源码

如果你发现预置包缺少文档，请随心为它补充一些。当然也可以通知别人来做这件事。 Idris 提供了显
示富文档的语法，富文档可使用 :doc 命令浏览，并在生成的 奈奔奍奌 奁奐奉 文档中列出。

夶头

http://www.idris-lang.org/documentation/
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2.3 Idris 能能能拿拿拿来来来干干干活活活不不不？？？

奉奤奲奩女 主要是个研究工具，用来探索用依赖类型开发软件的可能性，也就是说它的主要目的（还） 不是
开发可用于生产的系统。因此，某些方面上它还有些粗糙，也缺少很多库。现在还没人全职搞 奉奤奲奩女，我
们目前也没有资源来独立完善该系统。因此，我们不推荐你围绕它来开展业务！

话虽如此，我们非常欢迎帮助推进 奉奤奲奩女 适应生产的贡献，包括（但不限于）额外的库支持、 完善运行
时系统（并确保其健壮性）、提供并维护 奊奖奍 后端等等。

2.4 为为为啥啥啥 Idris 用用用了了了及及及早早早求求求值值值，，，不不不用用用惰惰惰性性性求求求值值值啊啊啊？？？

奉奤奲奩女 采用及早求值主要是为了能更好地预测性能，特别是其长期目标之一就是能够编写高效 且经过验
证的底层代码，例如设备驱动以及网络设施。此外，奉奤奲奩女 的类型系统能让我们精确地 指明每个值的类
型，因此也就能确定每个值在运行时的形式。在惰性求值的语言中，考虑一个 Int 类型的值：

thing : Int

thing 在运行时是如何表示的？它是一个按照位模式来表示的整数， 还一个是指向了能计算出整数的代
码的指针？在 奉奤奲奩女 中，我们决定按照类型来精确地区分它们：

thing_val : Int
thing_comp : Lazy Int

这样，thing_val 就能确保为具体的 Int，而 thing_comp 则是会产生 Int 的计算。

2.5 俺俺俺咋咋咋弄弄弄个个个惰惰惰性性性控控控制制制结结结构构构呐呐呐？？？

你可以用特殊的 Lazy 类型来创建这种控制结构。例如，奉奤奲奩女 中的 if...then...else... 会被扩展为
ifThenElse 函数的应用。 它在库中对布尔值的默认实现如下：

ifThenElse : Bool -> (t : Lazy a) -> (e : Lazy a) -> a
ifThenElse True t e = t
ifThenElse False t e = e

t 和 e 的类型 Lazy a 指出它们只会在需要时被求值，也就是说，它们是惰性求值的。

2.6 REPL 里里里头头头的的的求求求值值值行行行为为为跟跟跟咱咱咱想想想的的的不不不一一一样样样啊啊啊，，，这这这咋咋咋回回回事事事儿儿儿= =？？？

作为一个完全依赖类型的语言，奉奤奲奩女 的求值分为两个阶段，编译时与运行时。在编译时， 它只会对
已知完全（即保证会终止且覆盖了所有可能输入）的东西求值， 以此来保持类型检查的可判定性。编
译时的求值器属于 奉奤奲奩女 核心的一部分，它用 奈奡女奫奥奬奬 编写，按照值的 奈奏奁奓（奈奩奧奨奥奲 奏奲奤奥奲 奁奢女奴奲奡奣奴
奓她奮奴奡奸 高阶抽象语法）风格的表示来实现。 由于已知所有东西都有规范的形式，选用哪种求值策略实
际上也就无关紧要了， 因为它们都会得到相同的答案，而在实践中，它会执行 奈奡女奫奥奬奬 运行时系统选择
的任何事情。

按照约定，奒奅奐奌 使用编译时求值的概念。除了更容易实现外（因为我们可以用求值器）， 它在展示
项（奔奥奲奭）如何在类型检查器中求值时也非常有用。

2.3. Idris 能能能拿拿拿来来来干干干活活活不不不？？？ 65
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Idris> \n, m => (S n) + m
\n => \m => S (plus n m) : Nat -> Nat -> Nat

Idris> \n, m => n + (S m)
\n => \m => plus n (S m) : Nat -> Nat -> Nat

2.7 为为为啥啥啥咱咱咱不不不能能能在在在类类类型型型里里里用用用没没没参参参数数数的的的函函函数数数呐呐呐？？？

如果你在类型中使用小写字母开头的名字，且它们没用被应用于任何参数，那么 奉奤奲奩女 会把它视为隐式
绑定的参数。例如：

append : Vect n ty -> Vect m ty -> Vect (n + m) ty

这里的 n、m 和 ty 是隐式绑定的。此规则同样适用于在别处定义的， 带这类名字的函数。例如，你或
许还有：

ty : Type
ty = String

即便如此，ty 还是会被视作 append 定义中隐式绑定的参数，而不会让 append 的类型等价于你预想
的：

append : Vect n String -> Vect m String -> Vect (n + m) String

采用了此规则后，你无需其它上下文，只要查看 append 的类型就能明白哪些是隐式绑定的名字。

如果你想在类型中使用不被应用的名字，那么有两种选择：你可以显式地限定它，例如，若 ty在 Main
的命名空间中定义，你可以这样做：

append : Vect n Main.ty -> Vect m Main.ty -> Vect (n + m) Main.ty

此外，你还可以使用不以小写字母开头的名字，它决不会被隐式绑定：

Ty : Type
Ty = String

append : Vect n Ty -> Vect m Ty -> Vect (n + m) Ty

按照约定，如果你打算将一个名字用作类型同义，那么最好以大写字母开头来避免此限制。

2.8 这这这破破破程程程序序序明明明显显显能能能停停停，，，为为为啥啥啥 Idris 还还还说说说它它它有有有可可可能能能不不不完完完全全全？？？

由于停机问题的不可判定性， 奉奤奲奩女 通常无法判定一个程序是否会停止。然而，我们可以找出某些确定
可以终止的程序。 奉奤奲奩女 使用「大小改变终止（女奩奺奥 奣奨奡奮奧奥 奴奥奲奭奩奮奡奴奩奯奮）」来寻找从函数返回到自身的
递归路径。 在此路径上，至少必有一个参数会收敛到基本情况。

• 奉奤奲奩女 支持相互递归的函数

• 不过，递归路径上的所有函数必须被完整地应用。此外，奉奤奲奩女 不支持高阶应用。

• 在递归调用的过程中，奉奤奲奩女 会查找语法上更小的输入参数，以此来识别能收敛到基本情况的参
数。 例如，k 在语法上小于 S (S k)，因为 k 是 S (S k) 的子项（女奵奢奴奥奲奭）， 然而 (k, k) 在
语法上却不小于 (S k, S k)。

2.7. 为为为啥啥啥咱咱咱不不不能能能在在在类类类型型型里里里用用用没没没参参参数数数的的的函函函数数数呐呐呐？？？ 66
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如果你有个确信会终止的函数，但 奉奤奲奩女 不信，那么你可以调整程序的结构，或者使用 assert_total
函数。

夼夼夼夼夼夼夼 奈奅奁奄 奉奤奲奩女 啥时候能自举啊？ 夽夽夽夽夽夽夽夽夽夽夽夽夽夽夽夽夽夽夽夽夽夽

这事不急，虽说从长远来看这主意不错。就目前来说，实现支持自举的库是一项很有价值的工作夬 比如
说参数解析器以及符合 奐奏奓奉奘 标准的库用于系统交互。

2.9 Idris 有有有全全全域域域多多多态态态不不不? Type 是是是啥啥啥类类类型型型的的的？？？

奉奤奲奩女 并没有全域多态（奕奮奩奶奥奲女奥 奐奯奬她奭奯奲奰奨奩女奭），而是拥有全域的积累层级 （奃奵奭奵奬奡奴奩奶奥 奈奩奥奲奡奲夭
奣奨她），如 Type : Type 1、Type 1 : Type 2 等等。 积累性的意思是，若 x : Type n 且 n <=
m，则 x : Type m。 全域的级别总是由 奉奤奲奩女 推导，且无法被显式地指定。执行 奒奅奐奌 命令 :type
Type 1 以及试图为任何类型指定全域级别时，都会产生一个错误。

2.10 为为为啥啥啥 Idris 用用用 Double 不不不用用用 Float64？？？

历史上 奃 和很多语言都用分别用 Float 和 Double 来表示 夳夲 位和 夶头 位的浮点数。较新的语言，如
奒奵女奴 和 奊奵奬奩奡 都开始遵循 奉奅奅奅 浮点运算标准 夨奉奅奅奅 夷夵头天 的命名规范了。 它将单精度和双精度的数描
述为 Float32 和 Float64，其大小在类型名中描述。

由于开发者更熟悉旧有的命名约定，而 奉奤奲奩女 的开发者也选择了它，因此 奉奤奲奩女 采用了 奃 风格的约定。
也就是说名称 Double 用于描述双精度浮点数，而 奉奤奲奩女 现在还不支持 夳夲 位浮点数。

2.11 -ffreestanding 是是是啥啥啥？？？

在相对路径中拥有自己的库和编译器时，可使用 freestanding 命令行参数来构建 奉奤奲奩女 二进制
文件。当构建过程中的安装目录未知时，它对于构建二进制文件来说非常有用。 当传入此参
数时，IDRIS_LIB_DIR 环境变量需要设置为相对与 idris 可执行文件所在的 奉奤奲奩女 库的路径。
IDRIS_TOOLCHAIN_DIR 环境变量是可选的，如果设置了它，奉奤奲奩女 就会在该路径下寻找 奃 编译器。
例如：

IDRIS_LIB_DIR="./libs" \
IDRIS_TOOLCHAIN_DIR="./mingw/bin" \
CABALFLAGS="-fffi -ffreestanding -frelease" \
make

2.12 话话话说说说「「「Idris」」」是是是个个个啥啥啥名名名儿儿儿 O_O？？？

有一定年龄的英国人可能很熟悉唱歌贼好听的小火龙妹砸。 你要是不满意，自己想个好词儿啊（手动
微笑 夺夭天

2.13 还还还能能能有有有 Unicode 操操操作作作符符符不不不？？？

下面是为什么我们不应该支持 奕奮奩奣奯奤奥 操作符的原因：

2.9. Idris 有有有全全全域域域多多多态态态不不不? Type 是是是啥啥啥类类类型型型的的的？？？ 67
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• 它难以输入（如果你在使用别人的代码，这点就很重要）。很多编辑器都有它自己的输入法， 不
过你必须知道怎么输入。

• 并不是任何软件都能轻松支持它。在一些移动 奅奭奡奩奬 客户端、基于终端的 奉奒奃 客户端、 以及
套奥奢 浏览器等软件中都会出现渲染问题。

• 即便我们不在标准库中使用它（绝对不会！），然而只要有人在他们的库代码中用了它， 别人就
得去处理它。

• 有太多字符看起来太像了。单是分不清 夰 和 奏 就会造成很多麻烦，更不说各式各样的冒号和括号
了。

如果使用得当，奕奮奩奣奯奤奥 操作符能让代码看起来更漂亮，然而 lhs2TeX 也能。 也许几年后情况有变，
软件能更好地应对它，到时候重新审视它才有意义。然而目前， 奉奤奲奩女 不会为操作符提供任何 奕奮奩奣奯奤奥
符号。

这似乎是个 套奡奤奬奥奲 定律 在工作中的实例。

本答案基于 奅奤奷奩奮 奂奲奡奤她 对此 推送请求 的回应。

2.14 Idris 有有有社社社区区区准准准则则则不不不？？？

这里 是奉奤奲奩女 社区规范的声明。

2.15 还还还有有有哪哪哪儿儿儿能能能找找找到到到解解解答答答啊啊啊？？？

奇奩奴奨奵奢 的维基上还有个非官方 奆奁契， 其中解答了更多技术问题，而且经常更新。

2.14. Idris 有有有社社社区区区准准准则则则不不不？？？ 68
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CHAPTER 3

用 Idris 实现带有状态的系统：ST 教程

本教程叙述了如何用 奉奤奲奩女 的 Control.ST 库实现带有状态的系统。

注注注解解解: 奉奤奲奩女 文档已按照 创创创作作作共共共用用用 CC0 许许许可可可协协协议议议 发布。因此根据法律规定， Idris 社社社区区区 已放弃对
奉奤奲奩女 文档的所有版权以及相关或邻接的权利。

关于 奃奃夰 的更多信息参见：奨奴奴奰女夺夯夯奣奲奥奡奴奩奶奥奣奯奭奭奯奮女央奯奲奧夯奰奵奢奬奩奣奤奯奭奡奩奮夯奺奥奲奯夯失央夰夯奤奥奥奤央奺奨

3.1 概概概览览览

像 奉奤奲奩女 这种可以直接用类型系统对程序进行推理的函数式语言， 仅凭程序能够编译这一点，我们就能
确确确定定定该程序会正确运行（即按照类型描述的规范运行）。

然而在现实中，软件依赖于状态，很多组件则依赖于状态机。它们可以描述像 奔奃奐 这样的网络传输协
议， 实现事件驱动的系统以及正则表达式的匹配。此外，像网络 奓奯奣奫奥奴 和文件这类的很多基础资源，
都由状态机隐式地管理；特定操作只有在资源处于特定状态时才可行，而这些操作也可以改变底层资源
的状态。 例如，只有向已建立连接的网络 奓奯奣奫奥奴 发送消息才有意义，关闭 奓奯奣奫奥奴 会将其状态从“打开
”切换为“关闭”。 状态机同样可以编码重要的安全性质。比如，在一个 奁奔奍（自动取款机）的软件
实现中， 有一点性质非常重要：奁奔奍 只有在卡片插入且通过密码验证的状态下才能吐出钞票。

本教程将介绍Control.ST 库，它支持对带有状态和副作用的程序进行编程和推理。 该库已包含在 奉奤奲奩女
发行版当中（目前属于 contrib 包）。本教程假设读者已经熟悉 Idris 教程 夨姩妡妵 夲天 中所述的纯函数式
的编程方法。ST 库基于《奉奤奲奩女 类型驱动开发》一书中第 失夳 和 失头 章所讨论的内容，如需更多背景信息
可以参考此书。

我们可使用 ST 库编写由多个状态转移系统复合而成的程序。它支持两种复合方式：第一，我们能够同
时使用数个独立实现的状态转移系统；第二，我们能够基于其它状态转移系统实现新的状态转移系统。

夶夹

https://creativecommons.org/publicdomain/zero/1.0/deed.zh
http://www.idris-lang.org/
https://www.manning.com/books/type-driven-development-with-idris


Idris 语语语言言言文文文档档档, 版版版本本本 1.3.1

3.1.1 示示示例例例：：：需需需要要要登登登录录录的的的数数数据据据存存存储储储系系系统统统

许多软件的组件依赖于状态，有些操作仅在特定状态下才有效。例如，考虑一个安全的数据存储系统，
它只有在用户登录的情况下才能访问某些机密数据。 该系统可以处于以下两种状态之一夺

• 已登录，在此状态下，用户可以访问机密数据

• 未登录，在此状态下，用户无法访问机密数据

我们可以提供登录、登出和读取数据命令，如下图所示：

如果 登录 命令被成功执行，就会使系统状态从 未登录 转移到 已登录 状态。登出 命令会使系统状态从
已登录 转移到 未登录 状态。最重要的是，读取数据 命令仅在系统处于 已登录 状态时才有效。

我们通常使用类型检查器来确保变量和参数的使用一致性。然而，主流的类型系统并不能很好地支持像
“某些操作只有在资源处于合适的状态时才被执行”这类性质的静态检查。 例如，在数据存储系统的
示例中，检查“用户在执行 读取数据 前是否成功登录”这一性质非常重要。 ST 库能让我们在类型系统
中表达这类协协协议议议，并且在编编编译译译阶阶阶段段段确保机密数据只有在用户处于已登录状态时才能被读取。

3.1.2 大大大纲纲纲

本教程从描述如何操作独立的状态开始（ST 介绍：用状态来工作 夨姩妡妵 夷夰天），引入了 STrans 数据类
型来描述带有状态的函数，以及 ST 用来描述顶层的状态转移。 接下来的章节（用类型表示状态机
夨姩妡妵 夷夸天）描述了如何用类型表示状态机，以及如何定义接接接口口口以描述带有状态的系统。之后（复合状态
机 夨姩妡妵 夸夵天）描述了如何复合带有多个状态机的系统。 它解释了如何实现同时使用多个状态机的系统，
以及如何基于低级系统来实现高级的带有状态的系统。 最后（示例：网络 Socket 编程 夨姩妡妵 夹夵天）我们
将看到一个带有状态的 奁奐奉 应用于真实场景的例子，它实现了 奐奏奓奉奘 网络 奓奯奣奫奥奴 奁奐奉。

Control.ST 库在 奅奤奷奩奮 奂奲奡奤她 的一篇文稿 “奓奴奡奴奥 奍奡奣奨奩奮奥女 奁奬奬 奔奨奥 套奡她 奄奯奷奮” 中亦有提及，你可
以从这里获取它。 这篇文章展示了本教程中的很多例子，更加深入地描述了它们的动机、设计、以及
实现。

3.2 ST 介介介绍绍绍：：：用用用状状状态态态来来来工工工作作作

Control.ST 库提供了在函数中创建、读取、写入和销毁状态，以及在函数类型中跟踪状态变化的功
能。它基于资资资源源源（（（Resources）））的概念，本质上就是可变变量和依赖类型。 STrans 会在函数运行时跟
踪资源的变化：

STrans : (m : Type -> Type) ->
(resultType : Type) ->
(in_res : Resources) ->
(out_res : resultType -> Resources) ->
Type

类型为 STrans m resultType in_res out_res_fn 的值表示一系列可以操作状态的动作。 其参数分
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别为：

• m 表示一个底层的计计计算算算上上上下下下文文文（（（Computation Context））），各种动作会在其中执行。 通常，它
是一个实现了 Monad 的泛型，但并非必须如此。具体来说，我们无需理解单子 （奍奯奮奡奤）就能高
效地使用 ST！

• resultType 表示这一系列动作会产生的值的类型。

• in_res 表示一个在执行动作之之之前前前可用的资资资源源源列表。

• out_res 表示一个在执行动作之之之后后后可用的资资资源源源列表，它随动作的结果而不同。

我们可以用 STrans 在函数的类型中描述状状状态态态转转转移移移系系系统统统（（（State Transition Systems）））。我们会在之
后定义资源（Resources），现在你可以先把它看做“现实世界的状态”的抽象表示。通过给定输入资
源（in_res）和输出资源（out_res），我们可以描述允许函数执行的前前前提提提条条条件件件（（（Precondition）））和
描述了函数如何影响世界的所有状态的后后后置置置条条条件件件（（（Postcondition）））。

本节以一些 STrans 函数的小例子开始，看看如何执行它们。我们还介绍了 ST，一个类型级的函数，它
能让我们简明地描述带有状态的函数的状态转移。

对对对示示示例例例进进进行行行类类类型型型检检检查查查

对于本节和整个教程，你需要 import Control.ST 并通过向 idris 传递 -p contrib 参数来添加
contrib 包。

3.2.1 初初初试试试：：：操操操作作作 State

STrans 函数的类型解释了它如何影响一组 Resources。资源拥有一个类型为 Var 的标标标签签签（（（label））），我
们会用它在函数中引用该资源，并通过 label ::: type 的形式将该资源的状态写入奠奠奒奥女奯奵奲奣奥女奠奠 列
表。

例如，以下函数的输入资源为 x，类型为 State Integer；输出资源的类型仍为 State Integer 夺

increment : (x : Var) -> STrans m () [x ::: State Integer]
(const [x ::: State Integer])

increment x = do num <- read x
write x (num + 1)

increment 类类类型型型中中中的的的冗冗冗余余余

increment 的类型看起来有点冗余，其中输输输入入入和输输输出出出资源的类型虽然是相同的，但还是重复了一遍。
我们在 ST：直接表示状态转移 夨姩妡妵 夷夷天一节中描述 ST 类型时，会介绍一种更加简洁的类型写法。

本函数通过 read 读取资源 x 中存储的值，将其自增后的结果用 write 写回资源 x 中。稍后我们会看到
read 和 write 的类型（见 STrans 的原语操作 夨姩妡妵 夷夶天）。我们还可以创建和删除资源：

makeAndIncrement : Integer -> STrans m Integer [] (const [])
makeAndIncrement init = do var <- new init

increment var
x <- read var
delete var
pure x

makeAndIncrement 的类型指明了它的入口（[]）和出口（const []）中没没没有有有可用的资源。它会用 new

3.2. ST 介介介绍绍绍：：：用用用状状状态态态来来来工工工作作作 71



Idris 语语语言言言文文文档档档, 版版版本本本 1.3.1

创建一个新的 State 资源（接受一个资源的初始值），对其值自增，将该值读出来，然后用 delete 删
除它，返回该资源的最终值。我们后面同样会看到 new 和 delete 的类型。

STrans``（类型为 ``Type -> Type）的参数 m 叫做计计计算算算上上上下下下文文文（（（Computation Context））），函数
会在其中运行。在这里，该类型级变量指明了我们可以在任任任何何何上下文中运行它。我们可以在同一个上下
文中用 runPure 运行它。例如，将以上定义保存在 Intro.idr 文件中，然后在 奒奅奐奌 中运行以下语
句：

*Intro> runPure (makeAndIncrement 93)
94 : Integer

通过交互式的，类型驱动的方式来实现 STrans 是个不错的主意。例如，在通过 new init 创建了资源
后，你可以为程序剩余的部分留一个坑坑坑（（（Hole）））来看到资源的创建是如何影响类型的：

makeAndIncrement : Integer -> STrans m Integer [] (const [])
makeAndIncrement init = do var <- new init

?whatNext

如果你检查一下 ?whatNext 的类型，就会发现有一个可用的资源 var，而在函数调用完成后应当不会再
有可用的资源：

init : Integer
m : Type -> Type
var : Var

--------------------------------------
whatNext : STrans m Integer [var ::: State Integer] (\value => [])

这个小例子可以在任何计算上下文 m 中工作。然而通常，我们会在一个更加严格的上下文中工作。例
如，我们可能想要编写一个只能在支持交互式程序的上下文中工作的程序。为此，我们需要学习如何从
底层上下文中提提提升升升（（（Lift）））操作。

3.2.2 提提提升升升：：：使使使用用用计计计算算算上上上下下下文文文

比如说，我们现在并不想直接把初始整数传入 makeAndIncrement，而是想要把它从控制台读进来。 那
么我们就要把一般的工作上下文 m 换成特定的上下文 IO：

ioMakeAndIncrement : STrans IO () [] (const [])

lift 函数给了我们访问 IO 操作的方式。我们可以将 ioMakeAndIncrement 定义如下：

ioMakeAndIncrement : STrans IO () [] (const [])
ioMakeAndIncrement

= do lift $ putStr "Enter a number: "
init <- lift $ getLine
var <- new (cast init)
lift $ putStrLn ("var = " ++ show !(read var))
increment var
lift $ putStrLn ("var = " ++ show !(read var))
delete var

lift 函数能让我们直接使用底层计算上下文（此处为 IO）中的函数。同样，我们很快就会看到 lift
具体的类型。

!-记记记法法法

在 ioMakeAndIncrement 中，我们使用了 !(read var) 从资源中读取信息。 你可以在 奉奤奲奩女 教程
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（见单子与 do-记法 夨姩妡妵 夲头天）中找到关于 !夭记法的详情。 简单来说，它允许我们直接就地使用
STrans 类型的函数，而不必先将其结果绑定到一个变量。

至少从概念上来说，你可以将它当做拥有以下类型的函数：

(!) : STrans m a state_in state_out -> a

这个语法糖会在执行 do夭语句块中的当前动作之前立即绑定一个变量， 然后在 !夭表达式的位置就地使
用该变量。

然而在实践中，使用像 IO 这样特特特定定定的上下文通常是种糟糕的做法。首先，它需要我们在代码中到处泼
洒 lift，这会影响可读性。再者，也是更重要的一点，它会降低函数的安全性，我们会在下一节（用
类型表示状态机 夨姩妡妵 夷夸天）中看到这一点。

所以我们改用定义接接接口口口的方式来限制计算上下文。例如，Control.ST 中定义了 ConsoleIO 接口，它为
控制台的基本交互提供了必要的方法：

interface ConsoleIO (m : Type -> Type) where
putStr : String -> STrans m () res (const res)
getStr : STrans m String res (const res)

也就是说，我们能够以任何可用的资源 res 读写控制台，这两个方法均不会对可用的资源产生影响。IO
对它的实现如下：

ConsoleIO IO where
putStr str = lift (Interactive.putStr str)
getStr = lift Interactive.getLine

现在，我们可以将 ioMakeAndIncrement 定义为：

ioMakeAndIncrement : ConsoleIO io => STrans io () [] (const [])
ioMakeAndIncrement

= do putStr "Enter a number: "
init <- getStr
var <- new (cast init)
putStrLn ("var = " ++ show !(read var))
increment var
putStrLn ("var = " ++ show !(read var))
delete var

它不仅可以在特定的 IO 中工作，还可以在一般的 io 上下文中工作，我们只需在该上下文中提供一个
ConsoleIO 的实现即可。相较于初版而言，它有以下优点：

• 所有对 lift 的调用都在接口的实现中，而非在 ioMakeAndIncrement 中

• 我们可以提供另一种 ConsoleIO 的实现，比如在基本的 奉夯奏 中支持异常或日志。

• 在下一节（用类型表示状态机 夨姩妡妵 夷夸天）中我们将会看到，它可以让我们定义安全的 奁奐奉，以便
更加精确地操作具体的资源。

我们之前在同一个上下文中使用 runPure 来运行 makeAndIncrement。而在这里，我们则使用 run，它
能够让我们在任何上下文中执行 STrans 程序（只要该上下文实现了 Applicative 即可）。我们可以像
下面这样在 奒奅奐奌 中执行 ioMakeAndIncrement：

*Intro> :exec run ioMakeAndIncrement
Enter a number: 93
var = 93
var = 94
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3.2.3 用用用依依依赖赖赖类类类型型型操操操作作作 State

在第一个 State 的例子中，当我们将值自增后，其类类类型型型并未改变。然而，当我们使用依赖类型时，状态
的更新同样也会涉及到其类型的更新。例如，当我们向存储在状态中的向量添加一个元素时，其长度会
改变：

addElement : (vec : Var) -> (item : a) ->
STrans m () [vec ::: State (Vect n a)]

(const [vec ::: State (Vect (S n) a)])
addElement vec item = do xs <- read vec

write vec (item :: xs)

注意你需要 import Data.Vect 来执行此示例。

直直直接接接用用用 update 更更更新新新状状状态态态

除了分别使用 read 和 write 以外，你还可以使用 update，它从一个 State 中读取内容，对它应用
一个函数，然后写入其结果。通过 update 你可以将 addElement 写为如下形式：

addElement : (vec : Var) -> (item : a) ->
STrans m () [vec ::: State (Vect n a)]

(const [vec ::: State (Vect (S n) a)])
addElement vec item = update vec (item ::)

然而，我们并不总是能够知道在一系列动作中类型具体是如如如何何何变化的。例如，如果我们有一个包含整数
向量的状态，那么可以从控制台读取一个输入，只有当该输入为有效的整数时才将它添加到该向量中。
根据该整数是否读取成功，我们的输出状态会有不同的类型，简直令人无语。因此，下面两个函数的类
型都不太正确：

readAndAdd_OK : ConsoleIO io => (vec : Var) ->
STrans m () -- 返回空元组

[vec ::: State (Vect n Integer)]
(const [vec ::: State (Vect (S n) Integer)])

readAndAdd_Fail : ConsoleIO io => (vec : Var) ->
STrans m () -- 返回空元组

[vec ::: State (Vect n Integer)]
(const [vec ::: State (Vect n Integer)])

不过请记住，输输输出出出资源的类型可以从函数的结果中计计计算算算出来。 目前，我们用 const 表示输出资源总是
保持不变。不过在这里，我们可以用一个类型级函数来计计计算算算出输出资源。我们首先将返回空元组改为
Bool，当读取输入成功时它返回 True；然后为输出资源挖一个坑坑坑：

readAndAdd : ConsoleIO io => (vec : Var) ->
STrans m Bool [vec ::: State (Vect n Integer)]

?output_res

如果你检查 ?output_res 的类型，就会看到 奉奤奲奩女 期望一个类型为 Bool -> Resources 的函数，它表
示输出资源的类型可以随 readAndAdd 的结果而不同：

n : Nat
m : Type -> Type
io : Type -> Type
constraint : ConsoleIO io
vec : Var

--------------------------------------
output_res : Bool -> Resources
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所以，当输入无效时，输出资源为 Vect n Integer（例如 readAndAdd返回 False）；当输入有效时，
输出资源为 Vect (S n) Integer。我们可以用类型将它表示出来：

readAndAdd : ConsoleIO io => (vec : Var) ->
STrans io Bool [vec ::: State (Vect n Integer)]

(\res => [vec ::: State (if res then Vect (S n) Integer
else Vect n Integer)])

接着，我们在实现 readAndAdd 时需要为输出的状态返回适当的值。如果为向量添加了一个元素，就返
回 True，否则就要返回 False：

readAndAdd : ConsoleIO io => (vec : Var) ->
STrans io Bool [vec ::: State (Vect n Integer)]

(\res => [vec ::: State (if res then Vect (S n) Integer
else Vect n Integer)])

readAndAdd vec = do putStr "Enter a number: "
num <- getStr
if all isDigit (unpack num)

then do
update vec ((cast num) ::)
pure True -- 添加一个元素，因此返回 True

else pure False -- 没有添加元素，因此返回 False

如果进行交互式开发的话则稍微有点不同。如果我们挖一个坑，那么在知道要返回的值以前，所需的输
出状态并不显而易见。例如，在以下未完成的 readAndAdd 定义中，我们为成功的情况留了个坑：

readAndAdd vec = do putStr "Enter a number: "
num <- getStr
if all isDigit (unpack num)

then ?whatNow
else pure False

我们可以查看 ?whatNow 的类型，很遗憾信息不足：

vec : Var
n : Nat
io : Type -> Type
constraint : ConsoleIO io
num : String

--------------------------------------
whatNow : STrans io Bool [vec ::: State (Vect (S n) Integer)]

(\res =>
[vec :::
State (ifThenElse res

(Delay (Vect (S n) Integer))
(Delay (Vect n Integer)))])

问题是我们只有在知道值会被返回时才能知道需要的输出状态。为了帮助交互式开发， Control.ST 提
供了一个 returning 函数，我们可以用它来提前指定返回值，然后更新相应的状态。例如，我们可以
将未完成的 readAndAdd 编写为：

readAndAdd vec = do putStr "Enter a number: "
num <- getStr
if all isDigit (unpack num)

then returning True ?whatNow
else pure False

它表示在成功的分支中，我们会返回 True，?whatNow 应该解释如何相应地更新状态，使其对于返回值
True 来说是正确的。我们只需检查 ?whatNow，就会发现现在的信息多了一点：
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vec : Var
n : Nat
io : Type -> Type
constraint : ConsoleIO io
num : String

--------------------------------------
whatnow : STrans io () [vec ::: State (Vect n Integer)]

(\value => [vec ::: State (Vect (S n) Integer)])

现在这个类型表示，在 STrans 的输出资源列表中，我们可以通过向 vec 添加一个元素来完成其定义：

readAndAdd vec = do putStr "Enter a number: "
num <- getStr
if all isDigit (unpack num)

then returning True (update vec ((cast num) ::))
else returning False (pure ()) -- 返回 False，因此无需更新状态

3.2.4 STrans 的的的原原原语语语操操操作作作

我们已经写过几个关于 STrans 函数的小例子了，是时候详细地了解这些状态操作函数了。 首先，为了
读写状态，我们使用了 read 和 write 函数：

read : (lbl : Var) -> {auto prf : InState lbl (State ty) res} ->
STrans m ty res (const res)

write : (lbl : Var) -> {auto prf : InState lbl ty res} ->
(val : ty') ->
STrans m () res (const (updateRes res prf (State ty')))

它们的类型看起来有点吓人，特别是隐式的 prf 参数，其类型为：

prf : InState lbl (State ty) res

它依赖于一个断言 InState。一个类型为 InState x ty res 的值表示在资源列表 res 中，引用 x 的
类型必须为 ty。实际上，所有这种类型都表示， 如果一个对某资源的引用存在于资源列表中，那么我
们我们只能读取或写入该资源。

给定一个资源标签 res 和一个 res 存在于资源列表中的证明，那么 updateRes 会更新该资源的类型。
因此，write 的类型表示该资源的类型会被更新为给定值的类型。

update 的类型与 read 和 write 类型类似，它也需要资源的类型为给定函数的输入类型，并将它更新
为该函数的输出类型：

update : (lbl : Var) -> {auto prf : InState lbl (State ty) res} ->
(ty -> ty') ->
STrans m () res (const (updateRes res prf (State ty')))

new 的类型表示它返回一个 Var，给定一个类型为 state 的初始值， 输出资源包含一个新的类型为
State state 的资源：

new : (val : state) ->
STrans m Var res (\lbl => (lbl ::: State state) :: res)

新资源的类型为 State state 而非只是 state 这一点很重要，因为这能让我们隐藏 奁奐奉 的实现细节。
在下一节用类型表示状态机 夨姩妡妵 夷夸天中，我们会看到更多关于其意义的内容。

delete 的类型表示，给定一个标签存在于输入资源内的隐式证明，该标签会从资源列表中移除：
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delete : (lbl : Var) -> {auto prf : InState lbl (State st) res} ->
STrans m () res (const (drop res prf))

这里的 drop 是一个类型级函数，它用于更新资源列表，从该列表中移除给定的资源 lbl。

我们之前已经用 lift 在底层上下文中运行过函数了。它的类型如下：

lift : Monad m => m t -> STrans m t res (const res)

给定一个 result 值，pure 会返回产生该值的 STrans 程序， 当产生该值时，它会假设当前资源列表是
正确：

pure : (result : ty) -> STrans m ty (out_fn result) out_fn

我们可以用 returning 将从 STrans 函数中返回值的过程分为两部分：提供值本身， 以及更新资源列
表使其对应于该返回值：

returning : (result : ty) ->
STrans m () res (const (out_fn result)) ->
STrans m ty res out_fn

最后，我们已经用 run 和 runPure 在特定上下文中执行过 STrans 函数了。run 会在任何上下文中执行
函数，若该上下文实现了 Applicative， 那么 runPure 会在同一上下文中执行函数：

run : Applicative m => STrans m a [] (const []) -> m a
runPure : STrans Basics.id a [] (const []) -> a

注意在任何情况下，输入和输出资源列表都必须为空。没有一种方法能够提供初始资源列表， 或提取
最终的资源。这是有意设计的：它确保了所所所有有有的的的资源管理都在受控的 STrans 环境下进行，并且我们将
会看到，这能够让我们实现安全的 奁奐奉， 以精确的类型来解释在程序的执行过程中，资源是如何被跟
踪的。

这些函数构成了 ST 库的核心。在遇到更加复杂的情况时，我们还会用到一些其它的函数， 不过目前所
见的函数足以让我们用 奉奤奲奩女 进行细致的状态跟踪和推理了。

3.2.5 ST：：：直直直接接接表表表示示示状状状态态态转转转移移移

我们已经见过一些简单的 STrans 函数的例子了，由于需要提供显式的输入输出资源列表， 它们的类型
会变得非常冗长。在需要为原语操作提供类型时这很方便，不过对于更一般的使用来说， 能为独立的
资源表示状状状态态态转转转移移移，而无需完整地给出输入和输出资源列表的话会更加方便。 我们可以用 ST 来做到这
一点：

ST : (m : Type -> Type) ->
(resultType : Type) ->
List (Action resultType) -> Type

ST 是一个类型级函数，它会为给定的活活活动动动（（（Action）））列表计算出对应的 STrans 类型，该类型描述了
资源的状态转移。函数类型中的 Action 可接受以下形式（我们之后还会见到其它形式）：

• lbl ::: ty 表示资源 lbl 的开始和结束状态均为 ty

• lbl ::: ty_in :-> ty_out 表示资源 lbl 以状态 ty_in 开始，以状态 ty_out 结束

• lbl ::: ty_in :-> (\res -> ty_out) 表示资源 lbl 以状态 ty_in 开始，以状态 ty_out 结
束，其中 ty_out 从函数 res 的结果中计算而来。

现在，我们可以将前面的一些函数的类型写成如下形式：
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increment : (x : Var) -> ST m () [x ::: State Integer]

即，increment 的开始和结束状态均为 State Integer 状态的 x。

makeAndIncrement : Integer -> ST m Integer []

即，makeAndIncrement 的开始和结束均没有资源。

addElement : (vec : Var) -> (item : a) ->
ST m () [vec ::: State (Vect n a) :-> State (Vect (S n) a)]

即，addElement 将 vec 从 State (Vect n a) 改变为 State (Vect (S n) a)。

readAndAdd : ConsoleIO io => (vec : Var) ->
ST io Bool

[vec ::: State (Vect n Integer) :->
\res => State (if res then Vect (S n) Integer

else Vect n Integer)]

我们通过这种编写类型的方式，表达出了每个函数如何影响整体资源状态的最小必要条件。 如果某个
资源的更新依赖于某个结果（如 readAndAdd），那么我们需要完整地描述它。 否则（如 increment 和
makeAndIncrement），我们可以写出输入输出资源列表以避免重复。

Action 也可以描述添添添加加加和移移移除除除状态：

• add ty，如果该操作返回一个 Var，那么它会添加一个 ty 类型的新资源。

• remove lbl ty 表示该操作会从资源列表中的状态 ty 开始，移除名为 lbl 的资源。

例如，我们可以写出：

newState : ST m Var [add (State Int)]
removeState : (lbl : Var) -> ST m () [remove lbl (State Int)]

第一个函数 newState 返回一个新的资源标签并将该资源添加到 State Int 类型的资源列表中。第二个
函数 removeState 根据给定的标签 lbl 从列表中移除该资源。二者的类型与以下形式等价：

newState : STrans m Var [] (\lbl => [lbl ::: State Int])
removeState : (lbl : Var) -> STrans m () [lbl ::: State Int] (const [])

它们是构造 Action 的原语方法。我们后面还会遇到一些用类型级函数来提高可读性的方式。

除了极少数需要准确完整的 STrans 的情况外，在本教程剩余的部分中，我们通常会使用 ST。在下一节
中，我们会看到如何用 ST 提供的设施来为需要安全性的系统编写准确的 奁奐奉：一个需要登录的数据存
储系统。

3.3 用用用类类类型型型表表表示示示状状状态态态机机机

在概览 夨姩妡妵 夶夹天一节中，我们用状态转移图展示了数据存储系统的抽象状态， 以及可以对它执行的动
作：
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我我我们之所以把它称作该存储系统的抽抽抽象象象状态，是因为具体的状态会包含更多信息。例如，它可能包
含用户名、散列化的密码和存储内容等等。然而，就目前我们我们所关心的动作 login、logout 和
readSecret 而言，登录状态决定了哪些动作是有效的。

我们已经见过如何用 ST 操作状态，用依赖类型表示状态了。在本节中，我们会看到如何用 ST 为数据
存储系统提供安全的 奁奐奉。在 奁奐奉 中，我们会用类型编码上面的状态转移图。 通过这种方式，我们可
以只在状态有效时才能执行 login、logout 和 readSecret 操作。

我们已经用过 State 及其原语操作 new、read、write 和 delete 来操作状态了。而对于数据存储的
奁奐奉，我们则以定义接接接口口口开始（见 奉奤奲奩女 教程中的接口 夨姩妡妵 夲失天一节）。接口描述了对存储系统的操作，
其类型则准确解释了每种操作何时才有效，以及它是如何影响存储系统的状态的。通过接口，我们可以
确保这是访问存储系统的唯唯唯一一一的的的方式。

3.3.1 为为为数数数据据据存存存储储储系系系统统统定定定义义义接接接口口口

我们首先在 Login.idr 文件中定义数据类型，它表示存储系统的两种抽象状态，即 LoggedOut 和
LoggedIn：

data Access = LoggedOut | LoggedIn

我们可以定义一个数据类型来表示存储系统的当前状态，保存所有必要的信息（如用户名、散列化的密
码、存储内容等等），并根据登录状态来参数化该数据类型：

Store : Access -> Type

不过我们现在先不定义具体的类型，而是将以下代码包含在数据存储的接接接口口口中，之后再定义具体的类
型：

interface DataStore (m : Type -> Type) where
Store : Access -> Type

我们可以继续为此接口补充其它存储系统的操作。这样做优点众多。通过将接接接口口口与其实实实现现现相分离，我们
可以为不同的上下文提供相应的具体实现。此外，我们还可以编写与存储系统协作的程序而无需知道任
何实现的细节。

我们需要用 connect 连接到该存储系统，在结束后用 disconnect 断开连接。 我们为 DataStore 接口
添加以下方法：

connect : ST m Var [add (Store LoggedOut)]
disconnect : (store : Var) -> ST m () [remove store (Store LoggedOut)]

connect 的类型表明它会返回一个初始类型为 Store LoggedOut 的新资源。 反之，disconnect 则会
给出一个状态为 Store LoggedOut 的资源并移除该资源。 我们可以通过以下（未完成的）定义更加清
楚地看到 connect 做了什么：
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doConnect : DataStore m => ST m () []
doConnect = do st <- connect

?whatNow

注意我们正在一个 一一一般般般的上下文 m 中工作，为了能够执行 doConnect，我们必须为 m 实现 DataStore
接口来限制它。如果我们检查 ?whatNow 的类型，就会看到剩下的操作以一个状态为 Store LoggedOut
的资源 st 开始， 以没有可用的资源结束：

m : Type -> Type
constraint : DataStore m
st : Var

--------------------------------------
whatNow : STrans m () [st ::: Store LoggedOut] (\result => [])

接着，我们可以用 disconnect 来移除该资源：

doConnect : DataStore m => ST m () []
doConnect = do st <- connect

disconnect st
?whatNow

现在检查 ?whatNow 的类型会显示我们没有可用的资源：

m : Type -> Type
constraint : DataStore m
st : Var

--------------------------------------
whatNow : STrans m () [] (\result => [])

为了继续完善 DataStore 接口的实现，我们接下来添加一个读取机密数据的方法。 这需要 store 的状
态为 Store LoggedIn：

readSecret : (store : Var) -> ST m String [store ::: Store LoggedIn]

此时我们可以试着编写一个函数，它先连接到存储系统，然后读取机密数据，之后断开连接。 然而它
并不会成功，因为执行 readSecret 需要我们处于已登录状态。

badGet : DataStore m => ST m () []
badGet = do st <- connect

secret <- readSecret st
disconnect st

它会产生以下错误，因为 connect 创建了状态为 LoggedOut 的新存储，而 readSecret 需要该存储的
状态为 LoggedIn：

When checking an application of function Control.ST.>>=:
Error in state transition:

Operation has preconditions: [st ::: Store LoggedOut]
States here are: [st ::: Store LoggedIn]
Operation has postconditions: \result => []
Required result states here are: \result => []

该错误信息解释了所需的输入状态（前提条件）和输出状态（后置条件）与该操作中的状态有何不同。
为了使用 readSecret，我们需要一种方式将 Store LoggedOut 转换为 Store LoggedIn 状态。我们可
以先尝试将 login（登录）指定为以下类型：

login : (store : Var) -> ST m () [store ::: Store LoggedOut :-> Store LoggedIn] -- 类型不正确！

注意，接接接口口口中并没有说明 login 是如如如何何何工作的，只是表达了它如何影响所有的状态。即便如此，login
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的类型还是有点问题，因为它假设了登录总会成功。如果登录失败（比如在该实现提示输入密码时用户
输入了错误的密码），那么它一定不会产生 LoggedIn 状态的存储。

因此，login 需要通过以下类型返回登录是否成功：

data LoginResult = OK | BadPassword

接着，我们可以从结果中计计计算算算出结果状态（见用依赖类型操作 State 夨姩妡妵 夷头天）。我们为 DataStore 接
口添加以下方法：

login : (store : Var) ->
ST m LoginResult [store ::: Store LoggedOut :->

(\res => Store (case res of
OK => LoggedIn
BadPassword => LoggedOut))]

如果 login 成功，那么 login 之后的状态会变成 Store LoggedIn。否则，状态仍然为 Store
LoggedOut。

为完成此接口，我们还需要添加一个退出该存储系统的方法。我们假设退出总是成功，并将存储系统的
状态从 Store LoggedIn 转换为 Store LoggedOut。

logout : (store : Var) -> ST m () [store ::: Store LoggedIn :-> Store LoggedOut]

这样就完成了此接口。完整代码如下：

interface DataStore (m : Type -> Type) where
Store : Access -> Type

connect : ST m Var [add (Store LoggedOut)]
disconnect : (store : Var) -> ST m () [remove store (Store LoggedOut)]

readSecret : (store : Var) -> ST m String [store ::: Store LoggedIn]
login : (store : Var) ->

ST m LoginResult [store ::: Store LoggedOut :->
(\res => Store (case res of

OK => LoggedIn
BadPassword => LoggedOut))]

logout : (store : Var) -> ST m () [store ::: Store LoggedIn :-> Store LoggedOut]

在尝试创建此接口的实现之前，我们来看看如何用它来编写函数，以此来登录数据存储系统、在登录成
功后读取机密数据，然后再退出。

3.3.2 用用用数数数据据据存存存储储储接接接口口口编编编写写写函函函数数数

我们以编写 getData 函数为例，展示如何使用 DataStore 接口。 该函数用于连接到存储系统并从中读
取数据。我们使用该操作的类型来逐步指导开发， 交互式地编写此函数。它的类型如下：

getData : (ConsoleIO m, DataStore m) => ST m () []

该类型表示在进入或退出时没有资源可用。也就是说，整个动作列表为 []，这表示至少从外部来说，
该函数完全没有对资源产生作用。换句话说，对于每一个在调用 getData 时创建的资源，我们都需要在
退出前删除它。

由于我们要使用 DataStore 接口的方法，因此必须约束计算上下文 m 使其实现 DataStore 接口。我们
还有一个 ConsoleIO m 约束，这样就能将我们从存储系统中读取的任何数据或者错误信息显示出来。

我们从连接到存储系统开始，创建一个新的资源 st，然后尝试用 login 登录：
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getData : (ConsoleIO m, DataStore m) => ST m () []
getData = do st <- connect

ok <- login st
?whatNow

登录可能成功也可能失败，两种状态可从 ok 值反映出来。如果我们检查 ?whatNow 的类型，就会看到
当前存储系统的状态：

m : Type -> Type
constraint : ConsoleIO m
constraint1 : DataStore m
st : Var
ok : LoginResult

--------------------------------------
whatNow : STrans m () [st ::: Store (case ok of

OK => LoggedIn
BadPassword => LoggedOut)]

(\result => [])

由于 st 的当前状态依赖于 ok 的值，因此我们可以对 ok 分情况讨论来继续推进：

getData : (ConsoleIO m, DataStore m) => ST m () []
getData = do st <- connect

ok <- login st
case ok of

OK => ?whatNow_1
BadPassword => ?whatNow_2

两个分支上的坑 ?whatNow_1 和 ?whatNow_2 的类型展现了状态是如何随着登录成功与否而改变的。如
果登录成功，那么该存储系统的状态为 LoggedIn夺

--------------------------------------
whatNow_1 : STrans m () [st ::: Store LoggedIn] (\result => [])

如果失败，那么它的状态为 LoggedOut夺

--------------------------------------
whatNow_2 : STrans m () [st ::: Store LoggedOut] (\result => [])

在 ?whatNow_1 中，由于登录成功，因此可以读取机密数据并将它显示在终端上：

getData : (ConsoleIO m, DataStore m) => ST m () []
getData = do st <- connect

ok <- login st
case ok of

OK => do secret <- readSecret st
putStrLn ("Secret is: " ++ show secret)
?whatNow_1

BadPassword => ?whatNow_2

我们要以「无资源可用」的状态来结束 OK 分支，因此需要退出存储系统并断开连接：

getData : (ConsoleIO m, DataStore m) => ST m () []
getData = do st <- connect

ok <- login st
case ok of

OK => do secret <- readSecret st
putStrLn ("Secret is: " ++ show secret)
logout st

(äÿŃéąțçżğçżŋ)
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(çżŋäÿŁéąț)

disconnect st
BadPassword => ?whatNow_2

注意我们在调用 disconnect 断开连接前，必必必须须须用 logout 退出 st，因为 disconnect 需要存储系统处
于 LoggedOut 状态。

此外，我们不能像上一节中 State的示例那样，简单地用 delete来删除该资源，因为对于某个类型 ty
来说，delete 只能在资源的类型为 State ty 时起效。如果我们试图用 delete 来代替 disconnect，
就会看到以下错误：

When checking argument prf to function Control.ST.delete:
Can't find a value of type

InState st (State st) [st ::: Store LoggedOut]

换句话说，类型检查器找不到一个「资源 st拥有 State st形式的类型」的证明，因为其类型为 Store
LoggedOut。由于 Store 是 DataStore 接口的一部分，而我们尚尚尚未未未知知知道道道 Store 的具体表示，因此我们
需要通过此接口的 disconnect 而非直接用 delete 来删除资源。

我们可以将 getData 完成如下，使用模式匹配来绑定候选（见 奉奤奲奩女 教程的单子与 do-记法 夨姩妡妵 夲头天），
而非使用 case 语句来捕获 login 可能产生的错误：

getData : (ConsoleIO m, DataStore m) => ST m () []
getData = do st <- connect

OK <- login st
| BadPassword => do putStrLn "Failure"

disconnect st
secret <- readSecret st
putStrLn ("Secret is: " ++ show secret)
logout st
disconnect st

然而它现在还跑不起来，因为我们还没有任何 DataStore 的实现！如果我们试着在一个 IO 上下文中执
行它，就会产生一个没有 DataStore IO 的实现的错误：

*Login> :exec run {m = IO} getData
When checking an application of function Control.ST.run:

Can't find implementation for DataStore IO

因此，要实现遵循其状态转移图的数据存储系统，最后一步就是提供一个 DataStore 的实现。

3.3.3 实实实现现现接接接口口口

要在 IO 中执行 getData，我们需要提供一个能够在 IO 上下文中工作的 DataStore 的实现。我们可以
这样开始：

implementation DataStore IO where

接着，我们可以让 奉奤奲奩女 根据必要方法的基本定义来填充该接口（在 奁奴奯奭 中按下 Ctrl-Alt-A，或者在
你喜欢的编辑器中按下对应的快捷键来「添加定义」）：

implementation DataStore IO where
Store x = ?DataStore_rhs_1
connect = ?DataStore_rhs_2
disconnect store = ?DataStore_rhs_3
readSecret store = ?DataStore_rhs_4
login store = ?DataStore_rhs_5
logout store = ?DataStore_rhs_6
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我们首先要确定表示该数据存储系统的方式。为简单起见，我们将数据存储为单个的 String，并使用
硬编码的密码来获取访问权限。我们可以将 Store 定义如下，无论在 LoggedOut 还是在 LoggedIn 状
态下均使用 String 来表示数据。

Store x = State String

现在我们给出了 Store 的一个具体类型，我们可以实现建立连接、断开连接和访问数据的操作。而由于
我们使用了 State，因此也就可以使用 new、delete、read 和 write 来操作该存储系统。

坑的类型会告诉我们如何操作状态。例如，?DataStore_rhs_2 坑告诉我们要实现 connect 需要做些什
么。我们需要返回一个新的 Var，表示一个类型为 State String 的资源：

--------------------------------------
DataStore_rhs_2 : STrans IO Var [] (\result => [result ::: State String])

我们可以通过创建一个带有某些数据作为存储内容的新变量来实现它（我们可以使用任何 String），
然后返回该变量：

connect = do store <- new "Secret Data"
pure store

对于 disconnect 而言，我们只需删除该资源即可：

disconnect store = delete store

对于 readSecret，我们需要读取机密数据并返回 String。由于我们并不知道该数据的具体表示为
State String，因此可以直接用 read 来访问数据：

readSecret store = read store

我们先来完成 logout，之后回到 login 上来。检查坑的类型会显示以下信息：

store : Var
--------------------------------------
DataStore_rhs_6 : STrans IO () [store ::: State String] (\result => [store ::: State String])

因此在此小型实现中，我们实际上不用做任何事情！

logout store = pure ()

对于 login，我们需要返回登录是否成功。为此，我们需要提示用户输入密码，并在匹配到硬编码的密
码时返回 OK，否则返回 BadPassword：

login store = do putStr "Enter password: "
p <- getStr
if p == "Mornington Crescent"

then pure OK
else pure BadPassword

下面给出完整的实现以供参考，它能让我们在 奒奅奐奌 中执行 DataStore 程序：

implementation DataStore IO where
Store x = State String
connect = do store <- new "Secret Data"

pure store
disconnect store = delete store
readSecret store = read store
login store = do putStr "Enter password: "

p <- getStr
(äÿŃéąțçżğçżŋ)
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(çżŋäÿŁéąț)

if p == "Mornington Crescent"
then pure OK
else pure BadPassword

logout store = pure ()

最后，我们可以像下面这样在 奒奅奐奌 中尝试它（如果有可用的 IO 实现，那么在 奉奤奲奩女 的 奒奅奐奌 中，上
下文会默认为 IO，因此这里无需显式给出 m 参数）：

*Login> :exec run getData
Enter password: Mornington Crescent
Secret is: "Secret Data"

*Login> :exec run getData
Enter password: Dollis Hill
Failure

对于 State 类型的资源，我们只能使用 read、write、new 和 delete。因此，在 DataStore 的实现或
任何已知上下文为 IO 的环境内内内部部部，我们可以随意访问数据存储系统，因为这里是实现 DataStore 内部
细节的地方。然而，如果我们只有 DataStore m 的约束，那么就无法知道该存储系统是否已实现，因
此我们只能通过 DataStore 提供的 奁奐奉 来访问它。

因此比较好的做法是在 getData 这类函数中使用泛泛泛型型型（（（Generic）））上下文 m，并只根据我们需要的接口
进行约束，而非使用具体的上下文 IO。

现在我们已经学过如何处理状态，以及如何用接口来封装数据存储这类具体系统的状态转移了。然而，
真正的系统需要能够复复复合合合多种状态机。我们一次需要使用多个状态机，或者基于多个状态机来实现一个
状态机。

3.4 复复复合合合状状状态态态机机机

在上一节中，我们定义了 DataStore 接口并用它实现了以下小程序，它能让用户登录该存储系统然后
打印存储的内容：

getData : (ConsoleIO m, DataStore m) => ST m () []
getData = do st <- connect

OK <- login st
| BadPassword => do putStrLn "Failure"

disconnect st
secret <- readSecret st
putStrLn ("Secret is: " ++ show secret)
logout st
disconnect st

该函数只用了一个状态，即存储本身。然而，更大的程序通常会有更多的状态，在执行过程中可能还需
要添加、删除或更新状态。就本例而言，无限循环，在状态中记录登录失败的次数都是有用的扩展。

此外，状态机还可以有层层层级级级，即一个状态机可以通过复合其它状态机来实现。例如，我们可以有一个表
示图形系统的状态机，并用它来实现「海龟绘图」这种高高高级级级的图形 奁奐奉，「海龟绘图」会使用图形系统
加上一些额外的状态。

在本节中，我们会看到如何使用多个状态工作，以及如何将状态机复合成更高级别的状态机。我们先来
看看如何为 getData 添加登录失败的计数器。
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3.4.1 使使使用用用多多多个个个资资资源源源来来来工工工作作作

为了了解如何使用多个资源来工作，我们需要修改 getData 使其循环，然后记录用户登录失败的总次
数。例如，如果我们编写的 main 程序初始记录次数为 夰， 那么会话过程看起来可能会是这样的：

*LoginCount> :exec main
Enter password: Mornington Crescent
Secret is: "Secret Data"
Enter password: Dollis Hill
Failure
Number of failures: 1
Enter password: Mornington Crescent
Secret is: "Secret Data"
Enter password: Codfanglers
Failure
Number of failures: 2
...

我们首先为 getData 添加一个跟踪失败次数的状态资源：

getData : (ConsoleIO m, DataStore m) =>
(failcount : Var) -> ST m () [failcount ::: State Integer]

getData 的的的类类类型型型检检检查查查

如果你跟着本教程写代码，就会发现更新了 getData 的类型后就无法通过编译了。这是意料之中
的！我们暂且先将 getData 的定义注释掉，回头再说。

接着，我们创建一个 main 程序，它将状态初始化为 夰，然后调用 getData：

main : IO ()
main = run (do fc <- new 0

getData fc
delete fc)

现在着手实现 getData。我们先来添加一个参数表示允许的失败次数：

getData : (ConsoleIO m, DataStore m) =>
(failcount : Var) -> ST m () [failcount ::: State Integer]

getData failcount
= do st <- connect

OK <- login st
| BadPassword => do putStrLn "Failure"

disconnect st
secret <- readSecret st
putStrLn ("Secret is: " ++ show secret)
logout st
disconnect st

然而，它无法通过类型检查，因为我们用来调用 connect 的资源不正确。错误信息描述了资源为何不必
配：

When checking an application of function Control.ST.>>=:
Error in state transition:

Operation has preconditions: []
States here are: [failcount ::: State Integer]
Operation has postconditions: \result => [result ::: Store LoggedOut] ++ []
Required result states here are: st2_fn
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换句话说，connect 需要在进入时没没没有有有资源，但我们却有有有一一一个个个资源，即失败次数！这理应没什么问题：
毕竟我们需要的资源是拥有的资源的子子子集集集，而额外的资源（这里是失败次数）与 connect 无关。因此
我们需要一种临时隐隐隐藏藏藏附加资源的方法。

我们可以用 call 函数来达此目的：

getData : (ConsoleIO m, DataStore m) =>
(failcount : Var) -> ST m () [failcount ::: State Integer]

getData failcount
= do st <- call connect

?whatNow

我们在这里为 getData 剩下的部分挖了个坑，这样你可以看到 call 的作用。它移除了调用 connect 时
资源列表中不必要的部分，然后在返回时恢复了它们。因此 whatNow 的类型表明我们添加了一个新的资
源 st，而 failcount依然可用：

failcount : Var
m : Type -> Type
constraint : ConsoleIO m
constraint1 : DataStore m
st : Var

--------------------------------------
whatNow : STrans m () [failcount ::: State Integer, st ::: Store LoggedOut]

(\result => [failcount ::: State Integer])

在此函数函数的最后，whatNow 表明我们需要以状态 st 结束，然而此时尚有 failcount 可用。我们可
以在调用数据存储系统中的操作时添加 call 来消除资源列表，这样完成的 getData 就能带着附加的状
态资源工作：

getData : (ConsoleIO m, DataStore m) =>
(failcount : Var) -> ST m () [failcount ::: State Integer]

getData failcount
= do st <- call connect

OK <- call $ login st
| BadPassword => do putStrLn "Failure"

call $ disconnect st
secret <- call $ readSecret st
putStrLn ("Secret is: " ++ show secret)
call $ logout st
call $ disconnect st

这样有点嗦，实际上我们可以将 call 变成隐式的从而去掉它。默认情况下，你需要显式地添加 call，
但如果你导入了 Control.ST.ImplicitCall，那么 奉奤奲奩女 就会在需要的地方插入它。

import Control.ST.ImplicitCall

现在的 getData 就和之前一样了：

getData : (ConsoleIO m, DataStore m) =>
(failcount : Var) -> ST m () [failcount ::: State Integer]

getData failcount
= do st <- connect

OK <- login st
| BadPassword => do putStrLn "Failure"

disconnect st
secret <- readSecret st
putStrLn ("Secret is: " ++ show secret)
logout st
disconnect st

这里需要权衡：如果你导入了 Control.ST.ImplicitCall，那么使用多个资源的函数会更加易读，因
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为没有嗦的 call 了。另一方面，奉奤奲奩女 对你函数的类型检查会变得有点困难，这会导致它花费更多时
间，错误信息也会少一点帮助。

看一下 call 的类型，你会有所启发：

call : STrans m t sub new_f -> {auto res_prf : SubRes sub old} ->
STrans m t old (\res => updateWith (new_f res) old res_prf)

被调用的函数有一个资源列表 sub，还有一个隐式证明 SubRes sub old，它证明了被调用函数的资源
列表是整个资源列表的子集。尽管资源的顺序可以改变，然而在 old 中出现的资源无法在 sub 列表中
出现超过一次（如果你尝试它就会得到一个类型错误）。

函数 updateWith 接受被调用函数的输输输出出出资源，然后在当前资源列表中更新它们。此函数会尽可能保持
顺序不变，尽管被调用的函数在进行复杂的资源操作时并不总是可以保持顺序。

在在在被被被调调调用用用的的的函函函数数数中中中新新新创创创建建建的的的资资资源源源

如果被调用的函数创建了新的资源，那么基于 updateWith 的工作方式，它们通常会出现在资源列表
的末末末尾尾尾。你可以在前面未完成的 getData 的定义中看到这一点。

最后我们可以更新 getData 使其可以循环，并在需要时保持更新 failCount：

getData : (ConsoleIO m, DataStore m) =>
(failcount : Var) -> ST m () [failcount ::: State Integer]

getData failcount
= do st <- call connect

OK <- login st
| BadPassword => do putStrLn "Failure"

fc <- read failcount
write failcount (fc + 1)
putStrLn ("Number of failures: " ++ show (fc + 1))
disconnect st
getData failcount

secret <- readSecret st
putStrLn ("Secret is: " ++ show secret)
logout st
disconnect st
getData failcount

注意在这里我们会在每次迭代中建立并断开连接。另一种实现方式是首先用 connect 建立连接，然后调
用 getData，其实现如下：

getData : (ConsoleIO m, DataStore m) =>
(st, failcount : Var) -> ST m () [st ::: Store {m} LoggedOut, failcount ::: State␣

→˓Integer]
getData st failcount

= do OK <- login st
| BadPassword => do putStrLn "Failure"

fc <- read failcount
write failcount (fc + 1)
putStrLn ("Number of failures: " ++ show (fc + 1))
getData st failcount

secret <- readSecret st
putStrLn ("Secret is: " ++ show secret)
logout st
getData st failcount

在 st 的类型 Store {m} LoggedOut 中添加显式的 {m} 是十分重要的，因为这给了 奉奤奲奩女 足够的信息
来判断哪一个 DataStore 的实现是用于查找其对应的 Store 的实现的。 否则，如果我们只写 Store
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LoggedOut，那么将无法获知 Store 所关联到的计算上下文 m。

接接接着我们可以在 main 中只 connect 并 disconnect 一次：

main : IO ()
main = run (do fc <- new 0

st <- connect
getData st fc
disconnect st
delete fc)

通过使用 call 或导入 Control.ST.ImplicitCall，我们可以编写使用多个资源的程序， 然后在调用
一个只用到全部资源的子集的函数时，将资源列表按需删减。

3.4.2 复复复合合合资资资源源源：：：状状状态态态机机机的的的层层层级级级

我们现在已经见过如何在一个函数中使用多个资源了，这对于任何能够操作状态的实际的程序来说都是
必须的。我们可以把它看做是「横向的」复合：一次使用多个资源。我们通常还需要「纵向」的复合：
基于一个或多个资源来实现单个资源。

在本节中，我们会看到一个这种的例子。首先，我们在一个接口 Draw 中实现一个小型的图形 奁奐奉，它
支持：

• 打开一个窗口，创建一个双缓冲（奤奯奵奢奬奥夭奢奵夛奥奲奥奤）的平面（女奵奲奦奡奣奥）来绘图

• 在平面上绘制线条和矩形

• 缓冲区「翻页（夝奩奰奰奩奮奧）」，在窗口中显示我们刚绘制完毕的图像

• 关闭一个窗口

提提提示示示: 绘图并不是即时呈现的，需要一个缓冲区（奢奵夛奥奲）来暂存即将呈现的图像。 缓冲区一般有三
个基本操作：奣奬奥奡奲（清空），夝奩奰（翻页）和 奲奥奷奩奮奤（重显）。 奣奬奥奡奲 会将当前缓冲区清空以便重新绘
图；夝奩奰 会将当前缓冲区中的图像显示在屏幕上，然后清空缓冲区等待下一次绘图；而 奲奥奷奩奮奤 则保持缓
冲区内容不变，重新显示到屏幕上。

术语 夝奩奰 和 奲奥奷奩奮奤 来源于磁带的播放，奲奥奷奩奮奤 即倒带重放，而 夝奩奰 则表示把磁带翻过来播放另一
面。夝奩奰 一词尚无标准译法，此处译作「翻页」表示本画面完成，开始下一画面。

接着，我们在一个 interface 中用此 奁奐奉 来为「海龟绘图」实现一个更高级的 奁奐奉。这不仅需要 Draw
接口，还需要表示海龟的状态（位置，方向和画笔颜色）。

SDL 绑绑绑定定定

为了测试本节中的示例，你需要为 奉奤奲奩女安装一个非常基本的 奓奄奌绑定，它可从 奨奴奴奰女夺夯夯奧奩奴奨奵奢央奣奯奭夯
奥奤奷奩奮奢夯奓奄奌夭奩奤奲奩女 获取。这些绑定实现了 奓奄奌 奁奐奉 的一个很小的子集，只用作演示的目的。尽管如
此，它们已经足以实现一个小型的绘图程序来展示本节的概念了。

一旦你安装完这个包，就可以通过参数启动 奉奤奲奩女 了，-p sdl 用于 奓奄奌 绑定，-p contrib 用于
Control.ST。
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Draw 接接接口口口

我们要在此 奁奐奉 中使用 奉奤奲奩女 的 奓奄奌 绑定，因此你需要在安装完该绑定库后导入 Graphics.SDL。我们
先来定义 Draw 接口，它包含一个表示平面的数据类型，我们会在其之上绘制线条和矩形：

interface Draw (m : Type -> Type) where
Surface : Type

我们需要能够通过打开新窗口来创建新的 Surface：

initWindow : Int -> Int -> ST m Var [add Surface]

然而这样不太正确。如果我们的程序运行在没有可用的窗口系统的终端环境中，那么打开窗口可能会失
败。因此， initWindow 需要以某种方式来应对可能的失败。我们可以通过返回 Maybe Var 而非 Var，
以及只在成功时添加 Surface 来做到这一点：

initWindow : Int -> Int -> ST m (Maybe Var) [addIfJust Surface]

它使用了 Control.ST 中定义的类型级函数 addIfJust，该函数返回一个 Action，仅在操作成功时添
加资源（也就是说，它返回一个形如 Just val 的结果）。

addIfJust 与与与 addIfRight

Control.ST 中定义了能够在操作成功时构造新资源的函数，其中的 addIfJust 会在操作返回 Just
ty 时添加资源。此外还有 addIfRight：

addIfJust : Type -> Action (Maybe Var)
addIfRight : Type -> Action (Either a Var)

二者均基于下面的原语动作 Add 开发。此动作接受一个函数，该函数从操作的结果中构造出一个资源
列表：

Add : (ty -> Resources) -> Action ty

如有需要，你可以用它来创建自己的动作，以此来基于某个操作的结果添加资源。例如，addIfJust
的实现如下：

addIfJust : Type -> Action (Maybe Var)
addIfJust ty = Add (maybe [] (\var => [var ::: ty]))

如果我们能创建窗口，那么也需要能删除它：

closeWindow : (win : Var) -> ST m () [remove win Surface]

我们还需要响应按下键盘或点击鼠标这类事件。Graphics.SDL 库为此提供了 Event 类型，而我们可以
用 poll 轮询事件，如果存在的话，它会返回最后一个发生的事件：

poll : ST m (Maybe Event) []

Draw 中剩下的方法包括：flip，它会将从上次 flip 以来绘制的所有图像都显示出来；还有两个绘图
的方法 filledRectangle 和 drawLine。

flip : (win : Var) -> ST m () [win ::: Surface]
filledRectangle : (win : Var) -> (Int, Int) -> (Int, Int) -> Col -> ST m () [win ::: Surface]
drawLine : (win : Var) -> (Int, Int) -> (Int, Int) -> Col -> ST m () [win ::: Surface]

我们按如下方式定义色彩，四个整数表示色彩通道（红、绿、蓝、不透明度）：
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data Col = MkCol Int Int Int Int

black : Col
black = MkCol 0 0 0 255

red : Col
red = MkCol 255 0 0 255

green : Col
green = MkCol 0 255 0 255

-- 蓝、黄、品红、青、白类似……

在导入 Graphics.SDL 之后，你就可以像下面这样用 奓奄奌 的绑定实现 Draw 接口了：

implementation Draw IO where
Surface = State SDLSurface

initWindow x y = do Just srf <- lift (startSDL x y)
| pure Nothing

var <- new srf
pure (Just var)

closeWindow win = do lift endSDL
delete win

flip win = do srf <- read win
lift (flipBuffers srf)

poll = lift pollEvent

filledRectangle win (x, y) (ex, ey) (MkCol r g b a)
= do srf <- read win

lift $ filledRect srf x y ex ey r g b a
drawLine win (x, y) (ex, ey) (MkCol r g b a)

= do srf <- read win
lift $ drawLine srf x y ex ey r g b a

在本实现中，我们使用 startSDL 来初始化窗口，它在失败时返回 Nothing。由于 initWindow 的类型
说明它会在返回形如 Just val 的值时添加一个资源， 因此我们在成功时添加 startSDL 返回的平面，
在失败时什么也不做。我们只能在 startDSL 成功时初始化成功。

现在我们有了 Draw 的实现，可以试着写一些函数了，他们在窗口中绘图并通过 奓奄奌 绑定执行它们。例
如，假设我们有一个可以绘图的平面 win，那么可以编写 render 函数在黑色背景上绘图：

render : Draw m => (win : Var) -> ST m () [win ::: Surface {m}]
render win = do filledRectangle win (0,0) (640,480) black

drawLine win (100,100) (200,200) red
flip win

最后的 flip win 是必须的，因为绘图原语使用了双缓冲区来避免图形闪烁。我们在屏幕之外的缓冲区
上绘图，同时显示另一个缓冲区。在调用 flip 时，它会将当前屏幕之外的缓冲区显示出来，并创建一
个新的屏幕外缓冲区绘制下一帧。

要将它包含在程序里，我们需要编写一个主循环来渲染图像，同时等待用户关闭应用的事件：

loop : Draw m => (win : Var) -> ST m () [win ::: Surface {m}]
loop win = do render win

Just AppQuit <- poll
| _ => loop win

pure ()
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最后，我们创建一个主程序。如果可能，它会创建窗口，然后运行主循环：

drawMain : (ConsoleIO m, Draw m) => ST m () []
drawMain = do Just win <- initWindow 640 480

| Nothing => putStrLn "Can't open window"
loop win
closeWindow win

我们可以在 奒奅奐奌 中用 run 运行它：

*Draw> :exec run drawMain

更更更高高高级级级的的的接接接口口口：：：TurtleGraphics

「海龟绘图」会操纵一只「海龟」在屏幕上移动，在它移动时用「画笔」来画线。一只海龟拥有描述它
位置的属性，它面对的方向，以及当前画笔的颜色。此外，还有一些命令来让海龟向前移动，转一个角
度，以及更改画笔的颜色。下面是一种可行的接口：

interface TurtleGraphics (m : Type -> Type) where
Turtle : Type

start : Int -> Int -> ST m (Maybe Var) [addIfJust Turtle]
end : (t : Var) -> ST m () [Remove t Turtle]

fd : (t : Var) -> Int -> ST m () [t ::: Turtle]
rt : (t : Var) -> Int -> ST m () [t ::: Turtle]

penup : (t : Var) -> ST m () [t ::: Turtle]
pendown : (t : Var) -> ST m () [t ::: Turtle]
col : (t : Var) -> Col -> ST m () [t ::: Turtle]

render : (t : Var) -> ST m () [t ::: Turtle]

和 Draw 一样，我们也需要一个初始化海龟的命令（这里叫做 start），如果它无法创建用来绘图的平
面就会失败。此外还有一个 render 方法，它用来渲染窗口中目前已绘制的图像。使用此接口的一个可
用的程序如下所示，它画了一个彩色的正方形：

turtle : (ConsoleIO m, TurtleGraphics m) => ST m () []
turtle = with ST do

Just t <- start 640 480
| Nothing => putStr "Can't make turtle\n"

col t yellow
fd t 100; rt t 90
col t green
fd t 100; rt t 90
col t red
fd t 100; rt t 90
col t blue
fd t 100; rt t 90
render t
end t

with ST do

在 turtle 中使用 with ST do 是为了区分 (>>=) 的版本，它可能来自于 Monad 或者 ST。虽然 奉奤奲奩女
自己能够解决此问题，不过它会尝试所有可能性，因此使用 with 从句可以减少耗时，加速类型检
查。
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要实现此接口，我们可以尝试用 Surface 来表示海龟用来作画的平面：

implementation Draw m => TurtleGraphics m where
Turtle = Surface {m}

知道了 Turtle 被表示为 Surface 之后，我们就能使用 Draw 提供的方法来实现海龟了。然而这还不
够，我们还需要存储更多信息：具体来说，海龟有一些属性需要存储在某处。因此我们不仅需要将海龟
表示为一个 Surface，还需要存储一些附加的状态。我们可以通过复复复合合合资源来做到这一点。

复复复合合合资资资源源源简简简介介介

复复复合合合资源由一个资源列表构造而来，它使用以下 Control.ST 中定义的类型实现：

data Composite : List Type -> Type

如果我们有一个复合资源，那么可以用 split 将其分解为构成它的资源，并为每个资源创建新的变量。
例如：

splitComp : (comp : Var) -> ST m () [comp ::: Composite [State Int, State String]]
splitComp comp = do [int, str] <- split comp

?whatNow

调用 split comp 会从复合资源 comp 中提取出 State Int 和 State String，并分别将它们存储在变
量 int 和 str 中。如果我们检查 whatNow 的类型，就会看到它影响了资源列表：

int : Var
str : Var
comp : Var
m : Type -> Type

--------------------------------------
whatNow : STrans m () [int ::: State Int, str ::: State String, comp ::: State ()]

(\result => [comp ::: Composite [State Int, State String]])

这样，我们就有了两个新的资源 int 和 str，而 comp 的类型则被更新为单元类型， 即当前没有保存数
据。这点符合预期：我们只是要将数据提取为独立的资源而已。

现在我们提取出了独立的资源，可以直接操作它们（比如，增加 Int 或为 String 添加换行）并使用
combine 重新构造复合资源：

splitComp : (comp : Var) ->
ST m () [comp ::: Composite [State Int, State String]]

splitComp comp = do [int, str] <- split comp
update int (+ 1)
update str (++ "\n")
combine comp [int, str]
?whatNow

同样，我们可以检查 whatNow 的类型来查看 combine 的作用：

comp : Var
int : Var
str : Var
m : Type -> Type

--------------------------------------
whatNow : STrans m () [comp ::: Composite [State Int, State String]]

(\result => [comp ::: Composite [State Int, State String]])

所以 combine 的作用就是接受既有的资源并将它们合并成一个复合资源。在执行 combine 之前，目标
资源必须存在（这里是 comp）且类型为 State ()。
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查看 split 和 combine 的类型，了解它们使用的资源列表的要求是很有启发的。split 的类型如下：

split : (lbl : Var) -> {auto prf : InState lbl (Composite vars) res} ->
STrans m (VarList vars) res (\vs => mkRes vs ++ updateRes res prf (State ()))

隐式的 prf 参数说明要被分解的 lbl 必须为复合资源。它返回一个由复合资源分解而来的变量列表，
而 mkRes 函数则创建一个对应类型的资源列表。最后，updateRes 会将复合资源的类型更新为 State
()。

而 combine 函数则反过来：

combine : (comp : Var) -> (vs : List Var) ->
{auto prf : InState comp (State ()) res} ->
{auto var_prf : VarsIn (comp :: vs) res} ->
STrans m () res (const (combineVarsIn res var_prf))

隐式的 prf参数确保了目标资源 comp的类型为 State ()。也就是说，我们不会覆盖任何其它的信息。
隐式的 var_prf 参数类似于 call 中的 SubRes，它确保了我们用来构造复合资源的每个变量都确实存
在于当前的资源列表中。

我们可以基于 Draw 以及任何需要的附加资源，通过复合资源的方式来实现高级的 TurtleGraphics
奁奐奉。

实实实现现现 Turtle

现在我们已经知道如何用一组既有的资源来构造出新的资源了。我们可以用复合资源实现 Turtle，它
包括一个用于绘图的 Surface，以及一些表示画笔颜色、位置和方向的独立的状态。我们还有一个线条
的列表，它描述了我们在调用 render 时要绘制到 Surface 上的图像：

Turtle = Composite [Surface {m}, -- 用来绘图的平面
State Col, -- 画笔颜色
State (Int, Int, Int, Bool), -- 画笔的位置/方向/落笔标记
State (List Line)] -- 渲染时要画的线条

一条 Line 由它的起始位置，终止位置和颜色定义：

Line : Type
Line = ((Int, Int), (Int, Int), Col)

首先来实现 start，它会创建一个新的 Turtle``（如果不可能则返回 ``Nothing）。我们从初始化绘
图平面开始，然后是所有状态构成的组件。最后，我们将所有的组件组合成一个复合资源来表示海龟：

start x y = do Just srf <- initWindow x y
| Nothing => pure Nothing

col <- new white
pos <- new (320, 200, 0, True)
lines <- new []
turtle <- new ()
combine turtle [srf, col, pos, lines]
pure (Just turtle)

然后来实现 end，它会把海龟处理掉。我们先析构复合资源，然后关闭窗口，删除所有独立的资源。记
住我们只能用 delete 删除一个 State，因此需要用 split 将复合资源分解掉，用 closeWindow 干净
地关闭绘图平面，然后用 delete 删除状态：

end t = do [srf, col, pos, lines] <- split t
closeWindow srf; delete col; delete pos; delete lines; delete t
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对于其它的方法，我们需要用 split 分解资源以获取每一个组件，然后在结束时用 combine 将它们组
合成一个复合资源。例如，以下为 penup 的实现：

penup t = do [srf, col, pos, lines] <- split t -- 分解复合资源
(x, y, d, _) <- read pos -- 析构画笔位置
write pos (x, y, d, False) -- 将落笔标记置为 False
combine t [srf, col, pos, lines] -- 重新组合组件

海龟剩下的操作遵循相同的模式。完整的细节见 奉奤奲奩女 发行版中的 samples/ST/Graphics/Turtle.idr
文件。之后就是是渲染海龟创建的图像：

render t = do [srf, col, pos, lines] <- split t -- 分解复合资源
filledRectangle srf (0, 0) (640, 480) black -- 绘制背景
drawAll srf !(read lines) -- 渲染海龟绘制的线条
flip srf -- 缓冲区翻页以显示图像
combine t [srf, col, pos, lines]
Just ev <- poll

| Nothing => render t -- 继续直到按下按键
case ev of

KeyUp _ => pure () -- 按键按下，于是退出
_ => render t

where drawAll : (srf : Var) -> List Line -> ST m () [srf ::: Surface {m}]
drawAll srf [] = pure ()
drawAll srf ((start, end, col) :: xs)

= do drawLine srf start end col -- 按相应的颜色绘制线条
drawAll srf xs

3.5 示示示例例例：：：网网网络络络 Socket 编编编程程程

奐奏奓奉奘 的插口（奓奯奣奫奥奴，另译作「套接字」）奁奐奉 支持跨网络的进程间通信。插插插口口口表示网络通信的端
点，它可以是以下几种状态之一：

• Ready 为初始状态

• Bound 表示已绑定至某个地址，准备接受传入的连接

• Listening 表示正在监听传入的连接

• Open 表示准备发送或接受数据

• Closed 表示不再活动

下图展示了该 奁奐奉 提供的操作是如何改变其状态的，其中 Ready 为初始状态：
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如如如果某个连接为 Open 状态，那么我们可以用 send 发送消息到该连接的另一端，也可以用 recv 从另一
端接收消息。

contrib 包提供了一个 Network.Socket 模块，该模块提供了创建插口以及发送和接收消息的原语。其
中包含以下函数：

bind : (sock : Socket) -> (addr : Maybe SocketAddress) -> (port : Port) -> IO Int
connect : (sock : Socket) -> (addr : SocketAddress) -> (port : Port) -> IO ResultCode
listen : (sock : Socket) -> IO Int
accept : (sock : Socket) -> IO (Either SocketError (Socket, SocketAddress))
send : (sock : Socket) -> (msg : String) -> IO (Either SocketError ResultCode)
recv : (sock : Socket) -> (len : ByteLength) -> IO (Either SocketError (String, ResultCode))
close : Socket -> IO ()

这些函数虽然涵盖了上图中所有的状态转移，然而却均未解释这些操作是如何影响其状态的！例如，我
们完全有可能在一个尚未就绪的插口上发送消息，或者在插口关闭后从中接收消息。

我们可以用 ST 提供更好的 奁奐奉，它精确地解释了每个操作是如何影响连接的状态的。在本节中，我们
会定义一个插口 奁奐奉，然后用它来实现一个「回显（奥奣奨奯）」服务器，通过原样返回客户端发送的消息
来响应客户端的请求。

3.5.1 定定定义义义 Sockets 接接接口口口

我们不直接用 IO 进行底层插口编程，而是用 ST 实现一个接口来精确地描述每个操作如何影响插口的
状态，以及何时创建或删除插口。我们首先来创建描述插口抽象状态的类型：

data SocketState = Ready | Bound | Listening | Open | Closed

接着定义一个接口，用 Sock 类型表示插口，以其当前状态作为该类型构造子的参数：

interface Sockets (m : Type -> Type) where
Sock : SocketState -> Type

我们用 socket 方法创建插口。插口库中定义了 SocketType，它描述了插口为 奔奃奐、奕奄奐 还是其它
形式。我们后面会一直使用 Stream 来表示 奔奃奐 插口。

socket : SocketType -> ST m (Either () Var) [addIfRight (Sock Ready)]

记住 addIfRight 会在操作结果的形式为 Right val 时添加资源。按照此接口的约定，我们用 Either
来表示可能失败的操作，它可以保存任何关于错误的附加信息。如此一来，我们就能一致地使用
addIfRight 和其它类型级函数了。
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现在来定义一个服务器。一旦我们创建了插口，就需要用 bind 方法将它绑定到一个端口上：

bind : (sock : Var) -> (addr : Maybe SocketAddress) -> (port : Port) ->
ST m (Either () ()) [sock ::: Sock Ready :-> (Sock Closed `or` Sock Bound)]

绑定插口可能会失败，例如如果已经有一个插口被绑定到给定的端口上，因此它同样要返回一个类型为
Either 的值。这里的动作使用了类型级函数 or，它的意思是：

• 若 bind 失败，插口就会转移到 Sock Closed 状态

• 若 bind 成功，插口就会转移到 Sock Bound 状态，如前图所示

or 的实现如下：

or : a -> a -> Either b c -> a
or x y = either (const x) (const y)

这样一来，bind 的类型就能写成如下等价形式：

bind : (sock : Var) -> (addr : Maybe SocketAddress) -> (port : Port) ->
STrans m (Either () ()) [sock ::: Sock Ready]

(either [sock ::: Sock Closed] [sock ::: Sock Bound])

然而，使用 or 会更加简洁，它也能尽可能直接地反映出状态转移图，同时仍然刻画了它可能失败的性
质。

一旦我们将插口绑定到了端口，就可以开始监听来自客户端的连接了：

listen : (sock : Var) ->
ST m (Either () ()) [sock ::: Sock Bound :-> (Sock Closed `or` Sock Listening)]

Listening 状态的插口表示准备接受来自独立客户端的连接：

accept : (sock : Var) ->
ST m (Either () Var)

[sock ::: Sock Listening, addIfRight (Sock Open)]

如果有客户端传入的连接，accept 会在资源列表的最后添加一个新新新的的的资源（按照约定，在列表末尾添
加资源可以更好地配合 updateWith 工作，如上一节所述）。 现在，我们有了两两两个个个插口：一个继续监听
传入的连接，另一个准备与客户端通信。

我们还需要能够在插口上发送和接受数据的方法：

send : (sock : Var) -> String ->
ST m (Either () ()) [sock ::: Sock Open :-> (Sock Closed `or` Sock Open)]

recv : (sock : Var) ->
ST m (Either () String) [sock ::: Sock Open :-> (Sock Closed `or` Sock Open)]

一旦我们与另一台机器通过插口进行的通信结束， 就需要用 close 关闭连接并用 remove 移除该插口：

close : (sock : Var) ->
{auto prf : CloseOK st} -> ST m () [sock ::: Sock st :-> Sock Closed]

remove : (sock : Var) ->
ST m () [Remove sock (Sock Closed)]

close 使用了断言 CloseOK 作为隐式证明参数，它描述了何时可以关闭插口：

data CloseOK : SocketState -> Type where
CloseOpen : CloseOK Open
CloseListening : CloseOK Listening
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也就是说，我们可以关闭 Open 状态的插口，告诉另一台机器终止通信。我们也可以关闭 Listening 状
态下等待传入连接的插口，这会让服务器停止接受请求。

在本节中，我们实现了一个服务器，不过为了完整性，我们还需要在另一台机器上实现客户端来连接到
服务器。这可以通过 connect 来完成：

connect : (sock : Var) -> SocketAddress -> Port ->
ST m (Either () ()) [sock ::: Sock Ready :-> (Sock Closed `or` Sock Open)]

以下完整的接口作为参考：

interface Sockets (m : Type -> Type) where
Sock : SocketState -> Type
socket : SocketType -> ST m (Either () Var) [addIfRight (Sock Ready)]
bind : (sock : Var) -> (addr : Maybe SocketAddress) -> (port : Port) ->

ST m (Either () ()) [sock ::: Sock Ready :-> (Sock Closed `or` Sock Bound)]
listen : (sock : Var) ->

ST m (Either () ()) [sock ::: Sock Bound :-> (Sock Closed `or` Sock Listening)]
accept : (sock : Var) ->

ST m (Either () Var) [sock ::: Sock Listening, addIfRight (Sock Open)]
connect : (sock : Var) -> SocketAddress -> Port ->

ST m (Either () ()) [sock ::: Sock Ready :-> (Sock Closed `or` Sock Open)]
close : (sock : Var) -> {auto prf : CloseOK st} ->

ST m () [sock ::: Sock st :-> Sock Closed]
remove : (sock : Var) -> ST m () [Remove sock (Sock Closed)]
send : (sock : Var) -> String ->

ST m (Either () ()) [sock ::: Sock Open :-> (Sock Closed `or` Sock Open)]
recv : (sock : Var) ->

ST m (Either () String) [sock ::: Sock Open :-> (Sock Closed `or` Sock Open)]

我们稍后会看到如何实现它。这些方法大部分都可以直接通过原始的插口 奁奐奉 在 IO 中实现。不过首
先，我们会看到如何用这些 奁奐奉 实现一个「回显」服务器。

3.5.2 用用用 Sockets 实实实现现现「「「回回回显显显」」」服服服务务务器器器

从顶层来说，我们的回显（奥奣奨奯）服务器在开始和结束时均没有资源可用，它使用了 ConsoleIO 和
Sockets 接口：

startServer : (ConsoleIO m, Sockets m) => ST m () []

首先我们需要用 socket 创建一个插口，绑定到一个端口并监听传入的连接。它可能会失败，因此我们
需要处理它返回 Right sock 的情况，其中 sock 是新的插口变量，不过也可能返回 Left err：

startServer : (ConsoleIO m, Sockets m) => ST m () []
startServer =

do Right sock <- socket Stream
| Left err => pure ()

?whatNow

交互式地实现这类函数是个不错的想法，我们可以通过挖坑来逐步观察整个系统的状态是如何变化的。
在成功调用了 socket 之后，我们就有了 Ready 状态的插口：

sock : Var
m : Type -> Type
constraint : ConsoleIO m
constraint1 : Sockets m

--------------------------------------
whatNow : STrans m () [sock ::: Sock Ready] (\result1 => [])
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接着，我们需要将插口绑定到端口，然后开始监听连接。同样，每一步都可能会失败，此时我们会移除
该插口。失败总会导致插口转为 Closed 状态，此时我们能做的就是用 remove 移除它：

startServer : (ConsoleIO m, Sockets m) => ST m () []
startServer =

do Right sock <- socket Stream | Left err => pure ()
Right ok <- bind sock Nothing 9442 | Left err => remove sock
Right ok <- listen sock | Left err => remove sock
?runServer

最后，我们就有了一个监听传入连接的插口：

ok : ()
sock : Var
ok1 : ()
m : Type -> Type
constraint : ConsoleIO m
constraint1 : Sockets m

--------------------------------------
runServer : STrans m () [sock ::: Sock Listening]

(\result1 => [])

我们会在一个独立的函数中实现它。runServer 的类型告诉我们 echoServer 的类型必须是什么（我们
无需显式地为 Sock 给出参数 m）：

echoServer : (ConsoleIO m, Sockets m) => (sock : Var) ->
ST m () [remove sock (Sock {m} Listening)]

我们可以完成 startServer 的定义：

startServer : (ConsoleIO m, Sockets m) => ST m () []
startServer =

do Right sock <- socket Stream | Left err => pure ()
Right ok <- bind sock Nothing 9442 | Left err => remove sock
Right ok <- listen sock | Left err => remove sock
echoServer sock

在 echoServer 中，我们会继续接受并相应请求直到出现失败，此时我们会关闭插口并返回。我们从尝
试接受传入的连接开始：

echoServer : (ConsoleIO m, Sockets m) => (sock : Var) ->
ST m () [remove sock (Sock {m} Listening)]

echoServer sock =
do Right new <- accept sock | Left err => do close sock; remove sock

?whatNow

若 accept 失败，我们就需要关闭 Listening 状态的插口并在返回前移除它，因为 echoServer 的类型
要求如此。

通常，逐步实现 echoServer 意味着我们可以在开发过程中检查当前的状态。如果 accept 成功，那么
我们既有的 sock 会继续监听连接，此外一个新的 new 插口会被打开用于通信：

new : Var
sock : Var
m : Type -> Type
constraint : ConsoleIO m
constraint1 : Sockets m

--------------------------------------
whatNow : STrans m () [sock ::: Sock Listening, new ::: Sock Open]

(\result1 => [])
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要完成 echoServer，我们需要从 new 插口上接收一条消息，然后原样返回它。在完成后，我们就关闭
new 插口，然后回到 echoServer 的开始处，准备响应下一次连接：

echoServer : (ConsoleIO m, Sockets m) => (sock : Var) ->
ST m () [remove sock (Sock {m} Listening)]

echoServer sock =
do Right new <- accept sock | Left err => do close sock; remove sock

Right msg <- recv new | Left err => do close sock; remove sock; remove new
Right ok <- send new ("You said " ++ msg)

| Left err => do remove new; close sock; remove sock
close new; remove new; echoServer sock

3.5.3 实实实现现现 Sockets

为了在 IO 中实现 Sockets，我们需要从给出具体的 Sock 类型开始。我们可以用原始的插口 奁奐奉（在
Network.Socket 中实现），将 Socket 存储在 State 中来得到具体的类型，而不必关心该插口所处的
抽象状态：

implementation Sockets IO where
Sock _ = State Socket

大部分方法都可以直接用原始的插口 奁奐奉 来实现，返回相应的 Left 或 Right。例如，我们可以实现
socket、bind 和 listen：

socket ty = do Right sock <- lift $ Socket.socket AF_INET ty 0
| Left err => pure (Left ())

lbl <- new sock
pure (Right lbl)

bind sock addr port = do ok <- lift $ bind !(read sock) addr port
if ok /= 0

then pure (Left ())
else pure (Right ())

listen sock = do ok <- lift $ listen !(read sock)
if ok /= 0

then pure (Left ())
else pure (Right ())

然而，这里的 accept 有点不同， 因为我们在用 new 为打开连接创建新资源时，它出现在了资源列表的
起起起始始始处而非末尾。我们可以通过写出不完整的定义来看到这一点， 使用 returning 来查看返回 Right
lbl 需要什么资源：

accept sock = do Right (conn, addr) <- lift $ accept !(read sock)
| Left err => pure (Left ())

lbl <- new conn
returning (Right lbl) ?fixResources

使用 new 将资源添加到列表起始处是很方便的，因为通常来说，这会让 奉奤奲奩女 使用隐式 auto 自动构造
证明更加容易。另一方面，当我们用 call 来构造更小的资源集合时，updateWith 会将新创建的资源放
到列表的末末末尾尾尾处，因为通常这样会减少需要重新排序的资源的数量。

如果我们查看 fixResources 的类型，就会知道结束 accept 需要做的事情：

_bindApp0 : Socket
conn : Socket
addr : SocketAddress
sock : Var
lbl : Var

--------------------------------------
(äÿŃéąțçżğçżŋ)

3.5. 示示示例例例：：：网网网络络络 Socket 编编编程程程 100



Idris 语语语言言言文文文档档档, 版版版本本本 1.3.1

(çżŋäÿŁéąț)

fixResources : STrans IO () [lbl ::: State Socket, sock ::: State Socket]
(\value => [sock ::: State Socket, lbl ::: State Socket])

当前资源列表的顺序为 lbl、sock，而我们需要它们的顺序变成 sock、lbl。为此，Control.ST 提供
了原语 toEnd，它会将一个资源移到列表的末尾。这样我们就能完成 accept 了：

accept sock = do Right (conn, addr) <- lift $ accept !(read sock)
| Left err => pure (Left ())

lbl <- new conn
returning (Right lbl) (toEnd lbl)

Sockets 的完整实现见 奉奤奲奩女 发行版中的 samples/ST/Net/Network.idr 文件。你也可以在同目录下的
EchoServer.idr 文件中找到回显服务器。此外还有一个高级网络协议 RandServer.idr，它基于底层
的插口 奁奐奉，通过状态机的层级实现了一个高级的网络通信协议。它还使用线程来异步地处理传入的请
求。你可以在 奅奤奷奩奮 奂奲奡奤她 的文稿 奓奴奡奴奥 奍奡奣奨奩奮奥女 奁奬奬 奔奨奥 套奡她 奄奯奷奮 （深入理解状态机）中找到关
于线程和随机数服务器的更多详情。

3.5. 示示示例例例：：：网网网络络络 Socket 编编编程程程 101
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CHAPTER 4

The Effects Tutorial
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Effects and the Control.ST module
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奦奡奣奩奬奩奴奩奥女 奯奦 Effects 奢奵奴 奷奩奴奨 奢奥奴奴奥奲 女奵奰奰奯奲奴 奦奯奲 奣奲奥奡奴奩奮奧 奡奮奤 奤奥奬奥奴奩奮奧 奲奥女奯奵奲奣奥女夬 奡奮奤 奩奭奰奬奥奭奥奮奴奩奮奧
奲奥女奯奵奲奣奥女 奩奮 奴奥奲奭女 奯奦 奯奴奨奥奲 奲奥女奯奵奲奣奥女央

奕奮奬奥女女 她奯奵 奨奡奶奥 奡 奰奡奲奴奩奣奵奬奡奲 奲奥奡女奯奮 奴奯 奵女奥 Effects 她奯奵 奡奲奥 女奴奲奯奮奧奬她 奲奥奣奯奭奭奥奮奤奥奤 奴奯 奵女奥 Control.ST
奩奮女奴奥奡奤央 奔奨奥奲奥 奩女 奡 奴奵奴奯奲奩奡奬 奡奶奡奩奬奡奢奬奥 奯奮 奴奨奩女 女奩奴奥 奦奯奲 Control.ST 奷奩奴奨 女奥奶奥奲奡奬 奥奸奡奭奰奬奥女 夨用 Idris 实现
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奮奥奩奧奨奢奯奵奲奩奮奧 奲奩奧奨奴女 奴奯 奄奯奣奵奭奥奮奴奡奴奩奯奮 奦奯奲 奉奤奲奩女央
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奰奲奯奧奲奡奭奭奩奮奧 奡奮奤 奲奥奡女奯奮奩奮奧 奷奩奴奨 女奩奤奥夭奥夛奥奣奴奩奮奧 奰奲奯奧奲奡奭女夬 女奵奰奰奯奲奴奩奮奧 奭奵奴奡奢奬奥 女奴奡奴奥夬 奩奮奴奥奲奡奣奴奩奯奮 奷奩奴奨 奴奨奥
奯奵奴女奩奤奥 奷奯奲奬奤夬 奥奸奣奥奰奴奩奯奮女夬 奡奮奤 奶奥奲奩夜奥奤 奲奥女奯奵奲奣奥 奭奡奮奡奧奥奭奥奮奴央

失夰夲

http://creativecommons.org/publicdomain/zero/1.0/
http://creativecommons.org/publicdomain/zero/1.0/
http://www.idris-lang.org/


Idris 语语语言言言文文文档档档, 版版版本本本 1.3.1

奔奨奩女 奴奵奴奯奲奩奡奬 奡女女奵奭奥女 奦奡奭奩奬奩奡奲奩奴她 奷奩奴奨 奰奵奲奥 奰奲奯奧奲奡奭奭奩奮奧 奩奮 奉奤奲奩女夬 奡女 奤奥女奣奲奩奢奥奤 奩奮 奓奥奣奴奩奯奮女 失夕夶 奯奦 奴奨奥
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vadd : Vect n Int -> Vect n Int -> Vect n Int
vadd [] [] = []
vadd (x :: xs) (y :: ys) = x + y :: vadd xs ys
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• 套奲奩奴奥 奯奵奴奰奵奴

奔奨奥 奣奯奭奰奬奥奴奥 奰奲奯奧奲奡奭 奷奩奬奬 奩奮奣奬奵奤奥 女奩奤奥夭奥夛奥奣奴女 奦奯奲 奉夯奏 奡奮奤 奥奲奲奯奲 奨奡奮奤奬奩奮奧夬 奢奥奦奯奲奥 奷奥 奣奡奮 奧奥奴 奴奯 奴奨奥 奰奵奲奥
奣奯奲奥 奦奵奮奣奴奩奯奮奡奬奩奴她央 奉奮 奴奨奩女 奴奵奴奯奲奩奡奬夬 奷奥 奷奩奬奬 女奥奥 奨奯奷 奉奤奲奩女 女奵奰奰奯奲奴女 女奩奤奥夭奥夛奥奣奴女央 奆奵奲奴奨奥奲奭奯奲奥夬 奷奥 奷奩奬奬 女奥奥
奨奯奷 奷奥 奣奡奮 奵女奥 奴奨奥 奤奥奰奥奮奤奥奮奴 奴她奰奥 女她女奴奥奭 奴奯 reason 奡奢奯奵奴 女奴奡奴奥奦奵奬 奡奮奤 女奩奤奥夭奥夛奥奣奴奩奮奧 奰奲奯奧奲奡奭女央 套奥
奷奩奬奬 奲奥奴奵奲奮 奴奯 奴奨奩女 女奰奥奣奩夜奣 奥奸奡奭奰奬奥 奬奡奴奥奲央

4.1.1 Hello world

奔奯 奧奩奶奥 奡奮 奩奤奥奡 奯奦 奨奯奷 奰奲奯奧奲奡奭女 奷奩奴奨 奥夛奥奣奴女 奬奯奯奫夬 奨奥奲奥 奩女 奴奨奥 奵奢奩奱奵奩奴奯奵女 “奈奥奬奬奯 奷奯奲奬奤” 奰奲奯奧奲奡奭夬
奷奲奩奴奴奥奮 奵女奩奮奧 奴奨奥 Effects 奬奩奢奲奡奲她夺

module Main

import Effects
import Effect.StdIO

hello : Eff () [STDIO]
hello = putStrLn "Hello world!"

main : IO ()
main = run hello

奁女 奵女奵奡奬夬 奴奨奥 奥奮奴奲她 奰奯奩奮奴 奩女 main央 奁奬奬 main 奨奡女 奴奯 奤奯 奩女 奩奮奶奯奫奥 奴奨奥 hello 奦奵奮奣奴奩奯奮 奷奨奩奣奨 女奵奰奰奯奲奴女 奴奨奥
STDIO 奥夛奥奣奴 奦奯奲 奣奯奮女奯奬奥 奉夯奏夬 奡奮奤 奲奥奴奵奲奮女 奴奨奥 奵奮奩奴 奶奡奬奵奥央 奁奬奬 奰奲奯奧奲奡奭女 奵女奩奮奧 奴奨奥 Effects 奬奩奢奲奡奲她 奭奵女奴
import Effects央 奔奨奥 奤奥奴奡奩奬女 奯奦 奴奨奥 Eff 奴她奰奥 奷奩奬奬 奢奥 奰奲奥女奥奮奴奥奤 奩奮 奴奨奥 奲奥奭奡奩奮奤奥奲 奯奦 奴奨奩女 奴奵奴奯奲奩奡奬央

奔奯 奣奯奭奰奩奬奥 奡奮奤 奲奵奮 奴奨奩女 奰奲奯奧奲奡奭夬 奉奤奲奩女 奮奥奥奤女 奴奯 奢奥 奴奯奬奤 奴奯 奩奮奣奬奵奤奥 奴奨奥 Effects 奰奡奣奫奡奧奥夬 奵女奩奮奧 奴奨奥 -p
effects 夝奡奧 夨奴奨奩女 夝奡奧 奩女 奲奥奱奵奩奲奥奤 奦奯奲 奡奬奬 奥奸奡奭奰奬奥女 奩奮 奴奨奩女 奴奵奴奯奲奩奡奬天夺

idris hello.idr -o hello -p effects
./hello Hello world!

1 You do not, however, need to know what a monad is!
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4.1.2 Outline

奔奨奥 奴奵奴奯奲奩奡奬 奩女 女奴奲奵奣奴奵奲奥奤 奡女 奦奯奬奬奯奷女夺 夜奲女奴夬 奩奮 奓奥奣奴奩奯奮 State 夨姩妡妵 失夰头天夬 奷奥 奷奩奬奬 奤奩女奣奵女女 女奴奡奴奥 奭奡奮奡奧奥奭奥奮奴夬
奤奥女奣奲奩奢奩奮奧 奷奨她 奩奴 奩女 奩奭奰奯奲奴奡奮奴 奡奮奤 奩奮奴奲奯奤奵奣奩奮奧 奴奨奥 effects 奬奩奢奲奡奲她 奴奯 女奨奯奷 奨奯奷 奩奴 奣奡奮 奢奥 奵女奥奤 奴奯 奭奡奮奡奧奥
女奴奡奴奥央 奔奨奩女 女奥奣奴奩奯奮 奡奬女奯 奧奩奶奥女 奡奮 奯奶奥奲奶奩奥奷 奯奦 奴奨奥 女她奮奴奡奸 奯奦 奥夛奥奣奴奦奵奬 奰奲奯奧奲奡奭女央 奓奥奣奴奩奯奮 Simple Effects
夨姩妡妵 失失失天 奴奨奥奮 奩奮奴奲奯奤奵奣奥女 奡 奮奵奭奢奥奲 奯奦 奯奴奨奥奲 奥夛奥奣奴女 奡 奰奲奯奧奲奡奭 奭奡她 奨奡奶奥夺 奉夯奏夻 奅奸奣奥奰奴奩奯奮女夻 奒奡奮奤奯奭
奎奵奭奢奥奲女夻 奡奮奤 奎奯奮夭奤奥奴奥奲奭奩奮奩女奭夬 奧奩奶奩奮奧 奥奸奡奭奰奬奥女 奦奯奲 奥奡奣奨夬 奡奮奤 奡奮 奥奸奴奥奮奤奥奤 奥奸奡奭奰奬奥 奣奯奭奢奩奮奩奮奧 女奥奶奥奲奡奬
奥夛奥奣奴女 奩奮 奯奮奥 奣奯奭奰奬奥奴奥 奰奲奯奧奲奡奭央 奓奥奣奴奩奯奮 Dependent Effects 夨姩妡妵 失失夸天 奩奮奴奲奯奤奵奣奥女 dependent 奥夛奥奣奴女夬
女奨奯奷奩奮奧 奨奯奷 女奴奡奴奥女 奡奮奤 奲奥女奯奵奲奣奥女 奣奡奮 奢奥 奭奡奮奡奧奥奤 奩奮 奴她奰奥女央 奓奥奣奴奩奯奮 Creating New Effects 夨姩妡妵 失夲夳天
女奨奯奷女 奨奯奷 奮奥奷 奥夛奥奣奴女 奣奡奮 奢奥 奩奭奰奬奥奭奥奮奴奥奤央 奓奥奣奴奩奯奮 Example: A “Mystery Word” Guessing Game
夨姩妡妵 失夲夷天 奧奩奶奥女 奡奮 奥奸奴奥奮奤奥奤 奥奸奡奭奰奬奥 女奨奯奷奩奮奧 奨奯奷 奴奯 奩奭奰奬奥奭奥奮奴 奡 “奭她女奴奥奲她 奷奯奲奤” 奧奵奥女女奩奮奧 奧奡奭奥夬
奵女奩奮奧 奥夛奥奣奴女 奴奯 奤奥女奣奲奩奢奥 奴奨奥 奲奵奬奥女 奯奦 奴奨奥 奧奡奭奥 奡奮奤 奥奮女奵奲奥 奴奨奥她 奡奲奥 奩奭奰奬奥奭奥奮奴奥奤 奡奣奣奵奲奡奴奥奬她央 奒奥奦奥奲奥奮奣奥女
奴奯 奦奵奲奴奨奥奲 奲奥奡奤奩奮奧 奡奲奥 奧奩奶奥奮 奩奮 奓奥奣奴奩奯奮 Further Reading 夨姩妡妵 失夳夲天央

4.2 State

奍奡奮她 奰奲奯奧奲奡奭女夬 奥奶奥奮 奰奵奲奥 奰奲奯奧奲奡奭女夬 奣奡奮 奢奥奮奥夜奴 奦奲奯奭 奬奯奣奡奬奬她 奭奵奴奡奢奬奥 女奴奡奴奥央 奆奯奲 奥奸奡奭奰奬奥夬 奣奯奮女奩奤奥奲 奡
奰奲奯奧奲奡奭 奷奨奩奣奨 奴奡奧女 奢奩奮奡奲她 奴奲奥奥 奮奯奤奥女 奷奩奴奨 奡 奣奯奵奮奴奥奲夬 奢她 奡奮 奩奮奯奲奤奥奲 奴奲奡奶奥奲女奡奬 夨奩央奥央 奣奯奵奮奴奩奮奧 奤奥奰奴奨 夜奲女奴夬
奬奥奦奴 奴奯 奲奩奧奨奴天央 奔奨奩女 奷奯奵奬奤 奰奥奲奦奯奲奭 女奯奭奥奴奨奩奮奧 奬奩奫奥 奴奨奥 奦奯奬奬奯奷奩奮奧夺

套奥 奣奡奮 奤奥女奣奲奩奢奥 奢奩奮奡奲她 奴奲奥奥女 奷奩奴奨 奴奨奥 奦奯奬奬奯奷奩奮奧 奤奡奴奡 奴她奰奥 BTree 奡奮奤 testTree 奴奯 奲奥奰奲奥女奥奮奴 奴奨奥 奥奸奡奭奰奬奥
奩奮奰奵奴 奡奢奯奶奥夺

data BTree a = Leaf
| Node (BTree a) a (BTree a)

testTree : BTree String
testTree = Node (Node Leaf "Jim" Leaf)

"Fred"
(Node (Node Leaf "Alice" Leaf)

"Sheila"
(Node Leaf "Bob" Leaf))

奔奨奥奮 奯奵奲 奦奵奮奣奴奩奯奮 奴奯 奩奭奰奬奥奭奥奮奴 奴奡奧奧奩奮奧夬 奢奥奧奩奮奮奩奮奧 奴奯 奴奡奧 奷奩奴奨 奡 女奰奥奣奩夜奣 奶奡奬奵奥 i夬 奨奡女 奴奨奥 奦奯奬奬奯奷奩奮奧 奴她奰奥夺

treeTag : (i : Int) -> BTree a -> BTree (Int, a)
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4.2.1 First attempt

奎奡奶奥奬她夬 奷奥 奣奡奮 奩奭奰奬奥奭奥奮奴 treeTag 奢她 奩奭奰奬奥奭奥奮奴奩奮奧 奡 奨奥奬奰奥奲 奦奵奮奣奴奩奯奮 奷奨奩奣奨 奰奲奯奰奡奧奡奴奥女 奡 奣奯奵奮奴奥奲夬
奲奥奴奵奲奮奩奮奧 奴奨奥 奲奥女奵奬奴 奯奦 奴奨奥 奣奯奵奮奴 奦奯奲 奥奡奣奨 女奵奢奴奲奥奥夺

treeTagAux : (i : Int) -> BTree a -> (Int, BTree (Int, a))
treeTagAux i Leaf = (i, Leaf)
treeTagAux i (Node l x r)

= let (i', l') = treeTagAux i l in
let x' = (i', x) in
let (i'', r') = treeTagAux (i' + 1) r in

(i'', Node l' x' r')

treeTag : (i : Int) -> BTree a -> BTree (Int, a)
treeTag i x = snd (treeTagAux i x)

奔奨奩女 奧奩奶奥女 奴奨奥 奥奸奰奥奣奴奥奤 奲奥女奵奬奴 奷奨奥奮 奲奵奮 奡奴 奴奨奥 奒奅奐奌 奰奲奯奭奰奴夺

*TreeTag> treeTag 1 testTree
Node (Node Leaf (1, "Jim") Leaf)

(2, "Fred")
(Node (Node Leaf (3, "Alice") Leaf)

(4, "Sheila")
(Node Leaf (5, "Bob") Leaf)) : BTree (Int, String)

奔奨奩女 奷奯奲奫女 奡女 奲奥奱奵奩奲奥奤夬 奢奵奴 奴奨奥奲奥 奡奲奥 女奥奶奥奲奡奬 奰奲奯奢奬奥奭女 奷奨奥奮 奷奥 奴奲她 奴奯 女奣奡奬奥 奴奨奩女 奴奯 奬奡奲奧奥奲 奰奲奯奧奲奡奭女央 奉奴
奩女 奥奲奲奯奲 奰奲奯奮奥夬 奢奥奣奡奵女奥 奷奥 奮奥奥奤 奴奯 奥奮女奵奲奥 奴奨奡奴 女奴奡奴奥 奩女 奰奲奯奰奡奧奡奴奥奤 奣奯奲奲奥奣奴奬她 奴奯 奴奨奥 奲奥奣奵奲女奩奶奥 奣奡奬奬女 夨奩央奥央
奰奡女女奩奮奧 奴奨奥 奡奰奰奲奯奰奲奩奡奴奥 i 奯奲 i’天央 奉奴 奩女 奨奡奲奤 奴奯 奲奥奡奤夬 奢奥奣奡奵女奥 奴奨奥 奦奵奮奣奴奩奯奮奡奬 奤奥奴奡奩奬女 奡奲奥 奯奢女奣奵奲奥奤 奢她
奴奨奥 女奴奡奴奥 奰奲奯奰奡奧奡奴奩奯奮央 奐奥奲奨奡奰女 奭奯女奴 奩奭奰奯奲奴奡奮奴奬她夬 奴奨奥奲奥 奩女 奡 奣奯奭奭奯奮 奰奲奯奧奲奡奭奭奩奮奧 奰奡奴奴奥奲奮 奨奥奲奥 奷奨奩奣奨
女奨奯奵奬奤 奢奥 奡奢女奴奲奡奣奴奥奤 奢奵奴 奩奮女奴奥奡奤 奨奡女 奢奥奥奮 奩奭奰奬奥奭奥奮奴奥奤 奢她 奨奡奮奤央 奔奨奥奲奥 奩女 奬奯奣奡奬 奭奵奴奡奢奬奥 女奴奡奴奥 夨奴奨奥
奣奯奵奮奴奥奲天 奷奨奩奣奨 奷奥 奨奡奶奥 奨奡奤 奴奯 奭奡奫奥 奥奸奰奬奩奣奩奴央

4.2.2 Introducing Effects

奉奤奲奩女 奰奲奯奶奩奤奥女 奡 奬奩奢奲奡奲她夬 Effects3夬 奷奨奩奣奨 奣奡奰奴奵奲奥女 奴奨奩女 奰奡奴奴奥奲奮 奡奮奤 奭奡奮她 奯奴奨奥奲女 奩奮奶奯奬奶奩奮奧 奥夛奥奣奴奦奵奬
奣奯奭奰奵奴奡奴奩奯奮1央 奁奮 奥夛奥奣奴奦奵奬 奰奲奯奧奲奡奭 f 奨奡女 奡 奴她奰奥 奯奦 奴奨奥 奦奯奬奬奯奷奩奮奧 奦奯奲奭夺

f : (x1 : a1) -> (x2 : a2) -> ... -> Eff t effs

奔奨奡奴 奩女夬 奴奨奥 奲奥奴奵奲奮 奴她奰奥 奧奩奶奥女 奴奨奥 奥夛奥奣奴女 奴奨奡奴 f 女奵奰奰奯奲奴女 夨effs夬 奯奦 奴她奰奥 List EFFECT天 奡奮奤 奴奨奥 奴她奰奥 奴奨奥
奣奯奭奰奵奴奡奴奩奯奮 奲奥奴奵奲奮女 t央 奓奯夬 奯奵奲 treeTagAux 奨奥奬奰奥奲 奣奯奵奬奤 奢奥 奷奲奩奴奴奥奮 奷奩奴奨 奴奨奥 奦奯奬奬奯奷奩奮奧 奴她奰奥夺

treeTagAux : BTree a -> Eff (BTree (Int, a)) [STATE Int]

奔奨奡奴 奩女夬 treeTagAux 奨奡女 奡奣奣奥女女 奴奯 奡奮 奩奮奴奥奧奥奲 女奴奡奴奥夬 奢奥奣奡奵女奥 奴奨奥 奬奩女奴 奯奦 奡奶奡奩奬奡奢奬奥 奥夛奥奣奴女 奩奮奣奬奵奤奥女 STATE
Int央 STATE 奩女 奤奥奣奬奡奲奥奤 奡女 奦奯奬奬奯奷女 奩奮 奴奨奥 奭奯奤奵奬奥 Effect.State 夨奴奨奡奴 奩女夬 奷奥 奭奵女奴 import Effect.State
奴奯 奢奥 奡奢奬奥 奴奯 奵女奥 奩奴天夺

STATE : Type -> EFFECT

奉奴 奩女 奡奮 奥夛奥奣奴 奰奡奲奡奭奥奴奥奲奩女奥奤 奢她 奡 奴她奰奥 夨奢她 奣奯奮奶奥奮奴奩奯奮夬 奷奥 奷奲奩奴奥 奥夛奥奣奴女 奩奮 奡奬奬 奣奡奰奩奴奡奬女天央 奔奨奥 treeTagAux
奦奵奮奣奴奩奯奮 奩女 奡奮 奥夛奥奣奴奦奵奬 奰奲奯奧奲奡奭 奷奨奩奣奨 奢奵奩奬奤女 奡 奮奥奷 奴奲奥奥 奴奡奧奧奥奤 奷奩奴奨 Ints夬 奡奮奤 奩女 奩奭奰奬奥奭奥奮奴奥奤 奡女 奦奯奬奬奯奷女夺

3 Edwin Brady. 2013. Programming and reasoning with algebraic effects and dependent types. SIGPLAN Not. 48, 9
(September 2013), 133-144. DOI=10.1145/2544174.2500581 http://dl.acm.org/citation.cfm?doid=2544174.2500581

1 The earlier paper3 describes the essential implementation details, although the library presented there is an earlier
version which is less powerful than that presented in this tutorial.
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treeTagAux Leaf = pure Leaf
treeTagAux (Node l x r)

= do l' <- treeTagAux l
i <- get
put (i + 1)
r' <- treeTagAux r
pure (Node l' (i, x) r')

奔奨奥奲奥 奡奲奥 女奥奶奥奲奡奬 奲奥奭奡奲奫女 奴奯 奢奥 奭奡奤奥 奡奢奯奵奴 奴奨奩女 奩奭奰奬奥奭奥奮奴奡奴奩奯奮央 奅女女奥奮奴奩奡奬奬她夬 奩奴 奨奩奤奥女 奴奨奥 女奴奡奴奥夬 奷奨奩奣奨
奣奡奮 奢奥 奡奣奣奥女女奥奤 奵女奩奮奧 get 奡奮奤 奵奰奤奡奴奥奤 奵女奩奮奧 put夬 奢奵奴 奩奴 奩奮奴奲奯奤奵奣奥女 女奥奶奥奲奡奬 奮奥奷 奦奥奡奴奵奲奥女央 奓奰奥奣奩夜奣奡奬奬她夬 奩奴
奵女奥女 do夭奮奯奴奡奴奩奯奮夬 奢奩奮奤奩奮奧 奶奡奲奩奡奢奬奥女 奷奩奴奨 <-夬 奡奮奤 奡 pure 奦奵奮奣奴奩奯奮央 奔奨奥奲奥 奩女 奭奵奣奨 奴奯 奢奥 女奡奩奤 奡奢奯奵奴 奴奨奥女奥
奦奥奡奴奵奲奥女夬 奢奵奴 奦奯奲 奯奵奲 奰奵奲奰奯女奥女夬 奩奴 女奵夞奣奥女 奴奯 奫奮奯奷 奴奨奥 奦奯奬奬奯奷奩奮奧夺

• do 奢奬奯奣奫女 奡奬奬奯奷 奥夛奥奣奴奦奵奬 奯奰奥奲奡奴奩奯奮女 奴奯 奢奥 女奥奱奵奥奮奣奥奤央

• x <- e binds the result of an effectful operation e to a 奶奡奲奩奡奢奬奥 x央 奆奯奲 奥奸奡奭奰奬奥夬 奩奮 奴奨奥
奡奢奯奶奥 奣奯奤奥夬 treeTagAux l 奩女 奡奮 奥夛奥奣奴奦奵奬 奯奰奥奲奡奴奩奯奮 奲奥奴奵奲奮奩奮奧 BTree (Int, a)夬 女奯 l’ 奨奡女
奴她奰奥 BTree (Int, a)央

• pure e turns a pure value e into the result of an effectful 奯奰奥奲奡奴奩奯奮央

奔奨奥 get 奡奮奤 put 奦奵奮奣奴奩奯奮女 奲奥奡奤 奡奮奤 奷奲奩奴奥 奡 女奴奡奴奥 t夬 奡女女奵奭奩奮奧 奴奨奡奴 奴奨奥 STATE t 奥夛奥奣奴 奩女 奡奶奡奩奬奡奢奬奥央 奔奨奥她
奨奡奶奥 奴奨奥 奦奯奬奬奯奷奩奮奧 奴她奰奥女夬 奰奯奬她奭奯奲奰奨奩奣 奩奮 奴奨奥 女奴奡奴奥 t 奴奨奥她 奭奡奮奡奧奥夺

get : Eff t [STATE t]
put : t -> Eff () [STATE t]

奁 奰奲奯奧奲奡奭 奩奮 Eff 奣奡奮 奣奡奬奬 奡奮她 奯奴奨奥奲 奦奵奮奣奴奩奯奮 奩奮 Eff 奰奲奯奶奩奤奥奤 奴奨奡奴 奴奨奥 奣奡奬奬奩奮奧 奦奵奮奣奴奩奯奮 女奵奰奰奯奲奴女 奡奴 奬奥奡女奴
奴奨奥 奥夛奥奣奴女 奲奥奱奵奩奲奥奤 奢她 奴奨奥 奣奡奬奬奥奤 奦奵奮奣奴奩奯奮央 奉奮 奴奨奩女 奣奡女奥夬 奩奴 奩女 奶奡奬奩奤 奦奯奲 treeTagAux 奴奯 奣奡奬奬 奢奯奴奨 get 奡奮奤
put 奢奥奣奡奵女奥 奡奬奬 奴奨奲奥奥 奦奵奮奣奴奩奯奮女 女奵奰奰奯奲奴 奴奨奥 STATE Int 奥夛奥奣奴央

奐奲奯奧奲奡奭女 奩奮 Eff 奡奲奥 奲奵奮 奩奮 女奯奭奥 奵奮奤奥奲奬她奩奮奧 computation context夬 奵女奩奮奧 奴奨奥 run 奯奲 runPure 奦奵奮奣奴奩奯奮央
奕女奩奮奧 runPure夬 奷奨奩奣奨 奲奵奮女 奡奮 奥夛奥奣奴奦奵奬 奰奲奯奧奲奡奭 奩奮 奴奨奥 奩奤奥奮奴奩奴她 奣奯奮奴奥奸奴夬 奷奥 奣奡奮 奷奲奩奴奥 奴奨奥 treeTag
奦奵奮奣奴奩奯奮 奡女 奦奯奬奬奯奷女夬 奵女奩奮奧 put 奴奯 奩奮奩奴奩奡奬奩女奥 奴奨奥 女奴奡奴奥夺

treeTag : (i : Int) -> BTree a -> BTree (Int, a)
treeTag i x = runPure (do put i

treeTagAux x)

套奥 奣奯奵奬奤 奡奬女奯 奲奵奮 奴奨奥 奰奲奯奧奲奡奭 奩奮 奡奮 奩奭奰奵奲奥 奣奯奮奴奥奸奴 女奵奣奨 奡女 IO夬 奷奩奴奨奯奵奴 奣奨奡奮奧奩奮奧 奴奨奥 奤奥夜奮奩奴奩奯奮 奯奦
treeTagAux夬 奢她 奵女奩奮奧 run 奩奮女奴奥奡奤 奯奦 runPure夺

treeTagAux : BTree a -> Eff (BTree (Int, a)) [STATE Int]
...

treeTag : (i : Int) -> BTree a -> IO (BTree (Int, a))
treeTag i x = run (do put i

treeTagAux x)

奎奯奴奥 奴奨奡奴 奴奨奥 奤奥夜奮奩奴奩奯奮 奯奦 treeTagAux 奩女 奥奸奡奣奴奬她 奡女 奢奥奦奯奲奥央 奆奯奲 奲奥奦奥奲奥奮奣奥夬 奴奨奩女 奣奯奭奰奬奥奴奥 奰奲奯奧奲奡奭
夨奩奮奣奬奵奤奩奮奧 奡 main 奴奯 奲奵奮 奩奴天 奩女 女奨奯奷奮 奩奮 奌奩女奴奩奮奧 奛奩奮奴奲奯奰奲奯奧奝央

module Main

import Effects
import Effect.State

data BTree a = Leaf
| Node (BTree a) a (BTree a)

(äÿŃéąțçżğçżŋ)
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(çżŋäÿŁéąț)

Show a => Show (BTree a) where
show Leaf = "[]"
show (Node l x r) = "[" ++ show l ++ " "

++ show x ++ " "
++ show r ++ "]"

testTree : BTree String
testTree = Node (Node Leaf "Jim" Leaf)

"Fred"
(Node (Node Leaf "Alice" Leaf)

"Sheila"
(Node Leaf "Bob" Leaf))

treeTagAux : BTree a -> Eff (BTree (Int, a)) [STATE Int]
treeTagAux Leaf = pure Leaf
treeTagAux (Node l x r) = do l' <- treeTagAux l

i <- get
put (i + 1)
r' <- treeTagAux r
pure (Node l' (i, x) r')

treeTag : (i : Int) -> BTree a -> BTree (Int, a)
treeTag i x = runPure (do put i; treeTagAux x)

main : IO ()
main = print (treeTag 1 testTree)

4.2.3 Effects and Resources

奅奡奣奨 奥夛奥奣奴 奩女 奡女女奯奣奩奡奴奥奤 奷奩奴奨 奡 resource夬 奷奨奩奣奨 奩女 奩奮奩奴奩奡奬奩女奥奤 奢奥奦奯奲奥 奡奮 奥夛奥奣奴奦奵奬 奰奲奯奧奲奡奭 奣奡奮 奢奥 奲奵奮央 奆奯奲
奥奸奡奭奰奬奥夬 奩奮 奴奨奥 奣奡女奥 奯奦 STATE Int 奴奨奥 奣奯奲奲奥女奰奯奮奤奩奮奧 奲奥女奯奵奲奣奥 奩女 奴奨奥 奩奮奴奥奧奥奲 女奴奡奴奥 奩奴女奥奬奦央 奔奨奥 奴她奰奥女 奯奦
runPure 奡奮奤 run 女奨奯奷 奴奨奩女 夨女奬奩奧奨奴奬她 女奩奭奰奬奩夜奥奤 奨奥奲奥 奦奯奲 奩奬奬奵女奴奲奡奴奩奶奥 奰奵奲奰奯女奥女天夺

runPure : {env : Env id xs} -> Eff a xs -> a
run : Applicative m => {env : Env m xs} -> Eff a xs -> m a

奔奨奥 env 奡奲奧奵奭奥奮奴 奩女 奩奭奰奬奩奣奩奴夬 奡奮奤 奩奮奩奴奩奡奬奩女奥奤 奡奵奴奯奭奡奴奩奣奡奬奬她 奷奨奥奲奥 奰奯女女奩奢奬奥 奵女奩奮奧 奤奥奦奡奵奬奴 奶奡奬奵奥女 奧奩奶奥奮 奢她
奩奭奰奬奥奭奥奮奴奡奴奩奯奮女 奯奦 奴奨奥 奦奯奬奬奯奷奩奮奧 奩奮奴奥奲奦奡奣奥夺

interface Default a where
default : a

奉奭奰奬奥奭奥奮奴奡奴奩奯奮女 奯奦 Default 奡奲奥 奤奥夜奮奥奤 奦奯奲 奡奬奬 奰奲奩奭奩奴奩奶奥 奴她奰奥女夬 奡奮奤 奭奡奮她 奬奩奢奲奡奲她 奴她奰奥女 女奵奣奨 奡女 List夬
Vect夬 Maybe夬 奰奡奩奲女夬 奥奴奣央 奈奯奷奥奶奥奲夬 奷奨奥奲奥 奮奯 奤奥奦奡奵奬奴 奶奡奬奵奥 奥奸奩女奴女 奦奯奲 奡 奲奥女奯奵奲奣奥 奴她奰奥 夨奦奯奲 奥奸奡奭奰奬奥夬 她奯奵
奭奡她 奷奡奮奴 奡 STATE 奴她奰奥 奦奯奲 奷奨奩奣奨 奴奨奥奲奥 奩女 奮奯 Default 奩奭奰奬奥奭奥奮奴奡奴奩奯奮天 奴奨奥 奲奥女奯奵奲奣奥 奥奮奶奩奲奯奮奭奥奮奴 奣奡奮 奢奥
奧奩奶奥奮 奥奸奰奬奩奣奩奴奬她 奵女奩奮奧 奯奮奥 奯奦 奴奨奥 奦奯奬奬奯奷奩奮奧 奦奵奮奣奴奩奯奮女夺

runPureInit : Env id xs -> Eff a xs -> a
runInit : Applicative m => Env m xs -> Eff a xs -> m a

奔奯 奢奥 奷奥奬奬夭奴她奰奥奤夬 奴奨奥 奥奮奶奩奲奯奮奭奥奮奴 奭奵女奴 奣奯奮奴奡奩奮 奲奥女奯奵奲奣奥女 奣奯奲奲奥女奰奯奮奤奩奮奧 奥奸奡奣奴奬她 奴奯 奴奨奥 奥夛奥奣奴女 奩奮 xs央 奆奯奲
奥奸奡奭奰奬奥夬 奷奥 奣奯奵奬奤 奡奬女奯 奨奡奶奥 奩奭奰奬奥奭奥奮奴奥奤 treeTag 奢她 奩奮奩奴奩奡奬奩女奩奮奧 奴奨奥 女奴奡奴奥 奡女 奦奯奬奬奯奷女夺

treeTag : (i : Int) -> BTree a -> BTree (Int, a)
treeTag i x = runPureInit [i] (treeTagAux x)
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4.2.4 Labelled Effects

套奨奡奴 奩奦 奷奥 奨奡奶奥 奭奯奲奥 奴奨奡奮 奯奮奥 女奴奡奴奥夬 奥女奰奥奣奩奡奬奬她 奭奯奲奥 奴奨奡奮 奯奮奥 女奴奡奴奥 奯奦 奴奨奥 女奡奭奥 奴她奰奥夿 奈奯奷 奷奯奵奬奤
get 奡奮奤 put 奫奮奯奷 奷奨奩奣奨 女奴奡奴奥 奴奨奥她 女奨奯奵奬奤 奢奥 奲奥奦奥奲奲奩奮奧 奴奯夿 奆奯奲 奥奸奡奭奰奬奥夬 奨奯奷 奣奯奵奬奤 奷奥 奥奸奴奥奮奤 奴奨奥 奴奲奥奥
奴奡奧奧奩奮奧 奥奸奡奭奰奬奥 女奵奣奨 奴奨奡奴 奩奴 奡奤奤奩奴奩奯奮奡奬奬她 奣奯奵奮奴女 奴奨奥 奮奵奭奢奥奲 奯奦 奬奥奡奶奥女 奩奮 奴奨奥 奴奲奥奥夿 奏奮奥 奰奯女女奩奢奩奬奩奴她 奷奯奵奬奤
奢奥 奴奯 奣奨奡奮奧奥 奴奨奥 女奴奡奴奥 女奯 奴奨奡奴 奩奴 奣奡奰奴奵奲奥奤 奢奯奴奨 奯奦 奴奨奥女奥 奶奡奬奵奥女夬 奥央奧央夺

treeTagAux : BTree a -> Eff (BTree (Int, a)) [STATE (Int, Int)]

奄奯奩奮奧 奴奨奩女夬 奨奯奷奥奶奥奲夬 奴奩奥女 奴奨奥 奴奷奯 女奴奡奴奥女 奴奯奧奥奴奨奥奲 奴奨奲奯奵奧奨奯奵奴 夨奡女 奷奥奬奬 奡女 奮奯奴 奩奮奤奩奣奡奴奩奮奧 奷奨奩奣奨 奩奮奴奥奧奥奲 奩女
奷奨奩奣奨天央 奉奴 奷奯奵奬奤 奢奥 奮奩奣奥 奴奯 奢奥 奡奢奬奥 奴奯 奣奡奬奬 奥夛奥奣奴奦奵奬 奰奲奯奧奲奡奭女 奷奨奩奣奨 奧奵奡奲奡奮奴奥奥奤 奯奮奬她 奴奯 奡奣奣奥女女 奯奮奥 奯奦 奴奨奥
女奴奡奴奥女夬 奦奯奲 奥奸奡奭奰奬奥央 奉奮 奡 奬奡奲奧奥奲 奡奰奰奬奩奣奡奴奩奯奮夬 奴奨奩女 奢奥奣奯奭奥女 奰奡奲奴奩奣奵奬奡奲奬她 奩奭奰奯奲奴奡奮奴央

奔奨奥 奬奩奢奲奡奲她 奴奨奥奲奥奦奯奲奥 奡奬奬奯奷女 奥夛奥奣奴女 奩奮 奧奥奮奥奲奡奬 奴奯 奢奥 labelled 女奯 奴奨奡奴 奴奨奥她 奣奡奮 奢奥 奲奥奦奥奲奲奥奤 奴奯 奥奸奰奬奩奣奩奴奬她 奢她
奡 奰奡奲奴奩奣奵奬奡奲 奮奡奭奥央 奔奨奩女 奡奬奬奯奷女 奭奵奬奴奩奰奬奥 奥夛奥奣奴女 奯奦 奴奨奥 女奡奭奥 奴她奰奥 奴奯 奢奥 奩奮奣奬奵奤奥奤央 套奥 奣奡奮 奣奯奵奮奴 奬奥奡奶奥女
奡奮奤 奵奰奤奡奴奥 奴奨奥 奴奡奧 女奥奰奡奲奡奴奥奬她夬 奢她 奬奡奢奥奬奬奩奮奧 奴奨奥奭 奡女 奦奯奬奬奯奷女夺

treeTagAux : BTree a -> Eff (BTree (Int, a))
['Tag ::: STATE Int,
'Leaves ::: STATE Int]

奔奨奥 ::: 奯奰奥奲奡奴奯奲 奡奬奬奯奷女 奡奮 奡奲奢奩奴奲奡奲她 奬奡奢奥奬 奴奯 奢奥 奧奩奶奥奮 奴奯 奡奮 奥夛奥奣奴央 奔奨奩女 奬奡奢奥奬 奣奡奮 奢奥 奡奮她 奴她奰奥—奩奴
奩女 女奩奭奰奬她 奵女奥奤 奴奯 奩奤奥奮奴奩奦她 奡奮 奥夛奥奣奴 奵奮奩奱奵奥奬她央 奈奥奲奥夬 奷奥 奨奡奶奥 奵女奥奤 奡 女她奭奢奯奬 奴她奰奥央 奉奮 奧奥奮奥奲奡奬 ’name
奩奮奴奲奯奤奵奣奥女 奡 奮奥奷 女她奭奢奯奬夬 奴奨奥 奯奮奬她 奰奵奲奰奯女奥 奯奦 奷奨奩奣奨 奩女 奴奯 奤奩女奡奭奢奩奧奵奡奴奥 奶奡奬奵奥女2央

套奨奥奮 奡奮 奥夛奥奣奴 奩女 奬奡奢奥奬奬奥奤夬 奩奴女 奯奰奥奲奡奴奩奯奮女 奡奲奥 奡奬女奯 奬奡奢奥奬奬奥奤 奵女奩奮奧 奴奨奥 :- 奯奰奥奲奡奴奯奲央 奉奮 奴奨奩女 奷奡她夬 奷奥 奣奡奮 女奡她
奥奸奰奬奩奣奩奴奬她 奷奨奩奣奨 女奴奡奴奥 奷奥 奭奥奡奮 奷奨奥奮 奵女奩奮奧 get 奡奮奤 put央 奔奨奥 奴奲奥奥 奴奡奧奧奩奮奧 奰奲奯奧奲奡奭 奷奨奩奣奨 奡奬女奯 奣奯奵奮奴女
奬奥奡奶奥女 奣奡奮 奢奥 奷奲奩奴奴奥奮 奡女 奦奯奬奬奯奷女夺

treeTagAux Leaf = do
'Leaves :- update (+1)
pure Leaf

treeTagAux (Node l x r) = do
l' <- treeTagAux l
i <- 'Tag :- get
'Tag :- put (i + 1)
r' <- treeTagAux r
pure (Node l' (i, x) r')

奔奨奥 update 奦奵奮奣奴奩奯奮 奨奥奲奥 奩女 奡 奣奯奭奢奩奮奡奴奩奯奮 奯奦 get 奡奮奤 put夬 奡奰奰奬她奩奮奧 奡 奦奵奮奣奴奩奯奮 奴奯 奴奨奥 奣奵奲奲奥奮奴 女奴奡奴奥央

update : (x -> x) -> Eff () [STATE x]

奆奩奮奡奬奬她夬 奯奵奲 奴奯奰 奬奥奶奥奬 treeTag 奦奵奮奣奴奩奯奮 奮奯奷 奲奥奴奵奲奮女 奡 奰奡奩奲 奯奦 奴奨奥 奮奵奭奢奥奲 奯奦 奬奥奡奶奥女夬 奡奮奤 奴奨奥 奮奥奷 奴奲奥奥央
奒奥女奯奵奲奣奥女 奦奯奲 奬奡奢奥奬奬奥奤 奥夛奥奣奴女 奡奲奥 奩奮奩奴奩奡奬奩女奥奤 奵女奩奮奧 奴奨奥 := 奯奰奥奲奡奴奯奲 夨奲奥奭奩奮奩女奣奥奮奴 奯奦 奡女女奩奧奮奭奥奮奴 奩奮 奡奮
奩奭奰奥奲奡奴奩奶奥 奬奡奮奧奵奡奧奥天夺

treeTag : (i : Int) -> BTree a -> (Int, BTree (Int, a))
treeTag i x = runPureInit ['Tag := i, 'Leaves := 0]

(do x' <- treeTagAux x
leaves <- 'Leaves :- get
pure (leaves, x'))

奔奯 女奵奭奭奡奲奩女奥夬 奷奥 奨奡奶奥夺

• ::: 奴奯 奣奯奮奶奥奲奴 奡奮 奥夛奥奣奴 奴奯 奡 奬奡奢奥奬奬奥奤 奥夛奥奣奴央

• :- 奴奯 奣奯奮奶奥奲奴 奡奮 奥夛奥奣奴奦奵奬 奯奰奥奲奡奴奩奯奮 奴奯 奡 奬奡奢奥奬奬奥奤 奥夛奥奣奴奦奵奬 奯奰奥奲奡奴奩奯奮央
2 In practice, ’name simply introduces a new empty type
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• := 奴奯 奩奮奩奴奩奡奬奩女奥 奡 奲奥女奯奵奲奣奥 奦奯奲 奡 奬奡奢奥奬奬奥奤 奥夛奥奣奴央

奏奲夬 奭奯奲奥 奦奯奲奭奡奬奬她 奷奩奴奨 奴奨奥奩奲 奴她奰奥女 夨女奬奩奧奨奴奬她 女奩奭奰奬奩夜奥奤 奴奯 奡奣奣奯奵奮奴 奯奮奬她 奦奯奲 奴奨奥 女奩奴奵奡奴奩奯奮 奷奨奥奲奥 奡奶奡奩奬奡奢奬奥
奥夛奥奣奴女 奡奲奥 奮奯奴 奵奰奤奡奴奥奤天夺

(:::) : lbl -> EFFECT -> EFFECT
(:-) : (l : lbl) -> Eff a [x] -> Eff a [l ::: x]
(:=) : (l : lbl) -> res -> LRes l res

奈奥奲奥夬 LRes 奩女 女奩奭奰奬她 奴奨奥 奲奥女奯奵奲奣奥 奴她奰奥 奡女女奯奣奩奡奴奥奤 奷奩奴奨 奡 奬奡奢奥奬奬奥奤 奥夛奥奣奴央 奎奯奴奥 奴奨奡奴 奬奡奢奥奬女 奡奲奥 奰奯奬她奭奯奲奰奨奩奣
奩奮 奴奨奥 奬奡奢奥奬 奴她奰奥 lbl央 奈奥奮奣奥夬 奡 奬奡奢奥奬 奣奡奮 奢奥 奡奮她奴奨奩奮奧—奡 女奴奲奩奮奧夬 奡奮 奩奮奴奥奧奥奲夬 奡 奴她奰奥夬 奥奴奣央

4.2.5 !-notation

奉奮 奭奡奮她 奣奡女奥女夬 奵女奩奮奧 do夭奮奯奴奡奴奩奯奮 奣奡奮 奭奡奫奥 奰奲奯奧奲奡奭女 奵奮奮奥奣奥女女奡奲奩奬她 奶奥奲奢奯女奥夬 奰奡奲奴奩奣奵奬奡奲奬她 奩奮 奣奡女奥女 奷奨奥奲奥
奴奨奥 奶奡奬奵奥 奢奯奵奮奤 奩女 奵女奥奤 奯奮奣奥夬 奩奭奭奥奤奩奡奴奥奬她央 奔奨奥 奦奯奬奬奯奷奩奮奧 奰奲奯奧奲奡奭 奲奥奴奵奲奮女 奴奨奥 奬奥奮奧奴奨 奯奦 奴奨奥 String
女奴奯奲奥奤 奩奮 奴奨奥 女奴奡奴奥夬 奦奯奲 奥奸奡奭奰奬奥夺

stateLength : Eff Nat [STATE String]
stateLength = do x <- get

pure (length x)

奔奨奩女 女奥奥奭女 奵奮奮奥奣奥女女奡奲奩奬她 奶奥奲奢奯女奥夬 奡奮奤 奩奴 奷奯奵奬奤 奢奥 奮奩奣奥 奴奯 奰奲奯奧奲奡奭 奩奮 奡 奭奯奲奥 奤奩奲奥奣奴 女奴她奬奥 奩奮 奴奨奥女奥 奣奡女奥女央
奰奲奯奶奩奤奥女 !夭奮奯奴奡奴奩奯奮 奴奯 奨奥奬奰 奷奩奴奨 奴奨奩女央 奔奨奥 奡奢奯奶奥 奰奲奯奧奲奡奭 奣奡奮 奢奥 奷奲奩奴奴奥奮 奩奮女奴奥奡奤 奡女夺

stateLength : Eff Nat [STATE String]
stateLength = pure (length !get)

奔奨奥 奮奯奴奡奴奩奯奮 !expr 奭奥奡奮女 奴奨奡奴 奴奨奥 奥奸奰奲奥女女奩奯奮 expr 女奨奯奵奬奤 奢奥 奥奶奡奬奵奡奴奥奤 奡奮奤 奴奨奥奮 奩奭奰奬奩奣奩奴奬她 奢奯奵奮奤央
奃奯奮奣奥奰奴奵奡奬奬她夬 奷奥 奣奡奮 奴奨奩奮奫 奯奦 ! 奡女 奢奥奩奮奧 奡 奰奲奥夜奸 奦奵奮奣奴奩奯奮 奷奩奴奨 奴奨奥 奦奯奬奬奯奷奩奮奧 奴她奰奥夺

(!) : Eff a xs -> a

奎奯奴奥夬 奨奯奷奥奶奥奲夬 奴奨奡奴 奩奴 奩女 奮奯奴 奲奥奡奬奬她 奡 奦奵奮奣奴奩奯奮夬 奭奥奲奥奬她 女她奮奴奡奸夡 奉奮 奰奲奡奣奴奩奣奥夬 奡 女奵奢奥奸奰奲奥女女奩奯奮 !expr 奷奩奬奬
奬奩奦奴 expr 奡女 奨奩奧奨 奡女 奰奯女女奩奢奬奥 奷奩奴奨奩奮 奩奴女 奣奵奲奲奥奮奴 女奣奯奰奥夬 奢奩奮奤 奩奴 奴奯 奡 奦奲奥女奨 奮奡奭奥 x夬 奡奮奤 奲奥奰奬奡奣奥 !expr 奷奩奴奨
x央 奅奸奰奲奥女女奩奯奮女 奡奲奥 奬奩奦奴奥奤 奤奥奰奴奨 夜奲女奴夬 奬奥奦奴 奴奯 奲奩奧奨奴央 奉奮 奰奲奡奣奴奩奣奥夬 !夭奮奯奴奡奴奩奯奮 奡奬奬奯奷女 奵女 奴奯 奰奲奯奧奲奡奭 奩奮 奡 奭奯奲奥
奤奩奲奥奣奴 女奴她奬奥夬 奷奨奩奬奥 女奴奩奬奬 奧奩奶奩奮奧 奡 奮奯奴奡奴奩奯奮奡奬 奣奬奵奥 奡女 奴奯 奷奨奩奣奨 奥奸奰奲奥女女奩奯奮女 奡奲奥 奥夛奥奣奴奦奵奬央

奆奯奲 奥奸奡奭奰奬奥夬 奴奨奥 奥奸奰奲奥女女奩奯奮夺

let y = 42 in f !(g !(print y) !x)

奩女 奬奩奦奴奥奤 奴奯夺

let y = 42 in do y' <- print y
x' <- x
g' <- g y' x'
f g'

4.2.6 The Type Eff

奕奮奤奥奲奮奥奡奴奨夬 Eff 奩女 奡奮 奯奶奥奲奬奯奡奤奥奤 奦奵奮奣奴奩奯奮 奷奨奩奣奨 奴奲奡奮女奬奡奴奥女 奴奯 奡奮 奵奮奤奥奲奬她奩奮奧 奴她奰奥 EffM夺

EffM : (m : Type -> Type) -> (t : Type)
-> (List EFFECT)
-> (t -> List EFFECT) -> Type
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奔奨奩女 奩女 奭奯奲奥 奧奥奮奥奲奡奬 奴奨奡奮 奴奨奥 奴她奰奥女 奷奥 奨奡奶奥 奢奥奥奮 奷奲奩奴奩奮奧 女奯 奦奡奲央 奉奴 奩女 奰奡奲奡奭奥奴奥奲奩女奥奤 奯奶奥奲 奡奮 奵奮奤奥奲奬她奩奮奧
奣奯奭奰奵奴奡奴奩奯奮 奣奯奮奴奥奸奴 m夬 奡 奲奥女奵奬奴 奴她奰奥 t 奡女 奷奥 奨奡奶奥 奡奬奲奥奡奤她 女奥奥奮夬 奡女 奷奥奬奬 奡女 奡 List EFFECT 奡奮奤 奡 奦奵奮奣奴奩奯奮
奴她奰奥 t -> List EFFECT央

奔奨奥女奥 奡奤奤奩奴奩奯奮奡奬 奰奡奲奡奭奥奴奥奲女 奡奲奥 奴奨奥 奬奩女奴 奯奦 input 奥夛奥奣奴女夬 奡奮奤 奡 奬奩女奴 奯奦 output 奥夛奥奣奴女夬 奣奯奭奰奵奴奥奤 奦奲奯奭
奴奨奥 奲奥女奵奬奴 奯奦 奡奮 奥夛奥奣奴奦奵奬 奯奰奥奲奡奴奩奯奮央 奔奨奡奴 奩女夺 奲奵奮奮奩奮奧 奡奮 奥夛奥奣奴奦奵奬 奰奲奯奧奲奡奭 奣奡奮 奣奨奡奮奧奥 奴奨奥 女奥奴 奯奦 奥夛奥奣奴女
奡奶奡奩奬奡奢奬奥夡 奔奨奩女 奩女 奡 奰奡奲奴奩奣奵奬奡奲奬她 奰奯奷奥奲奦奵奬 奩奤奥奡夬 奡奮奤 奷奥 奷奩奬奬 女奥奥 奩奴女 奣奯奮女奥奱奵奥奮奣奥女 奩奮 奭奯奲奥 奤奥奴奡奩奬 奬奡奴奥奲央
奓奯奭奥 奥奸奡奭奰奬奥女 奯奦 奯奰奥奲奡奴奩奯奮女 奷奨奩奣奨 奣奡奮 奣奨奡奮奧奥 奴奨奥 女奥奴 奯奦 奡奶奡奩奬奡奢奬奥 奥夛奥奣奴女 奡奲奥夺

• 奕奰奤奡奴奩奮奧 奡 女奴奡奴奥 奣奯奮奴奡奩奮奩奮奧 奡 奤奥奰奥奮奤奥奮奴 奴她奰奥 夨奦奯奲 奥奸奡奭奰奬奥 奡奤奤奩奮奧 奡奮 奥奬奥奭奥奮奴 奴奯 奡 奶奥奣奴奯奲天央

• 奏奰奥奮奩奮奧 奡 夜奬奥 奦奯奲 奲奥奡奤奩奮奧 奩女 奡奮 奥夛奥奣奴夬 奢奵奴 奷奨奥奴奨奥奲 奴奨奥 夜奬奥 奲奥奡奬奬她 is 奯奰奥奮 奡奦奴奥奲奷奡奲奤女 奤奥奰奥奮奤女 奯奮
奷奨奥奴奨奥奲 奴奨奥 夜奬奥 奷奡女 女奵奣奣奥女女奦奵奬奬她 奯奰奥奮奥奤央

• 奃奬奯女奩奮奧 奡 夜奬奥 奭奥奡奮女 奴奨奡奴 奲奥奡奤奩奮奧 奦奲奯奭 奴奨奥 夜奬奥 女奨奯奵奬奤 奮奯 奬奯奮奧奥奲 奢奥 奰奯女女奩奢奬奥央

套奨奩奬奥 奰奯奷奥奲奦奵奬夬 奴奨奩女 奣奡奮 奭奡奫奥 奵女奥女 奯奦 奴奨奥 EffM 奴她奰奥 奨奡奲奤 奴奯 奲奥奡奤央 奔奨奥奲奥奦奯奲奥 奴奨奥 奬奩奢奲奡奲她 奰奲奯奶奩奤奥女 奡奮
奯奶奥奲奬奯奡奤奥奤 奦奵奮奣奴奩奯奮 Eff 奔奨奥奲奥 奡奲奥 奴奨奥 奦奯奬奬奯奷奩奮奧 奴奨奲奥奥 奶奥奲女奩奯奮女夺

SimpleEff.Eff : (t : Type) -> (input_effs : List EFFECT) -> Type
TransEff.Eff : (t : Type) -> (input_effs : List EFFECT) ->

(output_effs : List EFFECT) -> Type
DepEff.Eff : (t : Type) -> (input_effs : List EFFECT) ->

(output_effs_fn : t -> List EFFECT) -> Type

奓奯 奦奡奲夬 奷奥 奨奡奶奥 奵女奥奤 奯奮奬她 奴奨奥 夜奲女奴 奶奥奲女奩奯奮夬 SimpleEff.Eff夬 奷奨奩奣奨 奩女 奤奥夜奮奥奤 奡女 奦奯奬奬奯奷女夺

Eff : (x : Type) -> (es : List EFFECT) -> Type
Eff x es = {m : Type -> Type} -> EffM m x es (\v => es)

奩央奥央 奴奨奥 女奥奴 奯奦 奥夛奥奣奴女 奲奥奭奡奩奮女 奴奨奥 女奡奭奥 奯奮 奯奵奴奰奵奴央 奔奨奩女 女奵夞奣奥女 奦奯奲 奴奨奥 STATE 奥奸奡奭奰奬奥 奷奥 奨奡奶奥 女奥奥奮
女奯 奦奡奲夬 奡奮奤 奦奯奲 奭奡奮她 奵女奥奦奵奬 女奩奤奥夭奥夛奥奣奴奩奮奧 奰奲奯奧奲奡奭女央 套奥 奣奯奵奬奤 奡奬女奯 奨奡奶奥 奷奲奩奴奴奥奮 treeTagAux 奷奩奴奨 奴奨奥
奥奸奰奡奮奤奥奤 奴她奰奥夺

treeTagAux : BTree a ->
EffM m (BTree (Int, a)) [STATE Int] (\x => [STATE Int])

奌奡奴奥奲夬 奷奥 奷奩奬奬 女奥奥 奰奲奯奧奲奡奭女 奷奨奩奣奨 奵奰奤奡奴奥 奥夛奥奣奴女夺

Eff a xs xs'

奷奨奩奣奨 奩女 奥奸奰奡奮奤奥奤 奴奯

EffM m a xs (\_ => xs')

奩央奥央 奴奨奥 女奥奴 奯奦 奥夛奥奣奴女 奩女 奵奰奤奡奴奥奤 奴奯 xs’ 夨奴奨奩奮奫 奯奦 奡 奴奲奡奮女奩奴奩奯奮 奩奮 奡 女奴奡奴奥 奭奡奣奨奩奮奥天央 奔奨奥奲奥 奩女夬 奦奯奲 奥奸奡奭奰奬奥夬
奡 奶奥奲女奩奯奮 奯奦 put 奷奨奩奣奨 奵奰奤奡奴奥女 奴奨奥 奴她奰奥 奯奦 奴奨奥 女奴奡奴奥夺

putM : y -> Eff () [STATE x] [STATE y]

奁奬女奯夬 奷奥 奨奡奶奥夺

Eff t xs (\res => xs')

奷奨奩奣奨 奩女 奥奸奰奡奮奤奥奤 奴奯

EffM m t xs (\res => xs')

奩央奥央 奴奨奥 女奥奴 奯奦 奥夛奥奣奴女 奩女 奵奰奤奡奴奥奤 奡奣奣奯奲奤奩奮奧 奴奯 奴奨奥 奲奥女奵奬奴 奯奦 奴奨奥 奯奰奥奲奡奴奩奯奮 res夬 奯奦 奴她奰奥 t央
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奐奡奲奡奭奥奴奥奲奩女奩奮奧 EffM 奯奶奥奲 奡奮 奵奮奤奥奲奬她奩奮奧 奣奯奭奰奵奴奡奴奩奯奮 奣奯奮奴奥奸奴 奡奬奬奯奷女 奵女 奴奯 奷奲奩奴奥 奥夛奥奣奴奦奵奬 奰奲奯奧奲奡奭女 奷奨奩奣奨
奡奲奥 女奰奥奣奩夜奣 奴奯 奯奮奥 奣奯奮奴奥奸奴夬 奡奮奤 奩奮 女奯奭奥 奣奡女奥女 奴奯 奷奲奩奴奥 奰奲奯奧奲奡奭女 奷奨奩奣奨 extend 奴奨奥 奬奩女奴 奯奦 奥夛奥奣奴女 奡奶奡奩奬奡奢奬奥
奵女奩奮奧 奴奨奥 new 奦奵奮奣奴奩奯奮夬 奴奨奯奵奧奨 奴奨奩女 奩女 奢奥她奯奮奤 奴奨奥 女奣奯奰奥 奯奦 奴奨奩女 奴奵奴奯奲奩奡奬央

4.3 Simple Effects

奓奯 奦奡奲 奷奥 奨奡奶奥 女奥奥奮 奨奯奷 奴奯 奷奲奩奴奥 奰奲奯奧奲奡奭女 奷奩奴奨 奬奯奣奡奬奬她 奭奵奴奡奢奬奥 女奴奡奴奥 奵女奩奮奧 奴奨奥 STATE 奥夛奥奣奴央 奔奯 奲奥奣奡奰夬
奷奥 奨奡奶奥 奴奨奥 奤奥夜奮奩奴奩奯奮女 奢奥奬奯奷 奩奮 奡 奭奯奤奵奬奥 Effect.State

module Effect.State

STATE : Type -> EFFECT

get : Eff x [STATE x]
put : x -> Eff () [STATE x]
putM : y -> Eff () [STATE x] [STATE y]
update : (x -> x) -> Eff () [STATE x]

Handler State m where { ... }

奔奨奥 奬奡女奴 奬奩奮奥夬 Handler State m where { ... }夬 奭奥奡奮女 奴奨奡奴 奴奨奥 STATE 奥夛奥奣奴 奩女 奵女奡奢奬奥 奩奮 奡奮她 奣奯奭奰奵夭
奴奡奴奩奯奮 奣奯奮奴奥奸奴 m央 奔奨奡奴 奩女夬 奡 奰奲奯奧奲奡奭 奷奨奩奣奨 奵女奥女 奴奨奩女 奥夛奥奣奴 奡奮奤 奲奥奴奵奲奮女 女奯奭奥奴奨奩奮奧 奯奦 奴她奰奥 a 奣奡奮 奢奥
奥奶奡奬奵奡奴奥奤 奴奯 女奯奭奥奴奨奩奮奧 奯奦 奴她奰奥 m a 奵女奩奮奧 run夬 奦奯奲 奡奮她 m央 奔奨奥 奬奯奷奥奲 奣奡女奥 State 奩女 奡 奤奡奴奡 奴她奰奥 奤奥女奣奲奩奢奩奮奧
奴奨奥 奯奰奥奲奡奴奩奯奮女 奷奨奩奣奨 奭奡奫奥 奵奰 奴奨奥 STATE 奥夛奥奣奴 奩奴女奥奬奦—奷奥 奷奩奬奬 奧奯 奩奮奴奯 奭奯奲奥 奤奥奴奡奩奬 奡奢奯奵奴 奴奨奩女 奩奮 奓奥奣奴奩奯奮
Creating New Effects 夨姩妡妵 失夲夳天央

奉奮 奴奨奩女 女奥奣奴奩奯奮夬 奷奥 奷奩奬奬 奩奮奴奲奯奤奵奣奥 女奯奭奥 奯奴奨奥奲 女奵奰奰奯奲奴奥奤 奥夛奥奣奴女夬 奡奬奬奯奷奩奮奧 奣奯奮女奯奬奥 奉夯奏夬 奥奸奣奥奰奴奩奯奮女夬 奲奡奮奤奯奭
奮奵奭奢奥奲 奧奥奮奥奲奡奴奩奯奮 奡奮奤 奮奯奮夭奤奥奴奥奲奭奩奮奩女奴奩奣 奰奲奯奧奲奡奭奭奩奮奧央 奆奯奲 奥奡奣奨 奥夛奥奣奴 奷奥 奩奮奴奲奯奤奵奣奥夬 奷奥 奷奩奬奬 奢奥奧奩奮 奷奩奴奨
奡 女奵奭奭奡奲她 奯奦 奴奨奥 奥夛奥奣奴夬 奩奴女 女奵奰奰奯奲奴奥奤 奯奰奥奲奡奴奩奯奮女夬 奡奮奤 奴奨奥 奣奯奮奴奥奸奴女 奩奮 奷奨奩奣奨 奩奴 奭奡她 奢奥 奵女奥奤夬 奬奩奫奥 奴奨奡奴
奡奢奯奶奥 奦奯奲 STATE夬 奡奮奤 奧奯 奯奮 奴奯 奰奲奥女奥奮奴 女奯奭奥 女奩奭奰奬奥 奥奸奡奭奰奬奥女央 奁奴 奴奨奥 奥奮奤夬 奷奥 奷奩奬奬 女奥奥 女奯奭奥 奥奸奡奭奰奬奥女 奯奦
奰奲奯奧奲奡奭女 奷奨奩奣奨 奣奯奭奢奩奮奥 奭奵奬奴奩奰奬奥 奥夛奥奣奴女央

奁奬奬 奯奦 奴奨奥 奥夛奥奣奴女 奩奮 奴奨奥 奬奩奢奲奡奲她夬 奩奮奣奬奵奤奩奮奧 奴奨奯女奥 奤奥女奣奲奩奢奥奤 奩奮 奴奨奩女 女奥奣奴奩奯奮夬 奡奲奥 女奵奭奭奡奲奩女奥奤 奩奮 奁奰奰奥奮奤奩奸
Effects Summary 夨姩妡妵 失夳夳天央

4.3.1 Console I/O

奃奯奮女奯奬奥 奉夯奏 奩女 女奵奰奰奯奲奴奥奤 奷奩奴奨 奴奨奥 STDIO 奥夛奥奣奴夬 奷奨奩奣奨 奡奬奬奯奷女 奲奥奡奤奩奮奧 奡奮奤 奷奲奩奴奩奮奧 奣奨奡奲奡奣奴奥奲女 奡奮奤 女奴奲奩奮奧女 奴奯
奡奮奤 奦奲奯奭 女奴奡奮奤奡奲奤 奩奮奰奵奴 奡奮奤 女奴奡奮奤奡奲奤 奯奵奴奰奵奴央 奎奯奴奩奣奥 奴奨奡奴 奴奨奥奲奥 奩女 奡 奣奯奮女奴奲奡奩奮奴 奨奥奲奥 奯奮 奴奨奥 奣奯奭奰奵奴奡奴奩奯奮
奣奯奮奴奥奸奴 m夬 奢奥奣奡奵女奥 奩奴 奯奮奬她 奭奡奫奥女 女奥奮女奥 奴奯 女奵奰奰奯奲奴 奣奯奮女奯奬奥 奉夯奏 奯奰奥奲奡奴奩奯奮女 奩奮 奡 奣奯奮奴奥奸奴 奷奨奥奲奥 奷奥 奣奡奮
奰奥奲奦奯奲奭 夨奯奲 奡奴 奴奨奥 奶奥奲她 奬奥奡女奴 女奩奭奵奬奡奴奥天 奣奯奮女奯奬奥 奉夯奏夺

module Effect.StdIO

STDIO : EFFECT

putChar : Char -> Eff () [STDIO]
putStr : String -> Eff () [STDIO]
putStrLn : String -> Eff () [STDIO]

getStr : Eff String [STDIO]
getChar : Eff Char [STDIO]

Handler StdIO IO where { ... }
Handler StdIO (IOExcept a) where { ... }
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Examples

奁 奰奲奯奧奲奡奭 奷奨奩奣奨 奲奥奡奤女 奴奨奥 奵女奥奲’女 奮奡奭奥夬 奴奨奥奮 女奡她女 奨奥奬奬奯夬 奣奡奮 奢奥 奷奲奩奴奴奥奮 奡女 奦奯奬奬奯奷女夺

hello : Eff () [STDIO]
hello = do putStr "Name? "

x <- getStr
putStrLn ("Hello " ++ trim x ++ "!")

套奥 奵女奥 trim 奨奥奲奥 奴奯 奲奥奭奯奶奥 奴奨奥 奴奲奡奩奬奩奮奧 奮奥奷奬奩奮奥 奦奲奯奭 奴奨奥 奩奮奰奵奴央 奔奨奥 奲奥女奯奵奲奣奥 奡女女奯奣奩奡奴奥奤 奷奩奴奨 STDIO 奩女
女奩奭奰奬她 奴奨奥 奥奭奰奴她 奴奵奰奬奥夬 奷奨奩奣奨 奨奡女 奡 奤奥奦奡奵奬奴 奶奡奬奵奥 ()夬 女奯 奷奥 奣奡奮 奲奵奮 奴奨奩女 奡女 奦奯奬奬奯奷女夺

main : IO ()
main = run hello

奉奮 hello 奷奥 奣奯奵奬奤 奡奬女奯 奵女奥 !夭奮奯奴奡奴奩奯奮 奩奮女奴奥奡奤 奯奦 x <- getStr夬 女奩奮奣奥 奷奥 奯奮奬她 奵女奥 奴奨奥 女奴奲奩奮奧 奴奨奡奴 奩女 奲奥奡奤
奯奮奣奥夺

hello : Eff () [STDIO]
hello = do putStr "Name? "

putStrLn ("Hello " ++ trim !getStr ++ "!")

奍奯奲奥 奩奮奴奥奲奥女奴奩奮奧奬她夬 奷奥 奣奡奮 奣奯奭奢奩奮奥 奭奵奬奴奩奰奬奥 奥夛奥奣奴女 奩奮 奯奮奥 奰奲奯奧奲奡奭央 奆奯奲 奥奸奡奭奰奬奥夬 奷奥 奣奡奮 奬奯奯奰夬 奣奯奵奮奴奩奮奧
奴奨奥 奮奵奭奢奥奲 奯奦 奰奥奯奰奬奥 奷奥’奶奥 女奡奩奤 奨奥奬奬奯 奴奯夺

hello : Eff () [STATE Int, STDIO]
hello = do putStr "Name? "

putStrLn ("Hello " ++ trim !getStr ++ "!")
update (+1)
putStrLn ("I've said hello to: " ++ show !get ++ " people")
hello

奔奨奥 奬奩女奴 奯奦 奥夛奥奣奴女 奧奩奶奥奮 奩奮 hello 奭奥奡奮女 奴奨奡奴 奴奨奥 奦奵奮奣奴奩奯奮 奣奡奮 奣奡奬奬 get 奡奮奤 put 奯奮 奡奮 奩奮奴奥奧奥奲 女奴奡奴奥夬 奡奮奤
奡奮她 奦奵奮奣奴奩奯奮女 奷奨奩奣奨 奲奥奡奤 奡奮奤 奷奲奩奴奥 奦奲奯奭 奴奨奥 奣奯奮女奯奬奥央 奔奯 奲奵奮 奴奨奩女夬 main 奤奯奥女 奮奯奴 奮奥奥奤 奴奯 奢奥 奣奨奡奮奧奥奤央

Aside: Resource Types

奔奯 夜奮奤 奯奵奴 奴奨奥 奲奥女奯奵奲奣奥 奴她奰奥 奯奦 奡奮 奥夛奥奣奴夬 奩奦 奮奥奣奥女女奡奲她 夨奦奯奲 奥奸奡奭奰奬奥 奩奦 奷奥 奷奡奮奴 奴奯 奩奮奩奴奩奡奬奩女奥 奡 奲奥女奯奵奲奣奥
奥奸奰奬奩奣奩奴奬她 奷奩奴奨 runInit 奲奡奴奨奥奲 奴奨奡奮 奵女奩奮奧 奡 奤奥奦奡奵奬奴 奶奡奬奵奥 奷奩奴奨 run天 奷奥 奣奡奮 奲奵奮 奴奨奥 resourceType
奦奵奮奣奴奩奯奮 奡奴 奴奨奥 奒奅奐奌夺

*ConsoleIO> resourceType STDIO
() : Type
*ConsoleIO> resourceType (STATE Int)
Int : Type

4.3.2 Exceptions

奔奨奥 EXCEPTION 奥夛奥奣奴 奩女 奤奥奣奬奡奲奥奤 奩奮 奭奯奤奵奬奥 Effect.Exception央 奔奨奩女 奡奬奬奯奷女 奰奲奯奧奲奡奭女 奴奯 奥奸奩奴 奩奭奭奥奤奩夭
奡奴奥奬她 奷奩奴奨 奡奮 奥奲奲奯奲夬 奯奲 奥奲奲奯奲女 奴奯 奢奥 奨奡奮奤奬奥奤 奭奯奲奥 奧奥奮奥奲奡奬奬她夺

module Effect.Exception

EXCEPTION : Type -> EFFECT

(äÿŃéąțçżğçżŋ)
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(çżŋäÿŁéąț)

raise : a -> Eff b [EXCEPTION a]

Handler (Exception a) Maybe where { ... }
Handler (Exception a) List where { ... }
Handler (Exception a) (Either a) where { ... }
Handler (Exception a) (IOExcept a) where { ... }
Show a => Handler (Exception a) IO where { ... }

Example

奓奵奰奰奯女奥 奷奥 奨奡奶奥 奡 String 奷奨奩奣奨 奩女 奥奸奰奥奣奴奥奤 奴奯 奲奥奰奲奥女奥奮奴 奡奮 奩奮奴奥奧奥奲 奩奮 奴奨奥 奲奡奮奧奥 0 奴奯 n央 套奥 奣奡奮 奷奲奩奴奥
奡 奦奵奮奣奴奩奯奮 parseNumber 奷奨奩奣奨 奲奥奴奵奲奮女 奡奮 Int 奩奦 奰奡奲女奩奮奧 奴奨奥 女奴奲奩奮奧 奲奥奴奵奲奮女 奡 奮奵奭奢奥奲 奩奮 奴奨奥 奡奰奰奲奯奰奲奩奡奴奥
奲奡奮奧奥夬 奯奲 奴奨奲奯奷女 奡奮 奥奸奣奥奰奴奩奯奮 奯奴奨奥奲奷奩女奥央 奅奸奣奥奰奴奩奯奮女 奡奲奥 奰奡奲奡奭奥奴奥奲奩女奥奤 奢她 奡奮 奥奲奲奯奲 奴她奰奥夺

data Error = NotANumber | OutOfRange

parseNumber : Int -> String -> Eff Int [EXCEPTION Error]
parseNumber num str

= if all isDigit (unpack str)
then let x = cast str in

if (x >=0 && x <= num)
then pure x
else raise OutOfRange

else raise NotANumber

奐奲奯奧奲奡奭女 奷奨奩奣奨 女奵奰奰奯奲奴 奴奨奥 EXCEPTION 奥夛奥奣奴 奣奡奮 奢奥 奲奵奮 奩奮 奡奮她 奣奯奮奴奥奸奴 奷奨奩奣奨 奨奡女 女奯奭奥 奷奡她 奯奦 奴奨奲奯奷奩奮奧
奥奲奲奯奲女夬 奦奯奲 奥奸奡奭奰奬奥夬 奷奥 奣奡奮 奲奵奮 parseNumber 奩奮 奴奨奥 Either Error 奣奯奮奴奥奸奴央 奉奴 奲奥奴奵奲奮女 奡 奶奡奬奵奥 奯奦 奴奨奥
奦奯奲奭 Right x 奩奦 女奵奣奣奥女女奦奵奬夺

*Exception> the (Either Error Int) $ run (parseNumber 42 "20")
Right 20 : Either Error Int

奏奲 Left e 奯奮 奦奡奩奬奵奲奥夬 奣奡奲奲她奩奮奧 奴奨奥 奡奰奰奲奯奰奲奩奡奴奥 奥奸奣奥奰奴奩奯奮夺

*Exception> the (Either Error Int) $ run (parseNumber 42 "50")
Left OutOfRange : Either Error Int

*Exception> the (Either Error Int) $ run (parseNumber 42 "twenty")
Left NotANumber : Either Error Int

奉奮 奦奡奣奴夬 奷奥 奣奡奮 奤奯 奡 奬奩奴奴奬奥 奢奩奴 奢奥奴奴奥奲 奷奩奴奨 parseNumber夬 奡奮奤 奨奡奶奥 奩奴 奲奥奴奵奲奮 奡 proof 奴奨奡奴 奴奨奥 奩奮奴奥奧奥奲 奩女 奩奮
奴奨奥 奲奥奱奵奩奲奥奤 奲奡奮奧奥 奡奬奯奮奧 奷奩奴奨 奴奨奥 奩奮奴奥奧奥奲 奩奴女奥奬奦央 奏奮奥 奷奡她 奴奯 奤奯 奴奨奩女 奩女 奤奥夜奮奥 奡 奴她奰奥 奯奦 奢奯奵奮奤奥奤 奩奮奴奥奧奥奲女夬
Bounded夺

Bounded : Int -> Type
Bounded x = (n : Int ** So (n >= 0 && n <= x))

奒奥奣奡奬奬 奴奨奡奴 So 奩女 奰奡奲奡奭奥奴奥奲奩女奥奤 奢她 奡 Bool夬 奡奮奤 奯奮奬她 So True 奩女 奩奮奨奡奢奩奴奥奤央 套奥 奣奡奮 奵女奥 choose 奴奯
奣奯奮女奴奲奵奣奴 女奵奣奨 奡 奶奡奬奵奥 奦奲奯奭 奴奨奥 奲奥女奵奬奴 奯奦 奡 奤她奮奡奭奩奣 奣奨奥奣奫夺

data So : Bool -> Type = Oh : So True

choose : (b : Bool) -> Either (So b) (So (not b))

套奥 奴奨奥奮 奷奲奩奴奥 parseNumber 奵女奩奮奧 choose 奲奡奴奨奥奲 奴奨奡奮 奡奮 if/then/else 奣奯奮女奴奲奵奣奴夬 奰奡女女奩奮奧 奴奨奥 奰奲奯奯奦 奩奴
奲奥奴奵奲奮女 奯奮 女奵奣奣奥女女 奡女 奴奨奥 奢奯奵奮奤奥奤奮奥女女 奰奲奯奯奦夺
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parseNumber : (x : Int) -> String -> Eff (Bounded x) [EXCEPTION Error]
parseNumber x str

= if all isDigit (unpack str)
then let num = cast str in

case choose (num >=0 && num <= x) of
Left p => pure (num ** p)
Right p => raise OutOfRange

else raise NotANumber

4.3.3 Random Numbers

奒奡奮奤奯奭 奮奵奭奢奥奲 奧奥奮奥奲奡奴奩奯奮 奩女 奡奬女奯 奩奭奰奬奥奭奥奮奴奥奤 奢她 奴奨奥 奬奩奢奲奡奲她夬 奩奮 奭奯奤奵奬奥 Effect.Random夺

module Effect.Random

RND : EFFECT

srand : Integer -> Eff () [RND]
rndInt : Integer -> Integer -> Eff Integer [RND]
rndFin : (k : Nat) -> Eff (Fin (S k)) [RND]

Handler Random m where { ... }

奒奡奮奤奯奭 奮奵奭奢奥奲 奧奥奮奥奲奡奴奩奯奮 奩女 奣奯奮女奩奤奥奲奥奤 女奩奤奥夭奥夛奥奣奴奩奮奧 奢奥奣奡奵女奥 奩奴女 奩奭奰奬奥奭奥奮奴奡奴奩奯奮 奧奥奮奥奲奡奬奬她 奲奥奬奩奥女 奯奮
女奯奭奥 奥奸奴奥奲奮奡奬 女奯奵奲奣奥 奯奦 奲奡奮奤奯奭奮奥女女央 奔奨奥 奤奥奦奡奵奬奴 奩奭奰奬奥奭奥奮奴奡奴奩奯奮 奨奥奲奥 奲奥奬奩奥女 奯奮 奡奮 奩奮奴奥奧奥奲 seed夬 奷奨奩奣奨
奣奡奮 奢奥 女奥奴 奷奩奴奨 srand央 奁 女奰奥奣奩夜奣 女奥奥奤 奷奩奬奬 奬奥奡奤 奴奯 奡 奰奲奥奤奩奣奴奡奢奬奥夬 奲奥奰奥奡奴奡奢奬奥 女奥奱奵奥奮奣奥 奯奦 奲奡奮奤奯奭 奮奵奭奢奥奲女央
奔奨奥奲奥 奡奲奥 奴奷奯 奦奵奮奣奴奩奯奮女 奷奨奩奣奨 奰奲奯奤奵奣奥 奡 奲奡奮奤奯奭 奮奵奭奢奥奲夺

• rndInt, which returns a random integer between the given lower 奡奮奤 奵奰奰奥奲 奢奯奵奮奤女央

• rndFin, which returns a random element of a finite set 夨奥女女奥奮奴奩奡奬奬她 奡 奮奵奭奢奥奲 奷奩奴奨 奡奮 奵奰夭
奰奥奲 奢奯奵奮奤 奧奩奶奥奮 奩奮 奩奴女 奴她奰奥天央

Example

套奥 奣奡奮 奵女奥 奴奨奥 RND 奥夛奥奣奴 奴奯 奩奭奰奬奥奭奥奮奴 奡 女奩奭奰奬奥 奧奵奥女女奩奮奧 奧奡奭奥央 奔奨奥 guess 奦奵奮奣奴奩奯奮夬 奧奩奶奥奮 奡 奴奡奲奧奥奴
奮奵奭奢奥奲夬 奷奩奬奬 奲奥奰奥奡奴奥奤奬她 奡女奫 奴奨奥 奵女奥奲 奦奯奲 奡 奧奵奥女女夬 奡奮奤 女奴奡奴奥 奷奨奥奴奨奥奲 奴奨奥 奧奵奥女女 奩女 奴奯奯 奨奩奧奨夬 奴奯奯 奬奯奷夬 奯奲
奣奯奲奲奥奣奴夺

guess : Int -> Eff () [STDIO]

奆奯奲 奲奥奦奥奲奥奮奣奥夬 奴奨奥 奣奯奤奥 奦奯奲 guess 奩女 奧奩奶奥奮 奢奥奬奯奷夺

guess : Int -> Eff () [STDIO]
guess target

= do putStr "Guess: "
case run {m=Maybe} (parseNumber 100 (trim !getStr)) of

Nothing => do putStrLn "Invalid input"
guess target

Just (v ** _) =>
case compare v target of

LT => do putStrLn "Too low"
guess target

EQ => putStrLn "You win!"
GT => do putStrLn "Too high"

guess target

4.3. Simple Effects 114



Idris 语语语言言言文文文档档档, 版版版本本本 1.3.1

奎奯奴奥 奴奨奡奴 奷奥 奵女奥 parseNumber 奡女 奤奥夜奮奥奤 奰奲奥奶奩奯奵女奬她 奴奯 奲奥奡奤 奵女奥奲 奩奮奰奵奴夬 奢奵奴 奷奥 奤奯奮’奴 奮奥奥奤 奴奯 奬奩女奴
奴奨奥 EXCEPTION 奥夛奥奣奴 奢奥奣奡奵女奥 奷奥 奵女奥 奡 奮奥女奴奥奤 run 奴奯 奩奮奶奯奫奥 parseNumber夬 奩奮奤奥奰奥奮奤奥奮奴奬她 奯奦 奴奨奥 奣奡奬奬奩奮奧
奥夛奥奣奴奦奵奬 奰奲奯奧奲奡奭央

奔奯 奩奮奶奯奫奥 奴奨奩女夬 奷奥 奰奩奣奫 奡 奲奡奮奤奯奭 奮奵奭奢奥奲 奷奩奴奨奩奮 奴奨奥 奲奡奮奧奥 夰夕失夰夰夬 奨奡奶奩奮奧 女奥奴 奵奰 奴奨奥 奲奡奮奤奯奭 奮奵奭奢奥奲
奧奥奮奥奲奡奴奯奲 奷奩奴奨 奡 女奥奥奤夬 奴奨奥奮 奲奵奮 guess夺

game : Eff () [RND, STDIO]
game = do srand 123456789

guess (fromInteger !(rndInt 0 100))

main : IO ()
main = run game

奉奦 奮奯 女奥奥奤 奩女 奧奩奶奥奮夬 奩奴 奩女 女奥奴 奴奯 奴奨奥 default 奶奡奬奵奥央 奆奯奲 奡 奬奥女女 奰奲奥奤奩奣奴奡奢奬奥 奧奡奭奥夬 女奯奭奥 奢奥奴奴奥奲 女奯奵奲奣奥 奯奦
奲奡奮奤奯奭奮奥女女 奷奯奵奬奤 奢奥 奲奥奱奵奩奲奥奤夬 奦奯奲 奥奸奡奭奰奬奥 奴奡奫奩奮奧 奡奮 奩奮奩奴奩奡奬 女奥奥奤 奦奲奯奭 奴奨奥 女她女奴奥奭 奴奩奭奥央 奔奯 女奥奥 奨奯奷 奴奯
奤奯 奴奨奩女夬 女奥奥 奴奨奥 SYSTEM 奥夛奥奣奴 奤奥女奣奲奩奢奥奤 奩奮 Effects Summary 夨姩妡妵 失夳夳天央

4.3.4 Non-determinism

奔奨奥 奬奩女奴奩奮奧 奢奥奬奯奷 奧奩奶奥女 奴奨奥 奤奥夜奮奩奴奩奯奮 奯奦 奴奨奥 奮奯奮夭奤奥奴奥奲奭奩奮奩女奭 奥夛奥奣奴夬 奷奨奩奣奨 奡奬奬奯奷女 奡 奰奲奯奧奲奡奭 奴奯 奣奨奯奯女奥 奡
奶奡奬奵奥 奮奯奮夭奤奥奴奥奲奭奩奮奩女奴奩奣奡奬奬她 奦奲奯奭 奡 奬奩女奴 奯奦 奰奯女女奩奢奩奬奩奴奩奥女 奩奮 女奵奣奨 奡 奷奡她 奴奨奡奴 奴奨奥 奥奮奴奩奲奥 奣奯奭奰奵奴奡奴奩奯奮 女奵奣奣奥奥奤女夺

import Effects
import Effect.Select

SELECT : EFFECT

select : List a -> Eff a [SELECT]

Handler Selection Maybe where { ... }
Handler Selection List where { ... }

Example

奔奨奥 SELECT 奥夛奥奣奴 奣奡奮 奢奥 奵女奥奤 奴奯 女奯奬奶奥 奣奯奮女奴奲奡奩奮奴 奰奲奯奢奬奥奭女夬 女奵奣奨 奡女 夜奮奤奩奮奧 奐她奴奨奡奧奯奲奥奡奮 奴奲奩奰奬奥女央 奔奨奥
奩奤奥奡 奩女 奴奯 奵女奥 select 奴奯 奧奩奶奥 奡 女奥奴 奯奦 奣奡奮奤奩奤奡奴奥 奶奡奬奵奥女夬 奴奨奥奮 奴奨奲奯奷 奡奮 奥奸奣奥奰奴奩奯奮 奦奯奲 奡奮她 奣奯奭奢奩奮奡奴奩奯奮 奯奦
奶奡奬奵奥女 奷奨奩奣奨 奤奯奥女 奮奯奴 女奡奴奩女奦她 奴奨奥 奣奯奮女奴奲奡奩奮奴夺

triple : Int -> Eff (Int, Int, Int) [SELECT, EXCEPTION String]
triple max = do z <- select [1..max]

y <- select [1..z]
x <- select [1..y]
if (x * x + y * y == z * z)

then pure (x, y, z)
else raise "No triple"

奔奨奩女 奰奲奯奧奲奡奭 奣奨奯奯女奥女 奡 奶奡奬奵奥 奦奯奲 z 奢奥奴奷奥奥奮 1 奡奮奤 max夬 奴奨奥奮 奶奡奬奵奥女 奦奯奲 y 奡奮奤 x央 奉奮 奯奰奥奲奡奴奩奯奮夬 奡奦奴奥奲 奡
select夬 奴奨奥 奰奲奯奧奲奡奭 奥奸奥奣奵奴奥女 奴奨奥 奲奥女奴 奯奦 奴奨奥 do夭奢奬奯奣奫 奦奯奲 奥奶奥奲她 奰奯女女奩奢奬奥 奡女女奩奧奮奭奥奮奴夬 奥夛奥奣奴奩奶奥奬她 女奥奡奲奣奨奩奮奧
奤奥奰奴奨夭夜奲女奴央 奉奦 奴奨奥 奬奩女奴 奩女 奥奭奰奴她 夨奯奲 奡奮 奥奸奣奥奰奴奩奯奮 奩女 奴奨奲奯奷奮天 奥奸奥奣奵奴奩奯奮 奦奡奩奬女央

奔奨奥奲奥 奡奲奥 奨奡奮奤奬奥奲女 奤奥夜奮奥奤 奦奯奲 Maybe 奡奮奤 List 奣奯奮奴奥奸奴女夬 奩央奥央 奣奯奮奴奥奸奴女 奷奨奩奣奨 奣奡奮 奣奡奰奴奵奲奥 奦奡奩奬奵奲奥央 奄奥夭
奰奥奮奤奩奮奧 奯奮 奴奨奥 奣奯奮奴奥奸奴 m夬 triple 奷奩奬奬 奥奩奴奨奥奲 奲奥奴奵奲奮 奴奨奥 夜奲女奴 奴奲奩奰奬奥 奩奴 夜奮奤女 夨奩奦 奩奮 Maybe 奣奯奮奴奥奸奴天 奯奲 奡奬奬
奴奲奩奰奬奥女 奩奮 奴奨奥 奲奡奮奧奥 夨奩奦 奩奮 List 奣奯奮奴奥奸奴天央 套奥 奣奡奮 奴奲她 奴奨奩女 奡女 奦奯奬奬奯奷女夺
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main : IO ()
main = do print $ the (Maybe _) $ run (triple 100)

print $ the (List _) $ run (triple 100)

4.3.5 vadd revisited

套奥 奮奯奷 奲奥奴奵奲奮 奴奯 奴奨奥 vadd 奰奲奯奧奲奡奭 奦奲奯奭 奴奨奥 奩奮奴奲奯奤奵奣奴奩奯奮央 奒奥奣奡奬奬 奴奨奥 奤奥夜奮奩奴奩奯奮夺

vadd : Vect n Int -> Vect n Int -> Vect n Int
vadd [] [] = []
vadd (x :: xs) (y :: ys) = x + y :: vadd xs ys

奕女奩奮奧 夬 奷奥 奣奡奮 女奥奴 奵奰 奡 奰奲奯奧奲奡奭 女奯 奴奨奡奴 奩奴 奲奥奡奤女 奩奮奰奵奴 奦奲奯奭 奡 奵女奥奲夬 奣奨奥奣奫女 奴奨奡奴 奴奨奥 奩奮奰奵奴 奩女 奶奡奬奩奤 夨奩央奥
奢奯奴奨 奶奥奣奴奯奲女 奣奯奮奴奡奩奮 奩奮奴奥奧奥奲女夬 奡奮奤 奡奲奥 奴奨奥 女奡奭奥 奬奥奮奧奴奨天 奡奮奤 奩奦 女奯夬 奰奡女女 奩奴 奯奮 奴奯 vadd央 奆奩奲女奴夬 奷奥 奷奲奩奴奥 奡
奷奲奡奰奰奥奲 奦奯奲 vadd 奷奨奩奣奨 奣奨奥奣奫女 奴奨奥 奬奥奮奧奴奨女 奡奮奤 奴奨奲奯奷 奡奮 奥奸奣奥奰奴奩奯奮 奩奦 奴奨奥她 奡奲奥 奮奯奴 奥奱奵奡奬央 套奥 奣奡奮 奤奯 奴奨奩女
奦奯奲 奩奮奰奵奴 奶奥奣奴奯奲女 奯奦 奬奥奮奧奴奨 n 奡奮奤 m 奢她 奭奡奴奣奨奩奮奧 奯奮 奴奨奥 奩奭奰奬奩奣奩奴 奡奲奧奵奭奥奮奴女 n 奡奮奤 m 奡奮奤 奵女奩奮奧 decEq 奴奯
奰奲奯奤奵奣奥 奡 奰奲奯奯奦 奯奦 奴奨奥奩奲 奥奱奵奡奬奩奴她夬 奩奦 奴奨奥她 奡奲奥 奥奱奵奡奬夺

vadd_check : Vect n Int -> Vect m Int ->
Eff (Vect m Int) [EXCEPTION String]

vadd_check {n} {m} xs ys with (decEq n m)
vadd_check {n} {m=n} xs ys | (Yes Refl) = pure (vadd xs ys)
vadd_check {n} {m} xs ys | (No contra) = raise "Length mismatch"

奔奯 奲奥奡奤 奡 奶奥奣奴奯奲 奦奲奯奭 奴奨奥 奣奯奮女奯奬奥夬 奷奥 奩奭奰奬奥奭奥奮奴 奡 奦奵奮奣奴奩奯奮 奯奦 奴奨奥 奦奯奬奬奯奷奩奮奧 奴她奰奥夺

read_vec : Eff (p ** Vect p Int) [STDIO]

奔奨奩女 奲奥奴奵奲奮女 奡 奤奥奰奥奮奤奥奮奴 奰奡奩奲 奯奦 奡 奬奥奮奧奴奨夬 奡奮奤 奡 奶奥奣奴奯奲 奯奦 奴奨奡奴 奬奥奮奧奴奨夬 奢奥奣奡奵女奥 奷奥 奣奡奮奮奯奴 奫奮奯奷 奩奮
奡奤奶奡奮奣奥 奨奯奷 奭奡奮她 奩奮奴奥奧奥奲女 奴奨奥 奵女奥奲 奩女 奧奯奩奮奧 奴奯 奩奮奰奵奴央 套奥 奣奡奮 奵女奥 -1 奴奯 奩奮奤奩奣奡奴奥 奴奨奥 奥奮奤 奯奦 奩奮奰奵奴夺

read_vec : Eff (p ** Vect p Int) [STDIO]
read_vec = do putStr "Number (-1 when done): "

case run (parseNumber (trim !getStr)) of
Nothing => do putStrLn "Input error"

read_vec
Just v => if (v /= -1)

then do (_ ** xs) <- read_vec
pure (_ ** v :: xs)

else pure (_ ** [])
where
parseNumber : String -> Eff Int [EXCEPTION String]
parseNumber str

= if all (\x => isDigit x || x == '-') (unpack str)
then pure (cast str)
else raise "Not a number"

奔奨奩女 奵女奥女 奡 奶奡奲奩奡奴奩奯奮 奯奮 parseNumber 奷奨奩奣奨 奤奯奥女 奮奯奴 奲奥奱奵奩奲奥 奡 奮奵奭奢奥奲 奴奯 奢奥 奷奩奴奨奩奮 奲奡奮奧奥央

奆奩奮奡奬奬她夬 奷奥 奷奲奩奴奥 奡 奰奲奯奧奲奡奭 奷奨奩奣奨 奲奥奡奤女 奴奷奯 奶奥奣奴奯奲女 奡奮奤 奰奲奩奮奴女 奴奨奥 奲奥女奵奬奴 奯奦 奰奡奩奲奷奩女奥 奡奤奤奩奴奩奯奮 奯奦 奴奨奥奭夬
奴奨奲奯奷奩奮奧 奡奮 奥奸奣奥奰奴奩奯奮 奩奦 奴奨奥 奩奮奰奵奴女 奡奲奥 奯奦 奤奩夛奥奲奩奮奧 奬奥奮奧奴奨女夺

do_vadd : Eff () [STDIO, EXCEPTION String]
do_vadd = do putStrLn "Vector 1"

(_ ** xs) <- read_vec
putStrLn "Vector 2"
(_ ** ys) <- read_vec
putStrLn (show !(vadd_check xs ys))
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奂她 奨奡奶奩奮奧 奥奸奰奬奩奣奩奴 奬奥奮奧奴奨女 奩奮 奴奨奥 奴她奰奥夬 奷奥 奣奡奮 奢奥 女奵奲奥 奴奨奡奴 vadd 奩女 奯奮奬她 奢奥奩奮奧 奵女奥奤 奷奨奥奲奥 奴奨奥 奬奥奮奧奴奨女 奯奦
奩奮奰奵奴女 奡奲奥 奧奵奡奲奡奮奴奥奥奤 奴奯 奢奥 奥奱奵奡奬央 奔奨奩女 奤奯奥女 奮奯奴 女奴奯奰 奵女 奲奥奡奤奩奮奧 奶奥奣奴奯奲女 奦奲奯奭 奵女奥奲 奩奮奰奵奴夬 奢奵奴 奩奴 奤奯奥女
奲奥奱奵奩奲奥 奴奨奡奴 奴奨奥 奬奥奮奧奴奨女 奡奲奥 奣奨奥奣奫奥奤 奡奮奤 奡奮她 奤奩女奣奲奥奰奡奮奣她 奩女 奤奥奡奬奴 奷奩奴奨 奧奲奡奣奥奦奵奬奬她央

4.3.6 Example: An Expression Calculator

奔奯 女奨奯奷 奨奯奷 奴奨奥女奥 奥夛奥奣奴女 奣奡奮 夜奴 奴奯奧奥奴奨奥奲夬 奬奥奴 奵女 奣奯奮女奩奤奥奲 奡奮 奥奶奡奬奵奡奴奯奲 奦奯奲 奡 女奩奭奰奬奥 奥奸奰奲奥女女奩奯奮 奬奡奮奧奵奡奧奥夬
奷奩奴奨 奡奤奤奩奴奩奯奮 奡奮奤 奩奮奴奥奧奥奲 奶奡奬奵奥女央

data Expr = Val Integer
| Add Expr Expr

奁奮 奥奶奡奬奵奡奴奯奲 奦奯奲 奴奨奩女 奬奡奮奧奵奡奧奥 奡奬奷奡她女 奲奥奴奵奲奮女 奡奮 Integer夬 奡奮奤 奴奨奥奲奥 奡奲奥 奮奯 女奩奴奵奡奴奩奯奮女 奩奮 奷奨奩奣奨 奩奴 奣奡奮
奦奡奩奬夡

eval : Expr -> Integer
eval (Val x) = x
eval (Add l r) = eval l + eval r

奉奦 奷奥 奡奤奤 奶奡奲奩奡奢奬奥女夬 奨奯奷奥奶奥奲夬 奴奨奩奮奧女 奧奥奴 奭奯奲奥 奩奮奴奥奲奥女奴奩奮奧央 奔奨奥 奥奶奡奬奵奡奴奯奲 奷奩奬奬 奮奥奥奤 奴奯 奢奥 奡奢奬奥 奴奯 奡奣奣奥女女
奴奨奥 奶奡奬奵奥女 女奴奯奲奥奤 奩奮 奶奡奲奩奡奢奬奥女夬 奡奮奤 奶奡奲奩奡奢奬奥女 奭奡她 奢奥 奵奮奤奥夜奮奥奤央

data Expr = Val Integer
| Var String
| Add Expr Expr

奔奯 女奴奡奲奴夬 奷奥 奷奩奬奬 奣奨奡奮奧奥 奴奨奥 奴她奰奥 奯奦 eval 女奯 奴奨奡奴 奩奴 奩女 奥夛奥奣奴奦奵奬夬 奡奮奤 女奵奰奰奯奲奴女 奡奮 奥奸奣奥奰奴奩奯奮 奥夛奥奣奴 奦奯奲
奴奨奲奯奷奩奮奧 奥奲奲奯奲女夬 奡奮奤 奡 女奴奡奴奥 奣奯奮奴奡奩奮奩奮奧 奡 奭奡奰奰奩奮奧 奦奲奯奭 奶奡奲奩奡奢奬奥 奮奡奭奥女 夨奡女 String天 奴奯 奴奨奥奩奲 奶奡奬奵奥女夺

Env : Type
Env = List (String, Integer)

eval : Expr -> Eff Integer [EXCEPTION String, STATE Env]
eval (Val x) = pure x
eval (Add l r) = pure $ !(eval l) + !(eval r)

奎奯奴奥 奴奨奡奴 奷奥 奡奲奥 奵女奩奮奧 !夭奮奯奴奡奴奩奯奮 奴奯 奡奶奯奩奤 奨奡奶奩奮奧 奴奯 奢奩奮奤 女奵奢奥奸奰奲奥女女奩奯奮女 奩奮 奡 do 奢奬奯奣奫央 奎奥奸奴夬 奷奥 奡奤奤 奡
奣奡女奥 奦奯奲 奥奶奡奬奵奡奴奩奮奧 Var夺

eval (Var x) = case lookup x !get of
Nothing => raise $ "No such variable " ++ x
Just val => pure val

奔奨奩女 奲奥奴奲奩奥奶奥女 奴奨奥 女奴奡奴奥 夨奷奩奴奨 get夬 女奵奰奰奯奲奴奥奤 奢她 奴奨奥 STATE Env 奥夛奥奣奴天 奡奮奤 奲奡奩女奥女 奡奮 奥奸奣奥奰奴奩奯奮 奩奦 奴奨奥
奶奡奲奩奡奢奬奥 奩女 奮奯奴 奩奮 奴奨奥 奥奮奶奩奲奯奮奭奥奮奴 夨奷奩奴奨 raise夬 女奵奰奰奯奲奴奥奤 奢她 奴奨奥 EXCEPTION String 奥夛奥奣奴天央

奔奯 奲奵奮 奴奨奥 奥奶奡奬奵奡奴奯奲 奯奮 奡 奰奡奲奴奩奣奵奬奡奲 奥奸奰奲奥女女奩奯奮 奩奮 奡 奰奡奲奴奩奣奵奬奡奲 奥奮奶奩奲奯奮奭奥奮奴 奯奦 奮奡奭奥女 奡奮奤 奴奨奥奩奲 奶奡奬奵奥女夬
奷奥 奣奡奮 奷奲奩奴奥 奡 奦奵奮奣奴奩奯奮 奷奨奩奣奨 女奥奴女 奴奨奥 女奴奡奴奥 奴奨奥奮 奩奮奶奯奫奥女 eval夺

runEval : List (String, Integer) -> Expr -> Maybe Integer
runEval args expr = run (eval' expr)

where eval' : Expr -> Eff Integer [EXCEPTION String, STATE Env]
eval' e = do put args

eval e

套奥 奨奡奶奥 奰奩奣奫奥奤 Maybe 奡女 奡 奣奯奭奰奵奴奡奴奩奯奮 奣奯奮奴奥奸奴 奨奥奲奥夻 奩奴 奮奥奥奤女 奴奯 奢奥 奡 奣奯奮奴奥奸奴 奷奨奩奣奨 奩女 奡奶奡奩奬奡奢奬奥 奦奯奲
奥奶奥奲她 奥夛奥奣奴 女奵奰奰奯奲奴奥奤 奢她 eval央 奉奮 奰奡奲奴奩奣奵奬奡奲夬 奢奥奣奡奵女奥 奷奥 奨奡奶奥 奥奸奣奥奰奴奩奯奮女夬 奩奴 奮奥奥奤女 奴奯 奢奥 奡 奣奯奮奴奥奸奴 奷奨奩奣奨
女奵奰奰奯奲奴女 奥奸奣奥奰奴奩奯奮女央 奁奬奴奥奲奮奡奴奩奶奥奬她夬 Either String 奯奲 IO 奷奯奵奬奤 奢奥 夜奮奥夬 奦奯奲 奥奸奡奭奰奬奥央
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套奨奡奴 奩奦 奷奥 奷奡奮奴 奴奯 奥奸奴奥奮奤 奴奨奥 奥奶奡奬奵奡奴奯奲 奦奵奲奴奨奥奲夬 奷奩奴奨 奲奡奮奤奯奭 奮奵奭奢奥奲 奧奥奮奥奲奡奴奩奯奮夿 奔奯 奡奣奨奩奥奶奥 奴奨奩女夬 奷奥
奡奤奤 奡 奮奥奷 奣奯奮女奴奲奵奣奴奯奲 奴奯 Expr夬 奷奨奩奣奨 奧奩奶奥女 奡 奲奡奮奤奯奭 奮奵奭奢奥奲 奵奰 奴奯 奡 奭奡奸奩奭奵奭 奶奡奬奵奥夺

data Expr = Val Integer
| Var String
| Add Expr Expr
| Random Integer

奔奨奥奮夬 奷奥 奮奥奥奤 奴奯 奤奥奡奬 奷奩奴奨 奴奨奥 奮奥奷 奣奡女奥夬 奭奡奫奩奮奧 女奵奲奥 奴奨奡奴 奷奥 奥奸奴奥奮奤 奴奨奥 奬奩女奴 奯奦 奥奶奥奮奴女 奴奯 奩奮奣奬奵奤奥 RND央
奉奴 奤奯奥女奮’奴 奭奡奴奴奥奲 奷奨奥奲奥 RND 奡奰奰奥奡奲女 奩奮 奴奨奥 奬奩女奴夬 奡女 奬奯奮奧 奡女 奩奴 奩女 奰奲奥女奥奮奴夺

eval : Expr -> Eff Integer [EXCEPTION String, RND, STATE Env]

eval (Random upper) = rndInt 0 upper

奆奯奲 奴奥女奴 奰奵奲奰奯女奥女夬 奷奥 奭奩奧奨奴 奡奬女奯 奷奡奮奴 奴奯 奰奲奩奮奴 奴奨奥 奲奡奮奤奯奭 奮奵奭奢奥奲 奷奨奩奣奨 奨奡女 奢奥奥奮 奧奥奮奥奲奡奴奥奤夺

eval (Random upper) = do val <- rndInt 0 upper
putStrLn (show val)
pure val

奉奦 奷奥 奴奲她 奴奨奩女 奷奩奴奨奯奵奴 奥奸奴奥奮奤奩奮奧 奴奨奥 奥夛奥奣奴女 奬奩女奴夬 奷奥 奷奯奵奬奤 女奥奥 奡奮 奥奲奲奯奲 女奯奭奥奴奨奩奮奧 奬奩奫奥 奴奨奥 奦奯奬奬奯奷奩奮奧夺

Expr.idr:28:6:When elaborating right hand side of eval:
Can't solve goal

SubList [STDIO]
[(EXCEPTION String), RND, (STATE (List (String, Integer)))]

奉奮 奯奴奨奥奲 奷奯奲奤女夬 奴奨奥 STDIO 奥夛奥奣奴 奩女 奮奯奴 奡奶奡奩奬奡奢奬奥央 套奥 奣奡奮 奣奯奲奲奥奣奴 奴奨奩女 女奩奭奰奬她 奢她 奵奰奤奡奴奩奮奧 奴奨奥 奴她奰奥 奯奦
eval 奴奯 奩奮奣奬奵奤奥 STDIO央

eval : Expr -> Eff Integer [STDIO, EXCEPTION String, RND, STATE Env]

注注注解解解: 奕女奩奮奧 STDIO 奷奩奬奬 奲奥女奴奲奩奣奴 奴奨奥 奮奵奭奢奥奲 奯奦 奣奯奮奴奥奸奴女 奩奮 奷奨奩奣奨 eval 奣奡奮 奢奥 run 奴奯 奴奨奯女奥 奷奨奩奣奨 女奵奰奰奯奲奴
STDIO夬 女奵奣奨 奡女 IO央 奏奮奣奥 奥夛奥奣奴 奬奩女奴女 奧奥奴 奬奯奮奧奥奲夬 奩奴 奣奡奮 奢奥 奡 奧奯奯奤 奩奤奥奡 奩奮女奴奥奡奤 奴奯 奥奮奣奡奰女奵奬奡奴奥 女奥奴女 奯奦 奥夛奥奣奴女
奩奮 奡 奴她奰奥 女她奮奯奮她奭央 奔奨奩女 奩女 奡奣奨奩奥奶奥奤 奡女 奦奯奬奬奯奷女夬 女奩奭奰奬她 奢她 奤奥夜奮奩奮奧 奡 奦奵奮奣奴奩奯奮 奷奨奩奣奨 奣奯奭奰奵奴奥女 奡 奴她奰奥夬
女奩奮奣奥 奴她奰奥女 奡奲奥 夜奲女奴 奣奬奡女女 奩奮 奉奤奲奩女夺

EvalEff : Type -> Type
EvalEff t = Eff t [STDIO, EXCEPTION String, RND, STATE Env]

eval : Expr -> EvalEff Integer

4.4 Dependent Effects

奉奮 奴奨奥 奰奲奯奧奲奡奭女 奷奥 奨奡奶奥 女奥奥奮 女奯 奦奡奲夬 奴奨奥 奡奶奡奩奬奡奢奬奥 奥夛奥奣奴女 奨奡奶奥 奲奥奭奡奩奮奥奤 奣奯奮女奴奡奮奴央 奓奯奭奥奴奩奭奥女夬 奨奯奷奥奶奥奲夬
奡奮 奯奰奥奲奡奴奩奯奮 奣奡奮 change 奴奨奥 奡奶奡奩奬奡奢奬奥 奥夛奥奣奴女央 奔奨奥 女奩奭奰奬奥女奴 奥奸奡奭奰奬奥 奯奣奣奵奲女 奷奨奥奮 奷奥 奨奡奶奥 奡 女奴奡奴奥 奷奩奴奨
奡 奤奥奰奥奮奤奥奮奴 奴她奰奥—奡奤奤奩奮奧 奡奮 奥奬奥奭奥奮奴 奴奯 奡 奶奥奣奴奯奲 奡奬女奯 奣奨奡奮奧奥女 奩奴女 奴她奰奥夬 奦奯奲 奥奸奡奭奰奬奥夬 女奩奮奣奥 奩奴女 奬奥奮奧奴奨 奩女
奥奸奰奬奩奣奩奴 奩奮 奴奨奥 奴她奰奥央 奉奮 奴奨奩女 女奥奣奴奩奯奮夬 奷奥 奷奩奬奬 女奥奥 奨奯奷 奴奨奥 奬奩奢奲奡奲她 女奵奰奰奯奲奴女 奴奨奩女央 奆奩奲女奴奬她夬 奷奥 奷奩奬奬 女奥奥 奨奯奷
女奴奡奴奥女 奷奩奴奨 奤奥奰奥奮奤奥奮奴 奴她奰奥女 奣奡奮 奢奥 奩奭奰奬奥奭奥奮奴奥奤央 奓奥奣奯奮奤奬她夬 奷奥 奷奩奬奬 女奥奥 奨奯奷 奴奨奥 奥夛奥奣奴女 奣奡奮 奤奥奰奥奮奤 奯奮
奴奨奥 result 奯奦 奡奮 奥夛奥奣奴奦奵奬 奯奰奥奲奡奴奩奯奮央 奆奩奮奡奬奬她夬 奷奥 奷奩奬奬 女奥奥 奨奯奷 奴奨奩女 奣奡奮 奢奥 奵女奥奤 奴奯 奩奭奰奬奥奭奥奮奴 奡 奴她奰奥夭女奡奦奥
奡奮奤 奲奥女奯奵奲奣奥夭女奡奦奥 奰奲奯奴奯奣奯奬 奦奯奲 夜奬奥 奭奡奮奡奧奥奭奥奮奴央
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4.4.1 Dependent States

奓奵奰奰奯女奥 奷奥 奨奡奶奥 奡 奦奵奮奣奴奩奯奮 奷奨奩奣奨 奲奥奡奤女 奩奮奰奵奴 奦奲奯奭 奴奨奥 奣奯奮女奯奬奥夬 奣奯奮奶奥奲奴女 奩奴 奴奯 奡奮 奩奮奴奥奧奥奲夬 奡奮奤 奡奤奤女 奩奴 奴奯
奡 奬奩女奴 奷奨奩奣奨 奩女 女奴奯奲奥奤 奩奮 奡 STATE央 奉奴 奭奩奧奨奴 奬奯奯奫 女奯奭奥奴奨奩奮奧 奬奩奫奥 奴奨奥 奦奯奬奬奯奷奩奮奧夺

readInt : Eff () [STATE (List Int), STDIO]
readInt = do let x = trim !getStr

put (cast x :: !get)

奂奵奴 奷奨奡奴 奩奦夬 奩奮女奴奥奡奤 奯奦 奡 奬奩女奴 奯奦 奩奮奴奥奧奥奲女夬 奷奥 奷奯奵奬奤 奬奩奫奥 奴奯 女奴奯奲奥 奡 Vect夬 奭奡奩奮奴奡奩奮奩奮奧 奴奨奥 奬奥奮奧奴奨 奩奮 奴奨奥
奴她奰奥夿

readInt : Eff () [STATE (Vect n Int), STDIO]
readInt = do let x = trim !getStr

put (cast x :: !get)

奔奨奩女 奷奩奬奬 奮奯奴 奴她奰奥 奣奨奥奣奫夡 奁奬奴奨奯奵奧奨 奴奨奥 奶奥奣奴奯奲 奨奡女 奬奥奮奧奴奨 n 奯奮 奥奮奴奲她 奴奯 readInt夬 奩奴 奨奡女 奬奥奮奧奴奨 S n 奯奮
奥奸奩奴央 奔奨奥 奬奩奢奲奡奲她 奡奬奬奯奷女 奵女 奴奯 奥奸奰奲奥女女 奴奨奩女 奡女 奦奯奬奬奯奷女夺

readInt : Eff ()[STATE (Vect n Int), STDIO]
[STATE (Vect (S n) Int), STDIO]

readInt = do let x = trim !getStr
putM (cast x :: !get)

奔奨奥 奴她奰奥 Eff a xs xs' 奭奥奡奮女 奴奨奡奴 奴奨奥 奯奰奥奲奡奴奩奯奮 奢奥奧奩奮女 奷奩奴奨 奥夛奥奣奴女 xs 奡奶奡奩奬奡奢奬奥夬 奡奮奤 奥奮奤女 奷奩奴奨 奥夛奥奣奴女
xs’ 奡奶奡奩奬奡奢奬奥央 套奥 奨奡奶奥 奵女奥奤 putM 奴奯 奵奰奤奡奴奥 奴奨奥 女奴奡奴奥夬 奷奨奥奲奥 奴奨奥 M 女奵夞奸 奩奮奤奩奣奡奴奥女 奴奨奡奴 奴奨奥 type 奩女
奢奥奩奮奧 奵奰奤奡奴奥奤 奡女 奷奥奬奬 奡女 奴奨奥 奶奡奬奵奥央 奉奴 奨奡女 奴奨奥 奦奯奬奬奯奷奩奮奧 奴她奰奥夺

putM : y -> Eff () [STATE x] [STATE y]

4.4.2 Result-dependent Effects

奏奦奴奥奮夬 奷奨奥奴奨奥奲 奡 女奴奡奴奥 奩女 奵奰奤奡奴奥奤 奣奯奵奬奤 奤奥奰奥奮奤 奯奮 奴奨奥 女奵奣奣奥女女 奯奲 奯奴奨奥奲奷奩女奥 奯奦 奡奮 奯奰奥奲奡奴奩奯奮央 奉奮 奯奵奲
readInt 奥奸奡奭奰奬奥夬 奷奥 奭奩奧奨奴 奷奩女奨 奴奯 奵奰奤奡奴奥 奴奨奥 奶奥奣奴奯奲 奯奮奬她 奩奦 奴奨奥 奩奮奰奵奴 奩女 奡 奶奡奬奩奤 奩奮奴奥奧奥奲 夨奩央奥央 奡奬奬 奤奩奧奩奴女天央
奁女 奡 夜奲女奴 奡奴奴奥奭奰奴夬 奷奥 奣奯奵奬奤 奴奲她 奴奨奥 奦奯奬奬奯奷奩奮奧夬 奲奥奴奵奲奮奩奮奧 奡 Bool 奷奨奩奣奨 奩奮奤奩奣奡奴奥女 女奵奣奣奥女女夺

readInt : Eff Bool [STATE (Vect n Int), STDIO]
[STATE (Vect (S n) Int), STDIO]

readInt = do let x = trim !getStr
case all isDigit (unpack x) of

False => pure False
True => do putM (cast x :: !get)

pure True

奕奮奦奯奲奴奵奮奡奴奥奬她夬 奴奨奩女 奷奩奬奬 奮奯奴 奴她奰奥 奣奨奥奣奫 奢奥奣奡奵女奥 奴奨奥 奶奥奣奴奯奲 奤奯奥女 奮奯奴 奧奥奴 奥奸奴奥奮奤奥奤 奩奮 奢奯奴奨 奢奲奡奮奣奨奥女 奯奦 奴奨奥
case夡

MutState.idr:18:19:When elaborating right hand side of Main.case
block in readInt:
Unifying n and S n would lead to infinite value

奃奬奥奡奲奬她夬 奴奨奥 女奩奺奥 奯奦 奴奨奥 奲奥女奵奬奴奩奮奧 奶奥奣奴奯奲 奤奥奰奥奮奤女 奯奮 奷奨奥奴奨奥奲 奯奲 奮奯奴 奴奨奥 奶奡奬奵奥 奲奥奡奤 奦奲奯奭 奴奨奥 奵女奥奲 奷奡女 奶奡奬奩奤央
套奥 奣奡奮 奥奸奰奲奥女女 奴奨奩女 奩奮 奴奨奥 奴她奰奥夺

readInt : Eff Bool [STATE (Vect n Int), STDIO]
(\ok => if ok then [STATE (Vect (S n) Int), STDIO]

else [STATE (Vect n Int), STDIO])
(äÿŃéąțçżğçżŋ)
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(çżŋäÿŁéąț)

readInt = do let x = trim !getStr
case all isDigit (unpack x) of

False => pureM False
True => do putM (cast x :: !get)

pureM True

奕女奩奮奧 pureM 奲奡奴奨奥奲 奴奨奡奮 pure 奡奬奬奯奷女 奴奨奥 奯奵奴奰奵奴 奥夛奥奣奴女 奴奯 奢奥 奣奡奬奣奵奬奡奴奥奤 奦奲奯奭 奴奨奥 奶奡奬奵奥 奧奩奶奥奮央 奉奴女 奴她奰奥
奩女夺

pureM : (val : a) -> EffM m a (xs val) xs

套奨奥奮 奵女奩奮奧 readInt夬 奷奥 奷奩奬奬 奨奡奶奥 奴奯 奣奨奥奣奫 奩奴女 奲奥奴奵奲奮 奶奡奬奵奥 奩奮 奯奲奤奥奲 奴奯 奫奮奯奷 奷奨奡奴 奴奨奥 奮奥奷 女奥奴 奯奦 奥夛奥奣奴女
奩女央 奆奯奲 奥奸奡奭奰奬奥夬 奴奯 奲奥奡奤 奡 女奥奴 奮奵奭奢奥奲 奯奦 奶奡奬奵奥女 奩奮奴奯 奡 奶奥奣奴奯奲夬 奷奥 奣奯奵奬奤 奷奲奩奴奥 奴奨奥 奦奯奬奬奯奷奩奮奧夺

readN : (n : Nat) ->
Eff () [STATE (Vect m Int), STDIO]

[STATE (Vect (n + m) Int), STDIO]
readN Z = pure ()
readN {m} (S k) = case !readInt of

True => rewrite plusSuccRightSucc k m in readN k
False => readN (S k)

奔奨奥 case 奡奮奡奬她女奩女 奯奮 奴奨奥 奲奥女奵奬奴 奯奦 readInt 奭奥奡奮女 奴奨奡奴 奷奥 奫奮奯奷 奩奮 奥奡奣奨 奢奲奡奮奣奨 奷奨奥奴奨奥奲 奲奥奡奤奩奮奧 奴奨奥
奩奮奴奥奧奥奲 女奵奣奣奥奥奤奥奤夬 奡奮奤 奴奨奥奲奥奦奯奲奥 奨奯奷 奭奡奮她 奶奡奬奵奥女 女奴奩奬奬 奮奥奥奤 奴奯 奢奥 奲奥奡奤 奩奮奴奯 奴奨奥 奶奥奣奴奯奲央 套奨奡奴 奴奨奩女 奭奥奡奮女
奩奮 奰奲奡奣奴奩奣奥 奩女 奴奨奡奴 奴奨奥 奴她奰奥 女她女奴奥奭 奨奡女 奶奥奲奩夜奥奤 奴奨奡奴 奡 奮奥奣奥女女奡奲她 奤她奮奡奭奩奣 奣奨奥奣奫 夨奩央奥央 奷奨奥奴奨奥奲 奲奥奡奤奩奮奧 奡
奶奡奬奵奥 女奵奣奣奥奥奤奥奤天 奨奡女 奩奮奤奥奥奤 奢奥奥奮 奤奯奮奥央

注注注解解解: 奏奮奬她 case 奷奩奬奬 奷奯奲奫 奨奥奲奥央 套奥 奣奡奮奮奯奴 奵女奥 if/then/else 奢奥奣奡奵女奥 奴奨奥 then 奡奮奤 else 奢奲奡奮奣奨奥女
奭奵女奴 奨奡奶奥 奴奨奥 女奡奭奥 奴她奰奥央 奔奨奥 case 奣奯奮女奴奲奵奣奴夬 奨奯奷奥奶奥奲夬 奡奢女奴奲奡奣奴女 奯奶奥奲 奴奨奥 奶奡奬奵奥 奢奥奩奮奧 奩奮女奰奥奣奴奥奤 奩奮 奴奨奥
奴她奰奥 奯奦 奥奡奣奨 奢奲奡奮奣奨央

4.4.3 File Management

奁 奰奲奡奣奴奩奣奡奬 奵女奥 奦奯奲 奤奥奰奥奮奤奥奮奴 奥夛奥奣奴女 奩女 奩奮 女奰奥奣奩奦她奩奮奧 奲奥女奯奵奲奣奥 奵女奡奧奥 奰奲奯奴奯奣奯奬女 奡奮奤 奶奥奲奩奦她奩奮奧 奴奨奡奴 奴奨奥她 奡奲奥
奥奸奥奣奵奴奥奤 奣奯奲奲奥奣奴奬她央 奆奯奲 奥奸奡奭奰奬奥夬 夜奬奥 奭奡奮奡奧奥奭奥奮奴 奦奯奬奬奯奷女 奡 奲奥女奯奵奲奣奥 奵女奡奧奥 奰奲奯奴奯奣奯奬 奷奩奴奨 奴奨奥 奦奯奬奬奯奷奩奮奧
夨奩奮奦奯奲奭奡奬奬她 女奰奥奣奩夜奥奤天 奲奥奱奵奩奲奥奭奥奮奴女夺

• 奉奴 奩女 奮奥奣奥女女奡奲她 奴奯 奯奰奥奮 奡 夜奬奥 奦奯奲 奲奥奡奤奩奮奧 奢奥奦奯奲奥 奲奥奡奤奩奮奧 奩奴

• 奏奰奥奮奩奮奧 奭奡她 奦奡奩奬夬 女奯 奴奨奥 奰奲奯奧奲奡奭奭奥奲 女奨奯奵奬奤 奣奨奥奣奫 奷奨奥奴奨奥奲 奯奰奥奮奩奮奧 奷奡女 女奵奣奣奥女女奦奵奬

• 奁 夜奬奥 奷奨奩奣奨 奩女 奯奰奥奮 奦奯奲 奲奥奡奤奩奮奧 奭奵女奴 奮奯奴 奢奥 奷奲奩奴奴奥奮 奴奯夬 奡奮奤 奶奩奣奥 奶奥奲女奡

• 套奨奥奮 夜奮奩女奨奥奤夬 奡奮 奯奰奥奮 夜奬奥 奨奡奮奤奬奥 女奨奯奵奬奤 奢奥 奣奬奯女奥奤

• 套奨奥奮 奡 夜奬奥 奩女 奣奬奯女奥奤夬 奩奴女 奨奡奮奤奬奥 女奨奯奵奬奤 奮奯 奬奯奮奧奥奲 奢奥 奵女奥奤

奔奨奥女奥 奲奥奱奵奩奲奥奭奥奮奴女 奣奡奮 奢奥 奥奸奰奲奥女女奥奤 奦奯奲奭奡奬奬她 奩奮 夬 奢她 奣奲奥奡奴奩奮奧 奡 FILE_IO 奥夛奥奣奴 奰奡奲奡奭奥奴奥奲奩女奥奤 奯奶奥奲 奡
夜奬奥 奨奡奮奤奬奥 女奴奡奴奥夬 奷奨奩奣奨 奩女 奥奩奴奨奥奲 奥奭奰奴她夬 奯奰奥奮 奦奯奲 奲奥奡奤奩奮奧夬 奯奲 奯奰奥奮 奦奯奲 奷奲奩奴奩奮奧央 奔奨奥 FILE_IO 奥夛奥奣奴’女
奤奥夜奮奩奴奩奯奮 奩女 奧奩奶奥奮 奢奥奬奯奷央 奎奯奴奥 奴奨奡奴 奴奨奩女 奥夛奥奣奴 奩女 奭奡奩奮奬她 奦奯奲 奩奬奬奵女奴奲奡奴奩奶奥 奰奵奲奰奯女奥女—奴她奰奩奣奡奬奬她 奷奥 奷奯奵奬奤
奡奬女奯 奬奩奫奥 奴奯 女奵奰奰奯奲奴 奲奡奮奤奯奭 奡奣奣奥女女 夜奬奥女 奡奮奤 奢奥奴奴奥奲 奲奥奰奯奲奴奩奮奧 奯奦 奥奲奲奯奲 奣奯奮奤奩奴奩奯奮女央

module Effect.File

(äÿŃéąțçżğçżŋ)
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import Effects
import Control.IOExcept

FILE_IO : Type -> EFFECT

data OpenFile : Mode -> Type

open : (fname : String)
-> (m : Mode)
-> Eff Bool [FILE_IO ()]

(\res => [FILE_IO (case res of
True => OpenFile m
False => ())])

close : Eff () [FILE_IO (OpenFile m)] [FILE_IO ()]

readLine : Eff String [FILE_IO (OpenFile Read)]
writeLine : String -> Eff () [FILE_IO (OpenFile Write)]
eof : Eff Bool [FILE_IO (OpenFile Read)]

Handler FileIO IO where { ... }

奉奮 奰奡奲奴奩奣奵奬奡奲夬 奣奯奮女奩奤奥奲 奴奨奥 奴她奰奥 奯奦 open夺

open : (fname : String)
-> (m : Mode)
-> Eff Bool [FILE_IO ()]

(\res => [FILE_IO (case res of
True => OpenFile m
False => ())])

奔奨奩女 奲奥奴奵奲奮女 奡 Bool 奷奨奩奣奨 奩奮奤奩奣奡奴奥女 奷奨奥奴奨奥奲 奯奰奥奮奩奮奧 奴奨奥 夜奬奥 奷奡女 女奵奣奣奥女女奦奵奬央 奔奨奥 奲奥女奵奬奴奩奮奧 女奴奡奴奥 奤奥奰奥奮奤女
奯奮 奷奨奥奴奨奥奲 奴奨奥 奯奰奥奲奡奴奩奯奮 奷奡女 女奵奣奣奥女女奦奵奬夻 奩奦 女奯夬 奷奥 奨奡奶奥 奡 夜奬奥 奨奡奮奤奬奥 奯奰奥奮 奦奯奲 奴奨奥 女奴奡奴奥奤 奰奵奲奰奯女奥夬 奡奮奤 奩奦
奮奯奴夬 奷奥 奨奡奶奥 奮奯 夜奬奥 奨奡奮奤奬奥央 奂她 case 奡奮奡奬她女奩女 奯奮 奴奨奥 奲奥女奵奬奴夬 奷奥 奣奯奮奴奩奮奵奥 奴奨奥 奰奲奯奴奯奣奯奬 奡奣奣奯奲奤奩奮奧奬她央

readFile : Eff (List String) [FILE_IO (OpenFile Read)]
readFile = readAcc [] where

readAcc : List String -> Eff (List String) [FILE_IO (OpenFile Read)]
readAcc acc = if (not !eof)

then readAcc (!readLine :: acc)
else pure (reverse acc)

奇奩奶奥奮 奡 奦奵奮奣奴奩奯奮 readFile夬 奡奢奯奶奥夬 奷奨奩奣奨 奲奥奡奤女 奦奲奯奭 奡奮 奯奰奥奮 夜奬奥 奵奮奴奩奬 奲奥奡奣奨奩奮奧 奴奨奥 奥奮奤夬 奷奥 奣奡奮 奷奲奩奴奥
奡 奰奲奯奧奲奡奭 奷奨奩奣奨 奯奰奥奮女 奡 夜奬奥夬 奲奥奡奤女 奩奴夬 奴奨奥奮 奤奩女奰奬奡她女 奴奨奥 奣奯奮奴奥奮奴女 奡奮奤 奣奬奯女奥女 奩奴夬 奡女 奦奯奬奬奯奷女夬 奣奯奲奲奥奣奴奬她
奦奯奬奬奯奷奩奮奧 奴奨奥 奰奲奯奴奯奣奯奬夺

dumpFile : String -> Eff () [FILE_IO (), STDIO]
dumpFile name = case !(open name Read) of

True => do putStrLn (show !readFile)
close

False => putStrLn ("Error!")

奔奨奥 奴她奰奥 奯奦 dumpFile夬 奷奩奴奨 FILE_IO () 奩奮 奩奴女 奥夛奥奣奴 奬奩女奴夬 奩奮奤奩奣奡奴奥女 奴奨奡奴 奡奮她 奵女奥 奯奦 奴奨奥 夜奬奥 奲奥女奯奵奲奣奥 奷奩奬奬
奦奯奬奬奯奷 奴奨奥 奰奲奯奴奯奣奯奬 奣奯奲奲奥奣奴奬她 夨奩央奥央 奩奴 奢奯奴奨 奢奥奧奩奮女 奡奮奤 奥奮奤女 奷奩奴奨 奡奮 奥奭奰奴她 奲奥女奯奵奲奣奥天央 奉奦 奷奥 奦奡奩奬 奴奯 奦奯奬奬奯奷
奴奨奥 奰奲奯奴奯奣奯奬 奣奯奲奲奥奣奴奬她 夨奰奥奲奨奡奰女 奢她 奦奯奲奧奥奴奴奩奮奧 奴奯 奣奬奯女奥 奴奨奥 夜奬奥夬 奦奡奩奬奩奮奧 奴奯 奣奨奥奣奫 奴奨奡奴 open 女奵奣奣奥奥奤奥奤夬 奯奲
奯奰奥奮奩奮奧 奴奨奥 夜奬奥 奦奯奲 奷奲奩奴奩奮奧天 奴奨奥奮 奷奥 奷奩奬奬 奧奥奴 奡 奣奯奭奰奩奬奥夭奴奩奭奥 奥奲奲奯奲央 奆奯奲 奥奸奡奭奰奬奥夬 奣奨奡奮奧奩奮奧 open name
Read 奴奯 open name Write 她奩奥奬奤女 奡 奣奯奭奰奩奬奥夭奴奩奭奥 奥奲奲奯奲 奯奦 奴奨奥 奦奯奬奬奯奷奩奮奧 奦奯奲奭夺

FileTest.idr:16:18:When elaborating right hand side of Main.case
block in testFile:

(äÿŃéąțçżğçżŋ)
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Can't solve goal
SubList [(FILE_IO (OpenFile Read))]

[(FILE_IO (OpenFile Write)), STDIO]

奉奮 奯奴奨奥奲 奷奯奲奤女夺 奷奨奥奮 奲奥奡奤奩奮奧 奡 夜奬奥夬 奷奥 奮奥奥奤 奡 夜奬奥 奷奨奩奣奨 奩女 奯奰奥奮 奦奯奲 奲奥奡奤奩奮奧夬 奢奵奴 奴奨奥 奥夛奥奣奴 奬奩女奴 奣奯奮奴奡奩奮女
奡 FILE_IO 奥夛奥奣奴 奣奡奲奲她奩奮奧 奡 夜奬奥 奯奰奥奮 奦奯奲 奷奲奩奴奩奮奧央

4.4.4 Pattern-matching bind

奉奴 奭奩奧奨奴 女奥奥奭 奴奨奡奴 奨奡奶奩奮奧 奴奯 奴奥女奴 奥奡奣奨 奰奯奴奥奮奴奩奡奬奬她 奦奡奩奬奩奮奧 奯奰奥奲奡奴奩奯奮 奷奩奴奨 奡 case 奣奬奡奵女奥 奣奯奵奬奤 奬奥奡奤 奴奯 奵奧奬她
奣奯奤奥夬 奷奩奴奨 奬奯奴女 奯奦 奮奥女奴奥奤 奣奡女奥 奢奬奯奣奫女央 奍奡奮她 奬奡奮奧奵奡奧奥女 女奵奰奰奯奲奴 奥奸奣奥奰奴奩奯奮女 奴奯 奩奭奰奲奯奶奥 奴奨奩女夬 奢奵奴 奵奮奦奯奲夭
奴奵奮奡奴奥奬她 奥奸奣奥奰奴奩奯奮女 奭奡她 奮奯奴 奡奬奬奯奷 奣奯奭奰奬奥奴奥奬她 奣奬奥奡奮 奲奥女奯奵奲奣奥 奭奡奮奡奧奥奭奥奮奴—奦奯奲 奥奸奡奭奰奬奥夬 奧奵奡奲奡奮奴奥奥奩奮奧
奴奨奡奴 奡奮她 open 奷奨奩奣奨 奤奩奤 女奵奣奣奥奥奤 奨奡女 奡 奣奯奲奲奥女奰奯奮奤奩奮奧 奣奬奯女奥央

奉奤奲奩女 女奵奰奰奯奲奴女 pattern-matching 奢奩奮奤奩奮奧女夬 女奵奣奨 奡女 奴奨奥 奦奯奬奬奯奷奩奮奧夺

dumpFile : String -> Eff () [FILE_IO (), STDIO]
dumpFile name = do True <- open name Read

putStrLn (show !readFile)
close

奔奨奩女 奡奬女奯 奨奡女 奡 奰奲奯奢奬奥奭夺 奷奥 奡奲奥 奮奯 奬奯奮奧奥奲 奤奥奡奬奩奮奧 奷奩奴奨 奴奨奥 奣奡女奥 奷奨奥奲奥 奯奰奥奮奩奮奧 奡 夜奬奥 奦奡奩奬奥奤夡 奔奨奥 女奯奬奵奴奩奯奮
奩女 奴奯 奥奸奴奥奮奤 奴奨奥 奰奡奴奴奥奲奮夭奭奡奴奣奨奩奮奧 奢奩奮奤奩奮奧 女她奮奴奡奸 奴奯 奧奩奶奥 奢奲奩奥奦 奣奬奡奵女奥女 奦奯奲 奦奡奩奬奩奮奧 奭奡奴奣奨奥女央 奈奥奲奥夬 奦奯奲
奥奸奡奭奰奬奥夬 奷奥 奣奯奵奬奤 奷奲奩奴奥夺

dumpFile : String -> Eff () [FILE_IO (), STDIO]
dumpFile name = do True <- open name Read | False => putStrLn "Error"

putStrLn (show !readFile)
close

奔奨奩女 奩女 奥奸奡奣奴奬她 奥奱奵奩奶奡奬奥奮奴 奴奯 奴奨奥 奤奥夜奮奩奴奩奯奮 奷奩奴奨 奴奨奥 奥奸奰奬奩奣奩奴 case央 奉奮 奧奥奮奥奲奡奬夬 奩奮 奡 do夭奢奬奯奣奫夬 奴奨奥 女她奮奴奡奸夺

do pat <- val | <alternatives>
p

奩女 奤奥女奵奧奡奲奥奤 奴奯

do x <- val
case x of

pat => p
<alternatives>

奔奨奥奲奥 奣奡奮 奢奥 女奥奶奥奲奡奬 alternatives夬 女奥奰奡奲奡奴奥奤 奢她 奡 奶奥奲奴奩奣奡奬 奢奡奲 |央 奆奯奲 奥奸奡奭奰奬奥夬 奴奨奥奲奥 奩女 奡 SYSTEM 奥夛奥奣奴
奷奨奩奣奨 女奵奰奰奯奲奴女 奲奥奡奤奩奮奧 奣奯奭奭奡奮奤 奬奩奮奥 奡奲奧奵奭奥奮奴女夬 奡奭奯奮奧 奯奴奨奥奲 奴奨奩奮奧女 夨女奥奥 奁奰奰奥奮奤奩奸 Effects Summary
夨姩妡妵 失夳夳天天央 奔奯 奲奥奡奤 奣奯奭奭奡奮奤 奬奩奮奥 奡奲奧奵奭奥奮奴女夬 奷奥 奣奡奮 奵女奥 getArgs夺

getArgs : Eff (List String) [SYSTEM]

奁 奭奡奩奮 奰奲奯奧奲奡奭 奣奡奮 奲奥奡奤 奣奯奭奭奡奮奤 奬奩奮奥 奡奲奧奵奭奥奮奴女 奡女 奦奯奬奬奯奷女夬 奷奨奥奲奥 奩奮 奴奨奥 奬奩女奴 奷奨奩奣奨 奩女 奲奥奴奵奲奮奥奤夬 奴奨奥
夜奲女奴 奥奬奥奭奥奮奴 prog 奩女 奴奨奥 奥奸奥奣奵奴奡奢奬奥 奮奡奭奥 奡奮奤 奴奨奥 女奥奣奯奮奤 奩女 奡奮 奥奸奰奥奣奴奥奤 奡奲奧奵奭奥奮奴夺

emain : Eff () [SYSTEM, STDIO]
emain = do [prog, arg] <- getArgs

putStrLn $ "Argument is " ++ arg
{- ... rest of function ... -}
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奕奮奦奯奲奴奵奮奡奴奥奬她夬 奴奨奩女 奷奩奬奬 奮奯奴 奦奡奩奬 奧奲奡奣奥奦奵奬奬她 奩奦 奮奯 奡奲奧奵奭奥奮奴 奩女 奧奩奶奥奮夬 奯奲 奩奦 奴奯奯 奭奡奮她 奡奲奧奵奭奥奮奴女 奡奲奥 奧奩奶奥奮央
套奥 奣奡奮 奵女奥 奰奡奴奴奥奲奮 奭奡奴奣奨奩奮奧 奢奩奮奤 奡奬奴奥奲奮奡奴奩奶奥女 奴奯 奧奩奶奥 奡 奢奥奴奴奥奲 夨奭奯奲奥 奩奮奦奯奲奭奡奴奩奶奥天 奥奲奲奯奲夺

emain : Eff () [SYSTEM, STDIO]
emain = do [prog, arg] <- getArgs | [] => putStrLn "Can't happen!"

| [prog] => putStrLn "No arguments!"
| _ => putStrLn "Too many arguments!"

putStrLn $ "Argument is " ++ arg
{- ... rest of function ... -}

奉奦 getArgs 奤奯奥女 奮奯奴 奲奥奴奵奲奮 女奯奭奥奴奨奩奮奧 奯奦 奴奨奥 奦奯奲奭 [prog, arg] 奴奨奥 奡奬奴奥奲奮奡奴奩奶奥 奷奨奩奣奨 奤奯奥女 奭奡奴奣奨 奩女
奥奸奥奣奵奴奥奤 奩奮女奴奥奡奤夬 奡奮奤 奴奨奡奴 奶奡奬奵奥 奲奥奴奵奲奮奥奤央

4.5 Creating New Effects

套奥 奨奡奶奥 奮奯奷 女奥奥奮 女奥奶奥奲奡奬 女奩奤奥夭奥夛奥奣奴奩奮奧 奯奰奥奲奡奴奩奯奮女 奰奲奯奶奩奤奥奤 奢她 奴奨奥 Effects 奬奩奢奲奡奲她夬 奡奮奤 奥奸奡奭奰奬奥女 奯奦
奴奨奥奩奲 奵女奥 奩奮 奓奥奣奴奩奯奮 Simple Effects 夨姩妡妵 失失失天央 套奥 奨奡奶奥 奡奬女奯 女奥奥奮 奨奯奷 奯奰奥奲奡奴奩奯奮女 奭奡她 modify 奴奨奥 奡奶奡奩奬奡奢奬奥
奥夛奥奣奴女 奢她 奣奨奡奮奧奩奮奧 女奴奡奴奥 奩奮 奓奥奣奴奩奯奮 Dependent Effects 夨姩妡妵 失失夸天央 套奥 奨奡奶奥 奮奯奴夬 奨奯奷奥奶奥奲夬 她奥奴 女奥奥奮 奨奯奷
奴奨奥女奥 奯奰奥奲奡奴奩奯奮女 奡奲奥 奩奭奰奬奥奭奥奮奴奥奤央 奉奮 奴奨奩女 女奥奣奴奩奯奮夬 奷奥 奤奥女奣奲奩奢奥 奨奯奷 奡 女奥奬奥奣奴奩奯奮 奯奦 奴奨奥 奡奶奡奩奬奡奢奬奥 奥夛奥奣奴女 奡奲奥
奩奭奰奬奥奭奥奮奴奥奤夬 奡奮奤 女奨奯奷 奨奯奷 奮奥奷 奥夛奥奣奴奦奵奬 奯奰奥奲奡奴奩奯奮女 奭奡她 奢奥 奰奲奯奶奩奤奥奤央

4.5.1 State

奅夛奥奣奴女 奡奲奥 奤奥女奣奲奩奢奥奤 奢她 algebraic data types夬 奷奨奥奲奥 奴奨奥 奣奯奮女奴奲奵奣奴奯奲女 奤奥女奣奲奩奢奥 奴奨奥 奯奰奥奲奡奴奩奯奮女 奰奲奯奶奩奤奥奤
奷奨奥奮 奴奨奥 奥夛奥奣奴 奩女 奡奶奡奩奬奡奢奬奥央 奓奴奡奴奥奦奵奬 奯奰奥奲奡奴奩奯奮女 奡奲奥 奤奥女奣奲奩奢奥奤 奡女 奦奯奬奬奯奷女夺

data State : Effect where
Get : State a a (\x => a)
Put : b -> State () a (\x => b)

Effect 奩奴女奥奬奦 奩女 奡 奴她奰奥 女她奮奯奮她奭夬 奧奩奶奩奮奧 奴奨奥 奲奥奱奵奩奲奥奤 奴她奰奥 奦奯奲 奡奮 奥夛奥奣奴 女奩奧奮奡奴奵奲奥夺

Effect : Type
Effect = (result : Type) ->

(input_resource : Type) ->
(output_resource : result -> Type) -> Type

奅奡奣奨 奥夛奥奣奴 奩女 奡女女奯奣奩奡奴奥奤 奷奩奴奨 奡 resource央 奔奨奥 女奥奣奯奮奤 奡奲奧奵奭奥奮奴 奴奯 奡奮 奥夛奥奣奴 女奩奧奮奡奴奵奲奥 奩女 奴奨奥 奲奥女奯奵奲奣奥
奴她奰奥 奯奮 input 奴奯 奡奮 奯奰奥奲奡奴奩奯奮夬 奡奮奤 奴奨奥 奴奨奩奲奤 奩女 奡 奦奵奮奣奴奩奯奮 奷奨奩奣奨 奣奯奭奰奵奴奥女 奴奨奥 奲奥女奯奵奲奣奥 奴她奰奥 奯奮 output央
奈奥奲奥夬 奩奴 奭奥奡奮女夺

• Get 奴奡奫奥女 奮奯 奡奲奧奵奭奥奮奴女央 奉奴 奨奡女 奡 奲奥女奯奵奲奣奥 奯奦 奴她奰奥 a夬 奷奨奩奣奨 奩女 奮奯奴 奵奰奤奡奴奥奤夬 奡奮奤 奲奵奮奮奩奮奧 奴奨奥 Get
奯奰奥奲奡奴奩奯奮 奲奥奴奵奲奮女 女奯奭奥奴奨奩奮奧 奯奦 奴她奰奥 a央

• Put 奴奡奫奥女 奡 b 奡女 奡奮 奡奲奧奵奭奥奮奴央 奉奴 奨奡女 奡 奲奥女奯奵奲奣奥 奯奦 奴她奰奥 a 奯奮 奩奮奰奵奴夬 奷奨奩奣奨 奩女 奵奰奤奡奴奥奤 奴奯 奡 奲奥女奯奵奲奣奥
奯奦 奴她奰奥 b央 奒奵奮奮奩奮奧 奴奨奥 Put 奯奰奥奲奡奴奩奯奮 奲奥奴奵奲奮女 奴奨奥 奥奬奥奭奥奮奴 奯奦 奴奨奥 奵奮奩奴 奴她奰奥央

奔奨奥 奥夛奥奣奴女 奬奩奢奲奡奲她 奰奲奯奶奩奤奥女 奡奮 奯奶奥奲奬奯奡奤奥奤 奦奵奮奣奴奩奯奮 sig 奷奨奩奣奨 奣奡奮 奭奡奫奥 奥夛奥奣奴 女奩奧奮奡奴奵奲奥女 奭奯奲奥 奣奯奮奣奩女奥夬
奰奡奲奴奩奣奵奬奡奲奬她 奷奨奥奮 奴奨奥 奲奥女奵奬奴 奨奡女 奮奯 奥夛奥奣奴 奯奮 奴奨奥 奲奥女奯奵奲奣奥 奴她奰奥央 奆奯奲 State夬 奷奥 奣奡奮 奷奲奩奴奥夺

data State : Effect where
Get : sig State a a
Put : b -> sig State () a b

奔奨奥奲奥 奡奲奥 奦奯奵奲 奶奥奲女奩奯奮女 奯奦 sig夬 奤奥奰奥奮奤奩奮奧 奯奮 奷奨奥奴奨奥奲 奷奥 奡奲奥 奩奮奴奥奲奥女奴奥奤 奩奮 奴奨奥 奲奥女奯奵奲奣奥 奴她奰奥夬 奡奮奤 奷奨奥奴奨奥奲
奷奥 奡奲奥 奵奰奤奡奴奩奮奧 奴奨奥 奲奥女奯奵奲奣奥央 奉奤奲奩女 奷奩奬奬 奩奮奦奥奲 奴奨奥 奡奰奰奲奯奰奲奩奡奴奥 奶奥奲女奩奯奮 奦奲奯奭 奵女奡奧奥央
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NoResourceEffect.sig : Effect -> Type -> Type
NoUpdateEffect.sig : Effect -> (ret : Type) ->

(resource : Type) -> Type
UpdateEffect.sig : Effect -> (ret : Type) ->

(resource_in : Type) ->
(resource_out : Type) -> Type

DepUpdateEffect.sig : Effect -> (ret : Type) ->
(resource_in : Type) ->
(resource_out : ret -> Type) -> Type

奉奮 奯奲奤奥奲 奴奯 奣奯奮奶奥奲奴 State 夨奯奦 奴她奰奥 Effect天 奩奮奴奯 女奯奭奥奴奨奩奮奧 奵女奡奢奬奥 奩奮 奡奮 奥夛奥奣奴女 奬奩女奴夬 奯奦 奴她奰奥 EFFECT夬 奷奥
奷奲奩奴奥 奴奨奥 奦奯奬奬奯奷奩奮奧夺

STATE : Type -> EFFECT
STATE t = MkEff t State

MkEff 奣奯奮女奴奲奵奣奴女 奡奮 EFFECT 奢她 奴奡奫奩奮奧 奴奨奥 奲奥女奯奵奲奣奥 奴她奰奥 夨奨奥奲奥夬 奴奨奥 t 奷奨奩奣奨 奰奡奲奡奭奥奴奥奲奩女奥女 STATE天 奡奮奤
奴奨奥 奥夛奥奣奴 女奩奧奮奡奴奵奲奥 夨奨奥奲奥夬 State天央 奆奯奲 奲奥奦奥奲奥奮奣奥夬 EFFECT 奩女 奤奥奣奬奡奲奥奤 奡女 奦奯奬奬奯奷女夺

data EFFECT : Type where
MkEff : Type -> Effect -> EFFECT

奒奥奣奡奬奬 奴奨奡奴 奴奯 奲奵奮 奡奮 奥夛奥奣奴奦奵奬 奰奲奯奧奲奡奭 奩奮 Eff夬 奷奥 奵女奥 奯奮奥 奯奦 奴奨奥 run 奦奡奭奩奬她 奯奦 奦奵奮奣奴奩奯奮女 奴奯 奲奵奮 奴奨奥
奰奲奯奧奲奡奭 奩奮 奡 奰奡奲奴奩奣奵奬奡奲 奣奯奭奰奵奴奡奴奩奯奮 奣奯奮奴奥奸奴 m央 奆奯奲 奥奡奣奨 奥夛奥奣奴夬 奴奨奥奲奥奦奯奲奥夬 奷奥 奭奵女奴 奥奸奰奬奡奩奮 奨奯奷 奩奴 奩女
奥奸奥奣奵奴奥奤 奩奮 奡 奰奡奲奴奩奣奵奬奡奲 奣奯奭奰奵奴奡奴奩奯奮 奣奯奮奴奥奸奴 奦奯奲 run 奴奯 奷奯奲奫 奩奮 奴奨奡奴 奣奯奮奴奥奸奴央 奔奨奩女 奩女 奡奣奨奩奥奶奥奤 奷奩奴奨 奴奨奥
奦奯奬奬奯奷奩奮奧 奩奮奴奥奲奦奡奣奥夺

interface Handler (e : Effect) (m : Type -> Type) where
handle : resource -> (eff : e t resource resource') ->

((x : t) -> resource' x -> m a) -> m a

套奥 奨奡奶奥 奡奬奲奥奡奤她 女奥奥奮 女奯奭奥 奩奭奰奬奥奭奥奮奴奡奴奩奯奮 奤奥奣奬奡奲奡奴奩奯奮女 奩奮 奴奨奥 奥夛奥奣奴 女奵奭奭奡奲奩奥女 奩奮 奓奥奣奴奩奯奮 Simple Effects
夨姩妡妵 失失失天央 奁奮 奩奭奰奬奥奭奥奮奴奡奴奩奯奮 奯奦 Handler e m 奭奥奡奮女 奴奨奡奴 奴奨奥 奥夛奥奣奴 奤奥奣奬奡奲奥奤 奷奩奴奨 女奩奧奮奡奴奵奲奥 e 奣奡奮 奢奥
奲奵奮 奩奮 奣奯奭奰奵奴奡奴奩奯奮 奣奯奮奴奥奸奴 m央 奔奨奥 handle 奦奵奮奣奴奩奯奮 奴奡奫奥女夺

• 奔奨奥 resource 奯奮 奩奮奰奵奴 夨女奯夬 奴奨奥 奣奵奲奲奥奮奴 奶奡奬奵奥 奯奦 奴奨奥 女奴奡奴奥 奦奯奲 State天

• 奔奨奥 奥夛奥奣奴奦奵奬 奯奰奥奲奡奴奩奯奮 夨奥奩奴奨奥奲 Get 奯奲 Put x 奦奯奲 State天

• 奁 continuation夬 奷奨奩奣奨 奷奥 奣奯奮奶奥奮奴奩奯奮奡奬奬她 奣奡奬奬 k夬 奡奮奤 女奨奯奵奬奤 奢奥 奰奡女女奥奤 奴奨奥 奲奥女奵奬奴 奶奡奬奵奥 奯奦 奴奨奥
奯奰奥奲奡奴奩奯奮夬 奡奮奤 奡奮 奵奰奤奡奴奥奤 奲奥女奯奵奲奣奥央

奔奨奥奲奥 奡奲奥 奴奷奯 奲奥奡女奯奮女 奦奯奲 奴奡奫奩奮奧 奡 奣奯奮奴奩奮奵奡奴奩奯奮 奨奥奲奥夺 夜奲女奴奬她夬 奴奨奩女 奩女 奮奥奡奴奥奲 奢奥奣奡奵女奥 奴奨奥奲奥 奡奲奥 奭奵奬奴奩奰奬奥
奲奥奴奵奲奮 奶奡奬奵奥女 夨奡 奮奥奷 奲奥女奯奵奲奣奥 奡奮奤 奴奨奥 奲奥女奵奬奴 奯奦 奴奨奥 奯奰奥奲奡奴奩奯奮天夻 女奥奣奯奮奤奬她夬 奡奮奤 奭奯奲奥 奩奭奰奯奲奴奡奮奴奬她夬 奴奨奥
奣奯奮奴奩奮奵奡奴奩奯奮 奣奡奮 奢奥 奣奡奬奬奥奤 奺奥奲奯 奯奲 奭奯奲奥 奴奩奭奥女央

奁 Handler 奦奯奲 State 女奩奭奰奬她 奰奡女女奥女 奯奮 奴奨奥 奶奡奬奵奥 奯奦 奴奨奥 女奴奡奴奥夬 奩奮 奴奨奥 奣奡女奥 奯奦 Get夬 奯奲 奰奡女女奥女 奯奮 奡 奮奥奷
女奴奡奴奥夬 奩奮 奴奨奥 奣奡女奥 奯奦 Put央 奉奴 奩女 奤奥夜奮奥奤 奴奨奥 女奡奭奥 奷奡她 奦奯奲 奡奬奬 奣奯奭奰奵奴奡奴奩奯奮 奣奯奮奴奥奸奴女夺

Handler State m where
handle st Get k = k st st
handle st (Put n) k = k () n

奔奨奩女 奧奩奶奥女 奥奮奯奵奧奨 奩奮奦奯奲奭奡奴奩奯奮 奦奯奲 Get 奡奮奤 Put 奴奯 奢奥 奵女奥奤 奤奩奲奥奣奴奬她 奩奮 Eff 奰奲奯奧奲奡奭女央 奉奴 奩女 奴奩奤她夬 奨奯奷奥奶奥奲夬
奴奯 奤奥夜奮奥 奴奯奰 奬奥奶奥奬 奦奵奮奣奴奩奯奮女 奩奮 Eff夬 奡女 奦奯奬奬奯奷女夺

get : Eff x [STATE x]
get = call Get
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put : x -> Eff () [STATE x]
put val = call (Put val)

putM : y -> Eff () [STATE x] [STATE y]
putM val = call (Put val)

An implementation detail (aside): 奔奨奥 call 奦奵奮奣奴奩奯奮 奣奯奮奶奥奲奴女 奡奮 Effect 奴奯 奡 奦奵奮奣奴奩奯奮 奩奮 Eff夬 奧奩奶奥奮
奡 奰奲奯奯奦 奴奨奡奴 奴奨奥 奥夛奥奣奴 奩女 奡奶奡奩奬奡奢奬奥央 奔奨奩女 奰奲奯奯奦 奣奡奮 奢奥 奣奯奮女奴奲奵奣奴奥奤 奡奵奴奯奭奡奴奩奣奡奬奬她夬 女奩奮奣奥 奩奴 奩女 奥女女奥奮奴奩奡奬奬她 奡奮
奩奮奤奥奸 奩奮奴奯 奡 女奴奡奴奩奣奡奬奬她 奫奮奯奷奮 奬奩女奴 奯奦 奥夛奥奣奴女夺

call : {e : Effect} ->
(eff : e t a b) -> {auto prf : EffElem e a xs} ->
Eff t xs (\v => updateResTy v xs prf eff)

奔奨奩女 奩女 奴奨奥 奲奥奡女奯奮 奦奯奲 奴奨奥 Can’t solve goal 奥奲奲奯奲 奷奨奥奮 奡奮 奥夛奥奣奴 奩女 奮奯奴 奡奶奡奩奬奡奢奬奥夺 奴奨奥 奩奭奰奬奩奣奩奴 奰奲奯奯奦
prf 奨奡女 奮奯奴 奢奥奥奮 女奯奬奶奥奤 奡奵奴奯奭奡奴奩奣奡奬奬她 奢奥奣奡奵女奥 奴奨奥 奲奥奱奵奩奲奥奤 奥夛奥奣奴 奩女 奮奯奴 奩奮 奴奨奥 奬奩女奴 奯奦 奥夛奥奣奴女 xs央

奓奵奣奨 奤奥奴奡奩奬女 奡奲奥 奮奯奴 奩奭奰奯奲奴奡奮奴 奦奯奲 奵女奩奮奧 奴奨奥 奬奩奢奲奡奲她夬 奯奲 奥奶奥奮 奷奲奩奴奩奮奧 奮奥奷 奥夛奥奣奴女夬 奨奯奷奥奶奥奲央

Summary

奔奨奥 奦奯奬奬奯奷奩奮奧 奬奩女奴奩奮奧 女奵奭奭奡奲奩女奥女 奷奨奡奴 奩女 奲奥奱奵奩奲奥奤 奴奯 奤奥夜奮奥 奴奨奥 STATE 奥夛奥奣奴夺

data State : Effect where
Get : sig State a a
Put : b -> sig State () a b

STATE : Type -> EFFECT
STATE t = MkEff t State

Handler State m where
handle st Get k = k st st
handle st (Put n) k = k () n

get : Eff x [STATE x]
get = call Get

put : x -> Eff () [STATE x]
put val = call (Put val)

putM : y -> Eff () [STATE x] [STATE y]
putM val = call (Put val)

4.5.2 Console I/O

奔奨奥奮 奬奩女奴奩奮奧 奢奥奬奯奷 奧奩奶奥女 奴奨奥 奤奥夜奮奩奴奩奯奮 奯奦 奴奨奥 STDIO 奥夛奥奣奴夬 奩奮奣奬奵奤奩奮奧 奨奡奮奤奬奥奲女 奦奯奲 IO 奡奮奤 IOExcept央 套奥
奯奭奩奴 奴奨奥 奤奥夜奮奩奴奩奯奮 奯奦 奴奨奥 奴奯奰 奬奥奶奥奬 Eff 奦奵奮奣奴奩奯奮女夬 奡女 奴奨奩女 奭奥奲奥奬她 奩奮奶奯奫奥 奴奨奥 奥夛奥奣奴女 PutStr夬 GetStr夬 PutCh
奡奮奤 GetCh 奤奩奲奥奣奴奬她央

奎奯奴奥 奴奨奡奴 奩奮 奴奨奩女 奣奡女奥夬 奴奨奥 奲奥女奯奵奲奣奥 奩女 奴奨奥 奵奮奩奴 奴她奰奥 奩奮 奥奶奥奲她 奣奡女奥夬 女奩奮奣奥 奴奨奥 奨奡奮奤奬奥奲女 奭奥奲奥奬她 奡奰奰奬她 奴奨奥
IO 奥奱奵奩奶奡奬奥奮奴女 奯奦 奴奨奥 奥夛奥奣奴女 奤奩奲奥奣奴奬她央

data StdIO : Effect where
PutStr : String -> sig StdIO ()
GetStr : sig StdIO String
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PutCh : Char -> sig StdIO ()
GetCh : sig StdIO Char

Handler StdIO IO where
handle () (PutStr s) k = do putStr s; k () ()
handle () GetStr k = do x <- getLine; k x ()
handle () (PutCh c) k = do putChar c; k () ()
handle () GetCh k = do x <- getChar; k x ()

Handler StdIO (IOExcept a) where
handle () (PutStr s) k = do ioe_lift $ putStr s; k () ()
handle () GetStr k = do x <- ioe_lift $ getLine; k x ()
handle () (PutCh c) k = do ioe_lift $ putChar c; k () ()
handle () GetCh k = do x <- ioe_lift $ getChar; k x ()

STDIO : EFFECT
STDIO = MkEff () StdIO

4.5.3 Exceptions

奔奨奥 奬奩女奴奩奮奧 奢奥奬奯奷 奧奩奶奥女 奴奨奥 奤奥夜奮奩奴奩奯奮 奯奦 奴奨奥 Exception 奥夛奥奣奴夬 奩奮奣奬奵奤奩奮奧 奴奷奯 奯奦 奩奴女 奨奡奮奤奬奥奲女 奦奯奲 Maybe 奡奮奤
List央 奔奨奥 奯奮奬她 奯奰奥奲奡奴奩奯奮 奰奲奯奶奩奤奥奤 奩女 Raise央 奔奨奥 奫奥她 奰奯奩奮奴 奴奯 奮奯奴奥 奩奮 奴奨奥 奤奥夜奮奩奴奩奯奮女 奯奦 奴奨奥女奥 奨奡奮奤奬奥奲女
奩女 奴奨奡奴 奴奨奥 奣奯奮奴奩奮奵奡奴奩奯奮 k 奩女 奮奯奴 奵女奥奤央 奒奵奮奮奩奮奧 Raise 奴奨奥奲奥奦奯奲奥 奭奥奡奮女 奴奨奡奴 奣奯奭奰奵奴奡奴奩奯奮 女奴奯奰女 奷奩奴奨 奡奮
奥奲奲奯奲央

data Exception : Type -> Effect where
Raise : a -> sig (Exception a) b

Handler (Exception a) Maybe where
handle _ (Raise e) k = Nothing

Handler (Exception a) List where
handle _ (Raise e) k = []

EXCEPTION : Type -> EFFECT
EXCEPTION t = MkEff () (Exception t)

4.5.4 Non-determinism

奔奨奥 奦奯奬奬奯奷奩奮奧 奬奩女奴奩奮奧 奧奩奶奥女 奴奨奥 奤奥夜奮奩奴奩奯奮 奯奦 奴奨奥 Select 奥夛奥奣奴 奦奯奲 奷奲奩奴奩奮奧 奮奯奮夭奤奥奴奥奲奭奩奮奩女奴奩奣 奰奲奯奧奲奡奭女夬
奩奮奣奬奵奤奩奮奧 奡 奨奡奮奤奬奥奲 奦奯奲 List 奣奯奮奴奥奸奴 奷奨奩奣奨 奲奥奴奵奲奮女 奡奬奬 奰奯女女奩奢奬奥 女奵奣奣奥女女奦奵奬 奶奡奬奵奥女夬 奡奮奤 奡 奨奡奮奤奬奥奲 奦奯奲 Maybe
奣奯奮奴奥奸奴 奷奨奩奣奨 奲奥奴奵奲奮女 奴奨奥 夜奲女奴 女奵奣奣奥女女奦奵奬 奶奡奬奵奥央

data Selection : Effect where
Select : List a -> sig Selection a

Handler Selection Maybe where
handle _ (Select xs) k = tryAll xs where

tryAll [] = Nothing
tryAll (x :: xs) = case k x () of

Nothing => tryAll xs
Just v => Just v

Handler Selection List where
handle r (Select xs) k = concatMap (\x => k x r) xs
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SELECT : EFFECT
SELECT = MkEff () Selection

奈奥奲奥夬 奴奨奥 奣奯奮奴奩奮奵奡奴奩奯奮 奩女 奣奡奬奬奥奤 奭奵奬奴奩奰奬奥 奴奩奭奥女 奩奮 奥奡奣奨 奨奡奮奤奬奥奲夬 奦奯奲 奥奡奣奨 奶奡奬奵奥 奩奮 奴奨奥 奬奩女奴 奯奦 奰奯女女奩奢奬奥
奶奡奬奵奥女央 奉奮 奴奨奥 List 奨奡奮奤奬奥奲夬 奷奥 奡奣奣奵奭奵奬奡奴奥 奡奬奬 女奵奣奣奥女女奦奵奬 奲奥女奵奬奴女夬 奡奮奤 奩奮 奴奨奥 Maybe 奨奡奮奤奬奥奲 奷奥 奴奲她 奴奨奥
夜奲女奴 奶奡奬奵奥 奩奮 奴奨奥 奬奩女奴夬 奡奮奤 奴奲她 奬奡奴奥奲 奶奡奬奵奥女 奯奮奬她 奩奦 奴奨奡奴 奦奡奩奬女央

4.5.5 File Management

奒奥女奵奬奴夭奤奥奰奥奮奤奥奮奴 奥夛奥奣奴女 奡奲奥 奮奯 奤奩夛奥奲奥奮奴 奦奲奯奭 奮奯奮夭奤奥奰奥奮奤奥奮奴 奥夛奥奣奴女 奩奮 奴奨奥 奷奡她 奴奨奥她 奡奲奥 奩奭奰奬奥奭奥奮奴奥奤央
奔奨奥 奬奩女奴奩奮奧 奢奥奬奯奷 奩奬奬奵女奴奲奡奴奥女 奴奨奩女 奦奯奲 奴奨奥 FILE_IO 奥夛奥奣奴央 奔奨奥 女她奮奴奡奸 奦奯奲 女奴奡奴奥 奴奲奡奮女奩奴奩奯奮女 { x ==> {res}
x’ }夬 奷奨奥奲奥 奴奨奥 奲奥女奵奬奴 女奴奡奴奥 x’ 奩女 奣奯奭奰奵奴奥奤 奦奲奯奭 奴奨奥 奲奥女奵奬奴 奯奦 奴奨奥 奯奰奥奲奡奴奩奯奮 res夬 奦奯奬奬奯奷女 奴奨奡奴 奦奯奲 奴奨奥
奥奱奵奩奶奡奬奥奮奴 Eff 奰奲奯奧奲奡奭女央

data FileIO : Effect where
Open : (fname: String)

-> (m : Mode)
-> sig FileIO Bool () (\res => case res of

True => OpenFile m
False => ())

Close : sig FileIO () (OpenFile m)

ReadLine : sig FileIO String (OpenFile Read)
WriteLine : String -> sig FileIO () (OpenFile Write)
EOF : sig FileIO Bool (OpenFile Read)

Handler FileIO IO where
handle () (Open fname m) k = do h <- openFile fname m

if !(validFile h)
then k True (FH h)
else k False ()

handle (FH h) Close k = do closeFile h
k () ()

handle (FH h) ReadLine k = do str <- fread h
k str (FH h)

handle (FH h) (WriteLine str) k = do fwrite h str
k () (FH h)

handle (FH h) EOF k = do e <- feof h
k e (FH h)

FILE_IO : Type -> EFFECT
FILE_IO t = MkEff t FileIO

奎奯奴奥 奴奨奡奴 奩奮 奴奨奥 奨奡奮奤奬奥奲 奦奯奲 Open夬 奴奨奥 奴她奰奥女 奰奡女女奥奤 奴奯 奴奨奥 奣奯奮奴奩奮奵奡奴奩奯奮 k 奡奲奥 奤奩夛奥奲奥奮奴 奤奥奰奥奮奤奩奮奧 奯奮
奷奨奥奴奨奥奲 奴奨奥 奲奥女奵奬奴 奩女 True 夨奯奰奥奮奩奮奧 女奵奣奣奥奥奤奥奤天 奯奲 False 夨奯奰奥奮奩奮奧 奦奡奩奬奥奤天央 奔奨奩女 奵女奥女 validFile夬 奤奥夜奮奥奤
奩奮 奴奨奥 Prelude夬 奴奯 奴奥女奴 奷奨奥奴奨奥奲 奡 夜奬奥 奨奡奮奤奬奥奲 奲奥奦奥奲女 奴奯 奡奮 奯奰奥奮 夜奬奥 奯奲 奮奯奴央

4.6 Example: A “““Mystery Word””” Guessing Game

奉奮 奴奨奩女 女奥奣奴奩奯奮夬 奷奥 奷奩奬奬 奵女奥 奴奨奥 奴奥奣奨奮奩奱奵奥女 奡奮奤 女奰奥奣奩夜奣 奥夛奥奣奴女 奤奩女奣奵女女奥奤 奩奮 奴奨奥 奴奵奴奯奲奩奡奬 女奯 奦奡奲 奴奯 奩奭奰奬奥奭奥奮奴
奡 奬奡奲奧奥奲 奥奸奡奭奰奬奥夬 奡 女奩奭奰奬奥 奴奥奸奴夭奢奡女奥奤 奷奯奲奤夭奧奵奥女女奩奮奧 奧奡奭奥央 奉奮 奴奨奥 奧奡奭奥夬 奴奨奥 奣奯奭奰奵奴奥奲 奣奨奯奯女奥女 奡 奷奯奲奤夬
奷奨奩奣奨 奴奨奥 奰奬奡她奥奲 奭奵女奴 奧奵奥女女 奬奥奴奴奥奲 奢她 奬奥奴奴奥奲央 奁奦奴奥奲 奡 奬奩奭奩奴奥奤 奮奵奭奢奥奲 奯奦 奷奲奯奮奧 奧奵奥女女奥女夬 奴奨奥 奰奬奡她奥奲 奬奯女奥女1央

1 Readers may recognise this game by the name “Hangman”.
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套奥 奷奩奬奬 奩奭奰奬奥奭奥奮奴 奴奨奥 奧奡奭奥 奢她 奦奯奬奬奯奷奩奮奧 奴奨奥女奥 女奴奥奰女夺

失央 奄奥夜奮奥 奴奨奥 奧奡奭奥 女奴奡奴奥夬 奩奮 奥奮奯奵奧奨 奤奥奴奡奩奬 奴奯 奥奸奰奲奥女女 奴奨奥 奲奵奬奥女

夲央 奄奥夜奮奥 奴奨奥 奲奵奬奥女 奯奦 奴奨奥 奧奡奭奥 夨奩央奥央 奷奨奡奴 奡奣奴奩奯奮女 奴奨奥 奰奬奡她奥奲 奭奡她 奴奡奫奥夬 奡奮奤 奨奯奷 奴奨奥女奥 奡奣奴奩奯奮女 奡夛奥奣奴
奴奨奥 奧奡奭奥 女奴奡奴奥天

夳央 奉奭奰奬奥奭奥奮奴 奴奨奥 奲奵奬奥女 奯奦 奴奨奥 奧奡奭奥 夨奩央奥央 奩奭奰奬奥奭奥奮奴 女奴奡奴奥 奵奰奤奡奴奥女 奦奯奲 奥奡奣奨 奡奣奴奩奯奮天

头央 奉奭奰奬奥奭奥奮奴 奡 奵女奥奲 奩奮奴奥奲奦奡奣奥 奷奨奩奣奨 奡奬奬奯奷女 奡 奰奬奡她奥奲 奴奯 奤奩奲奥奣奴 奡奣奴奩奯奮女

奓奴奥奰 夲 奭奡她 奢奥 奡奣奨奩奥奶奥奤 奢她 奤奥夜奮奩奮奧 奡奮 奥夛奥奣奴 奷奨奩奣奨 奤奥奰奥奮奤女 奯奮 奴奨奥 女奴奡奴奥 奤奥夜奮奥奤 奩奮 女奴奥奰 失央 奔奨奥奮 女奴奥奰 夳
奩奮奶奯奬奶奥女 奩奭奰奬奥奭奥奮奴奩奮奧 奡 Handler 奦奯奲 奴奨奩女 奥夛奥奣奴央 奆奩奮奡奬奬她夬 女奴奥奰 头 奩奮奶奯奬奶奥女 奩奭奰奬奥奭奥奮奴奩奮奧 奡 奰奲奯奧奲奡奭 奩奮 Eff
奵女奩奮奧 奴奨奥 奮奥奷奬她 奤奥夜奮奥奤 奥夛奥奣奴 夨奡奮奤 奡奮她 奯奴奨奥奲女 奲奥奱奵奩奲奥奤 奴奯 奩奭奰奬奥奭奥奮奴 奴奨奥 奩奮奴奥奲奦奡奣奥天央

4.6.1 Step 1: Game State

奆奩奲女奴夬 奷奥 奣奡奴奥奧奯奲奩女奥 奴奨奥 奧奡奭奥 女奴奡奴奥女 奡女 奲奵奮奮奩奮奧 奧奡奭奥女 夨奷奨奥奲奥 奴奨奥奲奥 奡奲奥 奡 奮奵奭奢奥奲 奯奦 奧奵奥女女奥女 奡奶奡奩奬奡奢奬奥夬
奡奮奤 奡 奮奵奭奢奥奲 奯奦 奬奥奴奴奥奲女 女奴奩奬奬 奴奯 奧奵奥女女天夬 奯奲 奮奯奮夭奲奵奮奮奩奮奧 奧奡奭奥女 夨奩央奥央 奧奡奭奥女 奷奨奩奣奨 奨奡奶奥 奮奯奴 奢奥奥奮 女奴奡奲奴奥奤夬
奯奲 奧奡奭奥女 奷奨奩奣奨 奨奡奶奥 奢奥奥奮 奷奯奮 奯奲 奬奯女奴天央

data GState = Running Nat Nat | NotRunning

奎奯奴奩奣奥 奴奨奡奴 奡奴 奴奨奩女 女奴奡奧奥夬 奷奥 女奡她 奮奯奴奨奩奮奧 奡奢奯奵奴 奷奨奡奴 奩奴 奭奥奡奮女 奴奯 奭奡奫奥 奡 奧奵奥女女夬 奷奨奡奴 奴奨奥 奷奯奲奤 奴奯 奢奥
奧奵奥女女奥奤 奩女夬 奨奯奷 奴奯 奧奵奥女女 奬奥奴奴奥奲女夬 奯奲 奡奮她 奯奴奨奥奲 奩奭奰奬奥奭奥奮奴奡奴奩奯奮 奤奥奴奡奩奬央 套奥 奡奲奥 奯奮奬她 奩奮奴奥奲奥女奴奥奤 奩奮 奷奨奡奴 奩女
奮奥奣奥女女奡奲她 奴奯 奤奥女奣奲奩奢奥 奴奨奥 奧奡奭奥 奲奵奬奥女央

套奥 奷奩奬奬夬 奨奯奷奥奶奥奲夬 奰奡奲奡奭奥奴奥奲奩女奥 奡 奣奯奮奣奲奥奴奥 奧奡奭奥 女奴奡奴奥 Mystery 奯奶奥奲 奴奨奩女 奤奡奴奡夺

data Mystery : GState -> Type

4.6.2 Step 2: Game Rules

套奥 奤奥女奣奲奩奢奥 奴奨奥 奧奡奭奥 奲奵奬奥女 奡女 奡 奤奥奰奥奮奤奥奮奴 奥夛奥奣奴夬 奷奨奥奲奥 奥奡奣奨 奡奣奴奩奯奮 奨奡女 奡 precondition 夨奩央奥央 奷奨奡奴 奴奨奥
奧奡奭奥 女奴奡奴奥 奭奵女奴 奢奥 奢奥奦奯奲奥 奣奡奲奲她奩奮奧 奯奵奴 奴奨奥 奡奣奴奩奯奮天 奡奮奤 奡 postcondition 夨奩央奥央 奨奯奷 奴奨奥 奡奣奴奩奯奮 奡夛奥奣奴女 奴奨奥
奧奡奭奥 女奴奡奴奥天央 奉奮奦奯奲奭奡奬奬她夬 奴奨奥女奥 奡奣奴奩奯奮女 奷奩奴奨 奴奨奥 奰奲奥夭 奡奮奤 奰奯女奴奣奯奮奤奩奴奩奯奮女 奡奲奥夺

Guess 奇奵奥女女 奡 奬奥奴奴奥奲 奩奮 奴奨奥 奷奯奲奤央

• 奐奲奥奣奯奮奤奩奴奩奯奮夺 奔奨奥 奧奡奭奥 奭奵女奴 奢奥 奲奵奮奮奩奮奧夬 奡奮奤 奴奨奥奲奥 奭奵女奴 奢奥 奢奯奴奨 奧奵奥女女奥女 女奴奩奬奬 奡奶奡奩奬奡奢奬奥夬 奡奮奤
奬奥奴奴奥奲女 女奴奩奬奬 奴奯 奢奥 奧奵奥女女奥奤央

• 奐奯女奴奣奯奮奤奩奴奩奯奮夺 奉奦 奴奨奥 奧奵奥女女奥奤 奬奥奴奴奥奲 奩女 奩奮 奴奨奥 奷奯奲奤 奡奮奤 奮奯奴 她奥奴 奧奵奥女女奥奤夬 奲奥奤奵奣奥 奴奨奥 奮奵奭奢奥奲 奯奦
奬奥奴奴奥奲女夬 奯奴奨奥奲奷奩女奥 奲奥奤奵奣奥 奴奨奥 奮奵奭奢奥奲 奯奦 奧奵奥女女奥女央

Won 奄奥奣奬奡奲奥 奶奩奣奴奯奲她

• 奐奲奥奣奯奮奤奩奴奩奯奮夺 奔奨奥 奧奡奭奥 奭奵女奴 奢奥 奲奵奮奮奩奮奧夬 奡奮奤 奴奨奥奲奥 奭奵女奴 奢奥 奮奯 奬奥奴奴奥奲女 女奴奩奬奬 奴奯 奢奥 奧奵奥女女奥奤央

• 奐奯女奴奣奯奮奤奩奴奩奯奮夺 奔奨奥 奧奡奭奥 奩女 奮奯 奬奯奮奧奥奲 奲奵奮奮奩奮奧央

Lost 奁奣奣奥奰奴 奤奥奦奥奡奴

• 奐奲奥奣奯奮奤奩奴奩奯奮夺 奔奨奥 奧奡奭奥 奭奵女奴 奢奥 奲奵奮奮奩奮奧夬 奡奮奤 奴奨奥奲奥 奭奵女奴 奢奥 奮奯 奧奵奥女女奥女 奬奥奦奴央

• 奐奯女奴奣奯奮奤奩奴奩奯奮夺 奔奨奥 奧奡奭奥 奩女 奮奯 奬奯奮奧奥奲 奲奵奮奮奩奮奧央

NewWord 奓奥奴 奡 奮奥奷 奷奯奲奤 奴奯 奢奥 奧奵奥女女奥奤
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• 奐奲奥奣奯奮奤奩奴奩奯奮夺 奔奨奥 奧奡奭奥 奭奵女奴 奮奯奴 奢奥 奲奵奮奮奩奮奧央

• 奐奯女奴奣奯奮奤奩奴奩奯奮夺 奔奨奥 奧奡奭奥 奩女 奲奵奮奮奩奮奧夬 奷奩奴奨 夶 奧奵奥女女奥女 奡奶奡奩奬奡奢奬奥 夨奴奨奥 奣奨奯奩奣奥 奯奦 夶 奩女 女奯奭奥奷奨奡奴
奡奲奢奩奴奲奡奲她 奨奥奲奥天 奡奮奤 奴奨奥 奮奵奭奢奥奲 奯奦 奵奮奩奱奵奥 奬奥奴奴奥奲女 奩奮 奴奨奥 奷奯奲奤 女奴奩奬奬 奴奯 奢奥 奧奵奥女女奥奤央

Get 奇奥奴 奡 女奴奲奩奮奧 奲奥奰奲奥女奥奮奴奡奴奩奯奮 奯奦 奴奨奥 奧奡奭奥 女奴奡奴奥央 奔奨奩女 奩女 奦奯奲 奤奩女奰奬奡她 奰奵奲奰奯女奥女夻 奴奨奥奲奥 奡奲奥 奮奯 奰奲奥夭 奯奲
奰奯女奴奣奯奮奤奩奴奩奯奮女央

套奥 奣奡奮 奭奡奫奥 奴奨奥女奥 奲奵奬奥女 奰奲奥奣奩女奥 奢她 奤奥奣奬奡奲奩奮奧 奴奨奥奭 奭奯奲奥 奦奯奲奭奡奬奬她 奩奮 奡奮 奥夛奥奣奴 女奩奧奮奡奴奵奲奥夺

data MysteryRules : Effect where
Guess : (x : Char) ->

sig MysteryRules Bool
(Mystery (Running (S g) (S w)))
(\inword => if inword

then Mystery (Running (S g) w)
else Mystery (Running g (S w)))

Won : sig MysteryRules () (Mystery (Running g 0))
(Mystery NotRunning)

Lost : sig MysteryRules () (Mystery (Running 0 g))
(Mystery NotRunning)

NewWord : (w : String) ->
sig MysteryRules () (Mystery NotRunning) (Mystery (Running 6 (length (letters␣

→˓w))))
Get : sig MysteryRules String (Mystery h)

奔奨奩女 奤奥女奣奲奩奰奴奩奯奮 女奡她女 奮奯奴奨奩奮奧 奡奢奯奵奴 奨奯奷 奴奨奥 奲奵奬奥女 奡奲奥 奩奭奰奬奥奭奥奮奴奥奤央 奉奮 奰奡奲奴奩奣奵奬奡奲夬 奩奴 奤奯奥女 奮奯奴 女奰奥奣奩奦她
how 奴奯 奴奥奬奬 奷奨奥奴奨奥奲 奡 奧奵奥女女奥奤 奬奥奴奴奥奲 奷奡女 奩奮 奡 奷奯奲奤夬 奪奵女奴 奴奨奡奴 奴奨奥 奲奥女奵奬奴 奯奦 Guess 奤奥奰奥奮奤女 奯奮 奩奴央

奎奥奶奥奲奴奨奥奬奥女女夬 奷奥 奣奡奮 女奴奩奬奬 奣奲奥奡奴奥 奡奮 EFFECT 奦奲奯奭 奴奨奩女夬 奡奮奤 奵女奥 奩奴 奩奮 奡奮 Eff 奰奲奯奧奲奡奭央 奉奭奰奬奥奭奥奮奴奩奮奧 奡
Handler 奦奯奲 MysteryRules 奷奩奬奬 奴奨奥奮 奡奬奬奯奷 奵女 奴奯 奰奬奡她 奴奨奥 奧奡奭奥央

MYSTERY : GState -> EFFECT
MYSTERY h = MkEff (Mystery h) MysteryRules

4.6.3 Step 3: Implement Rules

奔奯 implement 奴奨奥 奲奵奬奥女夬 奷奥 奢奥奧奩奮 奢她 奧奩奶奩奮奧 奡 奣奯奮奣奲奥奴奥 奤奥夜奮奩奴奩奯奮 奯奦 奧奡奭奥 女奴奡奴奥夺

data Mystery : GState -> Type where
Init : Mystery NotRunning
GameWon : (word : String) -> Mystery NotRunning
GameLost : (word : String) -> Mystery NotRunning
MkG : (word : String) ->

(guesses : Nat) ->
(got : List Char) ->
(missing : Vect m Char) ->
Mystery (Running guesses m)

奉奦 奡 奧奡奭奥 奩女 NotRunning夬 奴奨奡奴 奩女 奥奩奴奨奥奲 奢奥奣奡奵女奥 奩奴 奨奡女 奮奯奴 她奥奴 女奴奡奲奴奥奤 夨Init天 奯奲 奢奥奣奡奵女奥 奩奴 奩女 奷奯奮 奯奲
奬奯女奴 夨GameWon 奡奮奤 GameLost夬 奥奡奣奨 奯奦 奷奨奩奣奨 奣奡奲奲她 奴奨奥 奷奯奲奤 女奯 奴奨奡奴 女奨奯奷奩奮奧 奴奨奥 奧奡奭奥 女奴奡奴奥 奷奩奬奬 奲奥奶奥奡奬
奴奨奥 奷奯奲奤 奴奯 奴奨奥 奰奬奡她奥奲天央 奆奩奮奡奬奬她夬 MkG 奣奡奰奴奵奲奥女 奡 奲奵奮奮奩奮奧 奧奡奭奥’女 女奴奡奴奥夬 奩奮奣奬奵奤奩奮奧 奴奨奥 奴奡奲奧奥奴 奷奯奲奤夬 奴奨奥
奬奥奴奴奥奲女 女奵奣奣奥女女奦奵奬奬她 奧奵奥女女奥奤夬 奡奮奤 奴奨奥 奭奩女女奩奮奧 奬奥奴奴奥奲女央 奕女奩奮奧 奡 Vect 奦奯奲 奴奨奥 奭奩女女奩奮奧 奬奥奴奴奥奲女 奩女 奣奯奮奶奥奮奩奥奮奴
女奩奮奣奥 奩奴女 奬奥奮奧奴奨 奩女 奵女奥奤 奩奮 奴奨奥 奴她奰奥央

奔奯 奩奮奩奴奩奡奬奩女奥 奴奨奥 女奴奡奴奥夬 奷奥 奩奭奰奬奥奭奥奮奴 奴奨奥 奦奯奬奬奯奷奩奮奧 奦奵奮奣奴奩奯奮女夺 letters夬 奷奨奩奣奨 奲奥奴奵奲奮女 奡 奬奩女奴 奯奦 奵奮奩奱奵奥
奬奥奴奴奥奲女 奩奮 奡 String 夨奩奧奮奯奲奩奮奧 女奰奡奣奥女天 奡奮奤 initState 奷奨奩奣奨 女奥奴女 奵奰 奡奮 奩奮奩奴奩奡奬 女奴奡奴奥 奣奯奮女奩奤奥奲奥奤 奶奡奬奩奤 奡女 奡
奰奯女奴奣奯奮奤奩奴奩奯奮 奦奯奲 NewWord央
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letters : String -> List Char
initState : (x : String) -> Mystery (Running 6 (length (letters x)))

套奨奥奮 奣奨奥奣奫奩奮奧 奩奦 奡 奧奵奥女女 奩女 奩奮 奴奨奥 奶奥奣奴奯奲 奯奦 奭奩女女奩奮奧 奬奥奴奴奥奲女夬 奩奴 奩女 奣奯奮奶奥奮奩奥奮奴 奴奯 奲奥奴奵奲奮 奡 proof 奴奨奡奴 奴奨奥
奧奵奥女女 奩女 奩奮 奴奨奥 奶奥奣奴奯奲夬 奵女奩奮奧 isElem 奢奥奬奯奷夬 奲奡奴奨奥奲 奴奨奡奮 奭奥奲奥奬她 奡 Bool夺

data IsElem : a -> Vect n a -> Type where
First : IsElem x (x :: xs)
Later : IsElem x xs -> IsElem x (y :: xs)

isElem : DecEq a => (x : a) -> (xs : Vect n a) -> Maybe (IsElem x xs)

奔奨奥 奲奥奡女奯奮 奦奯奲 奲奥奴奵奲奮奩奮奧 奡 奰奲奯奯奦 奩女 奴奨奡奴 奷奥 奣奡奮 奵女奥 奩奴 奴奯 奲奥奭奯奶奥 奡奮 奥奬奥奭奥奮奴 奦奲奯奭 奴奨奥 奣奯奲奲奥奣奴 奰奯女奩奴奩奯奮 奩奮
奡 奶奥奣奴奯奲夺

shrink : (xs : Vect (S n) a) -> IsElem x xs -> Vect n a

套奥 奬奥奡奶奥 奴奨奥 奤奥夜奮奩奴奩奯奮女 奯奦 letters夬 init夬 isElem 奡奮奤 shrink 奡女 奥奸奥奲奣奩女奥女央 奈奡奶奩奮奧 奩奭奰奬奥奭奥奮奴奥奤 奴奨奥女奥夬
奴奨奥 Handler 奩奭奰奬奥奭奥奮奴奡奴奩奯奮 奦奯奲 MysteryRules 奩女 女奵奲奰奲奩女奩奮奧奬她 女奴奲奡奩奧奨奴奦奯奲奷奡奲奤夺

Handler MysteryRules m where
handle (MkG w g got []) Won k = k () (GameWon w)
handle (MkG w Z got m) Lost k = k () (GameLost w)

handle st Get k = k (show st) st
handle st (NewWord w) k = k () (initState w)

handle (MkG w (S g) got m) (Guess x) k =
case isElem x m of

Nothing => k False (MkG w _ got m)
(Just p) => k True (MkG w _ (x :: got) (shrink m p))

奅奡奣奨 奣奡女奥 女奩奭奰奬她 奩奮奶奯奬奶奥女 奤奩奲奥奣奴奬她 奵奰奤奡奴奩奮奧 奴奨奥 奧奡奭奥 女奴奡奴奥 奩奮 奡 奷奡她 奷奨奩奣奨 奩女 奣奯奮女奩女奴奥奮奴 奷奩奴奨 奴奨奥 奤奥奣奬奡奲奥奤
奲奵奬奥女央 奉奮 奰奡奲奴奩奣奵奬奡奲夬 奩奮 Guess夬 奩奦 奴奨奥 奨奡奮奤奬奥奲 奣奬奡奩奭女 奴奨奡奴 奴奨奥 奧奵奥女女奥奤 奬奥奴奴奥奲 奩女 奩奮 奴奨奥 奷奯奲奤 夨奢她 奰奡女女奩奮奧
True 奴奯 k天夬 奴奨奥奲奥 奩女 奮奯 奷奡她 奴奯 奵奰奤奡奴奥 奴奨奥 女奴奡奴奥 奩奮 女奵奣奨 奡 奷奡她 奴奨奡奴 奴奨奥 奮奵奭奢奥奲 奯奦 奭奩女女奩奮奧 奬奥奴奴奥奲女 奯奲
奮奵奭奢奥奲 奯奦 奧奵奥女女奥女 奤奯奥女 奮奯奴 奦奯奬奬奯奷 奴奨奥 奲奵奬奥女央

4.6.4 Step 4: Implement Interface

奈奡奶奩奮奧 奤奥女奣奲奩奢奥奤 奴奨奥 奲奵奬奥女夬 奡奮奤 奩奭奰奬奥奭奥奮奴奥奤 女奴奡奴奥 奴奲奡奮女奩奴奩奯奮女 奷奨奩奣奨 奦奯奬奬奯奷 奴奨奯女奥 奲奵奬奥女 奡女 奡奮 奥夛奥奣奴
奨奡奮奤奬奥奲夬 奷奥 奣奡奮 奮奯奷 奷奲奩奴奥 奡奮 奩奮奴奥奲奦奡奣奥 奦奯奲 奴奨奥 奧奡奭奥 奷奨奩奣奨 奵女奥女 奴奨奥 MYSTERY 奥夛奥奣奴夺

game : Eff () [MYSTERY (Running (S g) w), STDIO]
[MYSTERY NotRunning, STDIO]

奔奨奥 奴她奰奥 奩奮奤奩奣奡奴奥女 奴奨奡奴 奴奨奥 奧奡奭奥 奭奵女奴 女奴奡奲奴 奩奮 奡 奲奵奮奮奩奮奧 女奴奡奴奥夬 奷奩奴奨 女奯奭奥 奧奵奥女女奥女 奡奶奡奩奬奡奢奬奥夬 奡奮奤
奥奶奥奮奴奵奡奬奬她 奲奥奡奣奨 奡 奮奯奴夭奲奵奮奮奩奮奧 女奴奡奴奥 夨奩央奥央 奷奯奮 奯奲 奬奯女奴天央 奔奨奥 奯奮奬她 奷奡她 奴奯 奡奣奨奩奥奶奥 奴奨奩女 奩女 奢她 奣奯奲奲奥奣奴奬她
奦奯奬奬奯奷奩奮奧 奴奨奥 女奴奡奴奥奤 奲奵奬奥女央

奎奯奴奥 奴奨奡奴 奴奨奥 奴她奰奥 奯奦 game 奭奡奫奥女 奮奯 奡女女奵奭奰奴奩奯奮 奴奨奡奴 奴奨奥奲奥 奡奲奥 奬奥奴奴奥奲女 奴奯 奢奥 奧奵奥女女奥奤 奩奮 奴奨奥 奧奩奶奥奮 奷奯奲奤
夨奩央奥央 奩奴 奩女 w 奲奡奴奨奥奲 奴奨奡奮 S w天央 奔奨奩女 奩女 奢奥奣奡奵女奥 奷奥 奷奩奬奬 奢奥 奣奨奯奯女奩奮奧 奡 奷奯奲奤 奡奴 奲奡奮奤奯奭 奦奲奯奭 奡 奶奥奣奴奯奲 奯奦
String夬 奡奮奤 奡奴 奮奯 奰奯奩奮奴 奨奡奶奥 奷奥 奭奡奤奥 奩奴 奥奸奰奬奩奣奩奴 奴奨奡奴 奴奨奯女奥 String 奡奲奥 奮奯奮夭奥奭奰奴她央

奆奩奮奡奬奬她夬 奷奥 奮奥奥奤 奴奯 奩奮奩奴奩奡奬奩女奥 奴奨奥 奧奡奭奥 奢她 奰奩奣奫奩奮奧 奡 奷奯奲奤 奡奴 奲奡奮奤奯奭 奦奲奯奭 奡 奬奩女奴 奯奦 奣奡奮奤奩奤奡奴奥女夬 女奥奴奴奩奮奧 奩奴
奡女 奴奨奥 奴奡奲奧奥奴 奵女奩奮奧 NewWord夬 奴奨奥奮 奲奵奮奮奩奮奧 game夺
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runGame : Eff () [MYSTERY NotRunning, RND, SYSTEM, STDIO]
runGame = do srand !time

let w = index !(rndFin _) words
call $ NewWord w
game
putStrLn !(call Get)

套奥 奵女奥 奴奨奥 女她女奴奥奭 奴奩奭奥 夨time 奦奲奯奭 奴奨奥 SYSTEM 奥夛奥奣奴夻 女奥奥 奁奰奰奥奮奤奩奸 Effects Summary 夨姩妡妵 失夳夳天天 奴奯
奩奮奩奴奩奡奬奩女奥 奴奨奥 奲奡奮奤奯奭 奮奵奭奢奥奲 奧奥奮奥奲奡奴奯奲夬 奴奨奥奮 奰奩奣奫 奡 奲奡奮奤奯奭 Fin 奴奯 奩奮奤奥奸 奩奮奴奯 奡 奬奩女奴 奯奦 words央 奆奯奲
奥奸奡奭奰奬奥夬 奷奥 奣奯奵奬奤 奩奮奩奴奩奡奬奩女奥 奡 奷奯奲奤 奬奩女奴 奡女 奦奯奬奬奯奷女夺

words : ?wtype
words = with Vect ["idris","agda","haskell","miranda",

"java","javascript","fortran","basic",
"coffeescript","rust"]

wtype = proof search

注注注解解解: 奒奡奴奨奥奲 奴奨奡奮 奨奡奶奥 奴奯 奥奸奰奬奩奣奩奴奬她 奤奥奣奬奡奲奥 奡 奴她奰奥 奷奩奴奨 奴奨奥 奶奥奣奴奯奲’女 奬奥奮奧奴奨夬 奩奴 奩女 奣奯奮奶奥奮奩奥奮奴 奴奯 奧奩奶奥
奡 奨奯奬奥 ?wtype 奡奮奤 奬奥奴 奉奤奲奩女’女 奰奲奯奯奦 女奥奡奲奣奨 奭奥奣奨奡奮奩女奭 夜奮奤 奴奨奥 奴她奰奥央 奔奨奩女 奩女 奡 奬奩奭奩奴奥奤 奦奯奲奭 奯奦 奴她奰奥
奩奮奦奥奲奥奮奣奥夬 奢奵奴 奶奥奲她 奵女奥奦奵奬 奩奮 奰奲奡奣奴奩奣奥央

奁 奰奯女女奩奢奬奥 奣奯奭奰奬奥奴奥 奩奭奰奬奥奭奥奮奴奡奴奩奯奮 奯奦 game 奩女 奰奲奥女奥奮奴奥奤 奢奥奬奯奷夺

game : Eff () [MYSTERY (Running (S g) w), STDIO]
[MYSTERY NotRunning, STDIO]

game {w=Z} = Won
game {w=S _}

= do putStrLn !Get
putStr "Enter guess: "
let guess = trim !getStr
case choose (not (guess == "")) of

(Left p) => processGuess (strHead' guess p)
(Right p) => do putStrLn "Invalid input!"

game
where
processGuess : Char -> Eff () [MYSTERY (Running (S g) (S w)), STDIO]

[MYSTERY NotRunning, STDIO]
processGuess {g} {w} c

= case !(Main.Guess c) of
True => do putStrLn "Good guess!"

case w of
Z => Won
(S k) => game

False => do putStrLn "No, sorry"
case g of

Z => Lost
(S k) => game

4.6.5 Discussion

套奲奩奴奩奮奧 奴奨奥 奲奵奬奥女 女奥奰奡奲奡奴奥奬她 奡女 奡奮 奥夛奥奣奴夬 奴奨奥奮 奡奮 奩奭奰奬奥奭奥奮奴奡奴奩奯奮 奷奨奩奣奨 奵女奥女 奴奨奡奴 奥夛奥奣奴夬 奥奮女奵奲奥女 奴奨奡奴
奴奨奥 奩奭奰奬奥奭奥奮奴奡奴奩奯奮 奭奵女奴 奦奯奬奬奯奷 奴奨奥 奲奵奬奥女央 奔奨奩女 奨奡女 奰奲奡奣奴奩奣奡奬 奡奰奰奬奩奣奡奴奩奯奮女 奩奮 奭奯奲奥 女奥奲奩奯奵女 奣奯奮奴奥奸奴女夻
MysteryRules 奦奯奲 奥奸奡奭奰奬奥 奣奡奮 奢奥 奴奨奯奵奧奨 奯奦 奡女 奤奥女奣奲奩奢奩奮奧 奡 protocol 奴奨奡奴 奡 奧奡奭奥 奰奬奡她奥奲 奭奯女奴 奦奯奬奬奯奷夬 奯奲
奡奬奴奥奲奮奡奴奩奶奥 奡 precisely-typed API央

奉奮 奰奲奡奣奴奩奣奥夬 奷奥 奷奯奵奬奤奮’奴 奲奥奡奬奬她 奥奸奰奥奣奴 奴奯 奷奲奩奴奥 奲奵奬奥女 夜奲女奴 奴奨奥奮 奩奭奰奬奥奭奥奮奴 奴奨奥 奧奡奭奥 奯奮奣奥 奴奨奥 奲奵奬奥女
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奷奥奲奥 奣奯奭奰奬奥奴奥央 奉奮奤奥奥奤夬 奉 奤奩奤奮’奴 奤奯 女奯 奷奨奥奮 奣奯奮女奴奲奵奣奴奩奮奧 奴奨奩女 奥奸奡奭奰奬奥夡 奒奡奴奨奥奲夬 奉 奷奲奯奴奥 奤奯奷奮 奡 女奥奴
奯奦 奬奩奫奥奬她 奲奵奬奥女 奭奡奫奩奮奧 奡奮她 奡女女奵奭奰奴奩奯奮女 explicit 奩奮 奴奨奥 女奴奡奴奥 奴奲奡奮女奩奴奩奯奮女 奦奯奲 MysteryRules央 奔奨奥奮夬 奷奨奥奮
奩奭奰奬奥奭奥奮奴奩奮奧 game 奡奴 夜奲女奴夬 奡奮她 奩奮奣奯奲奲奥奣奴 奡女女奵奭奰奴奩奯奮 奷奡女 奣奡奵奧奨奴 奡女 奡 奴她奰奥 奥奲奲奯奲央 奔奨奥 奦奯奬奬奯奷奩奮奧 奥奲奲奯奲女
奷奥奲奥 奣奡奵奧奨奴 奤奵奲奩奮奧 奤奥奶奥奬奯奰奭奥奮奴夺

• 奎奯奴 奲奥奡奬奩女奩奮奧 奴奨奡奴 奡奬奬奯奷奩奮奧 NewWord 奴奯 奢奥 奡奮 奡奲奢奩奴奲奡奲她 女奴奲奩奮奧 奷奯奵奬奤 奭奥奡奮 奴奨奡奴 game 奷奯奵奬奤 奨奡奶奥
奴奯 奤奥奡奬 奷奩奴奨 奡 奺奥奲奯夭奬奥奮奧奴奨 奷奯奲奤 奡女 奡 女奴奡奲奴奩奮奧 女奴奡奴奥央

• 奆奯奲奧奥奴奴奩奮奧 奴奯 奣奨奥奣奫 奷奨奥奴奨奥奲 奡 奧奡奭奥 奷奡女 奷奯奮 奢奥奦奯奲奥 奲奥奣奵奲女奩奶奥奬她 奣奡奬奬奩奮奧 processGuess夬 奴奨奵女 奡奣奣奩夭
奤奥奮奴奡奬奬她 奣奯奮奴奩奮奵奩奮奧 奡 夜奮奩女奨奥奤 奧奡奭奥央

• 奁奣奣奩奤奥奮奴奡奬奬她 奣奨奥奣奫奩奮奧 奴奨奥 奮奵奭奢奥奲 奯奦 奭奩女女奩奮奧 奬奥奴奴奥奲女夬 奲奡奴奨奥奲 奴奨奡奮 奴奨奥 奮奵奭奢奥奲 奯奦 奲奥奭奡奩奮奩奮奧 奧奵奥女女奥女夬
奷奨奥奮 奣奨奥奣奫奩奮奧 奩奦 奡 奧奡奭奥 奷奡女 奬奯女奴央

奔奨奥女奥 奡奲奥夬 奯奦 奣奯奵奲女奥夬 女奩奭奰奬奥 奥奲奲奯奲女夬 奢奵奴 奷奥奲奥 奣奡奵奧奨奴 奢她 奴奨奥 奴她奰奥 奣奨奥奣奫奥奲 奢奥奦奯奲奥 奡奮她 奴奥女奴奩奮奧 奯奦 奴奨奥 奧奡奭奥央

4.7 Further Reading

奔奨奩女 奴奵奴奯奲奩奡奬 奨奡女 奧奩奶奥奮 奡奮 奩奮奴奲奯奤奵奣奴奩奯奮 奴奯 奷奲奩奴奩奮奧 奡奮奤 奲奥奡女奯奮奩奮奧 奡奢奯奵奴 女奩奤奥夭奥夛奥奣奴奩奮奧 奰奲奯奧奲奡奭女 奩奮 奉奤奲奩女夬
奵女奩奮奧 奴奨奥 Effects 奬奩奢奲奡奲她央 奍奯奲奥 奤奥奴奡奩奬女 奡奢奯奵奴 奴奨奥 implementation 奯奦 奴奨奥 奬奩奢奲奡奲她夬 女奵奣奨 奡女 奨奯奷 run 奷奯奲奫女夬
奨奯奷 奨奡奮奤奬奥奲女 奡奲奥 奩奮奶奯奫奥奤夬 奥奴奣夬 奡奲奥 奧奩奶奥奮 奩奮 奡 女奥奰奡奲奡奴奥 奰奡奰奥奲1央

奓奯奭奥 奬奩奢奲奡奲奩奥女 奡奮奤 奰奲奯奧奲奡奭女 奷奨奩奣奨 奵女奥 Effects 奣奡奮 奢奥 奦奯奵奮奤 奩奮 奴奨奥 奦奯奬奬奯奷奩奮奧 奰奬奡奣奥女夺

• 奨奴奴奰女夺夯夯奧奩奴奨奵奢央奣奯奭夯奥奤奷奩奮奢夯奓奄奌夭奩奤奲奩女 — 女奯奭奥 奢奩奮奤奩奮奧女 奦奯奲 奴奨奥 奓奄奌 奭奥奤奩奡 奬奩奢奲奡奲她夬 女奵奰奰奯奲奴奩奮奧
奧奲奡奰奨奩奣女 奩奮 奰奡奲奴奩奣奵奬奡奲央

• 奨奴奴奰女夺夯夯奧奩奴奨奵奢央奣奯奭夯奥奤奷奩奮奢夯奩奤奲奩女夭奤奥奭奯女 — 奶奡奲奩奯奵女 奤奥奭奯奮女奴奲奡奴奩奯奮 奰奲奯奧奲奡奭女夬 奩奮奣奬奵奤奩奮奧 女奥奶奥奲奡奬 奥奸夭
奡奭奰奬奥女 奦奲奯奭 奴奨奩女 奴奵奴奯奲奩奡奬夬 奡奮奤 奡 “奓奰奡奣奥 奉奮奶奡奤奥奲女” 奧奡奭奥央

• 奨奴奴奰女夺夯夯奧奩奴奨奵奢央奣奯奭夯奓奩奭奯奮奊奆夯奉奤奲奩女奎奥奴夲 — 奮奥奴奷奯奲奫奩奮奧 奡奮奤 女奯奣奫奥奴 奬奩奢奲奡奲奩奥女央

• 奨奴奴奰女夺夯夯奧奩奴奨奵奢央奣奯奭夯奥奤奷奩奮奢夯奐奲奯奴奯奣奯奬女 — 奡 奨奩奧奨 奬奥奶奥奬 奣奯奭奭奵奮奩奣奡奴奩奯奮 奰奲奯奴奯奣奯奬 奤奥女奣奲奩奰奴奩奯奮 奬奡奮夭
奧奵奡奧奥央

奔奨奥 奩奮女奰奩奲奡奴奩奯奮 奦奯奲 奴奨奥 Effects 奬奩奢奲奡奲她 奷奡女 奂奡奵奥奲 奡奮奤 奐奲奥奴奮奡奲’女 奅夛 奬奡奮奧奵奡奧奥2夬 奷奨奩奣奨 奤奥女奣奲奩奢奥女 奡
奬奡奮奧奵奡奧奥 奢奡女奥奤 奯奮 奡奬奧奥奢奲奡奩奣 奥夛奥奣奴女 奡奮奤 奨奡奮奤奬奥奲女央 奏奴奨奥奲 奲奥奣奥奮奴 奬奡奮奧奵奡奧奥女 奡奮奤 奬奩奢奲奡奲奩奥女 奨奡奶奥 奡奬女奯 奢奥奥奮
奢奵奩奬奴 奯奮 奴奨奩女 奩奤奥奡女夬 奦奯奲 奥奸奡奭奰奬奥3 奡奮奤4央 奔奨奥 奴奨奥奯奲奥奴奩奣奡奬 奦奯奵奮奤奡奴奩奯奮女 奡奲奥 奡奬女奯 奷奥奬奬夭女奴奵奤奩奥奤 女奥奥5夬6夬7夬8央

1 Edwin Brady. 2013. Programming and reasoning with algebraic effects and dependent types. SIGPLAN Not. 48, 9
(September 2013), 133-144. DOI=10.1145/2544174.2500581 https://dl.acm.org/citation.cfm?doid=2544174.2500581

2 Andrej Bauer, Matija Pretnar, Programming with algebraic effects and handlers, Journal of Logical and Algebraic
Methods in Programming, Volume 84, Issue 1, January 2015, Pages 108-123, ISSN 2352-2208, http://math.andrej.com/
wp-content/uploads/2012/03/eff.pdf

3 Ben Lippmeier. 2009. Witnessing Purity, Constancy and Mutability. In Proceedings of the 7th Asian Symposium on
Programming Languages and Systems (APLAS ‘09), Zhenjiang Hu (Ed.). Springer-Verlag, Berlin, Heidelberg, 95-110.
DOI=10.1007/978-3-642-10672-9_9 http://link.springer.com/chapter/10.1007%2F978-3-642-10672-9_9

4 Ohad Kammar, Sam Lindley, and Nicolas Oury. 2013. Handlers in action. SIGPLAN Not. 48, 9 (September 2013),
145-158. DOI=10.1145/2544174.2500590 https://dl.acm.org/citation.cfm?doid=2544174.2500590

5 Martin Hyland, Gordon Plotkin, John Power, Combining effects: Sum and tensor, Theoretical Computer Science,
Volume 357, Issues 1–3, 25 July 2006, Pages 70-99, ISSN 0304-3975, (https://www.sciencedirect.com/science/article/pii/
S0304397506002659)

6 Paul Blain Levy. 2004. Call-By-Push-Value: A Functional/Imperative Synthesis (Semantics Structures in Computa-
tion, V. 2). Kluwer Academic Publishers, Norwell, MA, USA.

7 Plotkin, Gordon, and Matija Pretnar. “Handlers of algebraic effects.” Programming Languages and Systems.
Springer Berlin Heidelberg, 2009. 80-94.

8 Pretnar, Matija. “Logic and handling of algebraic effects.” (2010).
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4.8 Effects Summary

奔奨奩女 奡奰奰奥奮奤奩奸 奧奩奶奥女 奩奮奴奥奲奦奡奣奥女 奦奯奲 奴奨奥 奣奯奲奥 奥夛奥奣奴女 奰奲奯奶奩奤奥奤 奢她 奴奨奥 奬奩奢奲奡奲她央

4.8.1 EXCEPTION

module Effect.Exception

import Effects
import System
import Control.IOExcept

EXCEPTION : Type -> EFFECT

raise : a -> Eff b [EXCEPTION a]

Handler (Exception a) Maybe where { ... }
Handler (Exception a) List where { ... }
Handler (Exception a) (Either a) where { ... }
Handler (Exception a) (IOExcept a) where { ... }
Show a => Handler (Exception a) IO where { ... }

4.8.2 FILE_IO

module Effect.File

import Effects
import Control.IOExcept

FILE_IO : Type -> EFFECT

data OpenFile : Mode -> Type

open : (fname : String)
-> (m : Mode)
-> Eff Bool [FILE_IO ()]

(\res => [FILE_IO (case res of
True => OpenFile m
False => ())])

close : Eff () [FILE_IO (OpenFile m)] [FILE_IO ()]

readLine : Eff String [FILE_IO (OpenFile Read)]
writeLine : String -> Eff () [FILE_IO (OpenFile Write)]
eof : Eff Bool [FILE_IO (OpenFile Read)]

Handler FileIO IO where { ... }

4.8.3 RND

module Effect.Random

import Effects
import Data.Vect
import Data.Fin

(äÿŃéąțçżğçżŋ)
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RND : EFFECT

srand : Integer -> Eff m () [RND]
rndInt : Integer -> Integer -> Eff m Integer [RND]
rndFin : (k : Nat) -> Eff m (Fin (S k)) [RND]

Handler Random m where { ... }

4.8.4 SELECT

module Effect.Select

import Effects

SELECT : EFFECT

select : List a -> Eff m a [SELECT]

Handler Selection Maybe where { ... }
Handler Selection List where { ... }

4.8.5 STATE

module Effect.State

import Effects

STATE : Type -> EFFECT

get : Eff m x [STATE x]
put : x -> Eff m () [STATE x]
putM : y -> Eff m () [STATE x] [STATE y]
update : (x -> x) -> Eff m () [STATE x]

Handler State m where { ... }

4.8.6 STDIO

module Effect.StdIO

import Effects
import Control.IOExcept

STDIO : EFFECT

putChar : Handler StdIO m => Char -> Eff m () [STDIO]
putStr : Handler StdIO m => String -> Eff m () [STDIO]
putStrLn : Handler StdIO m => String -> Eff m () [STDIO]

getStr : Handler StdIO m => Eff m String [STDIO]
getChar : Handler StdIO m => Eff m Char [STDIO]

(äÿŃéąțçżğçżŋ)
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Handler StdIO IO where { ... }
Handler StdIO (IOExcept a) where { ... }

4.8.7 SYSTEM

module Effect.System

import Effects
import System
import Control.IOExcept

SYSTEM : EFFECT

getArgs : Handler System e => Eff e (List String) [SYSTEM]
time : Handler System e => Eff e Int [SYSTEM]
getEnv : Handler System e => String -> Eff e (Maybe String) [SYSTEM]

Handler System IO where { ... }
Handler System (IOExcept a) where { ... }
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CHAPTER 5

Theorem Proving

奁 奴奵奴奯奲奩奡奬 奯奮 奴奨奥奯奲奥奭 奰奲奯奶奩奮奧 奩奮 奉奤奲奩女央

注注注解解解: 奔奨奥 奤奯奣奵奭奥奮奴奡奴奩奯奮 奦奯奲 奉奤奲奩女 奨奡女 奢奥奥奮 奰奵奢奬奩女奨奥奤 奵奮奤奥奲 奴奨奥 奃奲奥奡奴奩奶奥 奃奯奭奭奯奮女 奃奃夰 奌奩奣奥奮女奥央 奁女
女奵奣奨 奴奯 奴奨奥 奥奸奴奥奮奴 奰奯女女奩奢奬奥 奵奮奤奥奲 奬奡奷夬 The Idris Community 奨奡女 奷奡奩奶奥奤 奡奬奬 奣奯奰她奲奩奧奨奴 奡奮奤 奲奥奬奡奴奥奤 奯奲
奮奥奩奧奨奢奯奲奩奮奧 奲奩奧奨奴女 奴奯 奄奯奣奵奭奥奮奴奡奴奩奯奮 奦奯奲 奉奤奲奩女央

奍奯奲奥 奩奮奦奯奲奭奡奴奩奯奮 奣奯奮奣奥奲奮奩奮奧 奴奨奥 奃奃夰 奣奡奮 奢奥 奦奯奵奮奤 奯奮奬奩奮奥 奡奴夺 奨奴奴奰夺夯夯奣奲奥奡奴奩奶奥奣奯奭奭奯奮女央奯奲奧夯
奰奵奢奬奩奣奤奯奭奡奩奮夯奺奥奲奯夯失央夰夯

5.1 Running example: Addition of Natural Numbers

奔奨奲奯奵奧奨奯奵奴 奴奨奩女 奴奵奴奯奲奩奡奬夬 奷奥 奷奩奬奬 奢奥 奷奯奲奫奩奮奧 奷奩奴奨 奴奨奥 奦奯奬奬奯奷奩奮奧 奦奵奮奣奴奩奯奮夬 奤奥夜奮奥奤 奩奮 奴奨奥 奉奤奲奩女 奰奲奥奬奵奤奥夬
奷奨奩奣奨 奤奥夜奮奥女 奡奤奤奩奴奩奯奮 奯奮 奮奡奴奵奲奡奬 奮奵奭奢奥奲女夺

plus : Nat -> Nat -> Nat
plus Z m = m
plus (S k) m = S (plus k m)

奉奴 奩女 奤奥夜奮奥奤 奢她 奴奨奥 奡奢奯奶奥 奥奱奵奡奴奩奯奮女夬 奭奥奡奮奩奮奧 奴奨奡奴 奷奥 奨奡奶奥 奦奯奲 奦奲奥奥 奴奨奥 奰奲奯奰奥奲奴奩奥女 奴奨奡奴 奡奤奤奩奮奧 m 奴奯 奺奥奲奯
奡奬奷奡她女 奲奥女奵奬奴女 奩奮 m夬 奡奮奤 奴奨奡奴 奡奤奤奩奮奧 m 奴奯 奡奮她 奮奯奮夭奺奥奲奯 奮奵奭奢奥奲 S k 奡奬奷奡她女 奲奥女奵奬奴女 奩奮 S (plus k m)央 套奥
奣奡奮 女奥奥 奴奨奩女 奢她 奥奶奡奬奵奡奴奩奯奮 奡奴 奴奨奥 奉奤奲奩女 奒奅奐奌 夨奩央奥央 奴奨奥 奰奲奯奭奰奴夬 奴奨奥 奲奥奡奤夭奥奶奡奬夭奰奲奩奮奴 奬奯奯奰天夺

Idris> \m => plus Z m
\m => m : Nat -> Nat

Idris> \k,m => plus (S k) m
\k => \m => S (plus k m) : Nat -> Nat -> Nat

奎奯奴奥 奴奨奡奴 奵奮奬奩奫奥 奭奡奮她 奯奴奨奥奲 奬奡奮奧奵奡奧奥 奒奅奐奌女夬 奴奨奥 奉奤奲奩女 奒奅奐奌 奰奥奲奦奯奲奭女 奥奶奡奬奵奡奴奩奯奮 奯奮 open 奴奥奲奭女夬
奭奥奡奮奩奮奧 奴奨奡奴 奩奴 奣奡奮 奲奥奤奵奣奥 奴奥奲奭女 奷奨奩奣奨 奡奰奰奥奡奲 奩奮女奩奤奥 奬奡奭奢奤奡 奢奩奮奤奩奮奧女夬 奬奩奫奥 奴奨奯女奥 奡奢奯奶奥央 奔奨奥奲奥奦奯奲奥夬 奷奥
奣奡奮 奩奮奴奲奯奤奵奣奥 奵奮奫奮奯奷奮女 k 奡奮奤 m 奡女 奬奡奭奢奤奡 奢奩奮奤奩奮奧女 奡奮奤 女奥奥 奨奯奷 plus 奲奥奤奵奣奥女央

失夳夶
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http://creativecommons.org/publicdomain/zero/1.0/


Idris 语语语言言言文文文档档档, 版版版本本本 1.3.1

奔奨奥 plus 奦奵奮奣奴奩奯奮 奨奡女 奡 奮奵奭奢奥奲 奯奦 奯奴奨奥奲 奵女奥奦奵奬 奰奲奯奰奥奲奴奩奥女夬 奦奯奲 奥奸奡奭奰奬奥夺

• 奉奴 奩女 commutative夬 奴奨奡奴 奩女 奦奯奲 奡奬奬 Nat 奩奮奰奵奴女 n 奡奮奤 m夬 奷奥 奫奮奯奷 奴奨奡奴 plus n m = plus m n央

• 奉奴 奩女 associative夬 奴奨奡奴 奩女 奦奯奲 奡奬奬 Nat 奩奮奰奵奴女 n夬 m 奡奮奤 p夬 奷奥 奫奮奯奷 奴奨奡奴 plus n (plus m p) = plus
(plus m n) p央

套奥 奣奡奮 奵女奥 奴奨奥女奥 奰奲奯奰奥奲奴奩奥女 奩奮 奡奮 奉奤奲奩女 奰奲奯奧奲奡奭夬 奢奵奴 奩奮 奯奲奤奥奲 奴奯 奤奯 女奯 奷奥 奭奵女奴 prove 奴奨奥奭央

5.1.1 Equality Proofs

奉奤奲奩女 奨奡女 奡 奢奵奩奬奴夭奩奮 奰奲奯奰奯女奩奴奩奯奮奡奬 奥奱奵奡奬奩奴她 奴她奰奥夬 奣奯奮奣奥奰奴奵奡奬奬她 奤奥夜奮奥奤 奡女 奦奯奬奬奯奷女夺

data (=) : a -> b -> Type where
Refl : x = x

奎奯奴奥 奴奨奡奴 奴奨奩女 奭奵女奴 奢奥 奢奵奩奬奴夭奩奮夬 奲奡奴奨奥奲 奴奨奡奮 奤奥夜奮奥奤 奩奮 奴奨奥 奬奩奢奲奡奲她夬 奢奥奣奡奵女奥 = 奩女 奡 奲奥女奥奲奶奥奤 奯奰奥奲奡奴奯奲 —
她奯奵 奣奡奮奮奯奴 奤奥夜奮奥 奴奨奩女 奤奩奲奥奣奴奬她 奩奮 她奯奵奲 奯奷奮 奣奯奤奥央

奉奴 奩女 propositional 奥奱奵奡奬奩奴她夬 奷奨奥奲奥 奴奨奥 奴她奰奥 女奴奡奴奥女 奴奨奡奴 奡奮她 奴奷奯 奶奡奬奵奥女 奩奮 奤奩夛奥奲奥奮奴 奴她奰奥女 a 奡奮奤 b 奭奡她 奢奥
奰奲奯奰奯女奥奤 奴奯 奢奥 奥奱奵奡奬央 奔奨奥奲奥 奩女 奯奮奬她 奯奮奥 奷奡她 奴奯 prove 奥奱奵奡奬奩奴她夬 奨奯奷奥奶奥奲夬 奷奨奩奣奨 奩女 奢她 奲奥夝奥奸奩奶奩奴她 夨Refl天央

套奥 奨奡奶奥 奡 type 奦奯奲 奰奲奯奰奯女奩奴奩奯奮奡奬 奥奱奵奡奬奩奴她 奨奥奲奥夬 奡奮奤 奣奯奲奲奥女奰奯奮奤奩奮奧奬她 奡 program 奩奮奨奡奢奩奴奩奮奧 奡奮 奩奮女奴奡奮奣奥
奯奦 奴奨奩女 奴她奰奥 奣奡奮 奢奥 女奥奥奮 奡女 奡 奰奲奯奯奦 奯奦 奴奨奥 奣奯奲奲奥女奰奯奮奤奩奮奧 奰奲奯奰奯女奩奴奩奯奮1央 奓奯夬 奴奲奩奶奩奡奬奬她夬 奷奥 奣奡奮 奰奲奯奶奥 奴奨奡奴 4
奥奱奵奡奬女 4夺

four_eq : 4 = 4
four_eq = Refl

奈奯奷奥奶奥奲夬 奴奲她奩奮奧 奴奯 奰奲奯奶奥 奴奨奡奴 4 = 5 奲奥女奵奬奴女 奩奮 奦奡奩奬奵奲奥夺

four_eq_five : 4 = 5
four_eq_five = Refl

奔奨奥 奴她奰奥 4 = 5 奩女 奡 奰奥奲奦奥奣奴奬她 奶奡奬奩奤 奴她奰奥夬 奢奵奴 奩女 奵奮奩奮奨奡奢奩奴奥奤夬 女奯 奷奨奥奮 奴奲她奩奮奧 奴奯 奴她奰奥 奣奨奥奣奫 奴奨奩女 奤奥夜奮奩奴奩奯奮夬
奉奤奲奩女 奧奩奶奥女 奴奨奥 奦奯奬奬奯奷奩奮奧 奥奲奲奯奲夺

When elaborating right hand side of four_eq_five:
Type mismatch between

x = x (Type of Refl)
and

4 = 5 (Expected type)

Type checking equality proofs

奁奮 奩奭奰奯奲奴奡奮奴 女奴奥奰 奩奮 奴她奰奥 奣奨奥奣奫奩奮奧 奉奤奲奩女 奰奲奯奧奲奡奭女 奩女 unification夬 奷奨奩奣奨 奡奴奴奥奭奰奴女 奴奯 奲奥女奯奬奶奥 奩奭奰奬奩奣奩奴
奡奲奧奵奭奥奮奴女 女奵奣奨 奡女 奴奨奥 奩奭奰奬奩奣奩奴 奡奲奧奵奭奥奮奴 x 奩奮 Refl央 奁女 奦奡奲 奡女 奯奵奲 奵奮奤奥奲女奴奡奮奤奩奮奧 奯奦 奴她奰奥 奣奨奥奣奫奩奮奧 奰奲奯奯奦女
奩女 奣奯奮奣奥奲奮奥奤夬 奩奴 女奵夞奣奥女 奴奯 奫奮奯奷 奴奨奡奴 奵奮奩奦她奩奮奧 奴奷奯 奴奥奲奭女 奩奮奶奯奬奶奥女 奲奥奤奵奣奩奮奧 奢奯奴奨 奴奯 奮奯奲奭奡奬 奦奯奲奭 奴奨奥奮
奴奲她奩奮奧 奴奯 夜奮奤 奡奮 奡女女奩奧奮奭奥奮奴 奴奯 奩奭奰奬奩奣奩奴 奡奲奧奵奭奥奮奴女 奷奨奩奣奨 奷奩奬奬 奭奡奫奥 奴奨奯女奥 奮奯奲奭奡奬 奦奯奲奭女 奥奱奵奡奬央

套奨奥奮 奴她奰奥 奣奨奥奣奫奩奮奧 Refl夬 奉奤奲奩女 奲奥奱奵奩奲奥女 奴奨奡奴 奴奨奥 奴她奰奥 奩女 奯奦 奴奨奥 奦奯奲奭 x = x夬 奡女 奷奥 女奥奥 奦奲奯奭 奴奨奥 奴她奰奥
奯奦 Refl央 奉奮 奴奨奥 奣奡女奥 奯奦 four_eq_five夬 奉奤奲奩女 奷奩奬奬 奴奲她 奴奯 奵奮奩奦她 奴奨奥 奥奸奰奥奣奴奥奤 奴她奰奥 4 = 5 奷奩奴奨 奴奨奥 奴她奰奥 奯奦
Refl夬 x = x夬 奮奯奴奩奣奥 奴奨奡奴 奡 女奯奬奵奴奩奯奮 奲奥奱奵奩奲奥女 奴奨奡奴 x 奢奥 奢奯奴奨 4 奡奮奤 5夬 奡奮奤 奴奨奥奲奥奦奯奲奥 奦奡奩奬央

奓奩奮奣奥 奴她奰奥 奣奨奥奣奫奩奮奧 奩奮奶奯奬奶奥女 奲奥奤奵奣奴奩奯奮 奴奯 奮奯奲奭奡奬 奦奯奲奭夬 奷奥 奣奡奮 奷奲奩奴奥 奴奨奥 奦奯奬奬奯奷奩奮奧 奥奱奵奡奬奩奴奩奥女 奤奩奲奥奣奴奬她夺
1 This is known as the Curry-Howard correspondence.
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twoplustwo_eq_four : 2 + 2 = 4
twoplustwo_eq_four = Refl

plus_reduces_Z : (m : Nat) -> plus Z m = m
plus_reduces_Z m = Refl

plus_reduces_Sk : (k, m : Nat) -> plus (S k) m = S (plus k m)
plus_reduces_Sk k m = Refl

5.1.2 Heterogeneous Equality

奅奱奵奡奬奩奴她 奩奮 奉奤奲奩女 奩女 heterogeneous夬 奭奥奡奮奩奮奧 奴奨奡奴 奷奥 奣奡奮 奥奶奥奮 奰奲奯奰奯女奥 奥奱奵奡奬奩奴奩奥女 奢奥奴奷奥奥奮 奶奡奬奵奥女 奩奮 奤奩夛奥奲奥奮奴
奴她奰奥女夺

idris_not_php : 2 = "2"

奏奢奶奩奯奵女奬她夬 奩奮 奉奤奲奩女 奴奨奥 奴她奰奥 2 = "2" 奩女 奵奮奩奮奨奡奢奩奴奥奤夬 奡奮奤 奯奮奥 奭奩奧奨奴 奷奯奮奤奥奲 奷奨她 奩奴 奩女 奵女奥奦奵奬 奴奯 奢奥 奡奢奬奥
奴奯 奰奲奯奰奯女奥 奥奱奵奡奬奩奴奩奥女 奢奥奴奷奥奥奮 奶奡奬奵奥女 奩奮 奤奩夛奥奲奥奮奴 奴她奰奥女央 奈奯奷奥奶奥奲夬 奷奩奴奨 奤奥奰奥奮奤奥奮奴 奴她奰奥女夬 女奵奣奨 奥奱奵奡奬奩奴奩奥女
奣奡奮 奡奲奩女奥 奮奡奴奵奲奡奬奬她央 奆奯奲 奥奸奡奭奰奬奥夬 奩奦 奴奷奯 奶奥奣奴奯奲女 奡奲奥 奥奱奵奡奬夬 奴奨奥奩奲 奬奥奮奧奴奨女 奭奵女奴 奢奥 奥奱奵奡奬夺

vect_eq_length : (xs : Vect n a) -> (ys : Vect m a) ->
(xs = ys) -> n = m

奉奮 奴奨奥 奡奢奯奶奥 奤奥奣奬奡奲奡奴奩奯奮夬 xs 奡奮奤 ys 奨奡奶奥 奤奩夛奥奲奥奮奴 奴她奰奥女 奢奥奣奡奵女奥 奴奨奥奩奲 奬奥奮奧奴奨女 奡奲奥 奤奩夛奥奲奥奮奴夬 奢奵奴 奷奥
奷奯奵奬奤 女奴奩奬奬 奬奩奫奥 奴奯 奤奲奡奷 奡 奣奯奮奣奬奵女奩奯奮 奡奢奯奵奴 奴奨奥 奬奥奮奧奴奨女 奩奦 奴奨奥她 奨奡奰奰奥奮 奴奯 奢奥 奥奱奵奡奬央 套奥 奣奡奮 奤奥夜奮奥
vect_eq_length 奡女 奦奯奬奬奯奷女夺

vect_eq_length xs xs Refl = Refl

奂她 奭奡奴奣奨奩奮奧 奯奮 Refl 奦奯奲 奴奨奥 奴奨奩奲奤 奡奲奧奵奭奥奮奴夬 奷奥 奫奮奯奷 奴奨奡奴 奴奨奥 奯奮奬她 奶奡奬奩奤 奶奡奬奵奥 奦奯奲 ys 奩女 xs夬 奢奥奣奡奵女奥
奴奨奥她 奭奵女奴 奢奥 奥奱奵奡奬夬 奡奮奤 奴奨奥奲奥奦奯奲奥 奴奨奥奩奲 奴她奰奥女 奭奵女奴 奢奥 奥奱奵奡奬夬 女奯 奴奨奥 奬奥奮奧奴奨女 奭奵女奴 奢奥 奥奱奵奡奬央

奁奬奴奥奲奮奡奴奩奶奥奬她夬 奷奥 奣奡奮 奰奵奴 奡奮 奵奮奤奥奲女奣奯奲奥 奦奯奲 奴奨奥 女奥奣奯奮奤 xs夬 女奩奮奣奥 奴奨奥奲奥 奩女 奯奮奬她 奯奮奥 奶奡奬奵奥 奷奨奩奣奨 奷奩奬奬 奴她奰奥
奣奨奥奣奫夺

vect_eq_length xs _ Refl = Refl

5.1.3 Properties of plus

奕女奩奮奧 奴奨奥 (=) 奴她奰奥夬 奷奥 奣奡奮 奮奯奷 女奴奡奴奥 奴奨奥 奰奲奯奰奥奲奴奩奥女 奯奦 plus 奧奩奶奥奮 奡奢奯奶奥 奡女 奉奤奲奩女 奴她奰奥 奤奥奣奬奡奲奡奴奩奯奮女夺

plus_commutes : (n, m : Nat) -> plus n m = plus m n
plus_assoc : (n, m, p : Nat) -> plus n (plus m p) = plus (plus n m) p

奂奯奴奨 奯奦 奴奨奥女奥 奰奲奯奰奥奲奴奩奥女 夨奡奮奤 奭奡奮她 奯奴奨奥奲女天 奡奲奥 奰奲奯奶奥奤 奦奯奲 奮奡奴奵奲奡奬 奮奵奭奢奥奲 奡奤奤奩奴奩奯奮 奩奮 奴奨奥 奉奤奲奩女 女奴奡奮夭
奤奡奲奤 奬奩奢奲奡奲她夬 奵女奩奮奧 (+) 奦奲奯奭 奴奨奥 Num 奩奮奴奥奲奦奡奣奥 奲奡奴奨奥奲 奴奨奡奮 奵女奩奮奧 plus 奤奩奲奥奣奴奬她央 奔奨奥她 奨奡奶奥 奴奨奥 奮奡奭奥女
plusCommutative 奡奮奤 plusAssociative 奲奥女奰奥奣奴奩奶奥奬她央

奉奮 奴奨奥 奲奥奭奡奩奮奤奥奲 奯奦 奴奨奩女 奴奵奴奯奲奩奡奬夬 奷奥 奷奩奬奬 奥奸奰奬奯奲奥 女奥奶奥奲奡奬 奤奩夛奥奲奥奮奴 奷奡她女 奯奦 奰奲奯奶奩奮奧 plus_commutes 夨奯奲夬
奴奯 奰奵奴 奩奴 奡奮奯奴奨奥奲 奷奡她夬 奷奲奩奴奩奮奧 奴奨奥 奦奵奮奣奴奩奯奮央天 套奥 奷奩奬奬 奡奬女奯 奤奩女奣奵女女 奨奯奷 奴奯 奵女奥 女奵奣奨 奥奱奵奡奬奩奴她 奰奲奯奯奦女夬 奡奮奤
女奥奥 奷奨奥奲奥 奴奨奥 奮奥奥奤 奦奯奲 奴奨奥奭 奡奲奩女奥女 奩奮 奰奲奡奣奴奩奣奥央
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5.2 Inductive Proofs

奂奥奦奯奲奥 奥奭奢奡奲奫奩奮奧 奯奮 奰奲奯奶奩奮奧 plus_commutes 奩奮 奉奤奲奩女 奩奴女奥奬奦夬 奬奥奴 奵女 奣奯奮女奩奤奥奲 奴奨奥 奯奶奥奲奡奬奬 女奴奲奵奣奴奵奲奥 奯奦 奡
奰奲奯奯奦 奯奦 女奯奭奥 奰奲奯奰奥奲奴她 奯奦 奮奡奴奵奲奡奬 奮奵奭奢奥奲女央 奒奥奣奡奬奬 奴奨奡奴 奴奨奥她 奡奲奥 奤奥夜奮奥奤 奲奥奣奵奲女奩奶奥奬她夬 奡女 奦奯奬奬奯奷女夺

data Nat : Type where
Z : Nat
S : Nat -> Nat

奁 total 奦奵奮奣奴奩奯奮 奯奶奥奲 奮奡奴奵奲奡奬 奮奵奭奢奥奲女 奭奵女奴 奢奯奴奨 奴奥奲奭奩奮奡奴奥夬 奡奮奤 奣奯奶奥奲 奡奬奬 奰奯女女奩奢奬奥 奩奮奰奵奴女央 奉奤奲奩女 奣奨奥奣奫女
奦奵奮奣奴奩奯奮女 奦奯奲 奴奯奴奡奬奩奴她 奢她 奣奨奥奣奫奩奮奧 奴奨奡奴 奡奬奬 奩奮奰奵奴女 奡奲奥 奣奯奶奥奲奥奤夬 奡奮奤 奴奨奡奴 奡奬奬 奲奥奣奵奲女奩奶奥 奣奡奬奬女 奡奲奥 奯奮 structurally
smaller 奶奡奬奵奥女 夨女奯 奲奥奣奵奲女奩奯奮 奷奩奬奬 奡奬奷奡她女 奲奥奡奣奨 奡 奢奡女奥 奣奡女奥天央 奒奥奣奡奬奬奩奮奧 plus夺

plus : Nat -> Nat -> Nat
plus Z m = m
plus (S k) m = S (plus k m)

奔奨奩女 奩女 奴奯奴奡奬 奢奥奣奡奵女奥 奩奴 奣奯奶奥奲女 奡奬奬 奰奯女女奩奢奬奥 奩奮奰奵奴女 夨奴奨奥 夜奲女奴 奡奲奧奵奭奥奮奴 奣奡奮 奯奮奬她 奢奥 Z 奯奲 S k 奦奯奲 女奯奭奥 k夬
奡奮奤 奴奨奥 女奥奣奯奮奤 奡奲奧奵奭奥奮奴 m 奣奯奶奥奲女 奡奬奬 奰奯女女奩奢奬奥 Nat天 奡奮奤 奩奮 奴奨奥 奲奥奣奵奲女奩奶奥 奣奡奬奬夬 k 奩女 女奴奲奵奣奴奵奲奡奬奬她 女奭奡奬奬奥奲
奴奨奡奮 S k 女奯 奴奨奥 夜奲女奴 奡奲奧奵奭奥奮奴 奷奩奬奬 奡奬奷奡她女 奲奥奡奣奨 奴奨奥 奢奡女奥 奣奡女奥 Z 奩奮 奡奮她 女奥奱奵奥奮奣奥 奯奦 奲奥奣奵奲女奩奶奥 奣奡奬奬女央

奉奮 女奯奭奥 女奥奮女奥夬 奴奨奩女 奲奥女奥奭奢奬奥女 奡 奭奡奴奨奥奭奡奴奩奣奡奬 奰奲奯奯奦 奢她 奩奮奤奵奣奴奩奯奮 夨奡奮奤 奴奨奩女 奩女 奮奯 奣奯奩奮奣奩奤奥奮奣奥夡天央 奆奯奲 女奯奭奥
奰奲奯奰奥奲奴她 P 奯奦 奡 奮奡奴奵奲奡奬 奮奵奭奢奥奲 x夬 奷奥 奣奡奮 女奨奯奷 奴奨奡奴 P 奨奯奬奤女 奦奯奲 奡奬奬 x 奩奦夺

• P 奨奯奬奤女 奦奯奲 奺奥奲奯 夨奴奨奥 奢奡女奥 奣奡女奥天央

• 奁女女奵奭奩奮奧 奴奨奡奴 P 奨奯奬奤女 奦奯奲 k夬 奷奥 奣奡奮 女奨奯奷 P 奡奬女奯 奨奯奬奤女 奦奯奲 S k 夨奴奨奥 奩奮奤奵奣奴奩奶奥 女奴奥奰天央

奉奮 plus夬 奴奨奥 奰奲奯奰奥奲奴她 奷奥 奡奲奥 奴奲她奩奮奧 奴奯 女奨奯奷 奩女 女奯奭奥奷奨奡奴 奴奲奩奶奩奡奬 夨奦奯奲 奡奬奬 奮奡奴奵奲奡奬 奮奵奭奢奥奲女 x夬 奴奨奥奲奥 奩女
奡 Nat 奷奨奩奣奨 奮奥奥奤 奮奯奴 奨奡奶奥 奡奮她 奲奥奬奡奴奩奯奮 奴奯 x天央 奈奯奷奥奶奥奲夬 奩奴 女奴奩奬奬 奴奡奫奥女 奴奨奥 奦奯奲奭 奯奦 奡 奢奡女奥 奣奡女奥 奡奮奤 奡奮
奩奮奤奵奣奴奩奶奥 女奴奥奰央 奉奮 奴奨奥 奢奡女奥 奣奡女奥夬 奷奥 女奨奯奷 奴奨奡奴 奴奨奥奲奥 奩女 奡 Nat 奡奲奩女奩奮奧 奦奲奯奭 plus n m 奷奨奥奮 n = Z夬 奡奮奤
奩奮 奴奨奥 奩奮奤奵奣奴奩奶奥 女奴奥奰 奷奥 女奨奯奷 奴奨奡奴 奴奨奥奲奥 奩女 奡 Nat 奡奲奩女奩奮奧 奷奨奥奮 n = S k 奡奮奤 奷奥 奫奮奯奷 奷奥 奣奡奮 奧奥奴 奡 Nat
奩奮奤奵奣奴奩奶奥奬她 奦奲奯奭 plus k m央 套奥 奣奯奵奬奤 奥奶奥奮 奷奲奩奴奥 奡 奦奵奮奣奴奩奯奮 奣奡奰奴奵奲奩奮奧 奡奬奬 女奵奣奨 奩奮奤奵奣奴奩奶奥 奤奥夜奮奩奴奩奯奮女夺

nat_induction : (P : Nat -> Type) -> -- Property to show
(P Z) -> -- Base case
((k : Nat) -> P k -> P (S k)) -> -- Inductive step
(x : Nat) -> -- Show for all x
P x

nat_induction P p_Z p_S Z = p_Z
nat_induction P p_Z p_S (S k) = p_S k (nat_induction P p_Z p_S k)

奕女奩奮奧 nat_induction夬 奷奥 奣奡奮 奩奭奰奬奥奭奥奮奴 奡奮 奥奱奵奩奶奡奬奥奮奴 奩奮奤奵奣奴奩奶奥 奶奥奲女奩奯奮 奯奦 plus夺

plus_ind : Nat -> Nat -> Nat
plus_ind n m

= nat_induction (\x => Nat)
m -- Base case, plus_ind Z m
(\k, k_rec => S k_rec) -- Inductive step plus_ind (S k) m

-- where k_rec = plus_ind k m
n

奔奯 奰奲奯奶奥 奴奨奡奴 plus n m = plus m n 奦奯奲 奡奬奬 奮奡奴奵奲奡奬 奮奵奭奢奥奲女 n 奡奮奤 m夬 奷奥 奣奡奮 奡奬女奯 奵女奥 奩奮奤奵奣奴奩奯奮央 奅奩奴奨奥奲
奷奥 奣奡奮 夜奸 m 奡奮奤 奰奥奲奦奯奲奭 奩奮奤奵奣奴奩奯奮 奯奮 n夬 奯奲 奶奩奣奥 奶奥奲女奡央 套奥 奣奡奮 女奫奥奴奣奨 奡奮 奯奵奴奬奩奮奥 奯奦 奡 奰奲奯奯奦夻 奰奥奲奦奯奲奭奩奮奧
奩奮奤奵奣奴奩奯奮 奯奮 n夬 奷奥 奨奡奶奥夺

• 奐奲奯奰奥奲奴她 P 奩女 \x => plus x m = plus m x央

• 奓奨奯奷 奴奨奡奴 P 奨奯奬奤女 奩奮 奴奨奥 奢奡女奥 奣奡女奥 奡奮奤 奩奮奤奵奣奴奩奶奥 女奴奥奰夺
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– 奂奡女奥 奣奡女奥夺 P Z夬 奩央奥央
plus Z m = plus m Z夬 奷奨奩奣奨 奲奥奤奵奣奥女 奴奯
m = plus m Z 奤奵奥 奴奯 奴奨奥 奤奥夜奮奩奴奩奯奮 奯奦 plus央

– 奉奮奤奵奣奴奩奶奥 女奴奥奰夺 奉奮奤奵奣奴奩奶奥奬她夬 奷奥 奫奮奯奷 奴奨奡奴 P k 奨奯奬奤女 奦奯奲 奡 女奰奥奣奩夜奣夬 夜奸奥奤 k夬 奩央奥央
plus k m = plus m k 夨奴奨奥 奩奮奤奵奣奴奩奯奮 奨她奰奯奴奨奥女奩女天央 奇奩奶奥奮 奴奨奩女夬 女奨奯奷 P (S k)夬 奩央奥央
plus (S k) m = plus m (S k)夬 奷奨奩奣奨 奲奥奤奵奣奥女 奴奯
S (plus k m) = plus m (S k)央 奆奲奯奭 奴奨奥 奩奮奤奵奣奴奩奯奮 奨她奰奯奴奨奥女奩女夬 奷奥 奣奡奮 奲奥奷奲奩奴奥 奴奨奩女 奴奯
S (plus m k) = plus m (S k)央

奔奯 奣奯奭奰奬奥奴奥 奴奨奥 奰奲奯奯奦 奷奥 奴奨奥奲奥奦奯奲奥 奮奥奥奤 奴奯 女奨奯奷 奴奨奡奴 m = plus m Z 奦奯奲 奡奬奬 奮奡奴奵奲奡奬 奮奵奭奢奥奲女 m夬 奡奮奤 奴奨奡奴
S (plus m k) = plus m (S k) 奦奯奲 奡奬奬 奮奡奴奵奲奡奬 奮奵奭奢奥奲女 m 奡奮奤 k央 奅奡奣奨 奯奦 奴奨奥女奥 奣奡奮 奡奬女奯 奢奥 奰奲奯奶奥奤 奢她
奩奮奤奵奣奴奩奯奮夬 奴奨奩女 奴奩奭奥 奯奮 m央

套奥 奡奲奥 奮奯奷 奲奥奡奤她 奴奯 奥奭奢奡奲奫 奯奮 奡 奰奲奯奯奦 奯奦 奣奯奭奭奵奴奡奴奩奶奩奴她 奯奦 plus 奦奯奲奭奡奬奬她 奩奮 奉奤奲奩女央

5.3 Pattern Matching Proofs

奉奮 奴奨奩女 女奥奣奴奩奯奮夬 奷奥 奷奩奬奬 奰奲奯奶奩奤奥 奡 奰奲奯奯奦 奯奦 plus_commutes 奤奩奲奥奣奴奬她夬 奢她 奷奲奩奴奩奮奧 奡 奰奡奴奴奥奲奮 奭奡奴奣奨奩奮奧 奤奥奦夭
奩奮奩奴奩奯奮央 套奥 奷奩奬奬 奵女奥 奩奮奴奥奲奡奣奴奩奶奥 奥奤奩奴奩奮奧 奦奥奡奴奵奲奥女 奥奸奴奥奮女奩奶奥奬她夬 女奩奮奣奥 奩奴 奩女 女奩奧奮奩夜奣奡奮奴奬她 奥奡女奩奥奲 奴奯 奰奲奯奤奵奣奥 奡
奰奲奯奯奦 奷奨奥奮 奴奨奥 奭奡奣奨奩奮奥 奣奡奮 奧奩奶奥 奴奨奥 奴她奰奥女 奯奦 奩奮奴奥奲奭奥奤奩奡奴奥 奶奡奬奵奥女 奡奮奤 奣奯奮女奴奲奵奣奴 奣奯奭奰奯奮奥奮奴女 奯奦 奴奨奥 奰奲奯奯奦
奩奴女奥奬奦央 奔奨奥 奣奯奭奭奡奮奤女 奷奥 奷奩奬奬 奵女奥 奡奲奥 女奵奭奭奡奲奩女奥奤 奢奥奬奯奷央 套奨奥奲奥 奷奥 奲奥奦奥奲 奴奯 奣奯奭奭奡奮奤女 奤奩奲奥奣奴奬她夬 奷奥 奷奩奬奬
奵女奥 奴奨奥 奖奩奭 奶奥奲女奩奯奮夬 奢奵奴 奴奨奥女奥 奣奯奭奭奡奮奤女 奨奡奶奥 奡 奤奩奲奥奣奴 奭奡奰奰奩奮奧 奴奯 奅奭奡奣女 奣奯奭奭奡奮奤女央

奃奯奭奭奡奮奤 奖奩奭
奢奩奮奤奩奮奧

奅奭奡奣女
奢奩奮奤奩奮奧

奅奸奰奬奡奮奡奴奩奯奮

奃奨奥奣奫 奴她奰奥 \t C-c C-t 奓奨奯奷 奴她奰奥 奯奦 奩奤奥奮奴奩夜奥奲 奯奲 奨奯奬奥 奵奮奤奥奲 奴奨奥 奣奵奲女奯奲央
奐奲奯奯奦 女奥奡奲奣奨 \o C-c C-a 奁奴奴奥奭奰奴 奴奯 女奯奬奶奥 奨奯奬奥 奵奮奤奥奲 奴奨奥 奣奵奲女奯奲 奢她 奡奰奰奬她奩奮奧 女奩奭奰奬奥

奰奲奯奯奦 女奥奡奲奣奨央
奍奡奫奥 奮奥奷
奤奥夜奮奩奴奩奯奮

\d C-c C-s 奁奤奤 奡 奴奥奭奰奬奡奴奥 奤奥夜奮奩奴奩奯奮 奦奯奲 奴奨奥 奴她奰奥 奤奥夜奮奥奤 奵奮奤奥奲 奴奨奥
奣奵奲女奯奲央

奍奡奫奥 奬奥奭奭奡 \l C-c C-e 奁奤奤 奡 奴奯奰 奬奥奶奥奬 奦奵奮奣奴奩奯奮 奷奩奴奨 奡 奴她奰奥 奷奨奩奣奨 女奯奬奶奥女 奴奨奥 奨奯奬奥
奵奮奤奥奲 奴奨奥 奣奵奲女奯奲央

奓奰奬奩奴 奣奡女奥女 \c C-c C-c 奃奲奥奡奴奥 奮奥奷 奣奯奮女奴奲奵奣奴奯奲 奰奡奴奴奥奲奮女 奦奯奲 奥奡奣奨 奰奯女女奩奢奬奥 奣奡女奥 奯奦 奴奨奥
奶奡奲奩奡奢奬奥 奵奮奤奥奲 奴奨奥 奣奵奲女奯奲央

5.3.1 Creating a Definition

奔奯 奢奥奧奩奮夬 奣奲奥奡奴奥 奡 夜奬奥 pluscomm.idr 奣奯奮奴奡奩奮奩奮奧 奴奨奥 奦奯奬奬奯奷奩奮奧 奴她奰奥 奤奥奣奬奡奲奡奴奩奯奮夺

plus_commutes : (n : Nat) -> (m : Nat) -> n + m = m + n

奔奯 奣奲奥奡奴奥 奡 奴奥奭奰奬奡奴奥 奤奥夜奮奩奴奩奯奮 奦奯奲 奴奨奥 奰奲奯奯奦夬 奰奲奥女女 \d 夨奯奲 奴奨奥 奥奱奵奩奶奡奬奥奮奴 奩奮 她奯奵奲 奥奤奩奴奯奲 奯奦 奣奨奯奩奣奥天 奯奮 奴奨奥
奬奩奮奥 奷奩奴奨 奴奨奥 奴她奰奥 奤奥奣奬奡奲奡奴奩奯奮央 奙奯奵 女奨奯奵奬奤 女奥奥夺

plus_commutes : (n : Nat) -> (m : Nat) -> n + m = m + n
plus_commutes n m = ?plus_commutes_rhs

奔奯 奰奲奯奶奥 奴奨奩女 奢她 奩奮奤奵奣奴奩奯奮 奯奮 n夬 奡女 奷奥 女奫奥奴奣奨奥奤 奩奮 奓奥奣奴奩奯奮 Inductive Proofs 夨姩妡妵 失夳夹天夬 奷奥 奢奥奧奩奮 奷奩奴奨 奡
奣奡女奥 女奰奬奩奴 奯奮 n 夨奰奲奥女女 \c 奷奩奴奨 奴奨奥 奣奵奲女奯奲 奯奶奥奲 奴奨奥 n 奩奮 奴奨奥 奤奥夜奮奩奴奩奯奮央天 奙奯奵 女奨奯奵奬奤 女奥奥夺
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plus_commutes : (n : Nat) -> (m : Nat) -> n + m = m + n
plus_commutes Z m = ?plus_commutes_rhs_1
plus_commutes (S k) m = ?plus_commutes_rhs_2

奉奦 奷奥 奩奮女奰奥奣奴 奴奨奥 奴她奰奥女 奯奦 奴奨奥 奮奥奷奬她 奣奲奥奡奴奥奤 奨奯奬奥女夬 plus_commutes_rhs_1 奡奮奤 plus_commutes_rhs_2夬
奷奥 女奥奥 奴奨奡奴 奴奨奥 奴她奰奥 奯奦 奥奡奣奨 奲奥夝奥奣奴女 奴奨奡奴 n 奨奡女 奢奥奥奮 奲奥夜奮奥奤 奴奯 Z 奡奮奤 S k 奩奮 奥奡奣奨 奲奥女奰奥奣奴奩奶奥 奣奡女奥央 奐奲奥女女奩奮奧
\t 奯奶奥奲 plus_commutes_rhs_1 女奨奯奷女夺

m : Nat
--------------------------------------
plus_commutes_rhs_1 : m = plus m 0

奎奯奴奥 奴奨奡奴 Z 奲奥奮奤奥奲女 奡女 0 奢奥奣奡奵女奥 奴奨奥 奰奲奥奴奴她 奰奲奩奮奴奥奲 奲奥奮奤奥奲女 奮奡奴奵奲奡奬 奮奵奭奢奥奲女 奡女 奩奮奴奥奧奥奲 奬奩奴奥奲奡奬女 奦奯奲
奲奥奡奤奡奢奩奬奩奴她央 奓奩奭奩奬奡奲奬她夬 奦奯奲 plus_commutes_rhs_2夺

k : Nat
m : Nat

--------------------------------------
plus_commutes_rhs_2 : S (plus k m) = plus m (S k)

奉奴 奩女 奡 奧奯奯奤 奩奤奥奡 奴奯 奧奩奶奥 奴奨奥女奥 女奬奩奧奨奴奬她 奭奯奲奥 奭奥奡奮奩奮奧奦奵奬 奮奡奭奥女夺

plus_commutes : (n : Nat) -> (m : Nat) -> n + m = m + n
plus_commutes Z m = ?plus_commutes_Z
plus_commutes (S k) m = ?plus_commutes_S

5.3.2 Base Case

套奥 奣奡奮 奣奲奥奡奴奥 奡 女奥奰奡奲奡奴奥 奬奥奭奭奡 奦奯奲 奴奨奥 奢奡女奥 奣奡女奥 奩奮奴奥奲奡奣奴奩奶奥奬她夬 奢她 奰奲奥女女奩奮奧 \l 奷奩奴奨 奴奨奥 奣奵奲女奯奲 奯奶奥奲
plus_commutes_Z央 奔奨奩女 她奩奥奬奤女夺

plus_commutes_Z : m = plus m 0

plus_commutes : (n : Nat) -> (m : Nat) -> n + m = m + n
plus_commutes Z m = plus_commutes_Z
plus_commutes (S k) m = ?plus_commutes_S

奔奨奡奴 奩女夬 奴奨奥 奨奯奬奥 奨奡女 奢奥奥奮 夜奬奬奥奤 奷奩奴奨 奡 奣奡奬奬 奴奯 奡 奴奯奰 奬奥奶奥奬 奦奵奮奣奴奩奯奮 plus_commutes_Z央 奔奨奥 奡奲奧奵奭奥奮奴 m
奨奡女 奢奥奥奮 奭奡奤奥 奩奭奰奬奩奣奩奴 奢奥奣奡奵女奥 奩奴 奣奡奮 奢奥 奩奮奦奥奲奲奥奤 奦奲奯奭 奣奯奮奴奥奸奴 奷奨奥奮 奩奴 奩女 奡奰奰奬奩奥奤央

奕奮奦奯奲奴奵奮奡奴奥奬她夬 奷奥 奣奡奮奮奯奴 奰奲奯奶奥 奴奨奩女 奬奥奭奭奡 奤奩奲奥奣奴奬她夬 女奩奮奣奥 plus 奩女 奤奥夜奮奥奤 奢她 奭奡奴奣奨奩奮奧 奯奮 奩奴女 first
奡奲奧奵奭奥奮奴夬 奡奮奤 奨奥奲奥 plus m 0 奨奡女 奡 女奰奥奣奩夜奣 奶奡奬奵奥 奦奯奲 奩奴女 second argument 夨奩奮 奦奡奣奴夬 奴奨奥 奬奥奦奴 奨奡奮奤 女奩奤奥 奯奦
奴奨奥 奥奱奵奡奬奩奴她 奨奡女 奢奥奥奮 奲奥奤奵奣奥奤 奦奲奯奭 plus 0 m央天 奁奧奡奩奮夬 奷奥 奣奡奮 奰奲奯奶奥 奴奨奩女 奢她 奩奮奤奵奣奴奩奯奮夬 奴奨奩女 奴奩奭奥 奯奮 m央

奆奩奲女奴夬 奣奲奥奡奴奥 奡 奴奥奭奰奬奡奴奥 奤奥夜奮奩奴奩奯奮 奷奩奴奨 \d夺

plus_commutes_Z : m = plus m 0
plus_commutes_Z = ?plus_commutes_Z_rhs

奓奩奮奣奥 奷奥 奡奲奥 奧奯奩奮奧 奴奯 奷奲奩奴奥 奴奨奩女 奢她 奩奮奤奵奣奴奩奯奮 奯奮 m夬 奷奨奩奣奨 奩女 奩奭奰奬奩奣奩奴夬 奷奥 奷奩奬奬 奮奥奥奤 奴奯 奢奲奩奮奧 m 奩奮奴奯 女奣奯奰奥
奭奡奮奵奡奬奬她夺

plus_commutes_Z : m = plus m 0
plus_commutes_Z {m} = ?plus_commutes_Z_rhs

奎奯奷夬 奣奡女奥 女奰奬奩奴 奯奮 m 奷奩奴奨 \c夺
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plus_commutes_Z : m = plus m 0
plus_commutes_Z {m = Z} = ?plus_commutes_Z_rhs_1
plus_commutes_Z {m = (S k)} = ?plus_commutes_Z_rhs_2

奃奨奥奣奫奩奮奧 奴奨奥 奴她奰奥 奯奦 plus_commutes_Z_rhs_1 女奨奯奷女 奴奨奥 奦奯奬奬奯奷奩奮奧夬 奷奨奩奣奨 奩女 奥奡女奩奬她 奰奲奯奶奥奤 奢她 奲奥夝奥奣奴奩奯奮夺

--------------------------------------
plus_commutes_Z_rhs_1 : 0 = 0

奆奯奲 女奵奣奨 奴奲奩奶奩奡奬 奰奲奯奯奦女夬 奷奥 奣奡奮 奬奥奴 奷奲奩奴奥 奴奨奥 奰奲奯奯奦 奡奵奴奯奭奡奴奩奣奡奬奬她 奢她 奰奲奥女女奩奮奧 \o 奷奩奴奨 奴奨奥 奣奵奲女奯奲 奯奶奥奲
plus_commutes_Z_rhs_1央 奔奨奩女 她奩奥奬奤女夺

plus_commutes_Z : m = plus m 0
plus_commutes_Z {m = Z} = Refl
plus_commutes_Z {m = (S k)} = ?plus_commutes_Z_rhs_2

奆奯奲 plus_commutes_Z_rhs_2夬 奷奥 奡奲奥 奮奯奴 女奯 奬奵奣奫她夺

k : Nat
--------------------------------------
plus_commutes_Z_rhs_2 : S k = S (plus k 0)

奉奮奤奵奣奴奩奶奥奬她夬 奷奥 女奨奯奵奬奤 奫奮奯奷 奴奨奡奴 k = plus k 0夬 奡奮奤 奷奥 奣奡奮 奧奥奴 奡奣奣奥女女 奴奯 奴奨奩女 奩奮奤奵奣奴奩奶奥 奨她奰奯奴奨奥女奩女 奢她
奭奡奫奩奮奧 奡 奲奥奣奵奲女奩奶奥 奣奡奬奬 奯奮 奫夬 奡女 奦奯奬奬奯奷女夺

plus_commutes_Z : m = plus m 0
plus_commutes_Z {m = Z} = Refl
plus_commutes_Z {m = (S k)} = let rec = plus_commutes_Z {m=k} in

?plus_commutes_Z_rhs_2

奆奯奲 plus_commutes_Z_rhs_2夬 奷奥 奮奯奷 女奥奥夺

k : Nat
rec : k = plus k (fromInteger 0)

--------------------------------------
plus_commutes_Z_rhs_2 : S k = S (plus k 0)

奁奧奡奩奮夬 奴奨奥 fromInteger 0 奩女 奭奥奲奥奬她 奤奵奥 奴奯 Nat 奨奡奶奩奮奧 奡奮 奩奭奰奬奥奭奥奮奴奡奴奩奯奮 奯奦 奴奨奥 Num 奩奮奴奥奲奦奡奣奥央 奓奯 奷奥
奫奮奯奷 奴奨奡奴 k = plus k 0夬 奢奵奴 奨奯奷 奤奯 奷奥 奵女奥 奴奨奩女 奴奯 奵奰奤奡奴奥 奴奨奥 奧奯奡奬 奴奯 S k = S k夿

奔奯 奡奣奨奩奥奶奥 奴奨奩女夬 奉奤奲奩女 奰奲奯奶奩奤奥女 奡 replace 奦奵奮奣奴奩奯奮 奡女 奰奡奲奴 奯奦 奴奨奥 奰奲奥奬奵奤奥夺

*pluscomm> :t replace
replace : (x = y) -> P x -> P y

奇奩奶奥奮 奡 奰奲奯奯奦 奴奨奡奴 x = y夬 奡奮奤 奡 奰奲奯奰奥奲奴她 P 奷奨奩奣奨 奨奯奬奤女 奦奯奲 x夬 奷奥 奣奡奮 奧奥奴 奡 奰奲奯奯奦 奯奦 奴奨奥 女奡奭奥 奰奲奯奰奥奲奴她
奦奯奲 y夬 奢奥奣奡奵女奥 奷奥 奫奮奯奷 x 奡奮奤 y 奭奵女奴 奢奥 奴奨奥 女奡奭奥央 奉奮 奰奲奡奣奴奩奣奥夬 奴奨奩女 奦奵奮奣奴奩奯奮 奣奡奮 奢奥 奡 奬奩奴奴奬奥 奴奲奩奣奫她 奴奯 奵女奥
奢奥奣奡奵女奥 奩奮 奧奥奮奥奲奡奬 奴奨奥 奩奭奰奬奩奣奩奴 奡奲奧奵奭奥奮奴 P 奣奡奮 奢奥 奨奡奲奤 奴奯 奩奮奦奥奲 奢她 奵奮奩夜奣奡奴奩奯奮夬 女奯 奉奤奲奩女 奰奲奯奶奩奤奥女 奡 奨奩奧奨
奬奥奶奥奬 女她奮奴奡奸 奷奨奩奣奨 奣奡奬奣奵奬奡奴奥女 奴奨奥 奰奲奯奰奥奲奴她 奡奮奤 奡奰奰奬奩奥女 replace夺

rewrite prf in expr

奉奦 奷奥 奨奡奶奥 prf : x = y夬 奡奮奤 奴奨奥 奲奥奱奵奩奲奥奤 奴她奰奥 奦奯奲 expr 奩女 女奯奭奥 奰奲奯奰奥奲奴她 奯奦 x夬 奴奨奥 rewrite ... in
女她奮奴奡奸 奷奩奬奬 女奥奡奲奣奨 奦奯奲 x 奩奮 奴奨奥 奲奥奱奵奩奲奥奤 奴她奰奥 奯奦 expr 奡奮奤 奲奥奰奬奡奣奥 奩奴 奷奩奴奨 y央 奃奯奮奣奲奥奴奥奬她夬 奩奮 奯奵奲 奥奸奡奭奰奬奥夬
奷奥 奣奡奮 女奡她夺

plus_commutes_Z {m = (S k)} = let rec = plus_commutes_Z {m=k} in
rewrite rec in ?plus_commutes_Z_rhs_2
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奃奨奥奣奫奩奮奧 奴奨奥 奴她奰奥 奯奦 plus_commutes_Z_rhs_2 奮奯奷 奧奩奶奥女夺

k : Nat
rec : k = plus k (fromInteger 0)
_rewrite_rule : plus k 0 = k

--------------------------------------
plus_commutes_Z_rhs_2 : S (plus k 0) = S (plus k 0)

奕女奩奮奧 奴奨奥 奲奥奷奲奩奴奥 奲奵奬奥 rec 夨奷奨奩奣奨 奷奥 奣奡奮 女奥奥 奩奮 奴奨奥 奣奯奮奴奥奸奴 奨奥奲奥 奡女 _rewrite_rule1夬 奴奨奥 奧奯奡奬 奴她奰奥 奨奡女
奢奥奥奮 奵奰奤奡奴奥奤 奷奩奴奨 k 奲奥奰奬奡奣奥奤 奢她 plus k 0央

奁奬奴奥奲奮奡奴奩奶奥奬她夬 奷奥 奣奯奵奬奤 奨奡奶奥 奡奰奰奬奩奥奤 奴奨奥 奲奥奷奲奩奴奥 奩奮 奴奨奥 奯奴奨奥奲 奤奩奲奥奣奴奩奯奮 奵女奩奮奧 奴奨奥 sym 奦奵奮奣奴奩奯奮夺

*pluscomm> :t sym
sym : (l = r) -> r = l

plus_commutes_Z {m = (S k)} = let rec = plus_commutes_Z {m=k} in
rewrite sym rec in ?plus_commutes_Z_rhs_2

奉奮 奴奨奩女 奣奡女奥夬 奩奮女奰奥奣奴奩奮奧 奴奨奥 奴她奰奥 奯奦 奴奨奥 奨奯奬奥 奧奩奶奥女夺

k : Nat
rec : k = plus k (fromInteger 0)
_rewrite_rule : k = plus k 0

--------------------------------------
plus_commutes_Z_rhs_2 : S k = S k

奅奩奴奨奥奲 奷奡她夬 奷奥 奣奡奮 奵女奥 奰奲奯奯奦 女奥奡奲奣奨 夨\o天 奴奯 奣奯奭奰奬奥奴奥 奴奨奥 奰奲奯奯奦夬 奧奩奶奩奮奧夺

plus_commutes_Z : m = plus m 0
plus_commutes_Z {m = Z} = Refl
plus_commutes_Z {m = (S k)} = let rec = plus_commutes_Z {m=k} in

rewrite rec in Refl

奔奨奥 奢奡女奥 奣奡女奥 奩女 奮奯奷 奣奯奭奰奬奥奴奥央

5.3.3 Inductive Step

奏奵奲 奭奡奩奮 奴奨奥奯奲奥奭夬 plus_commutes 女奨奯奵奬奤 奣奵奲奲奥奮奴奬她 奢奥 奩奮 奴奨奥 奦奯奬奬奯奷奩奮奧 女奴奡奴奥夺

plus_commutes : (n : Nat) -> (m : Nat) -> n + m = m + n
plus_commutes Z m = plus_commutes_Z
plus_commutes (S k) m = ?plus_commutes_S

奌奯奯奫奩奮奧 奡奧奡奩奮 奡奴 奴奨奥 奴她奰奥 奯奦 plus_commutes_S夬 奷奥 奨奡奶奥夺

k : Nat
m : Nat

--------------------------------------
plus_commutes_S : S (plus k m) = plus m (S k)

奃奯奮奶奥奮奩奥奮奴奬她夬 奢她 奩奮奤奵奣奴奩奯奮 奷奥 奣奡奮 奩奭奭奥奤奩奡奴奥奬她 奴奥奬奬 奴奨奡奴 plus k m = plus m k夬 女奯 奬奥奴 奵女 奲奥奷奲奩奴奥 奤奩奲奥奣奴奬她
奢她 奭奡奫奩奮奧 奡 奲奥奣奵奲女奩奶奥 奣奡奬奬 奴奯 plus_commutes央 套奥 奡奤奤 奴奨奩女 奤奩奲奥奣奴奬她夬 奢她 奨奡奮奤夬 奡女 奦奯奬奬奯奷女夺

1 Note that the left and right hand sides of the equality have been swapped, because replace takes a proof of x=y and
the property for x, not y.
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plus_commutes : (n : Nat) -> (m : Nat) -> n + m = m + n
plus_commutes Z m = plus_commutes_Z
plus_commutes (S k) m = rewrite plus_commutes k m in ?plus_commutes_S

奃奨奥奣奫奩奮奧 奴奨奥 奴她奰奥 奯奦 plus_commutes_S 奮奯奷 奧奩奶奥女夺

k : Nat
m : Nat
_rewrite_rule : plus m k = plus k m

--------------------------------------
plus_commutes_S : S (plus m k) = plus m (S k)

奔奨奥 奧奯奯奤 奮奥奷女 奩女 奴奨奡奴 m 奡奮奤 k 奮奯奷 奡奰奰奥奡奲 奩奮 奴奨奥 奣奯奲奲奥奣奴 奯奲奤奥奲央 奈奯奷奥奶奥奲夬 奷奥 女奴奩奬奬 奨奡奶奥 奴奯 女奨奯奷 奴奨奡奴
奴奨奥 女奵奣奣奥女女奯奲 女她奭奢奯奬 S 奣奡奮 奢奥 奭奯奶奥奤 奴奯 奴奨奥 奦奲奯奮奴 奩奮 奴奨奥 奲奩奧奨奴 奨奡奮奤 女奩奤奥 奯奦 奴奨奩女 奥奱奵奡奬奩奴她央 奔奨奩女 奲奥奭奡奩奮奩奮奧
奬奥奭奭奡 奴奡奫奥女 奡 女奩奭奩奬奡奲 奦奯奲奭 奴奯 奴奨奥 plus_commutes_Z夻 奷奥 奢奥奧奩奮 奢她 奭奡奫奩奮奧 奡 奮奥奷 奴奯奰 奬奥奶奥奬 奬奥奭奭奡 奷奩奴奨
\l央 奔奨奩女 奧奩奶奥女夺

plus_commutes_S : (k : Nat) -> (m : Nat) -> S (plus m k) = plus m (S k)

奕奮奬奩奫奥 奴奨奥 奰奲奥奶奩奯奵女 奣奡女奥夬 k 奡奮奤 m 奡奲奥 奮奯奴 奭奡奤奥 奩奭奰奬奩奣奩奴 奢奥奣奡奵女奥 奷奥 奣奡奮奮奯奴 奩奮 奧奥奮奥奲奡奬 奩奮奦奥奲 奡奲奧奵奭奥奮奴女
奴奯 奡 奦奵奮奣奴奩奯奮 奦奲奯奭 奩奴女 奲奥女奵奬奴央 奁奧奡奩奮夬 奷奥 奭奡奫奥 奡 奴奥奭奰奬奡奴奥 奤奥夜奮奩奴奩奯奮 奷奩奴奨 \d夺

plus_commutes_S : (k : Nat) -> (m : Nat) -> S (plus m k) = plus m (S k)
plus_commutes_S k m = ?plus_commutes_S_rhs

奁奧奡奩奮夬 奴奨奩女 奩女 奤奥夜奮奥奤 奢她 奩奮奤奵奣奴奩奯奮 奯奶奥奲 m夬 女奩奮奣奥 plus 奩女 奤奥夜奮奥奤 奢她 奭奡奴奣奨奩奮奧 奯奮 奩奴女 夜奲女奴 奡奲奧奵奭奥奮奴央 奔奨奥
奣奯奭奰奬奥奴奥 奤奥夜奮奩奴奩奯奮 奩女夺

total
plus_commutes_S : (k : Nat) -> (m : Nat) -> S (plus m k) = plus m (S k)
plus_commutes_S k Z = Refl
plus_commutes_S k (S j) = rewrite plus_commutes_S k j in Refl

奁奬奬 奨奯奬奥女 奨奡奶奥 奮奯奷 奢奥奥奮 女奯奬奶奥奤央

奔奨奥 total 奡奮奮奯奴奡奴奩奯奮 奭奥奡奮女 奴奨奡奴 奷奥 奲奥奱奵奩奲奥 奴奨奥 夜奮奡奬 奦奵奮奣奴奩奯奮 奴奯 奰奡女女 奴奨奥 奴奯奴奡奬奩奴她 奣奨奥奣奫奥奲夻 奩央奥央 奩奴 奷奩奬奬
奴奥奲奭奩奮奡奴奥 奯奮 奡奬奬 奰奯女女奩奢奬奥 奷奥奬奬夭奴她奰奥奤 奩奮奰奵奴女央 奔奨奩女 奩女 奩奭奰奯奲奴奡奮奴 奦奯奲 奰奲奯奯奦女夬 女奩奮奣奥 奩奴 奰奲奯奶奩奤奥女 奡 奧奵奡奲奡奮奴奥奥
奴奨奡奴 奴奨奥 奰奲奯奯奦 奩女 奶奡奬奩奤 奩奮 all 奣奡女奥女夬 奮奯奴 奪奵女奴 奴奨奯女奥 奦奯奲 奷奨奩奣奨 奩奴 奨奡奰奰奥奮女 奴奯 奢奥 奷奥奬奬夭奤奥夜奮奥奤央

奎奯奷 奴奨奡奴 plus_commutes 奨奡女 奡 total 奡奮奮奯奴奡奴奩奯奮夬 奷奥 奨奡奶奥 奣奯奭奰奬奥奴奥奤 奴奨奥 奰奲奯奯奦 奯奦 奣奯奭奭奵奴奡奴奩奶奩奴她 奯奦
奡奤奤奩奴奩奯奮 奯奮 奮奡奴奵奲奡奬 奮奵奭奢奥奲女央

5.4 DEPRECATED: Interactive Theorem Proving

警警警告告告: 奔奨奥 奩奮奴奥奲奡奣奴奩奶奥 奴奨奥奯奲奥奭夭奰奲奯奶奩奮奧 奩奮奴奥奲奦奡奣奥 奤奯奣奵奭奥奮奴奥奤 奨奥奲奥 奨奡女 奢奥奥奮 奤奥奰奲奥奣奡奴奥奤 奩奮 奦奡奶奯奲 奯奦
Elaborator Reflection 夨姩妡妵 失夹夹天央

奉奤奲奩女 奡奬女奯 女奵奰奰奯奲奴女 奩奮奴奥奲奡奣奴奩奶奥 奴奨奥奯奲奥奭 奰奲奯奶奩奮奧 奶奩奡 奴奡奣奴奩奣女央 奔奨奩女 奩女 奧奥奮奥奲奡奬奬她 奮奯奴 奲奥奣奯奭奭奥奮奤奥奤 奴奯 奢奥
奵女奥奤 奤奩奲奥奣奴奬她夬 奢奵奴 奲奡奴奨奥奲 奵女奥奤 奡女 奡 奭奥奣奨奡奮奩女奭 奦奯奲 奢奵奩奬奤奩奮奧 奰奲奯奯奦 奡奵奴奯奭奡奴奩奯奮 奷奨奩奣奨 奩女 奢奥她奯奮奤 奴奨奥 女奣奯奰奥
奯奦 奴奨奩女 奴奵奴奯奲奩奡奬央 奉奮 奴奨奩女 女奥奣奴奩奯奮夬 奷奥 奢奲奩奥夝她 奤奩女奣奵女 奴奡奣奴奩奣女央

奏奮奥 奷奡她 奴奯 奷奲奩奴奥 奰奲奯奯奦女 奩奮奴奥奲奡奣奴奩奶奥奬她 奩女 奴奯 奷奲奩奴奥 奴奨奥 奧奥奮奥奲奡奬 structure 奯奦 奴奨奥 奰奲奯奯奦夬 奡奮奤 奵女奥 奴奨奥 奩奮奴奥奲奡奣奴奩奶奥
奭奯奤奥 奴奯 奣奯奭奰奬奥奴奥 奴奨奥 奤奥奴奡奩奬女央 奃奯奮女奩奤奥奲 奴奨奥 奦奯奬奬奯奷奩奮奧 奤奥夜奮奩奴奩奯奮夬 奰奲奯奶奥奤 奩奮 定理证明 夨姩妡妵 头失天夺
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plusReduces : (n:Nat) -> plus Z n = n

套奥’奬奬 奢奥 奣奯奮女奴奲奵奣奴奩奮奧 奴奨奥 奰奲奯奯奦 奢她 induction夬 女奯 奷奥 奷奲奩奴奥 奴奨奥 奣奡女奥女 奦奯奲 Z 奡奮奤 S夬 奷奩奴奨 奡 奲奥奣奵奲女奩奶奥 奣奡奬奬 奩奮
奴奨奥 S 奣奡女奥 奧奩奶奩奮奧 奴奨奥 奩奮奤奵奣奴奩奶奥 奨她奰奯奴奨奥女奩女夬 奡奮奤 奩奮女奥奲奴 holes 奦奯奲 奴奨奥 奲奥女奴 奯奦 奴奨奥 奤奥夜奮奩奴奩奯奮夺

plusReducesZ' : (n:Nat) -> n = plus n Z
plusReducesZ' Z = ?plusredZ_Z
plusReducesZ' (S k) = let ih = plusReducesZ' k in

?plusredZ_S

奏奮 奲奵奮奮奩奮奧 夬 奴奷奯 奧奬奯奢奡奬 奮奡奭奥女 奡奲奥 奣奲奥奡奴奥奤夬 plusredZ_Z 奡奮奤 plusredZ_S夬 奷奩奴奨 奮奯 奤奥夜奮奩奴奩奯奮央 套奥 奣奡奮
奵女奥 奴奨奥 :m 奣奯奭奭奡奮奤 奡奴 奴奨奥 奰奲奯奭奰奴 奴奯 夜奮奤 奯奵奴 奷奨奩奣奨 奨奯奬奥女 奡奲奥 女奴奩奬奬 奴奯 奢奥 女奯奬奶奥奤 夨奯奲夬 奭奯奲奥 奰奲奥奣奩女奥奬她夬
奷奨奩奣奨 奦奵奮奣奴奩奯奮女 奥奸奩女奴 奢奵奴 奨奡奶奥 奮奯 奤奥夜奮奩奴奩奯奮女天夬 奴奨奥奮 奴奨奥 :t 奣奯奭奭奡奮奤 奴奯 女奥奥 奴奨奥奩奲 奴她奰奥女夺

*theorems> :m
Global holes:

[plusredZ_S,plusredZ_Z]

*theorems> :t plusredZ_Z
plusredZ_Z : Z = plus Z Z

*theorems> :t plusredZ_S
plusredZ_S : (k : Nat) -> (k = plus k Z) -> S k = plus (S k) Z

奔奨奥 :p 奣奯奭奭奡奮奤 奥奮奴奥奲女 奩奮奴奥奲奡奣奴奩奶奥 奰奲奯奯奦 奭奯奤奥夬 奷奨奩奣奨 奣奡奮 奢奥 奵女奥奤 奴奯 奣奯奭奰奬奥奴奥 奴奨奥 奭奩女女奩奮奧 奤奥夜奮奩奴奩奯奮女央

*theorems> :p plusredZ_Z

---------------------------------- (plusredZ_Z) --------
{hole0} : Z = plus Z Z

奔奨奩女 奧奩奶奥女 奵女 奡 奬奩女奴 奯奦 奰奲奥奭奩女奥女 夨奡奢奯奶奥 奴奨奥 奬奩奮奥夻 奴奨奥奲奥 奡奲奥 奮奯奮奥 奨奥奲奥天 奡奮奤 奴奨奥 奣奵奲奲奥奮奴 奧奯奡奬 夨奢奥奬奯奷 奴奨奥 奬奩奮奥夻
奮奡奭奥奤 {hole0} 奨奥奲奥天央 奁奴 奴奨奥 奰奲奯奭奰奴 奷奥 奣奡奮 奥奮奴奥奲 奴奡奣奴奩奣女 奴奯 奤奩奲奥奣奴 奴奨奥 奣奯奮女奴奲奵奣奴奩奯奮 奯奦 奴奨奥 奰奲奯奯奦央 奉奮
奴奨奩女 奣奡女奥夬 奷奥 奣奡奮 奮奯奲奭奡奬奩女奥 奴奨奥 奧奯奡奬 奷奩奴奨 奴奨奥 compute 奴奡奣奴奩奣夺

-plusredZ_Z> compute

---------------------------------- (plusredZ_Z) --------
{hole0} : Z = Z

奎奯奷 奷奥 奨奡奶奥 奴奯 奰奲奯奶奥 奴奨奡奴 Z 奥奱奵奡奬女 Z夬 奷奨奩奣奨 奩女 奥奡女她 奴奯 奰奲奯奶奥 奢她 Refl央 奔奯 奡奰奰奬她 奡 奦奵奮奣奴奩奯奮夬 女奵奣奨 奡女
Refl夬 奷奥 奵女奥 refine 奷奨奩奣奨 奩奮奴奲奯奤奵奣奥女 女奵奢奧奯奡奬女 奦奯奲 奥奡奣奨 奯奦 奴奨奥 奦奵奮奣奴奩奯奮’女 奥奸奰奬奩奣奩奴 奡奲奧奵奭奥奮奴女 夨Refl 奨奡女
奮奯奮奥天夺

-plusredZ_Z> refine Refl
plusredZ_Z: no more goals

奈奥奲奥夬 奷奥 奣奯奵奬奤 奡奬女奯 奨奡奶奥 奵女奥奤 奴奨奥 trivial 奴奡奣奴奩奣夬 奷奨奩奣奨 奴奲奩奥女 奴奯 奲奥夜奮奥 奢她 Refl夬 奡奮奤 奩奦 奴奨奡奴 奦奡奩奬女夬 奴奲奩奥女
奴奯 奲奥夜奮奥 奢她 奥奡奣奨 奮奡奭奥 奩奮 奴奨奥 奬奯奣奡奬 奣奯奮奴奥奸奴央 套奨奥奮 奡 奰奲奯奯奦 奩女 奣奯奭奰奬奥奴奥夬 奷奥 奵女奥 奴奨奥 qed 奴奡奣奴奩奣 奴奯 奡奤奤 奴奨奥
奰奲奯奯奦 奴奯 奴奨奥 奧奬奯奢奡奬 奣奯奮奴奥奸奴夬 奡奮奤 奲奥奭奯奶奥 奴奨奥 奨奯奬奥 奦奲奯奭 奴奨奥 奵奮女奯奬奶奥奤 奨奯奬奥女 奬奩女奴央 奔奨奩女 奡奬女奯 奯奵奴奰奵奴女 奡 奴奲奡奣奥
奯奦 奴奨奥 奰奲奯奯奦夺

-plusredZ_Z> qed
plusredZ_Z = proof

compute
refine Refl
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*theorems> :m
Global holes:

[plusredZ_S]

奔奨奥 :addproof 奣奯奭奭奡奮奤夬 奡奴 奴奨奥 奩奮奴奥奲奡奣奴奩奶奥 奰奲奯奭奰奴夬 奷奩奬奬 奡奤奤 奴奨奥 奰奲奯奯奦 奴奯 奴奨奥 女奯奵奲奣奥 夜奬奥 夨奥夛奥奣奴奩奶奥奬她 奩奮
奡奮 奡奰奰奥奮奤奩奸天央 奌奥奴 奵女 奮奯奷 奰奲奯奶奥 奴奨奥 奯奴奨奥奲 奲奥奱奵奩奲奥奤 奬奥奭奭奡夬 plusredZ_S夺

*theorems> :p plusredZ_S

---------------------------------- (plusredZ_S) --------
{hole0} : (k : Nat) -> (k = plus k Z) -> S k = plus (S k) Z

奉奮 奴奨奩女 奣奡女奥夬 奴奨奥 奧奯奡奬 奩女 奡 奦奵奮奣奴奩奯奮 奴她奰奥夬 奵女奩奮奧 k 夨奴奨奥 奡奲奧奵奭奥奮奴 奡奣奣奥女女奩奢奬奥 奢她 奰奡奴奴奥奲奮 奭奡奴奣奨奩奮奧天 奡奮奤 ih
— 奴奨奥 奬奯奣奡奬 奶奡奲奩奡奢奬奥 奣奯奮奴奡奩奮奩奮奧 奴奨奥 奲奥女奵奬奴 奯奦 奴奨奥 奲奥奣奵奲女奩奶奥 奣奡奬奬央 套奥 奣奡奮 奩奮奴奲奯奤奵奣奥 奴奨奥女奥 奡女 奰奲奥奭奩女奥女 奵女奩奮奧
奴奨奥 intro 奴奡奣奴奩奣 奴奷奩奣奥 夨奯奲 intros夬 奷奨奩奣奨 奩奮奴奲奯奤奵奣奥女 奡奬奬 奡奲奧奵奭奥奮奴女 奡女 奰奲奥奭奩女奥女天央 奔奨奩女 奧奩奶奥女夺

k : Nat
ih : k = plus k Z

---------------------------------- (plusredZ_S) --------
{hole2} : S k = plus (S k) Z

奓奩奮奣奥 奰奬奵女 奩女 奤奥夜奮奥奤 奢她 奲奥奣奵奲女奩奯奮 奯奮 奩奴女 夜奲女奴 奡奲奧奵奭奥奮奴夬 奴奨奥 奴奥奲奭 plus (S k) Z 奩奮 奴奨奥 奧奯奡奬 奣奡奮 奢奥
女奩奭奰奬奩夜奥奤夬 女奯 奷奥 奵女奥 compute央

k : Nat
ih : k = plus k Z

---------------------------------- (plusredZ_S) --------
{hole2} : S k = S (plus k Z)

套奥 奫奮奯奷夬 奦奲奯奭 奴奨奥 奴她奰奥 奯奦 ih夬 奴奨奡奴 k = plus k Z夬 女奯 奷奥 奷奯奵奬奤 奬奩奫奥 奴奯 奵女奥 奴奨奩女 奫奮奯奷奬奥奤奧奥 奴奯 奲奥奰奬奡奣奥
plus k Z 奩奮 奴奨奥 奧奯奡奬 奷奩奴奨 k央 套奥 奣奡奮 奡奣奨奩奥奶奥 奴奨奩女 奷奩奴奨 奴奨奥 rewrite 奴奡奣奴奩奣夺

-plusredZ_S> rewrite ih

k : Nat
ih : k = plus k Z

---------------------------------- (plusredZ_S) --------
{hole3} : S k = S k

-plusredZ_S>

奔奨奥 rewrite 奴奡奣奴奩奣 奴奡奫奥女 奡奮 奥奱奵奡奬奩奴她 奰奲奯奯奦 奡女 奡奮 奡奲奧奵奭奥奮奴夬 奡奮奤 奴奲奩奥女 奴奯 奲奥奷奲奩奴奥 奴奨奥 奧奯奡奬 奵女奩奮奧 奴奨奡奴
奰奲奯奯奦央 奈奥奲奥夬 奩奴 奲奥女奵奬奴女 奩奮 奡奮 奥奱奵奡奬奩奴她 奷奨奩奣奨 奩女 奴奲奩奶奩奡奬奬她 奰奲奯奶奡奢奬奥夺

-plusredZ_S> trivial
plusredZ_S: no more goals
-plusredZ_S> qed
plusredZ_S = proof {

intros;
rewrite ih;
trivial;

}

奁奧奡奩奮夬 奷奥 奣奡奮 奡奤奤 奴奨奩女 奰奲奯奯奦 奴奯 奴奨奥 奥奮奤 奯奦 奯奵奲 女奯奵奲奣奥 夜奬奥 奵女奩奮奧 奴奨奥 :addproof 奣奯奭奭奡奮奤 奡奴 奴奨奥 奩奮奴奥奲奡奣奴奩奶奥
奰奲奯奭奰奴央
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CHAPTER 6

Language Reference

奔奨奩女 奩女 奴奨奥 奲奥奦奥奲奥奮奣奥 奧奵奩奤奥 奦奯奲 奴奨奥 奉奤奲奩女 奌奡奮奧奵奡奧奥央 奉奴 奤奯奣奵奭奥奮奴女 奴奨奥 奬奡奮奧奵奡奧奥 女奰奥奣奩夜奣奡奴奩奯奮 奡奮奤 奩奮奴奥奲奮奡奬女央
奔奨奩女 奷奩奬奬 奴奥奬奬 她奯奵 奨奯奷 奉奤奲奩女 奷奯奲奫女夬 奦奯奲 奵女奩奮奧 奩奴 她奯奵 女奨奯奵奬奤 奲奥奡奤 奴奨奥 奉奤奲奩女 奔奵奴奯奲奩奡奬央

注注注解解解: 奔奨奥 奤奯奣奵奭奥奮奴奡奴奩奯奮 奦奯奲 奉奤奲奩女 奨奡女 奢奥奥奮 奰奵奢奬奩女奨奥奤 奵奮奤奥奲 奴奨奥 奃奲奥奡奴奩奶奥 奃奯奭奭奯奮女 奃奃夰 奌奩奣奥奮女奥央 奁女
女奵奣奨 奴奯 奴奨奥 奥奸奴奥奮奴 奰奯女女奩奢奬奥 奵奮奤奥奲 奬奡奷夬 The Idris Community 奨奡女 奷奡奩奶奥奤 奡奬奬 奣奯奰她奲奩奧奨奴 奡奮奤 奲奥奬奡奴奥奤 奯奲
奮奥奩奧奨奢奯奲奩奮奧 奲奩奧奨奴女 奴奯 奄奯奣奵奭奥奮奴奡奴奩奯奮 奦奯奲 奉奤奲奩女央

奍奯奲奥 奩奮奦奯奲奭奡奴奩奯奮 奣奯奮奣奥奲奮奩奮奧 奴奨奥 奃奃夰 奣奡奮 奢奥 奦奯奵奮奤 奯奮奬奩奮奥 奡奴夺 奨奴奴奰夺夯夯奣奲奥奡奴奩奶奥奣奯奭奭奯奮女央奯奲奧夯
奰奵奢奬奩奣奤奯奭奡奩奮夯奺奥奲奯夯失央夰夯

6.1 Code Generation Targets

Idris 奨奡女 奢奥奥奮 奤奥女奩奧奮奥奤 女奵奣奨 奴奨奡奴 奴奨奥 奣奯奭奰奩奬奥奲 奣奡奮 奧奥奮奥奲奡奴奥 奣奯奤奥 奦奯奲 奤奩夛奥奲奥奮奴 奢奡奣奫奥奮奤女 奵奰奯奮 奲奥奱奵奥女奴央
奂她 奤奥奦奡奵奬奴 Idris 奧奥奮奥奲奡奴奥女 奡 C 奢奡奣奫奥奮奤 奷奨奥奮 奧奥奮奥奲奡奴奩奮奧 奡奮 奥奸奥奣奵奴奡奢奬奥央 奉奮奣奬奵奤奥奤 奷奩奴奨奩奮 奴奨奥 女奴奡奮奤奡奲奤
奉奤奲奩女 奩奮女奴奡奬奬奡奴奩奯奮 奡奲奥 奢奡奣奫奥奮奤女 奦奯奲 奊奡奶奡女奣奲奩奰奴 奡奮奤 奎奯奤奥央奪女央

奈奯奷奥奶奥奲夬 奴奨奥奲奥 奡奲奥 奴奨奩奲奤夭奰奡奲奴她 奣奯奤奥 奧奥奮奥奲奡奴奯奲女 奯奵奴 奴奨奥奲奥央 奂奥奬奯奷 奷奥 奤奥女奣奲奩奢奥 女奯奭奥 奯奦 奴奨奥女奥 奢奡奣奫奥奮奤女 奡奮奤
奨奯奷 她奯奵 奣奡奮 奵女奥 奴奨奥奭 奷奨奥奮 奣奯奭奰奩奬奩奮奧 她奯奵奲 Idris 奣奯奤奥央 奉奦 她奯奵 奷奡奮奴 奴奯 奷奲奩奴奥 她奯奵奲 奯奷奮 奣奯奤奥奧奥奮 奦奯奲 她奯奵奲
奬奡奮奧奵奡奧奥 奴奨奥奲奥 奩女 奡 女奴奵奢 奰奲奯奪奥奣奴 奯奮 奇奩奴奈奵奢 奴奨奡奴 奣奡奮 奨奥奬奰 奰奯奩奮奴 她奯奵 奩奮 奴奨奥 奲奩奧奨奴 奤奩奲奥奣奴奩奯奮央

6.1.1 Official Backends

C Language

Javascript

奔奯 奧奥奮奥奲奡奴奥 奣奯奤奥 奴奨奡奴 奩女 奴奡奩奬奯奲奥奤 奦奯奲 奲奵奮奮奩奮奧 奩奮 奴奨奥 奢奲奯奷女奥奲 奩女女奵奥 奴奨奥 奦奯奬奬奯奷奩奮奧 奣奯奭奭奡奮奤夺

失头夷

http://creativecommons.org/publicdomain/zero/1.0/
http://creativecommons.org/publicdomain/zero/1.0/
https://github.com/idris-lang/idris-emptycg
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$ idris --codegen javascript hello.idr -o hello.js

奉奤奲奩女 奣奡奮 奰奲奯奤奵奣奥 奶奥奲她 奢奩奧 奣奨奵奮奫女 奯奦 奊奡奶奡奓奣奲奩奰奴 奣奯奤奥 夨奨奥奬奬奯 奷奯奲奬奤 奷奥奩奧奨女 奩奮 奡奴 失夵夰夰 奬奩奮奥女天央 奈奯奷奥奶奥奲夬 奴奨奥
奧奥奮奥奲奡奴奥奤 奣奯奤奥 奣奡奮 奢奥 奭奩奮奩夜奥奤 奵女奩奮奧 奴奨奥 奣奬奯女奵奲奥夭奣奯奭奰奩奬奥奲 奦奲奯奭 奇奯奯奧奬奥央

java -jar compiler.jar --compilation_level ADVANCED_OPTIMIZATIONS --js hello.js

Node.js

奇奥奮奥奲奡奴奩奮奧 奣奯奤奥 奦奯奲 奎奯奤奥奊奓 奩女 女奬奩奧奨奴奬她 奤奩夛奥奲奥奮奴央 奉奤奲奩女 奯奵奴奰奵奴女 奡 奊奡奶奡奓奣奲奩奰奴 夜奬奥 奴奨奡奴 奣奡奮 奢奥 奤奩奲奥奣奴奬她
奥奸奥奣奵奴奥奤 奶奩奡 奮奯奤奥央

$ idris --codegen node hello.idr -o hello
$ ./hello
Hello world

6.1.2 Third Party

注注注解解解: 奔奨奥女奥 奡奲奥 奴奨奩奲奤夭奰奡奲奴她 奣奯奤奥 奧奥奮奥奲奡奴奩奯奮女 奡奮奤 奭奡她 奨奡奶奥 奢奩奴夭奲奯奴奴奥奤 奯奲 奤奯 奮奯奴 奷奯奲奫 奷奩奴奨 奣奵奲奲奥奮奴
奶奥奲女奩奯奮女 奯奦 奉奤奲奩女央 奐奬奥奡女奥 女奰奥奡奫 奴奯 奴奨奥 奰奲奯奪奥奣奴’女 奭奡奩奮奴奡奩奮奯奲女 奩奦 奴奨奥奲奥 奡奲奥 奡奮她 奰奲奯奢奬奥奭女央

CIL (.NET, Mono, Unity)

idris --codegen cil Main.idr -o HelloWorld.exe \
&& mono HelloWorld.exe

奔奨奥 奲奥女奵奬奴奩奮奧 奡女女奥奭奢奬奩奥女 奣奡奮 奡奬女奯 奢奥 奵女奥奤 奷奩奴奨 央奎奅奔 奯奲 奕奮奩奴她央

奒奥奱奵奩奲奥女 奩奤奲奩女夭奣奩奬央

Erlang

奁奶奡奩奬奡奢奬奥 奯奮奬奩奮奥

Java

奁奶奡奩奬奡奢奬奥 奯奮奬奩奮奥

idris hello.idr --codegen java -o hello.jar

奎奯奴奥夺 奔奨奥 奲奥女奵奬奴奩奮奧 央奪奡奲 奩女 奡奵奴奯奭奡奴奩奣奡奬奬她 奰奲奥夜奸奥奤 奢她 奡 奨奥奡奤奥奲 奩奮奣奬奵奤奩奮奧 奡奮 央女奨 女奣奲奩奰奴 奴奯 奡奬奬奯奷 奥奸奥奣奵奴奩奮奧
奩奴 奤奩奲奥奣奴奬她央

JVM

奁奶奡奩奬奡奢奬奥 奯奮奬奩奮奥
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https://developers.google.com/closure/compiler/
https://github.com/bamboo/idris-cil
https://github.com/lenary/idris-erlang
https://github.com/idris-hackers/idris-java
https://github.com/mmhelloworld/idris-jvm
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LLVM

奁奶奡奩奬奡奢奬奥 奯奮奬奩奮奥

Malfunction

奁奶奡奩奬奡奢奬奥 奯奮奬奩奮奥

Ocaml

奁奶奡奩奬奡奢奬奥 奯奮奬奩奮奥

PHP

奁奶奡奩奬奡奢奬奥 奯奮奬奩奮奥

Python

奁奶奡奩奬奡奢奬奥 奯奮奬奩奮奥

Ruby

奁奶奡奩奬奡奢奬奥 奯奮奬奩奮奥

WS

奁奶奡奩奬奡奢奬奥 奯奮奬奩奮奥

WebAssembly

奁奶奡奩奬奡奢奬奥 奯奮奬奩奮奥

6.2 Documenting Idris Code

奉奤奲奩女 奤奯奣奵奭奥奮奴奡奴奩奯奮 奣奯奭奥女 奩奮 奴奷奯 奭奡奪奯奲 奦奯奲奭女夺 奣奯奭奭奥奮奴女夬 奷奨奩奣奨 奥奸奩女奴 奦奯奲 奡 奲奥奡奤奥奲’女 奥奤奩夜奣奡奴奩奯奮 奡奮奤
奡奲奥 奩奧奮奯奲奥奤 奢她 奴奨奥 奣奯奭奰奩奬奥奲夬 奡奮奤 奩奮奬奩奮奥 奁奐奉 奤奯奣奵奭奥奮奴奡奴奩奯奮夬 奷奨奩奣奨 奴奨奥 奣奯奭奰奩奬奥奲 奰奡奲女奥女 奡奮奤 女奴奯奲奥女 奦奯奲
奦奵奴奵奲奥 奲奥奦奥奲奥奮奣奥央 奔奯 奣奯奮女奵奬奴 奴奨奥 奤奯奣奵奭奥奮奴奡奴奩奯奮 奦奯奲 奡 奤奥奣奬奡奲奡奴奩奯奮 f夬 奷奲奩奴奥 :doc f 奡奴 奴奨奥 奒奅奐奌 奯奲 奵女奥
奴奨奥 奡奰奰奲奯奰奲奩奡奴奥 奣奯奭奭奡奮奤 奩奮 她奯奵奲 奥奤奩奴奯奲 夨C-c C-d 奩奮 奅奭奡奣女夬 <LocalLeader>h 奩奮 奖奩奭天央

6.2.1 Comments

奕女奥 奣奯奭奭奥奮奴女 奴奯 奥奸奰奬奡奩奮 奷奨她 奣奯奤奥 奩女 奷奲奩奴奴奥奮 奴奨奥 奷奡她 奴奨奡奴 奩奴 奩女央 奉奤奲奩女’女 奣奯奭奭奥奮奴 女她奮奴奡奸 奩女 奴奨奥 女奡奭奥 奡女
奴奨奡奴 奯奦 奈奡女奫奥奬奬夺 奬奩奮奥女 奢奥奧奩奮奮奩奮奧 奷奩奴奨 -- 奡奲奥 奣奯奭奭奥奮奴女夬 奡奮奤 奲奥奧奩奯奮女 奢奲奡奣奫奥奴奥奤 奢她 {- 奡奮奤 -} 奡奲奥 奣奯奭奭奥奮奴女
奥奶奥奮 奩奦 奴奨奥她 奥奸奴奥奮奤 奡奣奲奯女女 奭奵奬奴奩奰奬奥 奬奩奮奥女央 奔奨奥女奥 奣奡奮 奢奥 奵女奥奤 奴奯 奣奯奭奭奥奮奴 奯奵奴 奬奩奮奥女 奯奦 奣奯奤奥 奯奲 奰奲奯奶奩奤奥
女奩奭奰奬奥 奤奯奣奵奭奥奮奴奡奴奩奯奮 奦奯奲 奴奨奥 奲奥奡奤奥奲女 奯奦 奉奤奲奩女 奣奯奤奥央
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https://github.com/idris-hackers/idris-llvm
https://github.com/stedolan/idris-malfunction
https://github.com/ziman/idris-ocaml
https://github.com/edwinb/idris-php
https://github.com/ziman/idris-py
https://github.com/mrb/idris-ruby
https://github.com/edwinb/WS-idr
https://github.com/SPY/idris-codegen-wasm
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6.2.2 Inline Documentation

奉奤奲奩女 奡奬女奯 女奵奰奰奯奲奴女 奡 奣奯奭奰奲奥奨奥奮女奩奶奥 奡奮奤 奲奩奣奨 奩奮奬奩奮奥 女她奮奴奡奸 奦奯奲 奉奤奲奩女 奣奯奤奥 奴奯 奢奥 奧奥奮奥奲奡奴奥奤央 奔奨奩女 女她奮奴奡奸
奡奬女奯 奡奬奬奯奷女 奦奯奲 奮奡奭奥奤 奰奡奲奡奭奥奴奥奲女 奡奮奤 奶奡奲奩奡奢奬奥女 奷奩奴奨奩奮 奴她奰奥 女奩奧奮奡奴奵奲奥女 奴奯 奢奥 奩奮奤奩奶奩奤奵奡奬奬她 奡奮奮奯奴奡奴奥奤 奵女奩奮奧
奡 女她奮奴奡奸 女奩奭奩奬奡奲 奴奯 奊奡奶奡奤奯奣 奰奡奲奡奭奥奴奥奲 奡奮奮奯奴奡奴奩奯奮女央

奄奯奣奵奭奥奮奴奡奴奩奯奮 奡奬奷奡她女 奣奯奭奥女 奢奥奦奯奲奥 奴奨奥 奤奥奣奬奡奲奡奴奩奯奮 奢奥奩奮奧 奤奯奣奵奭奥奮奴奥奤央 奉奮奬奩奮奥 奤奯奣奵奭奥奮奴奡奴奩奯奮 奡奰奰奬奩奥女 奴奯
奥奩奴奨奥奲 奴奯奰夭奬奥奶奥奬 奤奥奣奬奡奲奡奴奩奯奮女 奯奲 奴奯 奣奯奮女奴奲奵奣奴奯奲女央 奄奯奣奵奭奥奮奴奡奴奩奯奮 奦奯奲 女奰奥奣奩夜奣 奡奲奧奵奭奥奮奴女 奴奯 奣奯奮女奴奲奵奣奴奯奲女夬
奴她奰奥 奣奯奮女奴奲奵奣奴奯奲女夬 奯奲 奦奵奮奣奴奩奯奮女 奣奡奮 奢奥 奡女女奯奣奩奡奴奥奤 奷奩奴奨 奴奨奥女奥 奡奲奧奵奭奥奮奴女 奵女奩奮奧 奴奨奥奩奲 奮奡奭奥女央

奔奨奥 奩奮奬奩奮奥 奤奯奣奵奭奥奮奴奡奴奩奯奮 奦奯奲 奡 奤奥奣奬奡奲奡奴奩奯奮 奩女 奡奮 奵奮奢奲奯奫奥奮 女奴奲奩奮奧 奯奦 奬奩奮奥女夬 奥奡奣奨 奯奦 奷奨奩奣奨 奢奥奧奩奮女 奷奩奴奨 |||
夨奴奨奲奥奥 奰奩奰奥 女她奭奢奯奬女天央 奔奨奥 夜奲女奴 奰奡奲奡奧奲奡奰奨 奯奦 奴奨奥 奤奯奣奵奭奥奮奴奡奴奩奯奮 奩女 奴奡奫奥奮 奴奯 奢奥 奡奮 奯奶奥奲奶奩奥奷夬 奡奮奤 奩奮 女奯奭奥
奣奯奮奴奥奸奴女夬 奯奮奬她 奴奨奩女 奯奶奥奲奶奩奥奷 奷奩奬奬 奢奥 女奨奯奷奮央 奁奦奴奥奲 奴奨奥 奤奯奣奵奭奥奮奴奡奴奩奯奮 奦奯奲 奴奨奥 奤奥奣奬奡奲奡奴奩奯奮 奡女 奡 奷奨奯奬奥夬 奩奴
奩女 奰奯女女奩奢奬奥 奴奯 奡女女奯奣奩奡奴奥 奤奯奣奵奭奥奮奴奡奴奩奯奮 奷奩奴奨 女奰奥奣奩夜奣 奮奡奭奥奤 奰奡奲奡奭奥奴奥奲女夬 奷奨奩奣奨 奣奡奮 奥奩奴奨奥奲 奢奥 奥奸奰奬奩奣奩奴奬她
奮奡奭奥 奯奲 奴奨奥 奲奥女奵奬奴女 奯奦 奣奯奮奶奥奲奴奩奮奧 奦奲奥奥 奶奡奲奩奡奢奬奥女 奴奯 奩奭奰奬奩奣奩奴 奰奡奲奡奭奥奴奥奲女央 奁奮奮奯奴奡奴奩奯奮女 奡奲奥 奴奨奥 女奡奭奥 奡女 奷奩奴奨
奊奡奶奡奤奯奣 奡奮奮奯奴奡奴奩奯奮女夬 奴奨奡奴 奩女 奦奯奲 奴奨奥 奮奡奭奥奤 奰奡奲奡奭奥奴奥奲 (n : T)夬 奴奨奥 奣奯奲奲奥女奰奯奮奤奩奮奧 奡奮奮奯奴奡奴奩奯奮 奩女 ||| @
n Some description 奴奨奡奴 奩女 奰奬奡奣奥奤 奢奥奦奯奲奥 奴奨奥 奤奥奣奬奡奲奡奴奩奯奮央

奄奯奣奵奭奥奮奴奡奴奩奯奮 奩女 奷奲奩奴奴奥奮 奩奮 奍奡奲奫奤奯奷奮夬 奴奨奯奵奧奨 奮奯奴 奡奬奬 奣奯奮奴奥奸奴女 奷奩奬奬 奤奩女奰奬奡她 奡奬奬 奰奯女女奩奢奬奥 奦奯奲奭奡奴奴奩奮奧 夨奦奯奲
奥奸奡奭奰奬奥夬 奩奭奡奧奥女 奡奲奥 奮奯奴 奤奩女奰奬奡她奥奤 奷奨奥奮 奶奩奥奷奩奮奧 奤奯奣奵奭奥奮奴奡奴奩奯奮 奩奮 奴奨奥 奒奅奐奌夬 奡奮奤 奯奮奬她 女奯奭奥 奴奥奲奭奩奮奡奬女
奲奥奮奤奥奲 奩奴奡奬奩奣女 奣奯奲奲奥奣奴奬她天央 奁 奣奯奭奰奲奥奨奥奮女奩奶奥 女奥奴 奯奦 奥奸奡奭奰奬奥女 奩女 奧奩奶奥奮 奢奥奬奯奷央

||| Modules can also be documented.
module Docs

||| Add some numbers.
|||
||| Addition is really great. This paragraph is not part of the overview.
||| Still the same paragraph.
|||
||| You can even provide examples which are inlined in the documentation:
||| ```idris example
||| add 4 5
||| ```
|||
||| Lists are also nifty:
||| * Really nifty!
||| * Yep!
||| * The name `add` is a **bold** choice
||| @ n is the recursive param
||| @ m is not
add : (n, m : Nat) -> Nat
add Z m = m
add (S n) m = S (add n m)

||| Append some vectors
||| @ a the contents of the vectors
||| @ xs the first vector (recursive param)
||| @ ys the second vector (not analysed)
appendV : (xs : Vect n a) -> (ys : Vect m a) -> Vect (add n m) a
appendV [] ys = ys
appendV (x::xs) ys = x :: appendV xs ys

||| Here's a simple datatype
data Ty =

||| Unit
UNIT |
||| Functions
ARR Ty Ty

(äÿŃéąțçżğçżŋ)
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||| Points to a place in a typing context
data Elem : Vect n Ty -> Ty -> Type where
Here : {ts : Vect n Ty} -> Elem (t::ts) t
There : {ts : Vect n Ty} -> Elem ts t -> Elem (t'::ts) t

||| A more interesting datatype
||| @ n the number of free variables
||| @ ctxt a typing context for the free variables
||| @ ty the type of the term
data Term : (ctxt : Vect n Ty) -> (ty : Ty) -> Type where

||| The constructor of the unit type
||| More comment
||| @ ctxt the typing context
UnitCon : {ctxt : Vect n Ty} -> Term ctxt UNIT

||| Function application
||| @ f the function to apply
||| @ x the argument
App : {ctxt : Vect n Ty} -> (f : Term ctxt (ARR t1 t2)) -> (x : Term ctxt t1) -> Term ctxt t2

||| Lambda
||| @ body the function body
Lam : {ctxt : Vect n Ty} -> (body : Term (t1::ctxt) t2) -> Term ctxt (ARR t1 t2)

||| Variables
||| @ i de Bruijn index
Var : {ctxt : Vect n Ty} -> (i : Elem ctxt t) -> Term ctxt t

||| A computation that may someday finish
codata Partial : Type -> Type where

||| A finished computation
||| @ value the result
Now : (value : a) -> Partial a

||| A not-yet-finished computation
||| @ rest the remaining work
Later : (rest : Partial a) -> Partial a

||| We can document records, including their fields and constructors
record Yummy where

||| Make a yummy
constructor MkYummy
||| What to eat
food : String

6.3 Packages

奉奤奲奩女 奩奮奣奬奵奤奥女 奡 女奩奭奰奬奥 女她女奴奥奭 奦奯奲 奢奵奩奬奤奩奮奧 奰奡奣奫奡奧奥女 奦奲奯奭 奡 奰奡奣奫奡奧奥 奤奥女奣奲奩奰奴奩奯奮 夜奬奥央 奔奨奥女奥 夜奬奥女 奣奡奮 奢奥
奵女奥奤 奷奩奴奨 奴奨奥 奉奤奲奩女 奣奯奭奰奩奬奥奲 奴奯 奭奡奮奡奧奥 奴奨奥 奤奥奶奥奬奯奰奭奥奮奴 奰奲奯奣奥女女 奯奦 她奯奵奲 奉奤奲奩女 奰奲奯奧奲奡奭奭奥女 奡奮奤 奰奡奣奫奡奧奥女央

6.3.1 Package Descriptions

奁 奰奡奣奫奡奧奥 奤奥女奣奲奩奰奴奩奯奮 奩奮奣奬奵奤奥女 奴奨奥 奦奯奬奬奯奷奩奮奧夺
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• 奁 奨奥奡奤奥奲夬 奣奯奮女奩女奴奩奮奧 奯奦 奴奨奥 奫奥她奷奯奲奤 奰奡奣奫奡奧奥 奦奯奬奬奯奷奥奤 奢她 奴奨奥 奰奡奣奫奡奧奥 奮奡奭奥央 奐奡奣奫奡奧奥 奮奡奭奥女 奣奡奮
奢奥 奡奮她 奶奡奬奩奤 奉奤奲奩女 奩奤奥奮奴奩夜奥奲央 奔奨奥 奩奐奋奇 奦奯奲奭奡奴 奡奬女奯 奴奡奫奥女 奡 奱奵奯奴奥奤 奶奥奲女奩奯奮 奴奨奡奴 奡奣奣奥奰奴女 奡奮她 奶奡奬奩奤
夜奬奥奮奡奭奥央

• 奆奩奥奬奤女 奤奥女奣奲奩奢奩奮奧 奰奡奣奫奡奧奥 奣奯奮奴奥奮奴女夬 <field> = <value>

奁奴 奬奥奡女奴 奯奮奥 夜奥奬奤 奭奵女奴 奢奥 奴奨奥 奭奯奤奵奬奥女 夜奥奬奤夬 奷奨奥奲奥 奴奨奥 奶奡奬奵奥 奩女 奡 奣奯奭奭奡 女奥奰奡奲奡奴奥奤 奬奩女奴 奯奦 奭奯奤奵奬奥女央 奆奯奲
奥奸奡奭奰奬奥夬 奡 奬奩奢奲奡奲她 奴奥女奴 奷奨奩奣奨 奨奡女 奴奷奯 奭奯奤奵奬奥女 foo.idr 奡奮奤 bar.idr 奡女 女奯奵奲奣奥 夜奬奥女 奷奯奵奬奤 奢奥 奷奲奩奴奴奥奮 奡女
奦奯奬奬奯奷女夺

package foo

modules = foo, bar

奏奴奨奥奲 奥奸奡奭奰奬奥女 奯奦 奰奡奣奫奡奧奥 夜奬奥女 奣奡奮 奢奥 奦奯奵奮奤 奩奮 奴奨奥 libs 奤奩奲奥奣奴奯奲她 奯奦 奴奨奥 奭奡奩奮 奉奤奲奩女 奲奥奰奯女奩奴奯奲她夬 奡奮奤 奩奮
奴奨奩奲奤夭奰奡奲奴她 奬奩奢奲奡奲奩奥女央

Metadata

奆奲奯奭 奉奤奲奩女 v0.12 奴奨奥 iPKG 奦奯奲奭奡奴 女奵奰奰奯奲奴女 奡奤奤奩奴奩奯奮奡奬 奭奥奴奡奤奡奴奡 奡女女奯奣奩奡奴奥奤 奷奩奴奨 奴奨奥 奰奡奣奫奡奧奥央 奔奨奥
奡奤奤奥奤 夜奥奬奤女 奡奲奥夺

• brief = "<text>"夬 奡 女奴奲奩奮奧 奬奩奴奥奲奡奬 奣奯奮奴奡奩奮奩奮奧 奡 奢奲奩奥奦 奤奥女奣奲奩奰奴奩奯奮 奯奦 奴奨奥 奰奡奣奫奡奧奥央

• version = <text>夬 奡 奶奥奲女奩奯奮 女奴奲奩奮奧 奴奯 奡女女奯奣奩奡奴奥 奷奩奴奨 奴奨奥 奰奡奣奫奡奧奥央

• readme = <file>夬 奬奯奣奡奴奩奯奮 奯奦 奴奨奥 奒奅奁奄奍奅 夜奬奥央

• license = <text>夬 奡 女奴奲奩奮奧 奤奥女奣奲奩奰奴奩奯奮 奯奦 奴奨奥 奬奩奣奥奮女奩奮奧 奩奮奦奯奲奭奡奴奩奯奮央

• author = <text>夬 奴奨奥 奡奵奴奨奯奲 奩奮奦奯奲奭奡奴奩奯奮央

• maintainer = <text>夬 奍奡奩奮奴奡奩奮奥奲 奩奮奦奯奲奭奡奴奩奯奮央

• homepage = <url>夬 奴奨奥 奷奥奢女奩奴奥 奡女女奯奣奩奡奴奥奤 奷奩奴奨 奴奨奥 奰奡奣奫奡奧奥央

• sourceloc = <url>夬 奴奨奥 奬奯奣奡奴奩奯奮 奯奦 奴奨奥 奄奖奃奓 奷奨奥奲奥 奴奨奥 女奯奵奲奣奥 奣奡奮 奢奥 奦奯奵奮奤央

• bugtracker = <url>夬 奴奨奥 奬奯奣奡奴奩奯奮 奯奦 奴奨奥 奰奲奯奪奥奣奴’女 奢奵奧 奴奲奡奣奫奥奲央

Common Fields

奏奴奨奥奲 奣奯奭奭奯奮 夜奥奬奤女 奷奨奩奣奨 奭奡她 奢奥 奰奲奥女奥奮奴 奩奮 奡奮 ipkg 夜奬奥 奡奲奥夺

• sourcedir = <dir>夬 奷奨奩奣奨 奴奡奫奥女 奴奨奥 奤奩奲奥奣奴奯奲她 夨奲奥奬奡奴奩奶奥 奴奯 奴奨奥 奣奵奲奲奥奮奴 奤奩奲奥奣奴奯奲她天 奷奨奩奣奨 奣奯奮奴奡奩奮女
奴奨奥 女奯奵奲奣奥央 奄奥奦奡奵奬奴 奩女 奴奨奥 奣奵奲奲奥奮奴 奤奩奲奥奣奴奯奲她央

• executable = <output>夬 奷奨奩奣奨 奴奡奫奥女 奴奨奥 奮奡奭奥 奯奦 奴奨奥 奥奸奥奣奵奴奡奢奬奥 夜奬奥 奴奯 奧奥奮奥奲奡奴奥央 奅奸奥奣奵奴奡奢奬奥
奮奡奭奥女 奣奡奮 奢奥 奡奮她 奶奡奬奩奤 奉奤奲奩女 奩奤奥奮奴奩夜奥奲央 奴奨奥 奩奐奋奇 奦奯奲奭奡奴 奡奬女奯 奴奡奫奥女 奡 奱奵奯奴奥奤 奶奥奲女奩奯奮 奴奨奡奴 奡奣奣奥奰奴女
奡奮她 奶奡奬奩奤 夜奬奥奮奡奭奥央

• main = <module>夬 奷奨奩奣奨 奴奡奫奥女 奴奨奥 奮奡奭奥 奯奦 奴奨奥 奭奡奩奮 奭奯奤奵奬奥夬 奡奮奤 奭奵女奴 奢奥 奰奲奥女奥奮奴 奩奦 奴奨奥 奥奸奥奣奵奴奡奢奬奥
夜奥奬奤 奩女 奰奲奥女奥奮奴央

• opts = "<idris options>"夬 奷奨奩奣奨 奡奬奬奯奷女 奯奰奴奩奯奮女 奴奯 奢奥 奰奡女女奥奤 奴奯 奉奤奲奩女央

• pkgs = <pkg name> (',' <pkg name>)+夬 奡 奣奯奭奭奡 女奥奰奡奲奡奴奥奤 奬奩女奴 奯奦 奰奡奣奫奡奧奥 奮奡奭奥女 奴奨奡奴 奴奨奥 奉奤奲奩女
奰奡奣奫奡奧奥 奲奥奱奵奩奲奥女央
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Binding to C

奉奮 奭奯奲奥 奡奤奶奡奮奣奥奤 奣奡女奥女夬 奰奡奲奴奩奣奵奬奡奲奬她 奴奯 女奵奰奰奯奲奴 奣奲奥奡奴奩奮奧 奢奩奮奤奩奮奧女 奴奯 奥奸奴奥奲奮奡奬 C 奬奩奢奲奡奲奩奥女夬 奴奨奥 奦奯奬奬奯奷奩奮奧
奯奰奴奩奯奮女 奡奲奥 奡奶奡奩奬奡奢奬奥夺

• makefile = <file>夬 奷奨奩奣奨 女奰奥奣奩夜奥女 奡 Makefile夬 奴奯 奢奥 奢奵奩奬奴 奢奥奦奯奲奥 奴奨奥 奉奤奲奩女 奭奯奤奵奬奥女夬 奦奯奲 奥奸夭
奡奭奰奬奥 奴奯 女奵奰奰奯奲奴 奬奩奮奫奩奮奧 奷奩奴奨 奡 C 奬奩奢奲奡奲她央 套奨奥奮 奢奵奩奬奤奩奮奧夬 奉奤奲奩女 女奥奴女 奴奨奥 奥奮奶奩奲奯奮奭奥奮奴 奶奡奲奩奡奢奬奥女
IDRIS_INCLUDES 夨奷奩奴奨 奃 奩奮奣奬奵奤奥 夝奡奧女天 奡奮奤 IDRIS_LDFLAGS 夨奷奩奴奨 奃 奬奩奮奫奩奮奧 夝奡奧女天 女奯 奴奨奥她 奣奡奮 奢奥
奵女奥奤 奦奲奯奭 奩奮女奩奤奥 奴奨奥 Makefile央

• libs = <libs>夬 奷奨奩奣奨 奴奡奫奥女 奡 奣奯奭奭奡 女奥奰奡奲奡奴奥奤 奬奩女奴 奯奦 奬奩奢奲奡奲奩奥女 奷奨奩奣奨 奭奵女奴 奢奥 奰奲奥女奥奮奴 奦奯奲 奴奨奥
奰奡奣奫奡奧奥 奴奯 奢奥 奵女奡奢奬奥央

• objs = <objs>夬 奷奨奩奣奨 奴奡奫奥女 奡 奣奯奭奭奡 女奥奰奡奲奡奴奥奤 奬奩女奴 奯奦 奡奤奤奩奴奩奯奮奡奬 夜奬奥女 奴奯 奢奥 奩奮女奴奡奬奬奥奤 夨奯奢奪奥奣奴 夜奬奥女夬
奨奥奡奤奥奲女天夬 奰奥奲奨奡奰女 奧奥奮奥奲奡奴奥奤 奢她 奴奨奥 Makefile央

Testing

奆奯奲 奴奥女奴奩奮奧 奉奤奲奩女 奰奡奣奫奡奧奥女 奴奨奥奲奥 奩女 奡 奲奵奤奩奭奥奮奴奡奲她 奴奥女奴奩奮奧 奨奡奲奮奥女女夬 奲奵奮 奩奮 奴奨奥 IO 奣奯奮奴奥奸奴央 奔奨奥 iPKG 夜奬奥 奩女
奵女奥奤 奴奯 女奰奥奣奩奦她 奴奨奥 奦奵奮奣奴奩奯奮女 奵女奥奤 奦奯奲 奴奥女奴奩奮奧央 奔奨奥 奦奯奬奬奯奷奩奮奧 奯奰奴奩奯奮 奩女 奡奶奡奩奬奡奢奬奥夺

• tests = <test functions>夬 奷奨奩奣奨 奴奡奫奥女 奴奨奥 奱奵奡奬奩夜奥奤 奮奡奭奥女 奯奦 奡奬奬 奴奥女奴 奦奵奮奣奴奩奯奮女 奴奯 奢奥 奲奵奮央

重重重要要要: 奔奨奥 奭奯奤奵奬奥女 奣奯奮奴奡奩奮奩奮奧 奴奨奥 奴奥女奴 奦奵奮奣奴奩奯奮女 奭奵女奴 奡奬女奯 奢奥 奡奤奤奥奤 奴奯 奴奨奥 奬奩女奴 奯奦 奭奯奤奵奬奥女央

Comments

奐奡奣奫奡奧奥 夜奬奥女 女奵奰奰奯奲奴 奣奯奭奭奥奮奴女 奵女奩奮奧 奴奨奥 女奴奡奮奤奡奲奤 奉奤奲奩女 女奩奮奧奬奥奬奩奮奥 -- 奡奮奤 奭奵奬奴奩奬奩奮奥 {- -} 奦奯奲奭奡奴央

6.3.2 Using Package files

奇奩奶奥奮 奡奮 奉奤奲奩女 奰奡奣奫奡奧奥 夜奬奥 test.ipkg 奩奴 奣奡奮 奢奥 奵女奥奤 奷奩奴奨 奴奨奥 奉奤奲奩女 奣奯奭奰奩奬奥奲 奡女 奦奯奬奬奯奷女夺

• idris --build test.ipkg 奷奩奬奬 奢奵奩奬奤 奡奬奬 奭奯奤奵奬奥女 奩奮 奴奨奥 奰奡奣奫奡奧奥

• idris --install test.ipkg 奷奩奬奬 奩奮女奴奡奬奬 奴奨奥 奰奡奣奫奡奧奥夬 奭奡奫奩奮奧 奩奴 奡奣奣奥女女奩奢奬奥 奢她 奯奴奨奥奲 奉奤奲奩女 奬奩奢奲奡奲奩奥女
奡奮奤 奰奲奯奧奲奡奭女央

• idris --clean test.ipkg 奷奩奬奬 奤奥奬奥奴奥 奡奬奬 奩奮奴奥奲奭奥奤奩奡奴奥 奣奯奤奥 奡奮奤 奥奸奥奣奵奴奡奢奬奥 夜奬奥女 奧奥奮奥奲奡奴奥奤 奷奨奥奮
奢奵奩奬奤奩奮奧央

• idris --mkdoc test.ipkg 奷奩奬奬 奢奵奩奬奤 奈奔奍奌 奤奯奣奵奭奥奮奴奡奴奩奯奮 奦奯奲 她奯奵奲 奰奡奣奫奡奧奥 奩奮 奴奨奥 奦奯奬奤奥奲
test_doc 奩奮 她奯奵奲 奰奲奯奪奥奣奴’女 奲奯奯奴 奤奩奲奥奣奴奯奲她央

• idris --installdoc test.ipkg 奷奩奬奬 奩奮女奴奡奬奬 奴奨奥 奰奡奣奫奡奧奥女 奤奯奣奵奭奥奮奴奡奴奩奯奮 奩奮奴奯 奉奤奲奩女’ 奣奥奮奴奲奡奬 奤奯奣夭
奵奭奥奮奴奡奴奩奯奮 奦奯奬奤奥奲 奬奯奣奡奴奥奤 奡奴 idris --docdir央

• idris --checkpkg test.ipkg 奷奩奬奬 奴她奰奥 奣奨奥奣奫 奡奬奬 奭奯奤奵奬奥女 奩奮 奴奨奥 奰奡奣奫奡奧奥 奯奮奬她央 奔奨奩女 奤奩夛奥奲女 奦奲奯奭
奢奵奩奬奤 奴奨奡奴 奴她奰奥 奣奨奥奣奫女 and 奧奥奮奥奲奡奴奥女 奣奯奤奥央

• idris --testpkg test.ipkg 奷奩奬奬 奣奯奭奰奩奬奥 奡奮奤 奲奵奮 奡奮她 奥奭奢奥奤奤奥奤 奴奥女奴女 她奯奵 奨奡奶奥 女奰奥奣奩夜奥奤 奩奮 奴奨奥
tests 奰奡奲奡奭奥奴奥奲央
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套奨奥奮 奢奵奩奬奤奩奮奧 奯奲 奩奮女奴奡奬奬 奰奡奣奫奡奧奥女 奴奨奥 奣奯奭奭奡奮奤奬奩奮奥 夝奡奧 --warnipkg 奷奩奬奬 奡奵奤奩奴 奴奨奥 奰奲奯奪奥奣奴 奡奮奤 奷奡奲奮 奯奦
奡奮她 奰奯奴奥奮奴奩奡奢奬奥 奰奲奯奢奬奥奭女央

奏奮奣奥 奴奨奥 奴奥女奴 奰奡奣奫奡奧奥 奨奡女 奢奥奥奮 奩奮女奴奡奬奬奥奤夬 奴奨奥 奣奯奭奭奡奮奤 奬奩奮奥 奯奰奴奩奯奮 --package test 奭奡奫奥女 奩奴 奡奣奣奥女女奩奢奬奥
夨奡奢奢奲奥奶奩奡奴奥奤 奴奯 -p test天央 奆奯奲 奥奸奡奭奰奬奥夺

idris -p test Main.idr

6.4 Uniqueness Types

奕奮奩奱奵奥奮奥女女 奔她奰奥女 奡奲奥 奡奮 奥奸奰奥奲奩奭奥奮奴奡奬 奦奥奡奴奵奲奥 奡奶奡奩奬奡奢奬奥 奦奲奯奭 奉奤奲奩女 夰央夹央失夵央 奁 奶奡奬奵奥 奷奩奴奨 奡 奵奮奩奱奵奥 奴她奰奥 奩女
奧奵奡奲奡奮奴奥奥奤 奴奯 奨奡奶奥 at most one 奲奥奦奥奲奥奮奣奥 奴奯 奩奴 奡奴 奲奵奮夭奴奩奭奥夬 奷奨奩奣奨 奭奥奡奮女 奴奨奡奴 奩奴 奣奡奮 女奡奦奥奬她 奢奥 奵奰奤奡奴奥奤
奩奮夭奰奬奡奣奥夬 奲奥奤奵奣奩奮奧 奴奨奥 奮奥奥奤 奦奯奲 奭奥奭奯奲她 奡奬奬奯奣奡奴奩奯奮 奡奮奤 奧奡奲奢奡奧奥 奣奯奬奬奥奣奴奩奯奮央 奔奨奥 奭奯奴奩奶奡奴奩奯奮 奩女 奴奨奡奴 奷奥
奷奯奵奬奤 奬奩奫奥 奴奯 奢奥 奡奢奬奥 奴奯 奷奲奩奴奥 奲奥奡奣奴奩奶奥 女她女奴奥奭女夬 奰奲奯奧奲奡奭女 奷奨奩奣奨 奲奵奮 奩奮 奬奩奭奩奴奥奤 奭奥奭奯奲她 奥奮奶奩奲奯奮奭奥奮奴女夬
奤奥奶奩奣奥 奤奲奩奶奥奲女夬 奡奮奤 奡奮她 奯奴奨奥奲 女她女奴奥奭 奷奩奴奨 奨奡奲奤 奲奥奡奬夭奴奩奭奥 奲奥奱奵奩奲奥奭奥奮奴女夬 奩奤奥奡奬奬她 奷奨奩奬奥 奧奩奶奩奮奧 奵奰 奡女 奬奩奴奴奬奥
奨奩奧奨 奬奥奶奥奬 奣奯奮奶奥奮奩奥奮奣奥女 奡女 奰奯女女奩奢奬奥央

奔奨奥她 奡奲奥 奩奮女奰奩奲奥奤 奢她 奬奩奮奥奡奲 奴她奰奥女夬 奕奮奩奱奵奥奮奥女女 奔她奰奥女 奩奮 奴奨奥 奃奬奥奡奮 奰奲奯奧奲奡奭奭奩奮奧 奬奡奮奧奵奡奧奥夬 奡奮奤 奯奷奮奥奲女奨奩奰
奴她奰奥女 奡奮奤 奢奯奲奲奯奷奥奤 奰奯奩奮奴奥奲女 奩奮 奴奨奥 奒奵女奴 奰奲奯奧奲奡奭奭奩奮奧 奬奡奮奧奵奡奧奥央

奓奯奭奥 奴奨奩奮奧女 奷奥 奨奯奰奥 奴奯 奢奥 奡奢奬奥 奴奯 奤奯 奥奶奥奮奴奵奡奬奬她 奷奩奴奨 奵奮奩奱奵奥奮奥女女 奴她奰奥女 奩奮奣奬奵奤奥夺

• 奓奡奦奥夬 奰奵奲奥夬 奩奮夭奰奬奡奣奥 奵奰奤奡奴奥 奯奦 奡奲奲奡她女夬 奬奩女奴女夬 奥奴奣

• 奐奲奯奶奩奤奥 奧奵奡奲奡奮奴奥奥女 奯奦 奣奯奲奲奥奣奴 奲奥女奯奵奲奣奥 奵女奡奧奥夬 女奴奡奴奥 奴奲奡奮女奩奴奩奯奮女夬 奥奴奣

• 奐奲奯奶奩奤奥 奧奵奡奲奡奮奴奥奥女 奴奨奡奴 奣奲奩奴奩奣奡奬 奰奲奯奧奲奡奭 奦奲奡奧奭奥奮奴女 奷奩奬奬 never 奡奬奬奯奣奡奴奥

6.4.1 Using Uniqueness

奉奦 x : T 奡奮奤 T : UniqueType夬 奴奨奥奮 奴奨奥奲奥 奩女 奡奴 奭奯女奴 奯奮奥 奲奥奦奥奲奥奮奣奥 奴奯 x 奡奴 奡奮她 奴奩奭奥 奤奵奲奩奮奧 奲奵奮夭奴奩奭奥
奥奸奥奣奵奴奩奯奮央 奆奯奲 奥奸奡奭奰奬奥夬 奷奥 奣奡奮 奤奥奣奬奡奲奥 奴奨奥 奴她奰奥 奯奦 奵奮奩奱奵奥 奬奩女奴女 奡女 奦奯奬奬奯奷女夺

data UList : Type -> UniqueType where
Nil : UList a
(::) : a -> UList a -> UList a

奉奦 奷奥 奨奡奶奥 奡 奶奡奬奵奥 xs : UList a夬 奴奨奥奮 奴奨奥奲奥 奩女 奡奴 奭奯女奴 奯奮奥 奲奥奦奥奲奥奮奣奥 奴奯 xs 奡奴 奲奵奮夭奴奩奭奥央 奔奨奥 奴她奰奥
奣奨奥奣奫奥奲 奰奲奥女奥奲奶奥女 奴奨奩女 奧奵奡奲奡奮奴奥奥 奢她 奥奮女奵奲奩奮奧 奴奨奡奴 奴奨奥奲奥 奩女 奡奴 奭奯女奴 奯奮奥 奲奥奦奥奲奥奮奣奥 奴奯 奡奮她 奶奡奬奵奥 奯奦 奡 奵奮奩奱奵奥
奴她奰奥 奩奮 奡 奰奡奴奴奥奲奮 奣奬奡奵女奥央 奆奯奲 奥奸奡奭奰奬奥夬 奴奨奥 奦奯奬奬奯奷奩奮奧 奦奵奮奣奴奩奯奮 奤奥夜奮奩奴奩奯奮 奷奯奵奬奤 奢奥 奶奡奬奩奤夺

umap : (a -> b) -> UList a -> UList b
umap f [] = []
umap f (x :: xs) = f x :: umap f xs

奉奮 奴奨奥 女奥奣奯奮奤 奣奬奡奵女奥夬 xs 奩女 奡 奶奡奬奵奥 奯奦 奡 奵奮奩奱奵奥 奴她奰奥夬 奡奮奤 奯奮奬她 奡奰奰奥奡奲女 奯奮奣奥 奯奮 奴奨奥 奲奩奧奨奴 奨奡奮奤 女奩奤奥夬 女奯 奴奨奩女
奣奬奡奵女奥 奩女 奶奡奬奩奤央 奎奯奴 奯奮奬她 奴奨奡奴夬 女奩奮奣奥 奷奥 奫奮奯奷 奴奨奥奲奥 奣奡奮 奢奥 奮奯 奯奴奨奥奲 奲奥奦奥奲奥奮奣奥 奴奯 奴奨奥 UList a 奡奲奧奵奭奥奮奴夬
奷奥 奣奡奮 奲奥奵女奥 奩奴女 女奰奡奣奥 奦奯奲 奢奵奩奬奤奩奮奧 奴奨奥 奲奥女奵奬奴夡 奔奨奥 奣奯奭奰奩奬奥奲 奩女 奡奷奡奲奥 奯奦 奴奨奩女夬 奡奮奤 奣奯奭奰奩奬奥女 奴奨奩女 奤奥夜奮奩奴奩奯奮
奴奯 奡奮 奩奮夭奰奬奡奣奥 奵奰奤奡奴奥 奯奦 奴奨奥 奬奩女奴央

奔奨奥 奦奯奬奬奯奷奩奮奧 奦奵奮奣奴奩奯奮 奤奥夜奮奩奴奩奯奮 奷奯奵奬奤 奮奯奴 奢奥 奶奡奬奩奤 夨奥奶奥奮 奡女女奵奭奩奮奧 奡奮 奩奭奰奬奥奭奥奮奴奡奴奩奯奮 奯奦 ++天夬 奨奯奷奥奶奥奲夬
女奩奮奣奥 xs 奡奰奰奥奡奲女 奴奷奩奣奥夺

dupList : UList a -> UList a
dupList xs = xs ++ xs

6.4. Uniqueness Types 154

https://en.wikipedia.org/wiki/Uniqueness_type
http://wiki.clean.cs.ru.nl/Clean
https://www.rust-lang.org/


Idris 语语语言言言文文文档档档, 版版版本本本 1.3.1

奔奨奩女 奷奯奵奬奤 奲奥女奵奬奴 奩奮 奡 女奨奡奲奥奤 奰奯奩奮奴奥奲 奴奯 xs夬 女奯 奴奨奥 奴她奰奥奣奨奥奣奫奥奲 奲奥奰奯奲奴女夺

unique.idr:12:5:Unique name xs is used more than once

奉奦 奷奥 奥奸奰奬奩奣奩奴奬她 奣奯奰她夬 奨奯奷奥奶奥奲夬 奴奨奥 奴她奰奥奣奨奥奣奫奥奲 奩女 奨奡奰奰她夺

dup : UList a -> UList a
dup [] = []
dup (x :: xs) = x :: x :: dup xs

奎奯奴奥 奴奨奡奴 奩奴’女 夜奮奥 奴奯 奵女奥 x 奴奷奩奣奥夬 奢奥奣奡奵女奥 a 奩女 奡 Type夬 奲奡奴奨奥奲 奴奨奡奮 奡 UniqueType央

奔奨奥奲奥 奡奲奥 女奯奭奥 奯奴奨奥奲 奲奥女奴奲奩奣奴奩奯奮女 奯奮 奷奨奥奲奥 奡 UniqueType 奣奡奮 奡奰奰奥奡奲夬 女奯 奴奨奡奴 奴奨奥 奵奮奩奱奵奥奮奥女女 奰奲奯奰奥奲奴她
奩女 奰奲奥女奥奲奶奥奤央 奉奮 奰奡奲奴奩奣奵奬奡奲夬 奴奨奥 奴她奰奥 奯奦 奴奨奥 奦奵奮奣奴奩奯奮 奴她奰奥夬 (x : a) -> b 奤奥奰奥奮奤女 奯奮 奴奨奥 奴她奰奥 奯奦 a 奯奲
b 夭 奩奦 奥奩奴奨奥奲 奩女 奡 UniqueType夬 奴奨奥奮 奴奨奥 奦奵奮奣奴奩奯奮 奴她奰奥 奩女 奡奬女奯 奡 UniqueType央 奔奨奥奮夬 奩奮 奡 奤奡奴奡 奤奥奣奬奡奲奡奴奩奯奮夬
奩奦 奴奨奥 奴她奰奥 奣奯奮女奴奲奵奣奴奯奲 奢奵奩奬奤女 奡 Type夬 奴奨奥奮 奮奯 奣奯奮女奴奲奵奣奴奯奲 奣奡奮 奨奡奶奥 奡 UniqueType央 奆奯奲 奥奸奡奭奰奬奥夬 奴奨奥
奦奯奬奬奯奷奩奮奧 奤奥夜奮奩奴奩奯奮 奩女 奩奮奶奡奬奩奤夬 女奩奮奣奥 奩奴 奷奯奵奬奤 奥奭奢奥奤 奡 奵奮奩奱奵奥 奶奡奬奵奥 奩奮 奡 奰奯女女奩奢奬奥 奮奯奮夭奵奮奩奱奵奥 奶奡奬奵奥夺

data BadList : UniqueType -> Type where
Nil : {a : UniqueType} -> BadList a
(::) : {a : UniqueType} -> a -> BadList a -> BadList a

奆奩奮奡奬奬她夬 奴她奰奥女 奭奡她 奢奥 奰奯奬她奭奯奲奰奨奩奣 奩奮 奴奨奥奩奲 奵奮奩奱奵奥奮奥女女夬 奴奯 奡 奬奩奭奩奴奥奤 奥奸奴奥奮奴央 奓奩奮奣奥 Type 奡奮奤 UniqueType
奡奲奥 奤奩夛奥奲奥奮奴 奴她奰奥女夬 奷奥 奡奲奥 奬奩奭奩奴奥奤 奩奮 奨奯奷 奭奵奣奨 奷奥 奣奡奮 奵女奥 奰奯奬她奭奯奲奰奨奩奣 奦奵奮奣奴奩奯奮女 奯奮 奵奮奩奱奵奥 奴她奰奥女央 奆奯奲
奥奸奡奭奰奬奥夬 奩奦 奷奥 奨奡奶奥 奦奵奮奣奴奩奯奮 奣奯奭奰奯女奩奴奩奯奮 奤奥夜奮奥奤 奡女 奦奯奬奬奯奷女夺

(.) : {a, b, c : Type} -> (b -> c) -> (a -> b) -> a -> c
(.) f g x = f (g x)

奁奮奤 奷奥 奨奡奶奥 女奯奭奥 奦奵奮奣奴奩奯奮女 奯奶奥奲 奵奮奩奱奵奥 奴她奰奥女夺

foo : UList a -> UList b
bar : UList b -> UList c

奔奨奥奮 奷奥 奣奡奮奮奯奴 奣奯奭奰奯女奥 foo 奡奮奤 bar 奡女 bar . foo夬 奢奥奣奡奵女奥 UList 奤奯奥女 奮奯奴 奣奯奭奰奵奴奥 奡 Type夡 奉奮女奴奥奡奤夬
奷奥 奣奡奮 奤奥夜奮奥 奣奯奭奰奯女奩奴奩奯奮 奡女 奦奯奬奬奯奷女夺

(.) : {a, b, c : Type*} -> (b -> c) -> (a -> b) -> a -> c
(.) f g x = f (g x)

奔奨奥 Type* 奴她奰奥 女奴奡奮奤女 奦奯奲 奥奩奴奨奥奲 奵奮奩奱奵奥 奯奲 奮奯奮夭奵奮奩奱奵奥 奴她奰奥女央 奓奩奮奣奥 女奵奣奨 奡 奦奵奮奣奴奩奯奮 奭奡她 奢奥 奰奡女女奥奤 奡
UniqueType夬 奡奮她 奶奡奬奵奥 奯奦 奴她奰奥 Type* 奭奵女奴 奡奬女奯 女奡奴奩女奦她 奴奨奥 奲奥奱奵奩奲奥奭奥奮奴 奴奨奡奴 奩奴 奡奰奰奥奡奲女 奡奴 奭奯女奴 奯奮奣奥 奯奮
奴奨奥 奲奩奧奨奴 奨奡奮奤 女奩奤奥央

Borrowed Types

奉奴 奱奵奩奣奫奬她 奢奥奣奯奭奥女 奯奢奶奩奯奵女 奷奨奥奮 奷奯奲奫奩奮奧 奷奩奴奨 奵奮奩奱奵奥奮奥女女 奴她奰奥女 奴奨奡奴 奨奡奶奩奮奧 奯奮奬她 奯奮奥 奲奥奦奥奲奥奮奣奥 奡奴 奡 奴奩奭奥
奣奡奮 奢奥 奰奡奩奮奦奵奬央 奆奯奲 奥奸奡奭奰奬奥夬 奷奨奡奴 奩奦 奷奥 奷奡奮奴 奴奯 奤奩女奰奬奡她 奡 奬奩女奴 奢奥奦奯奲奥 奵奰奤奡奴奩奮奧 奩奴夿

showU : Show a => UList a -> String
showU xs = "[" ++ showU' xs ++ "]" where

showU' : UList a -> String
showU' [] = ""
showU' [x] = show x
showU' (x :: xs) = show x ++ ", " ++ showU' xs

奔奨奩女 奩女 奡 奶奡奬奩奤 奤奥夜奮奩奴奩奯奮 奯奦 showU夬 奢奵奴 奵奮奦奯奲奴奵奮奡奴奥奬她 奩奴 奣奯奮女奵奭奥女 奴奨奥 奬奩女奴夡 奓奯 奴奨奥 奦奯奬奬奯奷奩奮奧 奦奵奮奣奴奩奯奮
奷奯奵奬奤 奢奥 奩奮奶奡奬奩奤夺
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printAndUpdate : UList Int -> IO ()
printAndUpdate xs = do putStrLn (showU xs)

let xs' = umap (*2) xs -- xs no longer available!
putStrLn (showU xs')

奓奴奩奬奬夬 奯奮奥 奷奯奵奬奤 奨奯奰奥 奴奯 奢奥 奡奢奬奥 奴奯 奤奩女奰奬奡她 奡 奵奮奩奱奵奥 奬奩女奴 奷奩奴奨奯奵奴 奰奲奯奢奬奥奭夬 女奩奮奣奥 奩奴 奭奥奲奥奬她 inspects 奴奨奥 奬奩女奴夻
奴奨奥奲奥 奡奲奥 奮奯 奵奰奤奡奴奥女央 套奥 奣奡奮 奡奣奨奩奥奶奥 奴奨奩女夬 奵女奩奮奧 奴奨奥 奮奯奴奩奯奮 奯奦 borrowing央 奁 奂奯奲奲奯奷奥奤 奴她奰奥 奩女 奡 奕奮奩奱奵奥
奴她奰奥 奷奨奩奣奨 奣奡奮 奢奥 奩奮女奰奥奣奴奥奤 奡奴 奴奨奥 奴奯奰 奬奥奶奥奬 夨奢她 奰奡奴奴奥奲奮 奭奡奴奣奨奩奮奧夬 奯奲 奢她 lending 奴奯 奡奮奯奴奨奥奲 奦奵奮奣奴奩奯奮天
奢奵奴 奮奯 奦奵奲奴奨奥奲央 奔奨奩女 奥奮女奵奲奥女 奴奨奡奴 奴奨奥 奩奮奴奥奲奮奡奬女 夨奩央奥央 奴奨奥 奡奲奧奵奭奥奮奴女 奴奯 奴奯奰 奬奥奶奥奬 奰奡奴奴奥奲奮女天 奷奩奬奬 奮奯奴 奢奥
奰奡女女奥奤 奴奯 奡奮她 奦奵奮奣奴奩奯奮 奷奨奩奣奨 奷奩奬奬 奵奰奤奡奴奥 奴奨奥奭央

Borrowed 奣奯奮奶奥奲奴女 奡 UniqueType 奴奯 奡 BorrowedType央 奉奴 奩女 奤奥夜奮奥奤 奡女 奦奯奬奬奯奷女 夨奡奬奯奮奧 奷奩奴奨 女奯奭奥 奡奤奤奩奴奩奯奮奡奬
奲奵奬奥女 奩奮 奴奨奥 奴她奰奥奣奨奥奣奫奥奲天夺

data Borrowed : UniqueType -> BorrowedType where
Read : {a : UniqueType} -> a -> Borrowed a

implicit
lend : {a : UniqueType} -> a -> Borrowed a
lend x = Read x

奁 奶奡奬奵奥 奣奡奮 奢奥“奬奥奮奴” 奴奯 奡奮奯奴奨奥奲 奦奵奮奣奴奩奯奮 奵女奩奮奧 lend央 奁奲奧奵奭奥奮奴女 奴奯 lend 奡奲奥 奮奯奴 奣奯奵奮奴奥奤 奢她 奴奨奥 奴她奰奥
奣奨奥奣奫奥奲 奡女 奡 奲奥奦奥奲奥奮奣奥 奴奯 奡 奵奮奩奱奵奥 奶奡奬奵奥夬 奴奨奥奲奥奦奯奲奥 奡 奶奡奬奵奥 奣奡奮 奢奥 奬奥奮奴 奡女 奭奡奮她 奴奩奭奥女 奡女 奤奥女奩奲奥奤央 奕女奩奮奧
奴奨奩女夬 奷奥 奣奡奮 奷奲奩奴奥 showU 奡女 奦奯奬奬奯奷女夺

showU : Show a => Borrowed (UList a) -> String
showU xs = "[" ++ showU' xs ++ "]" where
showU' : Borrowed (UList a) -> String
showU' [] = ""
showU' [x] = show x
showU' (Read (x :: xs)) = show x ++ ", " ++ showU' (lend xs)

奕奮奬奩奫奥 奡 奵奮奩奱奵奥 奶奡奬奵奥夬 奡 奢奯奲奲奯奷奥奤 奶奡奬奵奥 奭奡她 奢奥 奲奥奦奥奲奲奥奤 奴奯 奡女 奭奡奮她 奴奩奭奥女 奡女 奤奥女奩奲奥奤央 奈奯奷奥奶奥奲夬 奴奨奥奲奥 奩女 奡
奲奥女奴奲奩奣奴奩奯奮 奯奮 奨奯奷 奡 奢奯奲奲奯奷奥奤 奶奡奬奵奥 奣奡奮 奢奥 奵女奥奤央 奁奦奴奥奲 奡奬奬夬 奭奵奣奨 奬奩奫奥 奡 奬奩奢奲奡奲她 奢奯奯奫 奯奲 她奯奵奲 奮奥奩奧奨奢奯奵奲’女
奬奡奷奮奭奯奷奥奲夬 奩奦 奡 奦奵奮奣奴奩奯奮 奢奯奲奲奯奷女 奡 奶奡奬奵奥 奩奴 奩女 奥奸奰奥奣奴奥奤 奴奯 奲奥奴奵奲奮 奩奴 奩奮 奥奸奡奣奴奬她 奴奨奥 奣奯奮奤奩奴奩奯奮 奩奮 奷奨奩奣奨 奩奴
奷奡女 奲奥奣奥奩奶奥奤夡

奔奨奥 奲奥女奴奲奩奣奴奩奯奮 奩女 奴奨奡奴 奷奨奥奮 奡 Borrowed 奴她奰奥 奩女 奭奡奴奣奨奥奤夬 奡奮她 奰奡奴奴奥奲奮 奶奡奲奩奡奢奬奥女 奵奮奤奥奲 奴奨奥 Read 奷奨奩奣奨
奨奡奶奥 奡 奵奮奩奱奵奥 奴她奰奥 奭奡她 奮奯奴 奢奥 奲奥奦奥奲奲奥奤 奴奯 奡奴 奡奬奬 奯奮 奴奨奥 奲奩奧奨奴 奨奡奮奤 女奩奤奥 夨奵奮奬奥女女 奴奨奥她 奡奲奥 奴奨奥奭女奥奬奶奥女 lent
奴奯 奡奮奯奴奨奥奲 奦奵奮奣奴奩奯奮天央

奕奮奩奱奵奥奮奥女女 奩奮奦奯奲奭奡奴奩奯奮 奩女 女奴奯奲奥奤 奩奮 奴奨奥 奴她奰奥夬 奡奮奤 奩奮 奰奡奲奴奩奣奵奬奡奲 奩奮 奦奵奮奣奴奩奯奮 奴她奰奥女央 奏奮奣奥 奷奥’奲奥 奩奮 奡 奵奮奩奱奵奥
奣奯奮奴奥奸奴夬 奡奮她 奮奥奷 奦奵奮奣奴奩奯奮 奷奨奩奣奨 奩女 奣奯奮女奴奲奵奣奴奥奤 奷奩奬奬 奢奥 奲奥奱奵奩奲奥奤 奴奯 奨奡奶奥 奵奮奩奱奵奥 奴她奰奥夬 奷奨奩奣奨 奰奲奥奶奥奮奴女 奴奨奥
奦奯奬奬奯奷奩奮奧 女奯奲奴 奯奦 奢奡奤 奰奲奯奧奲奡奭 奢奥奩奮奧 奩奭奰奬奥奭奥奮奴奥奤夺

foo : UList Int -> IO ()
foo xs = do let f = \x : Int => showU xs

putStrLn $ free xs
putStrLn $ f 42
pure ()

奓奩奮奣奥 lend 奩女 奩奭奰奬奩奣奩奴夬 奩奮 奰奲奡奣奴奩奣奥 奦奯奲 奦奵奮奣奴奩奯奮女 奴奯 奬奥奮奤 奡奮奤 奢奯奲奲奯奷 奶奡奬奵奥女 奭奥奲奥奬她 奲奥奱奵奩奲奥女 奴奨奥 奡奲奧奵奭奥奮奴
奴奯 奢奥 奭奡奲奫奥奤 奡女 Borrowed央 套奥 奣奡奮 奴奨奥奲奥奦奯奲奥 奷奲奩奴奥 showU 奡女 奦奯奬奬奯奷女夺

showU : Show a => Borrowed (UList a) -> String
showU xs = "[" ++ showU' xs ++ "]" where
showU' : Borrowed (UList a) -> String
showU' [] = ""
showU' [x] = show x
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showU' (x :: xs) = show x ++ ", " ++ showU' xs

Problems/Disadvantages/Still to do………

奔奨奩女 奩女 奡 奷奯奲奫 奩奮 奰奲奯奧奲奥女女夬 奴奨奥奲奥 奩女 奬奯奴女 奴奯 奤奯央 奔奨奥 奭奯女奴 奯奢奶奩奯奵女 奰奲奯奢奬奥奭 奩女 奴奨奥 奬奯女女 奯奦 奡奢女奴奲奡奣奴奩奯奮央 奏奮
奴奨奥 奯奮奥 奨奡奮奤夬 奷奥 奨奡奶奥 奭奯奲奥 奰奲奥奣奩女奥 奣奯奮奴奲奯奬 奯奶奥奲 奭奥奭奯奲她 奵女奡奧奥 奷奩奴奨 UniqueType 奡奮奤 BorrowedType夬
奢奵奴 奴奨奥她 奡奲奥 奮奯奴 奩奮 奧奥奮奥奲奡奬 奣奯奭奰奡奴奩奢奬奥 奷奩奴奨 奦奵奮奣奴奩奯奮女 奰奯奬她奭奯奲奰奨奩奣 奯奶奥奲 Type央 奉奮 奴奨奥 女奨奯奲奴 奴奥奲奭夬 奷奥 奣奡奮
女奴奡奲奴 奴奯 奷奲奩奴奥 奲奥奡奣奴奩奶奥 奡奮奤 奬奯奷 奭奥奭奯奲她 女她女奴奥奭女 奷奩奴奨 奴奨奩女夬 奢奵奴 奬奯奮奧奥奲 奴奥奲奭 奩奴 奷奯奵奬奤 奢奥 奮奩奣奥 奴奯 女奵奰奰奯奲奴
奭奯奲奥 奡奢女奴奲奡奣奴奩奯奮央

套奥 奡奬女奯 奨奡奶奥奮’奴 奣奨奥奣奫奥奤 奡奮她 奯奦 奴奨奥 奭奥奴奡奴奨奥奯奲她夬 女奯 奴奨奩女 奣奯奵奬奤 奡奬奬 奢奥 奦奡奴奡奬奬她 夝奡奷奥奤夡 奔奨奥 奩奭奰奬奥奭奥奮奴奡奴奩奯奮
奩女 奢奡女奥奤 奴奯 奡 奬奡奲奧奥 奥奸奴奥奮奴 奯奮 奕奮奩奱奵奥奮奥女女 奔她奰奩奮奧 奓奩奭奰奬奩夜奥奤夬 奢她 奤奥 奖奲奩奥女 奥奴 奡奬夬 女奯 奴奨奥奲奥 奩女 奲奥奡女奯奮 奴奯 奢奥奬奩奥奶奥
奴奨奩奮奧女 女奨奯奵奬奤 奢奥 夜奮奥夬 奢奵奴 奷奥 女奴奩奬奬 奨奡奶奥 奴奯 奤奯 奴奨奥 奷奯奲奫央

奍奵奣奨 奡女 奴奨奥奲奥 奡奲奥 奷奩奴奨 奬奩奮奥奡奲 奴她奰奥女夬 奴奨奥奲奥 奡奲奥 女奯奭奥 奡奮奮奯她奡奮奣奥女 奷奨奥奮 奴奲她奩奮奧 奴奯 奰奲奯奶奥 奰奲奯奰奥奲奴奩奥女 奯奦
奦奵奮奣奴奩奯奮女 奷奩奴奨 奵奮奩奱奵奥 奴她奰奥女 夨奦奯奲 奥奸奡奭奰奬奥夬 奷奨奡奴 奣奯奵奮奴女 奡女 奡 奵女奥 奯奦 奡 奶奡奬奵奥天央 奓奩奮奣奥 奷奥 奲奥奱奵奩奲奥 at most
奯奮奥 奵女奥 奯奦 奡 奶奡奬奵奥夬 奲奡奴奨奥奲 奴奨奡奮 exactly 奯奮奥夬 奴奨奩女 女奥奥奭女 奴奯 奢奥 奬奥女女 奯奦 奡奮 奩女女奵奥 奩奮 奰奲奡奣奴奩奣奥夬 奢奵奴 女奴奩奬奬 奮奥奥奤女
奴奨奯奵奧奨奴央

6.5 New Foreign Function Interface

奅奶奥奲 女奩奮奣奥 奉奤奲奩女 奨奡女 奨奡奤 奭奵奬奴奩奰奬奥 奢奡奣奫奥奮奤女 奣奯奭奰奩奬奩奮奧 奴奯 奤奩夛奥奲奥奮奴 奴奡奲奧奥奴 奬奡奮奧奵奡奧奥女 奯奮 奰奯奴奥奮奴奩奡奬奬她 奤奩夛奥奲奥奮奴
奰奬奡奴奦奯奲奭女夬 奷奥 奨奡奶奥 奨奡奤 奴奨奥 奰奲奯奢奬奥奭 奴奨奡奴 奴奨奥 奦奯奲奥奩奧奮 奦奵奮奣奴奩奯奮 奩奮奴奥奲奦奡奣奥 夨奆奆奉天 奷奡女 奷奲奩奴奴奥奮 奵奮奤奥奲 奴奨奥
奡女女奵奭奰奴奩奯奮 奯奦 奣奯奭奰奩奬奩奮奧 奴奯 奃央 奁女 奡 奲奥女奵奬奴夬 奩奴 奨奡女 奢奥奥奮 奨奡奲奤 奴奯 奷奲奩奴奥 奧奥奮奥奲奩奣 奣奯奤奥 奦奯奲 奭奵奬奴奩奰奬奥 奴奡奲奧奥奴女夬
奯奲 奥奶奥奮 奴奯 奢奥 女奵奲奥 奴奨奡奴 奩奦 奣奯奤奥 奣奯奭奰奩奬奥女 奴奨奡奴 奩奴 奷奩奬奬 奲奵奮 奯奮 奴奨奥 奥奸奰奥奣奴奥奤 奴奡奲奧奥奴央

奁女 奯奦 夰央夹央失夷夬 奉奤奲奩女 奷奩奬奬 奨奡奶奥 奡 奮奥奷 奦奯奲奥奩奧奮 奦奵奮奣奴奩奯奮 奩奮奴奥奲奦奡奣奥 夨奆奆奉天 奷奨奩奣奨 奩女 奡奷奡奲奥 奯奦 奭奵奬奴奩奰奬奥 奴奡奲奧奥奴女央
奕女奥奲女 奷奨奯 奡奲奥 奷奯奲奫奩奮奧 奷奩奴奨 奴奨奥 奤奥奦奡奵奬奴 奣奯奤奥 奧奥奮奥奲奡奴奯奲 奣奡奮 奨奡奰奰奩奬她 奣奯奮奴奩奮奵奥 奷奲奩奴奩奮奧 奰奲奯奧奲奡奭女 奡女 奢奥奦奯奲奥
奷奩奴奨 奮奯 奣奨奡奮奧奥女夬 奢奵奴 奩奦 她奯奵 奡奲奥 奷奲奩奴奩奮奧 奢奩奮奤奩奮奧女 奦奯奲 奡奮 奥奸奴奥奲奮奡奬 奬奩奢奲奡奲她夬 奷奲奩奴奩奮奧 奡 奢奡奣奫 奥奮奤夬 奯奲 奷奯奲奫奩奮奧
奷奩奴奨 奡 奮奯奮夭奃 奢奡奣奫 奥奮奤夬 奴奨奥奲奥 奡奲奥 女奯奭奥 奴奨奩奮奧女 她奯奵 奷奩奬奬 奮奥奥奤 奴奯 奢奥 奡奷奡奲奥 奯奦夬 奷奨奩奣奨 奴奨奩女 奰奡奧奥 奤奥女奣奲奩奢奥女央

6.5.1 The IO' monad, and main

奔奨奥 IO 奭奯奮奡奤 奥奸奩女奴女 奡女 奢奥奦奯奲奥夬 奢奵奴 奩女 奮奯奷 女奰奥奣奩夜奣 奴奯 奴奨奥 奃 奢奡奣奫奥奮奤 夨奯奲夬 奭奯奲奥 奰奲奥奣奩女奥奬她夬 奡奮她 奢奡奣奫奥奮奤
奷奨奯女奥 奦奯奲奥奩奧奮 奦奵奮奣奴奩奯奮 奣奡奬奬女 奡奲奥 奣奯奭奰奡奴奩奢奬奥 奷奩奴奨 奃央天 奁奤奤奩奴奩奯奮奡奬奬她夬 奴奨奥奲奥 奩女 奮奯奷 奡奮 IO' 奭奯奮奡奤夬 奷奨奩奣奨 奩女
奰奡奲奡奭奥奴奥奲奩女奥奤 奯奶奥奲 奡 奆奆奉 奤奥女奣奲奩奰奴奯奲夺

data IO' : (lang : FFI) -> Type -> Type

奔奨奥 奐奲奥奬奵奤奥 奤奥夜奮奥女 奴奷奯 奆奆奉 奤奥女奣奲奩奰奴奯奲女 奷奨奩奣奨 奡奲奥 奩奭奰奯奲奴奥奤 奡奵奴奯奭奡奴奩奣奡奬奬她夬 奦奯奲 奃 奡奮奤 奊奡奶奡奓奣奲奩奰奴夯奎奯奤奥夬
奡奮奤 奤奥夜奮奥女 IO 奴奯 奵女奥 奴奨奥 奃 奆奆奉 奡奮奤 JS_IO 奴奯 奵女奥 奴奨奥 奊奡奶奡奓奣奲奩奰奴 奆奆奉夺

FFI_C : FFI
FFI_JS : FFI

IO : Type -> Type
IO a = IO' FFI_C a

JS_IO : Type -> Type
JS_IO a = IO' FFI_JS a
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奁女 奢奥奦奯奲奥夬 奴奨奥 奥奮奴奲她 奰奯奩奮奴 奴奯 奡奮 奉奤奲奩女 奰奲奯奧奲奡奭 奩女 main夬 奢奵奴 奴奨奥 奴她奰奥 奯奦 main 奣奡奮 奮奯奷 奢奥 奡奮她 奩奭奰奬奥奭奥奮夭
奴奡奴奩奯奮 奯奦 IO'夬 奥央奧央 奴奨奥 奦奯奬奬奯奷奩奮奧 奡奲奥 奢奯奴奨 奶奡奬奩奤夺

main : IO ()
main : JS_IO ()

奔奨奥 奆奆奉 奤奥女奣奲奩奰奴奯奲 奩奮奣奬奵奤奥女 奤奥奴奡奩奬女 奡奢奯奵奴 奷奨奩奣奨 奴她奰奥女 奣奡奮 奢奥 奭奡奲女奨奡奬奬奥奤 奢奥奴奷奥奥奮 奴奨奥 奦奯奲奥奩奧奮 奬奡奮奧奵奡奧奥
奡奮奤 奉奤奲奩女夬 奡奮奤 奴奨奥 “奴奡奲奧奥奴” 奯奦 奡 奦奯奲奥奩奧奮 奦奵奮奣奴奩奯奮 奣奡奬奬 夨奴她奰奩奣奡奬奬她 奪奵女奴 奡 奓奴奲奩奮奧 奲奥奰奲奥女奥奮奴奡奴奩奯奮 奯奦 奴奨奥
奦奵奮奣奴奩奯奮’女 奮奡奭奥夬 奢奵奴 奰奯奴奥奮奴奩奡奬奬她 女奯奭奥奴奨奩奮奧 奭奯奲奥 奣奯奭奰奬奩奣奡奴奥奤 女奵奣奨 奡女 奡奮 奥奸奴奥奲奮奡奬 奬奩奢奲奡奲她 夜奬奥 奯奲 奥奶奥奮 奡
奕奒奌天央

6.5.2 FFI descriptors

奁奮 奆奆奉 奤奥女奣奲奩奰奴奯奲 奩女 奡 奲奥奣奯奲奤 奣奯奮奴奡奩奮奩奮奧 奡 奰奲奥奤奩奣奡奴奥 奷奨奩奣奨 奨奯奬奤女 奷奨奥奮 奡 奴她奰奥 奣奡奮 奢奥 奭奡奲女奨奡奬奬奥奤夬 奡奮奤
奴奨奥 奴她奰奥 奯奦 奴奨奥 奴奡奲奧奥奴 奯奦 奡 奦奯奲奥奩奧奮 奣奡奬奬夺

record FFI where
constructor MkFFI
ffi_types : Type -> Type
ffi_fn : Type

奆奯奲 奃夬 奴奨奩女 奩女夺

||| Supported C integer types
public export
data C_IntTypes : Type -> Type where

C_IntChar : C_IntTypes Char
C_IntNative : C_IntTypes Int
C_IntBits8 : C_IntTypes Bits8
C_IntBits16 : C_IntTypes Bits16
C_IntBits32 : C_IntTypes Bits32
C_IntBits64 : C_IntTypes Bits64

||| Supported C function types
public export
data C_FnTypes : Type -> Type where

C_Fn : C_Types s -> C_FnTypes t -> C_FnTypes (s -> t)
C_FnIO : C_Types t -> C_FnTypes (IO' FFI_C t)
C_FnBase : C_Types t -> C_FnTypes t

||| Supported C foreign types
public export
data C_Types : Type -> Type where

C_Str : C_Types String
C_Float : C_Types Double
C_Ptr : C_Types Ptr
C_MPtr : C_Types ManagedPtr
C_Unit : C_Types ()
C_Any : C_Types (Raw a)
C_FnT : C_FnTypes t -> C_Types (CFnPtr t)
C_IntT : C_IntTypes i -> C_Types i

||| A descriptor for the C FFI. See the constructors of `C_Types`
||| and `C_IntTypes` for the concrete types that are available.
%error_reverse
public export
FFI_C : FFI

FFI_C = MkFFI C_Types String String
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6.5.3 Linking foreign code

奔奨奩女 奩女 奴奨奥 奥奸奡奭奰奬奥 奯奦 奬奩奮奫奩奮奧 奃 奣奯奤奥央

奅奸奡奭奰奬奥 奍奡奫奥夜奬奥

6.5.4 Foreign calls

奔奯 奣奡奬奬 奡 奦奯奲奥奩奧奮 奦奵奮奣奴奩奯奮夬 奴奨奥 foreign 奦奵奮奣奴奩奯奮 奩女 奵女奥奤央 奆奯奲 奥奸奡奭奰奬奥夺

do_fopen : String -> String -> IO Ptr
do_fopen f m

= foreign FFI_C "fileOpen" (String -> String -> IO Ptr) f m

奔奨奥 foreign 奦奵奮奣奴奩奯奮 奴奡奫奥女 奡奮 奆奆奉 奤奥女奣奲奩奰奴奩奯奮夬 奡 奦奵奮奣奴奩奯奮 奮奡奭奥 夨奴奨奥 奴她奰奥 奩女 奧奩奶奥奮 奢她 奴奨奥 ffi_fn 夜奥奬奤
奯奦 FFI_C 奨奥奲奥天夬 奡奮奤 奡 奦奵奮奣奴奩奯奮 奴她奰奥夬 奷奨奩奣奨 奧奩奶奥女 奴奨奥 奥奸奰奥奣奴奥奤 奴她奰奥女 奯奦 奴奨奥 奲奥奭奡奩奮奩奮奧 奡奲奧奵奭奥奮奴女央 奈奥奲奥夬
奷奥’奲奥 奣奡奬奬奩奮奧 奡奮 奥奸奴奥奲奮奡奬 奦奵奮奣奴奩奯奮 fileOpen 奷奨奩奣奨 奴奡奫奥女夬 奩奮 奴奨奥 奃夬 奡 char* 夜奬奥 奮奡奭奥夬 奡 char* 奭奯奤奥夬
奡奮奤 奲奥奴奵奲奮女 奡 夜奬奥 奰奯奩奮奴奥奲央 奉奴 奩女 奴奨奥 奪奯奢 奯奦 奴奨奥 奃 奢奡奣奫 奥奮奤 奴奯 奣奯奮奶奥奲奴 奉奤奲奩女 String 奴奯 奃 char* 奡奮奤 奶奩奣奥
奶奥奲女奡央

奔奨奥 奡奲奧奵奭奥奮奴 奴她奰奥女 奡奮奤 奲奥奴奵奲奮 奴她奰奥 奧奩奶奥奮 奨奥奲奥 奭奵女奴 奢奥 奰奲奥女奥奮奴 奩奮 奴奨奥 fn_types 奰奲奥奤奩奣奡奴奥 奯奦 奴奨奥 FFI_C
奤奥女奣奲奩奰奴奩奯奮 奦奯奲 奴奨奥 奦奯奲奥奩奧奮 奣奡奬奬 奴奯 奢奥 奶奡奬奩奤央

Note 奔奨奥 奡奲奧奵奭奥奮奴女 奴奯 foreign must 奢奥 奫奮奯奷奮 奡奴 奣奯奭奰奩奬奥 奴奩奭奥夬 奢奥奣奡奵女奥 奴奨奥 奦奯奲奥奩奧奮 奣奡奬奬女 奡奲奥 奧奥奮奥奲奡奴奥奤
女奴奡奴奩奣奡奬奬她央 奔奨奥 %inline 奤奩奲奥奣奴奩奶奥 奯奮 奡 奦奵奮奣奴奩奯奮 奣奡奮 奢奥 奵女奥奤 奴奯 奧奩奶奥 奨奩奮奴女 奴奯 奨奥奬奰 奴奨奩女夬 奦奯奲 奥奸奡奭奰奬奥 奡
女奨奯奲奴奨奡奮奤 奦奯奲 奣奡奬奬奩奮奧 奥奸奴奥奲奮奡奬 奊奡奶奡奓奣奲奩奰奴 奦奵奮奣奴奩奯奮女夺

%inline
jscall : (fname : String) -> (ty : Type) ->

{auto fty : FTy FFI_JS [] ty} -> ty
jscall fname ty = foreign FFI_JS fname ty

C callbacks

奉奴 奩女 奰奯女女奩奢奬奥 奴奯 奰奡女女 奡奮 奉奤奲奩女 奦奵奮奣奴奩奯奮 奴奯 奡 奃 奦奵奮奣奴奩奯奮 奴奡奫奩奮奧 奡 奦奵奮奣奴奩奯奮 奰奯奩奮奴奥奲 奢她 奵女奩奮奧 CFnPtr 奩奮 奴奨奥
奦奵奮奣奴奩奯奮 奴她奰奥央 奔奨奥 奉奤奲奩女 奦奵奮奣奴奩奯奮 奩女 奰奡女女奥奤 奴奯 MkCFnPtr 奩奮 奴奨奥 奡奲奧奵奭奥奮奴女央 奔奨奥 奥奸奡奭奰奬奥 奢奥奬奯奷 女奨奯奷女
奤奥奣奬奡奲奩奮奧 奴奨奥 奃 女奴奡奮奤奡奲奤 奬奩奢奲奡奲她 奦奵奮奣奴奩奯奮 qsort 奷奨奩奣奨 奴奡奫奥女 奡 奰奯奩奮奴奥奲 奴奯 奡 奣奯奭奰奡奲奩女奯奮 奦奵奮奣奴奩奯奮央

myComparer : Ptr -> Ptr -> Int
myComparer = ...

qsort : Ptr -> Int -> Int -> IO ()
qsort data elems elsize = foreign FFI_C "qsort"

(Ptr -> Int -> Int -> CFnPtr (Ptr -> Ptr -> Int) -> IO ())
data elems elsize (MkCFnPtr myComparer)

奔奨奥奲奥 奡奲奥 奡 奦奥奷 奬奩奭奩奴奡奴奩奯奮女 奴奯 奣奡奬奬奢奡奣奫女 奩奮 奴奨奥 奃 奆奆奉央 奔奨奥 奦奯奲奥奩奧奮 奦奵奮奣奴奩奯奮 奣奡奮’奴 奴奡奫奥 奴奨奥 奦奵奮奣奴奩奯奮 奴奯
奭奡奫奥 奡 奣奡奬奬奢奡奣奫 奯奦 奡女 奡奮 奡奲奧奵奭奥奮奴央 奔奨奩女 奷奩奬奬 奧奩奶奥 奡 奣奯奭奰奩奬奡奴奩奯奮 奥奲奲奯奲夺

-- This does not work
example : (Int -> ()) -> IO ()
example f = foreign FFI_C "callbacker" (CFnPtr (Int -> ()) -> IO ()) f

奎奯奴奥 奴奨奡奴 奴奨奥 奦奵奮奣奴奩奯奮 奴奨奡奴 奩女 奵女奥奤 奡女 奡 奣奡奬奬奢奡奣奫 奣奡奮’奴 奢奥 奡 奣奬奯女奵奲奥夬 奴奨奡奴 奩女 奩奴 奣奡奮’奴 奢奥 奡 奰奡奲奴奩奡奬奬她
奡奰奰奬奩奥奤 奦奵奮奣奴奩奯奮央 奔奨奩女 奩女 奢奥奣奡奵女奥 奴奨奥 奭奥奣奨奡奮奩女奭 奵女奥奤 奩女 奵奮奡奢奬奥 奴奯 奰奡女女 奴奨奥 奣奬奯女奥奤夭奯奶奥奲 奶奡奬奵奥女 奴奨奲奯奵奧奨 奃央
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奉奦 奷奥 奷奡奮奴 奴奯 奰奡女女 奉奤奲奩女 奶奡奬奵奥女 奴奯 奴奨奥 奣奡奬奬奢奡奣奫 奷奥 奨奡奶奥 奴奯 奰奡女女 奴奨奥奭 奴奨奲奯奵奧奨 奃 奥奸奰奬奩奣奩奴奬她央 奎奯奮夭奰奲奩奭奩奴奩奶奥
奉奤奲奩女 奶奡奬奵奥女 奣奡奮 奢奥 奰奡女女奥奤 奴奯 奃 奶奩奡 奴奨奥 Raw 奴她奰奥央

奔奨奥 奯奴奨奥奲 奢奩奧 奬奩奭奩奴奡奴奩奯奮 奩女 奴奨奡奴 奩奴 奤奯奥女奮’奴 女奵奰奰奯奲奴 奉奏 奦奵奮奣奴奩奯奮女央 奕女奥 unsafePerformIO 奴奯 奷奲奡奰 奴奨奥奭
夨奩央奥央 奴奯 奭奡奫奥 奡奮 奉奏 奦奵奮奣奴奩奯奮 奵女奡奢奬奥 奡女 奡 奣奡奬奬奢奡奣奫夬 奣奨奡奮奧奥 奴奨奥 奲奥奴奵奲奮 奴她奰奥 奦奲奯奭 奉奏奲 奴奯 奲夬 奡奮奤 奣奨奡奮奧奥 奴奨奥
夽 奤奯 奴奯 夽 奵奮女奡奦奥奐奥奲奦奯奲奭奉奏 夤 奤奯天央

奔奨奥奲奥 奡奲奥 奴奷奯 女奰奥奣奩奡奬 奦奵奮奣奴奩奯奮 奮奡奭奥女夺 %wrapper 奲奥奴奵奲奮女 奴奨奥 奦奵奮奣奴奩奯奮 奰奯奩奮奴奥奲 奴奨奡奴 奷奲奡奰女 奡奮 奉奤奲奩女 奦奵奮奣奴奩奯奮央
奔奨奩女 奩女 奵女奥奦奵奬 奩奦 奴奨奥 奦奵奮奣奴奩奯奮 奰奯奩奮奴奥奲 奩女奮’奴 奴奡奫奥奮 奢她 奡 奃 奦奵奮奣奴奩奯奮 奤奩奲奥奣奴奬她 奢奵奴 女奨奯奵奬奤 奢奥 奩奮女奥奲奴奥奤 奩奮奴奯 奡
奤奡奴奡 女奴奲奵奣奴奵奲奥央 奁 奦奯奲奥奩奧奮 奤奥奣奬奡奲奡奴奩奯奮 奵女奩奮奧 %wrapper 奭奵女奴 奲奥奴奵奲奮 IO Ptr央

-- this returns the C function pointer to a qsort comparer
example_wrapper : IO Ptr
example_wrapper = foreign FFI_C "%wrapper" (CFnPtr (Ptr -> Ptr -> Int) -> IO Ptr)

(MkCFnPtr myComparer)

%dynamic 奣奡奬奬女 奡 奃 奦奵奮奣奴奩奯奮 奰奯奩奮奴奥奲 奷奩奴奨 女奯奭奥 奡奲奧奵奭奥奮奴女央 奔奨奩女 奩女 奵女奥奦奵奬 奩奦 奡 奃 奦奵奮奣奴奩奯奮 奲奥奴奵奲奮女 奯奲
奤奡奴奡 女奴奲奵奣奴奵奲奥 奣奯奮奴奡奩奮女 奡 奃 奦奵奮奣奴奩奯奮 奰奯奩奮奴奥奲夬 奦奯奲 奥奸奡奭奰奬奥 女奴奲奵奣奴女 奯奦 奦奵奮奣奴奩奯奮 奰奯奩奮奴奥奲女 奡奲奥 奣奯奭奭奯奮 奩奮
奯奢奪奥奣奴夭奯奲奩奥奮奴奥奤 奃 女奵奣奨 奡女 奩奮 奃奏奍 奯奲 奴奨奥 奌奩奮奵奸 奫奥奲奮奥奬央 奔奨奥 奦奵奮奣奴奩奯奮 奴她奰奥 奣奯奮奴奡奩奮女 奡奮 奥奸奴奲奡 Ptr 奡奴 奴奨奥
女奴奡奲奴 奦奯奲 奴奨奥 奦奵奮奣奴奩奯奮 奰奯奩奮奴奥奲央 %dynamic 奣奡奮 奢奥 女奥奥奮 奡女 奡 奰女奥奵奤奯夭奦奵奮奣奴奩奯奮 奴奨奡奴 奣奡奬奬女 奴奨奥 奦奵奮奣奴奩奯奮 奩奮 奴奨奥
夜奲女奴 奡奲奧奵奭奥奮奴夬 奰奡女女奩奮奧 奴奨奥 奲奥奭奡奩奮奩奮奧 奡奲奧奵奭奥奮奴女 奴奯 奩奴央

-- we have a pointer to a function with the signature int f(int), call it
example_dynamic : Ptr -> Int -> IO Int
example_dynamic fn x = foreign FFI_C "%dynamic" (Ptr -> Int -> IO Int) fn x

奉奦 奴奨奥 奦奯奲奥奩奧奮 奮奡奭奥 奩女 奰奲奥夜奸奥奤 奢她 奡 &夬 奩奴 奩女 奴奲奥奡奴奥奤 奡女 奡 奰奯奩奮奴奥奲 奴奯 奴奨奥 奧奬奯奢奡奬 奶奡奲奩奡奢奬奥 奷奩奴奨 奴奨奥 奦奯奬奬奯奷奩奮奧
奮奡奭奥央 奔奨奥 奴她奰奥 奭奵女奴 奢奥 奪奵女奴 IO Ptr央

-- access the global variable errno
errno : IO Ptr
errno = foreign FFI_C "&errno" (IO Ptr)

奉奦 奴奨奥 奦奯奲奥奩奧奮 奮奡奭奥 奩女 奰奲奥夜奸奥奤 奢她 奡 #夬 奴奨奥 奮奡奭奥 奩女 奰奡女奴奥奤 奩奮 奬奩奴奥奲奡奬奬她央 奔奨奩女 奩女 奵女奥奦奵奬 奴奯 奡奣奣奥女女 奣奯奮女奴奡奮奴女
奴奨奡奴 奡奲奥 奰奲奥奰奲奯奣奥女女奯奲 奤奥夜奮奩奴奩奯奮女 夨奬奩奫奥 INT_MAX天央

%include C "limits.h"

-- access the preprocessor definition INT_MAX
intMax : IO Int
intMax = foreign FFI_C "#INT_MAX" (IO Int)

main : IO ()
main = print !intMax

奆奯奲 奭奯奲奥 奣奯奭奰奬奩奣奡奴奥奤 奩奮奴奥奲奡奣奴奩奯奮女 奷奩奴奨 奃 夨女奵奣奨 奡女 奲奥奡奤奩奮奧 奡奮奤 女奥奴奴奩奮奧 夜奥奬奤女 奯奦 奡 奃 女奴奲奵奣奴天夬 奴奨奥奲奥 奩女 奡
奭奯奤奵奬奥 奃奆奆奉 奡奶奡奩奬奡奢奬奥 奩奮 奴奨奥 奣奯奮奴奲奩奢 奰奡奣奫奡奧奥央

C heap

奉奤奲奩女 奨奡女 奴奷奯 奨奥奡奰女 奷奨奥奲奥 奯奢奪奥奣奴女 奣奡奮 奢奥 奡奬奬奯奣奡奴奥奤夺
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奆奐 奨奥奡奰 奃 奨奥奡奰
奃奨奥奮奥她夭奣奯奬奬奥奣奴奥奤 奍奡奲奫夭奡奮奤夭女奷奥奥奰夭奣奯奬奬奥奣奴奥奤
奇奡奲奢奡奧奥 奣奯奬奬奥奣奴奩奯奮女 奴奯奵奣奨奥女 奯奮奬她 奬奩奶奥 奯奢奪奥奣奴女央 奇奡奲奢奡奧奥 奣奯奬奬奥奣奴奩奯奮 奨奡女 奴奯 奴奲奡奶奥奲女奥 奡奬奬 奲奥奧奩女奴奥奲奥奤

奩奴奥奭女央
奉奤奥奡奬 奦奯奲 奆奐夭女奴她奬奥 奲奡奰奩奤 奡奬奬奯奣奡奴奩奯奮 奯奦 奬奯奴女 奯奦
女奭奡奬奬 女奨奯奲奴夭奬奩奶奥奤 奰奩奥奣奥女 奯奦 奭奥奭奯奲她夬 女奵奣奨 奡女
奤奡奴奡 奣奯奮女奴奲奵奣奴奯奲女央

奉奤奥奡奬 奦奯奲 奃夭女奴她奬奥 奡奬奬奯奣奡奴奩奯奮 奯奦 奡 奦奥奷 奢奩奧 奢奵夛奥奲女央

奆奩奮奡奬奩奺奥奲女 奡奲奥 奩奭奰奯女女奩奢奬奥 奴奯 女奵奰奰奯奲奴 奲奥奡女奯奮夭
奡奢奬她央

奉奴奥奭女 奨奡奶奥 夜奮奡奬奩奺奥奲女 奴奨奡奴 奡奲奥 奣奡奬奬奥奤 奯奮 奤奥奡奬奬奯奣奡奴奩奯奮央

奄奡奴奡 奩女 奣奯奰奩奥奤 奡奬奬 奴奨奥 奴奩奭奥 夨奷奨奥奮 奣奯奬奬奥奣奴奩奮奧
奧奡奲奢奡奧奥夬 奭奯奤奩奦她奩奮奧 奤奡奴奡夬 奲奥奧奩女奴奥奲奩奮奧 奭奡奮奡奧奥奤
奰奯奩奮奴奥奲女夬 奥奴奣央天

奃奯奰她奩奮奧 奤奯奥女 奮奯奴 奨奡奰奰奥奮央

奃奯奮奴奡奩奮女 奯奢奪奥奣奴女 奯奦 奶奡奲奩奯奵女 奴她奰奥女央 奃奯奮奴奡奩奮女 奃 奨奥奡奰 奩奴奥奭女夺 (void *) 奰奯奩奮奴奥奲女 奷奩奴奨 夜夭
奮奡奬奩奺奥奲女央 奁 夜奮奡奬奩奺奥奲 奩女 奡 奲奯奵奴奩奮奥 奴奨奡奴 奤奥奡奬奬奯奣奡奴奥女 奴奨奥
奲奥女奯奵奲奣奥女 奡女女奯奣奩奡奴奥奤 奷奩奴奨 奴奨奥 奩奴奥奭央

奆奩奸奥奤 女奥奴 奯奦 奯奢奪奥奣奴 奴她奰奥女央 奔奨奥 奤奡奴奡 奰奯奩奮奴奥奲 奭奡她 奰奯奩奮奴 奴奯 奡奮她奴奨奩奮奧夬 奡女 奬奯奮奧 奡女
奴奨奥 夜奮奡奬奩奺奥奲 奣奬奥奡奮女 奵奰 奣奯奲奲奥奣奴奬她央

奎奯奴 女奵奩奴奡奢奬奥 奦奯奲 奃 奲奥女奯奵奲奣奥女 奡奮奤 奡奲奢奩奴奲奡奲她
奰奯奩奮奴奥奲女央

奓奵奩奴奡奢奬奥 奦奯奲 奃 奲奥女奯奵奲奣奥女 奡奮奤 奡奲奢奩奴奲奡奲她 奰奯奩奮奴奥奲女央

奖奡奬奵奥女 奦奯奲奭 奡 奣奯奭奰奡奣奴 奭奥奭奯奲她 奢奬奯奣奫央 奉奴奥奭女 奡奲奥 奫奥奰奴 奩奮 奡 奬奩奮奫奥奤 奬奩女奴央
奁奮她 奉奤奲奩女 奶奡奬奵奥夬 奭奯女奴 奮奯奴奡奢奬她 ManagedPtr央 奉奴奥奭女 奲奥奰奲奥女奥奮奴奥奤 奢她 奴奨奥 奉奤奲奩女 奴她奰奥 CData央
奄奡奴奡 奯奦 ManagedPtr 奡奬奬奯奣奡奴奥奤 奩奮 奃夬 奢奵夛奥奲 奴奨奥奮
奣奯奰奩奥奤 奩奮奴奯 奴奨奥 奆奐 奨奥奡奰央

奄奡奴奡 奡奬奬奯奣奡奴奥奤 奩奮 奃夬 奰奯奩奮奴奥奲 奣奯奰奩奥奤 奩奮奴奯 奴奨奥 奃 奨奥奡奰央

奁奬奬奯奣奡奴奩奯奮 奡奮奤 奲奥奡奬奬奯奣奡奴奩奯奮 奮奯奴 奰奯女女奩奢奬奥 奦奲奯奭 奃
奣奯奤奥 夨奷奩奴奨奯奵奴 奨奡奶奩奮奧 奡 奲奥奦奥奲奥奮奣奥 奴奯 奴奨奥 奖奍天央
奅奶奥奲她奴奨奩奮奧 奩女 奣奯奰奩奥奤 奩奮女奴奥奡奤央

奁奬奬奯奣奡奴奥奤 奡奮奤 奲奥奡奬奬奯奣奡奴奥 奦奲奥奥奬她 奩奮 奃夬 奲奥奧奩女奴奥奲奩奮奧 奴奨奥
奡奬奬奯奣奡奴奥奤 奩奴奥奭女 奩奮 奴奨奥 奆奆奉央

奔奨奥 奆奐 奨奥奡奰 奩女 奴奨奥 奰奲奩奭奡奲她 奨奥奡奰央 奉奴 奭奡她 奣奯奮奴奡奩奮 奶奡奬奵奥女 奯奦 奴她奰奥 CData夬 奷奨奩奣奨 奡奲奥 奲奥奦奥奲奥奮奣奥女 奴奯 奩奴奥奭女
奩奮 奴奨奥 奃 奨奥奡奰央 奁 奃 奨奥奡奰 奩奴奥奭 奣奯奮奴奡奩奮女 奡 (void *) 奰奯奩奮奴奥奲 奡奮奤 奴奨奥 奣奯奲奲奥女奰奯奮奤奩奮奧 夜奮奡奬奩奺奥奲央 奏奮奣奥 奡 奃
奨奥奡奰 奩奴奥奭 奩女 奮奯 奬奯奮奧奥奲 奲奥奦奥奲奥奮奣奥奤 奦奲奯奭 奴奨奥 奆奐 奨奥奡奰夬 奩奴 奩女 奭奡奲奫奥奤 奡女 奵奮奵女奥奤 奡奮奤 奴奨奥 奮奥奸奴 奇奃 女奷奥奥奰 奷奩奬奬
奣奡奬奬 奩奴女 夜奮奡奬奩奺奥奲 奡奮奤 奤奥奡奬奬奯奣奡奴奥 奩奴央

奔奨奥奲奥 奩女 奮奯 奉奤奲奩女 奩奮奴奥奲奦奡奣奥 奦奯奲 CData 奯奴奨奥奲 奴奨奡奮 奩奴女 奴她奰奥 奡奮奤 奆奆奉央

Usage from C code

• 奁奬奴奨奯奵奧奨 奮奯奴 奥奮奦奯奲奣奥奤 奩奮 奣奯奤奥夬 CData 奩女 奭奥奡奮奴 奴奯 奢奥 奯奰奡奱奵奥 奡奮奤 奮奯奮夭奒奔奓 奣奯奤奥 夨女奵奣奨 奡女 奬奩奢奲奡奲奩奥女
奯奲 奃 奢奩奮奤奩奮奧女天 女奨奯奵奬奤 奡奣奣奥女女 奯奮奬她 奩奴女 (void *) 夜奥奬奤 奣奡奬奬奥奤 data央

• 奆奥奥奬 奦奲奥奥 奴奯 奭奵奴奡奴奥 奢奯奴奨 奴奨奥 奰奯奩奮奴奥奲 data 夨奥奧央 奡奦奴奥奲 奣奡奬奬奩奮奧 realloc天 奡奮奤 奴奨奥 奭奥奭奯奲她 奩奴 奰奯奩奮奴女 奴奯央
奈奯奷奥奶奥奲夬 奫奥奥奰 奩奮 奭奩奮奤 奴奨奡奴 奴奨奩女 奭奵女奴 奮奯奴 奢奲奥奡奫 奉奤奲奩女’女 奲奥奦奥奲奥奮奴奩奡奬 奴奲奡奮女奰奡奲奥奮奣她央

• WARNING! 奉奦 她奯奵 奣奡奬奬 cdata_allocate 奯奲 cdata_manage夬 奴奨奥 奲奥女奵奬奴奩奮奧 CData 奯奢奪奥奣奴 must 奢奥
奲奥奴奵奲奮奥奤 奦奲奯奭 她奯奵奲 奆奆奉 奦奵奮奣奴奩奯奮 女奯 奴奨奡奴 奩奴 奩女 奩奮女奥奲奴奥奤 奩奮 奴奨奥 奃 奨奥奡奰 奢她 奴奨奥 奒奔奓央 奏奴奨奥奲奷奩女奥 奴奨奥
奭奥奭奯奲她 奷奩奬奬 奢奥 奬奥奡奫奥奤央

some_allocating_fun : Int -> IO CData
some_allocating_fun i = foreign FFI_C "some_allocating_fun" (Int -> IO CData) i

other_fun : CData -> Int -> IO Int
other_fun cd i = foreign FFI_C "other_fun" (CData -> Int -> IO Int) cd i

#include "idris_rts.h"

static void finalizer(void * data)
(äÿŃéąțçżğçżŋ)
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(çżŋäÿŁéąț)

{
MyStruct * ptr = (MyStruct *) data;
free_something(ptr->something);
free(ptr);

}

CData some_allocating_fun(int arg)
{

size_t size = sizeof(...);
void * data = (void *) malloc(size);
// ...
return cdata_manage(data, size, finalizer);

}

int other_fun(CData cd, int arg)
{

int result = foo(cd->data);
return result;

}

奔奨奥 Raw 奴她奰奥 奣奯奮女奴奲奵奣奴奯奲 奡奬奬奯奷女 她奯奵 奴奯 奡奣奣奥女女 奯奲 奲奥奴奵奲奮 奡 奲奵奮奴奩奭奥 奲奥奰奲奥女奥奮奴奡奴奩奯奮 奯奦 奴奨奥 奶奡奬奵奥央 奆奯奲
奩奮女奴奡奮奣奥夬 奩奦 她奯奵 奷奡奮奴 奴奯 奣奯奰她 奡 女奴奲奩奮奧 奧奥奮奥奲奡奴奥奤 奦奲奯奭 奃 奣奯奤奥 奩奮奴奯 奡奮 奉奤奲奩女 奶奡奬奵奥夬 她奯奵 奭奡她 奷奡奮奴 奴奯 奲奥奴奵奲奮
奡 Raw String``instead of a ``String 奡奮奤 奵女奥 MKSTR 奯奲 MKSTRlen 奴奯 奣奯奰她 奩奴 奯奶奥奲央

getString : () -> IO (Raw String)
getString () = foreign FFI_C "get_string" (IO (Raw String))

const VAL get_string ()
{

char * c_string = get_string_allocated_with_malloc()
const VAL idris_string = MKSTR(c_string);
free(c_string);
return idris_string

}

FFI implementation

奉奮 奯奲奤奥奲 奴奯 奷奲奩奴奥 奢奩奮奤奩奮奧女 奴奯 奥奸奴奥奲奮奡奬 奬奩奢奲奡奲奩奥女夬 奴奨奥 奤奥奴奡奩奬女 奯奦 奨奯奷 foreign 奷奯奲奫女 奡奲奥 奵奮奮奥奣奥女女奡奲她 —
她奯奵 女奩奭奰奬她 奮奥奥奤 奴奯 奫奮奯奷 奴奨奡奴 foreign 奴奡奫奥女 奡奮 奆奆奉 奤奥女奣奲奩奰奴奯奲夬 奴奨奥 奦奵奮奣奴奩奯奮 奮奡奭奥夬 奡奮奤 奩奴女 奴她奰奥央 奉奴 奩女
奩奮女奴奲奵奣奴奩奶奥 奴奯 奬奯奯奫 奡 奬奩奴奴奬奥 奤奥奥奰奥奲夬 奨奯奷奥奶奥奲夺

奔奨奥 奴她奰奥 奯奦 foreign 奩女 奡女 奦奯奬奬奯奷女夺

foreign : (ffi : FFI)
-> (fname : ffi_fn f)
-> (ty : Type)
-> {auto fty : FTy ffi [] ty}
-> ty

奔奨奥 奩奭奰奯奲奴奡奮奴 奡奲奧奵奭奥奮奴 奨奥奲奥 奩女 奴奨奥 奩奭奰奬奩奣奩奴 fty夬 奷奨奩奣奨 奣奯奮奴奡奩奮女 奡 奰奲奯奯奦 夨FTy天 奴奨奡奴 奴奨奥 奧奩奶奥奮 奴她奰奥 奩女
奶奡奬奩奤 奡奣奣奯奲奤奩奮奧 奴奯 奴奨奥 奆奆奉 奤奥女奣奲奩奰奴奩奯奮 ffi夺

data FTy : FFI -> List Type -> Type -> Type where
FRet : ffi_types f t -> FTy f xs (IO' f t)
FFun : ffi_types f s -> FTy f (s :: xs) t -> FTy f xs (s -> t)

奎奯奴奩奣奥 奴奨奡奴 奴奨奩女 奵女奥女 奴奨奥 ffi_types 夜奥奬奤 奯奦 奴奨奥 奆奆奉 奤奥女奣奲奩奰奴奯奲— 奴奨奥女奥 奡奲奧奵奭奥奮奴女 奴奯 FRet 奡奮奤 FFun 奧奩奶奥
奥奸奰奬奩奣奩奴 奰奲奯奯奦女 奴奨奡奴 奴奨奥 奴她奰奥 奩女 奶奡奬奩奤 奩奮 奴奨奩女 奆奆奉央 奆奯奲 奥奸奡奭奰奬奥夬 奴奨奥 奡奢奯奶奥 do_fopen 奢奵奩奬奤女 奴奨奥 奦奯奬奬奯奷奩奮奧
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奩奭奰奬奩奣奩奴 奰奲奯奯奦 奡女 奴奨奥 fty 奡奲奧奵奭奥奮奴 奴奯 foreign夺

FFun C_Str (FFun C_Str (FRet C_Ptr))

6.5.5 Compiling foreign calls

夨奔奨奩女 女奥奣奴奩奯奮 奡女女奵奭奥女 女奯奭奥 奫奮奯奷奬奥奤奧奥 奯奦 奴奨奥 奉奤奲奩女 奩奮奴奥奲奮奡奬女央天

套奨奥奮 奷奲奩奴奩奮奧 奡 奢奡奣奫 奥奮奤夬 奷奥 奮奯奷 奮奥奥奤 奴奯 奫奮奯奷 奨奯奷 奴奯 奣奯奭奰奩奬奥 foreign央 套奥’奬奬 女奫奩奰 奴奨奥 奤奥奴奡奩奬女 奨奥奲奥 奯奦
奨奯奷 奡 foreign 奣奡奬奬 奲奥奡奣奨奥女 奴奨奥 奩奮奴奥奲奭奥奤奩奡奴奥 奲奥奰奲奥女奥奮奴奡奴奩奯奮 夨奴奨奥 奉奒天夬 奴奨奯奵奧奨 她奯奵 奣奡奮 奬奯奯奫 奩奮 IO.idr 奩奮
奴奨奥 prelude 奰奡奣奫奡奧奥 奴奯 女奥奥 奡 奢奩奴 奭奯奲奥 奤奥奴奡奩奬— 奡 foreign 奣奡奬奬 奩女 奩奭奰奬奥奭奥奮奴奥奤 奢她 奴奨奥 奰奲奩奭奩奴奩奶奥 奦奵奮奣奴奩奯奮
mkForeignPrim央 奔奨奥 奩奭奰奯奲奴奡奮奴 奰奡奲奴 奯奦 奴奨奥 奉奒 奡女 奤奥夜奮奥奤 奩奮 Lang.hs 奩女 奴奨奥 奦奯奬奬奯奷奩奮奧 奣奯奮女奴奲奵奣奴奯奲夺

data LExp = ...
| LForeign FDesc -- Function descriptor

FDesc -- Return type descriptor
[(FDesc, LExp)]

奓奯夬 奡 foreign 奣奡奬奬 奡奰奰奥奡奲女 奩奮 奴奨奥 奉奒 奡女 奴奨奥 LForeign 奣奯奮女奴奲奵奣奴奯奲夬 奷奨奩奣奨 奴奡奫奥女 奡 奦奵奮奣奴奩奯奮 奤奥女奣奲奩奰奴奯奲 夨奯奦
奡 奴她奰奥 奧奩奶奥奮 奢她 奴奨奥 ffi_fn 夜奥奬奤 奩奮 奴奨奥 奆奆奉 奤奥女奣奲奩奰奴奯奲天夬 奡 奲奥奴奵奲奮 奴她奰奥 奤奥女奣奲奩奰奴奯奲 夨奧奩奶奥奮 奢她 奡奮 奡奰奰奬奩奣奡奴奩奯奮
奯奦 FTy天夬 奡奮奤 奡 奬奩女奴 奯奦 奡奲奧奵奭奥奮奴女 奷奩奴奨 奴她奰奥 奤奥女奣奲奩奰奴奯奲女 夨奡奬女奯 奧奩奶奥奮 奢她 奡奮 奡奰奰奬奩奣奡奴奩奯奮 奯奦 FTy天央

奁奮 FDesc 奤奥女奣奲奩奢奥女 奡奮 奡奰奰奬奩奣奡奴奩奯奮 奯奦 奡 奮奡奭奥 奴奯 女奯奭奥 奡奲奧奵奭奥奮奴女夬 奡奮奤 奩女 奲奥奡奬奬她 奪奵女奴 奡 女奩奭奰奬奩夜奥奤 女奵奢女奥奴
奯奦 奡奮 LExp夺

data FDesc = FCon Name
| FStr String
| FUnknown
| FApp Name [FDesc]

奔奨奥奲奥 奡奲奥 奣奯奲奲奥女奰奯奮奤奩奮奧 女奴奲奵奣奴奵奲奥女 奩奮 奴奨奥 奬奯奷奥奲 奬奥奶奥奬 奉奒女夬 女奵奣奨 奡女 奴奨奥 奤奥奦奵奮奣奴奩奯奮奡奬奩女奥奤夬 女奩奭奰奬奩夜奥奤 奡奮奤
奢她奴奥奣奯奤奥 奦奯奲奭女央

奏奵奲 do_fopen 奥奸奡奭奰奬奥 奡奢奯奶奥 奡奲奲奩奶奥女 奩奮 奴奨奥 LExp 奦奯奲奭 奡女夺

LForeign (FStr "fileOpen") (FCon (sUN "C_Ptr"))
[(FCon (sUN "C_Str"), f), (FCon (sUN "C_Str"), m)]

夨奁女女奵奭奩奮奧 奴奨奡奴 f 奡奮奤 m 女奴奡奮奤 奦奯奲 奴奨奥 LExp 奲奥奰奲奥女奥奮奴奡奴奩奯奮女 奯奦 奴奨奥 奡奲奧奵奭奥奮奴女央天 奔奨奩女 奩奮奦奯奲奭奡奴奩奯奮 女奨奯奵奬奤
奢奥 奥奮奯奵奧奨 奦奯奲 奡奮她 奢奡奣奫 奥奮奤 奴奯 奭奡奲女奨奡奬 奴奨奥 奡奲奧奵奭奥奮奴女 奡奮奤 奲奥奴奵奲奮 奶奡奬奵奥 奡奰奰奲奯奰奲奩奡奴奥奬她央

注注注解解解: 套奨奥奮 奰奲奯奣奥女女奩奮奧 FDesc夬 奢奥 奡奷奡奲奥 奴奨奡奴 奴奨奥奲奥 奭奡她 奢奥 奩奭奰奬奩奣奩奴 奡奲奧奵奭奥奮奴女夬 奷奨奩奣奨 奨奡奶奥 奮奯奴 奢奥奥奮
奥奲奡女奥奤央 奆奯奲 奥奸奡奭奰奬奥夬 C_IntT 奨奡女 奡奮 奩奭奰奬奩奣奩奴 奡奲奧奵奭奥奮奴 i夬 女奯 奷奩奬奬 奡奰奰奥奡奲 奩奮 奡奮 FDesc 奡女 女奯奭奥奴奨奩奮奧 奯奦 奴奨奥
奦奯奲奭 FApp (sUN "C_IntT") [i, t] 奷奨奥奲奥 i 奩女 奴奨奥 奩奭奰奬奩奣奩奴 奡奲奧奵奭奥奮奴 夨奷奨奩奣奨 奣奡奮 奢奥 奩奧奮奯奲奥奤天 奡奮奤 t 奩女
奴奨奥 奤奥女奣奲奩奰奴奯奲 奯奦 奴奨奥 奩奮奴奥奧奥奲 奴她奰奥央 奓奥奥 CodegenC.hs夬 女奰奥奣奩夜奣奡奬奬她 奴奨奥 奦奵奮奣奴奩奯奮 toFType夬 奴奯 女奥奥 奨奯奷 奴奨奩女
奷奯奲奫女 奩奮 奰奲奡奣奴奩奣奥央

6.5.6 JavaScript FFI descriptor

奔奨奥 奊奡奶奡奓奣奲奩奰奴 奆奆奉 奤奥女奣奲奩奰奴奯奲 奩女 奡 奬奩奴奴奬奥 奭奯奲奥 奣奯奭奰奬奥奸夬 奢奥奣奡奵女奥 奴奨奥 奊奡奶奡奓奣奲奩奰奴 奆奆奉 女奵奰奰奯奲奴女 奭奡奲女奨奡奬奬奩奮奧
奦奵奮奣奴奩奯奮女央 奉奴 奩女 奤奥夜奮奥奤 奡女 奦奯奬奬奯奷女夺
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mutual
data JsFn t = MkJsFn t

data JS_IntTypes : Type -> Type where
JS_IntChar : JS_IntTypes Char
JS_IntNative : JS_IntTypes Int

data JS_FnTypes : Type -> Type where
JS_Fn : JS_Types s -> JS_FnTypes t -> JS_FnTypes (s -> t)
JS_FnIO : JS_Types t -> JS_FnTypes (IO' l t)
JS_FnBase : JS_Types t -> JS_FnTypes t

data JS_Types : Type -> Type where
JS_Str : JS_Types String
JS_Float : JS_Types Double
JS_Ptr : JS_Types Ptr
JS_Unit : JS_Types ()
JS_FnT : JS_FnTypes a -> JS_Types (JsFn a)
JS_IntT : JS_IntTypes i -> JS_Types i

奔奨奥 奲奥奡女奯奮 奦奯奲 奷奲奡奰奰奩奮奧 奦奵奮奣奴奩奯奮 奴她奰奥女 奩奮 奡 JsFn 奩女 奴奯 奨奥奬奰 奴奨奥 奰奲奯奯奦 女奥奡奲奣奨 奷奨奥奮 奢奵奩奬奤奩奮奧 FTy央 套奥
奨奯奰奥 奴奯 奩奭奰奲奯奶奥 奰奲奯奯奦 女奥奡奲奣奨 奥奶奥奮奴奵奡奬奬她夬 奢奵奴 奦奯奲 奴奨奥 奭奯奭奥奮奴 奩奴 奷奯奲奫女 奭奵奣奨 奭奯奲奥 奲奥奬奩奡奢奬她 奩奦 奴奨奥 奩奮奤奩奣奥女
奡奲奥 奤奩女奪奯奩奮奴夡 奁奮 奥奸奡奭奰奬奥 奯奦 奵女奩奮奧 奴奨奩女 奡奰奰奥奡奲女 奩奮 奉奤奲奩女奓奣奲奩奰奴 奷奨奥奮 女奥奴奴奩奮奧 奴奩奭奥奯奵奴女夺

setTimeout : (() -> JS_IO ()) -> (millis : Int) -> JS_IO Timeout
setTimeout f millis = do

timeout <- jscall "setTimeout(%0, %1)"
(JsFn (() -> JS_IO ()) -> Int -> JS_IO Ptr)
(MkJsFn f) millis

pure $ MkTimeout timeout

6.6 Syntax Guide

奅奸奡奭奰奬奥女 奡奲奥 奭奯女奴奬她 奡奤奡奰奴奥奤 奦奲奯奭 奴奨奥 奉奤奲奩女 奴奵奴奯奲奩奡奬央

6.6.1 Source File Structure

奓奯奵奲奣奥 夜奬奥女 奣奯奮女奩女奴 奯奦夺

失央 奁奮 奯奰奴奩奯奮奡奬 Module Header 夨姩妡妵 失夶夵天央

夲央 奚奥奲奯 奯奲 奭奯奲奥 Imports 夨姩妡妵 失夶夵天央

夳央 奚奥奲奯 奯奲 奭奯奲奥 奤奥奣奬奡奲奡奴奩奯奮女夬 奥央奧央 Variables 夨姩妡妵 失夶夵天夬 Data types 夨姩妡妵 失夶夶天夬 奥奴奣央

奆奯奲 奥奸奡奭奰奬奥夺

module MyModule -- module header

import Data.Vect -- an import

%default total -- a directive

foo : Nat -- a declaration
foo = 5
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Module Header

奁 夜奬奥 奣奡奮 女奴奡奲奴 奷奩奴奨 奡 奭奯奤奵奬奥 奨奥奡奤奥奲夬 奩奮奴奲奯奤奵奣奥奤 奢她 奴奨奥 module 奫奥她奷奯奲奤夺

module Semantics

奍奯奤奵奬奥 奮奡奭奥女 奣奡奮 奢奥 奨奩奥奲奡奲奣奨奩奣奡奬夬 奷奩奴奨 奰奡奲奴女 女奥奰奡奲奡奴奥奤 奢她 .夺

module Semantics.Transform

奅奡奣奨 夜奬奥 奣奡奮 奤奥夜奮奥 奯奮奬她 奡 女奩奮奧奬奥 奭奯奤奵奬奥夬 奷奨奩奣奨 奩奮奣奬奵奤奥女 奥奶奥奲她奴奨奩奮奧 奤奥夜奮奥奤 奩奮 奴奨奡奴 夜奬奥央

奌奩奫奥 奷奩奴奨 奤奥奣奬奡奲奡奴奩奯奮女夬 奡 docstring 夨姩妡妵 失夷夰天 奣奡奮 奢奥 奵女奥奤 奴奯 奰奲奯奶奩奤奥 奤奯奣奵奭奥奮奴奡奴奩奯奮 奦奯奲 奡 奭奯奤奵奬奥夺

||| Implementation of predicate transformer semantics.
module Semantics.Transform

Imports

奁奮 import 奭奡奫奥女 奴奨奥 奮奡奭奥女 奩奮 奡奮奯奴奨奥奲 奭奯奤奵奬奥 奡奶奡奩奬奡奢奬奥 奦奯奲 奵女奥 奢她 奴奨奥 奣奵奲奲奥奮奴 奭奯奤奵奬奥夺

import Data.Vect

奁奬奬 奴奨奥 奤奥奣奬奡奲奡奴奩奯奮女 奩奮 奡奮 奩奭奰奯奲奴奥奤 奭奯奤奵奬奥 奡奲奥 奡奶奡奩奬奡奢奬奥 奦奯奲 奵女奥 奩奮 奴奨奥 夜奬奥央 奉奮 奡 奣奡女奥 奷奨奥奲奥 奡 奮奡奭奥
奩女 奡奭奢奩奧奵奯奵女 — 奥央奧央 奢奥奣奡奵女奥 奩奴 奩女 奩奭奰奯奲奴奥奤 奦奲奯奭 奭奵奬奴奩奰奬奥 奭奯奤奵奬奥女夬 奯奲 奡奰奰奥奡奲女 奩奮 奭奵奬奴奩奰奬奥 奶奩女奩奢奬奥
奮奡奭奥女奰奡奣奥女 — 奴奨奥 奡奭奢奩奧奵奩奴她 奣奡奮 奢奥 奲奥女奯奬奶奥奤 奵女奩奮奧 Qualified Names 夨姩妡妵 失夷夰天央 夨奏奦奴奥奮夬 奴奨奥 奣奯奭奰奩奬奥奲 奣奡奮
奲奥女奯奬奶奥 奴奨奥 奡奭奢奩奧奵奩奴她 奦奯奲 她奯奵夬 奵女奩奮奧 奴奨奥 奴她奰奥女 奩奮奶奯奬奶奥奤央天

奉奭奰奯奲奴奥奤 奭奯奤奵奬奥女 奣奡奮 奢奥 奧奩奶奥奮 奡奬奩奡女奥女 奴奯 奭奡奫奥 奱奵奡奬奩夜奥奤 奮奡奭奥女 奭奯奲奥 奣奯奭奰奡奣奴夺

import Data.Vect as V

奎奯奴奥 奴奨奡奴 奮奡奭奥女 奭奡奤奥 奶奩女奩奢奬奥 奢她 奩奭奰奯奲奴 奡奲奥 奮奯奴夬 奢她 奤奥奦奡奵奬奴夬 奲奥夭奥奸奰奯奲奴奥奤 奴奯 奵女奥奲女 奯奦 奴奨奥 奭奯奤奵奬奥 奢奥奩奮奧
奷奲奩奴奴奥奮央 奔奨奩女 奣奡奮 奢奥 奤奯奮奥 奵女奩奮奧 import public夺

import public Data.Vect

6.6.2 Variables

奁 奶奡奲奩奡奢奬奥 奩女 奡奬奷奡她女 奤奥夜奮奥奤 奢她 奤奥夜奮奩奮奧 奩奴女 奴她奰奥 奯奮 奯奮奥 奬奩奮奥夬 奡奮奤 奩奴女 奶奡奬奵奥 奯奮 奴奨奥 奮奥奸奴 奬奩奮奥夬 奵女奩奮奧 奴奨奥
女她奮奴奡奸

<id> : <type>
<id> = <value>

奅奸奡奭奰奬奥女

x : Int
x = 100
hello : String
hello = "hello"
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6.6.3 Types

奉奮 奉奤奲奩女夬 奴她奰奥女 奡奲奥 夜奲女奴 奣奬奡女女 奶奡奬奵奥女央 奓奯 奡 奴她奰奥 奤奥奣奬奡奲奡奴奩奯奮 奩女 奴奨奥 女奡奭奥 奡女 奪奵女奴 奤奥奣奬奡奲奡奴奩奯奮 奯奦 奡 奶奡奲奩奡奢奬奥
奷奨奯女奥 奴她奰奥 奩女 Type央 奉奮 奉奤奲奩女夬 奶奡奲奩奡奢奬奥女 奴奨奡奴 奤奥奮奯奴奥 奡 奴她奰奥 奮奥奥奤 奮奯奴 奢奥 奣奡奰奩奴奡奬奩女奥奤央 奅奸奡奭奰奬奥夺

MyIntType : Type
MyIntType = Int

奡 奭奯奲奥 奩奮奴奥奲奥女奴奩奮奧 奥奸奡奭奰奬奥夺

MyListType : Type
MyListType = List Int

套奨奩奬奥 奣奡奰奩奴奡奬奩女奩奮奧 奴她奰奥女 奩女 奮奯奴 奲奥奱奵奩奲奥奤夬 奴奨奥 奲奵奬奥女 奦奯奲 奧奥奮奥奲奡奴奩奮奧 奩奭奰奬奩奣奩奴 奡奲奧奵奭奥奮奴女 奭奥奡奮 奩奴 奩女 奯奦奴奥奮 奡
奧奯奯奤 奩奤奥奡央

Data types

奉奤奲奩女 奰奲奯奶奩奤奥女 奴奷奯 奫奩奮奤女 奯奦 女她奮奴奡奸 奦奯奲 奤奥夜奮奩奮奧 奤奡奴奡 奴她奰奥女央 奔奨奥 夜奲女奴夬 奈奡女奫奥奬奬 女奴她奬奥 女她奮奴奡奸夬 奤奥夜奮奥女 奡
奲奥奧奵奬奡奲 奡奬奧奥奢奲奡奩奣 奤奡奴奡 奴她奰奥央 奆奯奲 奥奸奡奭奰奬奥

data Either a b = Left a | Right b

奯奲

data List a = Nil | (::) a (List a)

奔奨奥 女奥奣奯奮奤夬 奭奯奲奥 奧奥奮奥奲奡奬 奫奩奮奤 奯奦 奤奡奴奡 奴她奰奥夬 奩女 奤奥夜奮奥奤 奵女奩奮奧 奁奧奤奡 奯奲 奇奁奄奔 女奴她奬奥 女她奮奴奡奸央 奔奨奩女 女她奮奴奡奸
奤奥夜奮奥女 奡 奤奡奴奡 奴她奰奥 奴奨奡奴 奩女 奰奡奲奡奭奥奴奥奲奩女奥奤 奢她 女奯奭奥 奶奡奬奵奥女 夨奩奮 奴奨奥 Vect 奥奸奡奭奰奬奥夬 奡 奶奡奬奵奥 奯奦 奴她奰奥 Nat 奡奮奤
奡 奶奡奬奵奥 奯奦 奴她奰奥 Type天央

data Vect : Nat -> Type -> Type where
Nil : Vect Z a
(::) : (x : a) -> (xs : Vect n a) -> Vect (S n) a

奔奨奥 女奩奧奮奡奴奵奲奥 奯奦 奴她奰奥 奣奯奮女奴奲奵奣奴奯奲女 奭奡她 奵女奥 奤奥奰奥奮奤奥奮奴 奴她奰奥女

data DPair : (a : Type) -> (a -> Type) -> Type where
MkDPair : {P : a -> Type} -> (x : a) -> (pf : P x) -> DPair a P

Records

奔奨奥奲奥 奩女 奡 女奰奥奣奩奡奬 女她奮奴奡奸 奦奯奲 奤奡奴奡 奴她奰奥女 奷奩奴奨 奯奮奥 奣奯奮女奴奲奵奣奴奯奲 奡奮奤 奭奵奬奴奩奰奬奥 夜奥奬奤女央

record A a where
constructor MkA
foo, bar : a
baz : Nat

奔奨奩女 奤奥夜奮奥女 奡 奣奯奮女奴奲奵奣奴奯奲 奡女 奷奥奬奬 奡女 奧奥奴奴奥奲 奡奮奤 女奥奴奴奥奲 奦奵奮奣奴奩奯奮 奦奯奲 奥奡奣奨 夜奥奬奤央

MkA : a -> a -> Nat -> A a
foo : A a -> a
set_foo : a -> A a -> A a

奔奨奥 奴她奰奥女 奯奦 奲奥奣奯奲奤 夜奥奬奤女 奭奡她 奤奥奰奥奮奤 奯奮 奴奨奥 奶奡奬奵奥 奯奦 奯奴奨奥奲 夜奥奬奤女
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record Collection a where
constructor MkCollection
size : Nat
items : Vect size a

奓奥奴奴奥奲 奦奵奮奣奴奩奯奮女 奡奲奥 奯奮奬她 奰奲奯奶奩奤奥奤 奦奯奲 夜奥奬奤女 奴奨奡奴 奤奯 奮奯奴 奵女奥 奤奥奰奥奮奤奡奮奴 奴她奰奥女央 奉奮 奴奨奥 奥奸奡奭奰奬奥 奡奢奯奶奥
奮奥奩奴奨奥奲 set_size 奮奯奲 set_items 奡奲奥 奤奥夜奮奥奤央

Co-data

奉奮奩夜奮奩奴奥 奤奡奴奡 女奴奲奵奣奴奵奲奥女 奣奡奮 奢奥 奩奮奴奲奯奤奵奣奥奤 奷奩奴奨 奴奨奥 codata 奫奥她奷奯奲奤央

codata Stream : Type -> Type where
(::) a -> Stream a -> Stream a

奔奨奩女 奩女 女她奮奴奡奣奴奩奣 女奵奧奡奲 奦奯奲 奴奨奥 奦奯奬奬奯奷奩奮奧夬 奷奨奩奣奨 奩女 奵女奵奡奬奬她 奰奲奥奦奥奲奲奥奤夺

data Stream : Type -> Type where
(::) a -> Inf (Stream a) -> Stream a

奅奶奥奲她 奯奣奣奵奲奥奮奣奥 奯奦 奴奨奥 奤奥夜奮奥奤 奴她奰奥 奩奮 奡 奣奯奮女奴奲奵奣奴奯奲 奡奲奧奵奭奥奮奴 奷奩奬奬 奢奥 奷奲奡奰奰奥奤 奩奮 奴奨奥 Inf 奴她奰奥 奣奯奮女奴奲奵奣夭
奴奯奲央 奔奨奩女 奨奡女 奴奨奥 奥夛奥奣奴 奯奦 奤奥奬奡她奩奮奧 奴奨奥 奥奶奡奬奵奡奴奩奯奮 奯奦 奴奨奥 女奥奣奯奮奤 奡奲奧奵奭奥奮奴 奷奨奥奮 奴奨奥 奤奡奴奡 奣奯奮女奴奲奵奣奴奯奲 奩女
奡奰奰奬奩奥奤央 奁奮 Inf 奡奲奧奵奭奥奮奴 奩女 奣奯奮女奴奲奵奣奴奥奤 奵女奩奮奧 Delay 夨奷奨奩奣奨 奉奤奲奩女 奷奩奬奬 奩奮女奥奲奴 奩奭奰奬奩奣奩奴奬她天 奡奮奤 奥奶奡奬奵奡奴奥奤
奵女奩奮奧 Force 夨奡奧奡奩奮 奩奮女奥奲奴奥奤 奩奭奰奬奩奣奩奴奬她天央

奆奵奲奴奨奥奲奭奯奲奥夬 奲奥奣奵奲女奩奶奥 奣奡奬奬女 奵奮奤奥奲 奡 Delay 奭奵女奴 奢奥 奧奵奡奲奤奥奤 奢她 奡 奣奯奮女奴奲奵奣奴奯奲 奴奯 奰奡女女 奴奨奥 奴奯奴奡奬奩奴她 奣奨奥奣奫奥奲央

6.6.4 Operators

Arithmetic

x + y
x - y
x * y
x / y
(x * y) + (a / b)

Equality and Relational

x == y
x /= y
x >= y
x > y
x <= y
x < y

Conditional

x && y
x || y
not x
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6.6.5 Conditionals

If Then Else

if <test> then <true> else <false>

Case Expressions

case <test> of
<case 1> => <expr>
<case 2> => <expr>
...
otherwise => <expr>

6.6.6 Functions

Named

奎奡奭奥奤 奦奵奮奣奴奩奯奮女 奡奲奥 奤奥夜奮奥奤 奩奮 奴奨奥 女奡奭奥 奷奡她 奡女 奶奡奲奩奡奢奬奥女夬 奷奩奴奨 奴奨奥 奴她奰奥 奦奯奬奬奯奷奥奤 奢她 奴奨奥 奤奥夜奮奩奴奩奯奮央

<id> : <argument type> -> <return type>
<id> arg = <expr>

奅奸奡奭奰奬奥

plusOne : Int -> Int
plusOne x = x + 1

奆奵奮奣奴奩奯奮女 奣奡奮 奡奬女奯 奨奡奶奥 奭奵奬奴奩奰奬奥 奩奮奰奵奴女夬 奦奯奲 奥奸奡奭奰奬奥

makeHello : String -> String -> String
makeHello first last = "hello, my name is " ++ first ++ " " ++ last

奆奵奮奣奴奩奯奮女 奣奡奮 奡奬女奯 奨奡奶奥 奮奡奭奥奤 奡奲奧奵奭奥奮奴女央 奔奨奩女 奩女 奲奥奱奵奩奲奥奤 奩奦 她奯奵 奷奡奮奴 奴奯 奡奮奮奯奴奡奴奥 奰奡奲奡奭奥奴奥奲女 奩奮 奡
奤奯奣女奴奲奩奮奧央 奔奨奥 奦奯奬奬奯奷奩奮奧 女奨奯奷女 奴奨奥 女奡奭奥 makeHello 奦奵奮奣奴奩奯奮 奡女 奡奢奯奶奥夬 奢奵奴 奷奩奴奨 奮奡奭奥奤 奰奡奲奡奭奥奴奥奲女
奷奨奩奣奨 奡奲奥 奡奬女奯 奡奮奮奯奴奡奴奥奤 奩奮 奴奨奥 奤奯奣女奴奲奩奮奧

||| Makes a string introducing a person
||| @first The person's first name
||| @last The person's last name
makeHello : (first : String) -> (last : String) -> String
makeHello first last = "hello, my name is " ++ first ++ " " ++ last

奌奩奫奥 奈奡女奫奥奬奬夬 奉奤奲奩女 奦奵奮奣奴奩奯奮女 奣奡奮 奢奥 奤奥夜奮奥奤 奢她 奰奡奴奴奥奲奮 奭奡奴奣奨奩奮奧央 奆奯奲 奥奸奡奭奰奬奥

sum : List Int -> Int
sum [] = 0
sum (x :: xs) = x + (sum xs)

奓奩奭奩奬奡奲奬她 奣奡女奥 奡奮奡奬她女奩女 奬奯奯奫女 奬奩奫奥

answerString : Bool -> String
answerString False = "Wrong answer"
answerString True = "Correct answer"
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Dependent Functions

奄奥奰奥奮奤奥奮奴 奦奵奮奣奴奩奯奮女 奡奲奥 奦奵奮奣奴奩奯奮女 奷奨奥奲奥 奴奨奥 奴她奰奥 奯奦 奴奨奥 奲奥奴奵奲奮 奶奡奬奵奥 奤奥奰奥奮奤女 奯奮 奴奨奥 奩奮奰奵奴 奶奡奬奵奥央 奉奮
奯奲奤奥奲 奴奯 奤奥夜奮奥 奡 奤奥奰奥奮奤奥奮奴 奦奵奮奣奴奩奯奮夬 奮奡奭奥奤 奰奡奲奡奭奥奴奥奲女 奭奵女奴 奢奥 奵女奥奤夬 女奩奮奣奥 奴奨奥 奰奡奲奡奭奥奴奥奲 奷奩奬奬 奡奰奰奥奡奲
奩奮 奴奨奥 奲奥奴奵奲奮 奴她奰奥央 奆奯奲 奥奸奡奭奰奬奥夬 奣奯奮女奩奤奥奲

zeros : (n : Nat) -> Vect n Int
zeros Z = []
zeros (S k) = 0 :: (zeros k)

奉奮 奴奨奩女 奥奸奡奭奰奬奥夬 奴奨奥 奲奥奴奵奲奮 奴她奰奥 奩女 Vect n Int 奷奨奩奣奨 奩女 奡奮 奥奸奰奲奥女女奩奯奮 奷奨奩奣奨 奤奥奰奥奮奤女 奯奮 奴奨奥 奩奮奰奵奴
奰奡奲奡奭奥奴奥奲 n央

Anonymous

奁奲奧奵奭奥奮奴女 奩奮 奡奮奯奮她奭奯奵女 奦奵奮奣奴奩奯奮女 奡奲奥 女奥奰奡奲奡奴奥奤 奢她 奣奯奭奭奡央

(\x => <expr>)
(\x, y => <expr>)

Modifiers

Visibility

public export
export
private

Totality

total
partial
covering

奓奥奴女 奥奸奰奬奩奣奩奴奬她 奴奯 奷奨奩奣奨 奥奸奴奥奮奴 奰奡奴奴奥奲奮 奭奡奴奣奨奩奮奧 奩女 奴奥奲奭奩奮奡奴奩奮奧 奡奮奤夯奯奲 奥奸奨奡奵女奴奩奶奥央 奁 partial 奰奡奴奴奥奲奮
奭奡奴奣奨奩奮奧 奭奡奫奥女 奮奯 奡女女奵奭奰奴奩奯奮央 奁 covering 奰奡奴奴奥奲奮 奭奡奴奣奨奩奮奧 奥奮女奵奲奥女 奴奨奡奴 奰奡奴奴奥奲奮 奭奡奴奣奨奩奮奧 奩女 奥奸奨奡奵女夭
奴奩奶奥 奯奮 奩奴女 奣奬奡奵女奥女央 奆奵奲奴奨奥奲奭奯奲奥夬 奡 total 奰奡奴奴奥奲奮 奭奡奴奣奨奩奮奧 奥奮奦奯奲奣奥女 奢奯奴奨 奥奸奨奡奵女奴奩奶奩奴她 奡奮奤 奴奥奲奭奩奮奡奴奩奯奮
奯奦 奴奨奥 奥奶奡奬奵奡奴奩奯奮 奯奦 奩奴女 奣奬奡奵女奥女央

Implicit Coercion

implicit

Options

%export
%hint
%no_implicit

(äÿŃéąțçżğçżŋ)

6.6. Syntax Guide 169



Idris 语语语言言言文文文档档档, 版版版本本本 1.3.1

(çżŋäÿŁéąț)

%error_handler
%error_reverse
%reflection
%specialise [<name list>]

6.6.7 Misc

Qualified Names

奉奦 奭奵奬奴奩奰奬奥 奤奥奣奬奡奲奡奴奩奯奮女 奷奩奴奨 奴奨奥 女奡奭奥 奮奡奭奥 奡奲奥 奶奩女奩奢奬奥夬 奵女奩奮奧 奴奨奥 奮奡奭奥 奣奡奮 奲奥女奵奬奴 奩奮 奡奮 奡奭奢奩奧奵奯奵女
女奩奴奵奡奴奩奯奮央 奔奨奥 奣奯奭奰奩奬奥奲 奷奩奬奬 奡奴奴奥奭奰奴 奴奯 奲奥女奯奬奶奥 奴奨奥 奡奭奢奩奧奵奩奴她 奵女奩奮奧 奴奨奥 奴她奰奥女 奩奮奶奯奬奶奥奤央 奉奦 奩奴’女 奵奮奡奢奬奥
— 奦奯奲 奥奸奡奭奰奬奥夬 奢奥奣奡奵女奥 奴奨奥 奤奥奣奬奡奲奡奴奩奯奮女 奷奩奴奨 奴奨奥 女奡奭奥 奮奡奭奥 奡奬女奯 奨奡奶奥 奴奨奥 女奡奭奥 奴她奰奥 女奩奧奮奡奴奵奲奥女 — 奴奨奥
女奩奴奵奡奴奩奯奮 奣奡奮 奢奥 奣奬奥奡奲奥奤 奵奰 奵女奩奮奧 奡 qualified name央

奁 奱奵奡奬奩夜奥奤 奮奡奭奥 奨奡女 奴奨奥 女她奭奢奯奬’女 奮奡奭奥女奰奡奣奥 奰奲奥夜奸奥奤夬 女奥奰奡奲奡奴奥奤 奢她 奡 .夺

Data.Vect.length

奔奨奩女 奷奯奵奬奤 女奰奥奣奩夜奣奡奬奬她 奲奥奦奥奲奥奮奣奥 奡 length 奤奥奣奬奡奲奡奴奩奯奮 奦奲奯奭 Data.Vect央

契奵奡奬奩夜奥奤 奮奡奭奥女 奣奡奮 奢奥 奷奲奩奴奴奥奮 奵女奩奮奧 奴奷奯 奤奩夛奥奲奥奮奴 女奨奯奲奴奨奡奮奤女夺

失央 奎奡奭奥女 奩奮 奭奯奤奵奬奥女 奴奨奡奴 奡奲奥 imported 夨姩妡妵 失夶夵天 奵女奩奮奧 奡奮 奡奬奩奡女 奣奡奮 奢奥 奱奵奡奬奩夜奥奤 奢她 奴奨奥 奡奬奩奡女央

夲央 奔奨奥 奮奡奭奥 奣奡奮 奢奥 奱奵奡奬奩夜奥奤 奢她 奴奨奥 shortest unique suffix 奯奦 奴奨奥 奮奡奭奥女奰奡奣奥 奩奮 奱奵奥女奴奩奯奮央 奆奯奲 奥奸奡奭奰奬奥夬
奴奨奥 length 奣奡女奥 奡奢奯奶奥 奣奡奮 奬奩奫奥奬她 奢奥 女奨奯奲奴奥奮奥奤 奴奯 Vect.length央

Comments

-- Single Line
{- Multiline -}
||| Docstring (goes before definition)

Multi line String literals

foo = """
this is a
string literal"""

6.6.8 Directives

%lib <path>
%link <path>
%flag <path>
%include <path>
%hide <function>
%freeze <name>
%access <accessibility>
%default <totality>
%logging <level 0--11>

(äÿŃéąțçżğçżŋ)
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%dynamic <list of libs>
%name <list of names>
%error_handlers <list of names>
%language <extension>

6.7 Erasure By Usage Analysis

奔奨奩女 奷奯奲奫 女奴奥奭女 奦奲奯奭 奴奨奩女 奦奥奡奴奵奲奥 奰奲奯奰奯女奡奬 夨奯奢女奯奬奥奴奥奤 奢她 奴奨奩女 奰奡奧奥天央 奂奥奷奡奲奥 奴奨奡奴 奴奨奥 奩奮奦奯奲奭奡奴奩奯奮 奩奮 奴奨奥
奰奲奯奰奯女奡奬 奩女 奯奵奴 奯奦 奤奡奴奥 — 奡奮奤 女奯奭奥奴奩奭奥女 奥奶奥奮 奩奮 奤奩奲奥奣奴 奣奯奮奴奲奡奤奩奣奴奩奯奮 奷奩奴奨 奴奨奥 奥奶奥奮奴奵奡奬 奩奭奰奬奥奭奥奮奴奡奴奩奯奮央

6.7.1 Motivation

奔奲奡奤奩奴奩奯奮奡奬 奤奥奰奥奮奤奥奮奴奬她 奴她奰奥奤 奬奡奮奧奵奡奧奥女 夨奁奧奤奡夬 奃奯奱天 奡奲奥 奧奯奯奤 奡奴 奥奲奡女奩奮奧 proofs 夨奥奩奴奨奥奲 奶奩奡 奩奲奲奥奬奥奶奡奮奣奥
奯奲 奡奮 奥奸奴奲奡 奵奮奩奶奥奲女奥天央

half : (n : Nat) -> Even n -> Nat
half Z EZ = Z
half (S (S n)) (ES pf) = S (half n pf)

奆奯奲 奥奸奡奭奰奬奥夬 奩奮 奴奨奥 奡奢奯奶奥 女奮奩奰奰奥奴夬 奴奨奥 女奥奣奯奮奤 奡奲奧奵奭奥奮奴 奩女 奡 奰奲奯奯奦夬 奷奨奩奣奨 奩女 奵女奥奤 奯奮奬她 奴奯 奣奯奮奶奩奮奣奥 奴奨奥
奣奯奭奰奩奬奥奲 奴奨奡奴 奴奨奥 奦奵奮奣奴奩奯奮 奩女 奴奯奴奡奬央 奔奨奩女 奰奲奯奯奦 奩女 奮奥奶奥奲 奩奮女奰奥奣奴奥奤 奡奴 奲奵奮奴奩奭奥 奡奮奤 奴奨奵女 奣奡奮 奢奥 奥奲奡女奥奤央
奉奮 奴奨奩女 奣奡女奥夬 奴奨奥 奭奥奲奥 奥奸奩女奴奥奮奣奥 奯奦 奴奨奥 奰奲奯奯奦 奩女 女奵夞奣奩奥奮奴 奡奮奤 奷奥 奣奡奮 奵女奥 奩奲奲奥奬奥奶奡奮奣奥夭奲奥奬奡奴奥奤 奭奥奴奨奯奤女 奴奯
奡奣奨奩奥奶奥 奥奲奡女奵奲奥央

奈奯奷奥奶奥奲夬 女奯奭奥奴奩奭奥女 奷奥 奷奡奮奴 奴奯 奥奲奡女奥 indices 奡奮奤 奴奨奩女 奩女 奷奨奥奲奥 奴奨奥 奴奲奡奤奩奴奩奯奮奡奬 奡奰奰奲奯奡奣奨奥女 女奴奯奰 奢奥奩奮奧
奵女奥奦奵奬夬 奭奡奩奮奬她 奦奯奲 奲奥奡女奯奮女 奤奥女奣奲奩奢奥奤 奩奮 奴奨奥 奯奲奩奧奩奮奡奬 奰奲奯奰奯女奡奬央

uninterleave : {n : Nat} -> Vect (n * 2) a -> (Vect n a, Vect n a)
uninterleave [] = ([] , [])
uninterleave (x :: y :: rest) with (unzipPairs rest)

| (xs, ys) = (x :: xs, y :: ys)

奎奯奴奩奣奥 奴奨奡奴 奩奮 奴奨奩女 奣奡女奥夬 奴奨奥 女奥奣奯奮奤 奡奲奧奵奭奥奮奴 奩女 奴奨奥 奩奭奰奯奲奴奡奮奴 奯奮奥 奡奮奤 奷奥 奷奯奵奬奤 奬奩奫奥 奴奯 奧奥奴 奲奩奤 奯奦 奴奨奥 n
奩奮女奴奥奡奤夬 奡奬奴奨奯奵奧奨 奴奨奥 女奨奡奰奥 奯奦 奴奨奥 奰奲奯奧奲奡奭 奩女 奧奥奮奥奲奡奬奬她 奴奨奥 女奡奭奥 奡女 奩奮 奴奨奥 奰奲奥奶奩奯奵女 奣奡女奥央

奔奨奥奲奥 奡奲奥 奭奥奴奨奯奤女 奤奥女奣奲奩奢奥奤 奢她 奂奲奡奤她夬 奍奣奂奲奩奤奥 奡奮奤 奍奣奋奩奮奮奡 奩奮 奛奂奍奍夰头奝 奴奯 奲奥奭奯奶奥 奴奨奥 奩奮奤奩奣奥女 奦奲奯奭
奤奡奴奡 女奴奲奵奣奴奵奲奥女夬 奥奸奰奬奯奩奴奩奮奧 奴奨奥 奦奡奣奴 奴奨奡奴 奦奵奮奣奴奩奯奮女 奯奰奥奲奡奴奩奮奧 奯奮 奴奨奥奭 奥奩奴奨奥奲 奡奬奲奥奡奤她 奨奡奶奥 奡 奣奯奰她 奯奦 奴奨奥
奡奰奰奲奯奰奲奩奡奴奥 奩奮奤奥奸 奯奲 奴奨奥 奩奮奤奥奸 奣奡奮 奢奥 奱奵奩奣奫奬她 奲奥奣奯奮女奴奲奵奣奴奥奤 奩奦 奮奥奥奤奥奤央 奈奯奷奥奶奥奲夬 奷奥 奯奦奴奥奮 奷奡奮奴 奴奯 奥奲奡女奥
奴奨奥 奩奮奤奩奣奥女 奡奬奴奯奧奥奴奨奥奲夬 奦奲奯奭 奴奨奥 奷奨奯奬奥 奰奲奯奧奲奡奭夬 奥奶奥奮 奩奮 奴奨奯女奥 奣奡女奥女 奷奨奥奲奥 奲奥奣奯奮女奴奲奵奣奴奩奯奮 奩女 奮奯奴 奰奯女女奩奢奬奥央

奔奨奥 奦奯奬奬奯奷奩奮奧 奴奷奯 女奥奣奴奩奯奮女 奤奥女奣奲奩奢奥 奴奷奯 奣奡女奥女 奷奨奥奲奥 奤奯奩奮奧 女奯 奩奭奰奲奯奶奥女 奴奨奥 奲奵奮奴奩奭奥 奰奥奲奦奯奲奭奡奮奣奥 奡女她奭奰夭
奴奯奴奩奣奡奬奬她央

Binary numbers

• 奏夨奮天 奩奮女奴奥奡奤 奯奦 奏夨奬奯奧 奮天

奃奯奮女奩奤奥奲 奴奨奥 奦奯奬奬奯奷奩奮奧 Nat夭奩奮奤奥奸奥奤 奴她奰奥 奦奡奭奩奬她 奲奥奰奲奥女奥奮奴奩奮奧 奢奩奮奡奲她 奮奵奭奢奥奲女夺

data Bin : Nat -> Type where
N : Bin 0
O : {n : Nat} -> Bin n -> Bin (0 + 2*n)
I : {n : Nat} -> Bin n -> Bin (1 + 2*n)
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奔奨奥女奥 奡奲奥 女奵奰奰奯女奥奤 奴奯 奢奥 夨奡奴 奬奥奡女奴 奡女她奭奰奴奯奴奩奣奡奬奬她天 奦奡女奴 奡奮奤 奭奥奭奯奲她夭奥夞奣奩奥奮奴 奢奥奣奡奵女奥 奴奨奥奩奲 女奩奺奥 奩女 奬奯奧奡夭
奲奩奴奨奭奩奣 奣奯奭奰奡奲奥奤 奴奯 奴奨奥 奮奵奭奢奥奲女 奴奨奥她 奲奥奰奲奥女奥奮奴央

奕奮奦奯奲奴奵奮奡奴奥奬她 奴奨奩女 奩女 奮奯奴 奴奨奥 奣奡女奥央 奔奨奥 奰奲奯奢奬奥奭 奩女 奴奨奡奴 奴奨奥女奥 奢奩奮奡奲她 奮奵奭奢奥奲女 女奴奩奬奬 奣奡奲奲她 奴奨奥 unary
奩奮奤奩奣奥女 奷奩奴奨 奴奨奥奭夬 奰奥奲奦奯奲奭奩奮奧 奡奲奩奴奨奭奥奴奩奣 奯奮 奴奨奥 奩奮奤奩奣奥女 奷奨奥奮奥奶奥奲 奡奲奩奴奨奭奥奴奩奣 奩女 奤奯奮奥 奯奮 奴奨奥 奢奩奮奡奲她
奮奵奭奢奥奲女 奴奨奥奭女奥奬奶奥女央 奈奥奮奣奥 奴奨奥 奲奥奡奬 奲奥奰奲奥女奥奮奴奡奴奩奯奮 奯奦 奴奨奥 奮奵奭奢奥奲 失夵 奬奯奯奫女 奬奩奫奥 奴奨奩女夺

I -> I -> I -> I -> N
S S S Z
S S Z
S S
S Z
S
S
S
Z

奔奨奥 奵女奥奤 奭奥奭奯奲她 奩女 奡奣奴奵奡奬奬她 linear夬 奮奯奴 奬奯奧奡奲奩奴奨奭奩奣 奡奮奤 奴奨奥奲奥奦奯奲奥 奷奥 奣奡奮奮奯奴 奧奥奴 奢奥奬奯奷 奏夨奮天 奷奩奴奨 奴奩奭奥
奣奯奭奰奬奥奸奩奴奩奥女央

奏奮奥 奣奯奵奬奤 奡奲奧奵奥 奴奨奡奴 奉奤奲奩女 奩奮 奦奡奣奴 奣奯奭奰奩奬奥女 Nat 奶奩奡 奇奍奐 奢奵奴 奴奨奡奴’女 奡 奭奯奯奴 奰奯奩奮奴 奦奯奲 奴奷奯 奲奥奡女奯奮女夺

• 奆奩奲女奴夬 奷奨奥奮奥奶奥奲 奷奥 奴奲她 奴奯 奩奮奤奥奸 奯奵奲 奤奡奴奡 女奴奲奵奣奴奵奲奥女 奷奩奴奨 奡奮她奴奨奩奮奧 奥奬女奥 奴奨奡奮 Nat夬 奴奨奥 奣奯奭奰奩奬奥奲 奩女
奮奯奴 奧奯奩奮奧 奴奯 奣奯奭奥 奴奯 奴奨奥 奲奥女奣奵奥央

• 奓奥奣奯奮奤夬 奥奶奥奮 奷奩奴奨 Nat夬 奴奨奥 奇奍奐 奩奮奴奥奧奥奲女 奡奲奥 still 奴奨奥奲奥 奡奮奤 奴奨奥她 女奬奯奷 奴奨奥 奲奵奮奴奩奭奥 奤奯奷奮央

奔奨奩女 奯奵奧奨奴 奮奯奴 奴奯 奢奥 奴奨奥 奣奡女奥 女奩奮奣奥 奴奨奥 Nat 奡奲奥 奮奥奶奥奲 奵女奥奤 奡奴 奲奵奮奴奩奭奥 奡奮奤 奴奨奥她 奡奲奥 奯奮奬她 奴奨奥奲奥 奦奯奲
奴她奰奥奣奨奥奣奫奩奮奧 奰奵奲奰奯女奥女央 奈奥奮奣奥 奷奥 女奨奯奵奬奤 奧奥奴 奲奩奤 奯奦 奴奨奥奭 奡奮奤 奧奥奴 奲奵奮奴奩奭奥 奣奯奤奥 女奩奭奩奬奡奲 奴奯 奷奨奡奴 奡奮 奉奤奲奩女
奰奲奯奧奲奡奭奭奥奲 奷奯奵奬奤 奷奲奩奴奥央

U-views of lists

• 奏夨奮奞夲天 奩奮女奴奥奡奤 奯奦 奏夨奮天

奃奯奮女奩奤奥奲 奴奨奥 奴她奰奥 奯奦 奕夭奶奩奥奷女 奯奦 奬奩女奴女夺

data U : List a -> Type where
nil : U []
one : (z : a) -> U [z]
two : {xs : List a} -> (x : a) -> (u : U xs) -> (y : a) -> U (x :: xs ++ [y])

奆奯奲 奢奥奴奴奥奲 奩奮奴奵奩奴奩奯奮夬 奴奨奥 女奨奡奰奥 奯奦 奴奨奥 奕夭奶奩奥奷 奯奦 [x0,x1,x2,z,y2,y1,y0] 奬奯奯奫女 奬奩奫奥 奴奨奩女夺

x0 y0 (two)
x1 y1 (two)
x2 y2 (two)

z (one)

套奨奥奮 奲奥奣奵奲女奩奮奧 奯奶奥奲 奴奨奩女 女奴奲奵奣奴奵奲奥夬 奴奨奥 奶奡奬奵奥女 奯奦 xs 奲奡奮奧奥 奯奶奥奲 [x0,x1,x2,z,y2,y1,y0]夬 [x1,x2,z,
y2,y1]夬 [x2,z,y2]夬 [z]央 奎奯 奭奡奴奴奥奲 奷奨奥奴奨奥奲 奴奨奥女奥 奬奩女奴女 奡奲奥 女奴奯奲奥奤 奯奲 奢奵奩奬奴 奯奮 奤奥奭奡奮奤夬 奴奨奥她 奴奡奫奥 奵奰 奡
奱奵奡奤奲奡奴奩奣 奡奭奯奵奮奴 奯奦 奭奥奭奯奲她 夨奢奥奣奡奵女奥 奴奨奥她 奣奡奮奮奯奴 女奨奡奲奥 奮奯奤奥女天夬 奡奮奤 奨奥奮奣奥 奩奴 奴奡奫奥女 奡 奱奵奡奤奲奡奴奩奣 奡奭奯奵奮奴
奯奦 奴奩奭奥 奪奵女奴 奴奯 奢奵奩奬奤 奶奡奬奵奥女 奯奦 奴奨奩女 奩奮奤奥奸 奡奬奯奮奥央

奂奵奴 奴奨奥 奲奥奡女奯奮奡奢奬奥 奥奸奰奥奣奴奡奴奩奯奮 奩女 奴奨奡奴 奯奰奥奲奡奴奩奯奮女 奷奩奴奨 奕夭奶奩奥奷女 奴奡奫奥 奬奩奮奥奡奲 奴奩奭奥 — 女奯 奷奥 奮奥奥奤 奴奯 奥奲奡女奥
奴奨奥 奩奮奤奥奸 xs 奩奦 奷奥 奷奡奮奴 奴奯 奡奣奨奩奥奶奥 奴奨奩女 奧奯奡奬央
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6.7.2 Changes to Idris

奕女奡奧奥 奡奮奡奬她女奩女 奩女 奲奵奮 奡奴 奥奶奥奲她 奣奯奭奰奩奬奡奴奩奯奮 奡奮奤 奩奴女 奯奵奴奰奵奴女 奡奲奥 奵女奥奤 奦奯奲 奶奡奲奩奯奵女 奰奵奲奰奯女奥女央 奔奨奩女 奩女 奡奣奴奵奡奬奬她
奩奮奶奩女奩奢奬奥 奴奯 奴奨奥 奵女奥奲 奢奵奴 奩奴’女 奡 奲奥奬奡奴奩奶奥奬她 奢奩奧 奡奮奤 奩奭奰奯奲奴奡奮奴 奣奨奡奮奧奥夬 奷奨奩奣奨 奥奮奡奢奬奥女 奴奨奥 奮奥奷 奦奥奡奴奵奲奥女央

奅奶奥奲她奴奨奩奮奧 奴奨奡奴 奩女 奦奯奵奮奤 奴奯 奢奥 奵奮奵女奥奤 奩女 奥奲奡女奥奤央 奎奯 奡奮奮奯奴奡奴奩奯奮女 奡奲奥 奮奥奥奤奥奤夬 奪奵女奴 奤奯奮’奴 奵女奥 奴奨奥 奴奨奩奮奧
奡奮奤 奩奴 奷奩奬奬 奶奡奮奩女奨 奦奲奯奭 奴奨奥 奧奥奮奥奲奡奴奥奤 奣奯奤奥央 奈奯奷奥奶奥奲夬 奩奦 她奯奵 奷奩女奨夬 她奯奵 奣奡奮 奵女奥 奴奨奥 奤奯奴 奡奮奮奯奴奡奴奩奯奮女 奴奯 奧奥奴
奡 奷奡奲奮奩奮奧 奩奦 奴奨奥 奴奨奩奮奧 奩女 奡奣奣奩奤奥奮奴奡奬奬她 奵女奥奤央

“奂奥奩奮奧 奵女奥奤” 奩奮 奴奨奩女 奣奯奮奴奥奸奴 奭奥奡奮女 奴奨奡奴 奴奨奥 奶奡奬奵奥 奯奦 奴奨奥 “奴奨奩奮奧” 奭奡她 奩奮夝奵奥奮奣奥 奲奵奮夭奴奩奭奥 奢奥奨奡奶奩奯奵奲
奯奦 奴奨奥 奰奲奯奧奲奡奭央 夨奍奯奲奥 奰奲奥奣奩女奥奬她夬 奩奴 奩女 奮奯奴 奦奯奵奮奤 奴奯 奢奥 奩奲奲奥奬奥奶奡奮奴 奴奯 奴奨奥 奲奵奮夭奴奩奭奥 奢奥奨奡奶奩奯奵奲 奢她 奴奨奥 奵女奡奧奥
奡奮奡奬她女奩女 奡奬奧奯奲奩奴奨奭央天

“奔奨奩奮奧女” 奣奯奮女奩奤奥奲奥奤 奦奯奲 奲奥奭奯奶奡奬 奢她 奥奲奡女奵奲奥 奩奮奣奬奵奤奥夺

• 奦奵奮奣奴奩奯奮 奡奲奧奵奭奥奮奴女

• 奤奡奴奡 奣奯奮女奴奲奵奣奴奯奲 夜奥奬奤女 夨奩奮奣奬奵奤奩奮奧 奲奥奣奯奲奤 夜奥奬奤女 奡奮奤 奤奩奣奴奩奯奮奡奲她 夜奥奬奤女 奯奦 奩奮奴奥奲奦奡奣奥 奩奭奰奬奥奭奥奮奴奡奴奩奯奮女天

奆奯奲 奥奸奡奭奰奬奥夬 Either 奯奦奴奥奮 奣奯奭奰奩奬奥女 奴奯 奴奨奥 女奡奭奥 奲奵奮奴奩奭奥 奲奥奰奲奥女奥奮奴奡奴奩奯奮 奡女 Bool央 奃奯奮女奴奲奵奣奴奯奲 夜奥奬奤
奲奥奭奯奶奡奬 女奯奭奥奴奩奭奥女 奣奯奭奢奩奮奥女 奷奩奴奨 奴奨奥 奮奥奷奴她奰奥 奯奰奴奩奭奩女奡奴奩奯奮 奴奯 奨奡奶奥 奱奵奩奴奥 奡 女奴奲奯奮奧 奥夛奥奣奴央

奔奨奥奲奥 奩女 奡 奮奥奷 奣奯奭奰奩奬奥奲 奯奰奴奩奯奮 --warnreach夬 奷奨奩奣奨 奷奩奬奬 奥奮奡奢奬奥 奷奡奲奮奩奮奧女 奣奯奭奩奮奧 奦奲奯奭 奥奲奡女奵奲奥央 奓奩奮奣奥
奷奥 奨奡奶奥 奦奵奬奬 奵女奡奧奥 奡奮奡奬她女奩女夬 奷奥 奣奡奮 奣奯奭奰奩奬奥 奥奶奥奮 奴奨奯女奥 奰奲奯奧奲奡奭女 奴奨奡奴 奶奩奯奬奡奴奥 奥奲奡女奵奲奥 奡奮奮奯奴奡奴奩奯奮女 夕 奩奴’女
奪奵女奴 奴奨奡奴 奴奨奥 奢奩奮奡奲奩奥女 奭奡她 奲奵奮 女奬奯奷奥奲 奴奨奡奮 奥奸奰奥奣奴奥奤央 奔奨奥 奷奡奲奮奩奮奧女 奷奩奬奬 奢奥 奥奮奡奢奬奥奤 奢她 奤奥奦奡奵奬奴 奩奮 奦奵奴奵奲奥
奶奥奲女奩奯奮女 奯奦 奉奤奲奩女 夨奡奮奤 奰奯女女奩奢奬她 奴奵奲奮奥奤 奴奯 奥奲奲奯奲女天央 奈奯奷奥奶奥奲夬 奩奮 奴奨奩女 奴奲奡奮女奩奴奩奯奮奡奬 奰奥奲奩奯奤夬 奷奥 奣奨奯女奥 奴奯 奫奥奥奰
奴奨奥奭 奯奮夭奤奥奭奡奮奤 奴奯 奡奶奯奩奤 奣奯奮奦奵女奩奯奮 奵奮奴奩奬 奢奥奴奴奥奲 奤奯奣奵奭奥奮奴奡奴奩奯奮 奩女 奷奲奩奴奴奥奮央

奃奡女奥夭奴奲奥奥 奥奬奡奢奯奲奡奴奩奯奮 奴奲奩奥女 奴奯 奡奶奯奩奤 奵女奩奮奧 奤奯奴奴奥奤 “奴奨奩奮奧女” 奷奨奥奮奥奶奥奲 奰奯女女奩奢奬奥央 夨奎奂央 奔奨奩女 奩女 奮奯奴 她奥奴
奰奥奲奦奥奣奴 奡奮奤 奩奴’女 奢奥奩奮奧 奷奯奲奫奥奤 奯奮夺 奨奴奴奰女夺夯夯奧奩女奴央奧奩奴奨奵奢央奣奯奭夯奺奩奭奡奮夯失夰头夵夸夳夳失天

奐奯女奴奵奬奡奴奥女 奡奲奥 奮奯 奬奯奮奧奥奲 奲奥奱奵奩奲奥奤 奴奯 奢奥 奣奯奬奬奡奰女奩奢奬奥央 奔奨奥她 奡奲奥 奮奯奷 奲奥奱奵奩奲奥奤 奴奯 奢奥 unused 奩奮女奴奥奡奤央

6.7.3 Changes to the language

奙奯奵 奣奡奮 奵女奥 奤奯奴女 奴奯 奭奡奲奫 夜奥奬奤女 奴奨奡奴 奡奲奥 奮奯奴 奩奮奴奥奮奤奥奤 奴奯 奢奥 奵女奥奤 奡奴 奲奵奮奴奩奭奥央

data Bin : Nat -> Type where
N : Bin 0
O : .{n : Nat} -> Bin n -> Bin (0 + 2*n)
I : .{n : Nat} -> Bin n -> Bin (1 + 2*n)

奉奦 奴奨奥女奥 夜奥奬奤女 奡奲奥 奦奯奵奮奤 奴奯 奢奥 奵女奥奤 奡奴 奲奵奮奴奩奭奥夬 奴奨奥 奤奯奴女 奷奩奬奬 奴奲奩奧奧奥奲 奡 奷奡奲奮奩奮奧 夨奷奩奴奨 --warnreach天央

奎奯奴奥 奴奨奡奴 奦奲奥奥 夨奵奮奢奯奵奮奤天 奩奭奰奬奩奣奩奴女 奡奲奥 奤奯奴奴奥奤 奢她 奤奥奦奡奵奬奴 女奯夬 奦奯奲 奥奸奡奭奰奬奥夬 奴奨奥 奣奯奮女奴奲奵奣奴奯奲 O 奣奡奮 奢奥 奤奥夜奮奥奤
奡女夺

O : Bin n -> Bin (0 + 2*n)

奡奮奤 奴奨奩女 奩女 奡奣奴奵奡奬奬她 奴奨奥 奰奲奥奦奥奲奲奥奤 奦奯奲奭央

奉奦 她奯奵 奨奡奶奥 奡 奦奲奥奥 奩奭奰奬奩奣奩奴 奷奨奩奣奨 奩女 奭奥奡奮奴 奴奯 奢奥 奵女奥奤 奡奴 奲奵奮奴奩奭奥夬 她奯奵 奨奡奶奥 奴奯 奣奨奡奮奧奥 奩奴 奩奮奴奯 奡奮 夨奵奮奤奯奴奴奥奤天
{bound : implicit}央

奙奯奵 奣奡奮 奡奬女奯 奰奵奴 奤奯奴女 奩奮 奴她奰奥女 奯奦 奦奵奮奣奴奩奯奮女 奴奯 奧奥奴 奭奯奲奥 奧奵奡奲奡奮奴奥奥女央

half : (n : Nat) -> .(pf : Even n) -> Nat

奡奮奤 奦奲奥奥 奩奭奰奬奩奣奩奴女 奡奲奥 奡奵奴奯奭奡奴奩奣奡奬奬她 奤奯奴奴奥奤 奨奥奲奥夬 奴奯奯央
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6.7.4 What it means

奄奯奴 奡奮奮奯奴奡奴奩奯奮女 女奥奲奶奥 奴奷奯 奰奵奲奰奯女奥女夺

• 奩奮夝奵奥奮奣奥 奣奡女奥夭奴奲奥奥 奥奬奡奢奯奲奡奴奩奯奮 奴奯 奡奶奯奩奤 奤奯奴奴奥奤 奶奡奲奩奡奢奬奥女

• 奴奲奩奧奧奥奲 奷奡奲奮奩奮奧女 奷奨奥奮 奡 奤奯奴奴奥奤 奶奡奲奩奡奢奬奥 奩女 奵女奥奤

奈奯奷奥奶奥奲夬 奴奨奥奲奥’女 奮奯 奤奩奲奥奣奴 奣奯奮奮奥奣奴奩奯奮 奢奥奴奷奥奥奮 奢奥奩奮奧 奤奯奴奴奥奤 奡奮奤 奢奥奩奮奧 奥奲奡女奥奤央 奔奨奥 奣奯奭奰奩奬奥奲 奥奲奡女奥女
奥奶奥奲她奴奨奩奮奧 奩奴 奣奡奮夬 奤奯奴奴奥奤 奯奲 奮奯奴央 奔奨奥 奤奯奴女 奡奲奥 奴奨奥奲奥 奭奡奩奮奬她 奴奯 奨奥奬奰 奴奨奥 奰奲奯奧奲奡奭奭奥奲 夨奡奮奤 奴奨奥 奣奯奭奰奩奬奥奲天
奲奥奦奲奡奩奮 奦奲奯奭 奵女奩奮奧 奴奨奥 奶奡奬奵奥女 奴奨奥她 奷奡奮奴 奴奯 奥奲奡女奥央

6.7.5 How to use it

奉奤奥奡奬奬她夬 奦奥奷 奯奲 奮奯 奥奸奴奲奡 奡奮奮奯奴奡奴奩奯奮女 奡奲奥 奮奥奥奤奥奤 夕 奩奮 奰奲奡奣奴奩奣奥夬 奩奴 奴奵奲奮女 奯奵奴 奴奨奡奴 奨奡奶奩奮奧 奦奲奥奥 奩奭奰奬奩奣奩奴女
奡奵奴奯奭奡奴奩奣奡奬奬她 奤奯奴奴奥奤 奩女 奥奮奯奵奧奨 奴奯 奧奥奴 奧奯奯奤 奥奲奡女奵奲奥央

奔奨奥奲奥奦奯奲奥夬 奪奵女奴 奣奯奭奰奩奬奥 奷奩奴奨 --warnreach 奴奯 女奥奥 奷奡奲奮奩奮奧女 奩奦 奥奲奡女奵奲奥 奣奡奮奮奯奴 奲奥奭奯奶奥 奰奡奲奴女 奯奦 奴奨奥 奰奲奯奧奲奡奭央

奈奯奷奥奶奥奲夬 奴奨奯女奥 奰奲奯奧奲奡奭女 奴奨奡奴 奨奡奶奥 奢奥奥奮 奷奲奩奴奴奥奮 奷奩奴奨奯奵奴 奲奵奮奴奩奭奥 奢奥奨奡奶奩奯奵奲 奩奮 奭奩奮奤夬 奷奩奬奬 奮奥奥奤 女奯奭奥
奨奥奬奰 奴奯 奧奥奴 奩奮 奴奨奥 奦奯奲奭 奴奨奡奴 奣奯奭奰奩奬奥女 奴奯 奡 奲奥奡女奯奮奡奢奬奥 奢奩奮奡奲她央 奇奥奮奥奲奡奬奬她夬 奩奴’女 女奵夞奣奩奥奮奴 奴奯 奦奯奬奬奯奷 奥奲奡女奵奲奥
奷奡奲奮奩奮奧女 夨奷奨奩奣奨 奭奡她 奢奥 女奯奭奥奴奩奭奥女 奵奮奨奥奬奰奦奵奬 奡奴 奴奨奥 奭奯奭奥奮奴天央

6.7.6 Benchmarks

• 女奯奵奲奣奥夺 奨奴奴奰女夺夯夯奧奩奴奨奵奢央奣奯奭夯奺奩奭奡奮夯奩奤奲奩女夭奢奥奮奣奨奭奡奲奫女

• 奲奥女奵奬奴女夺 奨奴奴奰夺夯夯奺奩奭奡奮央奦奵奮奣奴奯奲央女奫夯奥奲奡女奵奲奥夭奢奭夯

奉奴 奣奡奮 奢奥 奣奬奥奡奲奬她 女奥奥奮 奴奨奡奴 奡女她奭奰奴奯奴奩奣女 奡奲奥 奩奭奰奲奯奶奥奤 奢她 奥奲奡女奵奲奥央

6.7.7 Shortcomings

奙奯奵 奣奡奮’奴 奧奥奴 奷奡奲奮奩奮奧女 奩奮 奬奩奢奲奡奲奩奥女 奢奥奣奡奵女奥 奵女奡奧奥 奡奮奡奬她女奩女 女奴奡奲奴女 奦奲奯奭 Main.main央 奔奨奩女 奷奩奬奬 奢奥 女奯奬奶奥奤
奢她 奴奨奥 奰奬奡奮奮奥奤 %default_usage 奰奲奡奧奭奡央

奕女奡奧奥 奷奡奲奮奩奮奧女 奡奲奥 奱奵奩奴奥 奢奡奤 奡奮奤 奵奮奨奥奬奰奦奵奬 奡奴 奴奨奥 奭奯奭奥奮奴央 套奥 女奨奯奵奬奤 奩奮奣奬奵奤奥 奭奯奲奥 奩奮奦奯奲奭奡奴奩奯奮 奡奮奤
奡奴 奬奥奡女奴 奴奲奡奮女奬奡奴奥 奡奲奧奵奭奥奮奴 奮奵奭奢奥奲女 奴奯 奴奨奥奩奲 奮奡奭奥女央

奔奨奥奲奥 奩女 奮奯 奤奥奣奥奮奴 奤奯奣奵奭奥奮奴奡奴奩奯奮 她奥奴央 奔奨奩女 奷奩奫奩 奰奡奧奥 奩女 奴奨奥 夜奲女奴 奯奮奥央

奔奨奥奲奥 奩女 奮奯 奧奥奮奥奲奡奬奬她 奡奣奣奥奰奴奥奤 奴奥奲奭奩奮奯奬奯奧她央 套奥 女奷奩奴奣奨 奢奥奴奷奥奥奮 “奤奯奴奴奥奤”夬 “奵奮奵女奥奤”夬 “奥奲奡女奥奤”夬
“奩奲奲奥奬奥奶奡奮奴”夬 “奩奮奡奣奣奥女女奩奢奬奥”夬 奷奨奩奬奥 奥奡奣奨 奨奡女 奡 女奬奩奧奨奴奬她 奤奩夛奥奲奥奮奴 奭奥奡奮奩奮奧央 套奥 奮奥奥奤 奭奯奲奥 奣奯奮女奩女奴奥奮奴
奡奮奤 奵奮奤奥奲女奴奡奮奤奡奢奬奥 奮奡奭奩奮奧央

奉奦 奴奨奥 女奡奭奥 奴她奰奥 奩女 奵女奥奤 奩奮 奢奯奴奨 奥奲奡女奥奤 奡奮奤 奮奯奮夭奥奲奡女奥奤 奣奯奮奴奥奸奴夬 奩奴 奷奩奬奬 奲奥奴奡奩奮 奩奴女 夜奥奬奤女 奴奯 奡奣奣奯奭奭奯奤奡奴奥
奴奨奥 奬奥奡女奴 奣奯奭奭奯奮 奤奥奮奯奭奩奮奡奴奯奲 夕 奴奨奥 奮奯奮夭奥奲奡女奥奤 奣奯奮奴奥奸奴央 奔奨奩女 奩女 奰奡奲奴奩奣奵奬奡奲奬她 奴奲奯奵奢奬奥女奯奭奥 奩奮 奴奨奥 奣奡女奥
奯奦 奴奨奥 奴她奰奥 奯奦 夨奤奥奰奥奮奤奥奮奴天 奰奡奩奲女夬 奷奨奥奲奥 奩奴 奡奣奴奵奡奬奬她 奭奥奡奮女 奴奨奡奴 奮奯 奥奲奡女奵奲奥 奷奯奵奬奤 奢奥 奰奥奲奦奯奲奭奥奤央 套奥
女奨奯奵奬奤 奰奲奯奢奡奢奬她 奬奯奣奡奴奥 奤奩女奪奯奩奮奴 奵女奥女 奯奦 奤奡奴奡 奴她奰奥女 奡奮奤 女奰奬奩奴 奴奨奥奭 奩奮奴奯 “女奵奢夭奴她奰奥女”央 奔奨奥奲奥 奡奲奥 奴奨奲奥奥
奤奩夛奥奲奥奮奴 夝奡奶奯奵奲女 奯奦 奤奥奰奥奮奤奥奮奴 奴她奰奥女 奮奯奷夺 Sigma 夨奮奯奴奨奩奮奧 奥奲奡女奥奤天夬 Exists 夨夜奲女奴 奣奯奭奰奯奮奥奮奴 奥奲奡女奥奤天夬
Subset 夨女奥奣奯奮奤 奣奯奭奰奯奮奥奮奴 奥奲奡女奥奤天央

奃奡女奥夭奴奲奥奥 奢奵奩奬奤奩奮奧 奤奯奥女 奮奯奴 奡奶奯奩奤 奤奯奴奴奥奤 奶奡奬奵奥女 奣奯奭奩奮奧 奦奲奯奭 奰奡奴奴奥奲奮夭奭奡奴奣奨奥奤 奣奯奮女奴奲奵奣奴奯奲女 夨奨奴奴奰女夺夯夯奧奩女奴央
奧奩奴奨奵奢央奣奯奭夯奺奩奭奡奮夯失夰头夵夸夳夳失天央 奔奨奩女 奩女 奴奯 奢奥 夜奸奥奤 女奯奯奮央 夨奆奩奸奥奤央天
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奈奩奧奨奥奲夭奯奲奤奥奲 奦奵奮奣奴奩奯奮 奡奲奧奵奭奥奮奴女 奡奮奤 奯奰奡奱奵奥 奦奵奮奣奴奩奯奮奡奬 奶奡奲奩奡奢奬奥女 奡奲奥 奣奯奮女奩奤奥奲奥奤 奴奯 奢奥 奵女奩奮奧 奡奬奬 奴奨奥奩奲
奡奲奧奵奭奥奮奴女央 奔奯 奷奯奲奫 奡奲奯奵奮奤 奴奨奩女夬 她奯奵 奣奡奮 奦奯奲奣奥 奥奲奡女奵奲奥 奶奩奡 奴奨奥 奴她奰奥 女她女奴奥奭夬 奵女奩奮奧 奴奨奥 Erased 奷奲奡奰奰奥奲夺
奨奴奴奰女夺夯夯奧奩奴奨奵奢央奣奯奭夯奩奤奲奩女夭奬奡奮奧夯奉奤奲奩女夭奤奥奶夯奢奬奯奢夯奭奡女奴奥奲夯奬奩奢女夯奢奡女奥夯奄奡奴奡夯奅奲奡女奥奤央奩奤奲

奉奮奴奥奲奦奡奣奥 奭奥奴奨奯奤女 奡奲奥 奣奯奮女奩奤奥奲奥奤 奴奯 奢奥 奵女奩奮奧 奴奨奥 奵奮奩奯奮 奯奦 奡奬奬 奴奨奥奩奲 奩奭奰奬奥奭奥奮奴奡奴奩奯奮女央 奉奮 奯奴奨奥奲 奷奯奲奤女夬 奡奮
奡奲奧奵奭奥奮奴 奯奦 奡 奭奥奴奨奯奤 奩女 奵奮奵女奥奤 奯奮奬她 奩奦 奩奴 奩女 奵奮奵女奥奤 奩奮 奥奶奥奲她 奩奭奰奬奥奭奥奮奴奡奴奩奯奮 奯奦 奴奨奥 奭奥奴奨奯奤 奴奨奡奴 奯奣奣奵奲女
奩奮 奴奨奥 奰奲奯奧奲奡奭央

6.7.8 Planned features

• 奆奩奸奥女 奴奯 奴奨奥 奡奢奯奶奥 女奨奯奲奴奣奯奭奩奮奧女 奩奮 奧奥奮奥奲奡奬央

• Improvements to the case-tree elaborator so that it properly avoids 奤奯奴奴奥奤 夜奥奬奤女 奯奦
奤奡奴奡 奣奯奮女奴奲奵奣奴奯奲女央 奄奯奮奥央

• Compiler pragma %default_usage used/unused and per-function 奯奶奥奲奲奩奤奥女 used 奡奮奤
unused夬 奷奨奩奣奨 奡奬奬奯奷 奴奨奥 奰奲奯奧奲奡奭奭奥奲 奴奯 奭奡奲奫 奴奨奥 奲奥奴奵奲奮 奶奡奬奵奥 奯奦 奡 奦奵奮奣奴奩奯奮 奡女 奵女奥奤夬 奥奶奥奮
奩奦 奴奨奥 奦奵奮奣奴奩奯奮 奩女 奮奯奴 奵女奥奤 奩奮 main 夨奷奨奩奣奨 奩女 奴奨奥 奣奡女奥 奷奨奥奮 奷奲奩奴奩奮奧 奬奩奢奲奡奲她 奣奯奤奥天央 奔奨奥女奥
奡奮奮奯奴奡奴奩奯奮女 奷奩奬奬 奨奥奬奰 奬奩奢奲奡奲她 奷奲奩奴奥奲女 奤奩女奣奯奶奥奲 奵女奡奧奥 奶奩奯奬奡奴奩奯奮女 奩奮 奴奨奥奩奲 奣奯奤奥 奢奥奦奯奲奥 奩奴 奩女
奡奣奴奵奡奬奬她 奰奵奢奬奩女奨奥奤 奡奮奤 奵女奥奤 奩奮 奣奯奭奰奩奬奥奤 奰奲奯奧奲奡奭女央

6.7.9 Troubleshooting

My program is slower

奔奨奥 奰奡奴奣奨 奩奮奴奲奯奤奵奣奩奮奧 奥奲奡女奵奲奥 奢她 奵女奡奧奥 奡奮奡奬她女奩女 奡奬女奯 奤奩女奡奢奬奥奤 女奯奭奥 奯奰奴奩奭奩女奡奴奩奯奮女 奴奨奡奴 奷奥奲奥 奩奮 奰奬奡奣奥
奢奥奦奯奲奥夻 奴奨奥女奥 奡奲奥 女奵奢女奵奭奥奤 奢她 奴奨奥 奮奥奷 奥奲奡女奵奲奥央 奈奯奷奥奶奥奲夬 奩奮 女奯奭奥 奥奲奡女奵奲奥夭奵奮奡奷奡奲奥 奰奲奯奧奲奡奭女夬 奷奨奥奲奥
奥奲奡女奵奲奥 奢她 奵女奡奧奥 奡奮奡奬她女奩女 奤奯奥女 奮奯奴 奥奸奥奲奣奩女奥 奩奴女 奦奵奬奬 奰奯奴奥奮奴奩奡奬 夨奢奵奴 奴奨奥 奯奬奤 奯奰奴奩奭奩女奡奴奩奯奮女 奷奯奵奬奤 奨奡奶奥
奷奯奲奫奥奤天夬 奣奥奲奴奡奩奮 女奬奯奷奤奯奷奮 奭奡她 奢奥 奯奢女奥奲奶奥奤 夨奵奰 奴奯 奾失夰夥 奡奣奣奯奲奤奩奮奧 奴奯 奰奲奥奬奩奭奩奮奡奲她 奢奥奮奣奨奭奡奲奫奩奮奧天夬 奤奵奥
奴奯 奲奥奴奥奮奴奩奯奮 奡奮奤 奣奯奭奰奵奴奡奴奩奯奮 奯奦 奩奮奦奯奲奭奡奴奩奯奮 奴奨奡奴 女奨奯奵奬奤 奮奯奴 奢奥 奮奥奣奥女女奡奲她 奡奴 奲奵奮奴奩奭奥央

奁 女奩奭奰奬奥 奣奨奥奣奫 奷奨奥奴奨奥奲 奴奨奩女 奩女 奴奨奥 奣奡女奥 奩女 奴奯 奣奯奭奰奩奬奥 奷奩奴奨 --warnreach央 奉奦 她奯奵 女奥奥 奷奡奲奮奩奮奧女夬 奴奨奥奲奥 奩女
女奯奭奥 奵奮奮奥奣奥女女奡奲她 奣奯奤奥 奧奥奴奴奩奮奧 奣奯奭奰奩奬奥奤 奩奮奴奯 奴奨奥 奢奩奮奡奲她央

奔奨奥 女奯奬奵奴奩奯奮 奩女 奴奯 奣奨奡奮奧奥 奴奨奥 奣奯奤奥 女奯 奴奨奡奴 奴奨奥奲奥 奡奲奥 奮奯 奷奡奲奮奩奮奧女央

Usage warnings are unhelpful

奔奨奩女 奩女 奡 奫奮奯奷奮 奩女女奵奥 奡奮奤 奷奥 奡奲奥 奷奯奲奫奩奮奧 奯奮 奩奴央 奆奯奲 奮奯奷夬 女奥奥 奴奨奥 女奥奣奴奩奯奮 How to read and resolve erasure
warnings 夨姩妡妵 失夷夶天央

There should be no warnings in this function

奁 奰奯女女奩奢奬奥 奣奡奵女奥 奩女 奮奯奮夭奴奯奴奡奬奩奴她 奯奦 奴奨奥 奦奵奮奣奴奩奯奮 夨奭奯奲奥 奰奲奥奣奩女奥奬她夬 奮奯奮夭奣奯奶奥奲奡奧奥天央 奉奦 奡 奦奵奮奣奴奩奯奮 奩女 奮奯奮夭
奣奯奶奥奲奩奮奧夬 奴奨奥 奰奲奯奧奲奡奭 奮奥奥奤女 奴奯 奩奮女奰奥奣奴 奡奬奬 奡奲奧奵奭奥奮奴女 奩奮 奯奲奤奥奲 奴奯 奤奥奴奥奣奴 奣奯奶奥奲奡奧奥 奦奡奩奬奵奲奥女 奡奴 奲奵奮奴奩奭奥央
奓奩奮奣奥 奴奨奥 奦奵奮奣奴奩奯奮 奩奮女奰奥奣奴女 奡奬奬 奩奴女 奡奲奧奵奭奥奮奴女夬 奮奯奴奨奩奮奧 奣奡奮 奢奥 奥奲奡女奥奤 奡奮奤 奴奨奩女 奭奡她 奴奲奡奮女奩奴奩奶奥奬她 奣奡奵女奥 奵女奡奧奥
奶奩奯奬奡奴奩奯奮女央 奔奨奥 女奯奬奵奴奩奯奮 奩女 奴奯 奭奡奫奥 奴奨奥 奦奵奮奣奴奩奯奮 奴奯奴奡奬 奯奲 奡奣奣奥奰奴 奴奨奥 奦奡奣奴 奴奨奡奴 奩奴 奷奩奬奬 奵女奥 奩奴女 奡奲奧奵奭奥奮奴女
奡奮奤 奲奥奭奯奶奥 女奯奭奥 奤奯奴女 奦奲奯奭 奴奨奥 奡奰奰奲奯奰奲奩奡奴奥 奣奯奮女奴奲奵奣奴奯奲 夜奥奬奤女 奡奮奤 奦奵奮奣奴奩奯奮 奡奲奧奵奭奥奮奴女央 夨奐奬奥奡女奥 奮奯奴奥 奴奨奡奴
奴奨奩女 奩女 奮奯奴 奡 女奨奯奲奴奣奯奭奩奮奧 奯奦 奥奲奡女奵奲奥 奡奮奤 奴奨奥奲奥 奩女 奮奯奴奨奩奮奧 奷奥 奣奡奮 奤奯 奡奢奯奵奴 奩奴央天

奁奮奯奴奨奥奲 奰奯女女奩奢奬奥 奣奡奵女奥 奩女 奴奨奥 奣奵奲奲奥奮奴奬她 奩奭奰奥奲奦奥奣奴 奣奡女奥夭奴奲奥奥 奥奬奡奢奯奲奡奴奩奯奮夬 奷奨奩奣奨 奤奯奥女 奮奯奴 奡奶奯奩奤 奤奯奴奴奥奤
奣奯奮女奴奲奵奣奴奯奲 夜奥奬奤女 夨女奥奥 奨奴奴奰女夺夯夯奧奩女奴央奧奩奴奨奵奢央奣奯奭夯奺奩奭奡奮夯失夰头夵夸夳夳失天央 奙奯奵 奣奡奮 奥奩奴奨奥奲 奲奥奰奨奲奡女奥 奴奨奥 奦奵奮奣奴奩奯奮
奯奲 奷奡奩奴 奵奮奴奩奬 奴奨奩女 奩女 夜奸奥奤夬 奨奯奰奥奦奵奬奬她 女奯奯奮央 奆奩奸奥奤央
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The compiler refuses to recognise this thing as erased

奙奯奵 奣奡奮 奦奯奲奣奥 奡奮她奴奨奩奮奧 奴奯 奢奥 奥奲奡女奥奤 奢她 奷奲奡奰奰奩奮奧 奩奴 奩奮 奴奨奥 Erased 奭奯奮奡奤央 套奨奩奬奥 奴奨奩女 奰奲奯奧奲奡奭 奴奲奩奧奧奥奲女
奵女奡奧奥 奷奡奲奮奩奮奧女夬

f : (g : Nat -> Nat) -> .(x : Nat) -> Nat
f g x = g x -- WARNING: g uses x

奴奨奥 奦奯奬奬奯奷奩奮奧 奰奲奯奧奲奡奭 奤奯奥女 奮奯奴夺

f : (g : Erased Nat -> Nat) -> .(x : Nat) -> Nat
f g x = g (Erase x) -- OK

6.7.10 How to read and resolve erasure warnings

Example 1

奃奯奮女奩奤奥奲 奴奨奥 奦奯奬奬奯奷奩奮奧 奰奲奯奧奲奡奭夺

vlen : Vect n a -> Nat
vlen {n = n} xs = n

sumLengths : List (Vect n a) -> Nat
sumLengths [] = 0
sumLengths (v :: vs) = vlen v + sumLengths vs

main : IO ()
main = print . sumLengths $ [[0,1],[2,3]]

套奨奥奮 她奯奵 奣奯奭奰奩奬奥 奩奴 奵女奩奮奧 --warnreach夬 奴奨奥奲奥 奩女 奯奮奥 奷奡奲奮奩奮奧夺

Main.sumLengths: inaccessible arguments reachable:
n (no more information available)

奔奨奥 奷奡奲奮奩奮奧 奤奯奥女 奮奯奴 奣奯奮奴奡奩奮 奭奵奣奨 奤奥奴奡奩奬 奡奴 奴奨奩女 奰奯奩奮奴 女奯 奷奥 奣奡奮 奴奲她 奣奯奭奰奩奬奩奮奧 奷奩奴奨 --dumpcases
cases.txt 奡奮奤 奬奯奯奫 奵奰 奴奨奥 奣奯奭奰奩奬奥奤 奤奥夜奮奩奴奩奯奮 奩奮 cases.txt夺

Main.sumLengths {e0} {e1} {e2} =
case {e2} of
| Prelude.List.::({e6}) => LPlus (ATInt ITBig)({e0}, Main.sumLengths({e0}, ____, {e6}))
| Prelude.List.Nil() => 0

奔奨奥 奲奥奡女奯奮 奦奯奲 奴奨奥 奷奡奲奮奩奮奧 奩女 奴奨奡奴 sumLengths 奣奡奬奬女 vlen夬 奷奨奩奣奨 奧奥奴女 奩奮奬奩奮奥奤央 奔奨奥 女奥奣奯奮奤 奣奬奡奵女奥 奯奦
sumLengths 奴奨奥奮 奡奣奣奥女女奥女 奴奨奥 奶奡奲奩奡奢奬奥 n夬 奣奯奭奰奩奬奥奤 奡女 {e0}央 奓奩奮奣奥 n 奩女 奡 奦奲奥奥 奩奭奰奬奩奣奩奴夬 奩奴 奩女 奡奵奴奯奭奡奴奩奣奡奬奬她
奣奯奮女奩奤奥奲奥奤 奤奯奴奴奥奤 奡奮奤 奴奨奩女 奴奲奩奧奧奥奲女 奴奨奥 奷奡奲奮奩奮奧央

奁 女奯奬奵奴奩奯奮 奷奯奵奬奤 奢奥 奥奩奴奨奥奲 奭奡奫奩奮奧 奴奨奥 奡奲奧奵奭奥奮奴 n 奡 奢奯奵奮奤 奩奭奰奬奩奣奩奴 奰奡奲奡奭奥奴奥奲 奴奯 奩奮奤奩奣奡奴奥 奴奨奡奴 奷奥 奷奩女奨
奴奯 奫奥奥奰 奩奴 奡奴 奲奵奮奴奩奭奥夬

sumLengths : {n : Nat} -> List (Vect n a) -> Nat

奯奲 夜奸奩奮奧 vlen 奴奯 奮奯奴 奵女奥 奴奨奥 奩奮奤奥奸夺

vlen : Vect n a -> Nat
vlen [] = Z
vlen (x :: xs) = S (vlen xs)
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套奨奩奣奨 女奯奬奵奴奩奯奮 奩女 奡奰奰奲奯奰奲奩奡奴奥 奤奥奰奥奮奤女 奯奮 奴奨奥 奵女奥奣奡女奥央

Example 2

奃奯奮女奩奤奥奲 奴奨奥 奦奯奬奬奯奷奩奮奧 奰奲奯奧奲奡奭 奭奡奮奩奰奵奬奡奴奩奮奧 奶奡奬奵奥夭奩奮奤奥奸奥奤 奢奩奮奡奲她 奮奵奭奢奥奲女央

data Bin : Nat -> Type where
N : Bin Z
O : Bin n -> Bin (0 + n + n)
I : Bin n -> Bin (1 + n + n)

toN : (b : Bin n) -> Nat
toN N = Z
toN (O {n} bs) = 0 + n + n
toN (I {n} bs) = 1 + n + n

main : IO ()
main = print . toN $ I (I (O (O (I N))))

奉奮 奴奨奥 奦奵奮奣奴奩奯奮 toN夬 奷奥 奡奴奴奥奭奰奴奥奤 奴奯 “奣奨奥奡奴” 奡奮奤 奩奮女奴奥奡奤 奯奦 奴奲奡奶奥奲女奩奮奧 奴奨奥 奷奨奯奬奥 女奴奲奵奣奴奵奲奥夬 奷奥 奪奵女奴
奰奲奯奪奥奣奴奥奤 奴奨奥 奶奡奬奵奥 奩奮奤奥奸 n 奯奵奴 奯奦 奣奯奮女奴奲奵奣奴奯奲女 I 奡奮奤 O央 奈奯奷奥奶奥奲夬 奴奨奩女 奩奮奤奥奸 奩女 奡 奦奲奥奥 奩奭奰奬奩奣奩奴夬 奴奨奥奲奥奦奯奲奥
奩奴 奩女 奣奯奮女奩奤奥奲奥奤 奤奯奴奴奥奤央

奉奮女奰奥奣奴奩奮奧 奩奴 奴奨奥奮 奰奲奯奤奵奣奥女 奴奨奥 奦奯奬奬奯奷奩奮奧 奷奡奲奮奩奮奧女 奷奨奥奮 奣奯奭奰奩奬奩奮奧 奷奩奴奨 --warnreach夺

Main.I: inaccessible arguments reachable:
n from Main.toN arg# 1

Main.O: inaccessible arguments reachable:
n from Main.toN arg# 1

套奥 奣奡奮 女奥奥 奴奨奡奴 奴奨奥 奡奲奧奵奭奥奮奴 n 奯奦 奢奯奴奨 I 奡奮奤 O 奩女 奵女奥奤 奩奮 奴奨奥 奦奵奮奣奴奩奯奮 toN夬 奡奲奧奵奭奥奮奴 失央

奁奴 奴奨奩女 女奴奡奧奥 奯奦 奤奥奶奥奬奯奰奭奥奮奴夬 奷奡奲奮奩奮奧女 奯奮奬她 奣奯奮奴奡奩奮 奡奲奧奵奭奥奮奴 奮奵奭奢奥奲女夬 奮奯奴 奮奡奭奥女夻 奴奨奩女 奷奩奬奬 奨奯奰奥奦奵奬奬她 奢奥
夜奸奥奤央 套奨奥奮 奮奵奭奢奥奲奩奮奧 奡奲奧奵奭奥奮奴女夬 奷奥 奧奯 奦奲奯奭 夰夬 奴奡奫奩奮奧 奦奲奥奥 奩奭奰奬奩奣奩奴女 夜奲女奴夬 奬奥奦奴夭奴奯夭奲奩奧奨奴夻 奴奨奥奮 奴奨奥 奢奯奵奮奤
奡奲奧奵奭奥奮奴女央 奔奨奥 奦奵奮奣奴奩奯奮 toN 奨奡女 奴奨奥奲奥奦奯奲奥 奩奮 奦奡奣奴 奴奷奯 奡奲奧奵奭奥奮奴女夺 n 夨奡奲奧奵奭奥奮奴 夰天 奡奮奤 b 夨奡奲奧奵奭奥奮奴 失天央
奁奮奤 奩奮奤奥奥奤夬 奡女 奴奨奥 奷奡奲奮奩奮奧 女奡她女夬 奷奥 奰奲奯奪奥奣奴 奴奨奥 奤奯奴奴奥奤 夜奥奬奤 奦奲奯奭 b央

奁奧奡奩奮夬 奯奮奥 女奯奬奵奴奩奯奮 奩女 奴奯 夜奸 奴奨奥 奦奵奮奣奴奩奯奮 toN 奴奯 奣奡奬奣奵奬奡奴奥 奩奴女 奲奥女奵奬奴 奨奯奮奥女奴奬她夻 奴奨奥 奯奴奨奥奲 奯奮奥 奩女 奴奯 奡奣奣奥奰奴
奴奨奡奴 奷奥 奣奡奲奲她 奡 Nat 奷奩奴奨 奥奶奥奲她 奣奯奮女奴奲奵奣奴奯奲 奯奦 Bin 奡奮奤 奭奡奫奥 奩奴 奡 奢奯奵奮奤 奩奭奰奬奩奣奩奴夺

O : {n : Nat} -> Bin n -> Bin (0 + n + n)
I : {n : Nat} -> bin n -> Bin (1 + n + n)

6.7.11 References

6.8 The IDE Protocol

奔奨奥 奉奤奲奩女 奒奅奐奌 奨奡女 奴奷奯 奭奯奤奥女 奯奦 奩奮奴奥奲奡奣奴奩奯奮夺 奡 奨奵奭奡奮夭奲奥奡奤奡奢奬奥 女她奮奴奡奸 奤奥女奩奧奮奥奤 奦奯奲 奤奩奲奥奣奴 奵女奥 奩奮 奡
奴奥奲奭奩奮奡奬夬 奡奮奤 奡 奭奡奣奨奩奮奥夭奲奥奡奤奡奢奬奥 女她奮奴奡奸 奤奥女奩奧奮奥奤 奦奯奲 奵女奩奮奧 奉奤奲奩女 奡女 奡 奢奡奣奫奥奮奤 奦奯奲 奥奸奴奥奲奮奡奬 奴奯奯奬女央

6.8.1 Protocol Overview

奔奨奥 奣奯奭奭奵奮奩奣奡奴奩奯奮 奰奲奯奴奯奣奯奬 奩女 奯奦 奡女她奮奣奨奲奯奮奯奵女 奲奥奱奵奥女奴夭奲奥奰奬她 女奴她奬奥夺 奡 女奩奮奧奬奥 奲奥奱奵奥女奴 奦奲奯奭 奴奨奥 奣奬奩奥奮奴 奩女
奨奡奮奤奬奥奤 奢她 奉奤奲奩女 奡奴 奡 奴奩奭奥央 奉奤奲奩女 奷奡奩奴女 奦奯奲 奡 奲奥奱奵奥女奴 奯奮 奩奴女 女奴奡奮奤奡奲奤 奩奮奰奵奴 女奴奲奥奡奭夬 奡奮奤 奯奵奴奰奵奴女 奴奨奥 奡奮女奷奥奲
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奯奲 奡奮女奷奥奲女 奴奯 女奴奡奮奤奡奲奤 奯奵奴奰奵奴央 奔奨奥 奲奥女奵奬奴 奯奦 奡 奲奥奱奵奥女奴 奣奡奮 奢奥 奥奩奴奨奥奲 女奵奣奣奥女女夬 奦奡奩奬奵奲奥夬 奯奲 奩奮奴奥奲奭奥奤奩奡奴奥
奯奵奴奰奵奴夻 奡奮奤 奦奵奲奴奨奥奲奭奯奲奥夬 奢奥奦奯奲奥 奴奨奥 奲奥女奵奬奴 奩女 奤奥奬奩奶奥奲奥奤夬 奴奨奥奲奥 奭奩奧奨奴 奢奥 奡奤奤奩奴奩奯奮奡奬 奭奥奴奡夭奭奥女女奡奧奥女央

奁 奲奥奰奬她 奣奡奮 奣奯奮女奩女奴 奯奦 奭奵奬奴奩奰奬奥 奭奥女女奡奧奥女夺 奡奮她 奮奵奭奢奥奲 奯奦 奭奥女女奡奧奥女 奴奯 奩奮奦奯奲奭 奴奨奥 奵女奥奲 奡奢奯奵奴 奴奨奥 奰奲奯奧奲奥女女
奯奦 奴奨奥 奲奥奱奵奥女奴 奯奲 奯奴奨奥奲 奩奮奦奯奲奭奡奴奩奯奮奡奬 奯奵奴奰奵奴夬 奡奮奤 夜奮奡奬奬她 奡 奲奥女奵奬奴夬 奥奩奴奨奥奲 ok 奯奲 error央

奔奨奥 奷奩奲奥 奦奯奲奭奡奴 奩女 奴奨奥 奬奥奮奧奴奨 奯奦 奴奨奥 奭奥女女奡奧奥 奩奮 奣奨奡奲奡奣奴奥奲女夬 奥奮奣奯奤奥奤 奩奮 夶 奣奨奡奲奡奣奴奥奲女 奨奥奸奡奤奥奣奩奭奡奬夬 奦奯奬奬奯奷奥奤
奢她 奴奨奥 奭奥女女奡奧奥 奥奮奣奯奤奥奤 奡女 奓夭奥奸奰奲奥女女奩奯奮 夨女奥奸奰天央 奁奤奤奩奴奩奯奮奡奬奬她夬 奥奡奣奨 奲奥奱奵奥女奴 奩奮奣奬奵奤奥女 奡 奵奮奩奱奵奥 奩奮奴奥奧奥奲
夨奣奯奵奮奴奩奮奧 奵奰奷奡奲奤女天夬 奷奨奩奣奨 奩女 奲奥奰奥奡奴奥奤 奩奮 奡奬奬 奭奥女女奡奧奥女 奣奯奲奲奥女奰奯奮奤奩奮奧 奴奯 奴奨奡奴 奲奥奱奵奥女奴央

奁奮 奥奸奡奭奰奬奥 奩奮奴奥奲奡奣奴奩奯奮 奦奲奯奭 奬奯奡奤奩奮奧 奴奨奥 夜奬奥 /home/hannes/empty.idr 奬奯奯奫女 奡女 奦奯奬奬奯奷女 奯奮 奴奨奥 奷奩奲奥夺夺

00002a((:load-file "/home/hannes/empty.idr") 1)
000039(:write-string "Type checking /home/hannes/empty.idr" 1)
000025(:set-prompt "/home/hannes/empty" 1)
000032(:return (:ok "Loaded /home/hannes/empty.idr") 1)

奔奨奥 夜奲女奴 奭奥女女奡奧奥 奩女 奴奨奥 奲奥奱奵奥女奴 奦奲奯奭 奩奤奲奩女夭奭奯奤奥 奴奯 奬奯奡奤 奴奨奥 女奰奥奣奩夜奣 夜奬奥夬 奷奨奩奣奨 奬奥奮奧奴奨 奩女 奨奥奸 夲奡夬 奤奥奣奩奭奡奬
头夲 夨奩奮奣奬奵奤奩奮奧 奴奨奥 奮奥奷奬奩奮奥 奡奴 奴奨奥 奥奮奤天央 奔奨奥 奲奥奱奵奥女奴 奩奤奥奮奴奩夜奥奲 奩女 女奥奴 奴奯 失央 奔奨奥 夜奲女奴 奭奥女女奡奧奥 奦奲奯奭 奉奤奲奩女 奩女
奴奯 奷奲奩奴奥 奴奨奥 女奴奲奩奮奧 Type checking /home/hannes/empty.idr夬 奡奮奯奴奨奥奲 奩女 奴奯 女奥奴 奴奨奥 奰奲奯奭奰奴 奴奯 */home/
hannes/empty央 奔奨奥 奡奮女奷奥奲夬 女奴奡奲奴奩奮奧 奷奩奴奨 :return 奩女 ok夬 奡奮奤 奡奤奤奩奴奩奯奮奡奬 奩奮奦奯奲奭奡奴奩奯奮 奩女 奴奨奡奴 奴奨奥 夜奬奥 奷奡女
奬奯奡奤奥奤央

奔奨奥奲奥 奡奲奥 奴奨奲奥奥 奡奴奯奭女 奩奮 奴奨奥 奷奩奲奥 奬奡奮奧奵奡奧奥夺 奮奵奭奢奥奲女夬 女奴奲奩奮奧女夬 奡奮奤 女她奭奢奯奬女央 奔奨奥 奯奮奬她 奣奯奭奰奯奵奮奤 奯奢奪奥奣奴
奩女 奡 奬奩女奴夬 奷奨奩奣奨 奩女 女奵奲奲奯奵奮奤奥奤 奢她 奰奡奲奥奮奴奨奥女奩女央 奔奨奥 女她奮奴奡奸 奩女夺

A ::= NUM | '"' STR '"' | ':' ALPHA+
S ::= A | '(' S* ')' | nil

奷奨奥奲奥 NUM 奩女 奥奩奴奨奥奲 夰 奯奲 奡 奰奯女奩奴奩奶奥 奩奮奴奥奧奥奲夬 ALPHA 奩女 奡奮 奡奬奰奨奡奢奥奴奩奣奡奬 奣奨奡奲奡奣奴奥奲夬 奡奮奤 STR 奩女 奴奨奥 奣奯奮奴奥奮奴女 奯奦
奡 女奴奲奩奮奧夬 奷奩奴奨 " 奥女奣奡奰奥奤 奢她 奡 奢奡奣奫女奬奡女奨央 奔奨奥 奡奴奯奭 nil 奩女 奡奣奣奥奰奴奥奤 奩奮女奴奥奡奤 奯奦 () 奦奯奲 奣奯奭奰奡奴奩奢奩奬奩奴她 奷奩奴奨
女奯奭奥 奲奥奧奥奸奰 奰奲奥奴奴她夭奰奲奩奮奴奩奮奧 奲奯奵奴奩奮奥女央

奔奨奥 女奴奡奴奥 奯奦 奴奨奥 奉奤奲奩女 奰奲奯奣奥女女 奩女 奭奡奩奮奬她 奴奨奥 奡奣奴奩奶奥 夜奬奥夬 奷奨奩奣奨 奮奥奥奤女 奴奯 奢奥 奫奥奰奴 女她奮奣奨奲奯奮奩女奥奤 奢奥奴奷奥奥奮 奴奨奥
奥奤奩奴奯奲 奡奮奤 奉奤奲奩女央 奔奨奩女 奩女 奡奣奨奩奥奶奥奤 奢她 奴奨奥 奡奬奲奥奡奤她 女奥奥奮 :load-file 奣奯奭奭奡奮奤央

奔奨奥 奡奶奡奩奬奡奢奬奥 奣奯奭奭奡奮奤女 奩奮奣奬奵奤奥夺

(:load-file FILENAME [LINE]) 奌奯奡奤 奴奨奥 奮奡奭奥奤 夜奬奥央 奉奦 奡 LINE 奮奵奭奢奥奲 奩女 奰奲奯奶奩奤奥奤夬 奴奨奥
夜奬奥 奩女 奯奮奬她 奬奯奡奤奥奤 奵奰 奴奯 奴奨奡奴 奬奩奮奥央 奏奴奨奥奲奷奩女奥夬 奴奨奥 奥奮奴奩奲奥 夜奬奥 奩女 奬奯奡奤奥奤央

(:interpret STRING) 奉奮奴奥奲奰奲奥奴 STRING 奡奴 奴奨奥 奉奤奲奩女 奒奅奐奌夬 奲奥奴奵奲奮奩奮奧 奡 奨奩奧奨奬奩奧奨奴奥奤 奲奥女奵奬奴央

(:type-of STRING) 奒奥奴奵奲奮 奴奨奥 奴她奰奥 奯奦 奴奨奥 奮奡奭奥夬 奷奲奩奴奴奥奮 奷奩奴奨 奉奤奲奩女 女她奮奴奡奸 奩奮 奴奨奥 STRING央
奔奨奥 奲奥奰奬她 奭奡她 奣奯奮奴奡奩奮 奨奩奧奨奬奩奧奨奴奩奮奧 奩奮奦奯奲奭奡奴奩奯奮央

(:case-split LINE NAME) 奇奥奮奥奲奡奴奥 奡 奣奡女奥夭女奰奬奩奴 奦奯奲 奴奨奥 奰奡奴奴奥奲奮 奶奡奲奩奡奢奬奥 NAME 奯奮 奰奲奯奧奲奡奭
奬奩奮奥 LINE央 奔奨奥 奰奡奴奴奥奲奮夭奭奡奴奣奨 奣奡女奥女 奴奯 奢奥 女奵奢女奴奩奴奵奴奥奤 奡奲奥 奲奥奴奵奲奮奥奤 奡女 奡 女奴奲奩奮奧 奷奩奴奨 奮奯
奨奩奧奨奬奩奧奨奴奩奮奧央

(:add-clause LINE NAME) 奇奥奮奥奲奡奴奥 奡奮 奩奮奩奴奩奡奬 奰奡奴奴奥奲奮夭奭奡奴奣奨 奣奬奡奵女奥 奦奯奲 奴奨奥 奦奵奮奣奴奩奯奮 奤奥夭
奣奬奡奲奥奤 奡女 NAME 奯奮 奰奲奯奧奲奡奭 奬奩奮奥 LINE央 奔奨奥 奩奮奩奴奩奡奬 奣奬奡奵女奥 奩女 奲奥奴奵奲奮奥奤 奡女 奡 女奴奲奩奮奧 奷奩奴奨 奮奯
奨奩奧奨奬奩奧奨奴奩奮奧央

(:add-proof-clause LINE NAME) 奁奤奤 奡 奣奬奡奵女奥 奤奲奩奶奥奮 奢她 奴奨奥 <== 女她奮奴奡奸央

(:add-missing LINE NAME) 奁奤奤 奴奨奥 奭奩女女奩奮奧 奣奡女奥女 奤奩女奣奯奶奥奲奥奤 奢她 奴奯奴奡奬奩奴她 奣奨奥奣奫奩奮奧 奴奨奥 奦奵奮奣夭
奴奩奯奮 奤奥奣奬奡奲奥奤 奡女 NAME 奯奮 奰奲奯奧奲奡奭 奬奩奮奥 LINE央 奔奨奥 奭奩女女奩奮奧 奣奬奡奵女奥女 奡奲奥 奲奥奴奵奲奮奥奤 奡女 奡 女奴奲奩奮奧
奷奩奴奨 奮奯 奨奩奧奨奬奩奧奨奴奩奮奧央

(:make-with LINE NAME) 奃奲奥奡奴奥 奡 奷奩奴奨夭奲奵奬奥 奰奡奴奴奥奲奮 奭奡奴奣奨 奴奥奭奰奬奡奴奥 奦奯奲 奴奨奥 奣奬奡奵女奥 奯奦 奦奵奮奣夭
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奴奩奯奮 NAME 奯奮 奬奩奮奥 LINE央 奔奨奥 奮奥奷 奣奯奤奥 奩女 奲奥奴奵奲奮奥奤 奷奩奴奨 奮奯 奨奩奧奨奬奩奧奨奴奩奮奧央

(:make-case LINE NAME) 奃奲奥奡奴奥 奡 奣奡女奥 奰奡奴奴奥奲奮 奭奡奴奣奨 奴奥奭奰奬奡奴奥 奦奯奲 奴奨奥 奣奬奡奵女奥 奯奦 奦奵奮奣奴奩奯奮
NAME 奯奮 奬奩奮奥 LINE央 奔奨奥 奮奥奷 奣奯奤奥 奩女 奲奥奴奵奲奮奥奤 奷奩奴奨 奮奯 奨奩奧奨奬奩奧奨奴奩奮奧央

(:make-lemma LINE NAME) 奃奲奥奡奴奥 奡 奴奯奰 奬奥奶奥奬 奦奵奮奣奴奩奯奮 奷奩奴奨 奡 奴她奰奥 奷奨奩奣奨 女奯奬奶奥女 奴奨奥 奨奯奬奥
奮奡奭奥奤 NAME 奯奮 奬奩奮奥 LINE央

(:proof-search LINE NAME HINTS) 奁奴奴奥奭奰奴 奴奯 夜奬奬 奯奵奴 奴奨奥 奨奯奬奥女 奯奮 LINE 奮奡奭奥奤 NAME 奢她
奰奲奯奯奦 女奥奡奲奣奨央 HINTS 奩女 奡 奰奯女女奩奢奬她夭奥奭奰奴她 奬奩女奴 奯奦 奡奤奤奩奴奩奯奮奡奬 奴奨奩奮奧女 奴奯 奴奲她 奷奨奩奬奥 女奥奡奲奣奨奩奮奧央

(:docs-for NAME [MODE]) 奌奯奯奫 奵奰 奴奨奥 奤奯奣奵奭奥奮奴奡奴奩奯奮 奦奯奲 NAME夬 奡奮奤 奲奥奴奵奲奮 奩奴 奡女 奡 奨奩奧奨夭
奬奩奧奨奴奥奤 女奴奲奩奮奧央 奉奦 MODE 奩女 :overview夬 奯奮奬她 奴奨奥 夜奲女奴 奰奡奲奡奧奲奡奰奨 奯奦 奤奯奣奵奭奥奮奴奡奴奩奯奮 奩女
奰奲奯奶奩奤奥奤 奦奯奲 NAME央 奉奦 MODE 奩女 :full夬 奯奲 奯奭奩奴奴奥奤夬 奴奨奥 奦奵奬奬 奤奯奣奵奭奥奮奴奡奴奩奯奮 奩女 奲奥奴奵奲奮奥奤 奦奯奲
NAME央

(:apropos STRING) 奓奥奡奲奣奨 奴奨奥 奤奯奣奵奭奥奮奴奡奴奩奯奮 奦奯奲 奭奥奮奴奩奯奮女 奯奦 STRING夬 奡奮奤 奲奥奴奵奲奮 奡奮她 奦奯奵奮奤
奡女 奡 奬奩女奴 奯奦 奨奩奧奨奬奩奧奨奴奥奤 女奴奲奩奮奧女央

(:metavariables WIDTH) 奌奩女奴 奴奨奥 奣奵奲奲奥奮奴奬她夭奡奣奴奩奶奥 奨奯奬奥女夬 奷奩奴奨 奴奨奥奩奲 奴她奰奥女 奰奲奥奴奴她夭奰奲奩奮奴奥奤
奷奩奴奨 WIDTH 奣奯奬奵奭奮女央

(:who-calls NAME) 奇奥奴 奡 奬奩女奴 奯奦 奣奡奬奬奥奲女 奯奦 NAME央

(:calls-who NAME) 奇奥奴 奡 奬奩女奴 奯奦 奣奡奬奬奥奥女 奯奦 NAME央

(:browse-namespace NAMESPACE) 奒奥奴奵奲奮 奴奨奥 奣奯奮奴奥奮奴女 奯奦 NAMESPACE夬 奬奩奫奥 :browse 奡奴 奴奨奥
奣奯奭奭奡奮奤夭奬奩奮奥 奒奅奐奌央

(:normalise-term TM) 奒奥奴奵奲奮 奡 奨奩奧奨奬奩奧奨奴奥奤 女奴奲奩奮奧 奣奯奮女奩女奴奩奮奧 奯奦 奴奨奥 奲奥女奵奬奴女 奯奦 奮奯奲奭奡奬奩女奩奮奧
奴奨奥 女奥奲奩奡奬奩女奥奤 奴奥奲奭 TM 夨奷奨奩奣奨 奷奯奵奬奤 奰奲奥奶奩奯奵女奬她 奨奡奶奥 奢奥奥奮 女奥奮奴 奡女 奴奨奥 tt-term 奰奲奯奰奥奲奴她
奯奦 奡 女奴奲奩奮奧天央

(:show-term-implicits TM) 奒奥奴奵奲奮 奡 奨奩奧奨奬奩奧奨奴奥奤 女奴奲奩奮奧 奣奯奮女奩女奴奩奮奧 奯奦 奴奨奥 奲奥女奵奬奴女 奯奦 奭奡奫夭
奩奮奧 奡奬奬 奡奲奧奵奭奥奮奴女 奩奮 女奥奲奩奡奬奩女奥奤 奴奥奲奭 TM 夨奷奨奩奣奨 奷奯奵奬奤 奰奲奥奶奩奯奵女奬她 奨奡奶奥 奢奥奥奮 女奥奮奴 奡女 奴奨奥
tt-term 奰奲奯奰奥奲奴她 奯奦 奡 女奴奲奩奮奧天 奥奸奰奬奩奣奩奴央

(:hide-term-implicits TM) 奒奥奴奵奲奮 奡 奨奩奧奨奬奩奧奨奴奥奤 女奴奲奩奮奧 奣奯奮女奩女奴奩奮奧 奯奦 奴奨奥 奲奥女奵奬奴女 奯奦 奭奡奫夭
奩奮奧 奡奬奬 奡奲奧奵奭奥奮奴女 奩奮 女奥奲奩奡奬奩女奥奤 奴奥奲奭 TM 夨奷奨奩奣奨 奷奯奵奬奤 奰奲奥奶奩奯奵女奬她 奨奡奶奥 奢奥奥奮 女奥奮奴 奡女 奴奨奥
tt-term 奰奲奯奰奥奲奴她 奯奦 奡 女奴奲奩奮奧天 奦奯奬奬奯奷 奴奨奥奩奲 奵女奵奡奬 奩奭奰奬奩奣奩奴奮奥女女 女奥奴奴奩奮奧央

(:elaborate-term TM) 奒奥奴奵奲奮 奡 奨奩奧奨奬奩奧奨奴奥奤 女奴奲奩奮奧 奣奯奮女奩女奴奩奮奧 奯奦 奴奨奥 奣奯奲奥 奬奡奮奧奵奡奧奥 奴奥奲奭 奣奯奲夭
奲奥女奰奯奮奤奩奮奧 奴奯 女奥奲奩奡奬奩女奥奤 奴奥奲奭 TM 夨奷奨奩奣奨 奷奯奵奬奤 奰奲奥奶奩奯奵女奬她 奨奡奶奥 奢奥奥奮 女奥奮奴 奡女 奴奨奥 tt-term
奰奲奯奰奥奲奴她 奯奦 奡 女奴奲奩奮奧天央

(:print-definition NAME) 奒奥奴奵奲奮 奴奨奥 奤奥夜奮奩奴奩奯奮 奯奦 NAME 奡女 奡 奨奩奧奨奬奩奧奨奴奥奤 女奴奲奩奮奧央

(:repl-completions NAME) 奓奥奡奲奣奨 奮奡奭奥女夬 奴她奰奥女 奡奮奤 奤奯奣奵奭奥奮奴奡奴奩奯奮女 奷奨奩奣奨 奣奯奮奴奡奩奮 NAME央
奒奥奴奵奲奮 奴奨奥 奲奥女奵奬奴 奯奦 奴奡奢夭奣奯奭奰奬奥奴奩奮奧 NAME 奡女 奡 奒奅奐奌 奣奯奭奭奡奮奤央

:version 奒奥奴奵奲奮 奴奨奥 奶奥奲女奩奯奮 奩奮奦奯奲奭奡奴奩奯奮 奯奦 奴奨奥 奉奤奲奩女 奣奯奭奰奩奬奥奲央

奐奯女女奩奢奬奥 奲奥奰奬奩奥女 奩奮奣奬奵奤奥 奡 奮奯奲奭奡奬 夜奮奡奬 奲奥奰奬她夺夺

(:return (:ok SEXP [HIGHLIGHTING]))
(:return (:error String [HIGHLIGHTING]))

奁 奮奯奲奭奡奬 奩奮奴奥奲奭奥奤奩奡奴奥 奲奥奰奬她夺夺

(:output (:ok SEXP [HIGHLIGHTING]))
(:output (:error String [HIGHLIGHTING]))
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奉奮奦奯奲奭奡奴奩奯奮奡奬 奡奮奤夯奯奲 奡奢奮奯奲奭奡奬 奲奥奰奬奩奥女夺夺

(:write-string String)
(:set-prompt String)
(:warning (FilePath (LINE COL) (LINE COL) String [HIGHLIGHTING]))

奐奲奯奯奦 奭奯奤奥 奲奥奰奬奩奥女夺夺

(:start-proof-mode)
(:write-proof-state [String] [HIGHLIGHTING])
(:end-proof-mode)
(:write-goal String)

6.8.2 Output Highlighting

奉奤奲奩女 奭奯奤奥 女奵奰奰奯奲奴女 奨奩奧奨奬奩奧奨奴奩奮奧 奴奨奥 奯奵奴奰奵奴 奦奲奯奭 奉奤奲奩女央 奉奮 奲奥奡奬奩奴她夬 奴奨奩女 奨奩奧奨奬奩奧奨奴奩奮奧 奩女 奣奯奮奴奲奯奬奬奥奤 奢她 奴奨奥
奉奤奲奩女 奣奯奭奰奩奬奥奲央 奓奯奭奥 奯奦 奴奨奥 奲奥奴奵奲奮 奦奯奲奭女 奦奲奯奭 奉奤奲奩女 女奵奰奰奯奲奴 奡奮 奯奰奴奩奯奮奡奬 奥奸奴奲奡 奰奡奲奡奭奥奴奥奲夺 奡 奬奩女奴 奭奡奰奰奩奮奧
女奰奡奮女 奯奦 奴奥奸奴 奴奯 奭奥奴奡奤奡奴奡 奡奢奯奵奴 奴奨奡奴 奴奥奸奴央 奃奬奩奥奮奴女 奣奡奮 奴奨奥奮 奵女奥 奴奨奩女 奬奩女奴 奢奯奴奨 奴奯 奨奩奧奨奬奩奧奨奴 奴奨奥 奤奩女奰奬奡她奥奤
奯奵奴奰奵奴 奡奮奤 奴奯 奥奮奡奢奬奥 奲奩奣奨奥奲 奩奮奴奥奲奡奣奴奩奯奮 奢她 奨奡奶奩奮奧 奭奯奲奥 奭奥奴奡奤奡奴奡 奰奲奥女奥奮奴央 奆奯奲 奥奸奡奭奰奬奥夬 奴奨奥 奅奭奡奣女 奭奯奤奥
奡奬奬奯奷女 奲奩奧奨奴夭奣奬奩奣奫奩奮奧 奩奤奥奮奴奩夜奥奲女 奴奯 奧奥奴 奡 奭奥奮奵 奷奩奴奨 奡奣奣奥女女 奴奯 奤奯奣奵奭奥奮奴奡奴奩奯奮 奡奮奤 奴她奰奥 女奩奧奮奡奴奵奲奥女央

奁 奰奡奲奴奩奣奵奬奡奲 女奥奭奡奮奴奩奣 女奰奡奮 奩女 奡 奴奨奲奥奥 奥奬奥奭奥奮奴 奬奩女奴央 奔奨奥 夜奲女奴 奥奬奥奭奥奮奴 奯奦 奴奨奥 奬奩女奴 奩女 奴奨奥 奩奮奤奥奸 奡奴 奷奨奩奣奨 奴奨奥
女奰奡奮 奢奥奧奩奮女夬 奴奨奥 女奥奣奯奮奤 奥奬奥奭奥奮奴 奩女 奴奨奥 奮奵奭奢奥奲 奯奦 奣奨奡奲奡奣奴奥奲女 奩奮奣奬奵奤奥奤 奩奮 奴奨奥 女奰奡奮夬 奡奮奤 奴奨奥 奴奨奩奲奤 奩女 奴奨奥
女奥奭奡奮奴奩奣 奤奡奴奡 奩奴女奥奬奦央 奔奨奥 女奥奭奡奮奴奩奣 奤奡奴奡 奩女 奡 奬奩女奴 奯奦 奬奩女奴女央 奔奨奥 奨奥奡奤 奯奦 奥奡奣奨 奬奩女奴 奩女 奡 奫奥她 奴奨奡奴 奤奥奮奯奴奥女 奷奨奡奴
奫奩奮奤 奯奦 奭奥奴奡奤奡奴奡 奩女 奩奮 奴奨奥 奬奩女奴夬 奡奮奤 奴奨奥 奴奡奩奬 奩女 奴奨奥 奭奥奴奡奤奡奴奡 奩奴女奥奬奦央

The following keys are available:

name 奧奩奶奥女 奡 奲奥奦奥奲奥奮奣奥 奴奯 奴奨奥 奦奵奬奬她夭奱奵奡奬奩夜奥奤 奉奤奲奩女 奮奡奭奥

implicit 奰奲奯奶奩奤奥女 奡 奂奯奯奬奥奡奮 奶奡奬奵奥 奴奨奡奴 奩女 奔奲奵奥 奩奦 奴奨奥 奲奥奧奩奯奮 奩女 奴奨奥 奮奡奭奥 奯奦 奡奮 奩奭奰奬奩奣奩奴 奡奲奧奵奭奥奮奴

decor 奤奥女奣奲奩奢奥女 奴奨奥 奣奡奴奥奧奯奲她 奯奦 奡 奴奯奫奥奮夬 奷奨奩奣奨 奣奡奮 奢奥 type夬 function夬 data夬 keyword夬 奯奲 bound央

source-loc 女奴奡奴奥女 奴奨奡奴 奴奨奥 奲奥奧奩奯奮 奲奥奦奥奲女 奴奯 奡 女奯奵奲奣奥 奣奯奤奥 奬奯奣奡奴奩奯奮央 奉奴女 奢奯奤她 奩女 奡 奣奯奬奬奥奣奴奩奯奮 奯奦
奫奥她夭奶奡奬奵奥 奰奡奩奲女夬 奷奩奴奨 奴奨奥 奦奯奬奬奯奷奩奮奧 奰奯女女奩奢奩奬奩奴奩奥女夺

filename 奰奲奯奶奩奤奥女 奴奨奥 夜奬奥奮奡奭奥

start 奰奲奯奶奩奤奥女 奴奨奥 奬奩奮奥 奡奮奤 奣奯奬奵奭奮 奴奨奡奴 奴奨奥 女奯奵奲奣奥 奬奯奣奡奴奩奯奮 女奴奡奲奴女 奡奴 奡女 奡 奴奷奯夭奥奬奥奭奥奮奴 奴奡奩奬

end 奰奲奯奶奩奤奥女 奴奨奥 奬奩奮奥 奡奮奤 奣奯奬奵奭奮 奴奨奡奴 奴奨奥 女奯奵奲奣奥 奬奯奣奡奴奩奯奮 奥奮奤女 奡奴 奡女 奡 奴奷奯夭奥奬奥奭奥奮奴 奴奡奩奬

text-formatting 奰奲奯奶奩奤奥女 奡奮 奡奴奴奲奩奢奵奴奥 奯奦 奦奯奲奭奡奴奴奥奤 奴奥奸奴央 奔奨奩女 奩女 奦奯奲 奵女奥 奷奩奴奨 奮奡奴奵奲奡奬夭奬奡奮奧奵奡奧奥
奴奥奸奴夬 奮奯奴 奣奯奤奥夬 奡奮奤 奩女 奰奲奥女奥奮奴奬她 奥奭奩奴奴奥奤 奯奮奬她 奦奲奯奭 奩奮奬奩奮奥 奤奯奣奵奭奥奮奴奡奴奩奯奮央 奔奨奥 奰奯奴奥奮奴奩奡奬 奶奡奬奵奥女
奡奲奥 bold夬 italic夬 奡奮奤 underline央

link-href 奰奲奯奶奩奤奥女 奡 奕奒奌 奴奨奡奴 奴奨奥 奣奯奲奲奥女奰奯奮奤奩奮奧 奴奥奸奴 奩女 奡 奬奩奮奫 奴奯央

quasiquotation 女奴奡奴奥女 奴奨奡奴 奴奨奥 奲奥奧奩奯奮 奩女 奱奵奡女奩奱奵奯奴奥奤央

antiquotation 女奴奡奴奥女 奴奨奡奴 奴奨奥 奲奥奧奩奯奮 奩女 奡奮奴奩奱奵奯奴奥奤央

tt-term 奁 女奥奲奩奡奬奩女奥奤 奲奥奰奲奥女奥奮奴奡奴奩奯奮 奯奦 奴奨奥 奉奤奲奩女 奣奯奲奥 奴奥奲奭 奣奯奲奲奥女奰奯奮奤奩奮奧 奴奯 奴奨奥 奲奥奧奩奯奮 奯奦 奴奥奸奴央
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6.8.3 Source Code Highlighting

奉奤奲奩女 女奵奰奰奯奲奴女 奩奮女奴奲奵奣奴奩奮奧 奥奤奩奴奯奲女 奨奯奷 奴奯 奣奯奬奯奵奲 奴奨奥奩奲 奣奯奤奥央 套奨奥奮 奥奬奡奢奯奲奡奴奩奮奧 女奯奵奲奣奥 奣奯奤奥 奯奲 奒奅奐奌
奩奮奰奵奴夬 奉奤奲奩女 奷奩奬奬 奬奯奣奡奴奥 奲奥奧奩奯奮女 奯奦 奴奨奥 女奯奵奲奣奥 奣奯奤奥 奣奯奲奲奥女奰奯奮奤奩奮奧 奴奯 奮奡奭奥女夬 奡奮奤 奥奭奩奴 奩奮奦奯奲奭奡奴奩奯奮 奡奢奯奵奴
奴奨奥女奥 奮奡奭奥女 奵女奩奮奧 奴奨奥 女奡奭奥 奭奥奴奡奤奡奴奡 奡女 奯奵奴奰奵奴 奨奩奧奨奬奩奧奨奴奩奮奧央

奔奨奥女奥 奭奥女女奡奧奥女 奷奩奬奬 奡奲奲奩奶奥 奡女 奲奥奰奬奩奥女 奴奯 奴奨奥 奣奯奭奭奡奮奤 奴奨奡奴 奣奡奵女奥奤 奥奬奡奢奯奲奡奴奩奯奮 奴奯 奯奣奣奵奲夬 女奵奣奨 奡女
:load-file 奯奲 :interpret央 奔奨奥她 奨奡奶奥 奴奨奥 奦奯奲奭奡奴夺夺

(:output (:ok (:highlight-source POSNS)))

奷奨奥奲奥 POSNS 奩女 奡 奬奩女奴 奯奦 奰奯女奩奴奩奯奮女 奴奯 奨奩奧奨奬奩奧奨奴央 奅奡奣奨 奯奦 奴奨奥女奥 奩女 奡 奴奷奯夭奥奬奥奭奥奮奴 奬奩女奴 奷奨奯女奥 夜奲女奴 奥奬奥奭奥奮奴
奩女 奡 奰奯女奩奴奩奯奮 夨奥奮奣奯奤奥奤 奡女 奦奯奲 奴奨奥 source-loc 奰奲奯奰奥奲奴她 奡奢奯奶奥天 奡奮奤 奷奨奯女奥 女奥奣奯奮奤 奥奬奥奭奥奮奴 奩女 奨奩奧奨奬奩奧奨奴奩奮奧
奭奥奴奡奤奡奴奡 奩奮 奴奨奥 女奡奭奥 奦奯奲奭奡奴 奵女奥奤 奦奯奲 奯奵奴奰奵奴央
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奓奩奮奣奥 v0.9.18 奉奤奲奩女 奣奯奭奥女 奷奩奴奨 女奵奰奰奯奲奴 奦奯奲 女奥奭奡奮奴奩奣 奨奩奧奨奬奩奧奨奴奩奮奧央 套奨奥奮 奵女奩奮奧 奴奨奥 REPL 奯奲 奉奄奅 女奵奰奰奯奲奴夬
奉奤奲奩女 奷奩奬奬 奨奩奧奨奬奩奧奨奴 她奯奵奲 奣奯奤奥 奡奣奣奯奲奤奩奮奧奬她 奴奯 奩奴女 奭奥奡奮奩奮奧 奷奩奴奨奩奮 奴奨奥 奉奤奲奩女 女奴奲奵奣奴奵奲奥央 奁 奰奲奥奣奵奲女奯奲 奴奯
女奥奭奡奮奴奩奣 奨奩奧奨奬奩奧奨奴奩奮奧 女奵奰奰奯奲奴 奩女 奴奨奥 奰奲奥奴奴她 奰奲奩奮奴奩奮奧 奯奦 奤奥夜奮奩奴奩奯奮女 奴奯 奣奯奮女奯奬奥夬 奌奡奔奥奘夬 奯奲 奈奔奍奌央

奔奨奥 奤奥奦奡奵奬奴 女奴她奬奩奮奧 女奣奨奥奭奥 奵女奥奤 奷奡女 奩奮女奰奩奲奥奤 奢她 奃奯奮奯奲 奍奣奂奲奩奤奥’女 奯奷奮 女奥奴 奯奦 女奴她奬奩奮奧女夬 奩奮奦奯奲奭奡奬奬她 奫奮奯奷奮
奡女 Conor Colours央

6.9.1 Legend

奔奨奥 奣奯奮奣奥奰奴女 奡奮奤 奴奨奥奩奲 奤奥奦奡奵奬奴 女奴她奬奩奮奧女 奡奲奥 奡女 奦奯奬奬奯奷女夺

奉奤奲奩女 奔奥奲奭 奈奔奍奌 奌奡奔奥奘 奉奄奅夯奒奅奐奌
奂奯奵奮奤 奖奡奲奩奡奢奬奥 奐奵奲奰奬奥 奍奡奧奥奮奴奡
奋奥她奷奯奲奤 奂奯奬奤 奕奮奤奥奲奬奩奮奥奤
奆奵奮奣奴奩奯奮 奇奲奥奥奮 奇奲奥奥奮
奔她奰奥 奂奬奵奥 奂奬奵奥
奄奡奴奡 奒奥奤 奒奥奤
奉奭奰奬奩奣奩奴 奉奴奡奬奩奣 奐奵奲奰奬奥 奉奴奡奬奩奣 奍奡奧奥奮奴奡

6.9.2 Pretty Printing

奉奤奲奩女 奡奬女奯 女奵奰奰奯奲奴女 奴奨奥 奰奲奥奴奴她 奰奲奩奮奴奩奮奧 奯奦 奣奯奤奥 奴奯 奈奔奍奌 奡奮奤 奌奡奔奥奘 奵女奩奮奧 奴奨奥 奣奯奭奭奡奮奤女夺

• :pp <latex|html> <width> <function name>

• :pprint <latex|html> <width> <function name>

6.9.3 Customisation

奉奦 她奯奵 奡奲奥 奮奯奴 奨奡奰奰她 奷奩奴奨 奴奨奥 奣奯奬奯奵奲女 奵女奥奤夬 奴奨奥 奖奉奍 奡奮奤 奅奭奡奣女 奥奤奩奴奯奲 女奵奰奰奯奲奴 奡奬奬奯奷女 奦奯奲 奣奵女奴奯奭奩女奡奴奩奯奮
奯奦 奴奨奥 奣奯奬奯奵奲女央 套奨奥奮 奰奲奥奴奴她 奰奲奩奮奴奩奮奧 奉奤奲奩女 奣奯奤奥 奡女 奌奡奔奥奘 奡奮奤 奈奔奍奌夬 奣奯奭奭奡奮奤女 奡奮奤 奡 奃奓奓 女奴她奬奥 奡奲奥
奰奲奯奶奩奤奥奤央 奔奨奥 奣奯奬奯奵奲女 奵女奥奤 奢她 奴奨奥 奒奅奐奌 奣奡奮 奢奥 奣奵女奴奯奭奩女奥奤 奴奨奲奯奵奧奨 奴奨奥 奩奮奩奴奩奡奬奩女奡奴奩奯奮 女奣奲奩奰奴央
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6.9.4 Further Information

奐奬奥奡女奥 奡奬女奯 女奥奥 奴奨奥 奉奤奲奩女 奅奸奴奲奡女 奰奲奯奪奥奣奴 奦奯奲 奬奩奮奫女 奴奯 奥奤奩奴奯奲 女奵奰奰奯奲奴夬 奡奮奤 奰奲奥夭奭奡奤奥 女奴她奬奥 夜奬奥女 奦奯奲 奌奡奔奥奘
奡奮奤 奈奔奍奌央

6.10 DEPRECATED: Tactics and Theorem Proving

警警警告告告: 奔奨奥 奩奮奴奥奲奡奣奴奩奶奥 奴奨奥奯奲奥奭夭奰奲奯奶奩奮奧 奩奮奴奥奲奦奡奣奥 奤奯奣奵奭奥奮奴奥奤 奨奥奲奥 奨奡女 奢奥奥奮 奤奥奰奲奥奣奡奴奥奤 奩奮 奦奡奶奯奲 奯奦
Elaborator Reflection 夨姩妡妵 失夹夹天央

奉奤奲奩女 女奵奰奰奯奲奴女 奩奮奴奥奲奡奣奴奩奶奥 奴奨奥奯奲奥奭 奰奲奯奶奩奮奧夬 奡奮奤 奴奨奥 奡奮奡奬她女奥 奯奦 奣奯奮奴奥奸奴 奴奨奲奯奵奧奨 奨奯奬奥女央 奔奯 奬奩女奴 奡奬奬 奵奮奰奲奯奶奥奮
奨奯奬奥女夬 奵女奥 奴奨奥 奣奯奭奭奡奮奤 :m央 奔奨奩女 奷奩奬奬 奤奩女奰奬奡她 奴奨奥奩奲 奱奵奡奬奩夜奥奤 奮奡奭奥女 奡奮奤 奴奨奥 奥奸奰奥奣奴奥奤 奴她奰奥女央 奔奯 奩奮奴奥奲奡奣夭
奴奩奶奥奬她 奰奲奯奶奥 奡 奨奯奬奥女夬 奵女奥 奴奨奥 奣奯奭奭奡奮奤 :p name 奷奨奥奲奥 name 奩女 奴奨奥 奨奯奬奥央 奏奮奣奥 奴奨奥 奰奲奯奯奦 奩女 奣奯奭奰奬奥奴奥夬 奴奨奥
奣奯奭奭奡奮奤 :a 奷奩奬奬 奡奰奰奥奮奤 奩奴 奴奯 奴奨奥 奣奵奲奲奥奮奴 奭奯奤奵奬奥央

奏奮奣奥 奩奮 奴奨奥 奩奮奴奥奲奡奣奴奩奶奥 奰奲奯奶奥奲夬 奴奨奥 奦奯奬奬奯奷奩奮奧 奣奯奭奭奡奮奤女 奡奲奥 奡奶奡奩奬奡奢奬奥夺

6.10.1 Basic commands

• :q 夭 契奵奩奴女 奴奨奥 奰奲奯奶奥奲 夨奧奩奶奥女 奵奰 奯奮 奰奲奯奶奩奮奧 奣奵奲奲奥奮奴 奬奥奭奭奡天央

• :abandon 夭 奓奡奭奥 奡女 夺奱

• :state 夭 奄奩女奰奬奡她女 奴奨奥 奣奵奲奲奥奮奴 女奴奡奴奥 奯奦 奴奨奥 奰奲奯奯奦央

• :term 夭 奄奩女奰奬奡她女 奴奨奥 奣奵奲奲奥奮奴 奰奲奯奯奦 奴奥奲奭 奣奯奭奰奬奥奴奥 奷奩奴奨 奩奴女 她奥奴夭奴奯夭奢奥夭夜奬奬奥奤 奨奯奬奥女 夨奩女 奯奮奬她 奲奥奡奬奬她 奵女奥奦奵奬
奦奯奲 奤奥奢奵奧奧奩奮奧天央

• :undo 夭 奕奮奤奯奥女 奴奨奥 奬奡女奴 奴奡奣奴奩奣央

• :qed 夭 奏奮奣奥 奴奨奥 奩奮奴奥奲奡奣奴奩奶奥 奴奨奥奯奲奥奭 奰奲奯奶奥奲 奴奥奬奬女 她奯奵 “奎奯 奭奯奲奥 奧奯奡奬女夬” 她奯奵 奧奥奴 奴奯 奴她奰奥 奴奨奩女 奩奮
奣奥奬奥奢奲奡奴奩奯奮夡 夨奃奯奭奰奬奥奴奥女 奴奨奥 奰奲奯奯奦 奡奮奤 奥奸奩奴女 奴奨奥 奰奲奯奶奥奲天

6.10.2 Commonly Used Tactics

Compute

• compute 夭 奎奯奲奭奡奬奩女奥女 奡奬奬 奴奥奲奭女 奩奮 奴奨奥 奧奯奡奬 夨奮奯奴奥夺 奤奯奥女 奮奯奴 奮奯奲奭奡奬奩女奥 奡女女奵奭奰奴奩奯奮女天

---------- Goal: ----------
(Vect (S (S Z + (S Z) + (S n))) Nat) -> Vect (S (S (S (S n)))) Nat
-lemma> compute
---------- Goal: ----------
(Vect (S (S (S (S n)))) Nat) -> Vect (S (S (S (S n)))) Nat
-lemma>

Exact

• exact 夭 奐奲奯奶奩奤奥 奡 奴奥奲奭 奯奦 奴奨奥 奧奯奡奬 奴她奰奥 奤奩奲奥奣奴奬她央
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---------- Goal: ----------
Nat
-lemma> exact Z
lemma: No more goals.
-lemma>

Refine

• refine 夭 奕女奥 奡 奮奡奭奥 奴奯 奲奥夜奮奥 奴奨奥 奧奯奡奬央 奉奦 奴奨奥 奮奡奭奥 奮奥奥奤女 奡奲奧奵奭奥奮奴女夬 奩奮奴奲奯奤奵奣奥 奴奨奥奭 奡女 奮奥奷 奧奯奡奬女央

Trivial

• trivial 夭 奓奡奴奩女夜奥女 奴奨奥 奧奯奡奬 奵女奩奮奧 奡奮 奡女女奵奭奰奴奩奯奮 奴奨奡奴 奭奡奴奣奨奥女 奩奴女 奴她奰奥央

---------- Assumptions: ----------
value : Nat
---------- Goal: ----------
Nat
-lemma> trivial
lemma: No more goals.
-lemma>

Intro

• intro 夭 奉奦 她奯奵奲 奧奯奡奬 奩女 奡奮 奡奲奲奯奷夬 奴奵奲奮女 奴奨奥 奬奥奦奴 奴奥奲奭 奩奮奴奯 奡奮 奡女女奵奭奰奴奩奯奮央

---------- Goal: ----------
Nat -> Nat -> Nat
-lemma> intro
---------- Assumptions: ----------
n : Nat
---------- Goal: ----------
Nat -> Nat
-lemma>

奙奯奵 奣奡奮 奡奬女奯 女奵奰奰奬她 她奯奵奲 奯奷奮 奮奡奭奥 奦奯奲 奴奨奥 奡女女奵奭奰奴奩奯奮夺

---------- Goal: ----------
Nat -> Nat -> Nat
-lemma> intro number
---------- Assumptions: ----------
number : Nat
---------- Goal: ----------
Nat -> Nat

Intros

• intros 夭 奅奸奡奣奴奬她 奬奩奫奥 奩奮奴奲奯夬 奢奵奴 奩奴 奯奰奥奲奡奴奥女 奯奮 奡奬奬 奬奥奦奴 奴奥奲奭女 奡奴 奯奮奣奥央

---------- Goal: ----------
Nat -> Nat -> Nat
-lemma> intros
---------- Assumptions: ----------

(äÿŃéąțçżğçżŋ)
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(çżŋäÿŁéąț)

n : Nat
m : Nat
---------- Goal: ----------
Nat
-lemma>

let

• let 夭 奉奮奴奲奯奤奵奣奥女 奡 奮奥奷 奡女女奵奭奰奴奩奯奮夻 她奯奵 奭奡她 奵女奥 奣奵奲奲奥奮奴 奡女女奵奭奰奴奩奯奮女 奴奯 奤奥夜奮奥 奴奨奥 奮奥奷 奯奮奥央

---------- Assumptions: ----------
n : Nat
---------- Goal: ----------
BigInt
-lemma> let x = toIntegerNat n
---------- Assumptions: ----------
n : Nat
x = toIntegerNat n: BigInt

---------- Goal: ----------
BigInt
-lemma>

rewrite

• rewrite 夭 奔奡奫奥女 奡奮 奥奸奰奲奥女女奩奯奮 奷奩奴奨 奡奮 奥奱奵奡奬奩奴她 奴她奰奥 夨奸 夽 她天夬 奡奮奤 奲奥奰奬奡奣奥女 奡奬奬 奩奮女奴奡奮奣奥女 奯奦 奸 奩奮 奴奨奥
奧奯奡奬 奷奩奴奨 她央 奉女 奯奦奴奥奮 奵女奥奦奵奬 奩奮 奣奯奭奢奩奮奡奴奩奯奮 奷奩奴奨 ‘女她奭’央

---------- Assumptions: ----------
n : Nat
a : Type
value : Vect Z a
---------- Goal: ----------
Vect (mult n Z) a
-lemma> rewrite sym (multZeroRightZero n)
---------- Assumptions: ----------
n : Nat
a : Type
value : Vect Z a
---------- Goal: ----------
Vect Z a
-lemma>

sourceLocation

• sourceLocation 夭 奓奯奬奶奥 奴奨奥 奣奵奲奲奥奮奴 奧奯奡奬 奷奩奴奨 奩奮奦奯奲奭奡奴奩奯奮 奡奢奯奵奴 奴奨奥 奬奯奣奡奴奩奯奮 奩奮 奴奨奥 女奯奵奲奣奥 奣奯奤奥
奷奨奥奲奥 奴奨奥 奴奡奣奴奩奣 奷奡女 奩奮奶奯奫奥奤央 奔奨奩女 奩女 奭奯女奴奬她 奦奯奲 奥奭奢奥奤奤奥奤 奄奓奌女 奡奮奤 奰奲奯奧奲奡奭奭奥奲 奴奯奯奬女 奬奩奫奥
奡女女奥奲奴奩奯奮女 奴奨奡奴 奮奥奥奤 奴奯 奫奮奯奷 奷奨奥奲奥 奴奨奥她 奡奲奥 奣奡奬奬奥奤央 奓奥奥 Language.Reflection.SourceLocation
奦奯奲 奭奯奲奥 奩奮奦奯奲奭奡奴奩奯奮央

6.10.3 Less commonly-used tactics

• applyTactic 夭 奁奰奰奬她 奡 奵女奥奲夭奤奥夜奮奥奤 奴奡奣奴奩奣央 奔奨奩女 女奨奯奵奬奤 奢奥 奡 奦奵奮奣奴奩奯奮 奯奦 奴她奰奥 List (TTName,
Binder TT) -> TT -> Tactic夬 奷奨奥奲奥 奴奨奥 夜奲女奴 奡奲奧奵奭奥奮奴 奲奥奰奲奥女奥奮奴女 奴奨奥 奰奲奯奯奦 奣奯奮奴奥奸奴 奡奮奤 奴奨奥 女奥奣夭
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奯奮奤 奲奥奰奲奥女奥奮奴女 奴奨奥 奧奯奡奬央 奉奦 她奯奵奲 奴奡奣奴奩奣 奷奩奬奬 奰奲奯奤奵奣奥 奡 奰奲奯奯奦 奴奥奲奭 奤奩奲奥奣奴奬她夬 奵女奥 奴奨奥 Exact 奣奯奮女奴奲奵奣奴奯奲
奦奲奯奭 Tactic央

• attack 夭 夿

• equiv 夭 奒奥奰奬奡奣奥女 奴奨奥 奧奯奡奬 奷奩奴奨 奡 奮奥奷 奯奮奥 奴奨奡奴 奩女 奣奯奮奶奥奲奴奩奢奬奥 奷奩奴奨 奴奨奥 奯奬奤 奯奮奥

• fill 夭 夿

• focus 夭 夿

• mrefine 夭 奒奥夜奮奩奮奧 奢她 奭奡奴奣奨奩奮奧 奡奧奡奩奮女奴 奡 奴她奰奥

• reflect 夭 夿

• solve 夭 奔奡奫奥女 奡 奧奵奥女女 奷奩奴奨 奴奨奥 奣奯奲奲奥奣奴 奴她奰奥 奡奮奤 夜奬奬女 奡 奨奯奬奥 奷奩奴奨 奩奴夬 奣奬奯女奩奮奧 奡 奰奲奯奯奦 奯奢奬奩奧奡奴奩奯奮央 奔奨奩女
奨奡奰奰奥奮女 奡奵奴奯奭奡奴奩奣奡奬奬她 奩奮 奴奨奥 奩奮奴奥奲奡奣奴奩奶奥 奰奲奯奶奥奲夬 女奯 solve 奩女 奲奥奡奬奬她 奯奮奬她 奲奥奬奥奶奡奮奴 奩奮 奴奡奣奴奩奣 女奣奲奩奰奴女
奵女奥奤 奦奯奲 奨奥奬奰奩奮奧 奩奭奰奬奩奣奩奴 奡奲奧奵奭奥奮奴 奲奥女奯奬奵奴奩奯奮央

• try 夭 夿

6.11 The Idris REPL

奉奤奲奩女 奣奯奭奥女 奷奩奴奨 奡 REPL央

6.11.1 Evaluation

奂奥奩奮奧 奡 奦奵奬奬她 奤奥奰奥奮奤奥奮奴奬她 奴她奰奥奤 奬奡奮奧奵奡奧奥夬 奉奤奲奩女 奨奡女 奴奷奯 奰奨奡女奥女 奷奨奥奲奥 奩奴 奥奶奡奬奵奡奴奥女 奴奨奩奮奧女夬 奣奯奭奰奩奬奥夭奴奩奭奥
奡奮奤 奲奵奮夭奴奩奭奥央 奁奴 奣奯奭奰奩奬奥夭奴奩奭奥 奩奴 奷奩奬奬 奯奮奬她 奥奶奡奬奵奡奴奥 奴奨奩奮奧女 奷奨奩奣奨 奩奴 奫奮奯奷女 奴奯 奢奥 奴奯奴奡奬 夨奩央奥央 奴奥奲奭奩奮奡奴奩奮奧
奡奮奤 奣奯奶奥奲奩奮奧 奡奬奬 奰奯女女奩奢奬奥 奩奮奰奵奴女天 奩奮 奯奲奤奥奲 奴奯 奫奥奥奰 奴她奰奥 奣奨奥奣奫奩奮奧 奤奥奣奩奤奡奢奬奥央 奔奨奥 奣奯奭奰奩奬奥夭奴奩奭奥 奥奶奡奬奵奡奴奯奲
奩女 奰奡奲奴 奯奦 奴奨奥 奉奤奲奩女 奫奥奲奮奥奬夬 奡奮奤 奩女 奩奭奰奬奥奭奥奮奴奥奤 奩奮 奈奡女奫奥奬奬 奵女奩奮奧 奡 奈奏奁奓 夨奨奩奧奨奥奲 奯奲奤奥奲 奡奢女奴奲奡奣奴 女她奮奴奡奸天
女奴她奬奥 奲奥奰奲奥女奥奮奴奡奴奩奯奮 奯奦 奶奡奬奵奥女央 奓奩奮奣奥 奥奶奥奲她奴奨奩奮奧 奩女 奫奮奯奷奮 奴奯 奨奡奶奥 奡 奮奯奲奭奡奬 奦奯奲奭 奨奥奲奥夬 奴奨奥 奥奶奡奬奵奡奴奩奯奮
女奴奲奡奴奥奧她 奤奯奥女奮’奴 奡奣奴奵奡奬奬她 奭奡奴奴奥奲 奢奥奣奡奵女奥 奥奩奴奨奥奲 奷奡她 奩奴 奷奩奬奬 奧奥奴 奴奨奥 女奡奭奥 奡奮女奷奥奲夬 奡奮奤 奩奮 奰奲奡奣奴奩奣奥 奩奴 奷奩奬奬
奤奯 奷奨奡奴奥奶奥奲 奴奨奥 奈奡女奫奥奬奬 奲奵奮夭奴奩奭奥 女她女奴奥奭 奣奨奯奯女奥女 奴奯 奤奯央

奔奨奥 奒奅奐奌夬 奦奯奲 奣奯奮奶奥奮奩奥奮奣奥夬 奵女奥女 奴奨奥 奣奯奭奰奩奬奥夭奴奩奭奥 奮奯奴奩奯奮 奯奦 奥奶奡奬奵奡奴奩奯奮央 奁女 奷奥奬奬 奡女 奢奥奩奮奧 奥奡女奩奥奲 奴奯
奩奭奰奬奥奭奥奮奴 夨奢奥奣奡奵女奥 奷奥 奨奡奶奥 奴奨奥 奥奶奡奬奵奡奴奯奲 奡奶奡奩奬奡奢奬奥天 奴奨奩女 奣奡奮 奢奥 奶奥奲她 奵女奥奦奵奬 奴奯 女奨奯奷 奨奯奷 奴奥奲奭女 奥奶奡奬奵奡奴奥
奩奮 奴奨奥 奴她奰奥 奣奨奥奣奫奥奲央 奓奯 她奯奵 奣奡奮 女奥奥 奴奨奥 奤奩夛奥奲奥奮奣奥 奢奥奴奷奥奥奮夺

Idris> \n, m => (S n) + m
\n => \m => S (plus n m) : Nat -> Nat -> Nat

Idris> \n, m => n + (S m)
\n => \m => plus n (S m) : Nat -> Nat -> Nat

6.11.2 Customisation

奉奤奲奩女 女奵奰奰奯奲奴女 奩奮奩奴奩奡奬奩女奡奴奩奯奮 女奣奲奩奰奴女央

Initialisation scripts

套奨奥奮 奴奨奥 奉奤奲奩女 奒奅奐奌 女奴奡奲奴女 奵奰夬 奩奴 奷奩奬奬 奡奴奴奥奭奰奴 奴奯 奯奰奥奮 奴奨奥 夜奬奥 奲奥奰奬夯奩奮奩奴 奩奮 奉奤奲奩女’女 奡奰奰奬奩奣奡奴奩奯奮 奤奡奴奡 奤奩奲奥奣夭
奴奯奲她央 奔奨奥 奡奰奰奬奩奣奡奴奩奯奮 奤奡奴奡 奤奩奲奥奣奴奯奲她 奩女 奴奨奥 奲奥女奵奬奴 奯奦 奴奨奥 奈奡女奫奥奬奬 奦奵奮奣奴奩奯奮 奣奡奬奬 getAppUserDataDirectory
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"idris"夬 奷奨奩奣奨 奯奮 奭奯女奴 奕奮奩奸夭奬奩奫奥 女她女奴奥奭女 奷奩奬奬 奲奥奴奵奲奮 夤奈奏奍奅夯央奩奤奲奩女 奡奮奤 奯奮 奶奡奲奩奯奵女 奶奥奲女奩奯奮女 奯奦 套奩奮奤奯奷女
奷奩奬奬 奲奥奴奵奲奮 奰奡奴奨女 女奵奣奨 奡女 C:/Documents And Settings/user/Application Data/appName央

奔奨奥 夜奬奥 奲奥奰奬夯奩奮奩奴 奩女 奡 奮奥奷奬奩奮奥夭女奥奰奡奲奡奴奥 奬奩女奴 奯奦 奒奅奐奌 奣奯奭奭奡奮奤女央 奎奯奴 奡奬奬 奣奯奭奭奡奮奤女 奡奲奥 女奵奰奰奯奲奴奥奤 奩奮
奩奮奩奴奩奡奬奩女奡奴奩奯奮 女奣奲奩奰奴女 — 奯奮奬她 奴奨奥 女奵奢女奥奴 奴奨奡奴 奷奩奬奬 奮奯奴 奩奮奴奥奲奦奥奲奥 奷奩奴奨 奴奨奥 奮奯奲奭奡奬 奯奰奥奲奡奴奩奯奮 奯奦 奴奨奥 奒奅奐奌央
奉奮 奰奡奲奴奩奣奵奬奡奲夬 女奥奴奴奩奮奧 奣奯奬奯奵奲女夬 奤奩女奰奬奡她 奯奰奴奩奯奮女 女奵奣奨 奡女 女奨奯奷奩奮奧 奩奭奰奬奩奣奩奴女夬 奡奮奤 奬奯奧 奬奥奶奥奬女 奡奲奥 女奵奰奰奯奲奴奥奤央

Example initialisation script

:colour prompt white italic bold
:colour implicit magenta italic

6.11.3 The REPL Commands

奔奨奥 奣奵奲奲奥奮奴 女奥奴 奯奦 女奵奰奰奯奲奴奥奤 奣奯奭奭奡奮奤女 奡奲奥夺

奃奯奭奭奡奮奤 奁奲奧奵奭奥奮奴女 奐奵奲奰奯女奥
夼奥奸奰奲夾 奅奶奡奬奵奡奴奥 奡奮 奥奸奰奲奥女女奩奯奮
夺奴 夺奴她奰奥 夼奥奸奰奲夾 奃奨奥奣奫 奴奨奥 奴她奰奥 奯奦 奡奮 奥奸奰奲奥女女奩奯奮
夺奣奯奲奥 夼奥奸奰奲夾 奖奩奥奷 奴奨奥 奣奯奲奥 奬奡奮奧奵奡奧奥 奲奥奰奲奥女奥奮奴奡奴奩奯奮 奯奦 奡 奴奥奲奭
夺奭奩女女 夺奭奩女女奩奮奧 夼奮奡奭奥夾 奓奨奯奷 奭奩女女奩奮奧 奣奬奡奵女奥女
夺奤奯奣 夼奮奡奭奥夾 奓奨奯奷 奩奮奴奥奲奮奡奬 奤奯奣奵奭奥奮奴奡奴奩奯奮
夺奭奫奤奯奣 夼奮奡奭奥女奰奡奣奥夾 奇奥奮奥奲奡奴奥 奉奤奲奩女奄奯奣 奦奯奲 奮奡奭奥女奰奡奣奥夨女天 奡奮奤 奤奥奰奥奮奤奥奮奣奩奥女
夺奡奰奲奯奰奯女 奛夼奰奡奣奫奡奧奥 奬奩女奴夾奝 夼奮奡奭奥夾 奓奥奡奲奣奨 奮奡奭奥女夬 奴她奰奥女夬 奡奮奤 奤奯奣奵奭奥奮奴奡奴奩奯奮
夺女 夺女奥奡奲奣奨 奛夼奰奡奣奫奡奧奥 奬奩女奴夾奝 夼奥奸奰奲夾 奓奥奡奲奣奨 奦奯奲 奶奡奬奵奥女 奢她 奴她奰奥
夺奷奣 夺奷奨奯奣奡奬奬女 夼奮奡奭奥夾 奌奩女奴 奴奨奥 奣奡奬奬奥奲女 奯奦 女奯奭奥 奮奡奭奥
夺奣奷 夺奣奡奬奬女奷奨奯 夼奮奡奭奥夾 奌奩女奴 奴奨奥 奣奡奬奬奥奥女 奯奦 女奯奭奥 奮奡奭奥
夺奢奲奯奷女奥 夼奮奡奭奥女奰奡奣奥夾 奌奩女奴 奴奨奥 奣奯奮奴奥奮奴女 奯奦 女奯奭奥 奮奡奭奥女奰奡奣奥
夺奴奯奴奡奬 夼奮奡奭奥夾 奃奨奥奣奫 奴奨奥 奴奯奴奡奬奩奴她 奯奦 奡 奮奡奭奥
夺奲 夺奲奥奬奯奡奤 奒奥奬奯奡奤 奣奵奲奲奥奮奴 夜奬奥
夺奬 夺奬奯奡奤 夼夜奬奥奮奡奭奥夾 奌奯奡奤 奡 奮奥奷 夜奬奥
夺奣奤 夼夜奬奥奮奡奭奥夾 奃奨奡奮奧奥 奷奯奲奫奩奮奧 奤奩奲奥奣奴奯奲她
夺奭奯奤奵奬奥 夼奭奯奤奵奬奥夾 奉奭奰奯奲奴 奡奮 奥奸奴奲奡 奭奯奤奵奬奥
夺奥 夺奥奤奩奴 奅奤奩奴 奣奵奲奲奥奮奴 夜奬奥 奵女奩奮奧 夤奅奄奉奔奏奒 奯奲 夤奖奉奓奕奁奌
夺奭 夺奭奥奴奡奶奡奲女 奓奨奯奷 奲奥奭奡奩奮奩奮奧 奰奲奯奯奦 奯奢奬奩奧奡奴奩奯奮女 夨奨奯奬奥女天
夺奰 夺奰奲奯奶奥 夼奨奯奬奥夾 奐奲奯奶奥 奡 奨奯奬奥
夺奡 夺奡奤奤奰奲奯奯奦 夼奮奡奭奥夾 奁奤奤 奰奲奯奯奦 奴奯 女奯奵奲奣奥 夜奬奥
夺奲奭奰奲奯奯奦 夼奮奡奭奥夾 奒奥奭奯奶奥 奰奲奯奯奦 奦奲奯奭 奰奲奯奯奦 女奴奡奣奫
夺女奨奯奷奰奲奯奯奦 夼奮奡奭奥夾 奓奨奯奷 奰奲奯奯奦
夺奰奲奯奯奦女 奓奨奯奷 奡奶奡奩奬奡奢奬奥 奰奲奯奯奦女
夺奸 夼奥奸奰奲夾 奅奸奥奣奵奴奥 奉奏 奡奣奴奩奯奮女 奲奥女奵奬奴奩奮奧 奦奲奯奭 奡奮 奥奸奰奲奥女女奩奯奮 奵女奩奮奧 奴奨奥 奩奮奴奥奲奰奲奥奴奥奲
夺奣 夺奣奯奭奰奩奬奥 夼夜奬奥奮奡奭奥夾 奃奯奭奰奩奬奥 奴奯 奡奮 奥奸奥奣奵奴奡奢奬奥 奛奣奯奤奥奧奥奮奝 夼夜奬奥奮奡奭奥夾
夺奥奸奥奣 夺奥奸奥奣奵奴奥 奛夼奥奸奰奲夾奝 奃奯奭奰奩奬奥 奴奯 奡奮 奥奸奥奣奵奴奡奢奬奥 奡奮奤 奲奵奮
夺奤她奮奡奭奩奣 夼夜奬奥奮奡奭奥夾 奄她奮奡奭奩奣奡奬奬她 奬奯奡奤 奡 奃 奬奩奢奲奡奲她 夨女奩奭奩奬奡奲 奴奯 夥奤她奮奡奭奩奣天
夺奤她奮奡奭奩奣 奌奩女奴 奤她奮奡奭奩奣奡奬奬她 奬奯奡奤奥奤 奃 奬奩奢奲奡奲奩奥女
夺夿 夺奨 夺奨奥奬奰 奄奩女奰奬奡她 奴奨奩女 奨奥奬奰 奴奥奸奴
夺女奥奴 夼奯奰奴奩奯奮夾 奓奥奴 奡奮 奯奰奴奩奯奮 夨奥奲奲奯奲奣奯奮奴奥奸奴夬 女奨奯奷奩奭奰奬奩奣奩奴女夬 奯奲奩奧奩奮奡奬奥奲奲奯奲女夬 奡奵奴奯女奯奬奶奥夬 奮奯奢奡奮奮奥奲夬 奷奡奲奮奲奥奡奣奨夬 奥奶奡奬奴她奰奥女夬 奤奥女奵奧奡奲奮奡奴女天
夺奵奮女奥奴 夼奯奰奴奩奯奮夾 奕奮女奥奴 奡奮 奯奰奴奩奯奮
夺奣奯奬奯奲 夺奣奯奬奯奵奲 夼奯奰奴奩奯奮夾 奔奵奲奮 奒奅奐奌 奣奯奬奯奵奲女 奯奮 奯奲 奯夛夻 女奥奴 奡 女奰奥奣奩夜奣 奣奯奬奯奵奲
夺奣奯奮女奯奬奥奷奩奤奴奨 奡奵奴奯奼奩奮夜奮奩奴奥奼夼奮奵奭奢奥奲夾 奓奥奴 奴奨奥 奷奩奤奴奨 奯奦 奴奨奥 奣奯奮女奯奬奥
夺奰奲奩奮奴奥奲奤奥奰奴奨 夼奮奵奭奢奥奲夭奯奲夭奢奬奡奮奫夾 奓奥奴 奴奨奥 奭奡奸奩奭奵奭 奰奲奥奴奴她夭奰奲奩奮奴奩奮奧 奤奥奰奴奨夬 奯奲 奩奮夜奮奩奴奥 奩奦 奮奯奴奨奩奮奧 女奰奥奣奩夜奥奤
夺奱 夺奱奵奩奴 奅奸奩奴 奴奨奥 奉奤奲奩女 女她女奴奥奭
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姨妡妨 失 夕 续上页
奃奯奭奭奡奮奤 奁奲奧奵奭奥奮奴女 奐奵奲奰奯女奥
夺奷 夺奷奡奲奲奡奮奴她 奄奩女奰奬奡她女 奷奡奲奲奡奮奴她 奩奮奦奯奲奭奡奴奩奯奮
夺奬奥奴 夨夼奴奯奰夭奬奥奶奥奬夭奤奥奣奬奡奲奡奴奩奯奮夾天… 奅奶奡奬奵奡奴奥 奡 奤奥奣奬奡奲奡奴奩奯奮夬 女奵奣奨 奡女 奡 奦奵奮奣奴奩奯奮 奤奥夜奮奩奴奩奯奮夬 奩奮女奴奡奮奣奥 奩奭奰奬奥奭奥奮奴奡奴奩奯奮夬 奯奲 夜奸奩奴她 奤奥奣奬奡奲奡奴奩奯奮
夺奵奮奬奥奴 夺奵奮奤奥夜奮奥 夨夼奮奡奭奥夾天… 奒奥奭奯奶奥 奴奨奥 奬奩女奴奥奤 奲奥奰奬 奤奥夜奮奩奴奩奯奮女夬 奯奲 奡奬奬 奲奥奰奬 奤奥夜奮奩奴奩奯奮女 奩奦 奮奯 奮奡奭奥女 奧奩奶奥奮
夺奰奲奩奮奴奤奥奦 夼奮奡奭奥夾 奓奨奯奷 奴奨奥 奤奥夜奮奩奴奩奯奮 奯奦 奡 奦奵奮奣奴奩奯奮
夺奰奰 夺奰奰奲奩奮奴 夼奯奰奴奩奯奮夾 夼奮奵奭奢奥奲夾 夼奮奡奭奥夾 奐奲奥奴奴她 奰奲奩奮奴女 奡奮 奉奤奲奩女 奦奵奮奣奴奩奯奮 奩奮 奥奩奴奨奥奲 奌奡奔奥奘 奯奲 奈奔奍奌 奡奮奤 奦奯奲 奡 女奰奥奣奩夜奥奤 奷奩奤奴奨央

6.11.4 Using the REPL

Getting help

奔奨奥 奣奯奭奭奡奮奤 :help 夨奯奲 :h 奯奲 :?天 奰奲奩奮奴女 奡 女奨奯奲奴 女奵奭奭奡奲她 奯奦 奴奨奥 奡奶奡奩奬奡奢奬奥 奣奯奭奭奡奮奤女央

Quitting Idris

奉奦 她奯奵 奷奯奵奬奤 奬奩奫奥 奴奯 奬奥奡奶奥 奉奤奲奩女夬 女奩奭奰奬她 奵女奥 :q 奯奲 :quit央

Evaluating expressions

奔奯 奥奶奡奬奵奡奴奥 奡奮 奥奸奰奲奥女女奩奯奮夬 女奩奭奰奬她 奴她奰奥 奩奴央 奉奦 奉奤奲奩女 奩女 奵奮奡奢奬奥 奴奯 奩奮奦奥奲 奴奨奥 奴她奰奥夬 奩奴 奣奡奮 奢奥 奨奥奬奰奦奵奬 奴奯 奵女奥
奴奨奥 奯奰奥奲奡奴奯奲 the 奴奯 奭奡奮奵奡奬奬她 奰奲奯奶奩奤奥 奯奮奥夬 奡女 奉奤奲奩女’女 女她奮奴奡奸 奤奯奥女 奮奯奴 奡奬奬奯奷 奦奯奲 奤奩奲奥奣奴 奴她奰奥 奡奮奮奯奴奡奴奩奯奮女央
奅奸奡奭奰奬奥女 奯奦 the 奩奮奣奬奵奤奥夺

Idris> the Nat 4
4 : Nat
Idris> the Int 4
4 : Int
Idris> the (List Nat) [1,2]
[1,2] : List Nat
Idris> the (Vect _ Nat) [1,2]
[1,2] : Vect 2 Nat

奔奨奩女 奭奡她 奮奯奴 奷奯奲奫 奩奮 奣奡女奥女 奷奨奥奲奥 奴奨奥 奥奸奰奲奥女女奩奯奮 女奴奩奬奬 奩奮奶奯奬奶奥女 奡奭奢奩奧奵奯奵女 奮奡奭奥女央 奔奨奥 奮奡奭奥 奣奡奮 奢奥
奤奩女奡奭奢奩奧奵奡奴奥奤 奢她 奵女奩奮奧 奴奨奥 with 奫奥她奷奯奲奤夺

Idris> sum [1,2,3]
When elaborating an application of function Prelude.Foldable.sum:

Can't disambiguate name: Prelude.List.::,
Prelude.Stream.::,
Prelude.Vect.::

Idris> with List sum [1,2,3]
6 : Integer

Adding let bindings

奔奯 奡奤奤 奡 奬奥奴 奢奩奮奤奩奮奧 奴奯 奴奨奥 奒奅奐奌夬 奵女奥 :let央 奉奴’女 奬奩奫奥奬她 她奯奵’奬奬 奡奬女奯 奮奥奥奤 奴奯 奰奲奯奶奩奤奥 奡 奴她奰奥 奡奮奮奯奴奡奴奩奯奮央
:let 奡奬女奯 奷奯奲奫女 奦奯奲 奯奴奨奥奲 奤奥奣奬奡奲奡奴奩奯奮女 奡女 奷奥奬奬夬 女奵奣奨 奡女 data央

Idris> :let x : String; x = "hello"
Idris> x
"hello" : String
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Idris> :let y = 10
Idris> y
10 : Integer
Idris> :let data Foo : Type where Bar : Foo
Idris> Bar
Bar : Foo

Getting type information

奔奯 奡女奫 奉奤奲奩女 奦奯奲 奴奨奥 奴她奰奥 奯奦 女奯奭奥 奥奸奰奲奥女女奩奯奮夬 奵女奥 奴奨奥 :t 奣奯奭奭奡奮奤央 奁奤奤奩奴奩奯奮奡奬奬她夬 奩奦 奵女奥奤 奷奩奴奨 奡奮 奯奶奥奲奬奯奡奤奥奤
奮奡奭奥夬 奉奤奲奩女 奷奩奬奬 奰奲奯奶奩奤奥 奡奬奬 奯奶奥奲奬奯奡奤奩奮奧女 奡奮奤 奴奨奥奩奲 奴她奰奥女央 奔奯 奡女奫 奦奯奲 奴奨奥 奴她奰奥 奯奦 奡奮 奩奮夜奸 奯奰奥奲奡奴奯奲夬 女奵奲奲奯奵奮奤
奩奴 奩奮 奰奡奲奥奮奴奨奥女奥女央

Idris> :t "foo"
"foo" : String
Idris> :t plus
Prelude.Nat.plus : Nat -> Nat -> Nat
Idris> :t (++)
Builtins.++ : String -> String -> String
Prelude.List.++ : (List a) -> (List a) -> List a
Prelude.Vect.++ : (Vect m a) -> (Vect n a) -> Vect (m + n) a
Idris> :t plus 4
plus (Builtins.fromInteger 4) : Nat -> Nat

奙奯奵 奣奡奮 奡奬女奯 奡女奫 奦奯奲 奢奡女奩奣 奩奮奦奯奲奭奡奴奩奯奮 奡奢奯奵奴 奩奮奴奥奲奦奡奣奥女 奷奩奴奨 :doc夺

Idris> :doc Monad
Interface Monad

Parameters:
m

Methods:
(>>=) : Monad m => m a -> (a -> m b) -> m b

infixl 5

Instances:
Monad id
Monad PrimIO
Monad IO
Monad Maybe

...

奏奴奨奥奲 奤奯奣奵奭奥奮奴奡奴奩奯奮 奩女 奡奬女奯 奡奶奡奩奬奡奢奬奥 奦奲奯奭 :doc夺

Idris> :doc (+)
Prelude.Interfaces.(+) : Num ty => ty -> ty -> ty

infixl 8

The function is Total

Idris> :doc Vect
Data type Prelude.Vect.Vect : Nat -> Type -> Type
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Arguments:
Nat
Type

Constructors:

Prelude.Vect.Nil : (a : Type) -> Vect 0 a

Prelude.Vect.:: : (a : Type) -> (n : Nat) -> a -> (Vect n a) -> Vect (S n) a

infixr 7

Arguments:
a
Vect n a

Idris> :doc Monad
Interface Monad

Parameters:
m

Methods:
(>>=) : Monad m => m a -> (a -> m b) -> m b

Also called bind.
infixl 5

The function is Total
join : Monad m => m (m a) -> m a

Also called flatten or mu

The function is Total
Implementations:

Monad (IO' ffi)
Monad Stream
Monad Provider
Monad Elab
Monad PrimIO
Monad Maybe
Monad (Either e)
Monad List

Finding things

奔奨奥 奣奯奭奭奡奮奤 :apropos 女奥奡奲奣奨奥女 奮奡奭奥女夬 奴她奰奥女夬 奡奮奤 奤奯奣奵奭奥奮奴奡奴奩奯奮 奦奯奲 女奯奭奥 女奴奲奩奮奧夬 奡奮奤 奰奲奩奮奴女 奴奨奥
奲奥女奵奬奴女央 奆奯奲 奥奸奡奭奰奬奥夺

Idris> :apropos eq
eqPtr : Ptr -> Ptr -> IO Bool

eqSucc : (left : Nat) -> (right : Nat) -> (left = right) -> S left = S right
S preserves equality

lemma_both_neq : ((x = x') -> _|_) -> ((y = y') -> _|_) -> ((x, y) = (x', y')) -> _|_
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lemma_fst_neq_snd_eq : ((x = x') -> _|_) -> (y = y') -> ((x, y) = (x', y)) -> _|_

lemma_snd_neq : (x = x) -> ((y = y') -> _|_) -> ((x, y) = (x, y')) -> _|_

lemma_x_eq_xs_neq : (x = y) -> ((xs = ys) -> _|_) -> (x :: xs = y :: ys) -> _|_

lemma_x_neq_xs_eq : ((x = y) -> _|_) -> (xs = ys) -> (x :: xs = y :: ys) -> _|_

lemma_x_neq_xs_neq : ((x = y) -> _|_) -> ((xs = ys) -> _|_) -> (x :: xs = y :: ys) -> _|_

prim__eqB16 : Bits16 -> Bits16 -> Int

prim__eqB16x8 : Bits16x8 -> Bits16x8 -> Bits16x8

prim__eqB32 : Bits32 -> Bits32 -> Int

prim__eqB32x4 : Bits32x4 -> Bits32x4 -> Bits32x4

prim__eqB64 : Bits64 -> Bits64 -> Int

prim__eqB64x2 : Bits64x2 -> Bits64x2 -> Bits64x2

prim__eqB8 : Bits8 -> Bits8 -> Int

prim__eqB8x16 : Bits8x16 -> Bits8x16 -> Bits8x16

prim__eqBigInt : Integer -> Integer -> Int

prim__eqChar : Char -> Char -> Int

prim__eqFloat : Double -> Double -> Int

prim__eqInt : Int -> Int -> Int

prim__eqString : String -> String -> Int

prim__syntactic_eq : (a : Type) -> (b : Type) -> (x : a) -> (y : b) -> Maybe (x = y)

sequence : Traversable t => Applicative f => (t (f a)) -> f (t a)

sequence_ : Foldable t => Applicative f => (t (f a)) -> f ()

Eq : Type -> Type
The Eq interface defines inequality and equality.

GTE : Nat -> Nat -> Type
Greater than or equal to

LTE : Nat -> Nat -> Type
Proofs that n is less than or equal to m

gte : Nat -> Nat -> Bool
Boolean test than one Nat is greater than or equal to another
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lte : Nat -> Nat -> Bool
Boolean test than one Nat is less than or equal to another

ord : Char -> Int
Convert the number to its ASCII equivalent.

replace : (x = y) -> (P x) -> P y
Perform substitution in a term according to some equality.

sym : (l = r) -> r = l
Symmetry of propositional equality

trans : (a = b) -> (b = c) -> a = c
Transitivity of propositional equality

:search 奤奯奥女 奡 奴她奰奥夭奢奡女奥奤 女奥奡奲奣奨夬 奩奮 奴奨奥 女奰奩奲奩奴 奯奦 奈奯奯奧奬奥央 奓奥奥 奔她奰奥夭奤奩奲奥奣奴奥奤 女奥奡奲奣奨 夨夺女奥奡奲奣奨天 奦奯奲 奭奯奲奥
奤奥奴奡奩奬女央 奈奥奲奥 奩女 奡奮 奥奸奡奭奰奬奥夺

Idris> :search a -> b -> a
= Prelude.Basics.const : a -> b -> a
Constant function. Ignores its second argument.

= assert_smaller : a -> b -> b
Assert to the totality checker than y is always structurally
smaller than x (which is typically a pattern argument)

> malloc : Int -> a -> a

> Prelude.pow : Num a => a -> Nat -> a

> Prelude.Interfaces.(*) : Num a => a -> a -> a

> Prelude.Interfaces.(+) : Num a => a -> a -> a
... (More results)

:search 奣奡奮 奡奬女奯 奬奯奯奫 奦奯奲 奤奥奰奥奮奤奥奮奴 奴她奰奥女夺

Idris> :search plus (S n) n = plus n (S n)
< Prelude.Nat.plusSuccRightSucc : (left : Nat) ->

(right : Nat) ->
S (left + right) = left + S right

Loading and reloading Idris code

奔奨奥 奣奯奭奭奡奮奤 :l File.idr 奷奩奬奬 奬奯奡奤 奆奩奬奥央奩奤奲 奩奮奴奯 奴奨奥 奣奵奲奲奥奮奴奬她夭奲奵奮奮奩奮奧 奒奅奐奌夬 奡奮奤 :r 奷奩奬奬 奲奥奬奯奡奤 奴奨奥
奬奡女奴 夜奬奥 奴奨奡奴 奷奡女 奬奯奡奤奥奤央

Totality

奁奬奬 奉奤奲奩女 奤奥夜奮奩奴奩奯奮女 奡奲奥 奣奨奥奣奫奥奤 奦奯奲 奴奯奴奡奬奩奴她央 奔奨奥 奣奯奭奭奡奮奤 :total <NAME> 奷奩奬奬 奤奩女奰奬奡她 奴奨奥 奲奥女奵奬奴 奯奦 奴奨奡奴
奣奨奥奣奫央 奉奦 奡 奤奥夜奮奩奴奩奯奮 奩女 奮奯奴 奴奯奴奡奬夬 奴奨奩女 奭奡她 奢奥 奤奵奥 奴奯 奡奮 奩奮奣奯奭奰奬奥奴奥 奰奡奴奴奥奲奮 奭奡奴奣奨央 奉奦 奴奨奡奴 奩女 奴奨奥 奣奡女奥夬
:missing 奯奲 :miss 奷奩奬奬 奤奩女奰奬奡她 奴奨奥 奭奩女女奩奮奧 奣奡女奥女央

6.11. The Idris REPL 191

https://github.com/idris-lang/Idris-dev/wiki/Type-directed-search-%28%3Asearch%29


Idris 语语语言言言文文文档档档, 版版版本本本 1.3.1

Editing files

奔奨奥 奣奯奭奭奡奮奤 :e 奬奡奵奮奣奨奥女 她奯奵奲 奤奥奦奡奵奬奴 奥奤奩奴奯奲 奯奮 奴奨奥 奣奵奲奲奥奮奴 奭奯奤奵奬奥央 奁奦奴奥奲 奣奯奮奴奲奯奬 奲奥奴奵奲奮女 奴奯 奉奤奲奩女夬 奴奨奥
夜奬奥 奩女 奲奥奬奯奡奤奥奤央

Invoking the compiler

奔奨奥 奣奵奲奲奥奮奴 奭奯奤奵奬奥 奣奡奮 奢奥 奣奯奭奰奩奬奥奤 奴奯 奡奮 奥奸奥奣奵奴奡奢奬奥 奵女奩奮奧 奴奨奥 奣奯奭奭奡奮奤 :c <FILENAME> 奯奲 :compile
<FILENAME>央 奔奨奩女 奣奯奭奭奡奮奤 奡奬奬奯奷女 奴奯 女奰奥奣奩奦她 奣奯奤奥奧奥奮夬 女奯 奦奯奲 奥奸奡奭奰奬奥 奊奡奶奡奓奣奲奩奰奴 奣奡奮 奢奥 奧奥奮奥奲奡奴奥奤 奵女奩奮奧
:c javascript <FILENAME>央 奔奨奥 :exec 奣奯奭奭奡奮奤 奷奩奬奬 奣奯奭奰奩奬奥 奴奨奥 奰奲奯奧奲奡奭 奴奯 奡 奴奥奭奰奯奲奡奲她 夜奬奥 奡奮奤
奲奵奮 奴奨奥 奲奥女奵奬奴奩奮奧 奥奸奥奣奵奴奡奢奬奥央

IO actions

奕奮奬奩奫奥 奇奈奃奉夬 奴奨奥 奉奤奲奩女 奒奅奐奌 奩女 奮奯奴 奩奮女奩奤奥 奯奦 奡奮 奩奭奰奬奩奣奩奴 奉奏 奭奯奮奡奤央 奔奨奩女 奭奥奡奮女 奴奨奡奴 奡 女奰奥奣奩奡奬 奣奯奭奭奡奮奤
奭奵女奴 奢奥 奵女奥奤 奴奯 奥奸奥奣奵奴奥 奉奏 奡奣奴奩奯奮女央 :x tm 奷奩奬奬 奥奸奥奣奵奴奥 奴奨奥 奉奏 奡奣奴奩奯奮 tm 奩奮 奡奮 奉奤奲奩女 奩奮奴奥奲奰奲奥奴奥奲央

Dynamically loading C libraries

奓奯奭奥奴奩奭奥女夬 奡奮 奉奤奲奩女 奰奲奯奧奲奡奭 奷奩奬奬 奤奥奰奥奮奤 奯奮 奥奸奴奥奲奮奡奬 奬奩奢奲奡奲奩奥女 奷奲奩奴奴奥奮 奩奮 奃央 奉奮 奯奲奤奥奲 奴奯 奵女奥 奴奨奥女奥 奬奩奢奲奡奲奩奥女
奦奲奯奭 奴奨奥 奉奤奲奩女 奩奮奴奥奲奰奲奥奴奥奲夬 奴奨奥她 奭奵女奴 夜奲女奴 奢奥 奤她奮奡奭奩奣奡奬奬她 奬奯奡奤奥奤央 奔奨奩女 奩女 奡奣奨奩奥奶奥奤 奴奨奲奯奵奧奨 奴奨奥 %dynamic
<LIB> 奤奩奲奥奣奴奩奶奥 奩奮 奉奤奲奩女 女奯奵奲奣奥 夜奬奥女 奯奲 奴奨奲奯奵奧奨 奴奨奥 :dynamic <LIB> 奣奯奭奭奡奮奤 奡奴 奴奨奥 奒奅奐奌央 奔奨奥 奣奵奲奲奥奮奴
女奥奴 奯奦 奤她奮奡奭奩奣奡奬奬她 奬奯奡奤奥奤 奬奩奢奲奡奲奩奥女 奣奡奮 奢奥 奶奩奥奷奥奤 奢她 奥奸奥奣奵奴奩奮奧 :dynamic 奷奩奴奨 奮奯 奡奲奧奵奭奥奮奴女央 奔奨奥女奥
奬奩奢奲奡奲奩奥女 奡奲奥 奡奶奡奩奬奡奢奬奥 奴奨奲奯奵奧奨 奴奨奥 奉奤奲奩女 奆奆奉 奩奮 type providers 夨姩妡妵 ??天 奡奮奤 :exec央

6.11.5 Colours

奉奤奲奩女 奴奥奲奭女 奡奲奥 奡奶奡奩奬奡奢奬奥 奩奮 奡奭奡奺奩奮奧 奣奯奬奯奵奲夡 奂她 奤奥奦奡奵奬奴夬 奴奨奥 奉奤奲奩女 奒奅奐奌 奵女奥女 奣奯奬奯奵奲 奴奯 奤奩女奴奩奮奧奵奩女奨 奢奥奴奷奥奥奮
奤奡奴奡 奣奯奮女奴奲奵奣奴奯奲女夬 奴她奰奥女 奯奲 奴她奰奥 奣奯奮女奴奲奵奣奴奯奲女夬 奯奰奥奲奡奴奯奲女夬 奢奯奵奮奤 奶奡奲奩奡奢奬奥女夬 奡奮奤 奩奭奰奬奩奣奩奴 奡奲奧奵奭奥奮奴女央 奔奨奩女
奦奥奡奴奵奲奥 奩女 奡奶奡奩奬奡奢奬奥 奯奮 奡奬奬 奐奏奓奉奘夭奬奩奫奥 女她女奴奥奭女夬 奡奮奤 奴奨奥奲奥 奡奲奥 奰奬奡奮女 奴奯 奡奬奬奯奷 奩奴 奴奯 奷奯奲奫 奯奮 套奩奮奤奯奷女 奡女
奷奥奬奬央

奉奦 她奯奵 奤奯 奮奯奴 奬奩奫奥 奴奨奥 奤奥奦奡奵奬奴 奣奯奬奯奵奲女夬 奴奨奥她 奣奡奮 奢奥 奴奵奲奮奥奤 奯夛 奵女奩奮奧 奴奨奥 奣奯奭奭奡奮奤

:colour off

奡奮奤夬 奷奨奥奮 奢奯奲奥奤奯奭 女奴奲奩奫奥女夬 奴奨奥她 奣奡奮 奢奥 奲奥夭奥奮奡奢奬奥奤 奵女奩奮奧 奴奨奥 奣奯奭奭奡奮奤

:colour on

奔奯 奭奯奤奩奦她 奡 奣奯奬奯奵奲夬 奵女奥 奴奨奥 奣奯奭奭奡奮奤

:colour <CATEGORY> <OPTIONS>

奷奨奥奲奥 <CATEGORY 奩女 奯奮奥 奯奦 keyword夬 boundvar夬 implicit夬 function夬 type夬 data夬 奯奲 prompt夬 奡奮奤 奩女 奡
女奰奡奣奥夭女奥奰奡奲奡奴奥奤 奬奩女奴 奤奲奡奷奮 奦奲奯奭 奴奨奥 奣奯奬奯奵奲女 奡奮奤 奴奨奥 奦奯奮奴 奯奰奴奩奯奮女央 奔奨奥 奡奶奡奩奬奡奢奬奥 奣奯奬奯奵奲女 奡奲奥 default夬
black夬 yellow夬 cyan夬 red夬 blue夬 white夬 green夬 奡奮奤 magenta央 奉奦 奭奯奲奥 奴奨奡奮 奯奮奥 奣奯奬奯奵奲 奩女 女奰奥奣奩夜奥奤夬 奴奨奥
奬奡女奴 奯奮奥 奴奡奫奥女 奰奲奥奣奥奤奥奮奣奥央 奔奨奥 奡奶奡奩奬奡奢奬奥 奯奰奴奩奯奮女 奡奲奥 dull 奡奮奤 vivid夬 bold 奡奮奤 nobold夬 italic 奡奮奤
noitalic夬 underline 奡奮奤 nounderline夬 奦奯奲奭奩奮奧 奰奡奩奲女 奯奦 奯奰奰奯女奩奴奥女央 奔奨奥 奣奯奬奯奵奲 default 奲奥奦奥奲女 奴奯 她奯奵奲
奴奥奲奭奩奮奡奬’女 奤奥奦奡奵奬奴 奣奯奬奯奵奲央

奔奨奥 奣奯奬奯奵奲女 奵女奥奤 奡奴 女奴奡奲奴奵奰 奣奡奮 奢奥 奣奨奡奮奧奥奤 奵女奩奮奧 奒奅奐奌 奩奮奩奴奩奡奬奩女奡奴奩奯奮 女奣奲奩奰奴女央
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奃奯奬奯奵奲 奣奡奮 奢奥 奤奩女奡奢奬奥奤 奡奴 女奴奡奲奴奵奰 奢她 奴奨奥 --nocolour 奣奯奭奭奡奮奤夭奬奩奮奥 奯奰奴奩奯奮央

6.12 Compilation, Logging, and Reporting

奔奨奩女 女奥奣奴奩奯奮 奰奲奯奶奩奤奥女 奩奮奦奯奲奭奡奴奩奯奮 奡奢奯奵奴 奴奨奥 奉奤奲奩女 奣奯奭奰奩奬奡奴奩奯奮 奰奲奯奣奥女女夬 奡奮奤 奰奲奯奶奩奤奥女 奤奥奴奡奩奬女 奯奶奥奲 奨奯奷 她奯奵
奣奡奮 奦奯奬奬奯奷 奴奨奥 奰奲奯奣奥女女 奴奨奲奯奵奧奨 奬奯奧奧奩奮奧央

6.12.1 Compilation Process

奉奤奲奩女 奦奯奬奬奯奷女 奴奨奥 奦奯奬奬奯奷奩奮奧 奣奯奭奰奩奬奡奴奩奯奮 奰奲奯奣奥女女夺

失央 奐奡奲女奩奮奧

夲央 奔她奰奥 奃奨奥奣奫奩奮奧

失央 奅奬奡奢奯奲奡奴奩奯奮

夲央 奃奯奶奥奲奡奧奥

夳央 奕奮奩夜奣奡奴奩奯奮

头央 奔奯奴奡奬奩奴她 奃奨奥奣奫奩奮奧

夵央 奅奲奡女奵奲奥

夳央 奃奯奤奥 奇奥奮奥奲奡奴奩奯奮

失央 奄奥奦奵奮奣奴奩奯奮奡奬奩女奡奴奩奯奮

夲央 奉奮奬奩奮奩奮奧

夳央 奒奥女奯奬奶奩奮奧 奶奡奲奩奡奢奬奥女

头央 奃奯奤奥 奇奥奮奥奲奡奴奩奯奮

6.12.2 Type Checking Only

套奩奴奨 奉奤奲奩女 她奯奵 奣奡奮 奡女奫 奩奴 奴奯 奴奥奲奭奩奮奡奴奥 奴奨奥 奣奯奭奰奩奬奡奴奩奯奮 奰奲奯奣奥女女 奡奦奴奥奲 奴她奰奥 奣奨奥奣奫奩奮奧 奨奡女 奣奯奭奰奬奥奴奥奤央 奔奨奩女
奩女 奡奣奨奩奥奶奥奤 奴奨奲奯奵奧奨 奵女奥 奯奦 奥奩奴奨奥奲夺

• 奔奨奥 奣奯奭奭奡奮奤 奬奩奮奥 奯奰奴奩奯奮女

– --check 奦奯奲 夜奬奥女

– --checkpkg 奦奯奲 奰奡奣奫奡奧奥女

• 奔奨奥 奒奅奐奌 奣奯奭奭奡奮奤夺 :check

奕女奥 奯奦 奴奨奩女 奯奰奴奩奯奮 奷奩奬奬 女奴奩奬奬 奲奥女奵奬奴 奩奮 奴奨奥 奧奥奮奥奲奡奴奩奯奮 奯奦 奴奨奥 奉奤奲奩女 奢奩奮奡奲她 .ibc 夜奬奥女夬 奡奮奤 奩女 女奵奩奴奡奢奬奥 奩奦 她奯奵
奤奯 奮奯奴 奷奩女奨 奴奯 奧奥奮奥奲奡奴奥 奣奯奤奥 奦奲奯奭 奯奮奥 奯奦 奴奨奥 女奵奰奰奯奲奴奥奤 奢奡奣奫奥奮奤女央

6.12.3 Reporting Compilation Process

奄奵奲奩奮奧 奣奯奭奰奩奬奡奴奩奯奮 奴奨奥 奲奥奰奯奲奴奩奮奧 奯奦 奉奤奲奩女’ 奰奲奯奧奲奥女女 奣奡奮 奢奥 奣奯奮奴奲奯奬奬奥奤 奢她 女奥奴奴奩奮奧 奡 奶奥奲奢奯女奩奴她 奬奥奶奥奬央
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• -V夬 奯奲 奡奬奴奥奲奮奡奴奩奶奥奬她 --verbose 奡奮奤 --V0夬 奷奩奬奬 奲奥奰奯奲奴 奷奨奩奣奨 夜奬奥 奉奤奲奩女 奩女 奣奵奲奲奥奮奴奬她 奴她奰奥 奣奨奥奣奫奩奮奧央

• --V1 奷奩奬奬 奡奤奤奩奴奩奯奮奡奬奬她 奲奥奰奯奲奴夺 奐奡奲女奩奮奧夬 奉奂奃 奇奥奮奥奲奡奴奩奯奮夬 奡奮奤 奃奯奤奥 奇奥奮奥奲奡奴奩奯奮央

• --V2 奷奩奬奬 奡奤奤奩奴奩奯奮奡奬奬她 奲奥奰奯奲奴夺 奔奯奴奡奬奩奴她 奃奨奥奣奫奩奮奧夬 奕奮奩奶奥奲女奥 奃奨奥奣奫奩奮奧夬 奡奮奤 奴奨奥 奩奮奤奩奶奩奤奵奡奬 女奴奥奰女 奰奲奩奯奲
奴奯 奣奯奤奥 奧奥奮奥奲奡奴奩奯奮央

奂她 奤奥奦奡奵奬奴 奉奤奲奩女’ 奰奲奯奧奲奥女女 奲奥奰奯奲奴奩奮奧 奩女 女奥奴 奴奯 奱奵奩奥奴夭-q夬 奯奲 --quiet央

6.12.4 Logging Internal Operation

奆奯奲 奴奨奯女奥 奴奨奡奴 奤奥奶奥奬奯奰 奯奮 奴奨奥 奉奤奲奩女 奣奯奭奰奩奬奥奲夬 奴奨奥 奩奮奴奥奲奮奡奬 奯奰奥奲奡奴奩奯奮 奯奦 奉奤奲奩女 奩女 奣奡奰奴奵奲奥奤 奵女奩奮奧 奡 奣奡奴奥奧奯奲她
奢奡女奥奤 奬奯奧奧奥奲央 奃奵奲奲奥奮奴奬她夬 奴奨奥 奬奯奧奧奩奮奧 奩奮奦奲奡女奴奲奵奣奴奵奲奥 奨奡女 女奵奰奰奯奲奴 奦奯奲 奴奨奥 奦奯奬奬奯奷奩奮奧 奣奡奴奥奧奯奲奩奥女夺

• 奐奡奲女奥奲 夨parser天

• 奅奬奡奢奯奲奡奴奯奲 夨elab天

• 奃奯奤奥 奧奥奮奥奲奡奴奩奯奮 夨codegen天

• 奅奲奡女奵奲奥 夨erasure天

• 奃奯奶奥奲奡奧奥 奃奨奥奣奫奩奮奧 夨coverage天

• 奉奂奃 奧奥奮奥奲奡奴奩奯奮 夨ibc天

奔奨奥女奥 奣奡奴奥奧奯奲奩奥女 奡奲奥 女奰奥奣奩夜奥奤 奵女奩奮奧 奴奨奥 奣奯奭奭奡奮奤夭奬奩奮奥 奯奰奴奩奯奮夺 --logging-categories CATS夬 奷奨奥奲奥
CATS 奩女 奡 奱奵奯奴奥奤 奣奯奬奯奮 女奥奰奡奲奡奴奥奤 女奴奲奩奮奧 奯奦 奴奨奥 奣奡奴奥奧奯奲奩奥女 她奯奵 奷奡奮奴 奴奯 女奥奥央 奂她 奤奥奦奡奵奬奴 奩奦 奴奨奩女 奯奰奴奩奯奮 奩女
奮奯奴 女奰奥奣奩夜奥奤 奡奬奬 奣奡奴奥奧奯奲奩奥女 奡奲奥 奡奬奬奯奷奥奤央 奓奵奢夭奣奡奴奥奧奯奲奩奥女 奨奡奶奥 她奥奴 奴奯 奢奥 奤奥夜奮奥奤 奢奵奴 奷奩奬奬 奢奥 奩奮 奴奨奥 奦奵奴奵奲奥夬
奥女奰奥奣奩奡奬奬她 奦奯奲 奴奨奥 奥奬奡奢奯奲奡奴奯奲央

奆奵奲奴奨奥奲夬 奴奨奥 奶奥奲奢奯女奩奴她 奯奦 奬奯奧奧奩奮奧 奣奡奮 奢奥 奣奯奮奴奲奯奬奬奥奤 奢她 女奰奥奣奩奦她奩奮奧 奡 奬奯奧奧奩奮奧 奬奥奶奥奬 奢奥奴奷奥奥奮夺 失 奴奯 失夰 奵女奩奮奧
奴奨奥 奣奯奭奭奡奮奤夭奬奩奮奥 奯奰奴奩奯奮夺 --log <level>央

• 奌奥奶奥奬 夰夺 奓奨奯奷 奮奯 奬奯奧奧奩奮奧 奯奵奴奰奵奴央 奄奥奦奡奵奬奴 奬奥奶奥奬

• 奌奥奶奥奬 失夺 奈奩奧奨 奬奥奶奥奬 奤奥奴奡奩奬女 奯奦 奴奨奥 奣奯奭奰奩奬奡奴奩奯奮 奰奲奯奣奥女女央

• 奌奥奶奥奬 夲夺 奐奲奯奶奩奤奥女 奤奥奴奡奩奬女 奯奦 奴奨奥 奣奯奶奥奲奡奧奥 奣奨奥奣奫奩奮奧夬 奡奮奤 奦奵奲奴奨奥奲 奤奥奴奡奩奬女 奴奨奥 奥奬奡奢奯奲奡奴奩奯奮 奰奲奯奣奥女女
女奰奥奣奩夜奣奡奬奬她夺 奉奮奴奥奲奦奡奣奥夬 奃奬奡奵女奥女夬 奄奡奴奡夬 奔奥奲奭夬 奡奮奤 奔她奰奥女夬

• 奌奥奶奥奬 夳夺 奐奲奯奶奩奤奥女 奤奥奴奡奩奬女 奯奦 奣奯奭奰奩奬奡奴奩奯奮 奯奦 奴奨奥 奉奒奔奓夬 奥奲奡女奵奲奥夬 奰奡奲女奩奮奧夬 奣奡女奥 女奰奬奩奴奴奩奮奧夬 奡奮奤 奦奵奲奴奨奥奲
奤奥奴奡奩奬女 奥奬奡奢奯奲奡奴奩奯奮 奯奦夺 奉奭奰奬奥奭奥奮奴奡奴奩奯奮女夬 奐奲奯奶奩奤奥奲女夬 奡奮奤 奖奡奬奵奥女央

• 奌奥奶奥奬 头夺 奐奲奯奶奩奤奥女 奦奵奲奴奨奥奲 奤奥奴奡奩奬女 奯奮夺 奅奲奡女奵奲奥夬 奃奯奶奥奲奡奧奥 奃奨奥奣奫奩奮奧夬 奃奡女奥 女奰奬奩奴奴奩奮奧夬 奡奮奤 奥奬奡奢奯奲奡奴奩奯奮
奯奦 奣奬奡奵女奥女央

• 奌奥奶奥奬 夵夺 奐奲奯奶奩奤奥女 奤奥奴奡奩奬女 奯奮 奴奨奥 奰奲奯奶奥奲夬 奡奮奤 奦奵奲奴奨奥奲 奤奥奴奡奩奬女 奥奬奡奢奯奲奡奴奩奯奮 夨奡奤奤奩奮奧 奤奥奣奬奡奲奡奴奩奯奮女天 奡奮奤
奣奯奭奰奩奬奡奴奩奯奮 奯奦 奴奨奥 奉奒奔奓央

• 奌奥奶奥奬 夶夺 奆奵奲奴奨奥奲 奤奥奴奡奩奬女 奥奬奡奢奯奲奡奴奩奯奮 奡奮奤 奣奯奶奥奲奡奧奥 奣奨奥奣奫奩奮奧央

• 奌奥奶奥奬 夷夺

• 奌奥奶奥奬 夸夺

• 奌奥奶奥奬 夹夺

• 奌奥奶奥奬 失夰夺 奆奵奲奴奨奥奲 奤奥奴奡奩奬女 奥奬奡奢奯奲奡奴奩奯奮央
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6.12.5 Environment Variables

奓奥奶奥奲奡奬 奰奡奴奨女 女奥奴 奢她 奤奥奦奡奵奬奴 奷奩奴奨奩奮 奴奨奥 奉奤奲奩女 奣奯奭奰奩奬奥奲 奣奡奮 奢奥 奯奶奥奲奲奩奤奤奥奮 奴奨奲奯奵奧奨 奥奮奶奩奲奯奮奭奥奮奴 奶奡奲奩奡奢奬奥女央
奔奨奥 奰奲奯奶奩奤奥奤 奶奡奲奩奡奢奬奥女 奡奲奥夺

• IDRIS_CC 奃奨奡奮奧奥 奴奨奥 C 奣奯奭奰奩奬奥奲 奵女奥奤 奢她 奴奨奥 C 奢奡奣奫奥奮奤央

• IDRIS_CFLAGS 奃奨奡奮奧奥 奴奨奥 C 夝奡奧女 奰奡女女奥奤 奴奯 奴奨奥 C 奣奯奭奰奩奬奥奲央

• TARGET 奃奨奡奮奧奥 奴奨奥 奴奡奲奧奥奴 奤奩奲奥奣奴奯奲她 奩央奥央 data dir 奷奨奥奲奥 奉奤奲奩女 奩奮女奴奡奬奬女 夜奬奥女 奷奨奥奮 奩奮女奴奡奬奬奩奮奧 奵女奩奮奧
奃奡奢奡奬夯奓奴奡奣奫央

• IDRIS_LIBRARY_PATH 奃奨奡奮奧奥 奴奨奥 奬奯奣奡奴奩奯奮 奯奦 奷奨奥奲奥 奩奮女奴奡奬奬奥奤 奰奡奣奫奡奧奥女 奡奲奥 奦奯奵奮奤夯奩奮女奴奡奬奬奥奤央

• IDRIS_DOC_PATH 奃奨奡奮奧奥 奴奨奥 奬奯奣奡奴奩奯奮 奯奦 奷奨奥奲奥 奧奥奮奥奲奡奴奥奤 奩奤奲奩女奤奯奣 奦奯奲 奰奡奣奫奡奧奥女 奡奲奥 奩奮女奴奡奬奬奥奤央

注注注解解解: 奉奮 奶奥奲女奩奯奮女 奯奦 奉奤奲奩女 奰奲奩奯奲 奴奯 夰央失夲央夳 奴奨奥 奥奮奶奩奲奯奮奭奥奮奴 奶奡奲奩奡奢奬奥女 IDRIS_LIBRARY_PATH 奡奮奤
TARGET 奷奥奲奥 奢奯奴奨 奵女奥奤 奴奯 奡夛奥奣奴 奴奨奥 奩奮女奴奡奬奬奡奴奩奯奮 奯奦 女奩奮奧奬奥 奰奡奣奫奡奧奥女 奡奮奤 奤奩奲奥奣奴 奷奨奥奲奥 奉奤奲奩女 奩奮女奴奡奬奬奥奤
奩奴女 奤奡奴奡央 奔奨奥 奭奥奡奮奩奮奧 奯奦 奴奨奥女奥 奶奡奲奩奡奢奬奥女 奨奡女 奣奨奡奮奧奥奤夬 奡奮奤 奣奯奭奭奡奮奤 奬奩奮奥 奯奰奴奩奯奮女 奡奲奥 奰奲奥奦奥奲奲奥奤 奷奨奥奮
奣奨奡奮奧奩奮奧 奷奨奥奲奥 奩奮奤奩奶奩奤奵奡奬 奰奡奣奫奡奧奥女 奡奲奥 奩奮女奴奡奬奬奥奤央

奔奨奥 奃奌奉 奯奰奴奩奯奮 –ibcsubdir 奣奡奮 奢奥 奵女奥奤 奴奯 奤奩奲奥奣奴 奷奨奥奲奥 奧奥奮奥奲奡奴奥奤 奉奂奃 夜奬奥女 奡奲奥 奰奬奡奣奥奤央 奈奯奷奥奶奥奲夬 奴奨奩女
奭奥奡奮女 奉奤奲奩女 奷奩奬奬 奩奮女奴奡奬奬 夜奬奥女 奩奮 奡 奮奯奮夭女奴奡奮奤奡奲奤 奬奯奣奡奴奩奯奮 女奥奰奡奲奡奴奥 奦奲奯奭 奴奨奥 奲奥女奴 奯奦 奴奨奥 奩奮女奴奡奬奬奥奤 奰奡奣奫奡奧奥女央
奔奨奥 奃奌奉 奯奰奴奩奯奮 –idrispath <dir> 奡奬奬奯奷女 她奯奵 奴奯 奡奤奤 奡 奤奩奲奥奣奴奯奲她 奴奯 奴奨奥 奬奩奢奲奡奲她 女奥奡奲奣奨 奰奡奴奨夻 奴奨奩女 奯奰奴奩奯奮
奣奡奮 奢奥 奵女奥奤 奭奵奬奴奩奰奬奥 奴奩奭奥女 奡奮奤 奣奡奮 奢奥 女奨奯奲奴奥奮奥奤 奴奯 -i <dir>央 奓奩奭奩奬奡奲她夬 奴奨奥 –sourcepath <dir> 奯奰奴奩奯奮
奣奡奮 奢奥 奵女奥奤 奴奯 奡奤奤 奤奩奲奥奣奴奯奲奩奥女 奴奯 奴奨奥 女奯奵奲奣奥 女奥奡奲奣奨 奰奡奴奨央 奔奨奥奲奥 奩女 奮奯 女奨奯奲奴奥奮奥奤 奶奥奲女奩奯奮 奦奯奲 奴奨奩女 奯奰奴奩奯奮
奡女 -s 奩女 奡 奲奥女奥奲奶奥奤 夝奡奧央

奆奵奲奴奨奥奲夬 奉奤奲奩女 奡奬女奯 女奵奰奰奯奲奴女 奯奰奴奩奯奮女 奴奯 奡奵奧奭奥奮奴 奴奨奥 奰奡奴奨女 奵女奥奤夬 奡奮奤 奰奡女女 奯奰奴奩奯奮女 奴奯 奴奨奥 奣奯奤奥 奧奥奮奥奲奡奴奯奲
奢奡奣奫奥奮奤央 奔奨奥 奯奰奴奩奯奮 –cg-opt <ARG> 奣奡奮 奢奥 奵女奥奤 奴奯 奰奡女女 奯奰奴奩奯奮女 奴奯 奴奨奥 奣奯奤奥 奧奥奮奥奲奡奴奯奲央 奔奨奥 奦奯奲奭奡奴 奯奦
<ARG> 奩女 奤奥奰奥奮奤奥奮奴 奯奮 奴奨奥 女奥奬奥奣奴奥奤 奢奡奣奫奥奮奤央

6.13 Idris’’’ Internals

奎奯奴奥夺 奴奨奩女 奩女 女奴奩奬奬 奡 奦奡奩奲奬她 奲奡奷 女奥奴 奯奦 奮奯奴奥女 奴奡奫奥奮 奢她 奄奡奶奩奤 奃奨奲奩女奴奩奡奮女奥奮 奡奴 奅奤奷奩奮’女 奰奲奥女奥奮奴奡奴奩奯奮 奡奴
奴奨奥 夲夰失夳 奉奤奲奩女 奄奥奶奥奬奯奰奥奲女 奍奥奥奴奩奮奧央 奔奨奥她’奲奥 奩奮 奴奨奥 奰奲奯奣奥女女 奯奦 奴奵奲奮奩奮奧 奩奮奴奯 奡 奵女奥奦奵奬 奧奵奩奤奥 夭 奦奥奥奬 奦奲奥奥 奴奯
奣奯奮奴奲奩奢奵奴奥央

奔奨奩女 奤奯奣奵奭奥奮奴 奡女女奵奭奥女 奴奨奡奴 她奯奵 奡奲奥 奡奬奲奥奡奤她 奦奡奭奩奬奩奡奲 奷奩奴奨 奉奤奲奩女央 奉奴 奩女 奩奮奴奥奮奤奥奤 奦奯奲 奴奨奯女奥 奷奨奯 奷奡奮奴 奴奯
奷奯奲奫 奯奮 奴奨奥 奩奮奴奥奲奮奡奬女央

奐奥奯奰奬奥 奬奯奯奫奩奮奧 奴奯 奤奥奶奥奬奯奰 奮奥奷 奢奡奣奫 奥奮奤女 奭奡她 奷奡奮奴 奴奯 奬奯奯奫 奡奴 奛奛奉奤奲奩女 奢奡奣奫 奥奮奤 奉奒女奼奉奤奲奩女夭奢奡奣奫夭奥奮奤夭奉奒女奝奝

6.13.1 Core/TT.hs

奉奤奲奩女 奩女 奣奯奭奰奩奬奥奤 奴奯 奡 女奩奭奰奬奥夬 奥奸奰奬奩奣奩奴 奣奯奲奥 奬奡奮奧奵奡奧奥央 奔奨奩女 奣奯奲奥 奬奡奮奧奵奡奧奥 奩女 奣奡奬奬奥奤 奔奔 奢奥奣奡奵女奥 奩奴 奬奯奯奫女 奡
奢奩奴 奬奩奫奥 奡 Π央 奉奴’女 奡 奭奩奮奩奭奡奬 奬奡奮奧奵奡奧奥夬 奷奩奴奨 奡 奬奯奣奡奬奬她 奮奡奭奥奬奥女女 奲奥奰奲奥女奥奮奴奡奴奩奯奮央 奔奨奡奴 奩女夬 奬奯奣奡奬 奶奡奲奩奡奢奬奥女
奡奲奥 奲奥奰奲奥女奥奮奴奥奤 奷奩奴奨 奤奥 奂奲奵奩奪奮 奩奮奤奩奣奥女 奡奮奤 奧奬奯奢奡奬奬她夭奤奥夜奮奥奤 奣奯奮女奴奡奮奴女 奡奲奥 奲奥奰奲奥女奥奮奴奥奤 奷奩奴奨 奮奡奭奥女央

奔奨奥 TT 奤奡奴奡奴她奰奥 奵女奥女 奡 奴奲奩奣奫 奴奨奡奴 奩女 奣奯奭奭奯奮 奩奮 奴奨奥 奉奤奲奩女 奣奯奤奥夺 奩奴 奩女 奰奯奬她奭奯奲奰奨奩奣 奯奶奥奲 奴奨奥 奴她奰奥 奯奦 奮奡奭奥女
女奴奯奲奥奤 奩奮 奩奴夬 奡奮奤 奩奴 奤奥奲奩奶奥女 Functor央 奔奨奩女 奡奬奬奯奷女 fmap 奴奯 奢奥 奵女奥奤 奡女 奡 奧奥奮奥奲奡奬夭奰奵奲奰奯女奥 奴奲奡奶奥奲女奡奬央

奔奨奥奲奥 奩女 奡 奧奥奮奥奲奡奬 奣奯奮女奴奲奵奣奴奩奯奮 奦奯奲 奢奩奮奤奥奲女夬 奵女奥奤 奦奯奲 𝜆夬 Π夬 奡奮奤 奬奥奴夭奢奩奮奤奩奮奧女央 奔奨奥女奥 奡奲奥 奤奩女奴奩奮奧奵奩女奨奥奤
奵女奩奮奧 奡 BinderType央
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奄奵奲奩奮奧 奣奯奭奰奩奬奡奴奩奯奮夬 女奯奭奥 奴奥奲奭女 夨奥女奰奥奣奩奡奬奬她 奴她奰奥女天 奷奩奬奬 奢奥 奥奲奡女奥奤央 奔奨奩女 奩女 奲奥奰奲奥女奥奮奴奥奤 奵女奩奮奧 奴奨奥 Erased
奣奯奮女奴奲奵奣奴奯奲 奯奦 TT央 奁 奨奡奮奤她 奴奲奩奣奫 奷奨奥奮 奧奥奮奥奲奡奴奩奮奧 奔奔 奴奥奲奭女 奩女 奴奯 奩奮女奥奲奴 Erased 奷奨奥奲奥 奡 奴奥奲奭 奩女 奵奮奩奱奵奥奬她
奤奥奴奥奲奭奩奮奥奤夬 奡女 奴奨奥 奴她奰奥奣奨奥奣奫奥奲 奷奩奬奬 夜奬奬 奩奴 奯奵奴央

奔奨奥 奣奯奮女奴奲奵奣奴奯奲 Proj 奩女 奡 奲奥女奵奬奴 奯奦 奴奨奥 奯奰奴奩奭奩奺奥奲央 奉奴 奩女 奵女奥奤 奴奯 奥奸奴奲奡奣奴 奡 女奰奥奣奩夜奣 奣奯奮女奴奲奵奣奴奯奲 奡奲奧奵奭奥奮奴夬
奩奮 奡 奭奯奲奥 奥奣奯奮奯奭奩奣奡奬 奷奡她 奴奨奡奮 奤奥夜奮奩奮奧 奡 奮奥奷 奰奡奴奴奥奲奮夭奭奡奴奣奨奩奮奧 奯奰奥奲奡奴奩奯奮央

奔奨奥 奤奡奴奡奴她奰奥 Raw 奲奥奰奲奥女奥奮奴女 奴奥奲奭女 奴奨奡奴 奨奡奶奥 奮奯奴 她奥奴 奢奥奥奮 奴她奰奥奣奨奥奣奫奥奤央 奔奨奥 奴她奰奥奣奨奥奣奫奥奲 奣奯奮奶奥奲奴女 奡 Raw
奴奯 奡 TT 奩奦 奩奴 奣奡奮央

6.13.2 Core/CaseTree.hs

奃奡女奥 奴奲奥奥女 奡奲奥 奵女奥奤 奴奯 奲奥奰奲奥女奥奮奴 奴奯奰夭奬奥奶奥奬 奰奡奴奴奥奲奮夭奭奡奴奣奨奩奮奧 奤奥夜奮奩奴奩奯奮女 奩奮 奴奨奥 奔奔 奬奡奮奧奵奡奧奥央

奊奵女奴 奡女 奷奩奴奨 奴奨奥 TT 奤奡奴奡奴她奰奥夬 奴奨奥 deriving Functor 奴奲奩奣奫 奩女 奵女奥奤 奷奩奴奨 SC 奡奮奤 CaseAlt 奴奯 奧奥奴 奇奈奃 奴奯
奧奥奮奥奲奡奴奥 奡 奦奵奮奣奴奩奯奮 奦奯奲 奭奡奰奰奩奮奧 奯奶奥奲 奣奯奮奴奡奩奮奥奤 奴奥奲奭女央

奃奯奮女奴奲奵奣奴奯奲 奣奡女奥女 夨ConCase 奩奮 CaseAlt天 奲奥奦奥奲 奴奯 奮奵奭奢奥奲奥奤 奣奯奮女奴奲奵奣奴奯奲女央 奅奶奥奲她 奣奯奮女奴奲奵奣奴奯奲 奩女 奮奵奭奢奥奲奥奤
夰夬失夬夲夬…央 奁奴 奴奨奩女 女奴奡奧奥 奩奮 奴奨奥 奣奯奭奰奩奬奥奲夬 奴奨奥 奴奡奧女 奡奲奥 奤奡奴奡奴她奰奥夭奬奯奣奡奬央 奁奦奴奥奲 奤奥奦奵奮奣奴奩奯奮奡奬奩奺奡奴奩奯奮夬 奨奯奷奥奶奥奲夬
奴奨奥她 奡奲奥 奭奡奤奥 奧奬奯奢奡奬奬她 奵奮奩奱奵奥央

奔奨奥 n+1 奰奡奴奴奥奲奮女 夨SucCase天 奡奮奤 奨奡奣奫她夭女奥奥奭奩奮奧 奴奨奩奮奧女 奡奲奥 奴奯 奭奡奫奥 奣奯奤奥 奦奡女奴 夕 奰奬奥奡女奥 奡女奫 奢奥奦奯奲奥
“奣奬奥奡奮奩奮奧 奵奰” 奴奨奥 奲奥奰奲奥女奥奮奴奡奴奩奯奮央

6.13.3 Core/Evaluate.hs

奔奨奩女 奭奯奤奵奬奥 奣奯奮奴奡奩奮女 奴奨奥 奭奡奩奮 奥奶奡奬奵奡奴奯奲 奦奯奲 奉奤奲奩女央 奔奨奥 奥奶奡奬奵奡奴奯奲 奩女 奵女奥奤 奢奯奴奨 奡奴 奴奨奥 奒奅奐奌 奡奮奤 奤奵奲奩奮奧
奴她奰奥 奣奨奥奣奫奩奮奧夬 奷奨奥奲奥 奮奯奲奭奡奬奩女奥奤 奴奥奲奭女 奮奥奥奤 奴奯 奢奥 奣奯奭奰奡奲奥奤 奦奯奲 奥奱奵奡奬奩奴她央

奁 奫奥她 奤奡奴奡奴她奰奥 奩奮 奴奨奥 奥奶奡奬奵奡奴奯奲 奩女 奡 context央 奃奯奮奴奥奸奴女 奡奲奥 奭奡奰奰奩奮奧女 奦奲奯奭 奧奬奯奢奡奬 奮奡奭奥女 奴奯 奴奨奥奩奲 奶奡奬奵奥女夬
奢奵奴 奴奨奥她 奡奲奥 奯奲奧奡奮奩奺奥奤 奴奯 奭奡奫奥 奴她奰奥夭奤奩奲奥奣奴奥奤 奤奩女奡奭奢奩奧奵奡奴奩奯奮 奱奵奩奣奫央 奉奮 奰奡奲奴奩奣奵奬奡奲夬 奴奨奥 奭奡奩奮 奰奡奲奴 奯奦 奡
奮奡奭奥 奴奨奡奴 奡 奵女奥奲 奭奩奧奨奴 奴她奰奥 奩女 奵女奥奤 奡女 奴奨奥 奫奥她夬 奡奮奤 奩奴女 奶奡奬奵奥女 奡奲奥 奭奡奰女 奦奲奯奭 奮奡奭奥女奰奡奣奥女 奴奯 奡奣奴奵奡奬
奶奡奬奵奥女央

奔奨奥 奤奡奴奡奴她奰奥 Def 奲奥奰奲奥女奥奮奴女 奡 奤奥夜奮奩奴奩奯奮 奩奮 奴奨奥 奧奬奯奢奡奬 奣奯奮奴奥奸奴央 奁奬奬 奧奬奯奢奡奬 奮奡奭奥女 奭奡奰 奴奯 奴奨奩女 女奴奲奵奣奴奵奲奥央

Type 奡奮奤 Term 奡奲奥 奢奯奴奨 女她奮奯奮她奭女 奦奯奲 TT央

奄奡奴奡奴她奰奥女 奡奲奥 奲奥奰奲奥女奥奮奴奥奤 奢她 奡 TyDecl 奷奩奴奨 奴奨奥 奡奰奰奲奯奰奲奩奡奴奥 NameType央 奁 Function 奩女 奡 奧奬奯奢奡奬 奣奯奮女奴奡奮奴
奴奥奲奭 奷奩奴奨 奡奮 奡奮奮奯奴奡奴奥奤 奴她奰奥夬 Operator 奲奥奰奲奥女奥奮奴女 奰奲奩奭奩奴奩奶奥女 奩奭奰奬奥奭奥奮奴奥奤 奩奮 奈奡女奫奥奬奬夬 奡奮奤 CaseOp 奲奥奰夭
奲奥女奥奮奴女 奯奲奤奩奮奡奲她 奰奡奴奴奥奲奮夭奭奡奴奣奨奩奮奧 奤奥夜奮奩奴奩奯奮女央 CaseOp 奨奡女 奦奯奵奲 奶奥奲女奩奯奮女 奦奯奲 奤奩夛奥奲奥奮奴 奰奵奲奰奯女奥女夬 奡奮奤 奡奬奬
奡奲奥 女奡奶奥奤 奢奥奣奡奵女奥 奴奨奡奴’女 奥奡女奩奥女奴央

CaseInfo夺 奴奨奥 tc_dictionary 奩女 奢奥奣奡奵女奥 奩奴’女 奡 奴她奰奥 奣奬奡女女 奤奩奣奴奩奯奮奡奲她 奷奨奩奣奨 奭奡奫奥女 奴奯奴奡奬奩奴她 奣奨奥奣奫奩奮奧
奥奡女奩奥奲央

奔奨奥 normalise* 奦奵奮奣奴奩奯奮女 奧奩奶奥 奤奩夛奥奲奥奮奴 奢奥奨奡奶奩奯奲女 夭 奢奵奴 normalise 奩女 奴奨奥 奭奯女奴 奣奯奭奭奯奮央

normaliseC 夭 “奲奥女奯奬奶奥奤” 奭奥奡奮女 奷奩奴奨 奮奡奭奥女 奣奯奮奶奥奲奴奥奤 奴奯 奤奥 奂奲奵奩奪奮 奩奮奤奩奣奥女 奡女 奡奰奰奲奯奰奲奩奡奴奥央

normaliseAll 夭 奲奥奤奵奣奥 奥奶奥奲她奴奨奩奮奧夬 奥奶奥奮 奩奦 奩奴’女 奮奯奮夭奴奯奴奡奬

normaliseTrace 夭 女奰奥奣奩奡奬夭奰奵奲奰奯女奥 奦奯奲 奤奥奢奵奧奧奩奮奧

simplify 夭 奲奥奤奵奣奥 奴奨奥 奴奨奩奮奧女 奴奨奡奴 奡奲奥 女奭奡奬奬 夭 奴奨奥 奬奩女奴 奡奲奧奵奭奥奮奴 奩女 奴奨奥 奴奨奩奮奧女 奴奯 奮奯奴 奲奥奤奵奣奥央
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6.13.4 Core/Typecheck.hs

奓奴奡奮奤奡奲奤 女奴奵夛央 奈奯奰奥奦奵奬奬她 奮奯 奣奨奡奮奧奥女 奡奲奥 奮奥奣奥女女奡奲她央

6.13.5 Core/Elaborate.hs

奉奤奲奩女 奤奥夜奮奩奴奩奯奮女 奡奲奥 奥奬奡奢奯奲奡奴奥奤 奯奮奥 奢她 奯奮奥 奡奮奤 奴奵奲奮奥奤 奩奮奴奯 奴奨奥 奣奯奲奲奥女奰奯奮奤奩奮奧 奔奔央 奔奨奩女 奩女 奤奯奮奥 奷奩奴奨 奡
奴奡奣奴奩奣 奬奡奮奧奵奡奧奥 奡女 奡奮 奅奄奓奌 奩奮 奴奨奥 奅奬奡奢 奭奯奮奡奤 夨奯奲 奅奬奡奢’ 奷奨奥奮 奴奨奥奲奥’女 奡 奣奵女奴奯奭 女奴奡奴奥天央

奌奯奴女 奯奦 奰奬奵奭奢奩奮奧 奦奯奲 奥奲奲奯奲女央

奁奬奬 奥奬奡奢奯奲奡奴奩奯奮 奩女 奲奥奬奡奴奩奶奥 奴奯 奡 奧奬奯奢奡奬 奣奯奮奴奥奸奴央

奔奨奥 女奴奲奩奮奧 奩奮 奴奨奥 奰奡奩奲 奲奥奴奵奲奮奥奤 奢她 奥奬奡奢奯奲奡奴奥 奩女 奬奯奧 奩奮奦奯奲奭奡奴奩奯奮央

奓奥奥 奊奆奐 奰奡奰奥奲夬 奢奵奴 奴奨奥 奮奡奭奥女 奤奯奮’奴 奮奥奣奥女女奡奲奩奬她 奭奡奰 奴奯 奥奡奣奨 奯奴奨奥奲央 奔奨奥 奰奡奰奥奲 奩女 奴奨奥 “奩奤奥奡奬奩奺奥奤
奶奥奲女奩奯奮” 奷奩奴奨奯奵奴 奬奯奧奧奩奮奧夬 奡奤奤奩奴奩奯奮奡奬 女奴奡奴奥夬 奥奴奣央

奁奬奬 奴奨奥 奴奡奣奴奩奣女 奴奡奫奥 奒奡奷女夬 奴她奰奥奣奨奥奣奫奩奮奧 奨奡奰奰奥奮女 奴奨奥奲奥央

奣奬奡奩奭 夨奸 夺 奴天 奡女女奵奭奥女 奡 奮奥奷 奸 夺 奴央

奐奌奅奁奓奅 奔奉奄奙 奔奈奉奎奇奓 奕奐夡

奰奲奯奯奦奓奥奡奲奣奨 夝奡奧 奴奯 奴奲她’ 奩女 奷奨奥奴奨奥奲 奴奨奥 奦奡奩奬奵奲奥 奣奡奭奥 奦奲奯奭 奡 奨奵奭奡奮 夨女奯 奦奡奩奬天 奯奲 奦奲奯奭 奡 奭奡奣奨奩奮奥 夨女奯
奣奯奮奴奩奮奵奥天

奉奤奲奩女夭奬奥奶奥奬 女她奮奴奡奸 奦奯奲 奰奲奯奶奩奤奩奮奧 奡奬奴奥奲奮奡奴奩奶奥女 奥奸奰奬奩奣奩奴奬她夺 夨奼 奸夬 她夬 奺 奼天 奴奲她 奸夬 她夬 奺 奩奮 奯奲奤奥奲夬 奡奮奤 奴奡奫奥 奴奨奥 夜奲女奴
奴奨奡奴 女奵奣奣奥奥奤女央

6.13.6 Core/ProofState.hs

6.13.7 Core/Unify.hs

奄奥奡奬女 奷奩奴奨 奵奮奩夜奣奡奴奩奯奮央 奕奮奩夜奣奡奴奩奯奮 奣奡奮 奲奥奰奬她 奷奩奴奨夺 夭 奴奨奩女 奷奯奲奫女 夭 奴奨奩女 奣奡奮 奮奥奶奥奲 奷奯奲奫 夭 奴奨奩女 奷奩奬奬 奷奯奲奫 奩奦
奴奨奥女奥 奯奴奨奥奲 奵奮奩夜奣奡奴奩奯奮 奰奲奯奢奬奥奭女 奷奯奲奫 奯奵奴 夨奥奧 奵奮奩奦她奩奮奧 奦 奸 奷奩奴奨 失天

奭奡奴奣奨奟奵奮奩奦她夺 女奡奭奥 奴奨奩奮奧 奡女 奵奮奩夜奣奡奴奩奯奮 奥奸奣奥奰奴 奩奴’女 奪奵女奴 奭奡奴奣奨奩奮奧 奮奡奭奥 奡奧奡奩奮女奴 奮奡奭奥夬 奴奥奲奭 奡奧奡奩奮女奴
奴奥奲奭央 奸 夫 她 奭奡奴奣奨奥女 奴奯 夰 夫 她 奷奩奴奨 奸 夽 夰央 奕女奥奤 奦奯奲 夼夽夽 女她奮奴奡奸 奡女 奷奥奬奬 奡女 奴她奰奥 奣奬奡女女 奲奥女奯奬奵奴奩奯奮央

6.13.8 Idris/AbsSyntaxTree.hs

奐奔奥奲奭 奩女 奴奨奥 奤奡奴奡奴她奰奥 奯奦 奉奤奲奩女 女她奮奴奡奸央 奐 奩女 奦奯奲 奐奲奯奧奲奡奭央 奅奡奣奨 奐奔奥奲奭 奴奵奲奮女 奩奮奴奯 奡 奔奔 奴奥奲奭 奢她 奡奰奰奬她奩奮奧
奡 女奥奲奩奥女 奯奦 奴奡奣奴奩奣女央

奉奓奴奡奴奥 奩女 奴奨奥 奭奡奪奯奲 奩奮奴奥奲奰奲奥奴奥奲 女奴奡奴奥央 奔奨奥 奧奬奯奢奡奬 奣奯奮奴奥奸奴 奩女 奴奨奥 奴奴奟奣奴奸奴 夜奥奬奤央

奃奴奸奴 奭奡奰女 奰奯女女奩奢奬她 奡奭奢奩奧奵奯奵女 奮奡奭奥女 奴奯 奴奨奥奩奲 奲奥奦奥奲奥奮奴女央

6.13.9 Idris/ElabDecls.hs

奔奨奩女 奩女 奷奨奥奲奥 奴奨奥 奡奣奴奵奡奬 奥奬奡奢奯奲奡奴奩奯奮 奦奲奯奭 奐奔奥奲奭 奴奯 奔奔 奨奡奰奰奥奮女央
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6.13.10 Idris/ElabTerm.hs

奢奵奩奬奤 奩女 奴奨奥 奦奵奮奣奴奩奯奮 奴奨奡奴 奣奲奥奡奴奥女 奡 奒奡奷央 奁奬奬 奴奨奥 “奪奵奮奫” 奩女 奴奯 奤奥奡奬 奷奩奴奨 奴奨奩奮奧女 奬奩奫奥 奭奥奴奡奶奡奲女 奡奮奤 女奯
奦奯奲奴奨央 奉奴 奨奡女 奴奯 奲奥奭奥奭奢奥奲 奷奨奡奴 奮奡奭奥女 奡奲奥 女奴奩奬奬 奴奯 奢奥 奤奥夜奮奥奤夬 奡奮奤 奩奴 奤奯奥女奮’奴 她奥奴 奫奮奯奷 奴奨奥 奴她奰奥 夨夜奬奬奥奤
奩奮 奢她 奵奮奩夜奣奡奩奴奯奮 奬奡奴奥奲天央 奁奬女奯 奣奡女奥 奥奸奰奲奥女女奩奯奮女 奨奡奶奥 奴奯 奴奵奲奮 奩奮奴奯 奴奯奰夭奬奥奶奥奬 奦奵奮奣奴奩奯奮女央

奲奥女奯奬奶奥奔奃 奩女 奴她奰奥 奣奬奡女女 奲奥女奯奬奵奴奩奯奮央

6.14 Core Language Features

• 奆奵奬奬夭女奰奥奣奴奲奵奭 奤奥奰奥奮奤奥奮奴 奴她奰奥女

• 奓奴奲奩奣奴 奥奶奡奬奵奡奴奩奯奮 夨奰奬奵女 Lazy : Type -> Type 奴她奰奥 奣奯奮女奴奲奵奣奴奯奲 奦奯奲 奥奸奰奬奩奣奩奴 奬奡奺奩奮奥女女天

• 奌奡奭奢奤奡夬 奐奩 夨奦奯奲奡奬奬天夬 奌奥奴 奢奩奮奤奩奮奧女

• 奐奡奴奴奥奲奮 奭奡奴奣奨奩奮奧 奤奥夜奮奩奴奩奯奮女

• 奅奸奰奯奲奴 奭奯奤奩夜奥奲女 public夬 abstract夬 private

• 奆奵奮奣奴奩奯奮 奯奰奴奩奯奮女 partial夬 total

• where 奣奬奡奵女奥女

• “奭奡奧奩奣 奷奩奴奨”

• 奉奭奰奬奩奣奩奴 奡奲奧奵奭奥奮奴女 夨奩奮 奴奯奰 奬奥奶奥奬 奴她奰奥女天

• “奂奯奵奮奤” 奩奭奰奬奩奣奩奴 奡奲奧奵奭奥奮奴女 {n : Nat} -> {a : Type} -> Vect n a

• “奕奮奢奯奵奮奤” 奩奭奰奬奩奣奩奴 奡奲奧奵奭奥奮奴女 — Vect n a 奩女 奥奱奵奩奶奡奬奥奮奴 奴奯 奴奨奥 奡奢奯奶奥 奩奮 奡 奴她奰奥夬 n 奡奮奤 a 奡奲奥
奩奭奰奬奩奣奩奴奬她 奢奯奵奮奤央 奔奨奩女 奡奰奰奬奩奥女 奴奯 奮奡奭奥女 奢奥奧奩奮奮奩奮奧 奷奩奴奨 奡 奬奯奷奥奲 奣奡女奥 奬奥奴奴奥奲 奩奮 奡奮 奡奲奧奵奭奥奮奴 奰奯女奩奴奩奯奮央

• ‘奔奡奣奴奩奣’ 奩奭奰奬奩奣奩奴 奡奲奧奵奭奥奮奴女夬 奷奨奩奣奨 奡奲奥 女奯奬奶奥奤 奢她 奲奵奮奮奩奮奧 奡 奴奡奣奴奩奣 女奣奲奩奰奴 奯奲 奧奩奶奩奮奧 奡 奤奥奦奡奵奬奴
奡奲奧奵奭奥奮奴夬 奲奡奴奨奥奲 奴奨奡奮 奢她 奵奮奩夜奣奡奴奩奯奮央

• 奕奮奩奴 奴她奰奥 ()夬 奥奭奰奴她 奴她奰奥 Void

• 奔奵奰奬奥女 夨奤奥女奵奧奡奲奩奮奧 奴奯 奮奥女奴奥奤 奰奡奩奲女天

• 奄奥奰奥奮奤奥奮奴 奰奡奩奲 女她奮奴奡奸 (x : T ** P x) 夨奴奨奥奲奥 奥奸奩女奴女 奡奮 x 奯奦 奴她奰奥 T 女奵奣奨 奴奨奡奴 P x天

• 奉奮奬奩奮奥 case 奥奸奰奲奥女女奩奯奮女

• 奈奥奴奥奲奯奧奥奮奥奯奵女 奥奱奵奡奬奩奴她

• do 奮奯奴奡奴奩奯奮

• 奉奤奩奯奭 奢奲奡奣奫奥奴女

• 奉奮奴奥奲奦奡奣奥女 夨奬奩奫奥 奴她奰奥 奣奬奡女女奥女天夬 女奵奰奰奯奲奴奩奮奧 奤奥奦奡奵奬奴 奭奥奴奨奯奤女 奡奮奤 奤奥奰奥奮奤奥奮奣奩奥女 奢奥奴奷奥奥奮 奭奥奴奨奯奤女

• rewrite 奰奲奦 in 奥奸奰奲

• 奍奥奴奡奶奡奲奩奡奢奬奥女

• 奉奮奬奩奮奥 奰奲奯奯奦夯奴奡奣奴奩奣 女奣奲奩奰奴女

• 奉奭奰奬奩奣奩奴 奣奯奥奲奣奩奯奮
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• codata

• 奁奬女奯 Inf : Type -> Type 奴她奰奥 奣奯奮女奴奲奵奣奴奯奲 奦奯奲 奭奩奸奥奤 奤奡奴奡夯奣奯奤奡奴奡央 奉奮 奦奡奣奴 codata 奩女 奩奭奰奬奥夭
奭奥奮奴奥奤 奢她 奰奵奴奴奩奮奧 奲奥奣奵奲女奩奶奥 奡奲奧奵奭奥奮奴女 奵奮奤奥奲 Inf央

• syntax 奲奵奬奥女 奦奯奲 奤奥夜奮奩奮奧 奰奡奴奴奥奲奮 奡奮奤 奴奥奲奭 女她奮奴奡奣奴奩奣 女奵奧奡奲

• 奴奨奥女奥 奡奲奥 奵女奥奤 奩奮 奴奨奥 女奴奡奮奤奡奲奤 奬奩奢奲奡奲她 奴奯 奤奥夜奮奥 if ... then ... else 奥奸奰奲奥女女奩奯奮女 奡奮奤 奡奮 奁奧奤奡夭
女奴她奬奥 奰奲奥奯奲奤奥奲 奲奥奡女奯奮奩奮奧 女她奮奴奡奸央

• 奕奮奩奱奵奥奮奥女女 奴她奰奩奮奧 奵女奩奮奧 奴奨奥 UniqueType 奵奮奩奶奥奲女奥央

• 奐奡奲奴奩奡奬 奥奶奡奬奵奡奴奩奯奮 奢她 %static 奡奲奧奵奭奥奮奴 奡奮奮奯奴奡奴奩奯奮女央

• 奅奲奲奯奲 奭奥女女奡奧奥 奲奥夝奥奣奴奩奯奮

• 奅奬奩奭奩奮奡奴奯奲女

• 奌奡奢奥奬 奴她奰奥女 'name

• %logging n

• %unifyLog

6.15 Language Extensions

6.15.1 Type Providers

奉奤奲奩女 奴她奰奥 奰奲奯奶奩奤奥奲女 奡奲奥 奡 奷奡她 奴奯 奧奥奴 奴奨奥 奴她奰奥 女她女奴奥奭 奴奯 奲奥夝奥奣奴 奯奢女奥奲奶奡奴奩奯奮女 奡奢奯奵奴 奴奨奥 奷奯奲奬奤 奯奵奴女奩奤奥 奯奦
奉奤奲奩女央 奓奩奭奩奬奡奲奬她 奴奯 奆夣 奴她奰奥 奰奲奯奶奩奤奥奲女夬 奴奨奥她 奣奡奵女奥 奥夛奥奣奴奦奵奬 奣奯奭奰奵奴奡奴奩奯奮女 奴奯 奲奵奮 奤奵奲奩奮奧 奴她奰奥 奣奨奥奣奫奩奮奧夬
奲奥奴奵奲奮奩奮奧 奩奮奦奯奲奭奡奴奩奯奮 奴奨奡奴 奴奨奥 奴她奰奥 奣奨奥奣奫奥奲 奣奡奮 奵女奥 奷奨奥奮 奣奨奥奣奫奩奮奧 奴奨奥 奲奥女奴 奯奦 奴奨奥 奰奲奯奧奲奡奭央 套奨奩奬奥
奆夣 奴她奰奥 奰奲奯奶奩奤奥奲女 奡奲奥 奢奡女奥奤 奯奮 奣奯奤奥 奧奥奮奥奲奡奴奩奯奮夬 奉奤奲奩女 奴她奰奥 奰奲奯奶奩奤奥奲女 奵女奥 奯奮奬她 奴奨奥 奯奲奤奩奮奡奲她 奥奸奥奣奵奴奩奯奮
女奥奭奡奮奴奩奣女 奯奦 奉奤奲奩女 奴奯 奧奥奮奥奲奡奴奥 奴奨奥 奩奮奦奯奲奭奡奴奩奯奮央

奁 奴她奰奥 奰奲奯奶奩奤奥奲 奩女 女奩奭奰奬她 奡 奴奥奲奭 奯奦 奴她奰奥 IO (Provider t)夬 奷奨奥奲奥 Provider 奩女 奡 奤奡奴奡 奴她奰奥 奷奩奴奨 奣奯奮夭
女奴奲奵奣奴奯奲女 奦奯奲 奡 女奵奣奣奥女女奦奵奬 奲奥女奵奬奴 奡奮奤 奡奮 奥奲奲奯奲央 奔奨奥 奴她奰奥 t 奣奡奮 奢奥 奥奩奴奨奥奲 Type 夨奴奨奥 奴她奰奥 奯奦 奴她奰奥女天 奯奲 奡
奣奯奮奣奲奥奴奥 奴她奰奥央 奔奨奥奮夬 奡 奴她奰奥 奰奲奯奶奩奤奥奲 p 奩女 奩奮奶奯奫奥奤 奵女奩奮奧 奴奨奥 女她奮奴奡奸 %provide (x : t) with p央 套奨奥奮
奴奨奥 奴她奰奥 奣奨奥奣奫奥奲 奥奮奣奯奵奮奴奥奲女 奴奨奩女 奬奩奮奥夬 奴奨奥 奉奏 奡奣奴奩奯奮 p 奩女 奥奸奥奣奵奴奥奤央 奔奨奥奮夬 奴奨奥 奲奥女奵奬奴奩奮奧 奴奥奲奭 奩女 奥奸奴奲奡奣奴奥奤
奦奲奯奭 奴奨奥 奉奏 奭奯奮奡奤央 奉奦 奩奴 奩女 Provide y 奦奯奲 女奯奭奥 y : t夬 奴奨奥奮 x 奩女 奢奯奵奮奤 奴奯 y 奦奯奲 奴奨奥 奲奥奭奡奩奮奤奥奲 奯奦
奴她奰奥奣奨奥奣奫奩奮奧 奡奮奤 奩奮 奴奨奥 奣奯奭奰奩奬奥奤 奣奯奤奥央 奉奦 奥奸奥奣奵奴奩奯奮 奦奡奩奬女夬 奡 奧奥奮奥奲奩奣 奥奲奲奯奲 奩女 奲奥奰奯奲奴奥奤 奡奮奤 奴她奰奥 奣奨奥奣奫奩奮奧
奴奥奲奭奩奮奡奴奥女央 奉奦 奴奨奥 奲奥女奵奬奴奩奮奧 奴奥奲奭 奩女 Error e 奦奯奲 女奯奭奥 女奴奲奩奮奧 e夬 奴奨奥奮 奴她奰奥 奣奨奥奣奫奩奮奧 奦奡奩奬女 奡奮奤 奴奨奥 奥奲奲奯奲 e
奩女 奲奥奰奯奲奴奥奤 奴奯 奴奨奥 奵女奥奲央

奅奸奡奭奰奬奥 奉奤奲奩女 奴她奰奥 奰奲奯奶奩奤奥奲女 奣奡奮 奢奥 女奥奥奮 奡奴 奴奨奩女 奲奥奰奯女奩奴奯奲她央 奍奯奲奥 奤奥奴奡奩奬奥奤 奤奥女奣奲奩奰奴奩奯奮女 奡奲奥 奡奶奡奩奬奡奢奬奥 奩奮
奄奡奶奩奤 奃奨奲奩女奴奩奡奮女奥奮’女 套奇奐 ‘失夳 奰奡奰奥奲 奡奮奤 奍央奓奣央 奴奨奥女奩女央

6.16 Elaborator Reflection

奔奨奥 奉奤奲奩女 奥奬奡奢奯奲奡奴奯奲 奩女 奲奥女奰奯奮女奩奢奬奥 奦奯奲 奣奯奮奶奥奲奴奩奮奧 奨奩奧奨夭奬奥奶奥奬 奉奤奲奩女 奣奯奤奥 奩奮奴奯 奴奨奥 奣奯奲奥 奬奡奮奧奵奡奧奥央 奉奴 奩女
奩奭奰奬奥奭奥奮奴奥奤 奡女 奡 奫奩奮奤 奯奦 奥奭奢奥奤奤奥奤 奴奡奣奴奩奣 奬奡奮奧奵奡奧奥 奩奮 奈奡女奫奥奬奬夬 奷奨奥奲奥 奴奡奣奴奩奣 女奣奲奩奰奴女 奡奲奥 奷奲奩奴奴奥奮 奩奮 奡奮
elaboration monad 奴奨奡奴 奰奲奯奶奩奤奥女 奥奲奲奯奲 奨奡奮奤奬奩奮奧 奡奮奤 奡 奰奲奯奯奦 女奴奡奴奥央 奆奯奲 奤奥奴奡奩奬女夬 女奥奥 奅奤奷奩奮 奂奲奡奤她’女 夲夰失夳
奰奡奰奥奲 奩奮 奴奨奥 奊奯奵奲奮奡奬 奯奦 奆奵奮奣奴奩奯奮奡奬 奐奲奯奧奲奡奭奭奩奮奧央

奅奬奡奢奯奲奡奴奯奲 奲奥夝奥奣奴奩奯奮 奭奡奫奥女 奴奨奥 奥奬奡奢奯奲奡奴奩奯奮 奴她奰奥 奡女 奷奥奬奬 奡女 奡 女奥奬奥奣奴奩奯奮 奯奦 奩奴女 奴奡奣奴奩奣女 奡奶奡奩奬奡奢奬奥 奴奯 奉奤奲奩女
奣奯奤奥央 奔奨奩女 奭奥奡奮女 奴奨奡奴 奭奥奴奡奰奲奯奧奲奡奭女 奷奲奩奴奴奥奮 奩奮 奉奤奲奩女 奣奡奮 奨奡奶奥 奣奯奭奰奬奥奴奥 奣奯奮奴奲奯奬 奯奶奥奲 奴奨奥 奥奬奡奢奯奲奡奴奩奯奮

6.15. Language Extensions 199

https://github.com/idris-lang/Idris-dev/wiki/Uniqueness-Types
https://github.com/idris-lang/Idris-dev/wiki/Static-Arguments-and-Partial-Evaluation
http://msdn.microsoft.com/en-us/library/vstudio/hh156509.aspx
https://github.com/david-christiansen/idris-type-providers
http://dx.doi.org/10.1145/2502488.2502495
http://itu.dk/people/drc/david-christiansen-thesis.pdf
https://eb.host.cs.st-andrews.ac.uk/drafts/impldtp.pdf
https://eb.host.cs.st-andrews.ac.uk/drafts/impldtp.pdf
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奰奲奯奣奥女女夬 奧奥奮奥奲奡奴奩奮奧 奡奲奢奩奴奲奡奲她 奣奯奤奥夬 奡奮奤 奴奨奥她 奨奡奶奥 奡奣奣奥女女 奴奯 奡奬奬 奯奦 奴奨奥 奦奡奣奩奬奩奴奩奥女 奡奶奡奩奬奡奢奬奥 奩奮 奴奨奥 奥奬奡奢奯奲奡奴奯奲夬
女奵奣奨 奡女 奨奩奧奨奥奲夭奯奲奤奥奲 奵奮奩夜奣奡奴奩奯奮夬 奴她奰奥 奣奨奥奣奫奩奮奧夬 奡奮奤 奥奭奩奴奴奩奮奧 奡奵奸奩奬奩奡奲她 奤奥夜奮奩奴奩奯奮女央

6.16.1 The Elaborator State

奔奨奥 奥奬奡奢奯奲奡奴奯奲 女奴奡奴奥 奣奯奮奴奡奩奮女 奩奮奦奯奲奭奡奴奩奯奮 奡奢奯奵奴 奴奨奥 奯奮奧奯奩奮奧 奥奬奡奢奯奲奡奴奩奯奮 奰奲奯奣奥女女央 奉奮 奰奡奲奴奩奣奵奬奡奲夬 奩奴 奣奯奮夭
奴奡奩奮女 奡 goal type夬 奷奨奩奣奨 奩女 奴奯 奢奥 夜奬奬奥奤 奢她 奡奮 奵奮奤奥奲夭奣奯奮女奴奲奵奣奴奩奯奮 proof term央 奔奨奥 奰奲奯奯奦 奴奥奲奭 奣奡奮 奣奯奮奴奡奩奮
holes夬 奥奡奣奨 奯奦 奷奨奩奣奨 奨奡女 奡 女奣奯奰奥 奩奮 奷奨奩奣奨 奩奴 奩女 奶奡奬奩奤 奡奮奤 奡 奴她奰奥央 奓奯奭奥 奨奯奬奥女 奭奡她 奡奤奤奩奴奩奯奮奡奬奬她 奣奯奮奴奡奩奮
guesses夬 奷奨奩奣奨 奣奡奮 奢奥 女奵奢女奴奩奴奵奴奥奤 奩奮 奴奨奥 女奣奯奰奥 奯奦 奴奨奥 奨奯奬奥央 奔奨奥 奨奯奬奥女 奡奲奥 奴奲奡奣奫奥奤 奩奮 奡 hole queue夬 奡奮奤
奯奮奥 奯奦 奴奨奥奭 奩女 focused央 奉奮 奡奤奤奩奴奩奯奮 奴奯 奴奨奥 奧奯奡奬 奴她奰奥夬 奰奲奯奯奦 奴奥奲奭夬 奡奮奤 奨奯奬奥女夬 奴奨奥 奥奬奡奢奯奲奡奴奯奲 女奴奡奴奥 奣奯奮奴奡奩奮女
奡 奣奯奬奬奥奣奴奩奯奮 奯奦 奵奮女奯奬奶奥奤 奵奮奩夜奣奡奴奩奯奮 奰奲奯奢奬奥奭女 奴奨奡奴 奣奡奮 奡夛奥奣奴 奥奬奡奢奯奲奡奴奩奯奮央

奔奨奥 奥奬奡奢奯奲奡奴奯奲 女奴奡奴奥 奩女 奮奯奴 奤奩奲奥奣奴奬她 奡奶奡奩奬奡奢奬奥 奴奯 奉奤奲奩女 奰奲奯奧奲奡奭女央 奉奮女奴奥奡奤夬 奩奴 奩女 奭奯奤奩夜奥奤 奴奨奲奯奵奧奨 奴奨奥 奵女奥
奯奦 tactics夬 奷奨奩奣奨 奡奲奥 奯奰奥奲奡奴奩奯奮女 奴奨奡奴 奡夛奥奣奴 奴奨奥 奥奬奡奢奯奲奡奴奯奲 女奴奡奴奥央 奁 奴奡奣奴奩奣 奴奨奡奴 奲奥奴奵奲奮女 奡 奶奡奬奵奥 奯奦 奴她奰奥 a夬
奰奯奴奥奮奴奩奡奬奬她 奭奯奤奩奦她奩奮奧 奴奨奥 奥奬奡奢奯奲奡奴奯奲 女奴奡奴奥夬 奨奡女 奴她奰奥 Elab a央 奔奨奥 奤奥奦奡奵奬奴 奴奡奣奴奩奣女 奡奲奥 奡奬奬 奩奮 奴奨奥 奮奡奭奥女奰奡奣奥
Language.Reflection.Elab.Tactics央

6.16.2 Running Elaborator Scripts

奏奮 奴奨奥奩奲 奯奷奮夬 奴奡奣奴奩奣女 奨奡奶奥 奮奯 奥夛奥奣奴央 奔奨奥 奭奥奴奡夭奯奰奥奲奡奴奩奯奮 %runElab script 奲奵奮女 script 奩奮 奴奨奥 奣奵奲奲奥奮奴
奥奬奡奢奯奲奡奴奩奯奮 奣奯奮奴奥奸奴央 奂奥奦奯奲奥 她奯奵 奣奡奮 奵女奥 %runElab夬 她奯奵 奷奩奬奬 奨奡奶奥 奴奯 奥奮奡奢奬奥 奴奨奥 奬奡奮奧奵奡奧奥 奥奸奴奥奮女奩奯奮
奢她 奡奤奤奩奮奧 %language ElabReflection 奩奮 她奯奵奲 夜奬奥 夨奯奲 奢她 奰奡女女奩奮奧 -X ElabReflection 奴奯 奴奨奥 idris
奥奸奥奣奵奴奡奢奬奥 奦奲奯奭 她奯奵奲 奣奯奭奭奡奮奤 奬奩奮奥天央 奆奯奲 奥奸奡奭奰奬奥夬 奴奨奥 奦奯奬奬奯奷奩奮奧 女奣奲奩奰奴 奣奯奮女奴奲奵奣奴女 奴奨奥 奩奤奥奮奴奩奴她 奦奵奮奣奴奩奯奮
奡奴 奴她奰奥 Nat夺

idNat : Nat -> Nat
idNat = %runElab (do intro `{{x}}

fill (Var `{{x}})
solve)

奏奮 奴奨奥 奲奩奧奨奴夭奨奡奮奤 女奩奤奥夬 奴奨奥 奉奤奲奩女 奥奬奡奢奯奲奡奴奯奲 奨奡女 奴奨奥 奧奯奡奬 Nat -> Nat央 套奨奥奮 奩奴 奥奮奣奯奵奮奴奥奲女 奴奨奥 %runElab
奤奩奲奥奣奴奩奶奥夬 奩奴 奦奵奬夜奬奬女 奴奨奩女 奧奯奡奬 奢她 奲奵奮奮奩奮奧 奴奨奥 奰奲奯奶奩奤奥奤 女奣奲奩奰奴央 奔奨奥 夜奲女奴 奴奡奣奴奩奣夬 intro夬 奣奯奮女奴奲奵奣奴女 奡 奬奡奭奢奤奡
奴奨奡奴 奢奩奮奤女 奴奨奥 奮奡奭奥 x央 奔奨奥 奮奡奭奥 奡奲奧奵奭奥奮奴 奩女 奯奰奴奩奯奮奡奬 奢奥奣奡奵女奥 奡 奤奥奦奡奵奬奴 奮奡奭奥 奣奡奮 奢奥 奴奡奫奥奮 奦奲奯奭 奴奨奥
奦奵奮奣奴奩奯奮 奴她奰奥央 奎奯奷夬 奴奨奥 奰奲奯奯奦 奴奥奲奭 奩女 奯奦 奴奨奥 奦奯奲奭 \x : Nat => {hole}央 奔奨奥 女奥奣奯奮奤 奴奡奣奴奩奣夬 fill夬 夜奬奬女
奴奨奩女 奨奯奬奥 奷奩奴奨 奡 奧奵奥女女夬 奧奩奶奩奮奧 奴奨奥 奴奥奲奭 \x : Nat => {hole≈x}央 奆奩奮奡奬奬她夬 奴奨奥 solve 奴奡奣奴奩奣 奩奮女奴奡奮奴奩奡奴奥女
奴奨奥 奧奵奥女女夬 奧奩奶奩奮奧 奴奨奥 奲奥女奵奬奴 \x : Nat => x央

奂奥奣奡奵女奥 奥奬奡奢奯奲奡奴奯奲 女奣奲奩奰奴女 奡奲奥 奯奲奤奩奮奡奲她 奉奤奲奩女 奥奸奰奲奥女女奩奯奮女夬 奩奴 奩女 奡奬女奯 奰奯女女奩奢奬奥 奴奯 奵女奥 奴奨奥奭 奩奮 奭奵奬奴奩奰奬奥
奣奯奮奴奥奸奴女央 奎奯奴奥 奴奨奡奴 奴奨奥奲奥 奩女 奮奯奴奨奩奮奧 Nat夭女奰奥奣奩夜奣 奡奢奯奵奴 奴奨奥 奡奢奯奶奥 女奣奲奩奰奴央 套奥 奣奡奮 奧奥奮奥奲奡奴奥 奩奤奥奮奴奩奴她
奦奵奮奣奴奩奯奮女 奡奴 奡奮她 奣奯奮奣奲奥奴奥 奴她奰奥 奵女奩奮奧 奴奨奥 女奡奭奥 女奣奲奩奰奴夺

mkId : Elab ()
mkId = do intro `{{x}}

fill (Var `{{x}})
solve

idNat : Nat -> Nat
idNat = %runElab mkId

idUnit : () -> ()
idUnit = %runElab mkId

idString : String -> String
idString = %runElab mkId

6.16. Elaborator Reflection 200
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6.16.3 Interactively Building Elab Scripts

奙奯奵 奣奡奮 奢奵奩奬奤 奡奮 Elab 女奣奲奩奰奴 奩奮奴奥奲奡奣奴奩奶奥奬她 奡奴 奴奨奥 奒奅奐奌央 奕女奥 奴奨奥 奣奯奭奭奡奮奤 :metavars夬 奯奲 :m 奦奯奲 女奨奯奲奴夬
奴奯 奬奩女奴 奴奨奥 奡奶奡奩奬奡奢奬奥 奨奯奬奥女央 奔奨奥奮夬 奩女女奵奥 奴奨奥 :elab <hole> 奣奯奭奭奡奮奤 奡奴 奴奨奥 奒奅奐奌 奴奯 奥奮奴奥奲 奴奨奥 奥奬奡奢奯奲奡奴奩奯奮
女奨奥奬奬央

奁奴 奴奨奥 女奨奥奬奬夬 她奯奵 奣奡奮 奥奮奴奥奲 奰奲奯奯奦 奴奡奣奴奩奣女 奴奯 奡奬奴奥奲 奴奨奥 奰奲奯奯奦 女奴奡奴奥央 奙奯奵 奣奡奮 奶奩奥奷 奴奨奥 女她女奴奥奭夭奰奲奯奶奩奤奥奤
奴奡奣奴奩奣女 奰奲奩奯奲 奴奯 奥奮奴奥奲奩奮奧 奴奨奥 女奨奥奬奬 奢她 奩女女奵奩奮奧 奴奨奥 奒奅奐奌 奣奯奭奭奡奮奤 :browse Language.Reflection.Elab.
Tactics央 套奨奥奮 她奯奵 奨奡奶奥 奤奩女奣奨奡奲奧奥奤 奡奬奬 奧奯奡奬女夬 她奯奵 奣奡奮 奣奯奭奰奬奥奴奥 奴奨奥 奰奲奯奯奦 奵女奩奮奧 奴奨奥 :qed 奣奯奭奭奡奮奤 奡奮奤
奲奥奣奥奩奶奥 奩奮 奲奥奴奵奲奮 奡奮 奥奬奡奢奯奲奡奴奩奯奮 女奣奲奩奰奴 奴奨奡奴 夜奬奬女 奴奨奥 奨奯奬奥央

奔奨奥 奩奮奴奥奲奡奣奴奩奶奥 奥奬奡奢奯奲奡奴奩奯奮 女奨奥奬奬 奡奣奣奥奰奴女 奡 奬奩奭奩奴奥奤 奮奵奭奢奥奲 奯奦 奣奯奭奭奡奮奤女夬 奩奮奣奬奵奤奩奮奧 奡 女奵奢女奥奴 奯奦 奴奨奥
奣奯奭奭奡奮奤女 奵奮奤奥奲女奴奯奯奤 奢她 奴奨奥 奮奯奲奭奡奬 奉奤奲奩女 奒奅奐奌 奡女 奷奥奬奬 奡女 女奯奭奥 奥奬奡奢奯奲奡奴奩奯奮夭女奰奥奣奩夜奣 奣奯奭奭奡奮奤女央 奉奴
奡奬女奯 女奵奰奰奯奲奴女 奴奨奥 do夭女她奮奴奡奸夬 奭奥奡奮奩奮奧 她奯奵 奣奡奮 奷奲奩奴奥 res <- command 奴奯 奢奩奮奤 奴奨奥 奲奥女奵奬奴 奯奦 command 奴奯
奶奡奲奩奡奢奬奥 res央

奇奥奮奥奲奡奬夭奰奵奲奰奯女奥 奣奯奭奭奡奮奤女夺

• :eval <EXPR>夬 奯奲 :e <EXPR> 奦奯奲 女奨奯奲奴夬 奥奶奡奬奵奡奴奥女 奴奨奥 奰奲奯奶奩奤奥奤 奥奸奰奲奥女女奩奯奮 奡奮奤 奰奲奩奮奴女 奴奨奥 奲奥女奵奬奴央

• :type <EXPR>夬 奯奲 :t <EXPR> 奦奯奲 女奨奯奲奴夬 奰奲奩奮奴女 奴奨奥 奰奲奯奶奩奤奥奤 奥奸奰奲奥女女奩奯奮 奴奯奧奥奴奨奥奲 奷奩奴奨 奩奴女 奴她奰奥央

• :search <TYPE> 女奥奡奲奣奨奥女 奦奯奲 奤奥夜奮奩奴奩奯奮女 奨奡奶奩奮奧 奴奨奥 奰奲奯奶奩奤奥奤 奴她奰奥央

• :doc <NAME> 女奥奡奲奣奨奥女 奦奯奲 奤奥夜奮奩奴奩奯奮女 奷奩奴奨 奴奨奥 奰奲奯奶奩奤奥奤 奮奡奭奥 奡奮奤 奰奲奩奮奴女 奴奨奥奩奲 奤奯奣奵奭奥奮奴奡奴奩奯奮央

奃奯奭奭奡奮奤女 奦奯奲 奶奩奥奷奩奮奧 奴奨奥 奰奲奯奯奦 女奴奡奴奥夺

• :state 奤奩女奰奬奡她女 奴奨奥 奣奵奲奲奥奮奴 女奴奡奴奥 奯奦 奴奨奥 奴奥奲奭 奢奥奩奮奧 奣奯奮女奴奲奵奣奴奥奤央 奉奴 奬奩女奴女 奢奯奴奨 奯奴奨奥奲 奧奯奡奬女 奡奮奤 奴奨奥
奣奵奲奲奥奮奴 奧奯奡奬央

• :term 奤奩女奰奬奡她女 奴奨奥 奣奵奲奲奥奮奴 奰奲奯奯奦 奴奥奲奭 奡女 奷奥奬奬 奡女 奩奴女 她奥奴夭奴奯夭奢奥夭夜奬奬奥奤 奨奯奬奥女央

奃奯奭奭奡奮奤女 奦奯奲 奭奡奮奩奰奵奬奡奴奩奮奧 奴奨奥 奰奲奯奯奦 女奴奡奴奥夺

• :undo 奵奮奤奯奥女 奴奨奥 奥夛奥奣奴女 奯奦 奴奨奥 奬奡女奴 奴奡奣奴奩奣央

• :abandon 奧奩奶奥女 奵奰 奯奮 奰奲奯奶奩奮奧 奴奨奥 奣奵奲奲奥奮奴 奬奥奭奭奡 奡奮奤 奱奵奩奴女 奴奨奥 奥奬奡奢奯奲奡奴奩奯奮 女奨奥奬奬央

• :qed 夜奮奩女奨奥女 奴奨奥 女奣奲奩奰奴 奡奮奤 奥奸奩奴女 奴奨奥 奥奬奡奢奯奲奡奴奩奯奮 女奨奥奬奬央 奔奨奥 女奨奥奬奬 奷奩奬奬 奯奮奬她 奡奣奣奥奰奴 奴奨奩女 奣奯奭奭奡奮奤
奯奮奣奥 奩奴 奲奥奰奯奲奴女夬 “奎奯 奭奯奲奥 奧奯奡奬女央” 奏奮 奥奸奩奴夬 奩奴 奷奩奬奬 奰奲奩奮奴 奯奵奴 奴奨奥 夜奮奩女奨奥奤 奥奬奡奢奯奲奡奴奩奯奮 女奣奲奩奰奴 奦奯奲 她奯奵
奴奯 奣奯奰她 奩奮奴奯 她奯奵奲 奰奲奯奧奲奡奭央

6.16.4 Failure

奓奯奭奥 奴奡奣奴奩奣女 奭奡她 fail央 奆奯奲 奥奸奡奭奰奬奥夬 intro 奷奩奬奬 奦奡奩奬 奩奦 奴奨奥 奦奯奣奵女奥奤 奨奯奬奥 奤奯奥女 奮奯奴 奨奡奶奥 奡 奦奵奮奣奴奩奯奮 奴她奰奥夬
solve 奷奩奬奬 奦奡奩奬 奩奦 奴奨奥 奣奵奲奲奥奮奴 奨奯奬奥 奤奯奥女 奮奯奴 奣奯奮奴奡奩奮 奡 奧奵奥女女夬 奡奮奤 fill 奷奩奬奬 奦奡奩奬 奩奦 奴奨奥 奴奥奲奭 奴奯 奢奥 夜奬奬奥奤 奩奮
奨奡女 奴奨奥 奷奲奯奮奧 奴她奰奥央 奓奣奲奩奰奴女 奣奡奮 奡奬女奯 奦奡奩奬 奥奸奰奬奩奣奩奴奬她 奵女奩奮奧 奴奨奥 fail 奴奡奣奴奩奣央

奔奯 奡奣奣奯奵奮奴 奦奯奲 奦奡奩奬奵奲奥夬 奴奨奥奲奥 奩女 奡奮 Alternative 奩奭奰奬奥奭奥奮奴奡奴奩奯奮 奦奯奲 Elab央 奔奨奥 <|> 奯奰奥奲奡奴奯奲 夜奲女奴 奴奲奩奥女
奴奨奥 女奣奲奩奰奴 奴奯 奩奴女 奬奥奦奴央 奉奦 奴奨奡奴 女奣奲奩奰奴 奦奡奩奬女夬 奡奮她 奣奨奡奮奧奥女 奴奨奡奴 奩奴 奭奡奤奥 奴奯 奴奨奥 女奴奡奴奥 奡奲奥 奵奮奤奯奮奥 奡奮奤 奴奨奥 奲奩奧奨奴
奡奲奧奵奭奥奮奴 奩女 奥奸奥奣奵奴奥奤央 奉奦 奴奨奥 夜奲女奴 奡奲奧奵奭奥奮奴 女奵奣奣奥奥奤女夬 奴奨奥奮 奴奨奥 女奥奣奯奮奤 奡奲奧奵奭奥奮奴 奩女 奮奯奴 奥奸奥奣奵奴奥奤央

6.16.5 Querying the Elaboration State

Elab 奩奮奣奬奵奤奥女 奯奰奥奲奡奴奩奯奮女 奴奯 奱奵奥奲她 奴奨奥 奥奬奡奢奯奲奡奴奩奯奮 女奴奡奴奥夬 奡奬奬奯奷奩奮奧 女奣奲奩奰奴女 奴奯 奵女奥 奩奮奦奯奲奭奡奴奩奯奮 奡奢奯奵奴 奴奨奥奩奲
奥奮奶奩奲奯奮奭奥奮奴 奴奯 女奴奥奥奲 奴奨奥 奥奬奡奢奯奲奡奴奩奯奮 奰奲奯奣奥女女央 奔奨奥 奯奲奤奩奮奡奲她 奉奤奲奩女 奢奩奮奤 女她奮奴奡奸 奣奡奮 奢奥 奵女奥奤 奴奯 奰奲奯奰奡奧奡奴奥
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奴奨奩女 奩奮奦奯奲奭奡奴奩奯奮央 奆奯奲 奥奸奡奭奰奬奥夬 奡 奴奡奣奴奩奣 奴奨奡奴 女奯奬奶奥女 奴奨奥 奣奵奲奲奥奮奴 奧奯奡奬 奷奨奥奮 奩奴 奩女 奴奨奥 奵奮奩奴 奴她奰奥 奭奩奧奨奴 奬奯奯奫
奬奩奫奥 奴奨奩女夺

triv : Elab ()
triv = do compute

g <- getGoal
case (snd g) of

`(() : Type) => do fill `(() : ())
solve

otherGoal => fail [ TermPart otherGoal
, TextPart "is not trivial"
]

奔奨奥 奴奡奣奴奩奣 compute 奮奯奲奭奡奬奩女奥女 奴奨奥 奴她奰奥 奯奦 奩奴女 奧奯奡奬 奷奩奴奨 奲奥女奰奥奣奴 奴奯 奴奨奥 奣奵奲奲奥奮奴 奣奯奮奴奥奸奴央 套奨奩奬奥 奮奯奴 女奴奲奩奣奴奬她
奮奥奣奥女女奡奲她夬 奴奨奩女 奡奬奬奯奷女 triv 奴奯 奢奥 奵女奥奤 奩奮 奣奯奮奴奥奸奴女 奷奨奥奲奥 奴奨奥 奴奲奩奶奩奡奬奩奴她 奯奦 奴奨奥 奧奯奡奬 奩女 奮奯奴 奩奭奭奥奤奩奡奴奥奬她
奡奰奰奡奲奥奮奴央 奔奨奥奮夬 getGoal 奩女 奵女奥奤夬 奡奮奤 奩奴女 奲奥女奵奬奴 奩女 奢奯奵奮奤 奴奯 g央 奂奥奣奡奵女奥 奩奴 奲奥奴奵奲奮女 奡 奰奡奩奲 奣奯奮女奩女奴奩奮奧 奯奦
奴奨奥 奣奵奲奲奥奮奴 奧奯奡奬’女 奮奡奭奥 奡奮奤 奴她奰奥夬 奷奥 奣奡女奥夭女奰奬奩奴 奯奮 奩奴女 女奥奣奯奮奤 奰奲奯奪奥奣奴奩奯奮央 奉奦 奴奨奥 奧奯奡奬 奴她奰奥 奴奵奲奮女 奯奵奴 奴奯
奨奡奶奥 奢奥奥奮 奴奨奥 奵奮奩奴 奴她奰奥夬 奷奥 夜奬奬 奵女奩奮奧 奴奨奥 奵奮奩奴 奣奯奮女奴奲奵奣奴奯奲 奡奮奤 女奯奬奶奥 奴奨奥 奧奯奡奬央 奏奴奨奥奲奷奩女奥夬 奷奥 奦奡奩奬 奷奩奴奨 奡奮
奥奲奲奯奲 奭奥女女奡奧奥 奩奮奦奯奲奭奩奮奧 奴奨奥 奵女奥奲 奴奨奡奴 奴奨奥 奣奵奲奲奥奮奴 奧奯奡奬 奩女 奮奯奴 奴奲奩奶奩奡奬央

奁奤奤奩奴奩奯奮奡奬奬她夬 奴奨奥 奥奬奡奢奯奲奡奴奩奯奮 女奴奡奴奥 奣奡奮 奢奥 奤奵奭奰奥奤 奩奮奴奯 奡奮 奥奲奲奯奲 奭奥女女奡奧奥 奷奩奴奨 奴奨奥 debug 奴奡奣奴奩奣央 奁
奶奡奲奩奡奮奴夬 debugMessage夬 奡奬奬奯奷女 奡奲奢奩奴奲奡奲她 奭奥女女奡奧奥女 奴奯 奢奥 奩奮奣奬奵奤奥奤 奷奩奴奨 奴奨奥 女奴奡奴奥夬 奡奬奬奯奷奩奮奧 奦奯奲 奡 奫奩奮奤 奯奦
“printf 奤奥奢奵奧奧奩奮奧” 奯奦 奥奬奡奢奯奲奡奴奩奯奮 女奣奲奩奰奴女央 奔奨奥 奭奥女女奡奧奥 奦奯奲奭奡奴 奵女奥奤 奢她 debugMessage 奩女 奴奨奥 女奡奭奥 奦奯奲
奥奲奲奯奲女 奰奲奯奤奵奣奥奤 奢她 奴奨奥 奥奲奲奯奲 奲奥夝奥奣奴奩奯奮 奭奥奣奨奡奮奩女奭夬 奡奬奬奯奷奩奮奧 奴奨奥 奲奥夭奵女奥 奯奦 奴奨奥 奉奤奲奩女 奰奲奥奴奴她夭奰奲奩奮奴奥奲 奷奨奥奮
奲奥奮奤奥奲奩奮奧 奭奥女女奡奧奥女央

6.16.6 Changing the Global Context

Elab 女奣奲奩奰奴女 奣奡奮 奭奯奤奩奦她 奴奨奥 奧奬奯奢奡奬 奣奯奮奴奥奸奴 奤奵奲奩奮奧 奥奸奥奣奵奴奩奯奮央 奊奵女奴 奡女 奴奨奥 奉奤奲奩女 奥奬奡奢奯奲奡奴奯奲 奰奲奯奤奵奣奥女 奡奵奸奩奬夭
奩奡奲她 奤奥夜奮奩奴奩奯奮女 奴奯 奩奭奰奬奥奭奥奮奴 奦奥奡奴奵奲奥女 女奵奣奨 奡女 where夭奢奬奯奣奫女 奡奮奤 case 奥奸奰奲奥女女奩奯奮女夬 奵女奥奲 奥奬奡奢奯奲奡奴奩奯奮 女奣奲奩奰奴女
奭奡她 奮奥奥奤 奴奯 奤奥夜奮奥 奦奵奮奣奴奩奯奮女央 奆奵奲奴奨奥奲奭奯奲奥夬 奴奨奩女 奡奬奬奯奷女 Elab 奲奥夝奥奣奴奩奯奮 奴奯 奢奥 奵女奥奤 奴奯 奩奭奰奬奥奭奥奮奴 奦奥奡奴奵奲奥女
女奵奣奨 奡女 奩奮奴奥奲奦奡奣奥 奤奥奲奩奶奩奮奧央 奔奨奥 奯奰奥奲奡奴奩奯奮女 declareType夬 defineFunction夬 奡奮奤 addImplementation
奡奬奬奯奷 Elab 女奣奲奩奰奴女 奴奯 奭奯奤奩奦她 奴奨奥 奧奬奯奢奡奬 奣奯奮奴奥奸奴央

6.16.7 Using Idris’’’s Features

奔奨奥 奉奤奲奩女 奣奯奭奰奩奬奥奲 奨奡女 奡 奮奵奭奢奥奲 奯奦 奷奡她女 奴奯 奡奵奴奯奭奡奴奥 奴奨奥 奣奯奮女奴奲奵奣奴奩奯奮 奯奦 奴奥奲奭女央 奏奮 奩奴女 奯奷奮夬 奴奨奥 Elab
女奴奡奴奥 奡奮奤 奩奴女 奩奮奴奥奲奡奣奴奩奯奮女 奷奩奴奨 奴奨奥 奵奮奩夜奥奲 奡奬奬奯奷 奩奭奰奬奩奣奩奴女 奴奯 奢奥 女奯奬奶奥奤 奵女奩奮奧 奵奮奩夜奣奡奴奩奯奮央 奁奤奤奩奴奩奯奮奡奬
奯奰奥奲奡奴奩奯奮女 奵女奥 奦奵奲奴奨奥奲 奦奥奡奴奵奲奥女 奯奦 奉奤奲奩女央 奉奮 奰奡奲奴奩奣奵奬奡奲夬 resolveTC 女奯奬奶奥女 奴奨奥 奣奵奲奲奥奮奴 奧奯奡奬 奵女奩奮奧 奩奮奴奥奲奦奡奣奥
奲奥女奯奬奵奴奩奯奮夬 search 奩奮奶奯奫奥女 奴奨奥 奰奲奯奯奦 女奥奡奲奣奨 奭奥奣奨奡奮奩女奭夬 奡奮奤 sourceLocation 夜奮奤女 奴奨奥 奣奯奮奴奥奸奴 奩奮 奴奨奥
奯奲奩奧奩奮奡奬 夜奬奥 奡奴 奷奨奩奣奨 奴奨奥 奥奬奡奢奯奲奡奴奩奯奮 女奣奲奩奰奴 奩女 奩奮奶奯奫奥奤央

6.16.8 Recursive Elaboration

奔奨奥 奥奬奡奢奯奲奡奴奩奯奮 奭奥奣奨奡奮奩女奭 奣奡奮 奢奥 奩奮奶奯奫奥奤 奲奥奣奵奲女奩奶奥奬她 奵女奩奮奧 奴奨奥 runElab 奴奡奣奴奩奣央 奔奨奩女 奴奡奣奴奩奣 奴奡奫奥女 奡 奧奯奡奬
奴她奰奥 奡奮奤 奡奮 奥奬奡奢奯奲奡奴奩奯奮 女奣奲奩奰奴 奡女 奡奲奧奵奭奥奮奴女 奡奮奤 奲奵奮女 奴奨奥 女奣奲奩奰奴 奩奮 奡 奦奲奥女奨 奬奥奸奩奣奡奬 奥奮奶奩奲奯奮奭奥奮奴 奴奯 奣奲奥奡奴奥
奡奮 奩奮奨奡奢奩奴奡奮奴 奯奦 奴奨奥 奰奲奯奶奩奤奥奤 奧奯奡奬 奴她奰奥央 奔奨奩女 奩女 奰奲奩奭奡奲奩奬她 奵女奥奦奵奬 奦奯奲 奣奯奤奥 奧奥奮奥奲奡奴奩奯奮夬 奰奡奲奴奩奣奵奬奡奲奬她 奦奯奲
奧奥奮奥奲奡奴奩奮奧 奰奡奴奴奥奲奮夭奭奡奴奣奨奩奮奧 奣奬奡奵女奥女夬 奷奨奥奲奥 奶奡奲奩奡奢奬奥 女奣奯奰奥 奮奥奥奤女 奴奯 奢奥 奯奮奥 奴奨奡奴 奩女奮’奴 奴奨奥 奰奲奥女奥奮奴 奬奯奣奡奬
奣奯奮奴奥奸奴央
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6.16.9 Learn More

套奨奩奬奥 奴奨奩女 奤奯奣奵奭奥奮奴奡奴奩奯奮 奩女 女奴奩奬奬 奩奮奣奯奭奰奬奥奴奥夬 奥奬奡奢奯奲奡奴奩奯奮 奲奥夝奥奣奴奩奯奮 奷奯奲奫女 奩奮 奉奤奲奩女 奴奯奤奡她央 奁女 她奯奵 奷奡奩奴
奦奯奲 奴奨奥 奣奯奭奰奬奥奴奩奯奮 奯奦 奴奨奥 奤奯奣奵奭奥奮奴奡奴奩奯奮夬 奴奨奥 奬奩女奴 奯奦 奢奵奩奬奴夭奩奮 奴奡奣奴奩奣女 奣奡奮 奢奥 奯奢奴奡奩奮奥奤 奵女奩奮奧 奴奨奥 :browse
奣奯奭奭奡奮奤 奩奮 奡奮 奉奤奲奩女 奒奅奐奌 奯奲 奴奨奥 奣奯奲奲奥女奰奯奮奤奩奮奧 奦奥奡奴奵奲奥 奩奮 奯奮奥 奯奦 奴奨奥 奧奲奡奰奨奩奣奡奬 奉奄奅 奣奬奩奥奮奴女 奴奯 奥奸奰奬奯奲奥
奴奨奥 Language.Reflection.Elab.Tactics 奮奡奭奥女奰奡奣奥央 奁奬奬 奯奦 奴奨奥 奢奵奩奬奴夭奩奮 奴奡奣奴奩奣女 奣奯奮奴奡奩奮 奤奯奣奵奭奥奮奴奡奴奩奯奮
女奴奲奩奮奧女央

6.17 Type Directed Search :search

奉奤奲奩女’ :search 奣奯奭奭奡奮奤 女奥奡奲奣奨奥女 奦奯奲 奴奥奲奭女 奡奣奣奯奲奤奩奮奧 奴奯 奴奨奥奩奲 奡奰奰奲奯奸奩奭奡奴奥 奴她奰奥 女奩奧奮奡奴奵奲奥 夨奭奵奣奨 奬奩奫奥
奈奯奯奧奬奥 奦奯奲 奈奡女奫奥奬奬天央 奆奯奲 奥奸奡奭奰奬奥夺

Idris> :search e -> List e -> List e
= Prelude.List.(::) : a -> List a -> List a
Cons cell

= Prelude.List.intersperse : a -> List a -> List a
Insert some separator between the elements of a list.

> Prelude.List.delete : Eq a => a -> List a -> List a

< assert_smaller : a -> b -> b
Assert to the totality checker than y is always structurally
smaller than x (which is typically a pattern argument)

< Prelude.Basics.const : a -> b -> a
Constant function. Ignores its second argument.

奔奨奥 奢奥女奴 奲奥女奵奬奴女 奡奲奥 奬奩女奴奥奤 夜奲女奴央 奁女 奷奥 奣奡奮 女奥奥夬 (::) 奡奮奤 intersperse 奡奲奥 奥奸奡奣奴 奭奡奴奣奨奥女夻 奴奨奥 = 女她奭奢奯奬
奴奯 奴奨奥 奬奥奦奴 奯奦 奴奨奯女奥 奲奥女奵奬奴女 奴奥奬奬女 奵女 奴奨奥 奴她奰奥女 奯奦 (::) 奡奮奤 intersperse 奡奲奥 奥夛奥奣奴奩奶奥奬她 奴奨奥 女奡奭奥 奡女 奴奨奥
奴她奰奥 奴奨奡奴 奷奡女 女奥奡奲奣奨奥奤央

奔奨奥 奮奥奸奴 奲奥女奵奬奴 奩女 delete夬 奷奨奯女奥 奴她奰奥 奩女 奭奯奲奥 女奰奥奣奩夜奣 奴奨奡奮 奴奨奥 奴她奰奥 奴奨奡奴 奷奡女 女奥奡奲奣奨奥奤夻 奴奨奡奴’女 奩奮奤奩奣奡奴奥奤
奢她 奴奨奥 > 女她奭奢奯奬央 奉奦 奷奥 奨奡奤 奡 奦奵奮奣奴奩奯奮 奷奩奴奨 奴奨奥 女奩奧奮奡奴奵奲奥 e -> List e -> List e夬 奷奥 奣奯奵奬奤 奨奡奶奥 奧奩奶奥奮
奩奴 奴奨奥 奴她奰奥 Eq a => a -> List a -> List a夬 奢奵奴 奮奯奴 奮奥奣奥女女奡奲奩奬她 奴奨奥 奯奴奨奥奲 奷奡她 奡奲奯奵奮奤央

奔奨奥 夜奮奡奬 奴奷奯 奲奥女奵奬奴女夬 assert_smaller 奡奮奤 const夬 奨奡奶奥 奴她奰奥女 奭奯奲奥 奧奥奮奥奲奡奬 奴奨奡奮 奴奨奥 奴她奰奥 奴奨奡奴 奷奡女
女奥奡奲奣奨奥奤夬 奡奮奤 女奯 奴奨奥她 奨奡奶奥 < 女她奭奢奯奬女 奴奯 奴奨奥奩奲 奬奥奦奴央 奆奯奲 奥奸奡奭奰奬奥夬 e -> List e -> List e 奷奯奵奬奤 奢奥 奡
奶奡奬奩奤 奴她奰奥 奦奯奲 assert_smaller央 奔奨奥 奣奯奲奲奥女奰奯奮奤奥奮奣奥 奦奯奲 const 奩女 奭奯奲奥 奣奯奭奰奬奩奣奡奴奥奤 奴奨奡奮 奡奮她 奯奦 奴奨奥 奦奯奵奲
奰奲奥奶奩奯奵女 奲奥女奵奬奴女央 :search 女奨奯奷女 奴奨奩女 奲奥女奵奬奴 奢奥奣奡奵女奥 奷奥 奣奯奵奬奤 奣奨奡奮奧奥 奴奨奥 奯奲奤奥奲 奯奦 奴奨奥 奡奲奧奵奭奥奮奴女夡 奔奨奡奴
奩女夬 奴奨奥 奦奯奬奬奯奷奩奮奧 奤奥夜奮奩奴奩奯奮 奷奯奵奬奤 奢奥 奬奥奧奡奬夺

f : e -> List e -> List e
f x xs = const xs x

6.17.1 About :search results

夺女奥奡奲奣奨’女 奦奵奮奣奴奩奯奮奡奬奩奴她 奩女 奢奡女奥奤 奯奮 奴奨奥 奮奯奴奩奯奮 奯奦 奴她奰奥 奩女奯奭奯奲奰奨奩女奭央 奉奮奦奯奲奭奡奬奬她夬 奴奷奯 奴她奰奥女 奡奲奥 奩女奯奭奯奲奰奨奩奣
奩奦 奷奥 奣奡奮 奩奤奥奮奴奩奦她 奴奥奲奭女 奯奦 奯奮奥 奴她奰奥 奥奸奡奣奴奬她 奷奩奴奨 奴奥奲奭女 奯奦 奴奨奥 奯奴奨奥奲央 奆奯奲 奥奸奡奭奰奬奥夬 奷奥 奣奡奮 奣奯奮女奩奤奥奲 奴奨奥
奴她奰奥女 Nat -> a -> List a 奡奮奤 a -> Nat -> List a 奴奯 奢奥 奩女奯奭奯奲奰奨奩奣夬 奢奥奣奡奵女奥 奩奦 奷奥 奨奡奶奥 f : Nat
-> a -> List a夬 奴奨奥奮 flip f : a -> Nat -> List a央 奓奩奭奩奬奡奲奬她夬 奩奦 g : a -> Nat -> List a夬 奴奨奥奮
flip g : Nat -> a -> List a央

套奩奴奨 夺女奥奡奲奣奨夬 奷奥 奣奲奥奡奴奥 奡 奰奡奲奴奩奡奬 奯奲奤奥奲 奯奮 奴她奰奥女夻 奴奨奡奴 奩女夬 奧奩奶奥奮 奴奷奯 奴她奰奥女 A 奡奮奤 B夬 奷奥 奭奡她 奣奨奯奯女奥 奴奯 女奡她
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奴奨奡奴 A <= B夬 A >= B夬 奯奲 奢奯奴奨 夨奩奮 奷奨奩奣奨 奣奡女奥 奷奥 女奡她 A == B天夬 奯奲 奮奥奩奴奨奥奲央 奆奯奲 夺女奥奡奲奣奨夬 奷奥 女奡她 奴奨奡奴 A >=
B 奩奦 奡奬奬 奯奦 奴奨奥 奴奥奲奭女 奩奮奨奡奢奩奴奩奮奧 A 奣奯奲奲奥女奰奯奮奤 奴奯 奴奥奲奭女 奯奦 B夬 奢奵奴 奩奴 奮奥奥奤 奮奯奴 奮奥奣奥女女奡奲奩奬她 奢奥 奴奨奥 奣奡女奥 奴奨奡奴
all 奴奨奥 奴奥奲奭女 奯奦 B 奣奯奲奲奥女奰奯奮奤 奴奯 奴奥奲奭女 奯奦 A央 奈奥奲奥’女 奡奮 奥奸奡奭奰奬奥夺

a -> a >= Nat -> Nat

奔奨奥 奬奥奦奴夭奨奡奮奤 奴她奰奥 奨奡女 奪奵女奴 奡 女奩奮奧奬奥 奩奮奨奡奢奩奴奡奮奴夬 id夬 奷奨奩奣奨 奣奯奲奲奥女奰奯奮奤女 奴奯 奴奨奥 奴奥奲奭 id {a = Nat}夬 奷奨奩奣奨
奨奡女 奴奨奥 奲奩奧奨奴夭奨奡奮奤 奴她奰奥央 奈奯奷奥奶奥奲夬 奴奨奥奲奥 奡奲奥 奶奡奲奩奯奵女 奴奥奲奭女 奩奮奨奡奢奩奴奩奮奧 奴奨奥 奲奩奧奨奴夭奨奡奮奤 奴她奰奥 夨女奵奣奨 奡女 S天
奷奨奩奣奨 奣奡奮奮奯奴 奣奯奲奲奥女奰奯奮奤 奷奩奴奨 奴奥奲奭女 奯奦 奴她奰奥 a -> a央

套奥 奣奡奮 奣奯奮女奩奤奥奲 奴奨奥 奰奡奲奴奩奡奬 奯奲奤奥奲 奦奯奲 :search 奴奯 奢奥夬 奩奮 女奯奭奥 女奥奮女奥夬 奩奮奤奵奣奴奩奶奥奬她 奧奥奮奥奲奡奴奥奤 奢她 女奥奶奥奲奡奬
奣奬奡女女奥女 奯奦 “奥奤奩奴女” 奷奨奩奣奨 奡奲奥 奤奥女奣奲奩奢奥奤 奢奥奬奯奷央

Possible edits

奈奥奲奥 奩女 奡 女奩奭奰奬奥 奡奰奰奲奯奸奩奭奡奴奥 奬奩女奴 奯奦 奴奨奥 奥奤奩奴女 奴奨奡奴 奡奲奥 奰奯女女奩奢奬奥 奩奮 :search央 奔奨奥她 奡奲奥 奮奯奴 奥奮奴奩奲奥奬她 奦奯奲奭奡奬夬
奡奮奤 奤奯 奮奯奴 奮奥奣奥女女奡奲奩奬她 奲奥夝奥奣奴 奴奨奥 :search 奣奯奭奭奡奮奤’女 奡奣奴奵奡奬 奢奥奨奡奶奩奯奲央 奆奯奲 奥奸奡奭奰奬奥夬 奴奨奥 argument
application 奲奵奬奥 奭奡她 奢奥 奵女奥奤 奤奩奲奥奣奴奬她 奯奮 奡奲奧奵奭奥奮奴女 奴奨奡奴 奡奲奥 奢奯奵奮奤 奡奦奴奥奲 奯奴奨奥奲 奡奲奧奵奭奥奮奴女夬 奷奩奴奨奯奵奴 奵女奩奮奧
女奥奶奥奲奡奬 奡奰奰奬奩奣奡奴奩奯奮女 奯奦 奴奨奥 argument transposition 奲奵奬奥央

• Argument transposition

A : Type B : Type a : A, b : B |- M : Type
----------------------------------------------------------------------------
(x : A) -> (y : B) -> [x,y/a,b]M == (y : B) -> (x : A) -> [x,y/a,b]M

奓奣奯奲奥夺 失 奰奯奩奮奴

奅奸奡奭奰奬奥夺

a -> Vect n a -> Vect (S n) a == Vect n a -> a -> Vect (S n) a

奎奯奴奥 奴奨奡奴 奩奮 奯奲奤奥奲 奦奯奲 奩奴 奴奯 奭奡奫奥 女奥奮女奥 奴奯 奣奨奡奮奧奥 奴奨奥 奯奲奤奥奲 奯奦 奡奲奧奵奭奥奮奴女夬 奮奥奩奴奨奥奲 奯奦 奴奨奥 奡奲奧奵奭奥奮奴女’
奴她奰奥女 奭奡她 奤奥奰奥奮奤 奯奮 奴奨奥 奶奡奬奵奥 奢奯奵奮奤 奢她 奴奨奥 奯奴奨奥奲 奡奲奧奵奭奥奮奴夡

• Symmetry of equality

A = B : Type t : Type |- M : Type
----------------------------------------
[A = B/t]M == [B = A/t]M

奓奣奯奲奥夺 失 奰奯奩奮奴

奅奸奡奭奰奬奥夺

(x,y,z : Nat) -> x + (y + z) = (x + y) + z
==

(x,y,z : Nat) -> (x + y) + z = x + (y + z)

奎奯奴奥 奴奨奡奴 奴奨奩女 奲奵奬奥 奭奥奡奮女 奴奨奡奴 奷奥 奣奡奮 夝奩奰 奥奱奵奡奬奩奴奩奥女 奡奮她奷奨奥奲奥 奴奨奥她 奯奣奣奵奲 夨奩央奥央夬 奮奯奴 奯奮奬她 奩奮 奴奨奥 奲奥奴奵奲奮
奴她奰奥天央

• Argument application

e : A |- M : Type y1 : T1, ..., yn : Tn |- x : A
-----------------------------------------------------------------
(z : A) -> [z/e]M >= (y1 : T1) -> ... -> (yn :Tn) -> [x/e]M

奓奣奯奲奥夺 夼夽 夺 夳 奰奯奩奮奴女夬 夾夽 夺 夹 奰奯奩奮奴女
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奅奸奡奭奰奬奥女夺

a -> a >= Nat -> Nat
a -> a >= List e -> List e
Vect k (Fin k) >= Vect 5 (Fin 5)

奎奯奴奥 奴奨奡奴 奴奨奥 n 女奨奯奷奮 奩奮 奴奨奥 女奣奨奥奭奥 奡奢奯奶奥 奭奡她 奢奥 夰夻 奴奨奡奴 奩女夬 奴奨奥奲奥 奡奲奥 奮奯 奐奩 奴奥奲奭女 奴奯 奢奥 奡奤奤奥奤 奯奮 奴奨奥
奲奩奧奨奴 女奩奤奥央 奆奯奲 奥奸奡奭奰奬奥夬 奴奨奡奴’女 奴奨奥 奣奡女奥 奦奯奲 奴奨奥 夜奲女奴 奥奸奡奭奰奬奥 女奨奯奷奮 奡奢奯奶奥央 奔奨奩女 奩女 奰奲奯奢奡奢奬她 奴奨奥 奭奯女奴
奩奭奰奯奲奴奡奮奴夬 奡奮奤 奭奯女奴 奷奩奤奥奬她 奵女奥奤夬 奲奵奬奥 奯奦 奡奬奬央

• Type class application

C : Type -> TypeClass
, y1 : T1, ..., yn : Tn |- A : Type, instance : C A
, t : Type |- M : Type
-----------------------------------------------------------------
C a => [a/t]M >= (y1 : T1) -> ... -> (yn : Tn) -> [A/t]M

奓奣奯奲奥夺 夼夽 夺 头 奰奯奩奮奴女夬 夾夽 夺 失夲 奰奯奩奮奴女

奅奸奡奭奰奬奥女

Ord a => a >= Int
Show (List e) => List e -> String >= Show a => List a -> String

奔奨奩女 奲奵奬奥 奩女 奵女奥奤 奢她 奬奯奯奫奩奮奧 奡奴 奴奨奥 奩奮女奴奡奮奣奥女 奦奯奲 奡 奰奡奲奴奩奣奵奬奡奲 奴她奰奥 奣奬奡女女央 套奨奩奬奥 奴奨奥 女奣奨奥奭奥 奩女 女奨奯奷奮 奯奮奬她
奦奯奲 女奩奮奧奬奥夭奰奡奲奡奭奥奴奥奲 奴她奰奥 奣奬奡女女奥女夬 奩奴 奮奡奴奵奲奡奬奬她 奧奥奮奥奲奡奬奩奺奥女 奴奯 奭奵奬奴奩夭奰奡奲奡奭奥奴奥奲 奴她奰奥 奣奬奡女女奥女央 奔奨奩女 奲奵奬奥 奩女
奰奡奲奴奩奣奵奬奡奲奬她 奵女奥奦奵奬 奩奮 奣奯奮奪奵奮奣奴奩奯奮 奷奩奴奨 奡奲奧奵奭奥奮奴 奡奰奰奬奩奣奡奴奩奯奮央 奁奧奡奩奮夬 奮奯奴奥 奴奨奡奴 奴奨奥 n 奩奮 奴奨奥 女奣奨奥奭奥 奡奢奯奶奥
奭奡她 奢奥 夰央

• Type class introduction

t : Type |- M : Type C : Type -> TypeClass
-----------------------------------------------
(t : Type) -> M >= C t => M

奓奣奯奲奥夺 夼夽 夺 夲 奰奯奩奮奴女夬 夾夽 夺 夶 奰奯奩奮奴女

奅奸奡奭奰奬奥夺

a -> a -> Bool >= Eq a => a -> a -> Bool

Scoring and listing search results

套奨奥奮 奡 奴她奰奥 S 奩女 女奥奡奲奣奨奥奤夬 奴奨奥 奴她奰奥 奩女 奣奯奭奰奡奲奥奤 奡奧奡奩奮女奴 奴奨奥 奴她奰奥女 奯奦 奡奬奬 奯奦 奴奨奥 奴奥奲奭女 奷奨奩奣奨 奡奲奥 奣奵奲奲奥奮奴奬她
奩奮 奣奯奮奴奥奸奴央 套奨奥奮 夺女奥奡奲奣奨 奣奯奭奰奡奲奥女 奴奷奯 奴她奰奥女 S 奡奮奤 T夬 奩奴 奥女女奥奮奴奩奡奬奬她 奴奲奩奥女 奴奯 夜奮奤 奡 奣奨奡奩奮 奯奦 奩奮奥奱奵奡奬奩奴奩奥女

R1 R2 Rn Rn+1
S <= A1 <= ... <= An <= T

奵女奩奮奧 奴奨奥 奥奤奩奴 奲奵奬奥女 奬奩女奴奥奤 奡奢奯奶奥央 奉奴 奡奬女奯 奴奲奩奥女 奴奯 夜奮奤 奣奨奡奩奮女 奧奯奩奮奧 奴奨奥 奯奴奨奥奲 奷奡她 夨奩央奥央夬 女奨奯奷奩奮奧 S >= T天
奡女 奷奥奬奬央 奅奡奣奨 奲奵奬奥 奨奡女 奡奮 奡女女奯奣奩奡奴奥奤 女奣奯奲奥 奷奨奩奣奨 奩奮奤奩奣奡奴奥女 奨奯奷 奤奲奡女奴奩奣 奯奦 奡 奣奨奡奮奧奥 奴奨奥 奲奵奬奥 奣奯奲奲奥女奰奯奮奤女
奴奯央 奔奨奥女奥 女奣奯奲奥女 奡奲奥 奬奩女奴奥奤 奡奢奯奶奥央 奎奯奴奥 奴奨奡奴 奦奯奲 奴奨奥 奲奵奬奥女 奷奨奩奣奨 奡奲奥 奮奯奴 女她奭奭奥奴奲奩奣夬 奴奨奥 女奣奯奲奥 奤奥奰奥奮奤女 奯奮
奴奨奥 奤奩奲奥奣奴奩奯奮 奩奮 奷奨奩奣奨 奴奨奥 奲奵奬奥 奩女 奵女奥奤央 奆奩奮奤奩奮奧 奴她奰奥女 奷奨奩奣奨 奡奲奥 奭奯奲奥 奧奥奮奥奲奡奬 奴奨奡奴 奴奨奥 女奥奡奲奣奨奥奤 奴她奰奥奤
夨S <= T天 奩女 奰奲奥奦奥奲奲奥奤 奴奯 夜奮奤奩奮奧 奴她奰奥女 奷奨奩奣奨 奡奲奥 奬奥女女 奧奥奮奥奲奡奬央

奔奨奥 女奣奯奲奥 奦奯奲 奴奨奥 奥奮奴奩奲奥 奣奨奡奩奮 奩女夬 奡奴 奭奩奮奩奭奵奭夬 奴奨奥 女奵奭 奯奦 奴奨奥 女奣奯奲奥女 奯奦 奴奨奥 奩奮奤奩奶奩奤奵奡奬 奲奵奬奥女 夨女奯奭奥 奮奯奮夭
奬奩奮奥奡奲 奩奮奴奥奲奡奣奴奩奯奮女 奭奡她 奢奥 奡奤奤奥奤天央 奔奨奥 夺女奥奡奲奣奨 奦奵奮奣奴奩奯奮 奴奲奩奥女 奴奯 夜奮奤 奴奨奥 奣奨奡奩奮 奢奥奴奷奥奥奮 S 奡奮奤 T 奷奨奩奣奨
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奲奥女奵奬奴女 奩奮 奴奨奥 奬奯奷奥女奴 女奣奯奲奥夬 奡奮奤 奴奨奩女 奩女 奴奨奥 女奣奯奲奥 奡女女奯奣奩奡奴奥奤 奴奯 奴奨奥 女奥奡奲奣奨 奲奥女奵奬奴 奦奯奲 T央

奓奥奡奲奣奨 奲奥女奵奬奴女 奡奲奥 奬奩女奴奥奤 奩奮 奯奲奤奥奲 奯奦 奡女奣奥奮奤奩奮奧 女奣奯奲奥央 奔奨奥 女她奭奢奯奬 奷奨奩奣奨 奩女 女奨奯奷奮 奡奬奯奮奧 奷奩奴奨 奴奨奥 女奥奡奲奣奨
奲奥女奵奬奴 奲奥夝奥奣奴女 奴奨奥 奴她奰奥 奯奦 奴奨奥 奣奨奡奩奮 奷奨奩奣奨 奲奥女奵奬奴奥奤 奩奮 奴奨奥 奭奩奮奩奭奵奭 女奣奯奲奥央

6.17.2 Implementation of :search

奐奲奡奣奴奩奣奡奬奬她夬 奮奡奩奶奥 奡奮奤 奵奮奤奩奲奥奣奴奥奤 奡奰奰奬奩奣奡奴奩奯奮 奯奦 奴奨奥 奲奵奬奥女 奥奮奵奭奥奲奡奴奥奤 奡奢奯奶奥 奩女 奮奯奴 奰奯女女奩奢奬奥夻 奮奯奴 奯奮奬她
奩女 奴奨奩女 奯奢奶奩奯奵女奬她 奩奮奥夞奣奩奥奮奴夬 奢奵奴 奴奨奥 奴奷奯 奡奰奰奬奩奣奡奴奩奯奮 奲奵奬奥女 夨奰奡奲奴奩奣奵奬奡奲奬她 argument application天 奡奲奥 奲奥奡奬奬她
奩奭奰奯女女奩奢奬奥 奴奯 奵女奥 奷奩奴奨奯奵奴 奣奯奮奴奥奸奴 奧奩奶奥奮 奢她 奯奴奨奥奲 奴她奰奥女央 奔奨奥奲奥奦奯奲奥夬 奷奥 奵女奥 奡 奨奥奵奲奩女奴奩奣 奡奬奧奯奲奩奴奨奭 奴奨奡奴 奩女
奭奥奡奮奴 奴奯 奢奥 奰奲奡奣奴奩奣奡奬夬 奴奨奯奵奧奨 奩奴 奭奩奧奨奴 奮奯奴 夜奮奤 奷奡她女 奴奯 奲奥奬奡奴奥 奴奷奯 奴她奰奥女 奷奨奩奣奨 奭奡她 奡奣奴奵奡奬奬她 奢奥 奲奥奬奡奴奥奤
奢她 奴奨奥 奲奵奬奥女 奬奩女奴奥奤 奡奢奯奶奥央

奓奵奰奰奯女奥 奷奥 奷奩女奨 奴奯 奭奡奴奣奨 奴奷奯 奴她奰奥女夬 S 奡奮奤 T央 套奥 奴奨奩奮奫 奯奦 奴奨奥 奰奲奯奢奬奥奭 奡女 奡 奮奯奮夭奤奥奴奥奲奭奩奮奩女奴奩奣 女奴奡奴奥
奭奡奣奨奩奮奥央 奔奨奥奲奥 奩女 奡 State 奤奡奴奡奴她奰奥 奷奨奩奣奨 奫奥奥奰女 奴奲奡奣奫 奯奦 奨奯奷 奷奥奬奬 奷奥’奶奥 奭奡奴奣奨奥奤 S 奡奮奤 T 女奯 奦奡奲央 奉奴
奣奯奮奴奡奩奮女夺

• 奎奡奭奥女 奯奦 奡奲奧奵奭奥奮奴 奶奡奲奩奡奢奬奥女 夨奐奩夭奢奯奵奮奤 奶奡奲奩奡奢奬奥女天 奩奮 奥奩奴奨奥奲 奴她奰奥 奷奨奩奣奨 奨奡奶奥 她奥奴 奴奯 奢奥 奭奡奴奣奨奥奤

• 奁 奤奩奲奥奣奴奥奤 奡奣她奣奬奩奣 奧奲奡奰奨 夨奄奁奇天 奯奦 奡奲奧奵奭奥奮奴女 夨奐奩夭奢奩奮奤奩奮奧女天 奦奯奲 S 奡奮奤 T 奷奨奩奣奨 奨奡奶奥 她奥奴 奴奯 奢奥
奭奡奴奣奨奥奤

• 奁 奬奩女奴 奯奦 奴她奰奥奣奬奡女女 奣奯奮女奴奲奡奩奮奴女 奦奯奲 S 奡奮奤 T 奷奨奩奣奨 奨奡奶奥 她奥奴 奴奯 奢奥 奭奡奴奣奨奥奤

• 奁 奲奥奣奯奲奤 奯奦 奴奨奥 奲奵奬奥女 奷奨奩奣奨 奨奡奶奥 奢奥奥奮 奵女奥奤 女奯 奦奡奲 奴奯 奧奥奴 奴奯 奴奨奩女 奰奯奩奮奴

奁 奦奵奮奣奴奩奯奮 nextSteps : State -> [State] 夜奮奤女 奴奨奥 奮奥奸奴 女奴奡奴奥女 奷奨奩奣奨 奭奡她 奦奯奬奬奯奷 奦奲奯奭 奡 奧奩奶奥奮 女奴奡奴奥央
奓奯奭奥 女奴奡奴奥女夬 奷奨奥奲奥 奥奶奥奲她奴奨奩奮奧 奨奡女 奢奥奥奮 奭奡奴奣奨奥奤夬 奡奲奥 奣奯奮女奩奤奥奲奥奤 夜奮奡奬央 奔奨奥 奡奬奧奯奲奩奴奨奭 奣奡奮 奢奥 奲奯奵奧奨奬她
奢奲奯奫奥奮 奤奯奷奮 奩奮奴奯 奭奵奬奴奩奰奬奥 女奴奡奧奥女夻 奩奦 奷奥 女奴奡奲奴 奦奲奯奭 奨奡奶奩奮奧 奴奷奯 奴她奰奥女夬 S 奡奮奤 T夬 奷奨奩奣奨 奷奥 奷奩女奨 奴奯 奭奡奴奣奨夬
奴奨奥她 奡奲奥 奡女 奦奯奬奬奯奷女夺

失央 奆奯奲 奥奡奣奨 奯奦 S 奡奮奤 T夬 女奰奬奩奴 奴奨奥 奴她奰奥女 奵奰 奩奮奴奯 奴奨奥奩奲 奲奥奴奵奲奮 奴她奰奥女 奡奮奤 奤奩奲奥奣奴奥奤 奡奣她奣奬奩奣 奧奲奡奰奨女 奯奦 奴奨奥
奡奲奧奵奭奥奮奴女夬 奷奨奥奲奥 奴奨奥奲奥 奩女 奡奮 奥奤奧奥 奦奲奯奭 奡奲奧奵奭奥奮奴 奁 奴奯 奡奲奧奵奭奥奮奴 奂 奩奦 奴奨奥 奴奥奲奭 奢奯奵奮奤 奩奮 奁 奡奰奰奥奡奲女
奩奮 奴奨奥 奴她奰奥 奯奦 奂央 奔奨奥 奴奯奰奯奬奯奧奩奣奡奬 女奯奲奴女 奯奦 奴奨奥 奄奁奇 奲奥奰奲奥女奥奮奴 奡奬奬 奴奨奥 奰奯女女奩奢奬奥 奷奡她女 奩奮 奷奨奩奣奨 奴奨奥
奡奲奧奵奭奥奮奴女 奭奡她 奢奥 奰奥奲奭奵奴奥奤央

夲央 奆奯奲 奴她奰奥 T夬 奲奥奣奵奲女奩奶奥奬她 夜奮奤 夨女奡奴奵奲奡奴奥奤天 奵女奥女 奯奦 奴奨奥 = 奴她奰奥 奣奯奮女奴奲奵奣奴奯奲 奡奮奤 奰奲奯奤奵奣奥 奡 奬奩女奴 奯奦 奭奯奤奩夜奥奤
奶奥奲女奩奯奮女 奯奦 T 奣奯奮奴奡奩奮奩奮奧 奡奬奬 奰奯女女奩奢奬奥 夝奩奰女 奯奦 奴奨奥 = 奣奯奮女奴奲奵奣奴奯奲 夨奴奨奩女 奣奯奲奲奥女奰奯奮奤女 奴奯 奴奨奥 symmetry of
equality rule天央

夳央 奆奯奲 奥奡奣奨 奭奯奤奩夜奥奤 奴她奰奥 奦奯奲 T夬 奴奲她 奴奯 奵奮奩奦她 奴奨奥 奲奥奴奵奲奮 奴她奰奥 奯奦 奴奨奥 奭奯奤奩夜奥奤 T 奷奩奴奨 S夬 奣奯奮女奩奤奥奲奩奮奧
奡奲奧奵奭奥奮奴女 奦奲奯奭 奢奯奴奨 S 奡奮奤 T 奴奯 奢奥 奨奯奬奥女夬 女奯 奴奨奡奴 奴奨奥 奵奮奩夜奥奲 奭奡她 奭奡奴奣奨 奰奩奥奣奥女 奯奦 奴奨奥 奴奷奯 奴她奰奥女央 奆奯奲
奥奡奣奨 奭奯奤奩夜奥奤 奶奥奲女奩奯奮 奯奦 T 奷奨奥奲奥 奴奨奩女 女奵奣奣奥奥奤女夬 奡奮 奩奮奩奴奩奡奬 State 奣奡奮 奢奥 奭奡奤奥央 奔奨奥 奡奲奧奵奭奥奮奴女 奡奮奤
奴她奰奥奣奬奡女女奥女 奡奲奥 奵奰奤奡奴奥奤 奡奣奣奯奲奤奩奮奧奬她 奷奩奴奨 奴奨奥 奲奥女奵奬奴女 奯奦 奵奮奩夜奣奡奴奩奯奮央 奔奨奥 奲奥奭奡奩奮奤奥奲 奯奦 奴奨奥 奡奬奧奯奲奩奴奨奭
奩奮奶奯奬奶奥女 奡奰奰奬她奩奮奧 nextSteps 奴奯 奴奨奥女奥 女奴奡奴奥女 奵奮奴奩奬 奥奩奴奨奥奲 奮奯 女奴奡奴奥女 奲奥奭奡奩奮 夨奣奯奲奲奥女奰奯奮奤奩奮奧 奴奯 奮奯 奰奡奴奨
奦奲奯奭 S 奴奯 T天 奯奲 奡 夜奮奡奬 女奴奡奴奥 奩女 奦奯奵奮奤央 nextSteps 奡奬女奯 奨奡女 女奥奶奥奲奡奬 女奴奡奧奥女夺

头央 奔奲她 奴奯 奵奮奩奦她 奡奲奧奵奭奥奮奴女 奯奦 S 奷奩奴奨 奡奲奧奵奭奥奮奴女 奯奦 T夬 奭奵奣奨 奬奩奫奥 奩女 奤奯奮奥 奷奩奴奨 奴奨奥 奲奥奴奵奲奮 奴她奰奥女央 套奥 奷奯奲奫
“奢奡奣奫奷奡奲奤女” 奴奨奲奯奵奧奨 奴奨奥 奡奲奧奵奭奥奮奴女夺 奷奥 奴奲她 奭奡奴奣奨奩奮奧 奡奬奬 奲奥奭奡奩奮奩奮奧 奡奲奧奵奭奥奮奴女 奯奦 S 奷奨奩奣奨 奬奡奣奫
奯奵奴奧奯奩奮奧 奥奤奧奥女 奩奮 奴奨奥 奄奁奇 奯奦 奲奥奭奡奩奮奩奮奧 奡奲奧奵奭奥奮奴女 夨奴奨奡奴 奩女夬 奴奨奥 奢奯奵奮奤 奶奡奬奵奥 奤奯奥女奮’奴 奡奰奰奥奡奲 奩奮
奴奨奥 奴她奰奥 奯奦 奡奮她 奯奴奨奥奲 奲奥奭奡奩奮奩奮奧 奡奲奧奵奭奥奮奴女天 奷奩奴奨 奴奨奥 奡奬奬 奯奦 奴奨奥 奣奯奲奲奥女奰奯奮奤奩奮奧 奲奥奭奡奩奮奩奮奧 奡奲奧奵奭奥奮奴女
奯奦 T央 奔奨奩女 奩女 奤奯奮奥 奲奥奣奵奲女奩奶奥奬她 奵奮奴奩奬 奮奯 奡奲奧奵奭奥奮奴女 奲奥奭奡奩奮 奦奯奲 奢奯奴奨 S 奡奮奤 T夻 奯奴奨奥奲奷奩女奥夬 奷奥 奧奩奶奥 奵奰
奡奴 奴奨奩女 奰奯奩奮奴央 奔奨奩女 女奴奥奰 奣奯奲奲奥女奰奯奮奤女 奴奯 奡奰奰奬奩奣奡奴奩奯奮 奯奦 奴奨奥 argument application rule夬 奡女 奷奥奬奬 奡女 奴奨奥
argument transposition 奲奵奬奥央

夵央 奎奯奷夬 奷奥 奴奲她 奴奯 奭奡奴奣奨 奴奨奥 奴她奰奥 奣奬奡女女奥女央 奆奩奲女奴夬 奷奥 奴奡奫奥 奡奬奬 奰奯女女奩奢奬奥 女奵奢女奥奴女 奯奦 奴她奰奥 奣奬奡女女 奣奯奮女奴奲奡奩奮奴女
奦奯奲 S 奡奮奤 T央 奓奯 奩奦 S 奡奮奤 T 奨奡奶奥 奡 奴奯奴奡奬 奯奦 n 奴她奰奥 奣奬奡女女 奣奯奮女奴奲奡奩奮奴女夬 奴奨奩女 奰奲奯奤奵奣奥女 2^n 女奴奡奴奥女 奦奯奲
奥奶奥奲她 女奴奡奴奥夬 奡奮奤 奴奨奩女 奱奵奩奣奫奬她 奢奥奣奯奭奥女 奩奮奦奥奡女奩奢奬奥 奡女 n 奧奲奯奷女 奬奡奲奧奥央 奔奨奩女 奩女 奰奲奯奢奡奢奬她 奴奨奥 奢奩奧奧奥女奴
奢奯奴奴奬奥奮奥奣奫 奯奦 奴奨奥 奡奬奧奯奲奩奴奨奭 奡奴 奴奨奥 奭奯奭奥奮奴央 奔奨奩女 女奴奥奰 奣奯奲奲奥女奰奯奮奤女 奴奯 奡奰奰奬奩奣奡奴奩奯奮女 奯奦 奴奨奥 type class
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introduction 奲奵奬奥央

夶央 奔奲她 奴奯 奭奡奴奣奨 奴她奰奥 奣奬奡女女 奣奯奮女奴奲奡奩奮奴女 奦奯奲 S 奷奩奴奨 奴奨奯女奥 奦奯奲 T央 套奥 奡奴奴奥奭奰奴 奴奯 奵奮奩奦她 奥奡奣奨 奴她奰奥 奣奬奡女女
奣奯奮女奴奲奡奩奮奴 奦奯奲 S 奷奩奴奨 奥奡奣奨 奣奯奮女奴奲奡奩奮奴 奦奯奲 T央 奔奨奩女 奭奡她 奲奥女奵奬奴 奩奮 奡奰奰奬奩奣奡奴奩奯奮女 奯奦 奴奨奥 type class appli-
cation 奲奵奬奥央 奏奮奣奥 奷奥 奡奲奥 奵奮奡奢奬奥 奴奯 奭奡奴奣奨 奡奮她 奭奯奲奥 奴她奰奥 奣奬奡女女 奣奯奮女奴奲奡奩奮奴女 奢奥奴奷奥奥奮 S 奡奮奤 T夬 奷奥
奰奲奯奣奥奥奤 奴奯 奴奨奥 夜奮奡奬 女奴奥奰央

夷央 奔奲她 奩奮女奴奡奮奴奩奡奴奩奮奧 奴她奰奥 奣奬奡女女奥女 奷奩奴奨 奴奨奥奩奲 奩奮女奴奡奮奣奥女 夨奩奮 奥奩奴奨奥奲 S 奯奲 T天央 奔奨奩女 奣奯奲奲奥女奰奯奮奤女 奴奯 奡奰奰奬奩奣奡奴奩奯奮女
奯奦 奴奨奥 type class application 奲奵奬奥央 奁奦奴奥奲 奩奮女奴奡奮奴奩奡奴奩奮奧 奡 奴她奰奥 奣奬奡女女夬 奷奥 奨奯奰奥奦奵奬奬她 奯奰奥奮 奵奰 奭奯奲奥
奯奰奰奯奲奴奵奮奩奴奩奥女 奴奯 奭奡奴奣奨 奴她奰奥奣奬奡女女 奣奯奮女奴奲奡奩奮奴女 奯奦 S 奷奩奴奨 奴奨奯女奥 奯奦 T夬 女奯 奷奥 奲奥奴奵奲奮 奴奯 奴奨奥 奰奲奥奶奩奯奵女
女奴奥奰央

奔奨奥 奣奯奤奥 奦奯奲 夺女奥奡奲奣奨 奩女 奬奯奣奡奴奥奤 奩奮 奴奨奥 奉奤奲奩女央奔她奰奥奓奥奡奲奣奨 奭奯奤奵奬奥央

Aggregating results

奔奨奥 女奥奡奲奣奨 奦奯奲 奣奨奡奩奮女 奯奦 奲奵奬奥女夯奥奤奩奴女 奷奨奩奣奨 奲奥奬奡奴奥 奴奷奯 奴她奰奥女 奣奡奮 奢奥 奶奩奥奷奥奤 奡女 奡 女奨奯奲奴奥女奴 奰奡奴奨 奰奲奯奢奬奥奭
奷奨奥奲奥 奮奯奤奥女 奣奯奲奲奥女奰奯奮奤 奴奯 奴她奰奥女 奡奮奤 奥奤奧奥女 奣奯奲奲奥女奰奯奮奤 奴奯 奲奵奬奥女 奲奥奬奡奴奩奮奧 奴奷奯 奴她奰奥女央 奔奨奥 奷奥奩奧奨奴女 奯奲
奤奩女奴奡奮奣奥女 奯奮 奥奡奣奨 奥奤奧奥 奣奯奲奲奥女奰奯奮奤 奴奯 奴奨奥 女奣奯奲奥 奯奦 奥奡奣奨 奲奵奬奥央 套奥 奴奨奥奮 奭奡她 奩奭奡奧奩奮奥 奴奨奡奴 奷奥 奨奡奶奥 奡 女奩奮奧奬奥
女奴奡奲奴 奮奯奤奥夬 奯奵奲 女奥奡奲奣奨 奴她奰奥 S夬 奡奮奤 女奥奶奥奲奡奬 夜奮奡奬 奮奯奤奥女夺 奡奬奬 奯奦 奴奨奥 奴她奰奥女 奦奯奲 奴奥奲奭女 奷奨奩奣奨 奡奲奥 奣奵奲奲奥奮奴奬她 奩奮
奣奯奮奴奥奸奴央 奔奨奥 奰奲奯奢奬奥奭夬 奴奨奥奮夬 奩女 奴奯 夜奮奤 奴奨奥 女奨奯奲奴奥女奴 奰奡奴奨女 夨奷奨奥奲奥 奴奨奥她 奥奸奩女奴天 奴奯 奡奬奬 奯奦 奴奨奥 夜奮奡奬 奮奯奤奥女央 奉奮
奰奡奲奴奩奣奵奬奡奲夬 奷奥 奷奩女奨 奴奯 夜奮奤 奴奨奥 “奣奬奯女奥女奴” 奴她奰奥女 夨奴奨奯女奥 奷奩奴奨 奴奨奥 奭奩奮奩奭奵奭 女奣奯奲奥天 夜奲女奴夬 奡女 奷奥’奤 奬奩奫奥 奴奯
奤奩女奰奬奡她 奴奨奥奭 夜奲女奴央

奔奨奩女 奰奲奯奢奬奥奭 奮奩奣奥奬她 奭奡奰女 奴奯 奵女奡奧奥 奯奦 奄奩奪奫女奴奲奡’女 奡奬奧奯奲奩奴奨奭央 套奥 女奥奡奲奣奨 奦奯奲 奡奬奬 奴她奰奥女 女奩奭奵奬奴奡奮奥奯奵女奬她
女奯 奷奥 奣奡奮 夜奮奤 奴奨奥 奣奬奯女奥女奴 奯奮奥女 奷奩奴奨 奴奨奥 奭奩奮奩奭奵奭 奡奭奯奵奮奴 奯奦 奷奯奲奫央 奉奮 奰奲奡奣奴奩奣奥夬 奴奨奩女 奲奥女奵奬奴女 奩奮 奵女奩奮奧 奡
奰奲奩奯奲奩奴她 奱奵奥奵奥 奯奦 奰奲奩奯奲奩奴她 奱奵奥奵奥女央 套奥 夜奲女奴 奡女奫 “奷奨奩奣奨 奧奯奡奬 奴她奰奥 女奨奯奵奬奤 奷奥 奷奯奲奫 奯奮 奮奥奸奴夿”夬 奡奮奤 奴奨奥奮
奡女奫 “奷奨奩奣奨 女奴奡奴奥 女奨奯奵奬奤 奷奥 奥奸奰奡奮奤 奵奰奯奮 奮奥奸奴夿” 奂她 奵女奩奮奧 奴奨奩女 女奴奲奡奴奥奧她夬 奴奨奥 奢奥女奴 奲奥女奵奬奴女 奣奡奮 奢奥 女奨奯奷奮
奱奵奩奣奫奬她夬 奥奶奥奮 奩奦 奩奴 奴奡奫奥女 奡 奢奩奴 奯奦 奴奩奭奥 奴奯 夜奮奤 奷奯奲女奥 奲奥女奵奬奴女 夨奯奲 奡奴 奬奥奡女奴 奲奵奬奥 奴奨奥奭 奯奵奴天央

6.17.3 Miscellaneous Notes

套奨奥奴奨奥奲 奡奲奧奵奭奥奮奴女 奡奲奥 奥奸奰奬奩奣奩奴 奯奲 奩奭奰奬奩奣奩奴 奤奯奥女 奮奯奴 奡夛奥奣奴 女奥奡奲奣奨 奲奥女奵奬奴女央

6.18 Static Arguments and Partial Evaluation

奁女 奯奦 奶奥奲女奩奯奮 夰央夹央失夵夬 奉奤奲奩女 奨奡女 女奵奰奰奯奲奴 奦奯奲 partial evaluation 奯奦 女奴奡奴奩奣奡奬奬她 奫奮奯奷奮 奡奲奧奵奭奥奮奴女央 奔奨奩女 奩奮奶奯奬奶奥女
奣奲奥奡奴奩奮奧 女奰奥奣奩奡奬奩女奥奤 奶奥奲女奩奯奮女 奯奦 奦奵奮奣奴奩奯奮女 奷奩奴奨 奡奲奧奵奭奥奮奴女 奡奮奮奯奴奡奴奥奤 奡女 %static央

夨奔奨奩女 奩女 奡奮 奩奭奰奬奥奭奥奮奴奡奴奩奯奮 奯奦 奴奨奥 奰奡奲奴奩奡奬 奥奶奡奬奵奡奴奯奲 奤奥女奣奲奩奢奥奤 奩奮 奴奨奩女 奉奃奆奐 夲夰失夰 奰奡奰奥奲央 奐奬奥奡女奥 奲奥奦奥奲 奴奯
奴奨奩女 奦奯奲 奭奯奲奥 奰奲奥奣奩女奥 奤奥夜奮奩奴奩奯奮女 奯奦 奷奨奡奴 奦奯奬奬奯奷女央天

奐奡奲奴奩奡奬 奥奶奡奬奵奡奴奩奯奮 奩女 女奷奩奴奣奨奥奤 奯夛 奢她 奤奥奦奡奵奬奴 女奩奮奣奥 奉奤奲奩女 失央夰央 奉奴 奣奡奮 奢奥 奥奮奡奢奬奥奤 奷奩奴奨 奴奨奥 --partial-eval
夝奡奧央

6.18.1 Introductory Example

奃奯奮女奩奤奥奲 奴奨奥 奰奯奷奥奲 奦奵奮奣奴奩奯奮 奯奶奥奲 奮奡奴奵奲奡奬 奮奵奭奢奥奲女夬 奤奥夜奮奥奤 奡女 奦奯奬奬奯奷女 夨奷奥’奬奬 奣奡奬奬 奩奴 my_pow 女奩奮奣奥 pow
奡奬奲奥奡奤她 奥奸奩女奴女 奩奮 奴奨奥 奐奲奥奬奵奤奥天夺

6.18. Static Arguments and Partial Evaluation 207

https://github.com/idris-lang/Idris-dev/blob/master/src/Idris/TypeSearch.hs
http://eb.host.cs.st-andrews.ac.uk/writings/icfp10.pdf


Idris 语语语言言言文文文档档档, 版版版本本本 1.3.1

my_pow : Nat -> Nat -> Nat
my_pow x Z = 1
my_pow x (S k) = mult x (my_pow x k)

奔奨奩女 奩女 奩奭奰奬奥奭奥奮奴奥奤 奢她 奲奥奣奵奲女奩奯奮 奯奮 奴奨奥 女奥奣奯奮奤 奡奲奧奵奭奥奮奴夬 奡奮奤 奷奥 奣奡奮 奥奶奡奬奵奡奴奥 奴奨奥 奤奥夜奮奩奴奩奯奮 奦奵奲奴奨奥奲
奩奦 奴奨奥 女奥奣奯奮奤 奡奲奧奵奭奥奮奴 奩女 奫奮奯奷奮夬 奥奶奥奮 奩奦 奴奨奥 夜奲女奴 奩女奮’奴央 奆奯奲 奥奸奡奭奰奬奥夬 奷奥 奣奡奮 奢奵奩奬奤 奡 奦奵奮奣奴奩奯奮 奡奴 奴奨奥
奒奅奐奌 奴奯 奣奵奢奥 奡 奮奵奭奢奥奲 奡女 奦奯奬奬奯奷女夺

*pow> \x => my_pow x 3
\x => mult x (mult x (mult x 1)) : Nat -> Nat
*pow> it 3
27 : Nat

奎奯奴奥 奴奨奡奴 奩奮 奴奨奥 奲奥女奵奬奴奩奮奧 奦奵奮奣奴奩奯奮 奴奨奥 奲奥奣奵奲女奩奯奮 奨奡女 奢奥奥奮 奥奬奩奭奩奮奡奴奥奤夬 女奩奮奣奥 my_pow 奩女 奩奭奰奬奥奭奥奮奴奥奤 奢她
奲奥奣奵奲女奩奯奮 奯奮 奴奨奥 奫奮奯奷奮 奡奲奧奵奭奥奮奴央 套奥 奨奡奶奥 奮奯 女奵奣奨 奬奵奣奫 奩奦 奴奨奥 夜奲女奴 奡奲奧奵奭奥奮奴 奩女 奫奮奯奷奮 奡奮奤 奴奨奥 女奥奣奯奮奤
奩女奮’奴夺

*pow> \x => my_pow 2 x
\x => my_pow 2 x : Nat -> Nat

奎奯奷夬 奣奯奮女奩奤奥奲 奴奨奥 奦奯奬奬奯奷奩奮奧 奤奥夜奮奩奴奩奯奮 奷奨奩奣奨 奣奡奬奣奵奬奡奴奥女 奸奞夲 夫 失夺

powFn : Nat -> Nat
powFn x = plus (my_pow x (S (S Z))) (S Z)

奓奩奮奣奥 奴奨奥 女奥奣奯奮奤 奡奲奧奵奭奥奮奴 奴奯 my_pow 奨奥奲奥 奩女 女奴奡奴奩奣奡奬奬她 奫奮奯奷奮夬 奩奴 女奥奥奭女 奡 女奨奡奭奥 奴奯 奨奡奶奥 奴奯 奭奡奫奥 奴奨奥
奲奥奣奵奲女奩奶奥 奣奡奬奬女 奥奶奥奲她 奴奩奭奥央 奈奯奷奥奶奥奲夬 奉奤奲奩女 奷奩奬奬 奮奯奴 奩奮 奧奥奮奥奲奡奬 奩奮奬奩奮奥 奲奥奣奵奲女奩奶奥 奤奥夜奮奩奴奩奯奮女夬 奩奮 奰奡奲奴奩奣奵奬奡奲
女奩奮奣奥 奴奨奥她 奭奡她 奤奩奶奥奲奧奥 奯奲 奤奵奰奬奩奣奡奴奥 奷奯奲奫 奷奩奴奨奯奵奴 女奯奭奥 奤奥奥奰奥奲 奡奮奡奬她女奩女央

套奥 奣奡奮夬 奨奯奷奥奶奥奲夬 奧奩奶奥 奉奤奲奩女 女奯奭奥 奨奩奮奴女 奴奨奡奴 奨奥奲奥 奷奥 奲奥奡奬奬她 奷奯奵奬奤 奬奩奫奥 奴奯 奣奲奥奡奴奥 奡 女奰奥奣奩奡奬奩女奥奤 奶奥奲女奩奯奮 奯奦
my_pow央

Automatic specialisation of pow

奔奨奥 奴奲奩奣奫 奩女 奴奯 奭奡奲奫 奴奨奥 女奴奡奴奩奣奡奬奬她 奫奮奯奷奮 奡奲奧奵奭奥奮奴女 奷奩奴奨 奴奨奥 %static 夝奡奧夺

my_pow : Nat -> %static Nat -> Nat
my_pow k Z = 1
my_pow k (S j) = mult k (my_pow k j)

套奨奥奮 奡奮 奡奲奧奵奭奥奮奴 奩女 奡奮奮奯奴奡奴奥奤 奩奮 奴奨奩女 奷奡她夬 奉奤奲奩女 奷奩奬奬 奴奲她 奴奯 奣奲奥奡奴奥 奡 女奰奥奣奩奡奬奩女奥奤 奶奥奲女奩奯奮 奷奨奥奮奥奶奥奲 奩奴
奡奣奣奯奵奮奴女 奡 奣奡奬奬 奷奩奴奨 奡 奣奯奮奣奲奥奴奥 奶奡奬奵奥 夨奩央奥央 奡 奣奯奮女奴奡奮奴夬 奣奯奮女奴奲奵奣奴奯奲 奦奯奲奭夬 奯奲 奧奬奯奢奡奬奬她 奤奥夜奮奥奤 奦奵奮奣奴奩奯奮天 奩奮
奡 %static 奰奯女奩奴奩奯奮央 奉奦 my_pow 奩女 奤奥夜奮奥奤 奴奨奩女 奷奡她夬 奡奮奤 powFn 奤奥夜奮奥奤 奡女 奡奢奯奶奥夬 奷奥 奣奡奮 女奥奥 奴奨奥 奥夛奥奣奴 奢她
奴她奰奩奮奧 :printdef powFn 奡奴 奴奨奥 奒奅奐奌夺

*pow> :printdef powFn
powFn : Nat -> Nat
powFn x = plus (PE_my_pow_3f3e5ad8 x) 1

套奨奡奴 奩女 奴奨奩女 奭她女奴奥奲奩奯奵女 PE_my_pow_3f3e5ad8夿 奉奴’女 奡 女奰奥奣奩奡奬奩女奥奤 奰奯奷奥奲 奦奵奮奣奴奩奯奮 奷奨奥奲奥 奴奨奥 女奴奡奴奩奣奡奬奬她
奫奮奯奷奮 奡奲奧奵奭奥奮奴 奨奡女 奢奥奥奮 女奰奥奣奩奡奬奩女奥奤 奡奷奡她央 奔奨奥 奮奡奭奥 奩女 奧奥奮奥奲奡奴奥奤 奦奲奯奭 奡 奨奡女奨 奯奦 奴奨奥 女奰奥奣奩奡奬奩女奥奤
奡奲奧奵奭奥奮奴女夬 奡奮奤 奷奥 奣奡奮 女奥奥 奩奴女 奤奥夜奮奩奴奩奯奮 奷奩奴奨 :printdef 奴奯奯夺

*petest> :printdef PE_my_pow_3f3e5ad8
PE_my_pow_3f3e5ad8 : Nat -> Nat
PE_my_pow_3f3e5ad8 (0arg) = mult (0arg) (mult (0arg) (PE_fromInteger_7ba9767f 1))
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奔奨奥 (0arg) 奩女 奡奮 奩奮奴奥奲奮奡奬 奡奲奧奵奭奥奮奴 奮奡奭奥 夨奰奲奯奧奲奡奭奭奥奲女 奣奡奮’奴 奧奩奶奥 奶奡奲奩奡奢奬奥 奮奡奭奥女 奢奥奧奩奮奮奩奮奧 奷奩奴奨 奡
奤奩奧奩奴 奡奦奴奥奲 奡奬奬天央 奎奯奴奩奣奥 奡奬女奯 奴奨奡奴 奴奨奥奲奥 奩女 奡 女奰奥奣奩奡奬奩女奥奤 奶奥奲女奩奯奮 奯奦 fromInteger 奦奯奲 Nat女夬 女奩奮奣奥 奴她奰奥 奣奬奡女女
奤奩奣奴奩奯奮奡奲奩奥女 奡奲奥 奴奨奥奭女奥奬奶奥女 奡 奰奡奲奴奩奣奵奬奡奲奬她 奣奯奭奭奯奮 奣奡女奥 奯奦 女奴奡奴奩奣奡奬奬她 奫奮奯奷奮 奡奲奧奵奭奥奮奴女夡

6.18.2 Specialising Type Classes

奔她奰奥 奣奬奡女女 奤奩奣奴奩奯奮奡奲奩奥女 奡奲奥 奶奥奲她 奯奦奴奥奮 女奴奡奴奩奣奡奬奬她 奫奮奯奷奮夬 女奯 奉奤奲奩女 奡奵奴奯奭奡奴奩奣奡奬奬她 奭奡奲奫女 奡奮她 奴她奰奥 奣奬奡女女
奣奯奮女奴奲奡奩奮奴 奡女 %static 奡奮奤 奢奵奩奬奤女 女奰奥奣奩奡奬奩女奥奤 奶奥奲女奩奯奮女 奯奦 奴奯奰 奬奥奶奥奬 奦奵奮奣奴奩奯奮女 奷奨奥奲奥 奴奨奥 奣奬奡女女 奩女 奩奮女奴奡奮奴奩奡奴奥奤央
奆奯奲 奥奸奡奭奰奬奥夬 奧奩奶奥奮夺

calc : Int -> Int
calc x = (x * x) + x

奉奦 奷奥 奰奲奩奮奴 奴奨奩女 奤奥夜奮奩奴奩奯奮夬 奷奥’奬奬 女奥奥 奡 女奰奥奣奩奡奬奩女奥奤 奶奥奲女奩奯奮 奯奦 + 奩女 奵女奥奤夺

*petest> :printdef calc
calc : Int -> Int
calc x = PE_+_954510b4 (PE_*_954510b4 x x) x

奍奯奲奥 奩奮奴奥奲奥女奴奩奮奧奬她夬 奣奯奮女奩奤奥奲 vadd 奷奨奩奣奨 奡奤奤女 奣奯奲奲奥女奰奯奮奤奩奮奧 奥奬奥奭奥奮奴女 奩奮 奡 奶奥奣奴奯奲 奯奦 奡奮她奴奨奩奮奧 奮奵奭奥奲奩奣夺

vadd : Num a => Vect n a -> Vect n a -> Vect n a
vadd [] [] = []
vadd (x :: xs) (y :: ys) = x + y :: vadd xs ys

奉奦 奷奥 奵女奥 奴奨奩女 奯奮 女奯奭奥奴奨奩奮奧 奣奯奮奣奲奥奴奥 奡女 奦奯奬奬奯奷女…

test : List Int -> List Int
test xs = let xs' = fromList xs in

toList $ vadd xs' xs'

…奴奨奥奮 奩奮 奦奡奣奴夬 奷奥 奧奥奴 奡 女奰奥奣奩奡奬奩女奥奤 奶奥奲女奩奯奮 奯奦 vadd 奩奮 奴奨奥 奤奥夜奮奩奴奩奯奮 奯奦 test夬 奡奮奤 奩奮奤奥奥奤 奴奨奥 女奰奥奣奩奡奬奩女奥奤
奶奥奲女奩奯奮 奯奦 toList夺

test : List Int -> List Int
test xs = let xs' = fromList xs

in PE_toList_888ae67 (PE_vadd_33f98d3d xs' xs')

奈奥奲奥’女 奴奨奥 女奰奥奣奩奡奬奩女奥奤 奶奥奲女奩奯奮 奯奦 vadd夺

PE_vadd_33f98d3d : Vect n Int -> Vect n Int -> Vect n Int
PE_vadd_33f98d3d [] [] = []
PE_vadd_33f98d3d (x :: xs) (y :: ys) = ((PE_+_954510b4 x y) ::

(PE_vadd_33f98d3d xs ys))

奎奯奴奥 奴奨奡奴 奴奨奥 奲奥奣奵奲女奩奶奥 女奴奲奵奣奴奵奲奥 奨奡女 奢奥奥奮 奰奲奥女奥奲奶奥奤夬 奡奮奤 奴奨奥 奲奥奣奵奲女奩奶奥 奣奡奬奬 奴奯 vadd 奨奡女 奢奥奥奮 奲奥奰奬奡奣奥奤
奷奩奴奨 奡 奲奥奣奵奲女奩奶奥 奣奡奬奬 奴奯 奴奨奥 女奰奥奣奩奡奬奩女奥奤 奶奥奲女奩奯奮央 套奥’奶奥 奡奬女奯 奧奯奴 奴奨奥 女奡奭奥 女奰奥奣奩奡奬奩女奥奤 奶奥奲女奩奯奮 奯奦 + 奴奨奡奴
奷奥 奨奡奤 奡奢奯奶奥 奩奮 calc央

6.18.3 Specialising Higher Order Functions

奁奮奯奴奨奥奲 奣奡女奥 奷奨奥奲奥 奰奡奲奴奩奡奬 奥奶奡奬奵奡奴奩奯奮 奣奡奮 奢奥 奵女奥奦奵奬 奩女 奩奮 奡奵奴奯奭奡奴奩奣奡奬奬她 奭奡奫奩奮奧 女奰奥奣奩奡奬奩女奥奤 奶奥奲女奩奯奮女 奯奦
奨奩奧奨奥奲 奯奲奤奥奲 奦奵奮奣奴奩奯奮女央 奕奮奬奩奫奥 奴她奰奥 奣奬奡女女 奤奩奣奴奩奯奮奡奲奩奥女夬 奴奨奩女 奩女 奮奯奴 奤奯奮奥 奡奵奴奯奭奡奴奩奣奡奬奬她夬 奢奵奴 奷奥 奭奩奧奨奴
奣奯奮女奩奤奥奲 奷奲奩奴奩奮奧 map 奡女 奦奯奬奬奯奷女夺
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my_map : %static (a -> b) -> List a -> List b
my_map f [] = []
my_map f (x :: xs) = f x :: my_map f xs

奔奨奥奮 奵女奩奮奧 my_map 奷奩奬奬 她奩奥奬奤 女奰奥奣奩奡奬奩女奥奤 奶奥奲女奩奯奮女夬 奦奯奲 奥奸奡奭奰奬奥 奴奯 奤奯奵奢奬奥 奥奶奥奲她 奶奡奬奵奥 奩奮 奡 奬奩女奴 奯奦 Int女 奷奥
奣奯奵奬奤 奷奲奩奴奥夺

doubleAll : List Int -> List Int
doubleAll xs = my_map (*2) xs

奔奨奩女 奷奯奵奬奤 她奩奥奬奤 奡 女奰奥奣奩奡奬奩女奥奤 奶奥奲女奩奯奮 奯奦 my_map夬 奵女奥奤 奩奮 doubleAll 奡女 奦奯奬奬奯奷女夺

doubleAll : List Int -> List Int
doubleAll xs = PE_my_map_1f8225c4 xs

PE_my_map_1f8225c4 : List Int -> List Int
PE_my_map_1f8225c4 [] = []
PE_my_map_1f8225c4 (x :: xs) = ((PE_*_954510b4 x 2) :: (PE_my_map_1f8225c4 xs))

6.18.4 Specialising Interpreters

奁 奰奡奲奴奩奣奵奬奡奲奬她 奵女奥奦奵奬 女奩奴奵奡奴奩奯奮 奷奨奥奲奥 奰奡奲奴奩奡奬 奥奶奡奬奵奡奴奩奯奮 奢奥奣奯奭奥女 奥夛奥奣奴奩奶奥 奩女 奩奮 奤奥夜奮奩奮奧 奡奮 奩奮奴奥奲奰奲奥奴奥奲 奦奯奲
奡 奷奥奬奬夭奴她奰奥奤 奥奸奰奲奥女女奩奯奮 奬奡奮奧奵奡奧奥夬 奤奥夜奮奥奤 奡女 奦奯奬奬奯奷女 夨女奥奥 奴奨奥 奉奤奲奩女 奴奵奴奯奲奩奡奬夬 女奥奣奴奩奯奮 头 奦奯奲 奭奯奲奥 奤奥奴奡奩奬女 奯奮
奨奯奷 奴奨奩女 奷奯奲奫女天夺

data Expr : Vect n Ty -> Ty -> Type where
Var : HasType i gamma t -> Expr gamma t
Val : (x : Int) -> Expr gamma TyInt
Lam : Expr (a :: gamma) t -> Expr gamma (TyFun a t)
App : Lazy (Expr gamma (TyFun a t)) -> Expr gamma a -> Expr gamma t
Op : (interpTy a -> interpTy b -> interpTy c) -> Expr gamma a -> Expr gamma

Expr gamma c
If : Expr gamma TyBool -> Expr gamma a -> Expr gamma a -> Expr gamma a

dsl expr
lambda = Lam
variable = Var
index_first = stop
index_next = pop

套奥 奣奡奮 奷奲奩奴奥 奡 奣奯奵奰奬奥 奯奦 奴奥女奴 奦奵奮奣奴奩奯奮女 奩奮 奴奨奩女 奬奡奮奧奵奡奧奥 奡女 奦奯奬奬奯奷女夬 奵女奩奮奧 奴奨奥 dsl 奮奯奴奡奴奩奯奮 奴奯 奯奶奥奲奬奯奡奤
奬奡奭奢奤奡女夻 夜奲女奴 奡 奦奵奮奣奴奩奯奮 奷奨奩奣奨 奭奵奬奴奩奰奬奩奥女 奴奷奯 奩奮奰奵奴女夺

eMult : Expr gamma (TyFun TyInt (TyFun TyInt TyInt))
eMult = expr (\x, y => Op (*) x y)

奔奨奥奮夬 奡 奦奵奮奣奴奩奯奮 奷奨奩奣奨 奣奡奬奣奵奬奡奴奥女 奴奨奥 奦奡奣奴奯奲奩奡奬 奯奦 奩奴女 奩奮奰奵奴夺

eFac : Expr gamma (TyFun TyInt TyInt)
eFac = expr (\x => If (Op (==) x (Val 0))

(Val 1)
(App (App eMult (App eFac (Op (-) x (Val 1)))) x))

奔奨奥 奩奮奴奥奲奰奲奥奴奥奲’女 奴她奰奥 奩女 奷奲奩奴奴奥奮 奡女 奦奯奬奬奯奷女夬 奭奡奲奫奩奮奧 奴奨奥 奥奸奰奲奥女女奩奯奮 奴奯 奢奥 奥奶奡奬奵奡奴奥奤 奡女 %static夺

interp : (env : Env gamma) -> %static (e : Expr gamma t) -> interpTy t

奔奨奩女 奭奥奡奮女 奴奨奡奴 奩奦 奷奥 奷奲奩奴奥 奡奮 奉奤奲奩女 奰奲奯奧奲奡奭 奴奯 奣奡奬奣奵奬奡奴奥 奡 奦奡奣奴奯奲奩奡奬 奢她 奣奡奬奬奩奮奧 interp 奯奮 eFac夬 奴奨奥
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奲奥女奵奬奴奩奮奧 奤奥夜奮奩奴奩奯奮 奷奩奬奬 奢奥 女奰奥奣奩奡奬奩女奥奤夬 奰奡奲奴奩奡奬奬她 奥奶奡奬奵奡奴奩奮奧 奡奷奡她 奴奨奥 奩奮奴奥奲奰奲奥奴奥奲夺

runFac : Int -> Int
runFac x = interp [] eFac x

套奥 奣奡奮 女奥奥 奴奨奡奴 奴奨奥 奣奡奬奬 奴奯 interp 奨奡女 奢奥奥奮 奰奡奲奴奩奡奬奬她 奥奶奡奬奵奡奴奥奤 奡奷奡她 奡女 奦奯奬奬奯奷女夺

*interp> :printdef runFac
runFac : Int -> Int
runFac x = PE_interp_ed1429e [] x

奉奦 奷奥 奬奯奯奫 奡奴 PE_interp_ed1429e 奷奥’奬奬 女奥奥 奴奨奡奴 奩奴 奦奯奬奬奯奷女 奥奸奡奣奴奬她 奴奨奥 女奴奲奵奣奴奵奲 奯奦 eFac夬 奷奩奴奨 奴奨奥
奩奮奴奥奲奰奲奥奴奥奲 奥奶奡奬奵奡奴奥奤 奡奷奡她夺

*interp> :printdef PE_interp_ed1429e
PE_interp_ed1429e : Env gamma -> Int -> Int
PE_interp_ed1429e (3arg) = \x =>

boolElim (x == 0)
(Delay 1)
(Delay (PE_interp_b5c2d0ff (x :: (3arg))

(PE_interp_ed1429e (x ::␣
→˓(3arg)) (x - 1)) x))

奆奯奲 奴奨奥 女奡奫奥 奯奦 奲奥奡奤奡奢奩奬奩奴她夬 奉 奨奡奶奥 女奩奭奰奬奩夜奥奤 奴奨奩女 女奬奩奧奨奴奬她夺 奷奨奡奴 她奯奵 奷奩奬奬 奲奥奡奬奬她 女奥奥 奡奬女奯 奩奮奣奬奵奤奥女 女奰奥奣奩奡奬奩女奥奤
奶奥奲女奩奯奮女 奯奦 ==夬 - 奡奮奤 fromInteger央 奎奯奴奥 奴奨奡奴 PE_interp_ed1429e夬 奷奨奩奣奨 奲奥奰奲奥女奥奮奴女 eFac 奨奡女 奢奥奣奯奭奥
奡 奲奥奣奵奲女奩奶奥 奦奵奮奣奴奩奯奮 奦奯奬奬奯奷奩奮奧 奴奨奥 女奴奲奵奣奴奵奲奥 奯奦 eFac央 奔奨奥奲奥 奩女 奡奬女奯 奡 奣奡奬奬 奴奯 PE_interp_b5c2d0ff 奷奨奩奣奨
奩女 奡 女奰奥奣奩奡奬奩女奥奤 奩奮奴奥奲奰奥奴奥奲 奦奯奲 eMult央

奔奨奥女奥 奤奥夜奮奩奴奩奯奮女 奡奲奩女奥 奢奥奣奡奵女奥 奴奨奥 奰奡奲奴奩奡奬 奥奶奡奬奵奡奴奯奲 奷奩奬奬 奯奮奬她 女奰奥奣奩奡奬奩女奥 奡 奤奥夜奮奩奴奩奯奮 奢她 奡 女奰奥奣奩夜奣 奣奯奮奣奲奥奴奥
奡奲奧奵奭奥奮奴 奯奮奣奥夬 奴奨奥奮 奩奴 奩女 奣奡奣奨奥奤 奦奯奲 奦奵奴奵奲奥 奵女奥央 奓奯 奡奮她 奦奵奴奵奲奥 奡奰奰奬奩奣奡奴奩奯奮女 奯奦 interp 奯奮 eFac 奷奩奬奬 奡奬女奯
奢奥 奴奲奡奮女奬奡奴奥奤 奴奯 PE_interp_ed1429e央

奔奨奥 女奰奥奣奩奡奬奩女奥奤 奶奥奲女奩奯奮 奯奦 eMult夬 奷奩奴奨奯奵奴 奡奮她 女奩奭奰奬奩夜奣奡奴奩奯奮 奦奯奲 奲奥奡奤奡奢奩奬奩奴她夬 奩女夺

PE_interp_b5c2d0ff : Env gamma -> Int -> Int -> Int
PE_interp_b5c2d0ff (3arg) = \x => \x1 => PE_*_954510b4 x x1

6.19 Miscellaneous

奔奨奩奮奧女 奷奥 奨奡奶奥 她奥奴 奴奯 奣奬奡女女奩奦她夬 奯奲 奡奲奥 奴奷奯 女奭奡奬奬 奴奯 奪奵女奴奩奦她 奴奨奥奩奲 奯奷奮 奰奡奧奥央

6.19.1 The Unifier Log

奉奦 她奯奵’奲奥 奨奡奶奩奮奧 奡 奨奡奲奤 奴奩奭奥 奤奥奢奵奧奧奩奮奧 奷奨她 奴奨奥 奵奮奩夜奥奲 奷奯奮’奴 奡奣奣奥奰奴 女奯奭奥奴奨奩奮奧 夨奯奦奴奥奮 奷奨奩奬奥 奤奥奢奵奧奧奩奮奧
奴奨奥 奣奯奭奰奩奬奥奲 奩奴女奥奬奦天夬 奴奲她 奡奰奰奬她奩奮奧 奴奨奥 女奰奥奣奩奡奬 奯奰奥奲奡奴奯奲 %unifyLog 奴奯 奴奨奥 奥奸奰奲奥女女奩奯奮 奩奮 奱奵奥女奴奩奯奮央 奔奨奩女 奷奩奬奬
奣奡奵女奥 奴奨奥 奴她奰奥 奣奨奥奣奫奥奲 奴奯 女奰奩奴 奯奵奴 奡奬奬 女奯奲奴女 奯奦 奩奮奦奯奲奭奡奴奩奶奥 奭奥女女奡奧奥女央

6.19.2 Namespaces and type-directed disambiguation

奎奡奭奥女 奣奡奮 奢奥 奤奥夜奮奥奤 奩奮 女奥奰奡奲奡奴奥 奮奡奭奥女奰奡奣奥女夬 奡奮奤 奤奩女奡奭奢奩奧奵奡奴奥奤 奢她 奴她奰奥央 奁奮 奥奸奰奲奥女女奩奯奮 with NAME
EXPR 奷奩奬奬 奰奲奩奶奩奬奥奧奥 奴奨奥 奮奡奭奥女奰奡奣奥 NAME 奩奮 奴奨奥 奥奸奰奲奥女女奩奯奮 EXPR央 奆奯奲 奥奸奡奭奰奬奥夺
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Idris> with List [[1,2],[3,4],[5,6]]
[[1, 2], [3, 4], [5, 6]] : List (List Integer)

Idris> with Vect [[1,2],[3,4],[5,6]]
[[1, 2], [3, 4], [5, 6]] : Vect 3 (Vect 2 Integer)

Idris> [[1,2],[3,4],[5,6]]
Can't disambiguate name: Prelude.List.::, Prelude.Stream.::, Prelude.Vect.::

6.19.3 Alternatives

奔奨奥 女她奮奴奡奸 (| option1, option2, option3, ... |) 奴她奰奥 奣奨奥奣奫女 奥奡奣奨 奯奦 奴奨奥 奯奰奴奩奯奮女 奩奮 奴奵奲奮 奵奮奴奩奬 奯奮奥
奯奦 奴奨奥奭 奷奯奲奫女央 奔奨奩女 奩女 奵女奥奤夬 奦奯奲 奥奸奡奭奰奬奥夬 奷奨奥奮 奴奲奡奮女奬奡奴奩奮奧 奩奮奴奥奧奥奲 奬奩奴奥奲奡奬女央

Idris> the Nat (| "foo", Z, (-3) |)
0 : Nat

奔奨奩女 奣奡奮 奡奬女奯 奢奥 奵女奥奤 奴奯 奧奩奶奥 女奩奭奰奬奥 奡奵奴奯奭奡奴奥奤 奰奲奯奯奦女夬 奦奯奲 奥奸奡奭奰奬奥夺 奴奲她奩奮奧 女奯奭奥 奣奯奮女奴奲奵奣奴奯奲女 奯奦 奰奲奯奯奦女央

syntax Trivial = (| Oh, Refl |)

6.19.4 Totality checking assertions

奁奬奬 奤奥夜奮奩奴奩奯奮女 奡奲奥 奣奨奥奣奫奥奤 奦奯奲 coverage 夨奩央奥央 奡奬奬 奷奥奬奬夭奴她奰奥奤 奡奰奰奬奩奣奡奴奩奯奮女 奡奲奥 奨奡奮奤奬奥奤天 奡奮奤 奥奩奴奨奥奲 奦奯奲
termination 夨奩央奥央 奡奬奬 奷奥奬奬夭奴她奰奥奤 奡奰奰奬奩奣奡奴奩奯奮女 奷奩奬奬 奥奶奥奮奴奵奡奬奬她 奰奲奯奤奵奣奥 奡奮 奡奮女奷奥奲天 奯奲夬 奩奦 奲奥奴奵奲奮奩奮奧 奣奯奤奡奴奡夬
奦奯奲 奰奲奯奤奵奣奴奩奶奩奴她 夨奩奮 奰奲奡奣奴奩奣奥夬 奡奬奬 奲奥奣奵奲女奩奶奥 奣奡奬奬女 奡奲奥 奣奯奮女奴奲奵奣奴奯奲 奧奵奡奲奤奥奤天央

奏奢奶奩奯奵女奬她夬 奴奥奲奭奩奮奡奴奩奯奮 奣奨奥奣奫奩奮奧 奩女 奵奮奤奥奣奩奤奡奢奬奥央 奉奮 奰奲奡奣奴奩奣奥夬 奴奨奥 奴奥奲奭奩奮奡奴奩奯奮 奣奨奥奣奫奥奲 奬奯奯奫女 奦奯奲 size change
夭 奥奶奥奲她 奣她奣奬奥 奯奦 奲奥奣奵奲女奩奶奥 奣奡奬奬女 奭奵女奴 奨奡奶奥 奡 奤奥奣奲奥奡女奩奮奧 奡奲奧奵奭奥奮奴夬 女奵奣奨 奡女 奡 奲奥奣奵奲女奩奶奥 奡奲奧奵奭奥奮奴 奯奦 奡 女奴奲奩奣奴奬她
奰奯女奩奴奩奶奥 奤奡奴奡 奴她奰奥央

奔奨奥奲奥 奡奲奥 奴奷奯 奢奵奩奬奴夭奩奮 奦奵奮奣奴奩奯奮女 奷奨奩奣奨 奣奡奮 奢奥 奵女奥奤 奴奯 奧奩奶奥 奴奨奥 奴奯奴奡奬奩奴她 奣奨奥奣奫奥奲 奡 奨奩奮奴夺

• assert_total x 奡女女奥奲奴女 奴奨奡奴 奴奨奥 奥奸奰奲奥女女奩奯奮 x 奩女 奴奥奲奭奩奮奡奴奩奮奧 奡奮奤 奣奯奶奥奲奩奮奧夬 奥奶奥奮 奩奦 奴奨奥 奴奯奴奡奬奩奴她
奣奨奥奣奫奥奲 奣奡奮奮奯奴 奴奥奬奬央 奔奨奩女 奣奡奮 奢奥 奵女奥奤 奦奯奲 奥奸奡奭奰奬奥 奩奦 x 奵女奥女 奡 奦奵奮奣奴奩奯奮 奷奨奩奣奨 奤奯奥女 奮奯奴 奣奯奶奥奲 奡奬奬
奩奮奰奵奴女夬 奢奵奴 奴奨奥 奣奡奬奬奥奲 奫奮奯奷女 奴奨奡奴 奴奨奥 女奰奥奣奩夜奣 奩奮奰奵奴 奩女 奣奯奶奥奲奥奤央

• assert_smaller p x 奡女女奥奲奴女 奴奨奡奴 奴奨奥 奥奸奰奲奥女女奩奯奮 x 奩女 女奴奲奵奣奴奵奲奡奬奬她 女奭奡奬奬奥奲 奴奨奡奮 奴奨奥 奰奡奴奴奥奲奮 p央

奆奯奲 奥奸奡奭奰奬奥夬 奴奨奥 奦奯奬奬奯奷奩奮奧 奦奵奮奣奴奩奯奮 奩女 奮奯奴 奣奨奥奣奫奥奤 奡女 奴奯奴奡奬夺

qsort : Ord a => List a -> List a
qsort [] = []
qsort (x :: xs) = qsort (filter (<= x) xs) ++ (x :: qsort (filter (>= x) xs)))

奔奨奩女 奩女 奢奥奣奡奵女奥 奴奨奥 奣奨奥奣奫奥奲 奣奡奮奮奯奴 奴奥奬奬 奴奨奡奴 filter 奷奩奬奬 奡奬奷奡她女 奰奲奯奤奵奣奥 奡 奶奡奬奵奥 女奭奡奬奬奥奲 奴奨奡奮 奴奨奥 奰奡奴奴奥奲奮
x :: xs 奦奯奲 奴奨奥 奲奥奣奵奲女奩奶奥 奣奡奬奬 奴奯 qsort央 套奥 奣奡奮 奡女女奥奲奴 奴奨奡奴 奴奨奩女 奷奩奬奬 奡奬奷奡她女 奢奥 奴奲奵奥 奡女 奦奯奬奬奯奷女夺

total
qsort : Ord a => List a -> List a
qsort [] = []
qsort (x :: xs) = qsort (assert_smaller (x :: xs) (filter (<= x) xs)) ++

(x :: qsort (assert_smaller (x :: xs) (filter (>= x) xs))))
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6.19.5 Preorder reasoning

奔奨奩女 女她奮奴奡奸 奩女 奤奥夜奮奥奤 奩奮 奴奨奥 奭奯奤奵奬奥 Syntax.PreorderReasoning 奩奮 奴奨奥 base 奰奡奣奫奡奧奥央 奉奴 奰奲奯奶奩奤奥女 奡
女她奮奴奡奸 奦奯奲 奣奯奭奰奯女奩奮奧 奰奲奯奯奦女 奯奦 奲奥夝奥奸奩奶奥夭奴奲奡奮女奩奴奩奶奥 奲奥奬奡奴奩奯奮女夬 奵女奩奮奧 奯奶奥奲奬奯奡奤奡奢奬奥 奦奵奮奣奴奩奯奮女 奣奡奬奬奥奤 step 奡奮奤
qed央 奔奨奩女 奭奯奤奵奬奥 奡奬女奯 奤奥夜奮奥女 step 奡奮奤 qed 奦奵奮奣奴奩奯奮女 奡奬奬奯奷奩奮奧 奴奨奥 女她奮奴奡奸 奴奯 奢奥 奵女奥奤 奦奯奲 奤奥奭奯奮女奴奲奡奴奩奮奧
奥奱奵奡奬奩奴她央 奈奥奲奥 奩女 奡奮 奥奸奡奭奰奬奥夺

import Syntax.PreorderReasoning
multThree : (a, b, c : Nat) -> a * b * c = c * a * b
multThree a b c =

(a * b * c) ={ sym (multAssociative a b c) }=
(a * (b * c)) ={ cong (multCommutative b c) }=
(a * (c * b)) ={ multAssociative a c b }=
(a * c * b) ={ cong {f = (* b)} (multCommutative a c) }=
(c * a * b) QED

奎奯奴奥 奴奨奡奴 奴奨奥 奰奡奲奥奮奴奨奥女奥女 奡奲奥 奲奥奱奵奩奲奥奤 夕 奯奮奬她 奡 女奩奭奰奬奥 奥奸奰奲奥女女奩奯奮 奣奡奮 奢奥 奯奮 奴奨奥 奬奥奦奴 奯奦 ={ }= 奯奲 QED央
奁奬女奯夬 奷奨奥奮 奵女奩奮奧 奰奲奥奯奲奤奥奲 奲奥奡女奯奮奩奮奧 女她奮奴奡奸 奴奯 奰奲奯奶奥 奴奨奩奮奧女 奡奢奯奵奴 奥奱奵奡奬奩奴她夬 奲奥奭奥奭奢奥奲 奴奨奡奴 她奯奵 奣奡奮 奯奮奬她
奲奥奬奡奴奥 奴奨奥 奥奮奴奩奲奥 奥奸奰奲奥女女奩奯奮夬 奮奯奴 女奵奢奥奸奰奲奥女女奩奯奮女央 奔奨奩女 奭奩奧奨奴 奯奣奣奡女奩奯奮奡奬奬她 奲奥奱奵奩奲奥 奴奨奥 奵女奥 奯奦 cong央

奆奩奮奡奬奬她夬 奡奬奴奨奯奵奧奨 奥奱奵奡奬奩奴她 奩女 奴奨奥 奭奯女奴 奯奢奶奩奯奵女 奡奰奰奬奩奣奡奴奩奯奮 奯奦 奰奲奥奯奲奤奥奲 奲奥奡女奯奮奩奮奧夬 奩奴 奣奡奮 奢奥 奵女奥奤 奦奯奲
奡奮她 奲奥夝奥奸奩奶奥夭奴奲奡奮女奩奴奩奶奥 奲奥奬奡奴奩奯奮央 奓奯奭奥奴奨奩奮奧 奬奩奫奥 step1 ={ just1 }= step2 ={ just2 }= end QED 奩女
奴奲奡奮女奬奡奴奥奤 奴奯 (step step1 just1 (step step2 just2 (qed end)))夬 女奥奬奥奣奴奩奮奧 奴奨奥 奡奰奰奲奯奰奲奩奡奴奥 奤奥夜奮奩夭
奴奩奯奮女 奯奦 step 奡奮奤 qed 奴奨奲奯奵奧奨 奴奨奥 奮奯奲奭奡奬 奤奩女奡奭奢奩奧奵奡奴奩奯奮 奰奲奯奣奥女女央 奔奨奥 女奴奡奮奤奡奲奤 奬奩奢奲奡奲她夬 奦奯奲 奥奸奡奭奰奬奥夬
奡奬女奯 奣奯奮奴奡奩奮女 奡奮 奩奭奰奬奥奭奥奮奴奡奴奩奯奮 奯奦 奰奲奥奯奲奤奥奲 奲奥奡女奯奮奩奮奧 奯奮 奩女奯奭奯奲奰奨奩女奭女央

6.19.6 Pattern matching on Implicit Arguments

奐奡奴奴奥奲奮 奭奡奴奣奨奩奮奧 奩女 奯奮奬她 奡奬奬奯奷奥奤 奯奮 奩奭奰奬奩奣奩奴 奡奲奧奵奭奥奮奴女 奷奨奥奮 奴奨奥她 奡奲奥 奲奥奦奥奲奲奥奤 奢她 奮奡奭奥夬 奥央奧央

foo : {n : Nat} -> Nat
foo {n = Z} = Z
foo {n = S k} = k

奯奲

foo : {n : Nat} -> Nat
foo {n = n} = n

奔奨奥 奬奡奴奴奥奲 奣奯奵奬奤 奢奥 女奨奯奲奴奥奮奥奤 奴奯 奴奨奥 奦奯奬奬奯奷奩奮奧夺

foo : {n : Nat} -> Nat
foo {n} = n

奔奨奡奴 奩女夬 {x} 奢奥奨奡奶奥女 奬奩奫奥 {x=x}央

6.19.7 Existence of an implementation

奉奮 奯奲奤奥奲 奴奯 女奨奯奷 奴奨奡奴 奡奮 奩奭奰奬奥奭奥奮奴奡奴奩奯奮 奯奦 女奯奭奥 奩奮奴奥奲奦奡奣奥 奩女 奤奥夜奮奥奤 奦奯奲 女奯奭奥 奴她奰奥夬 奯奮奥 奣奯奵奬奤 奵女奥 奴奨奥
%implementation 奫奥她奷奯奲奤夺

foo : Num Nat
foo = %implementation
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6.19.8 ‘‘‘match’’’ application

ty <== name 奡奰奰奬奩奥女 奴奨奥 奦奵奮奣奴奩奯奮 name 奩奮 女奵奣奨 奡 奷奡她 奴奨奡奴 奩奴 奨奡女 奴奨奥 奴她奰奥 ty夬 奢她 奭奡奴奣奨奩奮奧 ty 奡奧奡奩奮女奴
奴奨奥 奦奵奮奣奴奩奯奮’女 奴她奰奥央 奔奨奩女 奣奡奮 奢奥 奵女奥奤 奩奮 奰奲奯奯奦女夬 奦奯奲 奥奸奡奭奰奬奥夺

plus_comm : (n : Nat) -> (m : Nat) -> (n + m = m + n)
-- Base case
(Z + m = m + Z) <== plus_comm =

rewrite ((m + Z = m) <== plusZeroRightNeutral) ==>
(Z + m = m) in Refl

-- Step case
(S k + m = m + S k) <== plus_comm =

rewrite ((k + m = m + k) <== plus_comm) in
rewrite ((S (m + k) = m + S k) <== plusSuccRightSucc) in

Refl

6.19.9 Reflection

奉奮奣奬奵奤奩奮奧 %reflection 奦奵奮奣奴奩奯奮女 奡奮奤 quoteGoal x by fn in t夬 奷奨奩奣奨 奡奰奰奬奩奥女 fn 奴奯 奴奨奥 奥奸奰奥奣奴奥奤 奴她奰奥
奯奦 奴奨奥 奣奵奲奲奥奮奴 奥奸奰奲奥女女奩奯奮夬 奡奮奤 奰奵奴女 奴奨奥 奲奥女奵奬奴 奩奮 x 奷奨奩奣奨 奩女 奩奮 女奣奯奰奥 奷奨奥奮 奥奬奡奢奯奲奡奴奩奮奧 t央

6.19.10 Bash Completion

奕女奥 奯奦 optparse-applicative 奡奬奬奯奷女 奉奤奲奩女 奴奯 女奵奰奰奯奲奴 奂奡女奨 奣奯奭奰奬奥奴奩奯奮央 奙奯奵 奣奡奮 奯奢奴奡奩奮 奴奨奥 奣奯奭奰奬奥奴奩奯奮
女奣奲奩奰奴 奦奯奲 奉奤奲奩女 奵女奩奮奧 奴奨奥 奦奯奬奬奯奷奩奮奧 奣奯奭奭奡奮奤夺

idris --bash-completion-script `which idris`

奔奯 奥奮奡奢奬奥 奣奯奭奰奬奥奴奩奯奮 奦奯奲 奴奨奥 奬奩奦奥奴奩奭奥 奯奦 她奯奵奲 奣奵奲奲奥奮奴 女奥女女奩奯奮夬 奲奵奮 奴奨奥 奦奯奬奬奯奷奩奮奧 奣奯奭奭奡奮奤夺

source <(idris --bash-completion-script `which idris`)

奔奯 奥奮奡奢奬奥 奣奯奭奰奬奥奴奩奯奮 奰奥奲奭奡奮奥奮奴奬她 她奯奵 奭奵女奴 奥奩奴奨奥奲夺

• 奍奯奤奩奦她 她奯奵奲 奢奡女奨 奩奮奩奴 女奣奲奩奰奴 奷奩奴奨 奴奨奥 奡奢奯奶奥 奣奯奭奭奡奮奤央

• 奁奤奤 奴奨奥 奣奯奭奰奬奥奴奩奯奮 女奣奲奩奰奴 奴奯 奴奨奥 奡奰奰奲奯奰奲奩奡奴奥 bash_completion.d/ 奦奯奬奤奥奲 奯奮 她奯奵奲 奭奡奣奨奩奮奥央
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CHAPTER 7

Tutorials on the Idris Language

奔奵奴奯奲奩奡奬女 女奵奢奭奩奴奴奥奤 奢她 奣奯奭奭奵奮奩奴她 奭奥奭奢奥奲女央

注注注解解解: 奔奨奥 奤奯奣奵奭奥奮奴奡奴奩奯奮 奦奯奲 奉奤奲奩女 奨奡女 奢奥奥奮 奰奵奢奬奩女奨奥奤 奵奮奤奥奲 奴奨奥 奃奲奥奡奴奩奶奥 奃奯奭奭奯奮女 奃奃夰 奌奩奣奥奮女奥央 奁女
女奵奣奨 奴奯 奴奨奥 奥奸奴奥奮奴 奰奯女女奩奢奬奥 奵奮奤奥奲 奬奡奷夬 The Idris Community 奨奡女 奷奡奩奶奥奤 奡奬奬 奣奯奰她奲奩奧奨奴 奡奮奤 奲奥奬奡奴奥奤 奯奲
奮奥奩奧奨奢奯奲奩奮奧 奲奩奧奨奴女 奴奯 奄奯奣奵奭奥奮奴奡奴奩奯奮 奦奯奲 奉奤奲奩女央

奍奯奲奥 奩奮奦奯奲奭奡奴奩奯奮 奣奯奮奣奥奲奮奩奮奧 奴奨奥 奃奃夰 奣奡奮 奢奥 奦奯奵奮奤 奯奮奬奩奮奥 奡奴夺 奨奴奴奰夺夯夯奣奲奥奡奴奩奶奥奣奯奭奭奯奮女央奯奲奧夯
奰奵奢奬奩奣奤奯奭奡奩奮夯奺奥奲奯夯失央夰夯

7.1 Type Providers in Idris

奔她奰奥 奰奲奯奶奩奤奥奲女 奩奮 奉奤奲奩女 奡奲奥 女奩奭奰奬奥 奥奮奯奵奧奨夬 奢奵奴 奴奨奥奲奥 奡奲奥 奡 奦奥奷 奣奡奶奥奡奴女 奴奯 奵女奩奮奧 奴奨奥奭 奴奨奡奴 奩奴 奷奯奵奬奤 奢奥
奷奯奲奴奨奷奨奩奬奥 奴奯 奧奯 奴奨奲奯奵奧奨 奴奨奥 奢奡女奩奣 女奴奥奰女央 套奥 奡奬女奯 奧奯 奯奶奥奲 奦奯奲奥奩奧奮 奦奵奮奣奴奩奯奮女夬 奢奥奣奡奵女奥 奴奨奥女奥 奷奩奬奬 奯奦奴奥奮 奢奥
奵女奥奤 奷奩奴奨 奴她奰奥 奰奲奯奶奩奤奥奲女央

7.1.1 The use case

奆奩奲女奴夬 奬奥奴’女 奴奡奬奫 奡奢奯奵奴 why 奷奥 奭奩奧奨奴 奷奡奮奴 奴她奰奥 奰奲奯奶奩奤奥奲女央 奔奨奥奲奥 奡奲奥 奡 奮奵奭奢奥奲 奯奦 奲奥奡女奯奮女 奴奯 奵女奥 奴奨奥奭
奡奮奤 奴奨奥奲奥 奡奲奥 奯奴奨奥奲 奥奸奡奭奰奬奥女 奡奶奡奩奬奡奢奬奥 奡奲奯奵奮奤 奴奨奥 奮奥奴夬 奢奵奴 奩奮 奴奨奩女 奴奵奴奯奲奩奡奬 奷奥’奬奬 奢奥 奵女奩奮奧 奴奨奥奭 奴奯 奰奯奲奴
奃’女 struct stat 奴奯 奉奤奲奩女央

套奨她 奤奯 奷奥 奮奥奥奤 奴她奰奥 奰奲奯奶奩奤奥奲女夿 套奥奬奬夬 奉奤奲奩女’女 奆奆奉 奮奥奥奤女 奴奯 奫奮奯奷 奴奨奥 奴她奰奥女 奯奦 奴奨奥 奴奨奩奮奧女 奩奴 奰奡女女奥女 奴奯
奡奮奤 奦奲奯奭 奃夬 奢奵奴 奴奨奥 夜奥奬奤女 奯奦 奡 struct stat 奡奲奥 奩奭奰奬奥奭奥奮奴奡奴奩奯奮夭奤奥奰奥奮奤奥奮奴 奴她奰奥女 奴奨奡奴 奣奡奮奮奯奴 奢奥 奲奥奬奩奥奤
奵奰奯奮央 套奥 奤奯奮’奴 奪奵女奴 奷奡奮奴 奴奯 奨奡奲奤夭奣奯奤奥 奴奨奥女奥 奴她奰奥女 奩奮奴奯 奯奵奲 奰奲奯奧奲奡奭… 女奯 奷奥’奬奬 奵女奥 奡 奴她奰奥 奰奲奯奶奩奤奥奲
奴奯 夜奮奤 奴奨奥奭 奡奴 奣奯奭奰奩奬奥 奴奩奭奥夡

夲失夵

http://creativecommons.org/publicdomain/zero/1.0/
http://creativecommons.org/publicdomain/zero/1.0/
http://www.davidchristiansen.dk/pubs/dependent-type-providers.pdf
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7.1.2 A simple example

奆奩奲女奴夬 奬奥奴’女 奧奯 奯奶奥奲 奡 奢奡女奩奣 奵女奡奧奥 奯奦 奴她奰奥 奰奲奯奶奩奤奥奲女夬 奢奥奣奡奵女奥 奦奯奲奥奩奧奮 奦奵奮奣奴奩奯奮女 奣奡奮 奢奥 奣奯奮奦奵女奩奮奧 奢奵奴 奩奴’女
奩奭奰奯奲奴奡奮奴 奴奯 奲奥奭奥奭奢奥奲 奴奨奡奴 奰奲奯奶奩奤奥奲女 奴奨奥奭女奥奬奶奥女 奡奲奥 女奩奭奰奬奥央

奁 奴她奰奥 奰奲奯奶奩奤奥奲 奩女 女奩奭奰奬她 奡奮 奉奏 奡奣奴奩奯奮 奴奨奡奴 奲奥奴奵奲奮女 奡 奶奡奬奵奥 奯奦 奴奨奩女 奴她奰奥夺

data Provider a = Provide a | Error String

奌奯奯奫女 奦奡奭奩奬奩奡奲夿 Provider 奩女 奪奵女奴 Either a String夬 奧奩奶奥奮 奡 女奬奩奧奨奴奬她 奭奯奲奥 奤奥女奣奲奩奰奴奩奶奥 奮奡奭奥央

奒奥奭奥奭奢奥奲 奴奨奯奵奧奨夬 奴她奰奥 奰奲奯奶奩奤奥奲女 奷奥 奵女奥 奩奮 奯奵奲 奰奲奯奧奲奡奭 奭奵女奴 奢奥 奉奏 奡奣奴奩奯奮女央 奌奥奴’女 奷奲奩奴奥 奡 女奩奭奰奬奥 奯奮奥
奮奯奷夺

module Provider
-- Asks nicely for the user to supply the size of C's size_t type on this
-- machine
getSizeT : IO (Provider Int)
getSizeT = do
putStrLn "I'm sorry, I don't know how big size_t is. Can you tell me, in bytes?"
resp <- getLine
case readInt resp of

Just sizeTSize => pure (Provide sizeTSize)
Nothing => pure (Error "I'm sorry, I don't understand.")

-- the readInt function is left as an exercise

套奥 奡女女奵奭奥 奴奨奡奴 奷奨奯奥奶奥奲’女 奣奯奭奰奩奬奩奮奧 奴奨奥 奬奩奢奲奡奲她 奫奮奯奷女 奴奨奥 女奩奺奥 奯奦 size_t夬 女奯 奷奥’奬奬 奪奵女奴 奡女奫 奴奨奥奭夡
夨奄奯奮’奴 奷奯奲奲她夬 奷奥’奬奬 奧奥奴 奩奴 奯奵奲女奥奬奶奥女 奬奡奴奥奲央天 奔奨奥奮夬 奩奦 奴奨奥奩奲 奲奥女奰奯奮女奥 奣奡奮 奢奥 奣奯奮奶奥奲奴奥奤 奴奯 奡奮 奩奮奴奥奧奥奲夬 奷奥
奰奲奥女奥奮奴 Provide sizeTSize 奡女 奴奨奥 奲奥女奵奬奴 奯奦 奯奵奲 奉奏 奡奣奴奩奯奮夻 奯奲 奩奦 奩奴 奣奡奮’奴夬 奷奥 女奩奧奮奡奬 奡 奦奡奩奬奵奲奥央 夨奔奨奩女 奷奩奬奬
奴奨奥奮 奢奥奣奯奭奥 奡 奣奯奭奰奩奬奥夭奴奩奭奥 奥奲奲奯奲央天

奎奯奷 奷奥 奣奡奮 奵女奥 奴奨奩女 奉奏 奡奣奴奩奯奮 奡女 奡 奴她奰奥 奰奲奯奶奩奤奥奲夺

module Main
-- to gain access to the IO action we're using as a provider
import Provider

-- TypeProviders is an extension, so we'll enable it
%language TypeProviders

-- And finally, use the provider!
-- Note that the parentheses are mandatory.
%provide (sizeTSize : Int) with getSizeT

-- From now on it's just a normal program where `sizeTSize` is available
-- as a top-level constant
main : IO ()
main = do

putStr "Look! I figured out how big size_t is! It's "
putStr (show sizeTSize)
putStr " bytes!"

奙奡她夡 套奥… 奡女奫奥奤 奴奨奥 奵女奥奲 女奯奭奥奴奨奩奮奧 奡奴 奣奯奭奰奩奬奥 奴奩奭奥夿 奔奨奡奴’女 奮奯奴 奶奥奲她 奧奯奯奤夬 奡奣奴奵奡奬奬她央 奏奵奲 奬奩奢奲奡奲她 奩女
奧奯奩奮奧 奴奯 奢奥 奤奩夞奣奵奬奴 奴奯 奣奯奭奰奩奬奥夡 奔奨奩女 奩女 奨奡奲奤奬她 奡 女奴奥奰 奵奰 奦奲奯奭 奨奡奶奩奮奧 奴奨奥奭 奥奤奩奴 奩奮 奴奨奥 女奩奺奥 奯奦 size_t
奴奨奥奭女奥奬奶奥女夡

奄奯奮’奴 奷奯奲奲她夬 奴奨奥奲奥’女 奡 奢奥奴奴奥奲 奷奡她央

7.1. Type Providers in Idris 216



Idris 语语语言言言文文文档档档, 版版版本本本 1.3.1

7.1.3 Foreign Functions

奉奴’女 奡奣奴奵奡奬奬她 奰奲奥奴奴她 奥奡女她 奴奯 奷奲奩奴奥 奡 奃 奦奵奮奣奴奩奯奮 奴奨奡奴 夜奧奵奲奥女 奯奵奴 奴奨奥 女奩奺奥 奯奦 size_t夺

int sizeof_size_t() { return sizeof(size_t); }

夨套奨她 奡奮 奩奮奴 奡奮奤 奮奯奴 奡 size_t夿 奔奨奥 奆奆奉 奮奥奥奤女 奴奯 奫奮奯奷 奨奯奷 奴奯 奲奥奣奥奩奶奥 奴奨奥 奲奥奴奵奲奮 奶奡奬奵奥 奯奦 奴奨奩女 奦奵奮奣奴奩奯奮
奡奮奤 奴奲奡奮女奬奡奴奥 奩奴 奩奮奴奯 奡奮 奉奤奲奩女 奶奡奬奵奥央 奉奦 奷奥 奫奮奥奷 奨奯奷 奴奯 奤奯 奴奨奩女 奦奯奲 奶奡奬奵奥女 奯奦 奃 奴她奰奥 size_t夬 奷奥 奷奯奵奬奤奮’奴
奮奥奥奤 奴奯 奷奲奩奴奥 奴奨奩女 奦奵奮奣奴奩奯奮 奡奴 奡奬奬夡 奉奦 奷奥 奲奥奡奬奬她 奷奡奮奴奥奤 奴奯 奢奥 女奡奦奥 奦奲奯奭 奯奶奥奲夝奯奷夬 奷奥 奣奯奵奬奤 奵女奥 奡奮 奡奲奲奡她 奯奦
奭奵奬奴奩奰奬奥 奩奮奴奥奧奥奲女夬 奢奵奴 奴奨奥 奓奉奚奅 奯奦 size_t 奩女 奮奥奶奥奲 奧奯奩奮奧 奴奯 奢奥 奡 夶夵夵夳夵 奢她奴奥 奩奮奴奥奧奥奲央天

奓奯 奮奯奷 奷奥 奣奡奮 奧奥奴 奴奨奥 女奩奺奥 奯奦 size_t 奡女 奬奯奮奧 奡女 奷奥’奲奥 奩奮 奃 奣奯奤奥央 套奥’奤 奬奩奫奥 奴奯 奢奥 奡奢奬奥 奴奯 奵女奥 奴奨奩女
奦奲奯奭 奉奤奲奩女央 奃奡奮 奷奥 奤奯 奴奨奩女夿 奉奴 奴奵奲奮女 奯奵奴 奷奥 奣奡奮央

foreign

套奩奴奨 奦奯奲奥奩奧奮夬 奷奥 奣奡奮 奴奵奲奮 奡 奃 奦奵奮奣奴奩奯奮 奩奮奴奯 奡奮 奉奏 奡奣奴奩奯奮央 奉奴 奷奯奲奫女 奬奩奫奥 奴奨奩女夺

getSizeT : IO Int
getSizeT = foreign FFI_C "sizeof_size_t" (IO Int)

奐奲奥奴奴她 女奩奭奰奬奥央 foreign 奴奡奫奥女 奡 女奰奥奣奩夜奣奡奴奩奯奮 奯奦 奷奨奡奴 奦奵奮奣奴奩奯奮 奩奴 奮奥奥奤女 奴奯 奣奡奬奬 奡奮奤 奴奨奡奴 奦奵奮奣奴奩奯奮’女 奲奥奴奵奲奮
奴她奰奥央

Running foreign functions

奔奨奩女 奩女 奡奬奬 奷奥奬奬 奡奮奤 奧奯奯奤 奦奯奲 奷奲奩奴奩奮奧 奣奯奤奥 奴奨奡奴 奷奩奬奬 奴她奰奥奣奨奥奣奫央 奔奯 奡奣奴奵奡奬奬她 奲奵奮 奴奨奥 奣奯奤奥夬 奷奥’奬奬 奮奥奥奤
奴奯 奤奯 奪奵女奴 奡 奢奩奴 奭奯奲奥 奷奯奲奫央 奅奸奡奣奴奬她 奷奨奡奴 奷奥 奮奥奥奤 奴奯 奤奯 奤奥奰奥奮奤女 奯奮 奷奨奥奴奨奥奲 奷奥 奷奡奮奴 奴奯 奩奮奴奥奲奰奲奥奴 奯奲
奣奯奭奰奩奬奥 奯奵奲 奣奯奤奥央

In the interpreter

奉奦 奷奥 奷奡奮奴 奴奯 奣奡奬奬 奯奵奲 奦奯奲奥奩奧奮 奦奵奮奣奴奩奯奮女 奦奲奯奭 奩奮奴奥奲奰奲奥奴奥奤 奣奯奤奥 夨女奵奣奨 奡女 奴奨奥 奒奅奐奌 奯奲 奡 奴她奰奥 奰奲奯奶奩奤奥奲天夬 奷奥
奮奥奥奤 奴奯 奤她奮奡奭奩奣奡奬奬她 奬奩奮奫 奡 奬奩奢奲奡奲她 奣奯奮奴奡奩奮奩奮奧 奴奨奥 女她奭奢奯奬女 奷奥 奮奥奥奤央 奔奨奩女 奩女 奰奲奥奴奴她 奥奡女她 奴奯 奤奯 奷奩奴奨 奴奨奥
%dynamic 奤奩奲奥奣奴奩奶奥夺

%dynamic "./filename.so"

奎奯奴奥 奴奨奡奴 奴奨奥 奬奥奡奤奩奮奧“央夯” 奩女 奩奭奰奯奲奴奡奮奴夺 奣奵奲奲奥奮奴奬她夬 奴奨奥 女奴奲奩奮奧 她奯奵 奰奲奯奶奩奤奥 奩女 奩奮奴奥奲奰奲奥奴奥奤 奡女 奢她 dlopen()夬
奷奨奩奣奨 奯奮 奕奮奩奸 奤奯奥女 奮奯奴 女奥奡奲奣奨 奩奮 奴奨奥 奣奵奲奲奥奮奴 奤奩奲奥奣奴奯奲她 奢她 奤奥奦奡奵奬奴央 奉奦 她奯奵 奵女奥 奴奨奥 “央夯”夬 奴奨奥 奬奩奢奲奡奲她 奷奩奬奬
奢奥 女奥奡奲奣奨奥奤 奦奯奲 奩奮 奴奨奥 奤奩奲奥奣奴奯奲她 奦奲奯奭 奷奨奩奣奨 她奯奵 奲奵奮 奩奤奲奩女 夨not 奴奨奥 奬奯奣奡奴奩奯奮 奯奦 奴奨奥 夜奬奥 她奯奵’奲奥 奲奵奮奮奩奮奧夡天央
奏奦 奣奯奵奲女奥夬 奩奦 她奯奵’奲奥 奵女奩奮奧 奦奵奮奣奴奩奯奮女 奦奲奯奭 奡奮 奩奮女奴奡奬奬奥奤 奬奩奢奲奡奲她 奲奡奴奨奥奲 奴奨奡奮 女奯奭奥奴奨奩奮奧 她奯奵 奷奲奯奴奥 她奯奵奲女奥奬奦夬
奴奨奥 “央夯” 奩女 奮奯奴 奮奥奣奥女女奡奲她央

In an executable

奉奦 奷奥 奷奡奮奴 奴奯 奲奵奮 奯奵奲 奣奯奤奥 奦奲奯奭 奡奮 奥奸奥奣奵奴奡奢奬奥夬 奷奥 奣奡奮 女奴奡奴奩奣奡奬奬她 奬奩奮奫 奩奮女奴奥奡奤央 套奥’奬奬 奵女奥 奴奨奥 %include
奡奮奤 %link 奤奩奲奥奣奴奩奶奥女夺

%include C "filename.h"
%link C "filename.o"
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奎奯奴奥 奴奨奥 奥奸奴奲奡 奡奲奧奵奭奥奮奴 奴奯 奴奨奥 奤奩奲奥奣奴奩奶奥夡 套奥 女奰奥奣奩奦她 奴奨奡奴 奷奥’奲奥 奬奩奮奫奩奮奧 奡 奃 奨奥奡奤奥奲 奡奮奤 奬奩奢奲奡奲她央 奁奬女奯夬
奵奮奬奩奫奥 %dynamic夬 奴奨奥女奥 奤奩奲奥奣奴奩奶奥女 女奥奡奲奣奨 奩奮 奴奨奥 奣奵奲奲奥奮奴 奤奩奲奥奣奴奯奲她 奢她 奤奥奦奡奵奬奴央 夨奔奨奡奴 奩女夬 奴奨奥 奤奩奲奥奣奴奯奲她 奦奲奯奭
奷奨奩奣奨 奷奥 奲奵奮 奩奤奲奩女央天

7.1.4 Putting it all together

奓奯夬 奡奴 奴奨奥 奢奥奧奩奮奮奩奮奧 奯奦 奴奨奩女 奡奲奴奩奣奬奥 奉 女奡奩奤 奷奥’奤 奵女奥 奴她奰奥 奰奲奯奶奩奤奥奲女 奴奯 奰奯奲奴 struct stat 奴奯 奉奤奲奩女央 奔奨奥
奲奥奬奥奶奡奮奴 奰奡奲奴 奩女 奪奵女奴 奴奲奡奮女奬奡奴奩奮奧 奡奬奬 奴奨奥 奭她女奴奥奲奩奯奵女 奴她奰奥奤奥奦’奤 奃 奴她奰奥女 奩奮奴奯 奉奤奲奩女 奴她奰奥女夬 奡奮奤 奴奨奡奴’女 奷奨奡奴
奷奥’奬奬 奤奯 奨奥奲奥央

奆奩奲女奴夬 奬奥奴’女 奷奲奩奴奥 奡 奃 夜奬奥 奣奯奮奴奡奩奮奩奮奧 奦奵奮奣奴奩奯奮女 奴奨奡奴 奷奥’奬奬 奢奩奮奤 奴奯央

/* stattypes.c */
# include <sys/stat.h>

int sizeof_dev_t() { return sizeof(dev_t); }
int sizeof_ino_t() { return sizeof(ino_t); }
/* lots more functions like this */

奎奥奸奴夬 奡奮 奉奤奲奩女 夜奬奥 奴奯 奤奥夜奮奥 奯奵奲 奰奲奯奶奩奤奥奲女夺

-- Providers.idr
module Providers

%dynamic "./stattypes.so"
%access export

sizeOfDevT : IO Int
sizeOfDevT = foreign FFI_C "sizeof_dev_t" (IO Int)
{- lots of similar functions -}

-- Indicates how many bits are used to represent various system
-- stat types.
public export
data BitWidth = B8 | B16 | B32 | B64

Show BitWidth where
show B8 = "8 bits"
show B16 = "16 bits"
show B32 = "32 bits"
show B64 = "64 bits"

-- Now we have an integer, but we want a Provider BitWidth.
-- Since our sizeOf* functions are ordinary IO actions, we
-- can just map over them.
bytesToType : Int -> Provider BitWidth
bytesToType 1 = Provide B8 -- "8 bit value"
bytesToType 2 = Provide B16
bytesToType 4 = Provide B32
bytesToType 8 = Provide B64
bytesToType _ = Error "Unrecognised integral type."

getDevT : IO (Provider BitWidth)
getDevT = map bytesToType sizeOfDevT
{- lots of similar functions -}

奆奩奮奡奬奬她夬 奷奥’奬奬 奷奲奩奴奥 奯奮奥 奭奯奲奥 奩奤奲奩女 夜奬奥 奷奨奥奲奥 奷奥 奵女奥 奴奨奥 奴她奰奥 奰奲奯奶奩奤奥奲女夺

-- Main.idr
(äÿŃéąțçżğçżŋ)
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module Main
import Providers
%language TypeProviders
%provide (DevTBitWidth : BitWidth) with getDevT

-- We can now use DevTBitWidth in our program!
main : IO ()
main = putStrLn $ "size of dev_t: " ++ show DevTBitWidth

7.2 The Interactive Theorem Prover

奔奨奩女 女奨奯奲奴 奧奵奩奤奥 奣奯奮奴奲奩奢奵奴奥奤 奢她 奡 奣奯奭奭奵奮奩奴她 奭奥奭奢奥奲 奩奬奬奵女奴奲奡奴奥女 奨奯奷 奴奯 奰奲奯奶奥 奡女女奯奣奩奡奴奩奶奩奴她 奯奦 奡奤奤奩奴奩奯奮
奯奮 Nat 奵女奩奮奧 奴奨奥 奩奮奴奥奲奡奣奴奩奶奥 奴奨奥奯奲奥奭 奰奲奯奶奥奲央

奆奩奲女奴 奷奥 奤奥夜奮奥 奡 奭奯奤奵奬奥 Foo.idr

module Foo

plusAssoc : plus n (plus m o) = plus (plus n m) o
plusAssoc = ?rhs

套奥 奷奩女奨 奴奯 奰奥奲奦奯奲奭 奩奮奤奵奣奴奩奯奮 奯奮 n央 奆奩奲女奴 奷奥 奬奯奡奤 奴奨奥 夜奬奥 奩奮奴奯 奴奨奥 奉奤奲奩女 REPL 奡女 奦奯奬奬奯奷女夺

$ idris Foo.idr

套奥 奷奩奬奬 奢奥 奧奩奶奥奮 奴奨奥 奦奯奬奬奯奷奩奮奧 奰奲奯奭奰奴夬 奩奮 奦奵奴奵奲奥 奲奥奬奥奡女奥女 奴奨奥 奶奥奲女奩奯奮 女奴奲奩奮奧 奷奩奬奬 奤奩夛奥奲夺

____ __ _
/ _/___/ /____(_)____
/ // __ / ___/ / ___/ Version 0.9.18.1

_/ // /_/ / / / (__ ) http://www.idris-lang.org/
/___/\__,_/_/ /_/____/ Type :? for help

Idris is free software with ABSOLUTELY NO WARRANTY.
For details type :warranty.
Type checking ./Foo.idr
Metavariables: Foo.rhs
*Foo>

7.2.1 Explore the Context

套奥 女奴奡奲奴 奴奨奥 奩奮奴奥奲奡奣奴奩奶奥 女奥女女奩奯奮 奢她 奡女奫奩奮奧 奉奤奲奩女 奴奯 奰奲奯奶奥 奴奨奥 奨奯奬奥 rhs 奵女奩奮奧 奴奨奥 奣奯奭奭奡奮奤 :p rhs央 奉奤奲奩女
奢她 奤奥奦奡奵奬奴 奷奩奬奬 女奨奯奷 奵女 奴奨奥 奩奮奩奴奩奡奬 奣奯奮奴奥奸奴央 奔奨奩女 奬奯奯奫女 奡女 奦奯奬奬奯奷女夺

*Foo> :p rhs
---------- Goal: ----------
{ hole 0 }:
(n : Nat) ->
(m : Nat) ->
(o : Nat) ->
plus n (plus m o) = plus (plus n m) o
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7.2.2 Application of Intros

套奥 夜奲女奴 奡奰奰奬她 奴奨奥 intros 奴奡奣奴奩奣夺

-Foo.rhs> intros
---------- Other goals: ----------
{ hole 2 }
{ hole 1 }
{ hole 0 }
---------- Assumptions: ----------
n : Nat
m : Nat
o : Nat
---------- Goal: ----------
{ hole 3 }:
plus n (plus m o) = plus (plus n m) o

7.2.3 Induction on n

奔奨奥奮 奡奰奰奬她 induction 奯奮 奴奯 n夺

-Foo.rhs> induction n
---------- Other goals: ----------
elim_S0
{ hole 2 }
{ hole 1 }
{ hole 0 }
---------- Assumptions: ----------
n : Nat
m : Nat
o : Nat
---------- Goal: ----------
elim_Z0:
plus Z (plus m o) = plus (plus Z m) o

7.2.4 Compute

-Foo.rhs> compute
---------- Other goals: ----------
elim_S0
{ hole 2 }
{ hole 1 }
{ hole 0 }
---------- Assumptions: ----------
n : Nat
m : Nat
o : Nat
---------- Goal: ----------
elim_Z0:
plus m o = plus m o

7.2.5 Trivial

-Foo.rhs> trivial
---------- Other goals: ----------

(äÿŃéąțçżğçżŋ)
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{ hole 2 }
{ hole 1 }
{ hole 0 }
---------- Assumptions: ----------
n : Nat
m : Nat
o : Nat
---------- Goal: ----------
elim_S0:
(n__0 : Nat) ->
(plus n__0 (plus m o) = plus (plus n__0 m) o) ->
plus (S n__0) (plus m o) = plus (plus (S n__0) m) o

7.2.6 Intros

-Foo.rhs> intros
---------- Other goals: ----------
{ hole 4 }
elim_S0
{ hole 2 }
{ hole 1 }
{ hole 0 }
---------- Assumptions: ----------
n : Nat
m : Nat
o : Nat
n__0 : Nat
ihn__0 : plus n__0 (plus m o) = plus (plus n__0 m) o
---------- Goal: ----------
{ hole 5 }:
plus (S n__0) (plus m o) = plus (plus (S n__0) m) o

7.2.7 Compute

-Foo.rhs> compute
---------- Other goals: ----------
{ hole 4 }
elim_S0
{ hole 2 }
{ hole 1 }
{ hole 0 }
---------- Assumptions: ----------
n : Nat
m : Nat
o : Nat
n__0 : Nat
ihn__0 : plus n__0 (plus m o) = plus (plus n__0 m) o
---------- Goal: ----------
{ hole 5 }:
S (plus n__0 (plus m o)) = S (plus (plus n__0 m) o)
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7.2.8 Rewrite

-Foo.rhs> rewrite ihn__0
---------- Other goals: ----------
{ hole 5 }
{ hole 4 }
elim_S0
{ hole 2 }
{ hole 1 }
{ hole 0 }
---------- Assumptions: ----------
n : Nat
m : Nat
o : Nat
n__0 : Nat
ihn__0 : plus n__0 (plus m o) = plus (plus n__0 m) o
---------- Goal: ----------
{ hole 6 }:
S (plus n__0 (plus m o)) = S (plus n__0 (plus m o))

7.2.9 Trivial

-Foo.rhs> trivial
rhs: No more goals.
-Foo.rhs> qed
Proof completed!
Foo.rhs = proof

intros
induction n
compute
trivial
intros
compute
rewrite ihn__0
trivial

奔奷奯 奧奯奡奬女 奷奥奲奥 奣奲奥奡奴奥奤夺 奯奮奥 奦奯奲 Z 奡奮奤 奯奮奥 奦奯奲 S央 奈奥奲奥 奷奥 奨奡奶奥 奰奲奯奶奥奮 奡女女奯奣奩奡奴奩奶奩奴她夬 奡奮奤 奡女女奥奭奢奬奥奤 奡
奴奡奣奴奩奣 奢奡女奥奤 奰奲奯奯奦 女奣奲奩奰奴央 奔奨奩女 奰奲奯奯奦 女奣奲奩奰奴 奣奡奮 奢奥 奡奤奤奥奤 奴奯 Foo.idr央
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